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About Tektronix oscilloscopes

Introduction

Introduction
This Tektronix oscilloscope provides the performance, simplicity, and connectivity needed for the
ever-changing electronics, computer, and communications industries. The easy-to-use interface includes a
large display and a touch-screen interface on a Microsoft Windows platform.
Choose the methods of controlling oscilloscope operations that are most convenient for you:
Customary front-panel controls
Menus and toolbar buttons
Touch screen
What do you want to do next?
Read the product description. (see page 1)
Learn about using the online help. (see page 38)
Learn about working with your oscilloscope. (see page 965)

Product description
This online help supports the following series of Tektronix Digital Phosphor oscilloscopes:
MSO70000DX and DPO70000DX Series
DPO70000C Series
MSO70000C Series
DPO7000C Series
MSO5000B and DPO5000B Series
NOTE. The features and options that are documented in this online help are available for several
instrument models. Your instrument may not have every feature discussed.

Key features
Tektronix oscilloscopes are high-performance solutions for verification, debugging, and characterization of
sophisticated electronic designs. These oscilloscopes feature exceptional signal acquisition performance,
operational simplicity, and open connectivity to the design environment. Classic analog-style controls, a
large display with an optional touch-sensitive screen, and graphical menus provide intuitive control. Open
access to the Windows operating system enables unprecedented customization and extensibility.
Key features include:

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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Bandwidth:
MSO73304DX, DPO73304DX, MSO72504DX, DPO72504DX, MSO72304DX, and
DPO72304DX: 33, 25, and 23 GHz models with up to 100 GS/s real-time sampling rate on two
channels
DPO71254C, MSO71254C, DPO71604C, MSO71604C, DPO72004C, and MSO72004C: 12.5,
16, and 20 GHz models with up to 100 GS/s real-time sampling rate on two channels
DPO70404C, MSO70404C, DPO70604C, MSO70604C, DPO70804C, and MSO70804C: 4, 6,
and 8 GHz models with up to 25 GS/s real-time sampling rate on four channels
DPO7054C, DPO7104C, DPO7254C, and DPO7354C: 500 MHz, 1 GHz, 2.5 GHz, 3.5 GHz
models with up to 20 GS/s real-time sampling rate on two channels
DPO5034B, MSO5034B, DPO5054B, MSO5054B, DPO5104B, MSO5104B, DPO5204B, and
MSO5204B: 350 MHz, 500 MHz, 1 GHz, and 2 GHz models with up to 10 GS/s real-time
sampling rate on two channels
Record length: up to 1,000,000,000 samples on 2 channels and 500,000,000 samples on 4 channels,
depending on the model and options
Fast acquisition up to 250,000 acquisitions per second, depending on the model of instrument
Enhanced Bandwidth (see page 683) controls available for some models
Up to 1% DC vertical gain accuracy
Four input channels (each with 8-bit resolution)
Auxiliary trigger input and output
Sample, envelope, peak-detect, high-resolution, average, fast acquisition, and waveform database
acquisition modes
Full programmability, with an extensive GPIB command set and a message-based interface
Extensive suite of advanced triggers including edge, bus, logic, pulse, video, communication
(optional), sequence, low-speed serial, and serial pattern
Powerful built-in measurement capability, including histograms, automatic measurements, eye pattern,
and measurement statistics
Basic math as well as advanced equation editor and spectral analysis
A large 12.1 inch (307.3 mm), 1024 x 768 resolution, XGA color display that supports color grading
of waveform data to show sample density
Customizable MyScope control windows (see page 387)
An intuitive graphical user interface (GUI) with online help
Internal disk storage
Wide array of probing solutions, options, and upgrades
GPIB Controller available on some models
Comprehensive suite of right-click menus

2
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Parallel bus decoding, triggering and analysis
Serial bus decoding, triggering and analysis are optionally available
MSO70000C/DX Series Mixed Signal Oscilloscopes also offer:
16 digital channels plus 1 clock/qualifier channel
High resolution timing as precise as 80 ps
An analog view of any digital channel through the iCapture feature
Enhanced Logic Pattern and Logic State triggering includes digital channels
Differential (P6780) and single-ended (P6717A) logic probes
Easy connection to your device-under-test through the convenient design of the P6780 and the
P6717 Logic probes
iCapture allows analyzing the analog characteristics of the digital channels
MSO5000B Series instruments offer:
MagniVu 60.6 ps resolution

Signal processing features
Waveform math. Set up math waveforms (see page 247) using the basic arithmetic functions,
including FFT, or create more advanced math waveforms using the math expression editor. Waveform
expressions can contain measurement results and other math waveforms.
Spectral analysis. Display spectral magnitude and phase waveforms based on your time-domain
acquisitions. Control the instrument using the traditional spectrum analyzer controls (see page 763),
such as span, center frequency, and resolution bandwidth.
Mask testing. Use Mask Testing (see page 786) for signal violation detection and pass/fail testing.
Test signals against a user defined mask, or with the Mask Testing Option (see page 914), you can
test against industry standard masks.

Display features
Color LCD display. Identify and differentiate waveforms (see page 172) easily with color coding.
Waveforms, readouts, and inputs are color matched to increase productivity and reduce operating
errors.
Digital phosphor. The Digital Phosphor Oscilloscope can provide visual clues as to the relative rate
of occurrence of waveform features or anomalies by combining many separate acquisitions of a
waveform into a single intensity-graded or color-graded display.
Fit to screen. The Digital Phosphor technology performs the compression required to represent all
record points on the screen, even at the maximum record length settings.
MultiView Zoom. To take advantage of the full resolution of the instrument, you can zoom in on a
waveform (see page 728) to see fine details. Both vertical and horizontal zoom are available. You
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can also zoom in on multiple areas of a single waveform simultaneously and on multiple waveforms
at the same time.

Measurement features
Cursors. Use Cursors (see page 84) to take simple voltage, time, and frequency measurements.
Automatic measurements. Choose from a large palette of amplitude, time, histogram, and
communication measurements. You can customize the measurements (see page 728) by changing
reference levels or by adding measurement gating. Statistics (mean, maximum, minimum, standard
deviation and population) are available for each measurement value.

Trigger features
Simple and advanced trigger types. Choose a simple edge trigger or advanced trigger types (see
page 393) to help you capture a specific signal fault or event.
Dual triggers. Use the A (main) trigger system alone or add the B trigger to capture more complex
events. You can use the A and B triggers together (see page 911) to set up a delay-by-time or
delay-by-events trigger condition.

Convenience features
Autoset. Use Autoset (see page 691) to quickly set up the vertical, horizontal, and trigger controls
for a usable display.
MyScope. Use MyScope (see page 387) to create your own control windows for easy access to the
controls you use most often.
Touch screen interface. You can operate all instrument functions (except the power switch) from the
touch screen interface (see page 60). You can also install a mouse and keyboard.
Toolbar or menu bar. You can choose a toolbar operating mode (see page 34) that is optimized for
use with the touch screen, or a PC-style menu-bar operating mode (see page 33) that is optimized
for use with a mouse.
Open desktop. The instrument is built on a Microsoft Windows software platform; the instrument
application program starts automatically when you apply power to the instrument. You can minimize
the instrument application and take full advantage of the built-in PC to run other applications. Moving
waveform images and data into other applications is as simple as a copy/paste operation.
Dedicated front panel controls. The front panel contains knobs and buttons (see page 39) to provide
immediate access to the most common instrument controls. Separate vertical controls (see page 62)
are provided for each channel. The same functions are also available through the screen interface.
Data storage and I/O. The instrument has a removable hard disk drive and a DVD/CD-RW drive that
can be used for storage and retrieval of data. The instrument has GPIB, USB, Centronics (available

4

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

About Tektronix oscilloscopes

Product software

on some models), RS-232, XGA out, extended desktop support, and Ethernet ports for input and
output to other devices.
Online help. The instrument has a complete online help system (see page 38) that covers all its
features. The help system is context sensitive; help for the displayed control window is automatically
shown if you click the help button. Graphical aids in the help windows assist you in getting to the
information you need. You can also access the help topics through a table of contents, index, or
full text search.

Product software
The instrument includes the following software:
System Software. The product software runs on a specially configured version of Microsoft Windows
which is pre-installed and enables you to install other compatible applications. Do not attempt to
substitute any version of Windows that is not specifically provided by Tektronix for use with your
instrument.
Product Software. This pre-installed software is the instrument application and runs on Microsoft
Windows. It provides the graphical user interface (GUI) and all other instrument control functions.
You can minimize or even exit/restart the instrument application as your needs dictate. However, it is
recommended that you exit the instrument application only when installing new software.
Support Software. The product software DVD, included with the instrument, contains additional
software and files that may be useful to you.
Readme file. This text file contains release notes and updates that are not included in other product
documentation.
GPIB Programmer Online Help. Available as online help or a PDF file. It contains the information
you need to program the instrument through its GPIB interface.
Specifications Performance Verification Procedures. The product DVD contains instrument
specifications and instructions to perform a manual performance verification.
See the instructions on the product software DVD for information about installing the support software.
NOTE. New versions of software for your instrument are available at our Web site. To find application
software releases that may not be on your instrument or to find the latest versions of instrument software
and application software that is on your instrument, visit www.tektronix.com/support.

Firmware upgrade
Tektronix may offer firmware upgrade kits for this instrument. Contact your local Tektronix distributor
or sales office for more information.
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Recommended accessories
The following accessories are recommended for your instrument.
MSO5000B and DPO5000B:
GPIB-to-USB adapter, order TEK-USB-488
TekVPI-to-TekProbe BNC adapter, order TPA-BNC
Hard transit case, HCTEK54
Rackmount kit, order RMD5000
Deskew pulse generator, 067-1686-XX
Mini keyboard, 119-7275-XX
Service manual as a PDF, 077-0076-XX
Programmer manual as a PDF, 077-0010-XX
Specifications and Performance Verification manual as a PDF, 077-0063-XX
DPO7000C
Oscilloscope cart, order K420
Power deskew fixture, order 067-1478-XX
Mini keyboard (USB), order 119-7275-XX
Rackmount kit, order 016-1965-XX
Service manual as a PDF file, 077-0076-XX
MSO/DPO70000DX, DPO70000C, and MSO70000C:
Deskew fixture, order 067-1586-XX
Oscilloscope cart, K4000 with brackets: order 407-5187-XX and 407-5188-XX
Rack mount, order 016-1981-XX
Transit case, order 016-1977-XX
Service manual as a PDF file, 077-0076-XX
The following probes and components are recommended for your instrument:
MSO5000B and DPO5000B:
TekProbe
TekProbe component

6

Description

ADA400A

100X, 10X, 1X, and 0.1X, high gain differential amplifier

P5100A

2.5 kV, 100X, 250 MHz high voltage passive probe
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TekProbe component

Description

P6015A

40 kVpk, 1000X, 75 MHz high voltage single-ended passive probe

TCPA300, TCPA400

Current measurement systems amplifier (requires TPA-BNC)

xxx

TekVPI
TekVPI component

Description

TAP1500

1.5 GHz active single-ended voltage probe

TAP2500

2.5 GHz active single-ended voltage probe

TCP0020

50 MHz, 20 A AC/DC current probe

TCP0030A

DC to 120 MHz, 30 A AC/DC current probe

TCP0150

DC to 20 MHz, 150 A AC/DC current probe

TDP0500

500 MHz active differential voltage probe

TDP1000

1 GHz active differential voltage probe

TDP1500

1.5 GHz active differential voltage probe with ±8.5 V differential input
voltage

TDP3500

3.5 GHz differential voltage probe with ±2 V differential input voltage

TPP0502

500 MHz 2X TekVPI passive voltage probe

TPP0850

2.5 kV 800 MHz TekVPI high-voltage passive probe

TPP500, TPP1000

10X Passive Probes are compact with 10X attenuation, designed for
use with Tektronix MSO/DPO4000B and MSO/DPO5000B Series
instruments.
The bandwidth (–3 dB) for TPP500 is 500 MHz.
The bandwidth (–3 dB) for TPP1000 is 1 GHz.

THDP0100

±6 kV, 100 MHz high-voltage differential probe

THDP0200

±1.5 kV, 200 MHz high-voltage differential probe

TMDP0200

±750 V, 200 MHz high-voltage differential probe

P5100A

2.5 kV, 500 MHz, 100X high-voltage passive probe

xxx

DPO7000C
BNC
BNC component

Description

CT1, CT2, CT6

Current probes, AC high-speed

P6021, P6022

Current probes, AC

xxx

TekProbe
TekProbe component

Description

ADA400A

Differential preamplifier

P5100A

High-voltage probe

P6015A

High-voltage probe

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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TekProbe component

Description

P6139B

Passive probe

P6158

20X low-capacitance probe, 3 GHz

P6243

Active probe, 1 GHz

P6245

Active probe, 1.5 GHz

P6246

Differential probe, 400 MHz

P6247

Differential probe, 1 GHz

P6248

Differential probe, 1.5 GHz

P6701B

Converter, optical-to-electrical (multi-mode)

P6703B

Converter, optical-electrical (single-mode)

TCP202A

Current probe

TCP300, TCP400 Series

Current measurement system (Requires TCPA300/TCPA400
amplifiers)

xxx

TekVPI
TekVPI component

Description

TAP1500

Active probe, 1.5 GHz

TAP2500

Active probe, 2.5 GHz

TAP3500

Active probe, 3.5 GHz

TCP0020

50 MHz TekVPI 20 Ampere AC/DC current probe

TCP0030A

120 MHz TekVPI 30 Ampere AC/DC current probe

TDP0500

500 MHz TekVPI differential voltage probe with ±42 V differential
input voltage

TDP1000

1 GHz TekVPI differential voltage probe with ±42 V differential input
voltage

TDP1500

1.5 GHz TekVPI differential voltage probe with ±8.5 V differential input
voltage

TDP3500

3.5 GHz TekVPI differential voltage probe with ±2 V differential input
voltage

TCP0150

DC to 20 MHz, 150 A AC/DC current probe

THDP0100

±6 kV, 100 MHz high-voltage differential probe

THDP0200

±1.5 kV, 200 MHz high-voltage differential probe

TMDP0200

±750 V, 200 MHz high-voltage differential probe

P5100A

2.5 kV, 500 MHz, 100X high-voltage passive probe

xxx

MSO/DPO70000DX, DPO70000C, and MSO70000C:
BNC
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BNC component

Description

CT1, CT2, CT6

Current probes, AC high-speed

P6021, P6022

Current probes, AC

xxx

Logic (MSO70000C/DX Series)
Logic component

Description

P6717A

16 data and 1 clock channel logic probe with accessories

P6780

16 data and 1 clock channel differential logic probe with accessories
that you solder in

xxx
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TekConnect
TekConnect component

Description

P7260

Low-capacitance active voltage probe, 6 GHz

P7313, P7313SMA

Differential probe, 12.5 GHz

P7350, P7350SMA

Differential probe, 5 GHz

P7360

Differential probe, 6 GHz

P7380, P7380SMA

Differential probe, 8 GHz

P7504

TriMode probe, 4 GHz

P7506

TriMode probe, 6 GHz

P7508

TriMode probe, 8 GHz

P7513A

TriMode probe, 13 GHz

P7516

TriMode probe, 15 GHz

P7520A

TriMode probe, 25 GHz with optional tip

P7630

TriMode probe, 30 GHz

TCA-BNC

Adapter, TekConnect-to-BNC

TCA-N

Adapter, TekConnect-to-N

TCA-SMA

Adapter, TekConnect-to-SMA

TCA-1MEG

High-impedance buffer amplifier (Includes P6139A passive probe)

TCA-75

Adapter, 4 GHz: 75 Ω to 50 Ω 75 Ω BNC input

TCA-292MM

TekConnect to 2.92 mm connectors

xxx

TekProbe
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Description

ADA400A

Differential preamplifier

P5050

10X passive probe, 500 MHz

P5100

High-voltage probe

P5200

High-voltage differential probe

P5205

High-voltage differential probe

P5210

High-voltage differential probe

P6015A

High-voltage probe

P6101B

1X passive probe, 15 MHz

P6139A

Passive probe

P6158

20X low-capacitance probe, 3 GHz

P6243

Active probe, 1 GHz

P6245

Active probe, 1.5 GHz

P6246

Differential probe, 400 MHz

P6247

Differential probe, 1 GHz

P6248

Differential probe, 1.5 GHz

P6701B

Converter, optical-to-electrical (multimode)
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TekProbe component

Description

P6703B

Converter, optical-electrical (single-mode)

TCP202A

Current probe

TCP300, TCP400 Series

Current measurement system (Requires TCPA300/TCPA400
amplifiers)

xxx

Options
The following options are available for your instrument.
DPO5000B, MSO5000B:
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Software:
Opt. BRR - BroadR-Reach Compliance Testing
Opt. DDRA - DDR Memory Bus Analysis; Available, only on 1 GHz and 2 GHz models
(requires DJA)
Opt. DJA - Jitter And Eye Analysis Tools - Advanced (DPOJET)
Opt. ET3 - Ethernet Compliance Testing
Opt. HSIC - USB HSIC protocol decode and electrical validation (Available on 2 GHz
models only.) (requires DJA)
Opt. MOST – MOST Essentials – Electrical Compliance and Debug Test Solution for
MOST50 and MOST150
Opt. MSOE - 16-channel MSO 1
Opt. MTM - Mask Testing for Serial Communication Standards (up to 1.5 Gb/s)
Opt. PS2 - Power Solution Bundle: DPOPWR, THDP0200, TCP0030A, 067-1686-XX
(Deskew Fixture)
Opt. PS3 - Power Solution Bundle: DPOPWR, TMDP0200, TCP0020, 067-1686-XX
(Deskew Fixture)
Opt. PWR - Power Measurement and Analysis
Opt. SR-AERO - MIL-STD-1553 Serial Triggering and Analysis
Opt. SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)
Opt. SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
Opt. SR-CUST - Custom Serial Analysis Kit for Developers
Opt. SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis
Opt. SR-EMBD - Embedded Serial Triggering and Analysis (I2C, SPI)
Opt. SR-ENET - Ethernet Serial Triggering and Analysis (10BASE-T and 100BASE-TX)
Opt. SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)
Opt. SVE - SignalVu Essentials - Vector Signal Analysis Software
Opt. USB - USB 2.0 Compliance Testing
Opt. USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,
and USB
Opt. USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution
Opt. VNM - CAN/LIN Protocol Analysis Software
1
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Record Length:
Opt. 5RL - 50 MSamples/ch, 125M maximum for 1 ch and 2 ch
Opt. 10RL - 125 MSamples/ch, 250M maximum for 1 ch and 2 ch
DPO7000C
Hardware:
Opt. 2SR (available only on DPO7104C instruments) - Double maximum real time sample
rate
Record Length:
Opt. 5RL - 250 MSamples max, 50 MSamples/ch
Opt. 10RL - 500 MSamples max, 125 MSamples/ch (Only available on
DPO7254C/DPO7354C instruments)
Service:
Opt. R3 - Repair service 3 years, including warranty
Opt. R5 - Repair service 5 years, including warranty
Software:
Opt. BRR - BroadR-Reach Compliance Testing
Opt. DDRA - DDR Memory Bus Analysis (requires DJA)
Opt. DJA - Jitter And Eye Analysis Tools - Advanced (DPOJET)
Opt. ET3 - Ethernet Compliance Test
Opt. D-PHY - MIPI® D-PHY Characterization and Compliance Testing
Opt. HSIC - USB HSIC protocol decode and electrical validation (For models of bandwidth
≥2.5 GHz only.) (requires DJA)
Opt. LSA - Low Speed Serial Analysis (CAN/LIN trigger)
Opt. MOST – MOST Essentials – Electrical Compliance and Debug Test Solution for
MOST50 and MOST150
Opt. MTM - Serial Communications Mask Testing
Opt. PWR - DPOPWR Power Measurement and Analysis
Opt. PS2 - Power Solution Bundle: DPOPWR, THDP0200, TCP0030A, 067-1686-XX
(Deskew Fixture)
Opt. PS3 - Power Solution Bundle: DPOPWR, TMDP0200, TCP0020, 067-1686-XX
(Deskew Fixture)
Opt. SR-AERO - MIL-STD-1553 Serial Triggering and Analysis
Opt. SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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Opt. SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
Opt. SR-CUST - Custom Serial Analysis Kit for Developers
Opt. SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis
Opt. SR-EMBD - Embedded Serial Triggering and Analysis (I2C, SPI)
Opt. SR-ENET - Ethernet Serial Analysis (10BASE-T and 100BASE-TX)
Opt. SR-PCIE - PCI Express Compliance Module for RT-Eye Serial Data Compliance and
Analysis
Opt. SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)
Opt. SR-810B - 8b/10b Serial Triggering and Analysis
Opt. ST1G – 64-bit NRZ Serial Trigger and 8b/10b Serial Protocol Decode (includes Opt.
SR-810B) (only available on DPO7254C/DPO7354C instruments)
Opt. SV23 - WLAN 802.11a/b/g measurement application (Requires Opt. SVE) (For models
of bandwidth ≥2.5 GHz only)
Opt. SV24 - WLAN 802.11n measurement application (Requires Opt. SVE and SV23)
(For models of bandwidth ≥2.5 GHz only)
Opt. SVA - SignalVu AM/FM/Direct Audio Measurements (requires SVE)
Opt. SVE - SignalVu™ Essentials for Vector Signal Analysis
Opt. SVM - General Purpose Modulation Analysis (requires SVE)
Opt. SVO - Flexible OFDM Analysis (requires SVE)
Opt. SVP - SignalVu Pulse — Advance Signal Analysis Software (requires SVE)
Opt. SVT - Settling Time Measurements such as Frequency and Phase (requires SVE)
Opt. USB - Universal Serial Bus USB2.0 Compliance Test
Opt. USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,
and USB
Opt. USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution
MSO/DPO70000C/DX:
Calibration:
Opt. C3 - Calibration service 3 years
Opt. C5 - Calibration service 5 years
Opt. D1 - Calibration data report
Opt. D3 - Calibration data report 3 years (with Opt C3)
Opt. D5 - Calibration data report 5 years (with Opt C5)
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Options

Hardware:
Opt. 1R - Rackmount kit
Record Length:
MSO70000C/DX, and DPO70000C/DX Series:
Opt. 2XL - 31 MSamples/ch (standard on DPO instruments)
Opt. 5XL - 62 MSamples/ch (standard on MSO instruments)
Opt. 10XL - 125 MSamples/ch
Opt. 20XL - 250 MSamples/ch
Opt. 50XL - 500 MSamples/ch
Service:
Opt. CA1 - Provides single calibration event for the designated interval
Opt. R3 - Repair service 3 years (including warranty)
Opt. R5 - Repair service 5 years (including warranty)
Software:
MSO70000C/DX, and DPO70000C/DX Series:
Opt. BRR - BroadR-Reach Compliance Testing
Opt. DDRA - DDR Memory Bus Analysis
Opt. DJA - Advanced Jitter and Eye Analysis (standard on MSO instruments)
Opt. D - PHY MIPI D-PHY Transmitter Debug, Characterization, and Compliance Test
Solution (requires DJA)
Opt. DP12 - DisplayPort 1.2 Source Test Automation (requires Opt. DJA and Opt.5XL
or higher)
Opt. ERRDT - Frame and Bit Error Rate Detector in high speed serial standards (requires
option ST6G).
Opt. ET3 - Ethernet Compliance Test
Opt. HSIC – HSIC Essentials - Electrical Validation and Protocol Decode Solution (Requires
Opt. DJA)
Opt. HT3 - HDMI Compliance Test
Opt. HT3DS - HDMI Direct Synthesis for HDMI 1.4 Compliance Test
Opt. M - PHY - MIPI M-PHY Essentials – Characterization and Analysis Solution (Requires
Opt. DJA)
Opt. M - PHYTX - M-PHY Automated Transmitter Solution (requires DJA)
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Opt. M - PHYRX - M-PHY Automated Receiver Solution (Requires Opt. ST6G) (Requires
Opt. ERRDT)
Opt. MTH - Mask Testing for serial standards, 4.25 GB/s (standard on MSO instruments)
Opt. MOST - Electrical Compliance and Debug Test Solution for MOST50 and MOST150
(Requires Opt. DJA)
Opt. PCE3 - PCI Express® Transmitter Compliance and Debug (Requires Opt. DJA) (For
models of bandwidth ≥6 GHz only)
Opt. PWR - DPOPWR Power Measurements and Analysis
Opt. QPI - Intel® Quick Path Interconnect Test Automation Software (Requires Opt. DJA)
Opt. SAS3 - SAS3 12 GB/s Essentials (Requires Opt. DJA and 2XL or higher) (For models
of bandwidth ≥20 GHz only)
Opt. SFP-TX - SFP+ Compliance and Debug Solution (Requires Opt. DJA)
Opt. SFP-WDP - SFP+ Compliance and Debug Solution – WDP Measurement (Requires
Opt. DJA)
Opt. SDLA64 - Serial Data Link Analysis Visualizer
Opt. SR-AERO - MIL-STD-1553 Serial Triggering and Analysis
Opt. SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)
Opt. SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
Opt. SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis
Opt. SR-EMBD - Embedded Serial Triggering and Analysis (I2C, SPI) (standard on MSO
instruments)
Opt. SR-ENET - Ethernet Serial Analysis (10BASE-T and 100BASE-TX)
Opt. SR-PCIE - PCI Express Compliance Module for RT-Eye Serial Data Compliance and
Analysis
Opt. SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)
Opt. SR-810B - 8b/10b Serial Triggering and Analysis
Opt. ST6G - Serial Protocol Trigger Software to trigger and decode 8 B/10 B data on
high-speed serial or data protocols. Protocol triggering up to 6.25 GS/s. (standard on MSO
instruments)
Opt. SVA - AM/FM/PM Audio Signal Analysis (Requires Opt. SVE)
Opt. SVE - SignalVu Essentials for Vector Signal Analysis
Opt. SVM - SignalVu Essentials for General Purpose Modulation Analysis (requires option
SVE)
Opt. SVO - Flexible OFDM Analysis (requires SVE)
Opt. SVP - SignalVu Pulse — Advance Signal Analysis Software (requires SVE)
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Opt. SVT - Settling Time Measurements such as Frequency and Phase (requires SVE)
Opt. TBT-TX - Thunderbolt Transmitter Characterization, Debug, and Compliance Testing
(Requires Opt. DJA and Opt. 2XL or higher) (For models of bandwidth ≥16 GHz only)
Opt. UHS2 - UHS-II-Host-Tx and UHS-ii-Device-Tx Measurements (For models of
bandwidth ≥6 GHz only)
Opt. USB - Universal Serial Bus USB 2.0 Compliance Test
Opt. USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,
and USB
Opt. USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution (Not
supported on 70000DX models)
Opt. USB3 - Universal Serial Bus USB 3.0 Compliance and Analysis
Opt. VET - Visual Trigger and Search
Opt. 10G-KR - 10GBASE-KR/KR4 Compliance and Debug Solution (Requires Opt. DJA)
(For models of bandwidth ≥16 GHz only)

Documentation
In addition to the instrument online help, the following documents are available:
Digital Phosphor Oscilloscopes User Manual (071-2980-XX). The Quick Start User Manual has
information about installing and operating your instrument. The Quick Start User Manual is available
in several languages, in addition to English.
Digital Phosphor Oscilloscopes Programmer Online Guide. The Programmer Guide is provided as
online help and as a printable PDF file. See the product software DVD for installation information.
Digital Phosphor Oscilloscopes Specifications and Performance Verification Technical Reference
Manual (077-0063-XX). This is a PDF only manual that includes both the specifications and the
performance verification procedure.
Digital Phosphor Oscilloscopes Service Manual (077-0076-XX). A service manual is available as a
PDF file; it includes procedures to service the instrument to the module level.

Other documentation
Your instrument includes PDF files of relevant information on the product software DVD, Tektronix
part number 020-3079-XX.
For quick access to PDF files of the user manual, probe manuals, programmer guide, primers and
applications, specifications and performance verification manual, service and installation manuals, and a
printable version of the online help, click the Documentation icon on your instrument desktop.
What do you want to do next?
Find out about using online help. (see page 38)
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Learn how to access Tektronix Support. (see page 18)
Provide feedback on this Tektronix product. (see page 21)

Support information
Tektronix offers the following services in support of our products:
Technical Support. For application-related questions about a Tektronix product, contact us by
telephone or e-mail ).
Service Support. For service-related questions about a Tektronix product, contact us by telephone or
e-mail ).
Tektronix also offers extended warranty and calibration programs as options on many products.
Contact your local Tektronix distributor or sales office.
Write to Tektronix:
Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077 USA
What do you want to do next?
Find out what other documents are available. (see page 17)
Find out about using online help. (see page 38)
Provide feedback on this Tektronix product. (see page 21)

TekScope Recovery Report Utility
The TekScope Recovery Report Utility is designed to gather logs and other files that may contain data
useful to Tektronix in the diagnosis of TekScope Errors, and it creates a .zip file on the desktop to hold all
of the gathered data. This compressed file is easily copied from the desktop to a removable flash drive, or
the file can be sent to Tektronix as an email attachment.
If you contact Tektronix for help in diagnosing TekScope Errors, you may be asked to run this utility
and supply Tektronix with the .zip file.
NOTE. The utility will erase temporary data created under the account of the user that runs the utility.
This allows TekScope to generate fresh files the next time it starts.
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TekScope Recovery Report Utility

Finding the utility
A link to the utility can be found under the Start\All Programs\Tektronix\TekScope\ directory.

Running the utility
Click on the utility link.
If TekScope is running when the utility is invoked, the utility will warn the user that TekScope must be
stopped. This is necessary to allow the utility to access some of the files. The utility will automatically
stop TekScope after it queries the serial number of the instrument. Click Yes to allow the utility to stop
TekScope and collect files for the report.

If TekScope is not running, the recovery utility will still run and will collect files for the report.
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TekScope Recovery Report Utility

Finding the report
When the utility is finished running, the zipped report file is on the desktop.
a) In the case where TekScope was running when the utility was invoked, the name of the .zip report
file created on the desktop will contain the type of instrument and the serial number. For example:
TekScope_Recovery_Report_MSO71254C_123456789.zip.

b) However, if TekScope was not running when the utility was invoked, the name of the .zip report file
will not contain the serial number. For example: TekScope_Recovery_Report_MSO71254C.zip

Data contained in the report
When the utility is finished running, if these files exist on the instrument, the report will contain copies
of these specific files:
C:\Windows\Sysnative\winevt\logs\Application.evtx
C:\programdata\tektronix\ISD.XML
C:\programdata\Tektronix\TekScope\Calibration\console.log
C:\programdata\Tektronix\TekScope\Calibration\console.logOld
C:\programdata\Tektronix\TekScope\Calibration\calSPCConst.dat
C:\programdata\Tektronix\TekScope\Calibration\caldiag.log
C:\programdata\Tektronix\TekScope\Calibration\caldiag.logOld
C:\programdata\Tektronix\TekScope\Calibration\error.log

When the utility is finished running, the zipped report file will also contain copies of all files found in the
following directories:
C:\programdata\Tektronix\TekScope\Internal\*.*
C:\programdata\Tektronix\TekScope\Calibration\CalDramDump\*.*
C:\programdata\Tektronix\TekScope\Calibration\CalDramDumpFact\*.*

Data deleted by the utility
Running this utility will delete the following files:
C:\users\<current_user>\AppData\LocalLow\Tektronix\tekScope\Internal\*.*

Because TekScope was having difficulties, some files may have been corrupted. Deleting these files will
allow TekScope to regenerate them on the next start-up. Deleting these files may resolve the initial problem.

The utility log file
You can see a log file of the operation performed by the recovery report utility at:
C:\Temp\TekScopeRecoveryReportUtility_log.txt
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Feedback
Tektronix values your feedback on our products. To help us serve you better, please send any suggestions,
ideas, or other comments you may have regarding your instrument.
Direct your feedback to us via e-mail at www.tektronix.com/home/mytek/survey.
Include the following information in the subject field: "NEW and IMPROVED Scope Customer Feedback."
Please be as specific as possible.

Recommended information to include
Instrument hardware, for example, display, chassis, and so on
Application software version
Probes

Optional information
Your name, company, mailing address, phone number, and FAX number.
What do you want to do next?
Find out what other documents are available. (see page 17)
Find out about using online help. (see page 38)
Learn how to access Tektronix Support. (see page 18)
Return to the beginning of the introduction. (see page 1)

Analysis and connectivity support
This instrument includes tools you can install to support data export for use with data-analysis tools.
You can use the analysis and connectivity tools included with your instrument to do the following:
Gather instrument data (waveforms and measurements) and port it to familiar, off-the-shelf, analysis
tools, such as Microsoft Excel
Interface with a popular software development environments, such as Lab Windows and LabVIEW
Click the following tools to find out how they can help you connect to your instrument and analyze
the data that it collects:
VXI Plug-and-Play Instrument Driver (see page 22)
TekVISA (see page 22)
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TekVISA ActiveX Control (TVC) (see page 23)
TekVISA Excel Toolbar (see page 23)
VXI 11.2 LAN Server (see page 23)
Report Generator (see page 23)
IVI Drivers (see page 23)
Tek LXI (see page 24)
For more information, see the Getting Started with OpenChoice Solutions Manual.

VXI Plug-and-Play instrument driver
The VXIplug&play instrument driver is a collection of software components, organized according
to the standard VXIplug&play model established by the VXIplug&play Systems Alliance. Use this
VXIplug&play instrument driver to simplify programming tasks when using the following software
development environments:
LabWindows/CVI
LabVIEW
MATLAB
Visual C++ 6.0
Visual Basic 6.0
HP-VEE

TekVISA
TekVISA is a library of industry-standard compliant software components, organized according to the
standard VISA model established by the VXIplug&play Systems Alliance. Use TekVISA in software
to write interoperable instrument drivers to handle communicating between software applications and
your oscilloscope. TekVISA offers the following features and benefits:
Provides end users with a consistent methodology for using instrument drivers from a variety
of vendors
Provides programmers with language interface libraries for use with multiple application
development environments, such as Microsoft C /C++, Microsoft Visual Basic, LabVIEW
graphics software using the G language, and MATLAB analysis software.
Provides a configuration utility for setting up additional VISA resources
Allows software installation and connectivity on any number of PCs
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TekVISA ActiveX Control (TVC)
The TekVISA Control (TVC) uses Microsoft Windows ActiveX control technology to simplify access
from Microsoft Office and Visual BASIC applications to TekVISA and the underlying instrument.
This is accomplished by providing support for key TekVISA features within an ActiveX control
object that is compatible with Excel’s Visual BASIC for Applications, Visual BASIC 6.0, and other
popular programming environments for Microsoft Windows.

TekVISA excel toolbar
The TekVISA Excel Toolbar allows direct, fast transfer of instrument measurements or captured
waveforms to an Excel 97 and/or Excel 2000 worksheets. Transfer is via a toolbar that is integrated
into Excel, implemented using the TekVISA ActiveX Control (TVC) and the Visual BASIC for
Applications macro editor built into Excel.
Source code for the toolbar is accessible through Excel’s built-in VBA editor for use as a learning
tool for using the TekVISA ActiveX Control, or to cut-and-paste selected components to new VB
applications.

VXI 11.2 LAN server
The VXI 11.2 LAN Server provides software connectivity between your instrument and remote PCs
over an Ethernet LAN. This tool is a client-side component built-in with TekVISA on each remote
PC, you must install another copy of TekVISA to make use of its client-side component.
The VXI-11 standard specifies a protocol for communication with devices over a network via a
network instrument server. This protocol uses the ONC/RPC (Open Network Computing/Remote
Procedure Call) standard that, in turn, is based on TCP/IP.

Report generator
Report Generator, a Microsoft Windows application, lets you create custom reports for displaying
your oscilloscope data.
Report Generator enables you to generate and print reports directly from the oscilloscope, enhancing
your application capabilities by simplifying the process of creating and maintaining reports.

IVI drivers
IVI drivers conform to specifications produced by the IVI Foundation.
Unlike VXI-plug&play drivers, IVI drivers provide a standard interface to different classes of
instruments, including oscilloscopes and spectrum analyzers.
IVI drivers have the ability to simulate instruments, automatically check ranges, and multithread
safety features.
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Tek LXI
Tek LXI conforms to the LAN eXtensions for Instrumentation (LXI) standard. The LXI standard
defines the communications protocols that allow communication with the instrument over a local
area network (LAN).

About Tekscope
From the Help menu, select About TekScope.

Overview
Provides the details of the instrument such as the model name, identification number, serial number, and
version of the software that is installed. The options name and the key details of the applications that are
installed in the instrument are also listed.
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Windows interface guidelines
Because the instrument uses the Microsoft Windows interface, you have open access to the Windows
operating system. You can access the Windows desktop to load and run other Windows-based applications
such as Microsoft Excel, WordPad, and Paint.
Although you have access to the Windows interface, you should avoid making operating system changes
that may cause problems or annoyances while trying to use the instrument. Here are some guidelines:
The instrument has been tested with the version of Microsoft Windows provided and is not intended
to operate with any other versions.
If the instrument powers on in Windows Safe Mode, the touch screen is inoperative. You may need to
use a mouse or keyboard to restore normal operation.
To keep the start-up time to a minimum, keep the network support to a minimum.
Be careful when making changes in the Control Panel. Avoid making changes to any controls with
which you are unfamiliar.
Do not change the LCD color quality (Highest 32 bit) and screen resolution settings (1024 by 768
pixels) or the video port may not work properly.
Some third-party applications may not work properly with the instrument. If your instrument stops
working after you install third-party software, try reloading the instrument software from the product
software DVD.
If you do not have an external monitor attached to the instrument, avoid changing the taskbar
properties to "Always on top" and "Auto hide." The Windows taskbar may obscure buttons or readouts
on the screen. However, if you do have an external monitor attached and the instrument is set to dual
monitor mode, you can drag the taskbar from the instrument display to the external monitor display
and use these settings.
Disable the Windows screen saver to prevent it from turning on while you are taking measurements or
viewing the display. If the screen saver comes on while taking measurements, touch the screen (if the
touch screen is installed and enabled), move the mouse, or press any key on the attached keyboard.
Do not delete or change any system fonts. Changing, removing, or resizing fonts may affect the
quality of the display and corrupt the TekScope buttons and menus.
Avoid personalizing or changing the system Display Properties, such as the theme, Background,
Appearance, Effects, or Settings. Making such changes can affect the usability of the instrument
and the touch screen.
Avoid making changes to the contents of the Windows folder or to the contents of the TekScope folder.
Avoid making changes to the BIOS settings. Changing the BIOS settings can affect the overall
operation of the instrument.
Avoid changing the Windows power management system.
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If you think that your Windows interface may cause problems with the instrument, contact your local
Tektronix support center (see page 18) for assistance.

Connecting to a network
The instrument is built on a PC-based platform that runs Microsoft Windows as its operating system. Like
any other Windows computer, you can connect the instrument to a network to enable printing, file sharing,
Internet access, and other communications functions.
Use the Windows Remote Desktop feature to remotely access the instrument.

Enabling a network connection
Use the following steps to enable network access to the instrument. You must begin this procedure
with the instrument powered off.
TIP. Consult your network administrator for further assistance.
You may want to print these instructions before you proceed.
1. Attach a keyboard and mouse to the instrument.
2. Power on the instrument.
3. Use the Windows Network Connection Wizard to define the instrument as a network client and
configure it for your network. You can find the network setup program in the Windows Start
menu if you select Settings > Control Panel, and then double-click Network Connections.
4. Consult with your network administrator for specific instructions for these settings.

Using Tek LXI
Tek LXI conforms to the LAN eXtensions for Instrumentation (LXI) standard. The LXI standard defines
the communications protocols that allow communication with the instrument over a local area network
(LAN). After the TekScope application is running, the LXI application starts. The LXI system tray icon
appears when LXI is running.
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Using Tek LXI

Right click on the icon and select Show LAN Status Indicator. LAN status is indicated in red or green
with an appropriate message.

NOTE. Pushing the LAN Reset button does a LAN configuration initialization: enables DHCP, enables
Auto-IP, enables ICMP ping responder, sets the Web password to default (No password), and updates the
LXI XML identification. Refer to the LXI specification for more information.
Enter the IP Address in the Address Bar of your Web browser and click return. The browser finds
and displays the instrument home page. Instrument information, instrument network information, and
instrument LXI information is displayed on the home page. Click on the SUPPORT Help link to see help
on the Welcome Web page.
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To display network configuration information, click on Network Configuration. The Web page displays the
network configuration, and allows you to submit changes to some of the instrument configuration. Click
on the Help SUPPORT link to see help on the configuration information.
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Using Tek LXI

Click on Datasheets, Manuals, or Driver Download to go to the Tektronix Oscilloscopes Web page to
access the information.
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NIST USGCB compliance
Tektronix oscilloscopes are compatible with the security configuration for Information Technology
products specified in the United States Government Configuration Baseline (USGCB) settings for
Windows 7 and Internet Explorer.
The National Institute of Standards and Technology (NIST) USGCB baseline operating system security
requirements (Version 1.1.x) were implemented and tested on our oscilloscopes. The oscilloscopes passed
the Security Content Automation Protocol (SCAP) tests. Our oscilloscopes operate with the USGCB
security settings implemented.
NOTE. Since the USGCB turns off the ISS server, LXI Class C compliance does not work with this data
security standard.
As shipped from the factory, your oscilloscope has none of the USGCB security settings implemented.

Making your oscilloscope compliant
To put their oscilloscope in a USGCB compliant state, follow instructions from the NIST Web site. Click
on the Content and then Microsoft Content links. Implement the settings in the GPO files found on the site.
After implementing all of the settings, run the SCAP tool to verify compliance.

Restoring your oscilloscope to its factory state
To back out of the USGCB compliant state and restore the oscilloscope to its factory condition, follow the
Operating System Restore procedures for your instrument. See you user manual.
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Hard copy printing
To make hard copies, use a printer attached to one of the rear-panel ports or connect to a network printer, if
your instrument is on a network.
You can print the full screen or just the graticule area.
The instrument uses Windows print drivers, so the process to install printers is the same as it is on any
other PC.
The Page Setup dialog box contains some useful options to optimize your printing:
Choose a print palette that is independent from the display palette. For example, you can print
gray-scale images to a black and white laser printer while you choose to view the display in color.
The color and gray scale palettes both render the intensity-graded waveform information generated
by the DPO display.
Choose the Ink Saver feature to print a hard copy with a white background. This function saves
printer ink while it preserves the color coding of the waveforms and readouts. Ink Saver also works
with the monochrome print palettes.

Other PC applications
Transferring images and data from the oscilloscope to other PC applications is as simple as a copy/paste
operation. With a word processing, spreadsheet, or analysis application running on the built-in PC, you can
easily transfer the following items using the familiar Windows clipboard system:
Copy a full screen or graticule-only image, and paste it into your document in either .bmp, .png,
.tif, or .jpg format.
Copy a waveform, and paste the waveform data into a spreadsheet in a comma-delimited (.csv) format.
Copy a waveform, and paste the waveform data into an analysis program in Mathcad (.dat) format.
Copy the displayed values of all measurements, and paste them into a document in text (.txt) format.
Copy the displayed values of all measurements, and paste them into a spreadsheet in a
comma-delimited (.csv) format.
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Second monitor use
To optimize your access to the PC that is built into the oscilloscope, connect a keyboard, mouse, and
monitor to the instrument, and then configure Windows for dual-display mode.
In this configuration, the oscilloscope retains full dynamic oscilloscope performance while Windows and
other applications such as publishing, analysis, or Web browsing tools reside on the external monitor. You
can copy/paste bitmap and waveform data from the oscilloscope to the locally running application or view
Web-based reference information while using the oscilloscope for design work.

Dockable windows
You can drag up to five dockable half-screen control windows from the TekScope application onto the
display of a second monitor. For example, this feature allows you to have the Horizontal/Acquisition,
the Horizontal Zoom, and the Display Setup Control Windows (half screen) open on the second monitor
at the same time.
In addition to the five dockable windows on the second monitor, you can have one dockable window open
on the main display. If you open a seventh dockable window, the window that has not been used for the
longest amount of time will automatically close.
To drag a half-screen control window, click and drag on the left edge of the window.

Connect to other instruments
Use the rear-panel vertical signal output (Signal Out) to connect to a buffered version of the signal
that is attached to the Channel 3 input (DPO7000C models only).
Use the rear-panel auxiliary output (Aux Out) to obtain a TTL-compatible, negative polarity pulse
when the oscilloscope triggers, or when certain other events occur, such as a mask test failure or
completion.
Use the rear-panel external reference input (Ext Ref) to synchronize the oscilloscope time base to an
external 9.8 MHz to 10.2 MHz reference frequency source.

Instrument interface
You can use the familiar knobs and buttons on the oscilloscope front panel to perform most vertical,
horizontal, and triggering functions. It allows you to make quick adjustments to your displayed signals
with the dedicated vertical controls for each channel.
The screen interface gives you access to the complete functionality of the instrument. This user interface is
built on the Windows operating system and has a similar look and feel. It is also fully compatible with a
wide range of PC hardware and software accessories, such as networked instrumentation and printers.
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Menu bar mode

The toolbar at the top of the screen is optimized for touch screen operation. Touching (or clicking) a button
on the toolbar opens a control window that you can use to select the instrument settings.

With a mouse, you may prefer to use the PC-style menu bar to open control windows or directly select
many instrument settings. Click the
button, in the upper-right corner of the screen, to switch between
Menu Bar Mode (see page 33) and Toolbar Mode (see page 34).

Menu bar mode
The menu bar menus provide access to commands that control all of the instrument features and functions.

When you select a feature setup command, the instrument displays the associated control window on the
lower half of the screen. Each control window provides access to the individual instrument controls.
The display graticule is redrawn to fit in the upper half of the screen.
What do you want to do next?
Display help on the File menu. (see page 823)
Display help on the Edit menu. (see page 818)
Display help on the Vertical menu. (see page 936)
Display help on the Digital menu. (see page 812)
Display help on the Horizontal/Acquisition (Horiz /Acq) menu. (see page 833)
Display help on the Trigger (Trig) menu. (see page 928)
Display help on the Display menu. (see page 815)
Display help on the Cursors menu. (see page 804)
Display help on the Measurement (Measure) menu. (see page 873)
Display help on the Math menu. (see page 868)
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Display help on the Mask menu. (see page 859)
Display help on the Analyze menu. (see page 936)
Display help on the Utilities menu. (see page 936)
Display help on the Help menu. (see page 38)

Toolbar mode
The toolbar buttons give you instant access to most instrument features without having to navigate
through several menus.

Click a toolbar button to display an associated control window on the lower half of the screen. Each
control window provides access to the individual instrument controls. The display graticule is redrawn
to fit in the upper half of the screen.
Not all features of the instrument are accessible from the toolbar. To access some of the less common
controls, you can change to Menu Bar Mode (see page 33). To do this, click the Menu button (with
the arrow) in the upper-right corner of the screen.
You can also customize the toolbar to add menus you use more frequently. Click the Menu button (with the
arrow) to see the list of menus you can add and to access the Customize Toolbar dialog box.
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What do you want to do next?
Display help on the Vertical Setup control window. (see page 485)
Display help on the Digital Setup control menu. (see page 89)
Display help on the Horizontal/Acquisition Setup control window. (see page 181)
Display help on the Trigger Setup control window. (see page 393)
Display help on the Display Setup control window. (see page 167)
Display help on the Cursors Setup control window. (see page 75)
Display help on the Measurement Setup control window. (see page 274)
Display help on the Math Setup control window. (see page 247)
Display help on the Mask Setup control window. (see page 215)
Display help on the Save As dialog box. (see page 535)
Display help on the Recall dialog box. (see page 528)
Learn to Customize the Toolbar. (see page 36)
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Toolbar customizing
The Customize option of toolbar mode gives you access to add or remove menu buttons, configure the
order of the menu buttons, and set the toolbar back to its default configuration. You can customize the
toolbar to view the menu buttons that you use more frequently.

To access some of the less common controls, click the Menu Bar Mode (see page 33). To do this, click the
Menu button (with the arrow) in the upper-right corner of the screen and select Customize to display the
Customize Toolbar dialog box.
Use the Up and Down buttons to move buttons within or between the Always Visible and Overflow panes.
Click the Default button to restore the default configuration on the toolbar.
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User interface map
See the next figure for a description of the elements of the user interface. These elements provide complete
control of the instrument.

1. Menu bar: Access to data I/O, printing, online help, and instrument functions.
2. Buttons or Menu bar: Click to toggle between toolbar and menu bar modes.
3. Multipurpose knob readouts: Adjust and display parameters controlled by the multipurpose knobs.
4. Display: Waveforms from live, reference, math, and digital channels display here, along with buses
and cursors.
5. Waveform handle: Click and drag to change the waveform vertical position.
6. Controls status: Quick reference to vertical selections, scale, and parameters.
7. Readouts: Display of cursor and measurement readouts in this area. You can select measurements
from the menu bar or toolbar.
8. Status: Display of acquisition status, mode, and number of acquisitions; trigger status; date; time;
quick reference to horizontal parameters.
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Online help
The online help is designed to assist you with all the features of the instrument.

Context-Sensitive help
Use the instrument online help to quickly get information about a function or assistance in performing
a task:
In Toolbar mode, click Help to display online help for the active window.
From the menu bar, click Help to display a list of help options.
If you are using the touch screen, you can touch the Help button in either mode.
The keyboard F1 function key displays help for the active window in either mode.

Microsoft Windows Help
Help is also available as part of Windows. For information about Windows features, refer to the Windows
online help by clicking Start in the Windows toolbar, and then selecting Help and Support.
What do you want to do next?
Learn how to navigate the online help. (see page 38)
Find out what other documents are available. (see page 17)
Learn how to contact Tektronix Support. (see page 18)
Provide feedback on this Tektronix product. (see page 21)
Provide information about Tekscope (see page 24)

Navigating the online help
To open the online help select Help, and then select Contents and Index. From the online help finder,
select one of the following tabs:
Contents Tab. Click any entry to display information on the subject.
Index Tab. Double-click an entry to display information on the subject. Or, enter a keyword you are
looking for (the list scrolls to that topic). Click Display to open the topic.
Search Tab. Type in the keyword you are looking for; then click List Topics. Every topic that contains
the keyword will be displayed. Select a topic, and then click Display to open the topic.
Favorites Tab. To save the current topic to the Favorites list, click the Favorites tab; then right-click
and select Add. Double-click to return to a topic at any time.
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What do you want to do next?
Find out what other documents are available. (see page 17)

ESD precautions
To avoid damage to the instrument, observe the following ESD (electrostatic discharge) precautions:
Before you apply power, connect the instrument to an electrically-neutral reference point, such as
earth ground. To do this, plug the three-pronged power cord into an outlet grounded to earth ground.
If you are working with static sensitive components, ground yourself. Static electricity that builds
up on your body can damage static-sensitive components. Wear a wrist strap to safely send static
charges on your body to earth ground.

Grounding the oscilloscope is necessary to ensure safety and to take accurate measurements. The
oscilloscope must share the same ground as any circuits that you plan to test.

Changing control settings
As you configure the instrument, you may need to set a numerical parameter such as a reference level or
delay time.
There are several different ways to set these parameters in a control window:
Touch or click the parameter to select it. Once selected, one of the multipurpose knobs (see page 40)
is assigned to the parameter.
To adjust a setting, turn a front panel upper knob (a) or lower knob (b) as indicated by the knob
graphic indicator (see page 41) next to the control window parameter.
Push the front panel Fine button to use the knob to make small changes, for example to add another
decimal place for greater accuracy.
This online help usually refers to using the multipurpose knobs to change control settings, although the
following methods are generally available:
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Some parameters with discrete values have increment/decrement buttons (see page 41). Touch or
click them to change to the next available value.
Some parameters supply a pop-up keypad (see page 42) or keyboard that you can use to enter a new
value. Some features provide other pop-up keypads (see page 43).
If you have an external keyboard attached, you can also use it to type in a new value.
You can also adjust parameter values using the mouse wheel. Press the mouse wheel to access fine
mode. Press it again to return to normal mode.

Multipurpose knobs

The multipurpose knobs on MSO/DPO5000B Series instruments are as follows:
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Graphic indicator

Increment/Decrement buttons
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Pop-up keypad
1. Double click in a data entry box, or:

Click in a data entry box.

Click on the keypad icon.

2. Use the pop-up keypad to enter data.

Sample Rate Keypad.
3. Click the Enter Button.
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Other keypads

1. 8b10b Character Keypad.

8b10b Symbol Keypad.

Moving and docking control windows
Control windows that open on the lower half of the screen can be moved to any location. To do this, move
the cursor to the upper left-most corner of the window until the hand appears. Left-click the mouse button
to grab the handle (see page 44). Hold the button and drag with the mouse to another position on the screen.
You can move freely to any position on the screen or to a second monitor (if you have set up a dual display)
by dragging the window. All controls on the window can be accessed and function as usual.
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NOTE. The window cannot be resized.

Control window handle

Controlling from within the graticule area
Use the mouse or your finger in the graticule area to click and drag (or touch and drag) the following:
An on-screen cursor to another position on the waveform.
A waveform handle (see page 45) to change the vertical position of a waveform.
A waveform label (see page 45) or other screen text that you have entered to reposition it.
The horizontal reference marker (see page 45) to set the horizontal position.
The trigger level marker (see page 45) to set the trigger level.
You can also click and drag (or touch and drag) across part of a waveform to select it and investigate it
further. Once the selection is made, choose one of the following actions:
Create a Zoom waveform that covers just the selected area
Create a histogram to analyze the selected area
Turn on measurement gates that take measurements only in the selected area
Create a visual trigger area.
Cancel the selection
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Waveform handle

Waveform label

Horizontal reference marker

Trigger level marker

Accessing shortcut menus by right-clicking
You can right-click to gain quick access to most common commands.
Right-click on a graticule, an object, or a readout to access their shortcut menus. The menus are dynamic;
their contents will vary, depending on the area or the object you right click.
You can right-click on any of the following to open a dynamic shortcut menu:
Waveform handle
Cursors
Labels
Histogram display
Masks
Templates

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

45

About Tektronix oscilloscopes

Creating your own control windows

Trigger level marker
Visual trigger area
Readouts (the menu varies with the type of readout)
Graticule
Control window
Entry boxes
Regions (Menu bar, Toolbar, Multipurpose Knobs)

Creating your own control windows
For quick access to the controls that you use most often, you can create your own MyScope control
window (see page 387). Choose from a list of controls to include, and make each control window
unique to your needs.
MyScope allows you to have up to eight tabs in a control window, increasing the flexibility and ease of use
for your unique MyScope control windows. You can create and save any number of control windows for
future use.

Initialize the instrument
After you complete a task, you may want to initialize the instrument settings before using the instrument
with your next task. This may be especially important if you share the instrument with others; previous
settings may make it difficult for you to perform the required task.
To quickly restore the instrument to its default settings, push the front-panel Default Setup button.
If data security is important to you, use the TekSecure Erase feature to overwrite all internal waveform and
setup memory with null values.
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Choosing and connecting probes
CAUTION. To avoid damage to the instrument, observe ESD (electrostatic discharge) precautions (see
page 39).
Choose from a wide variety of passive, active, and specialty probes to use with your instrument. The
instrument automatically configures the input impedance when you attach a probe that is compatible
with the TekProbe or TekVPI interface.
Remember the following when connecting a probe:
For most passive probes, adjust the low-frequency compensation after you connect them to a channel
input.
To compensate for gain (and offset) error in many probes, connect the probe tip to the probe
compensation connectors; then execute the built-in compensation procedure to optimize system
accuracy.
To compensate for propagation delay differences between voltage probes using the probe deskew
feature, attach up to two probe tips at a time to the probe compensation terminals; then execute the
deskew procedure to time align the display for each channel. The deskew adjustment range is ±75 ns.

Triggering, timebase, and horizontal delay
The architecture of an analog oscilloscope requires its time bases and triggering to be linked. The main
trigger triggers the main time base, and then you can use a delayed trigger to trigger a delayed time base.
Many digital oscilloscopes have also been designed using this traditional, but complex, paradigm.
This instrument uses a simpler paradigm that cleanly separates the concepts of triggering and time bases.
You can still do everything that you could with an analog oscilloscope and more. Now these features
are easier to set up and use.
The trigger event can be simple or complex. Examples of a simple trigger are the rising edge of the
Channel 1 signal or a glitch narrower than 10 ns on Channel 2. You can set up a complex trigger where the
trigger system is armed by a condition on one channel and then is triggered by a condition on another
channel. In either case, simple or complex, there is just one trigger event.
The time base can be either delayed or not delayed. If it is not delayed, acquisition occurs surrounding the
trigger event depending on the amount of pretrigger (see page 48) and posttrigger (see page 456) data that
you have selected. If you turn on horizontal delay, you can delay the acquisition to a point well beyond the
trigger event (similar in effect to a delayed time base). By alternately turning horizontal delay on and off,
you can make quick, detailed comparisons between two segments of a signal that are separated from each
other by a fixed amount of time. In any case, the time base is always triggered by one trigger event.
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Pretrigger data
The data points of the waveform acquired and displayed before the trigger event. You can set the
amount of pretrigger data with the Horizontal Position control.

Looking at waveform details
Use the instrument Zoom function to magnify an acquisition vertically, horizontally, or in both dimensions
to let you see the fine detail in your signals. The MultiView Zoom function affects only the display,
not the actual waveform that is being acquired.

Set up Zoom
The fastest way to set up a MultiView Zoom display is to click (or touch) and drag across the segment of
the waveform that you want to see in greater detail. Then, when you touch or click the on-screen Zoom
menu item (see page 49), that waveform appears in the Zoom (lower) graticule, while the entire waveform
appears in the Acquisition (upper) graticule. Markers in the main graticule give you position context
for what you are seeing in the Zoom graticule.
Another way to set up the MultiView Zoom function is to push the front-panel Multiview Zoom button
(see page 49). Then you can set parameters in a control window to focus your Zoom waveform on the
signal segment of interest.
NOTE. If zoom is on but the readouts are not attached to the zoom controls, press the MultiView Zoom
button to attach the readouts to the zoom controls. Press the MultiView Zoom button again to turn zoom off.
To see more waveform detail you can also use horizontal delay (as described in the previous topic) (see
page 49) to focus the acquisition on a segment of a waveform separated from the trigger event by a
significant interval of time. This technique lets you increase the horizontal resolution (sample faster) on a
segment of a signal, even when you cannot trigger on that particular segment.

Zoom function
The Zoom function also allows you to zoom on multiple areas of a waveform or on multiple waveforms
simultaneously. You can lock the zoomed areas and scroll through them together or unlock the zoomed
areas and scroll through them independently.
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Looking at waveform details

On-screen MultiView Zoom menu item

Front-panel MultiView Zoom button

Triggering, timebase, and horizontal delay
The architecture of an analog oscilloscope requires its time bases and triggering to be linked. The
main trigger triggers the main time base, and then you can use a delayed trigger to trigger a delayed
time base. Many digital oscilloscopes have also been designed using this traditional, but complex,
paradigm.
This instrument uses a simpler paradigm that cleanly separates the concepts of triggering and time
bases. You can still do everything that you could with an analog oscilloscope and more. Now these
features are easier to set up and use.
The trigger event can be simple or complex. Examples of a simple trigger are the rising edge of the
Channel 1 signal or a glitch narrower than 10 ns on Channel 2. You can set up a complex trigger
where the trigger system is armed by a condition on one channel and then is triggered by a condition
on another channel. In either case, simple or complex, there is just one trigger event.
The time base can be either delayed or not delayed. If it is not delayed, acquisition occurs surrounding
the trigger event depending on the amount of pretrigger (see page 48) and posttrigger (see page 456)
data that you have selected. If you turn on horizontal delay, you can delay the acquisition to a point
well beyond the trigger event (similar in effect to a delayed time base). By alternately turning
horizontal delay on and off, you can make quick, detailed comparisons between two segments of a
signal that are separated from each other by a fixed amount of time. In any case, the time base is
always triggered by one trigger event.
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Using fast acquisition and DPO
When you turn on FastAcq (see page 50), you can acquire up to 250,000 waveforms per second. In fast
acquisition mode, the dead time (see page 51) between acquisitions can be very short, approaching that of
the finest analog oscilloscopes. Reduced dead time means that your chances of capturing an infrequent
event are greatly improved. More time is spent acquiring and displaying your signal. And with the digital
phosphor (DPO) technology, you can easily differentiate between the normal shape of your signal and
that infrequent anomaly that you want to capture.
As a comparison, high quality analog real-time oscilloscopes (see page 50) can sweep at high repetition
rates with little dead time between sweeps, which makes it possible to capture an infrequent event.
Typical digital oscilloscopes (DSOs) (see page 51) have relatively long dead times between acquisitions;
infrequent events are much more difficult to capture. With fast acquisition and digital phosphor technology,
the oscilloscope acquires at a high repetition rate and then overlays the acquired information into a
three-dimensional database that is updated on the display 30 times per second.
The digital phosphor oscilloscope shows you not only the displayed waveform, but also the sample
density. You can choose to see sample density represented in a color palette or as shades of gray or shades
of green. The DPO display in monochrome green bears a strong resemblance to the CRT of a high-quality
analog oscilloscope. When you increase waveform brightness with the front-panel Intensity knob, areas of
lower sample density appear more clearly.
DPO provides display benefits, whether fast acquisition is on or off. When it is on, DPO helps you
identify an infrequent anomaly in a repetitive signal, especially when either the spectral or temporal color
palettes are used. The repetitive signal appears in one color and the anomalies appear in another. When
fast acquisition is off, DPO improves the waveform display quality when long records are compressed
for display with the 1000 horizontal pixels in the graticule. The compression algorithm works with the
intensity-graded display to show brighter pixels where many points have been compressed and dimmer
pixels where fewer points have been compressed.

Fast acquisition

Analog oscilloscope sweeps
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“Dead time” between acquisitions

Typical DSO acquisitions
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Using logic waveforms
NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
The instrument can display logic waveforms of analog or digital signals in bus views with bus decoding.
You can use digital, analog, and math waveforms to define up to 16 buses (serial or parallel) in the Bus
Setup window.
You can use a logic probe to connect the D15-D0 channels to signals in your system under test. If you
need more than 16 digital channels in a bus, you can designate Ch1-Ch4 and Math1-Math4 to be logic
waveforms in the Bus Setup window.
The instrument acquires and displays data from digital signals as follows:
Stores a high or low state of the logic waveform for each sample. You can set the voltage threshold
level on individual channels.
Depicts data as a waveform, a busform, or both.
Decodes data as numeric or symbolic values.
Displays a logic high level as green and a logic low level as blue.
Color codes the channel labels and on-screen indicators for the D15-D8 and the D7-D0 channels that
follow the color code used on the logic probes.
Adds custom labels for easier channel-to-signal identification.
Uses iCapture to display the analog view of up to four signals connected to the logic probe. If you
want to see the analog characteristics of signals connected to the logic probe, you can assign up to four
of the D15-D0 channels to the Ch1-Ch4 function with iCapture.
NOTE. iCapture is available on MSO70000C/DX Series instruments.
What do you want to do next?
Learn about iCapture. (see page 809)
Learn about bus setups. (see page 97)
Learn about digital setups. (see page 89)
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Using waveform math
Waveform math in the instrument can be as simple as basic arithmetic or as powerful as building a
complicated math expression.

Equation editor
You can build a complicated math waveform expression using multiple waveform sources, constants,
variables, operators, and functions. The waveform sources can be any channel, reference, or math
waveform.
You can enter constants with a keypad. Live results from the measurement system can be used as variables,
and there is a full assortment of arithmetic operators and math functions to use. As you enter the waveform
expression, you will see it appear as an equation in the control window.
You can define up to four separate math waveforms.

Using spectral analysis
When you are displaying an FFT (spectral) math waveform, you can use either of these two ways to
operate the instrument:
Use the conventional time-domain instrument controls, such as vertical and horizontal position and
scale.
Use the spectrum analyzer controls, such as center frequency, span, resolution bandwidth, and
reference level.
When you use the Basic Spectrum Analyzer controls, the instrument automatically sets its time domain
parameters, including record length and sample rate, as necessary to give you the view of the spectral
waveform that you want to see. You can switch back to using the conventional time-domain controls
at any time.
Spectral waveforms can be simple magnitude or phase waveforms calculated from the data acquired on
a single channel. Or you can combine spectral operations with other math operations to do complex
analysis of your signals.
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Characterizing a signal
Signal characterization begins with taking measurements. To gain even more insight into your
measurements, you can add measurement statistics to calculate the average measurement value, the
standard deviation, and the maximum range of the measurement value.
Another way to characterize a signal is to compile a histogram from the acquired waveform. You can set
up either a vertical histogram to analyze amplitude values or a horizontal histogram to analyze timing.
For example, the vertical histogram is useful for characterizing noise and the horizontal histogram is
useful for characterizing jitter.
While the histogram is being compiled from the acquired waveform, you can take continuous
measurements on the histogram data to determine its mean value and other useful statistics.
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Application-Specific measurements
You can load optional measurement extensions as needed to enhance the capabilities of the instrument
for specific applications. These applications build on the precision signal acquisition performance of the
instrument to address your specific design requirements.
Here are some examples of the application packages:
Jitter and Timing Analysis. Use the DPOJET software to characterize the timing performance
of semiconductor systems. Analyze clock jitter, setup and hold times, and many other timing
measurements on a cycle-by-cycle basis over long, single-shot acquisitions. Measurement statistics are
presented as numerical statistics, or graphically in a histogram, cycle trend, time trend, or spectral plot.
Ethernet Compliance Testing. Use the ET3 software to perform 10/100/1000 Base T Ethernet
compliance testing.
USB Signals. Use the USB or USB3 software to characterize USB 2.0 or USB 3.0 universal serial bus
signals, including mask testing and parametric testing.
Power Measurements. Use the DPOPWR software to quickly measure and analyze power dissipation
in power supply switching devices and magnetic components.
DDR Memory Bus Analysis. Automatically identify DDR1, LP-DDR1 DDR2, DDR3, and GDDR3
Reads and Writes and make JEDEC conformance measurements with pass/fail results on all edges in
every Read and Write burst.
MIPI® D-PHY Characterization and Compliance Testing. Verify to the D-PHY specification,
rapidly characterize and discover sources of jitter and signal integrity concerns.
SignalVu™ Vector Signal Analysis. Easily validate wideband designs and characterize wideband
spectral events.
CAN and LIN Timing and Protocol Decode Software. When you need to ensure seamless and
reliable operation of a CAN or LIN network, this option enables CAN bus triggering and provides
the solution to measure oscillator tolerance, propagation delay, and simultaneously decode CAN and
LIN messages, with the protocol leveraging the trigger capabilities.
8b10b Serial Triggering and Analysis. Use the 8b10b software to trigger on and analyze 8b10b
serial bus signals.
Additional packages may be available. Contact your Tektronix representative for more information.
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Front panel overview

Front panel overview
The instrument features the following front-panel controls and connectors.
For all DPO7000C, MSO/DPO70000C, and MSO/DPO70000DX models:
1. DVD/CD-RW drive
2. Front-panel controls
3. USB port
4. Ground terminal (see page 60)
5. Recovered data output
6. Recovered clock output
7. Probe compensation output (see
page 58)
8. PROBE CALIBRATION output
(see page 59)

Only for MSO5000B and DPO5000B models:

9. Channel 1 - 4 inputs (see
page 59)
10. Auxiliary trigger input (see
page 59)

For DPO7000C Series models:
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For DPO70000C models:

11. Fast Edge output used for probe
compensation (see page 58)
12. DC Probe Cal output

For DPO70000DX models:

For MSO70000C models:
13. Logic probe input (see page 59),
inactive on DPO models. MSO
capabilities are available as
a user upgradeable option on
DPO70000DX instruments.
On / Standby switch (see
page 59)
For MSO70000DX models:

For MSO5000B and DPO5000B models:
14. Clear button
15. Save/Recall buttons
16. Digital Channel setup menu
17. Menu Off button
18. Print screen image button
xxx

Probe Compensation output
Use the Probe Compensation output to compensate or deskew passive probes or active voltage probes.
On some models, this is the Fast Edge output.
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Front panel overview

Probe Calibration output
Use the Probe Calibration output to calibrate or deskew passive or active voltage probes.

Channel 1–4 inputs
You can connect up to four probes to the inputs of the instrument. Each vertical input channel has its
own vertical control settings. Each probe input channel has its own TekProbe/TekVPI interface.

D15–D0 inputs
You can connect one logic probe to the logic port on the front of the instrument. Each digital channel
has its own control settings.

Auxiliary trigger input
The trigger level range for the Auxiliary Input is adjustable.

On/Standby switch
Use this button to power on the instrument or to set the instrument to standby.

Before shutting down, it is recommended that you first exit the instrument application and any other
active Windows applications to avoid error messages on shutdown or the next power up.
TIP. To exit the instrument application and shut down in one step, select Shutdown in the File menu.
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Touch screen

Ground terminals
Use these terminals to connect the instrument to the same ground as the unit under test, and if you are
working with static sensitive components, ground yourself. Static electricity that builds up on your
body can damage static-sensitive components. Wear a wrist strap to safely send static charges on
your body to earth ground.

Touch screen
You can use touch to control the instrument in addition to the front-panel controls, toolbar buttons, and
menu options. Generally, touch can be used anywhere that click is mentioned in this online help.
To disable the touch screen, push the front-panel Touch
Screen button. When the touch screen is off, the button
is lighted. You can still access the on-screen menus with
a mouse or keyboard.
xxx

To adjust the touch screen operation to your personal preferences, select Touch Screen > Calibrate from
the Utilities menu.
NOTE. If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You may
need to use a mouse or keyboard to restore normal operation.
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Wave Inspector controls

Wave Inspector controls
NOTE. Wave Inspector Controls are available only on MSO/DPO5000B Series instruments.
The Wave Inspector controls (zoom/pan, play/pause, mark, and search) help you to efficiently work with
long record length waveforms.
Use Measure to perform automated measurements,
Search to search through an acquisition for user-defined
events/criteria, or DPX/FastAcq to start or stop fast
acquisitions.

Push
to turn on MultiView Zoom and add a
magnified graticule to the display.
Zooming a waveform: Enable or disable the zoom mode
by pushing the zoom button. Rotate the inner knob on the
Pan-Zoom control clockwise to zoom in on a selected part
of the waveform. Rotate the knob counterclockwise to zoom
back out.
Use the Pan knob to scroll through a zoomed waveform.
Panning a waveform: Rotate the pan (outer) knob of the
pan-zoom controls to pan the waveform. Turn the knob
clockwise to pan forward. Turn it counterclockwise to pan
backwards. The further you turn the knob, the faster the
zoom window pans.
Use the play-pause knob
to automatically pan
through a waveform record.
Playing and Pausing a Waveform: Enable the play-pause
mode by pushing the play-pause button. Adjust the play
speed by turning the pan (outer) knob further. The further
you turn it, the faster it goes.
Use to search and mark waveforms, to establish or delete a
waveform mark, or to jump to the previous or next waveform
mark.
xxx
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Vertical controls

Vertical controls
Use the Vertical controls to adjust the vertical display parameters of live data channels connected to the
vertical inputs. Each input channel has identical controls.
Use the dedicated channel (Ch <1–4>) buttons to turn
channel displays on and off. The channel button is lighted
when the selected channel is on.
Use the dedicated push-to-toggle Position/Offset and
Scale knobs to adjust the vertical position and scale of the
waveform.

NOTE. The Offset button is not available on
MSO/DPO5000B Series instruments.
For channel waveforms (waveforms connected to the
vertical inputs), the scale setting controls the vertical size of
the acquisition window (see page 62) as well as the display
scale. The range and resolution of the scale value depends
on the attached probes and on any other external factors
you have specified.
For reference or math waveforms, the scale setting controls
the display only. Scaling these waveforms has no effect
on the acquisition hardware.
Use the front panel controls to display the math (M),
reference (R), bus (B), or vertical (V) setup menus.

NOTE. The M, R, B, V buttons are available only on
MSO/DPO5000B Series instruments.

xxx

Acquisition window
This window defines what data is removed from the input signal to form a waveform record.
The vertical scale and offset set the vertical size and the vertical center of this window independently
for each channel. The horizontal scale and position set the horizontal size and positions for all
channels in parallel.
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Horizontal controls

Horizontal controls
Use the Horizontal controls to adjust the horizontal parameters of waveforms. The horizontal controls
globally affect all displayed waveforms.
Use the dedicated Position knob to adjust the horizontal
position of all waveforms. Use this knob to adjust the trigger
point so that you can select the amount of pretrigger data
or posttrigger data. In Delay Mode, this knob can be used
to set the delay time.
Use the dedicated Scale knob to adjust the horizontal scale
(time base) of all channel waveforms.

Use the Resolution knob to change the number of acquired
points (record length, in the Automatic and Constant Sample
Rate horizontal modes. The actual resolution cannot be
set directly but is derived and displayed on the horizontal
readouts.

NOTE. The Resolution knob is not available on
MSO/DPO5000B Series instruments.
Push the Delay button to turn on horizontal delay, and
then use the Position knob to set the delay time. Delay is
useful when you want to acquire waveform details that are
separated from the trigger event by a significant interval
of time.

NOTE. The Delay button is not available on
MSO/DPO5000B Series instruments.
xxx

Trigger controls
Use the Trigger controls to set basic trigger parameters.
By default, the instrument uses the Edge trigger. To return to the Edge trigger from any other
A (main) event trigger, push the Edge button. Pushing this button does not open the Edge
Trigger control window unless another A event trigger is already displayed.

NOTE. The Edge button is not available on MSO/DPO5000B Series instruments.
To select other trigger types, push the Advanced button. In the Trigger control window, click
the Select button to choose one of the other trigger types.
Select the trigger source (see page 64) for the Edge trigger by pushing the left or right
arrow buttons until the desired Source is lighted. These buttons are only valid for the A
event Edge trigger.
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Trigger controls
Select Trig in the menu bar to open the Trigger control window. Use the Coupling drop-down
menu to select trigger coupling (see page 64) for an A event or B event Edge trigger.
To open the Trigger control window, push the Menu button (Available only on MSO/DPO5000B
Series instruments only).
Push the Force Trig button for the running trigger (Available only on MSO/DPO5000B Series
instruments only).
Push the button in the Slope column to toggle between positive, negative, or both trigger
slopes (see page 65) for the Edge trigger. The selected trigger slope(s) are lighted. These
buttons are only valid for the A event Edge trigger.

NOTE. The trigger slope selection button is not available on MSO/DPO5000B Series
instruments.
Push the button in the Mode column to toggle between Normal (see page 65) (Norm) and
Auto (see page 65) (Automatic) modes; the selected trigger mode is lighted.

NOTE. The trigger mode selection button is not available on MSO/DPO5000B Series
instruments.
Push the Level knob to set the trigger level to 50%. To set a different trigger level (see
page 65), rotate the Level knob. The trigger level appears on the screen. The trigger level
knob affects Edge, Width, Glitch, Timeout, Serial, Video and some Communications trigger
types.
xxx

Trigger source
The trigger source determines the source of the trigger signal. The input channels are the most
commonly used trigger sources and are available for all trigger types.

Trigger coupling
The trigger coupling determines what part of the signal is passed to the trigger circuitry. All trigger
types except edge triggering use DC coupling only. Edge triggering can use all available coupling
choices.
DC. This coupling passes all input signals to the trigger circuitry.
AC. This coupling passes the input signals above 60 Hz to the trigger circuitry.
HF Reject. This coupling attenuates signals above 50 kHz before passing the signal to the trigger
circuitry.
LF Rej. This coupling attenuates signals below 80 kHz before passing the signal to the trigger
circuitry.
Noise Rej. This coupling provides stable triggering by increasing the trigger hysteresis. Increased
hysteresis reduces the trigger sensitivity to noise but may require greater signal amplitude.
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Trigger controls

Trigger slope
The trigger slope determines whether the instrument finds the trigger point on the rising edge, falling
edge, or both edges of the signal.

Normal trigger mode
Normal trigger mode causes the instrument to wait for a valid trigger event before displaying
waveform data. Normal trigger mode is most useful during single-shot acquisitions.

Trigger level
The trigger level determines the voltage level where the trigger point occurs.
Adjust the trigger level with the front-panel Level knob.
Click in the Level entry box in a Trigger control window and use the multipurpose knob to adjust
the level.

Auto trigger mode
Auto trigger mode causes the instrument to trigger if a valid trigger event does not occur within
a set amount of time.
Auto trigger mode is useful when probing DC signal levels such as power supplies or logic levels that
are stuck high or low. It is also useful when looking for activities on signal nodes such as oscillations
when you first set up the instrument. The length of time it waits for a trigger event depends on
the time base setting.
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Run controls

Run controls
Use the Run controls to start, stop, and to monitor the status of acquisitions.

Push the Run/Stop button to start and stop acquisitions.
Push the Run/Stop button once to stop the acquisition.
Push the Run/Stop button a second time to begin acquisitions again.
Push the Single button to exit Run mode and start a single sequence of acquisitions.
Push Clear to remove any acquired data.
In Sample, Peak Detect, or High Res mode, the instrument acquires a waveform record with
the first trigger event and then stops.
In Envelope, Average, or WfmDB mode, the instrument makes the specified number of
acquisitions to complete the averaging or enveloping task, and then stops.
xxx

The Acquisition Status readouts, and lights on some instruments, indicate the state of the acquisition.
Arm indicates the instrument is filling the pretrigger portion of the waveform record.
Ready indicates the instrument can accept a valid trigger event and is waiting for the trigger
event to occur.
Trig’d or Triggered indicate that instrument has recognized a valid trigger and is filling the
posttrigger portion of the waveform.
When Arm, Ready, and Trig’d are not on, the acquisitions have stopped.
When Ready and Trig’d are both on, the instrument has recognized a valid trigger and is
waiting for a delayed trigger. When the instrument recognizes a delayed trigger, it will fill
in the posttrigger portion of the waveform.
xxx
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General purpose controls

General purpose controls
Use the following front-panel controls to perform general-purpose tasks such as to Autoset the instrument,
to send items to the printer, or to enable cursors.
Push the Autoset button to automatically set up the instrument to obtain and display a stable
waveform of usable size. For information on the Autoset default settings click Autoset (see
page 189).
Push the Default Setup button to reset the instrument to the factory default settings.

Push the Menu Off button to turn off a displayed menu.

NOTE. Menu Off is available only on MSO/DPO5000B Series instruments.

Push the Print button to make a hard copy of the screen. The printed image is sent directly to
the selected (internal or attached) printer. To change the print settings, click the File menu
Print command, and change the settings in the Print dialog box.
Push the Cursors button to enable cursors on the screen. The Cursor Type control window
(see page 75) opens so that you can specify the cursor parameters.

NOTE. If cursors are on but the multipurpose knob readouts are not attached to the Position
controls, press the Cursors button to attach the controls to the readouts. Press the Cursors
button again to turn cursors off.
Push the Search and Mark buttons to find and place a mark on a waveform at a point of
interest, or to edit marks. You can return to a mark and analyze the waveform at a later time.

Push the FastAcq DPX button to turn Fast Acquisition On or Off. The FastAcq button is
lighted when Fast Acquisition is turned on.
Use the Intensity knob to adjust the brightness of the waveform. High intensity settings show
less frequently acquired points more clearly.

xxx
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MultiView Zoom controls

MultiView Zoom controls
Push the front panel MultiView Zoom button to do the following:
Open a magnified window or windows in the upper half of the screen.
Open the Zoom control window (see page 487) to set the position and factor of the selected
waveform in the Zoom window, select the Zoom Area and Source, and lock and scroll the
zoomed areas.
Assign the multipurpose knobs to the horizontal or vertical position and scale controls in the
Zoom graticule.
xxx

NOTE. If zoom is on but the multipurpose knob readouts are not attached to the zoom Position and Factory
controls, press the MultiView Zoom button to attach the controls to the readouts. Press the MultiView
Zoom button again to turn zoom off.
The MultiView Zoom button is lighted when the Zoom mode is on.

Rear and side panel connectors
The instrument features the following rear and/or side panel connectors:
Use the PS-2 connectors to connect a PS-2 keyboard or a mouse to the
instrument.

Use the USB connectors to connect a USB mouse, a keyboard, or other
USB devices to the instrument.

NOTE. Plug USB devices directly into the USB connectors on the
instrument to improve reliability rather than connecting the devices
serially. If the USB mouse locks up, disconnect and reconnect the USB
connector to restore normal operation. If the instrument front panel and/or
touch screen do not respond, press the On/Standby switch for 5 seconds
to cycle power.
Use this VGA port to connect a monitor for extended desktop operation.
For example, use the front panel to display the contents of the instrument,
and use an additional monitor for Windows operation.

NOTE. This port is available on all instruments except MSO70000C and
DPO70000C Series instruments.
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Rear and side panel connectors
Use the COM 1 serial port to connect to other devices through the serial
port.

NOTE. The COM1 port is available on all instruments except
MSO/DPO5000B Series instruments.

Use the COM 2 serial port to connect to other devices through the serial
port.

NOTE. The COM2 port is not available on some instruments.

Use the RJ-45 connector to connect the instrument to a network.

Use the Audio ports for stereo microphone input and stereo line output.
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Rear and side panel connectors
For MSO/DPO5000B and DPO7000C instruments:
Use the AUX TRIG OUT / REF OUT connector to obtain a TTL-compatible,
negative polarity pulse when the instrument triggers.
Use the CH 3 OUT connector to connect to a buffered version of the signal
that is attached to the Channel 3 input. The amplitude is 50 mV/div ±20%
into a 1 MΩ load, or 25 mV/div ±20% into a 50 Ω load.
Use the EXT REF IN connector to synchronize the instrument time base
to an external 9.8 – 10.2 MHz reference frequency source. When not
using the external reference, disconnect signals from the EXT REF IN
BNC connector.

AUX OUT

REF OUT EXT

REF IN

For MSO/DPO70000C and MSO/DPO70000DX instruments:
Use the AUX OUT connector to obtain a TTL-compatible, negative polarity
pulse when the instrument triggers or when certain other events occur,
such as a mask test failure or completion.
Use the REF OUT connector to obtain a copy of the internal reference.
Use the EXT REF IN connector to synchronize the instrument time base
to an external 9.8 – 10.2 MHz reference frequency source. When not
using the external reference, disconnect signals from the EXT REF IN
BNC connector.
For MSO/DPO5000B instruments:
Use the Probe Power to input the probe power.
Use the REF IN to input the external reference. When not using the
external reference, disconnect signals from the REF IN BNC connector.
Use the AUX OUT connector to obtain a TTL-compatible, negative polarity
pulse when the instrument triggers or when certain other events occur,
such as a mask test failure or completion. You may also set the AUX OUT
connector to obtain a copy of the internal reference.
Use the GPIB connector to connect the instrument to a GPIB controller
for GPIB operation.

NOTE. The GPIB connector is available on all instruments except
MSO/DPO5000B Series instruments.
This connector is not used.
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Rear and side panel connectors
Use the DVI-I Video port (some instruments have a DVI-D Video port) to
send the instrument display to a projector or to a flat-panel LCD monitor.

NOTE. This port is available only on MSO70000C/DX, DPO70000C/DX,
and DPO7000C Series instruments.
Use the eSATA port as an external interface for SATA support devices.

NOTE. This port is available only on MSO70000C/DX, DPO70000C/DX,
and DPO7000C Series instruments.

xxx
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Cursor setup control window (YT display format)

Cursor setup control window (YT display format)
From the Cursor menu, select Cursor Setup.

Overview
Use the Cursor Setup controls to configure cursor parameters. The available controls vary depending on
the Display Format (see page 174) and the rest of the cursor window settings.
NOTE. Cursor measurements on digital channels require that at least one analog channel be displayed.
Alternatively, to take a measurement of a digital channel, you can first send the waveform acquired on the
digital channel to an analog channel using iCapture.
This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
For information on the controls, click the buttons.

To use
1. Click the Cursor button to turn cursors on and off.
NOTE. If cursors are on but the readouts are not attached to the cursor controls, press the Cursors button
to attach the readouts to the cursor controls. Press the Cursors button again to turn the cursors off.
2. To select the cursor Track Mode, click either the Indep (independent) or Tracking button.
3. Select a cursor type by clicking one of the Cursor Type buttons.
4. Select the waveform you want to measure from the Source drop-down lists. Cursor 1 and Cursor 2
each have their own source.
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Cursor setup control window (YT display format)

TIP. If are using H Bar or V Bar Cursors and want the cursor source to be the same for both cursors, set
the source for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you change it.
5. Click in the Position entry boxes to map the cursors to the multipurpose knobs, and then use the
knobs to move the cursors.
6. Select a Line style from the drop-down list. Line styles are available for all cursor types.
7. Select a Symbol style from the drop-down list. Symbol styles are only available on Waveform and
Screen cursors.
NOTE. If you are using XY or XYZ display format, you can also select the type of readout from the XY
Readout Type drop-down list. Only Waveform and Screen cursors are available in the XY or XYZ display
format.
TIP. The Cursors menu Cursors On command can also be used to toggle the cursors on and off. The
cursors are on when a check mark appears next to this command.

Behavior
When cursors are turned on, the front panel Cursors button illuminates.

Track mode
Indep (Independent) moves the cursors independent of each other.
Tracking moves Cursor 1 and Cursor 2 in tandem. However, moving Cursor 2 does not move Cursor 1.

Style
Applies only to Waveform and Screen cursors. The Line & X symbol style displays only an X when used
with waveform cursors in XY display mode such that the vertical line is not drawn, only the X.
If you change the display format to XY when H Bar cursors are enabled, the cursor type will change to
Screen. In normal acquisition mode, changing the display format to XY when V Bar cursors are enabled,
changes the cursor type to Waveform.
TIP. To turn the cursors off, push the front-panel Cursors button.
What do you want to do next?
Go to a step-by-step procedure for taking cursor measurements. (see page 605)
Learn about the cursor types. (see page 80)
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Cursor type control window

Learn about Cursor Readouts in XY display format. (see page 77)

Cursor type control window
From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

Overview
Use the Cursor Type control window to select the source for each cursor and the type of cursors used
for waveform measurements.
For information on the controls, click the buttons.

To use
1. Click the Source drop-down list to select the source for the cursor.
2. Click one of the Cursor Type buttons to select a cursor type.
TIP. Select a cursor type directly from the Cursors menu Cursor Type submenu.

Behavior
If you are using H-Bar or V-Bar Cursors, and want to measure the same waveform with both cursors,
select the waveform for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you change it.
Click Setup to open the Cursor control window where you can specify other cursor parameters.
What do you want to do next?
Learn about the Cursor Position controls. (see page 79)
Learn about the Cursor Setup controls. (see page 73)
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Cursor sources (YT display)
From the Cursor menu, select Cursor Setup.

Overview
Use these controls to define the source for both Cursor 1 and Cursor 2 for any cursor type.

To use
1. Click the Source drop-down list to select the measurement source for the cursor.
2. Click in an X Position entry box and use a multipurpose knob to adjust the position of the cursor.

Behavior
If the cursor type is V Bars or H Bars, setting the Cursor 1 source sets the Cursor 2 source to the same
value. To have different sources for Cursor 1 and Cursor 2, set the Cursor 1 source first, and then set the
Cursor 2 source.
NOTE. Only Screen Cursors have both an X and Y Position controls.
The Multipurpose Knobs Adj buttons appear only with Screen cursors. Click the Adj buttons to assign the
multipurpose knobs to the X-axis and the Y-axis controls.
What do you want to do next?
Learn about cursor types. (see page 75)
Learn about cursor styles. (see page 77)
Learn about Cursor Readouts in XY display format. (see page 77)
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Cursor style

Cursor style
From the Cursor menu, select Cursor Setup.

Overview
Use these controls to change the appearance of the cursors.

To use
1. Select a Line style from the drop-down list: Solid, Dashed, or Solid and Dashed.
2. Select a Symbol style from the drop-down list: Lines, Line & X, or X.
NOTE. Symbol styles are only available for Waveform (see page 82) and Screen (see page 83) cursors.
If you are in XY display format, you can also select the XY Cursor Readout from the drop-down list.

Behavior
Cursor positions are displayed according to line style, symbol style, cursor type, and waveform display
format. See the following table. The Line & X symbol style displays only the X when used with waveform
cursors in XY display mode. (The vertical line is not drawn.)
Symbol style

Cursor type

Display format

Cursor position

Lines

Waveform and Screen

YT

Intersection of horizontal
and vertical lines. Default
style for Screen cursors.

Line & X

Waveform and Screen

YT

Horizontal position is
shown by a vertical line, the
Y-axis is shown by an X.
Default style for Waveform
cursors in YT mode.

X

Waveform and Screen

XY

Single X indicates the
horizontal and vertical
position. Default style for
Waveform Cursors in XY
mode.

xxx

Cursor readouts are displayed based on the selection in the XY cursor Readout drop-down list. This list is
only available for Waveform and Screen cursors when you are using XY display format.
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XY cursor readout

Cursor type

Display format

Cursor position

Rectangular

Waveform and Screen

XY

Shown as rectangular
coordinate positions. There
are nine readouts for
Waveform cursors and six
for Screen cursors.

Polar

Waveform and Screen

XY

Shown as polar coordinate
positions. There are nine
readouts for Waveform
cursors and six for Screen
cursors.

Product

Waveform and Screen

XY

Shown as rectangular
coordinates and the X
vertical value is multiplied
by the Y vertical value.
There are six readouts
for Waveform cursors and
three for Screen cursors.

Ratio

Waveform and Screen

XY

Shown as rectangular
coordinates and the Y
vertical value is divided by
X vertical value.

xxx
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Cursor position control window

Cursor position control window
From the Cursor menu, select Cursor Position.

Overview
Use the Cursor Position control window to position the cursors with the multipurpose knobs.

To use
1. Click the Source drop-down list to select the measurement source for the cursor.
2. Click in one of the cursor Position entry boxes, and use a multipurpose knob to enter the cursor position.

Behavior
The cursor units depend on the cursor type. The cursor position readouts appear on the display graticule.
When using the IRE graticule style, amplitude cursor readouts are shown in IRE units.
Cursor position does not change if the cursor source changes or if the waveform is repositioned.
TIP. Use the pop-up keypad or your external keyboard to specify exact numerical cursor coordinates.
What do you want to do next?
Learn about the Cursor Setup controls. (see page 73)
Learn about the cursor types. (see page 80)
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Horizontal bar cursors
From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use
1. To use the horizontal bar cursors, click H Bars in one of the cursor control windows, or from the
Cursors menu, highlight Cursor Type, and then select H-bars from the submenu.
2. Use the multipurpose knobs to move the cursors.
3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior
Horizontal bar cursors measure vertical parameters (amplitude). Typically the vertical parameters are in
volts, but depend on the Vertical Units selected for the measurement window.
The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen. Each cursor has its own
readout with respect to the zero-reference. The Δ (delta) value shows the difference between the cursor
values.
What do you want to do next?
Learn more about the Cursor controls. (see page 81)
Go to a step-by-step procedure for taking cursor measurements. (see page 605)

80

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Cursor setups

Vertical bar cursors

Vertical bar cursors
From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use
1. To use the vertical bar cursors, click V Bars in one of the cursor control windows or highlight Cursor
Type from the Cursors menu, and then select V-bars from the submenu.
2. Use the multipurpose knobs to move the cursors.
3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior
Vertical bar cursors measure horizontal parameters. Typically horizontal parameters are in time or
frequency.
The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.
For time domain waveforms, each cursor has its own readout relative to the trigger point. The Δ (delta)
value shows the time difference between the cursor values, or the frequency associated with the period
between the cursors (Hz = 1/time).
For frequency domain signals, each cursor has its own readout relative to 0 Hz. The Δ value shows the
difference in the frequencies between the cursors.
You can also use vertical bar cursors with measurement gating. Measurement gating enables you to
limit automatic measurements to within the boundaries of the vertical bar cursors rather than use the
entire display width.
What do you want to do next?
Learn more about the Cursor controls. (see page 82)
Go to a step-by-step procedure for taking cursor measurements. (see page 605)
Learn more about measurement gating. (see page 295)
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Waveform cursors

Waveform cursors
From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use
1. To use the waveform cursors, click Waveform in one of the cursor control windows or from the
Cursors menu, highlight Cursor Type, and then select Waveform from the submenu.
2. Use the multipurpose knobs to move the cursors.
3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior
Waveform cursors can measure parameters on the same waveform or on different waveforms. The cursors
measure vertical parameters (typically volts) and horizontal parameters (typically time or frequency)
simultaneously. An X identifies the cursor location at the point where the cursors intersect the waveform.
The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.
One Δ (delta) value shows the voltage difference between the two cursors while the other Δ value shows
the time (or frequency) difference between the cursor values.
What do you want to do next?
Learn more about the Cursor controls. (see page 83)
Go to a step-by-step procedure for taking cursor measurements (see page 605)
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Screen cursors

Screen cursors
From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use
1. To use the screen cursors, click Screen in one of the cursor control windows or from the Cursors menu
highlight Cursor Type, and then select Screen from the submenu.
2. Use the multipurpose knobs to move the cursors.
3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior
Use screen cursors to indicate an arbitrary X and Y position in the waveform display area represented by
the intersection of a vertical and horizontal cursor line. Screen cursors measure both vertical parameters
(typically volts) and horizontal parameters (typically time or frequency).
Readouts display measurement parameters for both cursors. Vertical readouts display voltage values for
each cursor with respect to the zero reference point and with respect to each other. Horizontal readouts
display time or frequency values for each cursor with respect to the trigger point and with respect to
each other.
The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.
What do you want to do next?
Learn more about the Cursor controls. (see page 84)
Go to a step-by-step procedure for taking cursor measurements. (see page 605)
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Cursor track mode

Cursor track mode
From the Cursor Setup control window, click the Indep or Tracking button. From the Cursor menu
highlight Cursor Mode; then select Indep or Tracking in the submenu.

Overview
Use this control to define the tracking relationship between cursors.

To use
To select a cursor tracking mode, click either the Indep or Track button.

Behavior
Click Indep (Independent) to move one cursor at a time using the multipurpose knobs.
Click Tracking to move Cursor 1 and Cursor 2 in tandem so that Cursor 2 will always remain a fixed
distance (time or voltage) from the Cursor 1. However, moving Cursor 2 does not move Cursor 1.

Cursor measurements
Because cursor measurements give immediate feedback on the amplitude or time values they measure,
they are usually quick to take and are more accurate than graticule measurements. Also, since you can
position cursors wherever you want them on the waveform, they are easier to localize to a waveform
segment or feature than automatic measurements.
Cursors can measure channel, reference, and math waveforms. You must set the source of each cursor
explicitly in the Cursor Control window.
Any cursor type can be used for YT display format. XY display format can only use Screen or Waveform
cursors.
To use cursors, simply move the cursors on screen and read the results in the cursor readouts. The
following key points will help you use the cursors effectively.
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Cursor measurements

NOTE. Cursor measurements on digital channels require that at least one analog channel be displayed.
Alternatively, to take a measurement of a digital channel, you can first send the waveform acquired on the
digital channel to an analog channel using iCapture.
This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.

Cursor types overview
There are two cursors types (see page 746) available for the displays, Cursor 1 and Cursor 2. You can
move cursors with the multipurpose knobs or the cursor position controls in the Cursor Control window, or
click and drag them to a new location.

Cursors are limited by the display
You cannot move a cursor off the graticule unless you are in Zoom mode. Also, if you resize waveforms,
the cursors do not track. That is, a cursor stays at its screen position, ignoring changes to horizontal
and vertical scale and position and vertical offset (Waveform and Screen cursors will track a waveform
vertically).

Cursors ignore the selected waveform
Each cursor measures its source, defined in the Cursor Control window. Selecting a waveform for
scaling on screen (by pushing the Ch 3 front-panel button, for example) does not change the source that
each cursor measures.
After you have selected the source from the Cursor Control window, you can operate the cursor from the
front-panel knobs and buttons.
NOTE. If a cursor readout does not seem correct, check the source of each cursor in the Cursor Setup
dialog box. Each cursor readout relates to the amplitude and time base settings of its source.

Vertical cursors measure from the trigger point
Remember that each vertical cursor measures the time from the trigger point to itself. This relationship
is shown in the next figure.
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Cursor measurements

A vertical cursor readout includes and varies directly with the Delay time, which varies directly with
the horizontal position set for the time base. To see the amount of time to the first point, set horizontal
delay to 0.0 and set the horizontal reference point to 0%. Now the horizontal position readout shows the
time following the first point, and adding this value to the cursor readout yields the cursor position on
screen relative to first point. (You can find the horizontal readout both in the control window and in the
readout at the bottom of the screen.)
The following relationships hold:
Time from First Point = Horiz Position (when Horiz Delay and Ref Position are zero)
T1 readout = Time to First Point + Additional Time to Cursor

Cursor units depend on sources
A cursor that measures amplitude or time will read out in the units of its source as indicated in the table
below. Mixed sources require delta cursor readouts to use the units of the Cursor 1 source.
Cursors

Standard units 1

Readout names

Horizontal

volts, watts, IRE

V1, V2, ΔV

Vertical

seconds, bits, Hertz

T1, T2, ΔT, ΔF

Waveform, Screen

volts, watts, seconds, bits, Hertz

V1, V2, ΔV, T1, T2, ΔT

xxx

1

If the V1 and V2 units do not match, the ΔV readout defaults to the units used by the V1 readout.

Changing cursor positions
Change cursor positions by using the position controls in the Cursor Position window, dragging the cursor
into position using the touch screen or mouse, or by turning the front-panel multipurpose knobs.
NOTE. To make small changes with the multipurpose knobs, push the Fine button before turning the knobs.
When a Fine button is lighted, its multipurpose knob makes smaller adjustments.
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Cursor setup control window (XY display format)

What do you want to do next?
Learn about cursor types. (see page 746)
Go to a step-by-step procedure for taking automatic measurements. (see page 606)

Cursor setup control window (XY display format)
From the Cursors menu, select Cursor Setup.

Overview
Use these controls to set the cursor parameters when you are using XY display format (see page 174). The
available controls vary depending on the rest of the cursor window settings.
For information on the controls, click the buttons.

To use
1. Use the same Cursor Control Window (YT format) (see page 73) guidelines to setup up the cursor
controls.
2. Select the readout format from the XY Readout drop-down list.

Behavior
When you are using XY display format, only Waveform and Screen cursors are available. If you change
the display format to XY when H Bar cursors are enabled, the cursor type will change to Screen. In normal
acquisition mode, changing the display format to XY when V Bar cursors are enabled, changes the cursor
type to Waveform. In FastAcq acquisition mode, changing the display format to XY when V Bar cursors
are enabled, changes the cursor type to Screen.
If you change the display format from XY to YT when Screen cursors are enabled, the cursor type
is changed to H Bars.
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Cursor setup control window (XY display format)

XY
These cursor Readouts only appear when you are using XY display format. Rectangular XY readouts are
the default.

Rectangular
Shows the cursor readouts as rectangular coordinate positions. Waveform cursors display nine rectangular
readouts (ΔX, ΔY, Δt, X1, X2, Y1, Y2, t1, and t2). Screen cursors display six readouts (ΔX, ΔY, X1,
X2, Y1, and Y2).

Polar
Shows the cursor position as polar coordinate positions. Waveform cursors display nine polar readouts (Δr,
Δ0, Δt, r1, r2, 01, 02, t1, and t2). Screen cursors display six polar readouts (Δr, Δ0, r1, r2, 01, and 02).

Product
Shows the cursor position as rectangular coordinates and the X vertical value is multiplied by the Y
vertical value. Waveform cursors display seven product readouts (ΔX×ΔY, X1×Y1, X2×Y1, X2×2, Δt, t1,
and t2). Screen cursors display three product readouts (ΔX×ΔY, X1×Y1, and X2×Y2).

Ratio
Shows the cursor position as rectangular coordinates and the Y vertical value is divided by the X vertical
value. Waveform cursors display six ratio readouts (ΔY÷ΔX, Y1÷X1, Y2÷Y1, Δt, t1, and t2). Screen
cursors display three ratio readouts (ΔY÷ΔX, Y1÷X1, and Y2÷Y1).
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Digital setup control window

Digital setup control window
From the Digital menu, select Digital Setup.
NOTE. The Digital Setup is available only on MSO5000B and MSO70000C/DX Series instruments and
DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with option
MSOU installed.

Overview
Use the Digital Setup control windows to set parameters for the D15-D0 digital channels. Use the D15-D8
tab to set up the upper eight bits and the D7-D0 tab to set up the lower eight bits.
For information on the controls, click the buttons.

To use
Click the digital channels buttons to turn the waveforms on and off.
Set the voltage level thresholds for individual channels or set the same threshold level for all channels.
Adjust the vertical position of each channel.
Set the vertical height of the channel in the display.
TIP. Click the Bus Setup button to quickly access the Bus Setup control window.
What do you want to do next?
Learn how to connect a logic probe to signals in your system under test. (see page 90)
Learn how to turn on or turn off the digital channels. (see page 93)
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Setting up digital signal inputs

Learn how to set up the digital channels. (see page 96)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn how to set up a bus. (see page 584)
Learn how to set up digital waveforms. (see page 583)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to troubleshoot circuits using a parallel bus. (see page 596)
Learn how to troubleshoot a serial bus. (see page 599)

Setting up digital signal inputs
Use the Digital setup menu to set up the digital channels to acquire signals.
NOTE. Digital Setup is available only on MSO5000B and MSO70000C/DX Series instruments and
DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with option
MSOU installed.

To use
1. Connect the logic probe to the instrument.
2. Connect the probe to the input signal sources.
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Digital channel threshold and position

CAUTION. To prevent damage to the instrument always wear an antistatic wrist strap when making
connections to the instrument and observe the maximum input voltage ratings for input connectors.
3. Set up digital channels and buses using the Digital Setup and Bus Setup control windows through the
Digital menu. The Bus Setup window is also accessible through the Vertical menu.
What do you want to do next?
Learn about setting up the digital channels. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)

Digital channel threshold and position
NOTE. The Digital Channel Threshold and Position option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.
From the Digital menu, select Digital Setup.

Overview
Use these controls to define the voltage threshold level of digital channels and their vertical position in
the display.

To use
1. Use the Channel Selectors to select a channel.
2. Use the Threshold and Position controls to set the voltage threshold level and the vertical position of
the selected channel.

Set digital channel threshold
NOTE. The Digital Channel Threshold option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPO5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.
From the Digital menu, select Digital Setup and use the Threshold entry box to set the voltage threshold
level of the digital channel.
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Digital channel threshold and position

NOTE. The instrument displays the Threshold entry box when you turn on the digital channel.

To use
Click in the Threshold entry box and use the keypad to enter a value or use the multipurpose knobs to
select a voltage level.

Behavior
The voltage threshold level determines when a voltage level on a digital channel is considered to be
a logic high and a logic low.

Set digital channel position
NOTE. The Digital Channel Position option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPO5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.
From the Digital menu, select Digital Setup and use the Position entry box to move the digital channel
vertically in the display.
NOTE. The instrument displays the Position entry box when you turn on the digital channel.

To use
Double-click in the Position entry box, and use the keypad or the multipurpose knobs to adjust the
position of the digital channel.

What do you want to do next?
Learn about setting up digital signals. (see page 96)
Learn more about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
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Turn on or off the digital channels D15-D8 and D7-D0

Turn on or off the digital channels D15-D8 and D7-D0
NOTE. The Turn On or Off the Digital Channels D15-D8 and D7-D0 option is available only on
MSO5000B and MSO70000C/DX Series instruments and DPO5000B Series instruments with option
MSOE installed, and DPO70000DX instruments with option MSOU installed.
From the Digital Setup menu, select the D15-D8 or D7-D0 tab.

To use
Click Turn D7–D0 or Turn D15-D8 On button to turn on the digital channels D0 to D7 or D8 to
D15 respectively.
Click the Threshold entry box and use the keypad to enter a value for the voltage level or use the
multipurpose knobs to select a voltage level.
Click the Position entry box and move the channel using the multipurpose knob.

Behavior
As you turn on the digital channels, the corresponding channel indicator along the bottom of the menu
changes to match the color on the digital channel button.
What do you want to do next?
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn more about digital setups. (see page 89)
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Set the display size of logic channels

Set the display size of logic channels
NOTE. The Display Size of Logic Channels option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPO5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.
From the Digital menu, select Digital Setup and use the Size selection box to define the height of the
digital channel in the display.

To use
Click Size and select from the drop-down list: Large, Medium, Small, and Extra Small.

Behavior
Large displays the channel as a division.
Medium displays the channel as half a division.
Small displays the channel as a quarter of a division.
Extra Small displays the channel as a fifth of a division.
What do you want to do next?
Learn about setting up digital signals. (see page 96)
Learn more about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
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Set the global threshold for digital channels

Set the global threshold for digital channels
NOTE. The Global Threshold for Digital Channels option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.
From the Digital menu, select Digital Setup and use the Global Threshold entry box to define the same
voltage threshold level for all digital channels.

To use
Click the Global Threshold entry box and enter a value for the voltage threshold level with the keypad.
Click the Apply button.

Behavior
The instrument sets the thresholds for all digital channels to the same voltage level.
What do you want to do next?
Learn how to set the threshold for Ch1-Ch4 (live) and Math1-Math4 channels to use as logic
waveforms. (see page 811)
Learn more about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
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Set up digital channels

Set up digital channels
NOTE. The Digital Channels D15-D8 and D7-D0 Tabs option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.
From the Digital Setup menu, select the D15-D8 or the D7-D0 tab to set up digital channels.

To use
Click a digital channel to turn on or turn off the display of the channel.
Click the Threshold entry box and use the keypad to enter a value for the voltage level or use the
multipurpose knobs to select a voltage level.
Click the Position entry box and move the channel using the multipurpose knob.
Select the size of the waveform in the display.

Behavior
As you turn on digital channels, the corresponding channel indicator along the bottom of the menu changes
to match the color on the digital channel button.
What do you want to do next?
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn more about digital setups. (see page 89)
Learn how to turn on or turn off the digital channels. (see page 93)
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Bus setup control window (Config tab)

Bus setup control window (Config tab)
From the Digital menu (or the Vertical menu), select Bus Setup.
The instrument supports serial data standards: SPI, I2C, USB, RS232, 8b10b, and MIPI. When you select
a serial bus, the instrument assigns specific bus signals (called components) to default digital channels,
sets the threshold to an appropriate voltage level.

Overview
Use the Bus Setup Control windows to define up to 16 buses from which to acquire, decode, and display
data. You can set up serial buses for the SPI, I2C, USB, RS232, 8b10b, and MIPI serial data standards.
You can also set up clocked or unclocked parallel buses.
NOTE. The instrument displays I2C as the I2C (Inter-IC Bus) serial bus selection.
For information on the controls, click the buttons.

To use
Click and drag the scroll bar until the desired Bus number <B1-B16> or name is visible
Click on a Bus number or name
Click the corresponding Bus number Off/On button
To name the bus, click the Label entry box and enter a name with the keyboard
To change the vertical position of the bus on the display, click the Bus Position entry box and use the
keypad or the multipurpose knob to move the bus
Click a Bus Type: Serial or Parallel
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Bus selection list
For Parallel buses, click the Add Sources button and build your bus with any combination of D15-D0,
Ch1-Ch4, and M1-M4 channels
For Serial buses, select one of the available options from the drop-down list; the instrument provides
additional parameters to set up for each standard

Behavior
Click the Clear Bus button to clear all the channels from the selected bus and remove the bus from the
display.
TIP. Click the Digital Setup button to quickly access the Digital Setup control window for the parallel
bus type.
What do you want to do next?
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up digital waveforms. (see page 583)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to set up a bus. (see page 584)
Learn how to trigger on a bus. (see page 662)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to troubleshoot circuits using a parallel bus. (see page 596)
Learn how to troubleshoot a serial bus. (see page 599)

Bus selection list
From the Bus Setup window, select a bus to set up from the list of Bus selections <B1-B16>.

To use
Click and drag the scroll bar until the desired Bus number or name is visible.
Click the Bus number <B1–B16> or name to be set up.
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Bus selection list

xxx

Behavior
Click the Bus button to display the bus (On) or to remove it from the display (Off).
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Bus search selection list

Bus search selection list
From the Search Configure window, select a bus source to set up from the list of Source selections
<B1-B16>.

To use
Select the Search Slot from the drop-down list.
Click and turn (drag) the scroll wheel or click the up/down arrows until the desired Bus number or
name is visible.
Click the Bus number <B1–B16> or name to be set up.
Click OK.

xxx

Behavior
Click the OK to return to the Search Configure .
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

100

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Bus setups

Display or clear a bus

Display or clear a bus
From the Bus Setup window, select the Bus number <B1-B16> or name that you want to display or
clear from the display.

To use
Select the bus number or name from the list.
Click the Bus button to select On and display the bus.
To clear and remove a bus, click the Clear Bus button.

Behavior
A parallel bus must be defined before it can be displayed.
When you click the Clear Bus button, the instrument removes the bus with the channels used to build the
bus, and the Bus button changes to Off.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

Label a bus
From the Bus Setup window, select a Bus number <B1-B16> to label from the Bus list.

To use
Double-click the Label entry box and enter a name up to 7 characters long with the keyboard.
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Label a bus

Here is an example of a setup for an SPI bus with a label.

Behavior
The bus label appears in the list of bus setups in the Config and Display tabs. The instrument also displays
the label adjacent to the bus number on the screen for easy identification.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Change the bus position

Change the bus position
From the Bus Setup window, select the Bus number <B1-B16> or name to position on the display from
the Bus list.

To use
To change the vertical position of the bus on the display, click the Bus Position entry box and use the
keypad or the multipurpose knob to enter a new position.

Behavior
The instrument moves the bus on the screen to the new position.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

Set up an I2C serial bus
NOTE. I2C serial bus setup is available only on instruments with the SR-EMBD option.
From the Bus Setup window, select Serial from the Bus Type list and then select the I2C Serial bus type.
NOTE. The Components for the I2C bus standard are set by the instrument.
For information on the controls, click the buttons.
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Set up an I2C serial bus

To use
To change the input for a component, click the Input arrow and select a channel from the cascading list.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected I2C bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to track down serial bus anomalies. (see page 594)
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Set up an SPI serial bus
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up an SPI serial bus
NOTE. SPI serial bus setup is available only on instruments with the SR-EMBD option.
From the Bus Setup window, select a bus from the Bus list and then select the SPI Serial bus type.
NOTE. The Components for the SPI bus standard are set by the instrument.
For information on the controls, click the buttons.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To set the polarity, click the Polarity entry box and select from the drop-down list. The selections vary
by component.
To set the word size, click the Word Size entry box and use the keypad to enter a value.
To set the bit order, click the Bit Order entry box and select from the drop-down list.

Behavior
The instrument changes the components, voltage threshold levels, polarity, word size, and bit order, and
uses those to decode the selected SPI bus.
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Set up an RS-232 serial bus

What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up an RS-232 serial bus
NOTE. RS-232 serial bus setup is available on instruments with the SR-COMP option.
From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the RS-232
Serial bus type.
NOTE. The Components for the RS-232 bus standard are set by the instrument.
For information on the controls, click the buttons.
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Set up an RS-232 serial bus

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To set the polarity, click the Polarity entry box and select from the drop-down list.
To set the data bits, click the Data Bits entry box and select from the drop-down list.
To set the parity, click the Parity entry box and select from the drop-down list.
To set the bit rate, click the Bit Rate entry box and select from the drop-down list.

Behavior
The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected RS-232 bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a MIL-1553 Bus (see page 122)
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Set up a USB serial bus
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
Learn to view the bus packets. (see page 157)

Set up a USB serial bus
NOTE. USB serial bus setup is available only on instruments with the SR-USB option.
From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the USB
Serial bus type.
NOTE. The Components for the USB bus standard are set by the instrument.
For information on the controls, click the buttons.

USB bus setup.
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Set up a USB serial bus

USB bus setup with SuperSpeed selected.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold (H) or Threshold (L) entry box and use the
keypad to enter a value or use the multipurpose knobs to select a voltage level.
To set the speed, click the Speed entry box and select from the drop-down list.
To set the signal type, click the Signal Type (not available with SuperSpeed) entry box and select
from the drop-down list.

Behavior
The instrument changes the components, voltage threshold levels, speed, and signal type, and uses those to
decode the selected USB bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
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Set up a MIPI DSI-1 serial bus
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a MIPI DSI-1 serial bus
NOTE. MIPI DSI-1 serial bus setup is available only on instruments with the SR-DPHY option.
From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the MIPI
DSI-1 Serial bus type.
NOTE. The Components for the MIPI DSI-1 bus standard are set by the instrument.
For information on the controls, click the buttons.

To use
To set the channel type, click the Channel Type entry box and select from the drop-down list.
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level. Set the threshold on the low power
portion of the waveform.
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Set up a MIPI CSI-2 serial bus

Behavior
The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected MIPI DSI-1 bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
Learn to view the bus packets. (see page 157)

Set up a MIPI CSI-2 serial bus
NOTE. MIPI CSI-2 serial bus setup is available only on instruments with the SR-DPHY option.
From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the MIPI
CSI-2 Serial bus type.
NOTE. The Components for the MIPI CSI-2 bus standard are set by the instrument.
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Set up a MIPI CSI-2 serial bus

For information on the controls, click the buttons.

To use
To set the channel type, click the Channel Type entry box and select from the drop-down list.
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level. Set the threshold on the low power
portion of the waveform.

Behavior
The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected MIPI CSI-2 bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
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Set up an 8B10B serial bus
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up a Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
Learn to view the bus packets. (see page 157)

Set up an 8B10B serial bus
NOTE. 8B10B serial bus setup is available only on instruments with the SR-810B or ST6G options.
From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the 8B10B
Serial bus type.
NOTE. The Components for the 8B10B bus standard are set by the instrument.
For information on the controls, click the buttons.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To change the voltage hysteresis level, click the Hysteresis entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
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Set up a Custom serial bus
To set the data rate, click the Data Rate entry box and select from the drop-down list.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

Behavior
The instrument changes the components, voltage threshold levels, speed, and signal type, and uses those to
decode the selected 8B10B bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to troubleshoot a serial bus. (see page 599)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a Custom serial bus
NOTE. Custom serial bus setup is available only on instruments with the SR-CUST option.
From the Bus Setup window, select Serial from the Bus Type list and then select the Custom Serial bus type.
NOTE. The Components for the Custom bus standard are set by the installed custom decoder.
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Set up a Custom serial bus

For information on the controls, click the buttons.

To use
To change the custom decoder, click the Custom Decoder arrow and select the decoder from the
cascading list.
To change the input for a component, click the Input arrow and select a channel from the cascading list.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected Custom bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a MIL-1553 Bus (see page 122)
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Set up a PCIe serial bus
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up a Custom serial bus. (see page 590)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a PCIe serial bus
NOTE. PCIe serial bus setup is available only on instruments with the SR-PCIE option.
From the Bus Setup window, select Serial from the Bus Type list and then select the PCIe Serial bus type.
For information on the controls, click the buttons.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To change the voltage hysteresis level, click the Hysteresis entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To set the data rate, click the Data Rate entry box and select from the drop-down list.

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
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Set up a CAN serial bus

What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a CAN Serial Bus (see page 117)
Learn how to set up a LIN Serial Bus (see page 591)
Learn how to set up a FLEXRAY Serial Bus (see page 592)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a CAN serial bus
NOTE. CAN serial bus setup is available only on instruments with the SR-AUTO option.
From the Bus Setup window, select Serial from the Bus Type list and then select the CAN Serial bus type.
For information on the controls, click the buttons.
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Set up a CAN serial bus

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To change the bit rate, click the Bit Rate and select the rate from the cascading list.

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a PCIe Serial Bus (see page 590)
Learn how to set up a LIN Serial Bus (see page 591)
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Set up a LIN serial bus
Learn how to set up a FLEXRAY Serial Bus (see page 592)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a LIN serial bus
NOTE. LIN serial bus setup is available only on instruments with the SR-AUTO option.
From the Bus Setup window, select Serial from the Bus Type list and then select the LIN Serial bus type.
For information on the controls, click the buttons.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.
To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
To set the polarity, click the Polarity entry box and select from the drop-down list.
To set the LIN standard, click the LIN Standard entry box and select from the drop-down list.
To set the bit rate, click the Bit Rate entry box and select from the drop-down list.
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Set up a FLEXRAY serial bus

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a PCIe Serial Bus (see page 590)
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a FLEXRAY Serial Bus (see page 592)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a FLEXRAY serial bus
NOTE. FLEXRAY serial bus setup is available only on instruments with the SR-AUTO option.
From the Bus Setup window, select Serial from the Bus Type list and then select the FLEXRAY Serial bus
type.
For information on the controls, click the buttons.

120

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Bus setups

Set up a FLEXRAY serial bus

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To set the signal type, click the Signal Type entry box and select from the drop-down list.
To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value
or use the multipurpose knobs to select a voltage level.
To set the channel type, click the Channel Type entry box and select from the drop-down list.
To set the bit rate, click the Bit Rate entry box and select from the drop-down list.

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a PCIe Serial Bus (see page 590)
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Set up a MIL-1553 serial bus
Learn how to set up a CAN Bus (see page 117)
Learn how to set up a LIN Serial Bus (see page 591)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up a MIL-1553 serial bus
NOTE. MIL-STD-1553 serial bus setup is available only on instruments with the SR-AERO option.
From the Bus Setup window, select Serial from the Bus Type list and then select the MIL-1553 Serial bus
type.
For information on the controls, click the buttons.

To use
To change the input for a component, click the Input and select a channel from the cascading lists.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.
To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value
or use the multipurpose knobs to select a voltage level.
To select the polarity, click the Polarity and select the polarity from the drop-down list.
To change the response time maximum and minimum, click a Response Time entry box and use the
keypad to enter a value or use the multipurpose knobs to select a time.
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Set up an Ethernet serial bus

Behavior
The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a PCIe Serial Bus (see page 590)
Learn how to set up a LIN Serial Bus (see page 591)
Learn how to set up a FLEXRAY Serial Bus (see page 592)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up an Ethernet Bus (see page 123)
Learn how to set up a CAN Bus (see page 117)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Set up an Ethernet serial bus
NOTE. Ethernet serial bus setup is available only on instruments with the SR-ENET option.
From the Bus Setup window, select Serial from the Bus Type list and then select the Ethernet Serial bus
type.
For information on the controls, click the buttons.
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Set up an Ethernet serial bus

To use
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.
To select the standard, click the Standard and select the standard from the drop-down list.
To select the signal type, click the Signal Type and select the signal type from the drop-down list.
To change the input for a component, click the Input and select a channel from the cascading lists.
To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value
or use the multipurpose knobs to select a voltage level.

Behavior
The instrument uses the selected components and voltage threshold levels to decode the selected bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up an I2C serial bus. (see page 586)
Learn how to set up an SPI serial bus. (see page 586)
Learn how to set up a USB serial bus. (see page 588)
Learn how to set up an RS-232 serial bus. (see page 587)
Learn how to set up a MIPI DSI1 Serial Bus (see page 588)
Learn how to set up a MIPI CSI2 Serial Bus (see page 589)
Learn how to set up an 8B10B Serial Bus (see page 113)
Learn how to set up an Custom serial bus. (see page 590)
Learn how to set up a PCIe Serial Bus (see page 590)
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Select the number of lanes
Learn how to set up a LIN Serial Bus (see page 591)
Learn how to set up a FLEXRAY Serial Bus (see page 592)
Learn how to set up a MIL-1553 Bus (see page 122)
Learn how to set up a CAN Bus (see page 117)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)

Select the number of lanes
From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use
To change the number of lanes for the bus, click the No Of Lanes and select from the cascading list.

Behavior
The instrument acquires data from the number of lanes you select. You can select a maximum of 4 lanes
on MSO instruments, other instruments only allow 1 lane.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the serial bus channel type

Select the serial bus channel type
NOTE. Serial bus Channel Type is only available on MSO70000C/DX models.
From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use
To change the channel type for the displayed components of the bus, click the Channel Type and select
from the cascading list.

Behavior
The instrument acquires data from the channel you select for each component. The channel type supported
are analog or digital (MSO models only) input. The analog input consists of two analog signals (D+
and D-). The digital input consists of three digital signals (D+, D-, and D+/D- [differential probing
between D+ and D-]).
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the serial bus channel input

Select the serial bus channel input
From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use
To change the input for the displayed components of the bus, click the Input and select from the cascading
list.

NOTE. You have the option to add user-defined label for the bus sources.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the USB serial bus speed

Select the USB serial bus speed
NOTE. USB serial bus Speed selection is available only on instruments with option SR-USB.
From the Bus Setup window, select Serial from the Bus Type list and then select the USB Serial bus type.

To use
To change the speed for the displayed component of the bus, click Speed and select from the cascading list.

Behavior
The instrument acquires data from the channel you select for each component. SuperSpeed is only
available on instruments with a bandwidth of ≥8 GHz.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the USB bus signal type

Select the USB bus signal type
NOTE. The USB bus Signal Type is available only on instruments with option SR-USB.
Signal Type is not available if you select SuperSpeed in the Bus Setup menu.
From the Bus Setup window, select Serial from the Bus Type list and then select the USB Serial bus type.

To use
To change the signal type for the displayed components of the bus, click Signal Type and select from
the cascading list.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the data rate

Select the data rate
From the Bus Setup window, select Serial from the Bus Type list and then select the Serial bus type.

To use
To change the data rate for the displayed component of the bus, click Data Rate and select from the
cascading list. Items in the list depend on the serial bus type.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the serial bus input

Select the serial bus input
From the Bus Setup window, select Serial from the Bus Type list and then select from the cascading list.

To use
To change the input for the displayed components of the bus, click the Input and select from the cascading
list.
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Select the USB bus threshold

Select the USB bus threshold
From the Bus Setup window, select Serial from the Bus Type list and then select USB Serial bus type.
NOTE. USB bus threshold high and low are available only on instruments with option SR-USB.

To use

To change the voltage high or low threshold level of the component Input, click

or

entry box respectively and use the keypad to enter a value or use the multipurpose knobs to
select a voltage level. Setting the low threshold is only available when the signal type is differential.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the serial bus channel threshold

Select the serial bus channel threshold
From the Bus Setup window, select Serial from the Bus Type list and then select from the cascading list.
NOTE. The serial bus channel Threshold option is available only on instruments with one or more of
the SR- options.

To use
To change the voltage threshold level of the component Input, click the Threshold entry box and use the
keypad to enter a value or use the multipurpose knobs to select a voltage level.

Behavior
The instrument can use different voltage thresholds levels for each component.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the SPI bus channel polarity

Select the SPI bus channel polarity
NOTE. The SPI Bus Channel Polarity option is available only on instruments with option SR-EMBD.
From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
Scroll through the Bus list and select the SPI bus to configure.
Click the Polarity box and select the polarity from the drop-down list.

Behavior
For the SCLK component:
Rising causes the instrument to acquire data on the rising edge of the signal.
Falling causes the instrument to acquire data on the falling edge of the signal.
For the SS component:
Active Low causes the instrument to decode the bus when the Slave Select signal is at a low level.
Active High causes the instrument to decode the bus when the Slave Select signal is at a high level.
For the Data component:
Active Low causes the instrument to decode signals at a low level.
Active High causes the instrument to decode signals at a high level.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the RS-232 bus channel polarity

Select the RS-232 bus channel polarity
NOTE. The RS-232 Bus Channel Polarity option is available on instruments with option SR-COMP.
From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

Scroll through the Bus list and select the RS-232 bus to configure.
Click the Polarity box and select the polarity from the drop-down list.

Behavior
For the Data component:
Normal causes the instrument to decode signals at a high level as a binary 1.
Inverted causes the instrument to decode signals at a high level as a binary 0.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the RS-232 bus data bits

Select the RS-232 bus data bits
NOTE. The RS-232 Bus Data Bits option is available only on instruments with option SR-COMP.
From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

Scroll through the Bus list and select the RS-232 bus to configure.
Click the Data Bits box and select the data bits from the drop-down list.

Behavior
You have the option to set the number of data bits in a frame for RS-232 bus to:
7.
8, the default.
9.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the RS-232 bus parity

Select the RS-232 bus parity
NOTE. The RS-232 Bus Parity option is available on instruments with option SR-COMP.
From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

Scroll through the Bus list and select the RS-232 bus to configure.
Click the Parity box and select the parity from the drop-down list.

Behavior
Set the bus parity selection to:
None, the default.
Odd.
Even.
NOTE. There is no parity selection when the number of data bits is 9.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the RS-232 bus bit rate

Select the RS-232 bus bit rate
NOTE. The RS-232 Bus Bit Rate option is available on instruments with option SR-COMP.
From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

Scroll through the Bus list and select the RS-232 bus to configure.
Click the Bit Rate box and select the bit rate from the drop-down list.

Behavior
Set the bus bit rate to:
50, 300, 1200, 2400, 9600, 19200, 38400, 115200, 921600, or 10000000. The default value is 9600.
Custom. To change the bit rate, click the Bit Rate entry box and use the keypad to enter a value.

What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the SPI bus framing

Select the SPI bus framing
NOTE. The SPI bus Framing option is available only on instruments with option SR-EMBD.
From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
Select the framing from the drop-down list.
Select SS framing for three wire SPI decode.
Select Idle framing for two wire SPI decode.

Behavior
The instrument changes the framing and uses that to decode the selected SPI bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Set the SPI bus idle time

Set the SPI bus idle time
NOTE. The SPI bus Idle Time option is available only on instruments with option SR-EMBD.
From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
Select the Idle framing from the drop-down list.
To change the idle time, click the Idle Time entry box and use the keypad to enter a value.

Behavior
The instrument changes the idle time and uses that to decode the selected SPI bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Set the SPI bus word size

Set the SPI bus word size
NOTE. The SPI Bus Word Size option is available only on instruments with option SR-EMBD.
From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
Scroll through the Bus list and select the SPI bus to configure.
Click the Word Size box and enter a size using the key pad. You can also edit the value with the
keyboard or multipurpose knob.

Behavior
The instrument changes the word size and uses that to decode the selected SPI bus.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the SPI bus bit order

Select the SPI bus bit order
NOTE. The SPI Bus Bit Order option is available only on instruments with option SR-EMBD.
From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
Scroll through the Bus list and select the SPI bus to configure.
Click the Bit Order box and select the direction from the drop-down list: MS First or LS First.

Behavior
MS First causes the instrument to decode the data sequence from the MSB to the LSB.
LS First causes the instrument to decode the data sequence from the LSB to the MSB.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Set up a parallel bus

Set up a parallel bus
From the Bus Setup window, select a bus from the Bus list, select the Parallel bus type, and then click
the Add Sources button.

Overview
When you acquire data from a Parallel bus, you can set up the bus to be clocked or unclocked.

To use
For information on the controls, click the buttons.

Behavior
If the bus is not clocked, the instrument acquires all data from the parallel bus at the sample rate of the
instrument.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up a parallel bus. (see page 584)
Learn how to troubleshoot circuits using a parallel bus. (see page 596)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
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Set up a clocked parallel bus

Set up a clocked parallel bus
From the Bus Setup window, select a bus from the Bus list and then select the Parallel bus type.

Overview
The instrument can trigger parallel bus data only when the Clock Source is Channel 4.
For information on the controls, click the buttons.

To use
To change the Clock Source, select a channel from the cascading list.
To change the Clock Polarity, select from Rising, Falling, or Either.

Behavior
Rising causes the instrument to decode data on the rising edge of the signal.
Falling causes the instrument to decode data on the falling edge of the signal.
Either causes the instrument to decode data on the rising and the falling edges of the signal.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
Learn how to set up a parallel bus. (see page 584)
Learn how to troubleshoot circuits using a parallel bus. (see page 596)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to trigger on a bus. (see page 662)
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Add sources to a parallel bus

Add sources to a parallel bus
From the Bus Setup window, click the Add Sources Select button.

To use
Click the button for each channel to add to the bus.
Click the OK button.

NOTE. You have the option to add user-defined labels for the analog, reference, bus, and digital sources.
Digital sources are only available on MSO series instruments.

Behavior
The instrument adds the channels to the parallel bus starting with the Most Significant Bit (MSB). As you
select each subsequent channel, the instrument adds the channel to the bus as the next lower bit. The last
channel you select is the Least Significant Bit (LSB).
What do you want to do next?
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Bus setups

Set up bus channel thresholds
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

Set up bus channel thresholds
NOTE. Serial Bus Channel Type is only available on instruments with an SR-xxxx option.
From the Bus Setup window, select a bus number from the Bus list.

To use
Click the Thresholds Setup button.
Double-click the Threshold entry box for the desired channel, and use the keypad to enter a value or
use the multipurpose knobs to select a voltage level.

TIP. To quickly set the thresholds for all channels to the same voltage level, use the Global Threshold (see
page 95) entry box to set the value, and click the Apply button.
What do you want to do next?
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Set up bus channel thresholds
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Change the bit order of a channel in a parallel bus

Change the bit order of a channel in a parallel bus
NOTE. Serial Bus Channel Type is only available on instruments with an SR-xxxx option.
From the Bus Setup window, select a channel to move to a different bit order position within a parallel bus.

To use
Select a parallel bus from the Bus list.
Click the channel for which you want to change the bit order in the Bus Contains list.
Click the Up or Down arrows to change the bit order of the selected channel.

Behavior
Moves the selected channel towards the MSB (most significant bit) position in the bit order when you
click the arrow that points up.
Moves the selected channel towards the LSB (least significant bit) position in the bit order when
you click the arrow that points down.
TIP. To quickly remove any channel from the parallel bus, double-click the channel in the Bus List control.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

148

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Bus setups

Remove a channel from a parallel bus

Remove a channel from a parallel bus
From the Bus Setup window, select a channel to remove from a parallel bus.

To use
Select a parallel bus from the Bus list.
Click the channel you want to remove from the Bus Contains list.
Click the Remove button.

Behavior
The instrument removes the channel from the bus and shifts the bit order accordingly.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the bus clock source channel

Select the bus clock source channel
From the Bus Setup window, select a bus, select the Parallel bus type, and click Clocked.

To use
Connect a probe between the instrument and the clock signal in your system under test.
Click the Clock Source selection box and select the appropriate channel from the cascading list.

NOTE. You have the option to add user-defined labels for the analog, reference, bus, and digital sources.
Digital sources are only available on MSO models.

Behavior
The instrument acquires data from the parallel bus only when the signal used as the Clock Source changes
logic levels.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)
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Select the Bus clock channel polarity

Select the Bus clock channel polarity
From the Bus Setup window, select a bus, select the Parallel bus type, and click Clocked.

To use
Connect a probe between the instrument and the clock signal in your system under test.
Click the Clock Polarity selection box and select from Rising, Falling, or Either.

Behavior
Rising causes the instrument to acquire data on the rising edge of the signal.
Falling causes the instrument to acquire data on the falling edge of the signal.
Either causes the instrument to acquire data on the rising and the falling edges of the signal.
What do you want to do next?
Learn more about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about digital setups. (see page 89)

Bus setup control window (Display tab)
From the Bus Setup window, select the Display tab.

Overview
Use the Bus Setup Display window to define how the instrument displays data acquired from the selected
bus.
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Bus setup control window (Display tab)

To use

Behavior
The instrument displays data from the bus based on the selected Bus Components, Busform Decode
option, and the symbol file.
For the LIN, FLEXRAY, MIL1553, MIPI DSI-1, MIPI CSI-2, and Custom serial bus, you can also display
the decode of the bus in mixed, Hex, and Binary method.

For the CAN serial bus, you can display the decode of the bus in Hex and Binary.

For the 8B10B serial bus, you can also display the decode of the bus in Symbol, Character , Data Hex, and
Data Binary method.
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Bus setup control window (Display tab)

For the PCIe serial bus, you can display the decode of the bus in Symbol, Character Symbol, Character
KCode, Data Hex, Data Binary, Descrambled Hex, and Descrambled Binary. Select the decode from
the drop down list.

For the RS232 serial bus, you can also display the decode of the bus in ASCII, Binary, and Hex.

For the USB serial bus, you can display the decode of the bus in Mixed Hex, Mixed ASCII, Hex, Binary,
Packet, and Details. The speed you select determines the available decodes. Select the decode form
the drop down list.

For the Ethernet serial bus, you can display the decode of the bus in Mixed Hex, Mixed ASCII, Hex, and
Binary. Select the decode form the drop down list.
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Select the bus display view

What do you want to do next?
Learn about bus setups. (see page 97)
Learn about digital setups. (see page 89)
Learn how to set up digital waveforms. (see page 583)
Learn how to view analog characteristics of a digital waveform. (see page 583)
Learn how to set up a bus. (see page 584)
Learn how to trigger on a bus. (see page 662)
Learn how to track down serial bus anomalies. (see page 594)
Learn how to troubleshoot circuits using a parallel bus. (see page 596)
Learn how to troubleshoot a serial bus. (see page 599)

Select the bus display view
From the Bus Setup window, select the Display tab.

To use
Scroll through the Bus list and select the bus to configure.
Click a + box to display additional views, or click a - box to remove views.
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Select the bus display view

Bus views may also be added or removed from the display by clicking on the + box or - box in the display.
Available views may include Transaction/transport, link/framing/packets, physical/bytes/symbols, and bit
level.

Behavior
Clicking on a + box displays additional views of a bus.
Clicking on a - box removes bus views from the display.
What do you want to do next?
Learn more about bus configuration. (see page 151)
Learn about bus setups. (see page 97)
Learn about digital setups. (see page 89)
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Select the bus decode method

Select the bus decode method
From the Bus Setup window, select the Display tab.

To use
Scroll through the Bus list and select the bus to configure.
Click the Busform Decode drop down list and select the method to interpret and display the data
from the bus.

Behavior
The instrument displays the busform based on the selected decode method. Available decode methods vary
with the selected bus.
Hex causes the instrument to decode and display the bus as a hexadecimal value.
Binary causes the instrument to decode and display the bus as a binary value.
ASCII causes the instrument to decode and display the bus as an ASCII value.
Mixed causes the instrument to decode and display the bus frame and address in decimal. You
have the option to display the data either as a hexadecimal or an ASCII value. Mixed displays the
data type as symbols, and it displays the virtual channel and word count in decimal. All other fields
are displayed in hexadecimal.
Mixed decoding methods like symbol for DT (Data Type MIPI element), decimal for VC (Virtual
Channel MIPI element) and WC (Word Count MIPI element), and hexadecimal for all other fields
are available for MIPI DSI-1 serial bus type.
What do you want to do next?
Learn more about bus configuration. (see page 151)
Learn about the symbol file format. (see page 158)
Learn about bus setups. (see page 97)
Learn about digital setups. (see page 89)
Learn to view the bus packets. (see page 157)
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View bus packet

View bus packet
NOTE. Serial Bus Channel Type is only available on instruments with option SR-COMP.
From the Bus Setup window, select Serial from the Bus Type list and then select the RS-232 in the
Config tab.

To use
Select the Packet View check box in the Config tab. The bus display shows decoded packet level
information on the bus and displays the value in hexadecimal, binary, or ASCII in the bus waveform.
Select one of the available options in the End of Packet list.

RS-232 decoding displays a stream of bytes. You can organize the stream into packets with an
end-of-packet character.

Select the bus symbol table
NOTE. Symbol tables are only available when a parallel bus is selected.
Symbol files are files of alphanumeric symbol names and associated data values, and are used to map a
group value to a text string. The instrument displays the symbol in place of the numeric value. For
example, a symbol file could map an address group value to a specific bus cycle. This decoding makes it
easier to recognize and locate specific numeric values on the bus.
Symbol files must follow a specific format (see page 158) to be compatible with the file reader of the
instrument.
From the Bus Setup window, select the Configure tab.
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Symbol file format

To use
Scroll through the Bus list <B1-B16> and select the bus to configure.
Select the Display tab.
Click the Use Symbol File check box.
Click the Browse button to locate the file (see page 160).

NOTE. The instrument looks for decode symbol table files in the C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory.

Behavior
The instrument searches for the numeric value in the symbol table file and displays the corresponding
symbol. For example, you might define a numeric value to display as RESET. If the instrument does not
find a symbol assigned to a numeric value, the numeric value displays.
What do you want to do next?
Learn about the symbol file format. (see page 158)
Learn how to find and open a symbol table file. (see page 160)
See an example of parallel bus values displayed as symbols. (see page 596)
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn more about bus configuration. (see page 151)

Symbol file format
NOTE. Symbol tables are only available when a parallel bus is selected.
The instrument requires a specific format to be compatible with the instrument reader. The instrument uses
a format called TSF, which is the TLA Symbol Format used with Tektronix logic analyzers.
The file extension is .tsf. You can use any text editor to create the file.
The file contains a TSF header line and lines to define the symbol names and values. White space (blank
spaces or tabs) separates fields on a line. The first few lines of a file are typically comment lines to
describe the file.
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All lines in the file that begin with a number sign (#) character are treated as comments, unless the very
next character is a plus sign (+). The plus sign signifies a reader directive. The number sign character can
also initiate a comment on the end of a symbol definition. All text between the number sign and the end
of the line is treated as a comment and ignored.
A TSF header identifies the file format version to the reader in the instrument. The header also specifies
that the file contains pattern symbols and the number system radices used to specify symbol values.
The next graphic shows an example of a TSF header in a symbol file. The first few lines are comments
that describe the file and are not required as part of the file header.
After the comment lines (if any), the file must contain the TSF header line that starts with the #+ characters
and the Version number. The Version number contains three fields. The first two fields are the file format
major and minor version numbers. The instrument only reads TSF files where the major and minor version
number of the file is less than or equal to that of the instrument reader. The third field denotes minor
format changes, which do not impact the file reader.
In the header, the Version number is followed by the word PATTERN.
Next in the header are two radix fields: Display and File. The Display Radix field sets the default radix
that will be used to display the numeric symbol value. This field must be HEX, OCT, DEC, or BIN.
The File Radix field specifies the radix used by the symbol values in the file. The File Radix field must
be HEX, OCT, DEC, or BIN.

You can create symbol names from ASCII with up to 220 characters. The numeric values must reflect
the base specified by the File Radix field. An X represents a “don't care” value. The number of bits
represented by each character depends on the radix. For a HEX value, each character represents 4 bits. For
an OCT value, each character represents 3 bits. For a BIN value, each character represents 1 bit.
NOTE. The order of the symbols in the file is important. The instrument scans the list of pattern symbols
starting from the top of the file and displays the first symbol that matches the bits with numeric values
(not Xs).
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Opening a bus symbol table file

To use
Create a TSF file with symbols and numeric values.
Copy the file to the C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory on the
instrument.
From the Bus Setup window, select the Config tab and select a bus to decode.
In the Display tab, select the Use Symbol File check box.
Click the Browse button to locate the file.

Behavior
The instrument searches for the numeric value in the symbol table file and displays the corresponding
symbol. If the instrument does not find the numeric value, there is no symbol and the numeric value
displays.
What do you want to do next?
See an example of parallel bus values displayed as symbols. (see page 596)
Learn how to find and open a symbol table file. (see page 160)
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn more about bus configuration. (see page 151)

Opening a bus symbol table file
NOTE. Symbol tables are only available when a parallel bus is selected.
From the Bus Setup window, select the Display tab, and then select the Use Symbol File check box.

To use
1. Click the Browse button to locate the file.
2. Navigate to the file location or select a symbol table file from the dialog box.
3. Click Open.
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Behavior
This dialog box opens to the default directory C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables. If you saved the file in another directory, you need to copy the file to the
C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory, where the instrument expects to
find it. When you open a symbol table file, the instrument uses the values to decode and display bus
values to be easier to recognize.
NOTE. The only available file is in TSF format.
What do you want to do next?
Learn about bus symbol tables. (see page 157)
Learn about the format. (see page 158)
See an example of parallel bus values displayed as symbols. (see page 596)
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Using MagniVu

Using MagniVu
NOTE. The MagniVu feature is available on MSO5000B models and on DPO5000B models with option
MSOE..
Select MagniVu in one of the following ways:
Digital menu.
Horiz/Acq menu.
Horiz/Acq > Horizontal/Acquisition Setup and click Acquisition tab.

Overview
Turn on or turn off MagniVu.

To use
Select MagniVu to increase the resolution.

Behavior
MagniVu gives you higher resolution to accurately determine edge placement. This helps you make
precise timing measurements on digital edges. You can see up to 32 times more detail than with normal
digital channel sampling. The MagniVu record is acquired in parallel to the main digital acquisition and is
available at any time, running or stopped. MagniVu provides an ultra high resolution view of your data
sampled at a maximum resolution of 60.6 ps for 10,000 points centered around the trigger.
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Using MagniVu

With MagniVu option disabled:
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Using MagniVu

With MagniVu option enabled (the Sample Rate and Resolution values set):

NOTE. The MagniVu record must always contain the trigger. If the trigger point is moved prior to the
display region using Horizontal Delay, then the MagniVu record will not be available. In most of these
cases, you can find the digital record by looking for the digital signal in the upper overview and panning
accordingly.
NOTE. You should turn on MagniVu when light gray shading is displayed to indicate the uncertainty of the
edge position. If the shading is not displayed, you do not need to use MagniVu.
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Using MagniVu
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Display control window (Appearance tab)

Display control window (Appearance tab)
From the Display menu, select Display Setup.

Overview
Use the Display General tab controls to change the display style, persistence, intensity, format, and
interpolation.
For information on the controls, click the buttons.

NOTE. The following screen appears on MSO/DPO5000B Series instruments.

What do you want to do next?
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)
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Display control window (Screen Text tab)

Learn about changing the display colors. (see page 172)

Display control window (Screen Text tab)
From the Display menu, select Screen Text, or open the Screen Text tab in the Display control window.

Overview
Use the controls on the Screen Text tab to define text captions that you can add to the instrument display.

To use
You can create up to eight lines of text to provide notes for screen shots, printouts, or for other instrument
users.
Click in a text field, 1 through 8.
Click the Text <1–8> button to turn the message text On or Off on the display.
Click the Font button to open the Font dialog box and change the font properties of the text.
Click the Color button to open the Color dialog box and change the color properties of the text.
Click the Clear button to delete the message text. (Text button must be On)
Click Controls button to open the Text Properties control window (see page 170), where you can define
the positioning of the message on the display.

Behavior
Click on one of the numbered lines and use the pop-up keyboard to enter up to 64 alphanumeric characters
of text per line.
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Click Clear to clear the entire text of the selected line. The screen text that you enter is not related to any
waveform labels that you may have created. The waveform labels help you identify waveforms on the
screen, while the screen text is intended to provide information or notes for screen shots or printouts.
TIP. Position the text on the screen by clicking and dragging the text to the desired location on the graticule.
What do you want to do next?
Learn about defining screen text properties. (see page 170)
Learn about changing the overall display appearance. (see page 167)
Learn about changing the display colors. (see page 172)
Learn about changing the appearance of objects in the display. (see page 171)
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Text properties control window

Text properties control window
From the Display menu, select Display Setup; then open the Screen Text tab and click the Controls button.

Overview
Use the Text Properties control window to position text to specific locations on the graticule.

To use
Select the line of text from the Screen Text drop-down list; then use the X Pos and Y Pos controls to define
the location of the text on the graticule.

Behavior
The text from the drop-down list is the text you defined under the Screen Text tab of the Display control
window.
The units for the position controls are in pixels. The minimum values are 1 for both X and Y positions.
The maximum X value is 450; the maximum Y value is 390. The origin of the X position is the left vertical
graticule boundary, while the origin of the Y position is the upper horizontal graticule boundary.
Setup opens the Display control window with the Screen Text tab selected. Click Setup to enter new
lines of text.
TIP. You can also position the text on the screen by clicking and dragging it to the desired location.
What do you want to do next?
Learn about using text with screen displays. (see page 168)
Learn about changing the overall display appearance. (see page 167)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about changing the display colors. (see page 172)
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Display control window (Objects tab)

Display control window (Objects tab)
From the Display menu, select Objects, or open the Objects tab in the Display control window.

Overview
Use the Objects tab controls to change the appearance of objects on the oscilloscope display.
For information on the controls, click the buttons.

To use
Click the Date/Time button to show the current date and time on the graticule.
Click the Trigger T (see page 172) button to turn this display marker on and off.
What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

171

Display setups

Display control window (Colors tab)

Trigger T marker

Display control window (Colors tab)
From the Display menu, select Colors, or open the Colors tab in the Display control window.

Overview
Use the controls on the Colors tab to change waveform color palettes. You can define colors for the
live, math, and reference waveforms.
If you are using Waveform Database acquisition mode, select the FastAcq/WfmDB Palette. For all other
acquisition modes, use the Record View Palette.
For information on the controls, click the buttons.

What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the appearance of objects in the display. (see page 171)
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Display persistence

Learn about using text with screen displays. (see page 168)

Display persistence
From the Display menu, select Display Setup; then open the Appearance tab.

To use
Click one of the buttons to select the display persistence.
Click Infinite (persistence) to continuously accumulate record points on the waveform until you
change one of the acquisition display settings.
Click Variable; then click in the Time entry box and use the multipurpose knobs to set the persistence
time.
Click Reset to clear the persistence.
Click the Controls to activate the Persistence Control window.

Behavior
Use infinite persistence for displaying record points that may occur outside the normal acquisition
envelope.
Use Variable to accumulate record points on the waveform for a specified time interval. Each record
point decays independently according to the time interval.
If you click Off, the waveform record points appear for the current acquisition only.
TIP. Use the Display menu Display Persistence submenu or right-click in the graticule and select Display
Persistence from the shortcut menu to directly access the persistence options.
What do you want to do next?
Learn about changing the display colors. (see page 172)
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Select the display format

Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)

Select the display format
From the Display menu, select Display Setup; then open the Appearance tab.

To use
Click one of the buttons to select the display format.

Behavior
YT format is the conventional oscilloscope format:
Amplitude appears on the vertical axis as the signal varies over time on the horizontal axis.
When you set the vertical position to center the display in YT format, the XY display is at center
screen, and each division of display in YT mode produces a division of display in XY mode.
XY format plots the amplitude of one waveform against the amplitude of another waveform on a
point-by-point basis:
This format is useful for showing the relationship between two signals, such as current and voltage
waveforms that combine to form an I-V characteristic.
When using this format, waveforms appear according to their channel pairings (see page 175). XY
format is a dot-only display, although it can have persistence.
The Vector style selection has no affect when you using XY format.
When using this format, the horizontal scale continues to control the time base and the horizontal
position continues to control the portion of the waveform that is shown.
Vectors and Intensified Samples (see page 813) selections are not available when using the XY
Display Format.
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XYZ format compares the voltage levels of the X and Y channel waveform records point-by-point, as in
XY format. The displayed waveform intensity is modulated by the Z channel waveform record. Refer to
the table below for channel assignments.
X-Axis input

Y-Axis input

Z-Axis input

Ch 1

Ch 2

Ch 3

xxx

A -5.0 division signal, including position and offset, on the Z channel produces a blank screen; a
+5.0 division signal produces full intensity.
NOTE. Selecting YT or XY only affects the display. The Horizontal, Vertical, and Position knobs (and
menus) control the same parameters except in the Fast. Acquisition XY format where the horizontal
scale setting is not used.
TIP. Use the Display menu Display Format submenu to directly access the format types.
What do you want to do next?
Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)

XY format pairs
When you use the XY display format, channel and reference waveforms are assigned to the axis
indicated in the following table.
XY Pair

X Axis

Y Axis

Ch 1 and Ch 2

Ch 1

Ch 2

Ch 3 and Ch 4

Ch 3

Ch 4

Ref 1 and Ref 2

Ref 1

Ref 2

Ref 3 and Ref 4

Ref 3

Ref 4

xxx

If you only display one source when you enter the XY format, the instrument automatically turns on
the other source waveform to complete the XY pair.
NOTE. You cannot display math waveforms in XY format. You cannot display logic waveforms
in XY or XYZ format.
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Set the waveform intensity

Set the waveform intensity
From the Display menu, select Display Setup; then open the Appearance tab.

To use
Click in the Record View entry box and use a multipurpose knob to adjust the intensity of live
waveforms, except when using Fast Acquisition or Waveform Database acquisition mode.

Click in the FastAcq/WfmDB entry box and use a multipurpose knob to adjust the intensity of live
waveforms when using Fast Acquisition or Waveform Database acquisition mode.

NOTE. Backlight control option is available only on MSO/DPO5000B and DPO7000C Series instruments.
Click in the Backlight list box and use the multipurpose knob to adjust the intensity of the backlight
to the required option.

What do you want to do next?
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about changing the display colors. (see page 172)

Select the waveform interpolation
From the Display menu, select Display Setup; then open the General tab.
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Select the waveform interpolation

To use
Click one of the buttons to select the interpolation that best displays the waveforms. Interpolation globally
affects all displayed waveforms.

Behavior
The instrument interpolates waveforms in Zoom mode when there is less than one sample for each pixel
column. These functions are performed on the acquired data as compared to the displayed data.
Click Sin(x)/x to compute record points along a curve between the actual acquired samples. This form
of interpolation is useful when acquiring rounded waveforms such as sine waves. It is good for
general-purpose uses but may introduce overshoot or undershoot in signals with fast rise times. This
interpolation is also useful for looking at high-frequency signals, especially where the frequency
components are just below the Nyquist frequency (see page 177).
Click Linear to compute record points between actual acquired samples using a straight-line fit. This
interpolation is useful for measuring waveforms with fast rise times, such as pulse trains.
TIP. Use the Display menu Waveform Interpolation submenu to directly access the interpolation options.
You may want to set the display style so that the real samples are intensified and interpolated samples
are dimmed.
What do you want to do next?
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about changing the display colors. (see page 172)

Nyquist frequency
The highest frequency that any digital oscilloscope can measure without errors is one-half of the
sample rate or frequency. This frequency is called the Nyquist frequency.
The FFT waveform displays the input signal frequency components from DC (0 Hz) to the Nyquist
frequency.
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Select the graticule style

Select the graticule style
From the Display menu, select Objects, or open the Objects tab in the Display control window.

To use
Click one of the buttons to select the graticule (display grid) style.

Behavior
Full provides a grid, cross hairs, and frame on the instrument display. Use Full to make quick
estimates of waveform parameters.
Cross Hair shows cross hairs and a frame on the instrument display. This style is useful for making
quick estimates of waveforms while leaving more room on the display for automatic readouts and
other data.
Grid shows a frame and a grid on the instrument display. This style is useful for making quick,
full-screen measurements with cursors and automatic readouts when cross hairs are not needed.
Frame shows only a frame on the instrument display. This style is useful with automatic readouts
and other screen text when other display features are not needed.
Use IRE if you are working with NTSC video signals. The instrument sets the graticule to
accommodate the vertical position and scale of the signal.
Use mV if you are working with video signals other than NTSC. The instrument sets the graticule to
accommodate the vertical position and scale of the signal.
Solid is similar to Full, but the grid, cross hairs, and frame are drawn using solid lines.
TIP. Use the Display menu Graticule Style submenu to directly access the graticule style options.
What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
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Define the color palette

Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)

Define the color palette
From the Display menu, select Colors, or open the Colors tab in the Display control window.

To use
Click the buttons to define the color for displayed waveforms.
Use the buttons under FastAcq/WfmDB Palette to define the color for live waveforms when using
Waveform Database acquisition mode.
For some models, click the Edit button to activate the Display Palette (see page 670), where you can
customize a waveform color.

TIP. Use the Display menu Record View Palette or the WfmDB Palette submenu to directly access the
color palettes.

Behavior
Click Normal to define hues and lightness levels for best overall viewing. The color of each channel
waveform matches the color of the corresponding front-panel vertical SCALE knob.
Click Spectral (Spectral Grading) to define areas of the waveform with the highest sample density
appear in blue shades while the areas of lowest sample density appear in red shades.
Click Temp (Temperature Grading) to define areas of the waveform with the highest sample density
appear in warmer colors (red shades) while the areas of lowest sample density appear in cooler
colors (blue shades).
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Click Gray (Monochrome Gray) to define waveforms in shades of gray. Areas of the waveform with
the highest sample density appear in lighter gray shades while the areas of lowest sample density
appear in darker gray shades.
Click Green (Monochrome Green) to define waveforms in shades of green. Areas of the waveform
with the highest sample density appear in lighter green shades while the areas of lowest sample
density appear in darker green shades.
Click User to display a color that you have previously defined with the User Palette.
TIP. The Green palette simulates the display of an analog oscilloscope.
What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about using text with screen displays. (see page 168)

Remote operation
Remote desktop connection
You can find the network setup program in the Windows Start menu. Either select All Programs >
Accessories > Remote Desktop Connection, or select Programs > Accessories > Communications >
Remote Desktop Connection.
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Horizontal/Acquisition control window (Horizontal tab)

Horizontal/Acquisition control window (Horizontal tab)
From the Horiz/Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab.

Overview
The Horizontal control window manages the horizontal parameters of waveforms. The controls in the
Horizontal tab are common to all channels.
Use the Horizontal tab to set up the horizontal mode and to adjust the horizontal scale. Normally, the
horizontal axis displays time information. However, in some cases, the horizontal axis can represent
frequency rather than time.
For information on the controls, click the buttons.
In the following two screens, Digital Sample Rate, Digital Resolution, and Digital Record Length only
appear on MSO series instrument.

What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 902)
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Set Record Length Limit

Learn about the Acquisition Setup controls (see page 185)

Set Record Length Limit
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then click Record Length Limit.

To use
Use the Record Length Limit entry box to set the maximum record length.
Use the Max button to set the record length limit to its maximum value.
Use the Min button to set the record length limit to its maximum value.

To increase the update rate, lower the record length limit. To enable higher sample rates or digital filtering
at slower horizontal scales, increase the record length limit.
What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 902)
Learn about the Acquisition Setup controls. (see page 185)

182

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Horizontal and acquisition setups

Horizontal digital control window

Horizontal digital control window
NOTE. The Horizontal Digital control window is only available when a parallel bus is selected on MSO
models and on DPO5000B models with option MSOE installed, and DPO70000DX instruments with
option MSOU installed.
From the Horiz /Acq menu, you can view the Digital Sample Rate and Digital Resolution of logic
waveforms. The values track the sample rate and resolution of the analog system.

To use
Use the Sample Rate and Scale entry boxes to set the Digital Sample Rate and the Digital Resolution.
The following screen is captured on MSO70000C/DX Series instruments:

The following screen is captured on MSO/DPO5000B Series instruments:

What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 902)
Learn about the Acquisition Setup controls. (see page 185)
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Horizontal Position/Scale control window

Horizontal Position/Scale control window
From the Horiz /Acq menu, select Position/Scale.

Overview
Use the Horizontal control window to set the horizontal position and scale of displayed waveforms.
For information on the controls, click the buttons.

To use
Click the Delay Mode button to toggle the horizontal delay on (see page 185).

Behavior
You can use this control window to turn on horizontal delay so the acquisition window can be focused on
events that occur at a fixed delay after the trigger point.
NOTE. The dedicated Horizontal controls on the front panel also perform the same functions.
What do you want to do next?
Learn more about the Horizontal Position controls. (see page 834)
Learn more about the Horizontal Scale controls. (see page 835)
Learn more about the Horizontal Delay Mode. (see page 834)
Learn more about the Horizontal controls. (see page 198)
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Horizontal Position/Scale control window: delay mode on

Horizontal Position/Scale control window: delay mode on
From the Horiz /Acq menu, select Position/Scale.

Overview
Use the Horizontal control window to set the horizontal delay and the horizontal scale of the displayed
waveforms when the horizontal delay is on.
For information on the controls, click the buttons.

To use
Click the Delay Mode button to toggle the horizontal delay on or off.

Behavior
You can use this control window to turn on horizontal delay so the acquisition window can be focused on
events that occur at a fixed delay after the trigger point.
NOTE. The dedicated Horizontal controls on the front panel also perform the same functions.
What do you want to do next?
Learn more about the Horizontal Delay Mode. (see page 836)
Learn more about the Horizontal Scale controls. (see page 837)
Learn more about the Horizontal controls. (see page 198)

Horizontal/Acquisition control window (Acquisition tab)
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Acquisition tab.
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Horizontal/Acquisition control window (Acquisition tab)

Overview
Use the Acquisition tab to set the acquisition parameters for all live waveforms. The Acquisition controls
are common to all channels. This means that you cannot acquire in Sample mode on channel 1 while
channel 2 acquires in Envelope mode.

To use
For information on the controls, click the buttons.

The following screen appears on MSO/DPO5000B Series instruments:
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Autoset

Behavior
Acquisition is the process of sampling the analog input signal, digitizing the signal to convert it into digital
data, and then assembling the signal information into a waveform record. The instrument creates a digital
representation of the input signal by sampling the voltage level of the signal at regular time intervals. The
sampled and digitized points are stored in memory along with the corresponding timing information. The
instrument uses the digital representation of the signal for display, measurements, or for further processing.
Use the controls on this tab to define the sampling method, the acquisition mode, turn Fast Acquisitions on
or off, and activate an external reference.
On MSO5000B models and DPO5000B models with option MSOE, you can turn on or turn off MagniVu.
What do you want to do next?
Learn about Acquisition modes. (see page 838)
Learn about MagniVu. (see page 163)

Autoset
From the Horiz/Acq menu, select Autoset or push the front panel Autoset button.

Overview
Use Autoset to automatically set up the front-panel controls based on the characteristics of the input signal.
This is much faster and easier than manually setting up the controls.

Autoset may change the vertical position to place the waveform appropriately on screen. The instrument
always sets vertical offset to 0 V.

To use
If you use Autoset when one or more channels are displayed, the instrument selects the lowest numbered
channel for horizontal scaling and triggering. The instrument individually scales all displayed vertical
channels. If you use Autoset with no vertical channels displayed, the instrument turns on and scales
channel 1.
The Autoset Undo (see page 189) button opens in a control window after the instrument completes the
operation. Click this button to undo only the parameters adjusted by the last Autoset.
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NOTE. The Autoset Undo control window remains on the screen until you open another control window.
After Autoset Undo closes, you can still undo the last Autoset by selecting the Undo Last Autoset command
from the Edit menu or the Horiz/Acq menu. Although the last Autoset is immediately undone, the Autoset
Undo control window does not open again.
Select User Preferences from the Utilities menu to display the Prompt Before Action (see page 559)
window.
Click Autoset to toggle between Off and On. Off immediately performs an Autoset when the Autoset
button is pushed. On displays a prompt when the Autoset button is pushed.
Click Close to save your selection.
The following table lists the Autoset default settings.
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Control

Changed by Autoset to

Selected Channel

Last channel selected

Acquisition Mode

Sample

Run/Stop

Run

Deskew, Channel/Probe

Unchanged

Display Style

Vectors

Display Intensity–Record View

If less than 50%, set to 75%

Display Format

YT

Horizontal Position

Centered within the graticule window

Graticule Setting

Unchanged

Horizontal Scale

As determined by the signal frequency, or 100 µs/div

Record Length and Sample Rate

When a new time per division is calculated, the sample rate
changes to maintain the current record length. If the sample
rate cannot be changed because of hardware limitations,
the sample rate is set to maximum while the record length is
reduced to maintain the time per division.

Trigger Position

Delay Off

Trigger A >B Sequence

A Only

Main Trigger Type

Edge

Trigger Source

Numerically lowest displayed channel (the selected channel)

Trigger Level

50% of selected channel amplitude

Trigger Slope

Positive

Trigger Coupling

DC

Trigger Holdoff

Minimum setting

Vertical Scale

As determined by the signal level

Vertical Position

As determined by the number of active channels

Vertical Coupling

DC unless AC was previously set. AC remains unchanged.

Vertical Bandwidth

Full
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Control

Changed by Autoset to

Vertical Offset

0 volts

Zoom

Off

xxx

Set Autoset preferences
From the Utilities menu, select User Preferences and the Prompts tab.

Overview
You can set the instrument to display a prompt asking you to confirm the requested action before applying
the Autoset function.

To use
Select User Preferences from the Utilities menu to display the Prompt Before Action (see page 559)
window.
Click Autoset to toggle between Off and On. Off immediately performs an Autoset when the Autoset
button is pushed. On displays a prompt when the Autoset button is pushed.
Click Close to save your selection.

Undo an autoset
Press Autoset on the instrument front panel to undo the last autoset operation.

Overview
The Autoset Undo window opens automatically following an autoset. Use this control to undo the last
autoset operation.
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To use
Click Undo. Only the parameters set by the last autoset are undone. The settings you have changed
since the last autoset (that are not controlled by Autoset) remain unchanged.
Click OK to close the window and proceed without an Undo.

Behavior
The Autoset Undo window remains open until you click Undo or OK. After the Autoset Undo window
closes, you can still undo the last autoset by selecting Undo Last Autoset from the Edit or Horiz/Acq
menus; the last autoset is immediately undone but the Autoset Undo control window does not open again.
To suppress the AutoSet Undo window following an autoset, do the following:
1. From the Utilities menu, select User Preferences.
2. Open the Prompts tab.
3. Under Prompt user before performing requested action, toggle the Autoset Undo button to Off.
What do you want to do next?
Learn about Autoset. (see page 189)

Enable enhanced effective number of bits
From the Horiz /Acq menu, select Horizontal/Acquisition Setup, and then select the Acquisition tab.

Overview
Use this control to turn the Enhanced Effective Number of Bits (ENOB) on or off to optimize waveform
detail.
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To use
1. Click the Enhanced Effective Number of Bits check box to turn ENOB On or Off. You will find this
control in the Acquisitions tab of the Horizontal/Acquisition control window (see page 185),

Behavior
Enhanced Effective Number of Bits enables interleave correction DSP that improves the effective number
of bits. This control is only available in some instrument models. This control is not available in Hi
Res mode.
When Enhanced Effective Number of Bits is enabled, EB+ is displayed in the horizontal/acquisition
readout.

Enable fast acquisitions
From the Horiz /Acq menu, select Fast Acquisitions, or press the front panel Fast/Acq button.

Overview
Use these controls to turn the Fast Acquisition feature on or off and to optimize waveform detail.

To use
1. Click the Fast Acq button to turn Fast Acquisitions On or Off. You will also find this control in the
Acquisitions tab of the Horizontal/Acquisition control window (see page 185),
2. Click the option boxes to optimize acquisitions for your measurement: Capturing Details with Higher
Sample Rate enhances waveforms detail, Capturing Rare Events with More acquisitions provides
the fastest update rate.
NOTE. The options Capturing Details with higher sample rate and Capturing rare events with more
acquisitions are not available on MSO/DPO5000B Series instruments.
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Behavior
Fast Acquisitions mode keeps the dead time (see page 192) between acquisitions very short. This improves
the chances of acquiring infrequent events. When Fast Acquisitions are turned on, the front-panel FastAcq
button is lighted.
If Fast Acquisitions mode is on and you attempt to activate a feature that conflicts with this mode, Fast
Acquisitions mode will be inhibited. When the conflicting feature is turned off, in most cases, Fast
Acquisitions will resume.
What do you want to do next?
Learn about Roll mode. (see page 193)

Dead time
Dead time is the time that the instrument requires to process an acquisition.

The instrument cannot acquire any new data until the previous data has been processed. If dead time
is long, the instrument can miss acquiring infrequent events.

Start and stop waveform acquisitions
From the Horiz /Acq menu, select Run/Stop.

Overview
Use the Run/Stop control window to start and stop waveform acquisition.

To use
Click Run/Stop to toggle waveform acquisition. (You can also press the front panel Run/Stop button.)
Click Single Sequence to complete a single acquisition sequence.
Click Force Trigger to immediately start acquiring waveform data without a valid trigger event.
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Behavior
These controls operate identically to the front-panel controls.
Click Run/Stop once to stop waveform acquisition. The Status readout at the top of the graticule
changes from Running to Stopped and shows the number of acquisitions. Click Run/Stop again to
resume waveform acquisition.
Click Single Sequence to provide a single sequence of acquisitions each time you click the button.
When Single Sequence is enabled, the front-panel single sequence (Single) button is lighted.
In Sample, Peak Detect, or Hi Res acquisition modes, the instrument acquires waveform records with
the first valid trigger event and then stops. In Average or Envelope acquisition modes, the instrument
makes the specified number of acquisitions to complete the averaging or enveloping task.
In Waveform Database mode, the instrument acquires and displays a waveform that is the
accumulation of several acquisitions. In addition to time and amplitude, the waveform displays a count
of the number of times a specific sample point has been acquired.
When you click Single Sequence (or press the Single button) in Equivalent Time mode, the instrument
continues to recognize trigger events and acquires samples until the waveform record is filled.
Click Force Trigger once to acquire a waveform record without a trigger event. Forcing a trigger is
useful when the input signal does not contain a valid trigger. The instrument recognizes and acts
upon the forced trigger even when you click the button before the end of the pretrigger holdoff. The
button has no effect when acquisitions are stopped.
What do you want to do next?
Go to the Horizontal/Acquisition control window. (see page 181)
Return to the Acquisition Setup control window. (see page 185)
Return to the Trigger Setup control window. (see page 393)

Enable Roll mode
From the Horiz /Acq menu, select Roll Mode Auto, or click Roll Mode in the Acquisition tab of the
Horizontal/Acquisition control window (see page 185).

Overview
Use these controls to turn Roll Mode on or off.
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Roll mode lets you see acquired data without waiting for the acquisition of a complete waveform record.
It gives you immediate feedback. For slow time base settings, Roll mode provides a rolling display
similar to a strip-chart recorder.

To use
The resolution appears near the lower-right corner of the graticule and is controlled by the Resolution
knob.
Use Untriggered Roll Mode to continuously observe a slow process. Apply math and measurement
operations after you stop the acquisition.
When Roll mode is on, the Acquisition Status Indicator Readout displays Roll.

Behavior
When using Roll mode, you do not have to wait for slow acquisitions to fill the display. When Roll mode
is enabled, the instrument displays newly acquired data points at the right edge of the display while
moving the older waveform data points to the left.
Using single sequence with roll mode causes the acquisition to automatically stop after a complete
waveform record is acquired. Roll mode is useful when observing a slow process where you always want
to see the most recent view of that process. Roll mode with single sequence is useful to save data for later
viewing. For example, at 20 seconds per division and 30 K record length, there are 12,000 seconds
of acquired data points.
The maximum record length where Roll mode is allowed is 10 M.
What do you want to do next?
Learn how Roll mode interacts with other instrument settings. (see page 847)
Learn about Equivalent Time mode. (see page 194)

Select a sampling mode
From the Horiz /Acq menu, select Sampling Modes, or select a sampling Mode in the Acquisition tab of
the Horizontal/Acquisition control window (see page 185).
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To use
To enable a sampling mode, click one of the Sampling Modes button.

In Real Time, the instrument acquires all the points in a waveform record after one trigger event.
In Interpolated time, the instrument interpolates between the samples it acquires when it cannot acquire
all the real samples it needs to fill up its waveform record after one trigger event. The instrument can
interpolate either as part of an acquisition or as part of the zoom/display behavior.
In Equivalent time, the instrument uses multiple trigger events to fill all the points in its waveform
record. Equivalent time sampling begins when the time base setting (horizontal scale) is too fast for
the instrument to acquire all the points in a waveform in one trigger event.
NOTE. In real-time sampling, the instrument digitizes all of the points it acquires after one trigger event.
Always use real-time or interpolated sampling to capture single-shot or transient events.

Behavior
Equivalent Time mode lets you accurately acquire repetitive waveforms at sample rates much higher than
the base analog-to-digital converter sample rate. Equivalent time sampling is generally not useful for
acquiring time-varying, random, or single-shot events.
The instrument takes a few samples with each trigger event and eventually obtains enough samples to
construct a waveform record. The instrument takes samples independent of the trigger position and
displays them based on the time difference between the sample and the trigger. You should only use
Equivalent Time mode on repetitive signals.
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The sampling speeds and the number of channels you choose affect the mode the instrument uses to
sample waveforms. The instrument always uses real-time sampling at slower time base settings; faster
time settings force the instrument to switch from real-time sampling to equivalent-time sampling.
The following tables show the time base setting(s) at which the switch from real-time sampling (RT) to
equivalent-time sampling (ET) occurs for your instrument.
Sampling mode selection DPO7354C, DPO7254C, and DPO7104C with Option 2SR
Channels on

1

2

3 or 4

Time base ≥100 ps/pt

RT

RT

RT

50 ps/pt

RT

RT

ET

25 ps/pt

RT

ET

ET

≤25 ps/pt

ET

ET

ET

Sampling mode selection DPO7104C, and DPO7054C
Channels on

1

2

3 or 4

Time base≥200 ps/pt

RT

RT

RT

100 ps/pt

RT

RT

ET

50 ps/pt

RT

ET

ET

≤50 ps/pt

ET

ET

ET

Sampling mode selection DPO7054C
Channels on

1

2

3 or 4

Time base≥400 ps/pt

RT

RT

RT

200 ps/pt

RT

RT

ET

100 ps/pt

RT

ET

ET

≤100 ps/pt

ET

ET

ET

Sampling mode selection MSO70000C/DX and DPO70000C/DX
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Channels on

1

2

3 or 4

Time base≥40 ps/pt

RT

RT

RT

≤20 ps/pt

ET/IT

ET/IT

ET/IT
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Sampling mode selection MSO/DPO5054B and MSO/DPO5034B
Channels on

1

2

3 or 4

Time base ≥20 ns/div

RT

ET

RT

10 ns/div

ET/IT

ETIT

ET/IT

Sampling mode selection MSO/DPO5204B and MSO/DPO5104B
Channels on

1

2

3 or 4

Time base ≥20 ns/div

RT

RT

RT

10 ns/div

RT

RT

ET

≤5 ns/div

ET/IT

ET/IT

ET/IT

xxx

The type of equivalent-time sampling the instrument uses is called random equivalent-time sampling.
Although it takes the samples sequentially in time, it takes them randomly with respect to the trigger.
Random sampling occurs because the instrument sample clock runs asynchronously with respect to the
input signal and the signal trigger. The instrument takes samples independently of the trigger position and
displays them based on the time difference between the sample and the trigger.
What do you want to do next?
Go to the Horizontal Setup control window. (see page 181)
Return to the Acquisition Setup control window. (see page 185)
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Set the resolution
From the Horiz /Acq menu, select Resolution.

Overview
Use the Resolution control window to select the number of samples per division for all acquired waveforms.

To use
Click in the Record Length control box and use the multipurpose knob or keypad to change the setting.

Behavior
The Duration, Sample Rate, and Resolution controls are readouts only. Their settings are impacted by
other controls.
Duration specifies the time across the 10-division screen.
Sample Rate specifies the number of samples per second that will be acquired for each waveform. The
faster the sample rate, the more accurately the instrument can represent fine details in a fast signal.
Resolution is similar to the acquisition interval. It can be thought of as the time between sample points.
In most cases, the acquisition interval is the same as the resolution.
Record Length specifies the total number of samples in the waveform acquisition. The maximum
record length depends on the amount of memory in the instrument. Because the instrument can only
store a finite number of waveform data points, there is a trade-off between the waveform details and
the record length. You can acquire either a detailed picture of a waveform for a shorter period of time
or a less detailed picture for a longer period of time.
What do you want to do next?
Learn about the Horizontal Setup control window. (see page 181)
Learn about the Acquisition Setup control window. (see page 185)

Select the acquisition mode
From the Horiz /Acq menu, highlight Acquisition Mode; then select Mode.
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Overview
The acquisition mode determines how the waveform data points are produced from the sampled data.

To use
Select the acquisition mode by clicking the appropriate button.
If you use Average or Envelope mode, select the number of waveforms for that mode using the
multipurpose knob.
If you use Waveform Database mode, select the number of samples using the multipurpose knob.

Behavior
A single waveform data point can be made up of several sequentially acquired data points. The waveform
data points can also be created from a composite of sampled data taken from multiple acquisitions.
Sample mode acquisition creates a record point by saving one or more samples during each acquisition
interval (see page 200). Sample mode is the default acquisition mode. The instrument does no post
processing of the acquired samples in this mode.
Pk Detect (Peak Detect) acquisition alternates between saving the highest sample in one acquisition
interval and the lowest sample in the next acquisition interval. Peak Detect mode only works with
real-time, noninterpolated sampling.
Hi Res (High Resolution) acquisition averages all samples taken during an acquisition interval to
create a record point. This average results in a higher-resolution, lower-bandwidth waveform. This
mode only works with real-time, noninterpolated sampling.
Envelope acquisition acquires and displays a waveform record that shows the extremes in variations
over several acquisitions. The instrument saves the highest and lowest values in two adjacent intervals
similar to the Peak Detect mode. Unlike Peak Detect mode, the peaks are gathered over many trigger
events.
Average acquisition acquires and displays a waveform record that is the average result of several
acquisitions. This mode reduces random noise. Use the multipurpose knob to specify the number of
waveforms that you want to average.
After each trigger event, the instrument acquires data and then compares the minimum and maximum
values from the current acquisition with those stored from the previous acquisition. The final display
shows the most extreme values for all the acquisitions for each point in the waveform record.
WfmDB (Waveform Database) acquisition acquires and displays a waveform that is the accumulation
of several acquisitions. In addition to time and amplitude, the waveform displays a count of the
number of times a specific sample point has been acquired. The value at each point on the waveform is
a counter that reflects the hit intensity. The instrument acquires data after each trigger event using
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Sample mode. It then determines the location of each sample point and accumulates it with shared data
from previous acquisitions. This is the only mode that can be used when doing mask testing with a
optical standard. Fast Acq is inhibited in Waveform Database mode.
What do you want to do next?
Learn about the Horizontal Setup control window. (see page 181)
Learn about the Acquisition Setup control window. (see page 185)

Acquisition interval
The acquisition interval is the time between sample points. For mathematical purposes, it is the time
covered by the waveform record divided by the record length.

FastFrame control windows
From the Horiz /Acq menu, select FastFrame Setup.

Overview
Use the FastFrame control windows to capture and view a series of triggered acquisitions without wasting
acquisition memory on the dead time (see page 192) between the trigger events.
For information on the controls, click the buttons.

Behavior
FastFrame mode combines multiple acquisitions into one large data record. By carefully defining the
trigger conditions, you can use FastFrame to capture only multiple events (see page 201) of the waveform
that you are interested in. Each captured event is stored sequentially in its own frame (see page 881).
The frames are in the order they were captured.
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FastFrame mode lets you jump to and view the desired frame. Time Stamps can display the absolute
trigger time for a specific frame and the relative time between triggers of two specified frames. FastFrame
lets you compare different waveforms. Math is performed on each frame.
FastFrame provides the following features:
Measure time between triggered acquisitions using time stamps (see page 202) in Sample, Peak
Detect, and Hi Res mode.
Save and recall FastFrame waveforms.
Display waveforms in YT mode.
Apply math functions to FastFrame waveforms.
Confine automatic measurements only to the displayed frame.
Overlay multiple frames for easy comparison.
FastFrame is not compatible with the following features or modes:
Equivalent Time
Histograms
Fast Acquisitions
Average
Envelope
What do you want to do next?
Learn about the frame setup controls. (see page 916)
Learn more about the Selected Frame controls. (see page 883)
Learn about the reference frame and time stamps. (see page 880)
Learn how to set up the instrument for FastFrame operation. (see page 916)
Learn some tips for using FastFrame. (see page 935)

FastFrame acquisitions
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Time stamps
Time stamps are a convenient way of measuring the time between triggers when using FastFrame.

Set up zoom
From the Vertical or Horiz/Acq menu, select Zoom Setup.

Overview
Use these control windows to define the overall settings of the Zoom controls.

To use
Click the Zoom <1–4> tabs to set up each zoom area. The controls under each tab apply only to that
zoom area. Click the Display On to turn on the display of that area. (MultiView Zoom must also
be turned on to display any of the zoom areas.)
Click in the Zoom Source entry box, and then use the drop-down list to select a source for the zoomed
area.
Click the Show/Hide Waveforms button to open the Show/Hide Waveforms dialog box; here you can
identify waveforms you do not want to display in the selected zoom area.
Click the Zoom button On to turn on Zoom. You can also toggle Zoom on and off with the MultiView
Zoom button on the front panel.
Click the Ch <1–4> entry box, and then use the drop-down list to select which waveform, (Ch <1– 4>,
Math <1–4>, or Ref <1– 4>), the Vertical Position and Factor controls adjust.
Click in the Position and Factor entry boxes, and then use the controls to change the position and
factor (or scale) in the Zoom area. They can be adjusted with the multipurpose knobs. To reset the
Position and Factor controls, click Reset.
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Click the Graticule Size down arrow and select the size of the Acquisition and Zoom windows from
the drop-down list. Select 80-20 to allocate 80% of the available display for the zoomed graticule
and 20% for the acquisition window. Select 50-50 to allocate half of the available display for the
zoomed graticule and half of the available display for the acquisition window. Select Full to use the
entire display for the zoomed graticule.
Click the Lock and Scroll tab to scroll the zoomed area(s). To scroll a single zoomed area, select the
zoom area (1–4), and then click an Auto Scroll button. You can also set the scroll speed. To scroll
multiple zoomed areas simultaneously, click Lock, and then click the zoomed areas (1–4) you want to
scroll through. This locks the zoomed areas in their relative horizontal positions.
TIP. Use the Vertical or Horiz/Acq menu Zoom Graticule Size submenu to directly access the Graticule
Split options.

Behavior
Use the Zoom Setup control window to magnify (zoom in on) a waveform without changing the main
acquisition parameters. Use Zoom when you want to temporarily look at details of a waveform.
If the zoom areas are unlocked, the Horizontal Position and Factor controls affect only the selected zoom
area. The Horizontal Position and Factor will affect all zoom areas that are locked together, such that a
change to one zoom area will change the horizontal position and factor of all the locked zoom areas.
On the Vertical Zoom tab, the Scale and Factor controls only affect the selected waveform.
What do you want to do next?
Return to the Vertical Setup control window overview. (see page 485)
Return to the Horizontal Setup control window. (see page 181)
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Use the Serial Error Detector
From the Analyze menu, select Serial Error Detector.

Overview
The Serial Error Detector requires option ERRDT. The oscilloscope Error Detector conducts Bit, Frame,
Symbol, and Character tests much like a BERT. It has the advantage that it not only counts the errors and
computes the error rates, but it also shows you where the error occurs in the signal and it allows you to
connect probes to other channels to debug the source of the errors, such as crosstalk.
The Error Detector is often used in conjunction with TekExpress software applications to conduct receiver
and margin testing.
The Error Detector has built-in preset setups that cover the most common use cases. These can be modified
and saved as custom setup files for later recall. Sample arbitrary waveform generator (AWG) setup files
are included for various SATA Gen3 and USB3 signals. These files make it easy to verify correct operation
of the Error Detector, and may be used to test a device-under-test (DUT).

To use
Select Analyze > Serial Error Detector to display the Error Detector control window.
Select a setup from the Preset Setting drop-down list and press Apply.
Press the Sync button and wait for a status of Not Counting (about 6 seconds). Depending on the
signal quality, you may need to press the Sync button more than once.
Sync gets the oscilloscope synchronized to the signal.
A status of No Signal indicates that the oscilloscope cannot detect the signal. You may need to turn on
the output of the signal generator or AWG. A status of No Sync may arise for Bit tests that require a
known pattern length, sync pattern, or alignment character.
Press the Learn button, if visible. Learn only applies to some Bit Error Tests. Frame, Symbol, and
Character tests do not require the learn operation. Learn discovers the repeating pattern in the signal
and stores it into system memory for comparison to the signal to determine errors in the signal. Once
a signal is in memory, it remains there until the next Learn operation, so you do not have to use the
Learn button every time you start testing for errors.
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Press the Run button to start the error detector.
If desired, you may press Stop or Reset at anytime. After a Stop, you can press Run again.
Run starts the Error Detector testing for errors.
Select the Results tab to see the results of running the error detector.
NOTE. The Serial Error Detector automatically resyncs and resets all counts to zero if you press Reset or
disconnect and then reconnect the signal.
If you are using one of the supplied AWG signal patterns, you can press the Force Event button on the
AWG to induce an error in the signal to verify the operation of the Error Detector. These AWG setup
files are located in Win7 in the directory C:\User\Public\Tektronix\Tekscope\ErrorDetector\AWG
Alternatively, you can verify operation by disconnecting and reconnecting the signal. There will be
massive errors when the signal is disconnected, but after the signal is reconnected the Error Detector
will resynchronize to the signal, clear the error counts and rates, and resume testing.
Press the Error Detector Off button to end the error detector session. A popup will appear saying the
trigger has changed to Edge.
What do you want to do next?
Set up the serial error detector. (see page 206)
Set error detector advanced settings. (see page 209)
Specify the error detector test pattern. (see page 210)
Set the error detector stop condition. (see page 211)

Set up the serial error detector
From the Analyze menu, select Serial Error Detector, press Setup, and then select the Source Setup tab.

Overview
If you select the Custom Setup or you select one of the presets, but want to make some changes to its
settings, then you will need to make selections in the Setup tab.
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To use
When you select the Custom_Setup, additional controls are put on the display so you can browse
for a setup file. The usual idea is to start with a setup that is close to what you want, use the UI
to specify the settings you desire, and then save the result. When you enter a new name for the
file in the file name text control, press Enter to have your editing changes accepted. Then select
the Save button to actually save the setup into the file. To recall a setup file, just browse to the
file you want and select Open. The default location for Error Detector setup files in Win7 is
C:\Users\Public\Tektronix\TekScope\ErrorDetector.
From the Source Setup tab, select the Serial Bus, Data Rate and signal Source from the drop-down
lists.
Click the Error Detection option button for the type of error you want to detect.
Press Advanced, to open the Advanced Settings window.
Click Error Detector Data Rates (see page 207) and Error Detector Standards and Buses (see page 207) to
display the data rates, standards and buses supported by the Serial Error Detector.
What do you want to do next?
Use the Error Detector. (see page 205)
Set error detector advanced settings. (see page 209)
Specify the error detector test pattern. (see page 210)
Set the error detector stop condition. (see page 211)

Data Rates Supported by the Error Detector
The range of data rates supported by the serial error detector matches the 8b/10b serial pattern trigger
range. The serial error detector will test 8b/10b-encoded data with following range of data rates: 1.25 to
1.65, 2.0 to 3.25, 3.5 to 5.2, and 5.3 to 6.25 GBaud.

Standards and Buses Supported by the Error Detector
The serial error detector has several presets for industry standards. In addition, there is a generic 8b/10b
preset. Each of these presets configure the error detector for the test types specified by the industry
standard or for the test type that makes sense for the current setup.
The test types (bit, frame, symbol, or character error) supported for each industry standard and for the
generic 8b/10b bus are listed in the following table.
Table 1: (Category) specifications
Test type
Standard

Bit

Frame

Symbol

Character

SATA

Yes

Yes

No

Yes

USB

Yes

No

Yes

Yes
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Table 1: (Category) specifications (cont.)
Test type
PCI Express

Yes

No

No

Yes

8b/10b

Yes

No

No

Yes

xxx
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Set error detector advanced settings

Set error detector advanced settings
From the Analyze menu, select Serial Error Detector, press Setup, elect the Source Setup tab, and then
press the Advanced button.

Overview
Advanced Settings allow you to set the Align Primitives and enable or disable spread spectrum clock
tracking.

To use
Click On or Off to turn Spread Spectrum Clocking (SSC Tracking) on or off.
SSC is ON by default and Tektronix recommends that it should always be ON, even if there is
no SSC on the signal.
To ignore align primitives, select the Ignore Align Primitives option button and specify the primitives
using the keypad or keyboard.
The Align Character informs the SerDes to align to 10-bit character boundaries when this character is
found in the signal. Alignment Primitives, also known as skip ordered sets, are inserted into the signal
by the DUT for purposes of pacing (keeping transmitter from overrunning the receiver).
Enter the Maximum consecutive ALIGNs using the keypad or keyboard.
The maximum consecutive aligns is a design parameter of the particular DUT that indicates how
many consecutive aligns are allowed.
What do you want to do next?
Use the Error Detector. (see page 205)
Set up the serial error detector. (see page 206)
Specify the error detector test pattern. (see page 210)
Set the error detector stop condition. (see page 211)
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Specify the error detector test pattern

Specify the error detector test pattern
From the Analyze menu, select Serial Error Detector, press Setup, and then select the Test Pattern tab.

Overview
The Test Pattern Setup provides control of the signal test pattern length and the Sync Pattern description.
These are often the most difficult settings, because they require knowledge of the signal. The Pattern
Length is the number of bits in the repeating signal being sent to the DUT or oscilloscope by the signal
generator or AWG. The Sync Pattern is a 10-, 20-, 30-, or 40-bit unique pattern in the signal that the error
detector uses to align the signal to the acquired comparison pattern. The Advanced check box just allows
you to set the Disparity of each of the Sync Pattern symbols individually. The ‘X’ means “don’t care.” The
Preset Setups set these parameters to make the job easier for the common cases.

To use
Specify the Sync Pattern, Sync Pattern Polarity, and the Pattern Length.
NOTE. Signal test patterns may be 800 to 100K bits in length, modulo 40, e.g. 800, 840, 880, 920….
What do you want to do next?
Use the Error Detector. (see page 205)
Set up the serial error detector. (see page 206)
Set error detector advanced settings. (see page 209)
Set the error detector stop condition. (see page 211)
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Set the error detector stop condition

Set the error detector stop condition
From the Analyze menu, select Serial Error Detector, press Setup, and then select the Stop Condition tab.

Overview
Use this control window to specify the action performed when the error detector detects an error.

To use
From the Stop Condition tab, select the Stop When condition. You can stop manually, after a preset
count or time that you specify, or on an error.
NOTE. Use large numbers for bit count tests: at 6 Gb/s, 60 billion tests take 10 seconds.
Select and setup the actions to perform when the stop condition is met. Using these actions, you can
preserve the information captured by the oscilloscope. You must setup the email address and the
SMTP server for Send E-mail to work.
What do you want to do next?
Use the Error Detector. (see page 205)
Set up the serial error detector. (see page 206)
Set error detector advanced settings. (see page 209)
Specify the error detector test pattern. (see page 210)

Error detector overview
The typical error detector startup sequence can be summarized as:
Select a Preset Setup
Press Sync
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Press Learn (if visible)
Press Run
The Sync operations gets the oscilloscope synchronized to the signal, the Learn operation acquires the
signal pattern into oscilloscope memory, and the Run operation starts the Error Detector testing for errors.
Note that the Learn operation only applies to some Bit error tests. Remember, Frame, Symbol, and
Character error tests do not require a Learn operation.
Then the typical sequence is to connect the DUT between the oscilloscope and the signal generator or
AWG for actual testing. After recabling, only a reSync and Run are needed, even for Bit testing, because
the signal test pattern has already been acquired into the oscilloscope memory.
There are several cable arrangements you can use with the Serial Error Detector. The first cable setup
specifically applies to SATA, PCIe, and generic 8b10b bit testing, when a Learn operation is required
to acquire the signal test pattern into Error Detector memory. However, you can use this same cable
arrangement to verify Error Detector operation.
Connect the cabling as shown for the Learn operation in SATA, PCIe, and generic bit testing.

Having done the Learn operation, you can now insert the DUT in-between the Signal Generator and
the Error Detector as shown.

With the DUT inserted between the Signal Generator and the Serial Error Detector, all you need to do to get
the Error Detector running is to press the Sync and Run buttons, because the Learn operation was completed
in the previous step. If you do another Learn operation, you risk learning errors created by the DUT.
To avoid having to rearrange the cables after the Learn operation, you may split the output of the signal
generator, putting one branch into the Error Detector and one branch into the DUT. Here the Learn
Operation is done on Ch1, but the actual error detection occurs on Ch2. You can adjust the amplitude
of the signal generator to account for the loss due to splitting the signal. This works because the Error
Detector learn operation stores the signal test pattern into error detector memory, not channel memory.
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Error detector overview

When the Error Detector is driven from the user interface, bus triggers are used whenever possible, so
that bus decoding is automatically enabled. The Decoding indicates the location of the error in the signal
by highlighting the decoded value in red, as shown in the screen capture below. You can use additional
oscilloscope channels to simultaneously probe other signals to debug the cause of the error.

What do you want to do next?
Set up the serial error detector. (see page 206)
Set error detector advanced settings. (see page 209)
Specify the error detector test pattern. (see page 210)
Set the error detector stop condition. (see page 211)
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Mask testing control window (Masks tab)

Mask testing control window (Masks tab)
From the Mask menu, select Mask Setup.

Overview
Use these controls to set up a mask test. You can set the type of mask, polarity, display, and alignment.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.
For information on the controls, click the buttons.

What do you want to do next?
Learn more about mask setups. (see page 225)
Learn more about mask test setups. (see page 227)

Serial mask testing option
Install Option MTM on DPO7000C and MSO/DPO5000B Series instruments.
Install Option MTH on MSO70000C/DX and DPO70000C/DX Series instruments.

Select a mask type
From the Mask menu, select Mask Setup; then open the Masks tab.
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Select a mask type

Overview
Use the Type controls to choose a mask. Use the standard drop-down list to select a standard for the mask
test. The Mask Polarity control will appear, depending on the standard selected. Use the Mask Polarity
controls to choose whether to test the positive pulse, negative pulse, or both.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option on some instruments before you can access the Comm triggers.

To use
1. Click one of the Type controls to select the mask type.
2. Click More for additional selections.
3. Click the standard drop-down list to select the mask standard.
4. If the Mask Polarity control is displayed, click it to select positive or negative.

Behavior
The type of mask you choose will determine which standards are available from the standard drop-down
list. The standard selected will determine whether the Mask Polarity control is displayed.
NOTE. For some masks, you may see a pop-up message that reads, "Consider System Bandwidth when
testing at this bit rate." This message appears if the bandwidth of the measurement system falls below 1.5 –
1.8 times the bit rate of the data signal. Because the T11 committee has published a strict rule of 1.8 times
the bit rate for electrical standards, be aware that useful qualitative information can be gathered at the
current system bandwidth but quantitative rise-time measurements may not be reliable. A Consider System
Bandwidth message will appear for all optical standards, since optical filtering is not available.
Alternatively, you can select Edge Setup from the Trigger menu to improve the stability.
What do you want to do next?
Learn about the Mask Display control window. (see page 219)
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Mask types and standards

Learn more about mask alignment. (see page 223)
Go to the Mask Setup control window. (see page 215)

Mask types and standards
The following tables list the Mask Types and Standards available with Mask Testing. The standards
available for your instrument depend on the bandwidth and configuration of your instrument.
The Comm Trigger is designed to work with communications mask and standard testing. Mask testing
automatically uses Communication triggers. You must install the Serial Communications Mask Testing
Option (see page 215) on some instruments before you can access the Comm triggers.
ITU-T masks
None

32 Mb 32.064 Mb/s

97 Mb 97.728 Mb/s

DS1 Rate 1.544 Mb/s

DS2 Rate Sym 6.312 Mb/s

DS2 Rate Coax 6.312 Mb/s

DS3 Rate 44.736 Mb/s

E1 Sym Pair 2.048 Mb/s

E1 Coax Pair 2.048 Mb/s

E2 8.448 Mb/s

E3 34.368 Mb/s

E4 Binary 0 139.26 Mb/s

E4 Binary 1 139.26 Mb/s

STM1E Binary 0
155.52 Mb/s

STM1E Binary 1
155.52 Mb/s

None

DS1 1.544 Mb/s

DS1A 2.048 Mb/s

DS1C 3.152 Mb/s

DS2 6.312 Mb/s

DS3 44.736 Mb/s

DS4NA 139.26 Mb/s

DS4NA Max Output
139.26 Mb/s

STS-1 Pulse 51.84 Mb/s

STS-1 Eye 51.84 Mb/s

STS-3 155.52 Mb/s

STS-3 Max Output
155.52 Mb/s

None

100Base-TX STP 125 Mb/s

100Base-TX UTP 125 Mb/s

Gigabit Ethernet 1.25 Gb/s

1000B-CX Norm, TP2
1.25 Gb/s

1000B-CX Abs, TP2
1.25 Gb/s

1000B-CX Abs, TP3
1.25 Gb/s

XAUI, Near 3.125 Gb/s

XAUI, Far 3.125 Gb/s

1000B-SX/LX 1.25 Gb/s
OC3/STM1 155.52 Mb/s

OC12/STM4 622.08 Mb/s

FC531 Optical 531.2 Mb/s

ANSI T1.102 masks

Ethernet masks

SONET/SDH masks
None

OC1/STM0 51.84 Mb/s

OC48/STM16 2.4883 Gb/s

OC48-FEC 2.666 Gb/s

Fibre channel masks
None

FC133 Optical 132.8 Mb/s

FC266 Optical 265.6 Mb/s

FC1063 Optical
1.0625 Gb/s

FC1063 Optical Draft Rev
11

FC2125 Optical 2.125 Gb/s

Fibre channel electrical masks
None

FC133E Elec. 132.8 Mb/s

FC266E Elec. 265.6 Mb/s

FC531E Elec. 531.2 Mb/s

FC1063E Elec.
1.0625 Gb/s

FC1063E Norm, Beta,
Transm

FC1063E Norm, Delta,
Transm

FC1063E Norm, Gamma,
Transm

FC1063E Abs, Beta,
Transm

FC1063E Abs, Delta,
Transm

FC1063E Abs, Gamma,
Transm

FC1063E Abs, Beta, Recv
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Mask types and standards

Fibre channel electrical masks
FC1063E Abs, Delta, Recv

FC1063E Abs, Gamma,
Recv

FC2125E Norm, Beta,
Transm

FC2125E Norm, Delta,
Transm

FC2125E Norm, Gamma,
Trans

FC2125E Abs, Beta,
Transm

FC2125E Abs, Delta,
Transm

FC2125E Abs, Gamma,
Transm

FC2125E Abs, Beta, Recv

FC2125E Abs, Delta, Recv

FC2125E Abs, Gamma,
Recv

InfiniBand masks
None

2.5 Optical 2.5 Gb/s

2.5 Electrical
2.5 Gb/s

Serial ATA masks
None

G1 Tx 1.5 Gb/s

G2 Tx 3.0 Gb/s

G2 Rx 3.0 Gb/s

G1 Rx 1.5 Gb/s

USB 1.1/2.0 masks
None

FS 12 Mb/s

HS:T1 480 Mb/s

HS:T2 480 Mb/s

HS:T3 480 Mb/s

HS:T4 480 Mb/s

HS:T5 480 Mb/s

HS:T6 480 Mb/s

IEEE 1394b masks
None

S400b T1 491.5 Mb/s

S400b T2 491.5 Mb/s

S400b Optical 491.5 Mb/s

S800b T1 983.0 Mb/s

S800b T2 983.0 Mb/s

S800bOptical 983.0 Mb/s

S1600b T1 1.966 Gb/s

S1600b T2 1.966 Gb/s

S1600b Optical 1.966 Gb/s

Rapid IO LP-LVDS masks
None

Drv 500 Mb/s

Drv 750 Mb/s

Drv 1.0 Gb/s

Drv 1.5 Gb/s

Drv 2.0 Gb/s

Ext Drv 500 Mb/s

Ext Drv 750 Mb/s

Ext Drv 1.0 Gb/s

Ext Drv 1.5 Gb/s

Ext Drv 2.0 Gb/s

Rcv 500 Mb/s

Rcv 750 Mb/s

Rcv 1.0 Gb/s

Rcv 1.5 Gb/s

Rcv 2.0 Gb/s

RIO Serial 1.25 Gb/s

RIO Serial 2.5 Gb/s

RIO Serial 3.125 Gb/s

None

4FSC NTSC "D2"
143.18 Mb/s

4:4:2 "D1" 270Mb/s

DVB ASI 270 Mb/s

4:2:2 SMPTE 259-M-D
360 Mb/s

SMPTE 292M 1.485 Gb/s

Rapid IO Serial masks
None
Video masks

xxx
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Use mask display controls

Use mask display controls
From the Mask menu, select Mask Setup; then open the Masks tab.

To use
Click the On/Off control to turn the mask display on or off.
Click the Config control to activate the Mask Configuration Display (see page 219) control window.

Behavior
When the On/Off control is on, the mask is displayed on the graticule. When the On/Off control is off, the
mask is not displayed.
Click the Config button to replace the Mask Testing control window with the Mask Configuration Display
control window.
What do you want to do next?
Learn about the Mask Configuration Display control window. (see page 219)
Learn about mask types. (see page 215)
Learn about mask alignment. (see page 223)
Go to the Mask Setup control window. (see page 215)

Mask configuration control window - Display
From the Mask menu, highlight Mask Configure; then select Display. From the Mask Testing control
window, click the Display Config button.

Overview
Use this control window to set whether changes in the scale will also be made in the mask. You can also
use this control window to return to the Mask Setup control window.
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Configure mask autoset

To use
Click the Lock Mask to Waveform button to turn it on and off.
Click the Masks button to go to the Mask Testing control window.

Behavior
When the Lock Mask to Waveform button is turned on, any changes you make to the scale, vertical
position or horizontal position will be reflected in the mask. Turning on Highlight Hits displays the hits in
a different color so they can be easily seen. When you click the Mask button this window closes, and
the Mask Setup control window opens.
What do you want to do next?
Go to the Mask Setup control window. (see page 215)
Learn more about mask configuration. (see page 220)

Configure mask autoset
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Testing control
window, click the Autoset Config button.
Use this control window to set the vertical, horizontal, and trigger autoset parameters, activate autofit or
autoset, choose the autoset mode, return to the default autoset configuration, or go to the Mask Testing
control window.
For information on the controls, click the buttons.
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Configure mask autofit

To use
Click Autoset to align the signal within the mask. This operates the same as the Autoset button on
the front panel.
Click Defaults to return the instrument to the default autoset configuration.
Click Masks to replace this control window with the Mask Testing control window.
What do you want to do next?
Go to the Mask Setup control window. (see page 215)
Learn about mask display configuration. (see page 219)
Learn about mask autofit configuration. (see page 221)

Configure mask autofit
From the Mask menu, highlight Mask Configure; then select Autofit. From the Mask Testing control
window, click the Autofit Config button.

Overview
Use this control window to configure the limits for minimizing mask hits, return to default setting, or return
to the Mask Testing control window.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

221

Mask testing setups

Configure mask autofit

To use
Set the vertical and horizontal maximum levels of adjustment by clicking in the entry boxes and use
the multipurpose knobs or double-clicking in the control and use the pop-up keypad.
Click Autofit to align the signal within the mask.
Click Defaults to reset the autofit configuration to the default values.
Click Masks to return to the Mask Testing control window.

Behavior
The maximum level of adjustment determines how far Autofit will search for the best fit to minimize hits.
For example, if you set the Vertical Maximum to 10% per division, Autofit searches up to and including
10 percent of the vertical divisions for the best fit. Autofit minimizes hits by aligning the signal within
the mask.
Clicking Masks replaces the Mask Configuration Autofit control window with the Mask Testing control
window.
NOTE. The interaction between Autofit and Persistence can affect the display of persistence data. Autofit
moves the waveform vertically and/or horizontally to reduce the number of hits within a given mask. If
either infinite or variable persistence is enabled these movements will clear any persistence data. If Autofit
makes frequent adjustments, there can be little or no persistence data.
What do you want to do next?
Learn about display configuration. (see page 219)
Learn about autoset configuration. (see page 220)
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Set up mask alignment

Set up mask alignment
From the Mask menu, select Mask Setup; then open the Masks tab.

To use
Click the Autoset control to perform an autoset on the signal.
Click the Autofit control to turn the minimize hits function on or off.
Click the Config control to access the Autoset (see page 220) or Autofit (see page 221) Configuration
control window.

Behavior
Clicking the Autoset control automatically aligns the mask based on the characteristics of the input signal.
This function is done once, and that setting is not changed until you run the autoset command again or
until you change any settings. This is the same as pushing the front-panel Autoset control.
When Autofit is used, the signal is aligned within the mask to minimize the number of hits on each
acquisition. Settings may change after each acquisition when autofit is used.
NOTE. The interaction between Autofit and Persistence can affect the display of persistence data. Autofit
moves the waveform vertically and/or horizontally to reduce the number of hits within a given mask. If
either infinite or variable persistence is enabled, these movements will clear any persistence data. If
Autofit makes frequent adjustments, there can be little or no persistence data.
Clicking the Autoset Config button will replace the control window with the Autoset Mask Configuration
control window. Clicking the Autofit Config control will replace this control window with the Autofit
Mask Configuration control window.
What do you want to do next?
Learn about autoset configuration. (see page 220)
Learn about autofit configuration. (see page 221)
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Edit a mask

Learn about mask display setup. (see page 219)
Learn about mask types. (see page 215)
Go to the Mask Setup control window. (see page 215)

Edit a mask
From the Mask menu, select Mask Edit Setup, or click the Edit User Mask button in the Mask Testing
control window.

Overview
Use this control window to select the Segment and Vertex for editing, set the Horizontal and Vertical
mask values, and Save or Recall masks.

To use
Click the Mask Segment and Vertex up and down arrows to select the segment or the vertex of the
mask to be edited.
Click Add to add a point to the boundary in the selected segment and just after the selected vertex.
Click Del to delete the selected vertex from the selected segment.
Click Del All to remove all points in the selected segment.
To change the horizontal or vertical mask values for the selected segment and vertex, click in the
Horizontal or Vertical entry boxes, and then use the multipurpose knobs to set the values.
To save a mask, click Save to activate the Save As dialog box.
To recall a previously saved mask, click Recall to activate the Recall dialog box.
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Set up mask testing source/tolerance

Behavior
The Segment up and down arrows increase or decrease the segment number by one. The Vertex up and
down arrows increase or decrease the vertex by 1. To set a specific number, click in the Vertex entry
box to activate the pop-up calculator.
Clicking the Add button adds a point to the boundary in the selected segment and just after the selected
vertex in addition to moving any points that follow the newly added point in the boundary up one. For
example, if there are 6 points in the boundary of the selected segment and you add a point when the
selected vertex is 4, then the vertex which was 4 becomes vertex number 5, number 5 becomes 6, and
vertex 6 is changed to vertex 7.
Clicking Del deletes the selected vertex from the selected segment and moves any points that follow the
deleted point down one in the boundary. Clicking Del All deletes all points in the selected segment,
effectively deleting that segment.
Clicking the Setup button will return you to the Masks Testing control window. Clicking the Controls
button will activate the User Mask Edit control window (see page 240) where you can make quick changes
to a User mask.
What do you want to do next?
Learn about saving masks. (see page 540)
Learn about recalling saved masks. (see page 241)
Learn more about mask types. (see page 215)
Learn more about mask setups. (see page 215)

Set up mask testing source/tolerance
From the Mask menu, select Source.

Overview
Use this control window to select the source of the signal you want to test.
For information on the controls, click the buttons.
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Set up mask margins

To use
1. Click the Ch, Math, or Ref tab to select the source for mask testing.
2. Click the number (1–4) of the channel, math expression, or reference you want to use.

Behavior
When you click the Ch tab and select a channel number, it is used as the source for mask testing. You can
select only one source at a time for mask testing.
What do you want to do next?
Learn more about mask setups. (see page 226)
Learn more about mask test setups. (see page 227)
Go to the Mask Setup control window. (see page 215)

Set up mask margins
From the Mask menu, select Tolerance Setup.

Overview
Use this control to turn the margin mode on or off and to set the percentage of margin used for the mask test.

To use
1. Click the On/Off button to turn the mask margin tolerance on or off.
2. Click the up and down arrows or click in the Margins entry box to activate the pop-up keyboard and
set the percentage of margin tolerance.
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Set up pass/fail mask testing

Behavior
When the mask margin tolerance is on, you can control the percentage of margin used in the mask test.
Use the up and down arrow buttons to increase or decrease the percentage in 1% increments. A tolerance
that is > 0 makes passing a mask test more difficult.
A mask test that passes with a tolerance that is > 0 demonstrates that the signal passes the test with a
margin for further error. Setting the tolerance to < 0 makes a mask test easier to pass. A tolerance that is <
0 can be used to demonstrate by how much of a margin the signal fails.
What do you want to do next?
Learn more about mask testing setup. (see page 227)
Go to the Mask Setup control window. (see page 215)

Set up pass/fail mask testing
From the Mask menu, select Pass/Fail Setup.

Overview
Use this control window to set the parameters for passing or failing the mask test, to set the test notification
mode, to select the polarity for testing, and whether to repeat the test.
For information on the controls, click the buttons.

What do you want to do next?
Learn more about mask testing. (see page 234)
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Set up mask test fail notification

Go to the Mask Setup control window. (see page 215)

Set up mask test fail notification
From the Mask menu, select Pass/Fail Setup.

Overview
Use the Test Fail Notification controls to set the mode of notification when a waveform fails a mask test.

To use
Click a button to switch the control on or off. Use this control window to save a failed waveform, log
the date and time of a failed waveform, and specify the directory where you want to save the waveform
or send E-mail on a failed waveform.

Behavior
Beep. When Beep is turned on, the instrument beeps when a mask test fails.
E-mail. When E-mail is turned on, the instrument sends an E-mail when a mask test fails. Click the
Setup button and complete the E-mail on Event Setup (see page 555) information.
Save WFM. When Save WFM is turned on, failed waveform data is saved to a file. Click the Path
button and enter the path location for the file.
Log Date. When Log Date is turned on, the date and time for each failed mask test is recorded to a
file. Click the Path button and enter the path location for the file.
Print. When Print is turned on, the instrument sends the waveform to a printer when a mask test fails.
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Set up mask test fail notification

SRQ. When SRQ is turned on, the instrument sends a GPIB SRQ command when a mask test fails.
AUX Out. When AUX Out is turned on, the instrument sends a trigger to the Auxiliary Out connector
when a mask test fails. See External Signals Control Window (see page 550) for additional details
on this feature.
What do you want to do next?
Learn about mask polarity. (see page 233)
Learn about waveform parameters. (see page 230)
Go to the Test Setup control window. (see page 227)
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Set up mask test completion notification

Set up mask test completion notification
From the Mask menu, select Pass/Fail Setup.

Overview
Use the Test Completion Notification controls to beep, execute a command, or send an external trigger
when a waveform passes a mask test.

To use
Click a button to switch a control on or off.

Behavior
Beep. When Beep is turned on, the instrument beeps when the test is completed. Beep is not available
on MSO/DPO5000B Series instruments.
SRQ. When SRQ is turned on, the instrument sends a GPIB SRQ command when a test is completed.
AUX Out. When AUX Out is turned on, the instrument sends a trigger to the Auxiliary Out connector
when the test is completed. See External Signals Control Window (see page 550) for additional
details on this feature.
What do you want to do next?
Learn about mask polarity. (see page 233)
Learn about waveform parameters. (see page 230)
Go to the Test Setup control window. (see page 227)

Set mask test parameters
From the Mask menu, select Pass/Fail Setup.
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Set mask test parameters

Overview
Use the Number of Waveforms (Samples), Fail Threshold, and Pre-Test Delay controls to set the
parameters for the mask test.
NOTE. If you are using Waveform Database mode, the Number of Waveforms entry box changes to
a Samples entry box.

To use
1. Click in the Number of Waveforms (Samples) entry box to activate the multipurpose knobs to enter a
value.
2. Click in the Fail Threshold entry box to activate the multipurpose knobs and enter the minimum
number of waveforms that must fail for the test to fail.
3. Click in the Pre-Test Delay entry box to activate the multipurpose knobs to enter the number of
seconds to wait before starting the test.

Behavior
Entering a number in the Number of Waveforms (Samples) entry box stops the test when that number
has been reached.
If the waveforms or samples that fail are equal to or greater than the number in the Fail Threshold entry
box, the test has failed. If the failed waveforms or samples are less than the number in the Fail Threshold
entry box, the test passes.
The instrument begins sampling after the number of seconds has passed set in the Pre-Test Delay entry
box. Use the Test Delay if you need to give the signal source time to stabilize.
What do you want to do next
Learn about test notification. (see page 228)
Learn about mask polarity. (see page 233)
Learn about test results. (see page 234)
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Select the sound source

Go to the Test Setup control window. (see page 227)

Select the sound source
NOTE. This feature is not available on MSO/DPO5000B Series instruments.
Your instrument is shipped with an internal speaker that some of the software features use to send an
audible alert to the user. To enable this speaker, the sound card in your instrument must be turned off. With
the sound card off, you will not have access to standard Windows audio features, such as the ability to
listen to a music CD.
If you turn the sound card on, the internal speaker is disabled. You will need to connect headphones or an
amplified speaker to the headphone jack on the instrument to hear the alerts.
NOTE. The default setting disables the sound card.
Use the following procedure to turn the sound card on or off.
1. Access the Device Manager:
a. From the File menu, click Minimize, or press CTRL+M to minimize the instrument application.
b. On your Windows desktop, right-click the My Computer icon.
c. Click Properties.
d. In the System Properties dialog box, click the Hardware tab.
e. Click the Device Manager button.
2. Select the Source:
a. Double-click Sound, video, and game controllers.
b. Double-click SigmaTel C-Major Audio.
c. In the Device usage drop-down list, click either Use this device (enable) or Do not use this device
(disable).
3. Save Your Changes:
a. Click OK.
b. Close the Device Manager dialog box.
c. Close the System Properties dialog box.
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Set the mask polarity

Set the mask polarity
From the Mask menu, select Pass/Fail Setup.

Overview
Use the Mask Polarity control to select whether to test the positive or negative pulse or both.

To use
Click Positive to set the pulse polarity to positive.
Click Negative to set the pulse polarity to negative.
Click Both to set the pulse polarity to both negative and positive.

Behavior
When the Positive control is selected, the mask test is performed on the positive pulse. When the Negative
control is selected, the mask test is performed on the negative pulse.
When the Both control is selected, the mask test is performed on both the positive and negative pulses.
NOTE. The mask polarity controls operate for pulse mask testing only; they have no affect on eye masks.
What do you want to do next?
Learn about test notification. (see page 228)
Learn about waveform parameters. (see page 230)
Learn about test results. (see page 234)
Go to the Test Setup control window. (see page 227)
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Set mask test repeat controls

Set mask test repeat controls
From the Mask menu, select Pass/Fail Setup.

Overview
Use the Pass/Fail Test controls to start the test or to run the test continuously.

To use
Click the On/Off button to start the test.
Click the Repeat button to run the test continuously.
Click the Controls button to open the Mask Test control window.

Behavior
When the Repeat control is on, the test runs continuously. When you click the On/Off button, the test starts
using the parameters from the Mask Test control window and the Pass/Fail Results window is displayed.
What do you want to do next?
Learn about waveform parameters. (see page 230)
Learn about test notification. (see page 228)
Learn about mask polarity. (see page 233)
Learn about the Mask Test Controls window. (see page 888)
Go to the Test Setup control window. (see page 227)

Mask Testing control window (Pass/Fail Results tab)
From the Mask menu, select Pass/Fail Results.
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View the mask test summary

Overview
Use this control window to view real time test results, start the test, reset the test at the beginning, activate
the waveform failure log file, and open the Mask Test Controls control window.
For information on the controls, click the buttons.

What do you want to do next?
Learn about test summary. (see page 235)
Learn about hits per segment. (see page 237)
Learn about the Mask Test Controls window. (see page 888)
Go to the Test Setup control window. (see page 227)

View the mask test summary
From the Mask menu, select Pass/Fail Results.

Overview
Use this window to view real time test results.
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View the mask test summary

To use
The Pass/Fail Test Summary is a read only field.

Behavior
The Pass/Fail Test Summary fields provide a real time summary of the test results. Waveforms or samples
tested shows how many waveforms or samples have been tested in relation to how many were specified
in the test setup.
Source indicates what signal source was used for the test.
Status indicates whether the test has passed, failed, or is passing.
Passing appears in yellow, passed in green, and failed in red.
Total Hits shows the total number of data points that violated the mask.
Failed Wfms shows the total number of waveforms that failed during the test sequence.
What do you want to do next?
Learn about hits per segment. (see page 237)
Learn about the Mask Test Controls window. (see page 888)
Learn about test results. (see page 234)
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View the mask hits per segment

View the mask hits per segment
From the Mask menu, select Pass/Fail Results.

Overview
Use this window to view the hits for each mask segment of the test.

To use
The Hits per segment is a read only field.

Behavior
Each mask test can have up to 16 segments. The data point violations per segment are shown in this
window. Source indicates the input signal in use for the test. The segments are identified by Seg followed
by the number of the segment. Only the number of segments used in a test is shown. A scroll bar appears
if there are more segments used than can be seen at one time.
The segments of a mask are the polygonal regions on the screen. Segment one is the left upper most
polygon. Segments are assigned from top to bottom and left to right on the screen.
What do you want to do next?
Learn about test summary. (see page 235)
Learn about the Mask Test Controls window. (see page 888)
Learn about test results. (see page 234)
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Start or reset a mask test

Start or reset a mask test
From the Mask menu, select Pass/Fail Results.

Overview
Use these controls to start a test or reset the test to the starting point.

To use
Click the On/Off control to start the test.
Click the Reset control to reset the test to the beginning.

Behavior
When the test starts, it uses the parameters in the Pass/Fail Test Setup control window. When the test is
reset, the Total Hits, Failed Wfms, Hits per segment, and Waveform Tested fields are reset to zero.
What do you want to do next?
Learn about test summary. (see page 235)
Learn about hits per segment. (see page 237)
Learn about the Mask Test Controls window. (see page 888)
Learn about test results. (see page 234)

Set the user mask controls
From the Mask menu, select Mask Setup; then open the Masks tab and click the User Mask button.
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Set the user mask controls

Overview
Use this control window to access the Edit User Mask control window or to copy a standard mask as a user
mask. You can also select the standard you want to copy or edit from the standard drop-down list.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option on some instruments before you can access the Comm triggers.
For information on the controls, click the buttons.

To use
Click the Edit User Mask button to access the Mask Edit control window.
Click the Copy Current Mask button To User Mask to make the current mask a user mask.

Behavior
Clicking the User Mask button gives you access to the User Mask in the standard drop-down list. Clicking
the Edit User Mask control will replace this control window with the Mask Edit control window. Clicking
the Copy Current Mask to User Mask control will activate a dialog box where you can overwrite the
user mask.
What do you want to do next?
Learn about editing masks. (see page 224)
Learn more about mask types. (see page 215)
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Set user mask edit controls

Learn more about mask setups. (see page 215)

Set user mask edit controls
From the Mask menu, select Mask Edit Controls.

Overview
Use this control window to select the segment and vertex for editing and set the Vertical and Horizontal
Mask Values.

To use
Click the up and down arrows to select the segment or the vertex of the mask to be edited.
Click the Add button to add a point to the boundary in the selected segment and just after the selected
vertex.
Click Del button to delete the selected vertex from the selected segment.
To change the horizontal or vertical values for the selected segment and vertex, click in the Horizontal
or Vertical entry boxes to activate the multipurpose knobs to enter a value.

Behavior
The Segment up and down arrows increase or decrease the segment number by one. The Vertex up and
down arrows increase or decrease the vertex by 10. To set a specific number click the Vertex entry box
to activate the pop-up calculator. Clicking the Add control adds a point to the boundary in the selected
segment and just after the selected vertex in addition to moving any points that follow up one. Clicking
Del deletes the selected vertex from the selected segment and moves any points that follow down one.
What do you want to do next?
Learn about saving masks. (see page 540)
Learn about recalling saved masks. (see page 241)
Learn more about mask types. (see page 215)
Learn more about mask setups. (see page 215)

240

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Mask testing setups

Recall user mask

Recall user mask
From the File menu, select Recall, or from the Reference Waveform controls (see page 527), click the
Recall button.

Overview
Use this dialog box to recall a saved user mask.

To use
Under Recall What, click User Mask.
In the Look in drop-down list box, navigate to the location of the user mask.
Click on the name of the mask file you want to recall. You can also click the keyboard icon to access
the pop-up keyboard and enter the file name.
Click Recall.
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Set up limit testing

Behavior
The Recall dialog box displays when you click Recall in the Mask Edit control window. Clicking Recall
replaces the current mask with the mask that you selected in the Recall dialog box.
Masks are saved in C:\Users\[Username]\Tektronix\TekScope\Masks unless you choose another
directory.
What do you want to do next?
Learn about saving masks. (see page 540)
Learn more about mask types. (see page 215)
Learn more about mask setups. (see page 215)

Set up limit testing
From the Mask menu, select Limit Test Setup; then open the Setup tab.

Overview
Limit testing allows you to compare an active signal to a template waveform.

To use
Use the following procedure to build a template from a known signal and compare it to an active signal.
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1. Create a template:
a. Select the signal Source and template Destination in the drop-down list boxes.
b. Click in the Vertical and Horizontal Tolerances entry boxes and use the multipurpose knobs to
specify the test limit tolerances. The Tolerances specify the margins allowed before a limit test
fails.
c. Click Save to save the template as a reference waveform or save to a file. You can create and
save multiple templates.
2. Compare a source waveform to a template:
a. In the Source drop-down list box, select the source waveform to compare to a template.
b. In the Template drop-down list box, select the template to compare to the source waveform.
Normally, this is the template you created in the steps above, but you can compare multiple
waveforms to multiple templates at the same time.
3. Failure Notification:
a. Open the Failure Notification tab and set up the mode you prefer for failure notification.
b. Click the Setup tab to return to the Limit Test setup window.
4. Select Test Options:
a. Click the Lock Template to Waveform button On to lock the vertical scale or position of the
template to the source waveform.
b. Click the Highlight Hits button On to show points on the waveform that fall outside the template.
These will occur in a different color.
5. Run Limit Test:
a. Click the Limit Test button On to start the test.
b. Click the Reset button to clear all violations in preparation for another test.
TIP. Use the Average acquisition mode to create a smoother template waveform; use the Envelope
acquisition mode to create a template that allows occasional overshoots.
NOTE. Limit testing is not available on digital channels.

Save a template
From the Mask menu, select Limit Test Setup. In the Destination drop-down list, select File to open the
Save Template dialog box. From the dialog box, click the Save button.
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Save a template

Overview
Use this dialog box to save the limit test template to a specified file.

To use
To save to a file, enter a Name or use the default file name. The file extension specified in the Save as
type list will automatically be appended to the file name.

Behavior
This dialog box opens when you select File from the Limit Test Setup control window. The default file
type is a waveform (.WFM).
The default folder is C:\Users\[Username]\Tektronix\TekScope\waveforms.
NOTE. Any characters that you enter in the file name box become part of the file name. The instrument
does not use any user-defined file extensions.
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Set up limit test failure notification
From the Mask menu, select Limit Test Setup; then open the Failure Notification tab.

Overview
Use the Limit Test controls to set the mode of failure notification when a mask limit test fails.

To use
Click a button to switch the control on or off. Use the controls to indicate the failure notification method,
if a waveform fails a mask limit test.

Behavior
Beep. When Beep is On, the instrument beeps if a mask test fails.
E-mail. When E-mail is On, the instrument sends an E-mail if a mask test fails. Click the Setup button
and complete the E-mail on Event Setup (see page 555) setup information.
Save WFM. When Save WFM is On, failed waveform data is saved to a file. Click the Path button
and enter a location to save the file.
Log Date. When Log Date is On, the date and time for each failed mask test is recorded to a file.
Click the Path button and enter a location to save the file.
Print. When Print is On, the instrument sends the waveform to a printer if a mask test fails.
SRQ. When SRQ is On, the instrument sends a GPIB SRQ command if a mask test fails.
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From the Math menu, select Math Setup.

Overview
Use the Math Setup control window to set up and define math waveforms (see page 747).
NOTE. Math calculations are not available on digital channels.
For information on the controls, click the buttons.

You can define up to four math waveforms. The controls for each waveform are similar, but independent
of each other.
TIP. To easily change the vertical position and scale of a math waveform, click the waveform handle on the
left side of the screen. Use the multipurpose knobs to change the waveform position and scale.
TIP. To open the Math Equation Editor, double-click in the math expression field or click the Editor button.
What do you want to do next?
Learn about the Math Waveform controls. (see page 868)
Learn about the Equation Editor. (see page 263)

Set up math averaging
From the Math menu, select Set Math Averages.
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Set math variables

Overview
Use this control window to specify the number of times the selected math waveform (see page 748)
is averaged.

To use
1. Click in a Math <1–4> n = entry box to map it to one of the multipurpose knobs.
2. Use the multipurpose knob to specify the number of times the selected waveform should be averaged.

Behavior
The selected math waveform is averaged over the number of acquisitions shown in the control. Each math
waveform has its own set of controls.
The following buttons allow you to change other setups after you set the averaging:
Click Editor to open the Math Equation Editor control window.
Click Spectral to open the Spectral Setup control window.
Click Setup to open the Math Setup control window.
What do you want to do next?
Learn about the Spectral Setup controls. (see page 252)
Learn more about the Math Setup controls. (see page 247)

Set math variables
From the Math menu, select Set Math Variables.

Overview
Use this control window to quickly set the math variables to use in your math expression.
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To use
Use the 1 – 4 or 5 – 8 tabs to access the variables you want.
Click in a Var <1–4> = or Var <5–8> = entry box and use the multipurpose knobs to set the value
for the variable.
Click the Editor button to access the Math Equation Editor.

Behavior
You can set or change the variable values in this control window. To add a variable to a math expression,
go to the math editor, and click the VAR <1–8> buttons.
What do you want to do next?
Learn about the Edit controls. (see page 818)

Use custom analysis functions
From the Math menu, select Math Setup.

To use
1. Select a custom function from the Custom Analysis Functions drop-down list.

Behavior
Custom functions are math functions that you have created and installed on the instrument. Once installed
you can select and use them just like the instrument built in functions.
Click the question mark to display information on custom analysis function plugins. Custom analysis
functions (see page 250).
What do you want to do next?
Learn about using Math Plugins (see page 755)
Learn about writing Math Plugins (see page 756)
Learn about writing MATLAB custom function plugins (see page 761)
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Custom analysis functions
This window provides information on MATLAB and .NET plugin functions you can use in math equations.

What do you want to do next?
Learn about using Math Plugins (see page 755)
Learn about writing Math Plugins (see page 756)
Learn about writing MATLAB custom function plugins (see page 761)
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MATLAB custom analysis interface
This window provides information on MATLAB plugin functions you can use in math equations.

Behavior
Clicking on the link takes you to the MathWorks Web site.
Use the drop down list to select a MATLAB plugin to insert in your math equation. If MATLAB or the
instrument toolbox is not installed, the drop down list is replaced with a instructions to install MATLAB
and the toolbox.
What do you want to do next?
Learn about using Math Plugins (see page 755)
Learn about writing Math Plugins (see page 756)
Learn about writing MATLAB custom function plugins (see page 761)

Set up basic spectral analysis
From the Math menu, select Basic Spectral, or click Basic in the Math Setup control window.

Overview
Use these controls to for simple spectral analysis.
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Use front panel spectral controls

To use
For information on the controls, click the buttons.

Changing the Horizontal Mode to Manual activates the Frequency Span and Resolution BW controls.

Use front panel spectral controls
From the Math menu, select Basic or Advanced Spectral; in the Spectral Setup window, click the ? mark.

To use
To map the spectral controls to the instrument front panel, do the following:
1. From the Horz/Acq menu, select Horizontal/Acquisition Setup.
2. Open the Horizontal tab.
3. Under Mode, click the Manual option box.
4. Return to the Spectral Setup control window.
5. Use the front panel Resolution knob to directly control Frequency Span.
6. Use the Horizontal Scale knob to directly control Resolution Bandwidth.

Set up advanced spectral analysis
From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.
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Set up the frequency spectral controls

Overview
Use the controls in this window to set up advanced math waveforms for spectral analysis. Using the tabs,
you can create a spectral waveform, define the vertical units, and adjust the measurement parameters.
You can also lock waveforms together.

To use
For information on the controls, click the buttons.

After you create the spectral waveform, use the controls on the right side of the control window to position
and adjust the waveform so that you can view the data you are interested in.
You can operate the instrument and view spectral (FFT) waveforms using the time-domain controls, gating
controls, or frequency domain controls. Some of these controls are interactive; making changes with one
set of controls will sometimes change settings in another control set.
What do you want to do next?
Learn about creating spectral waveforms. (see page 918)
Learn about the Math Setup controls. (see page 247)

Set up the frequency spectral controls
From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.

To use
Click in an entry box, and then use the multipurpose knobs to set the Center Freq (see page 254), Freq
Span (see page 254), and Res BW (see page 255).
Click Full to set the frequency span to full.
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Behavior
The maximum frequency span is equal to half of the sample rate. If you need a higher frequency span,
set the sample rate to a larger value.
The Resolution Bandwidth determines how small of a frequency difference can be resolved in the frequency
domain output data. It defines the bandwidth of filters used to perform the frequency domain analysis.
The resolution bandwidth is measured in hertz at the 3 dB points on each side of the peak spectral lobe.
Adjusting the resolution bandwidth controls the gate duration to obtain the desired resolution bandwidth.
NOTE. The frequency domain controls interact with the gating and acquisition controls; changing one set
of controls may change the other control settings.
What do you want to do next?
Learn about the Gating controls. (see page 255)
Learn about the Math Setup controls. (see page 247)

Center frequency
The center frequency is the frequency at the center of the frequency span. The maximum center
frequency is equal to the sample rate divided by two (the Nyquist frequency) minus one half the span.
The minimum center frequency is equal to one half of the span.
If the frequency span is set to maximum, then the center frequency will not move. To increase the
center frequency beyond the present limits, either reduce the frequency span or increase the sample
rate. To decrease the center frequency beyond the present limits, reduce the frequency span.

Frequency span
The frequency span is the range of frequencies over which the spectral analysis is performed. The
maximum span is from DC to one half of the sample rate (the Nyquist frequency). A smaller
frequency span allows a greater range of center-frequency adjustment. If a larger frequency span
is desired, increase the sample rate.
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Resolution bandwidth
The resolution bandwidth controls the bandwidth of the spectral analyzer filters. You can adjust the
resolution bandwidth in units of hertz. The resolution bandwidth is measured at the –3 dB points on
each side of the peak spectral lobe of the filter.
Resolution bandwidth is inversely proportional to the gate duration in the time domain. Changing the
gate duration changes the resolution bandwidth. Changing the spectral analyzer window function also
changes the resolution bandwidth but will not affect the gate duration.
To decrease the resolution bandwidth beyond the present limits, increase the time domain gate
duration. If this is insufficient, increase the record length and then increase the gate duration
again. You can also try the rectangular or Hamming window to maximize the frequency resolution
(minimize resolution bandwidth).

Set up spectral gating controls
From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.

To use
1. Select an FFT window type from the Window Type list.

2. Click in the Gate Position, Gate Duration, or Gate Length entry boxes and use the multipurpose
knobs to set the gating parameters.

Behavior
An FFT Window Type (see page 908) can help reduce spectral noise for many types of signals. Some
windows provide better frequency resolution at the expense of better amplitude measurements. Other
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windows provide better amplitude accuracy over frequency resolution. The choice of window also affects
the resolution bandwidth.
Gate Position moves the gate that selects the data for the spectral waveform. The gate position is the
center point in the gate measured in seconds with respect to the trigger point. In most cases the phase
reference point is located at the center of the gated data. However, if you use a Tek Exponential
window, the phase reference point is at the 20% point of the gated data.
Gate Duration sets the gate time duration in seconds. The default gate duration is the duration of the
entire waveform record. The resolution bandwidth is inversely proportional to the gate duration.
Gate Length displays the gate length in points. The default gate duration is the duration of the entire
waveform record.
NOTE. The gating controls interact with the acquisition and frequency domain controls; changing one set
of controls may change the other control settings.
What do you want to do next?
Learn about selecting an FFT window. (see page 908)
Learn about the Math Setup controls. (see page 247)
Learn about the Frequency controls. (see page 253)

Spectral analysis overview
You can use math waveforms to perform FFT (Fast Fourier Transform) measurements with the instrument.
The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot
acquisition) into its frequency components, providing spectral analysis capabilities.
The ability to quickly look at signal frequency components and spectrum shape is a powerful research and
analysis tool. FFT is an excellent troubleshooting aid for the following:
Testing the impulse response of filters and systems
Measuring harmonic content and distortion in systems
Identifying and locating noise and interference sources
Analyzing vibration
Analyzing harmonics in 50 and 60 Hz power lines

Spectral analysis features
You can display an FFT waveform on any actively acquired signal (periodic or single-shot), the last
acquired signal, or any signal stored in reference memory.
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FFT windows
The instrument allows you to match the optimum window to the signal you are analyzing.
The Rectangular window is best for nonperiodic events such as transients, pulses, and single-sequence
acquisitions.
The Hamming, Hanning, and Blackman-Harris windows are better for periodic signals.
The Kaiser Bessel window has less spectral leakage than the Hanning, Hamming, or Rectangular
windows.
The Gaussian window provides optimal localization in both the time and frequency domain.
The Flattop2 window is good for high accuracy magnitude measurements for signals that do not
require narrow resolution bandwidth.
The Tek Exponential window is useful for impulse response testing.

Vertical scales
The FFT vertical graticule can be set to either dB or Linear RMS.
A dB scale is useful when the frequency component magnitudes cover a wide dynamic range, letting
you show both lesser and greater magnitude frequency components on the same display.
A Linear scale is useful when the frequency component magnitudes are all close in value, enabling
direct comparison of their magnitudes.

Spectral and Time-Domain displays
Time signals and FFT waveforms can be shown together on the display. The time signal highlights the
problem; the FFT waveform helps you determine the cause of the problem.
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FFT process
The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot
acquisition) into its frequency components.
The FFT function processes the waveform record and displays the FFT frequency domain record, which
contains the input signal frequency components from DC (0 Hz) to ½ the sample frequency (also called
the Nyquist frequency (see page 177)).

The FFT display
The following illustration shows a typical time-domain waveform and the frequency components of that
signal as part of the math FFT waveform.
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FFT windows
The FFT process assumes that the part of the waveform
record used for FFT analysis represents a repeating
waveform that starts and ends at or near the same voltage
of a cycle. In other words, it is an integer number of cycles.
When a waveform starts and ends at the same amplitude,
there are no artificial discontinuities in the signal shape, and
both the frequency and amplitude information is accurate.
A nonintegral number of cycles in the waveform record
causes the waveform start and end points to be at different
amplitudes. The transitions between the start and end
points cause discontinuities in the waveform that introduce
high-frequency transients. These transients add false
frequency information to the frequency domain record.
Applying a window function to the waveform record changes
the waveform so that the start and stop values are close to
each other, reducing the discontinuities. This results in an
FFT measurement that more accurately reflects the actual
signal frequency components. The shape of the window
determines how well it resolves frequency or magnitude
information.

xxx
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FFT window characteristics
Each FFT window is a trade-off between frequency resolution and magnitude accuracy. What you want to
measure and your source signal characteristics help determine which window to use. Use the following
guidelines to select the best window.
FFT window

Characteristics

Best for measuring

Rectangular

Best frequency, worst magnitude
resolution. This is essentially the
same as no window.

Transients or bursts where the signal
levels before and after the event are
nearly equal.
Equal-amplitude sine waves with
frequencies that are very close.

Hamming, Hanning

Better frequency, poorer magnitude
accuracy than Rectangular. Hamming
has slightly better frequency resolution
than Hanning.

Sine, periodic, and narrow-band
random noise.
Transients or bursts where the signal
levels before and after the event are
significantly different.

Blackman-Harris

Best magnitude, worst frequency
resolution.

Predominantly single frequency
signals to look for higher order
harmonics.

xxx

You can also determine the best window empirically by first selecting the Rectangular window, and
then selecting (in the following order) the Hamming, Hanning, and Blackman-Harris windows until the
frequency components merge. Use the window just prior to where the frequencies emerge for the best
compromise between resolution and amplitude accuracy.
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Time domain gating
You can use time domain gating to select a specific segment of your signal for spectral analysis. Two
controls, gate position and gate duration, determine the location and size of the gate.
The resulting spectrum corresponds to the frequency components of the signal in the gated segment.

Time domain gating is inversely proportional to the resolution bandwidth of the spectral waveform. The
narrower the gate, the larger the resolution bandwidth and the lower the frequency resolution. To obtain
the best frequency resolution, use as wide a gate as possible.
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Aliasing
Problems occur when the instrument acquires a signal containing frequency components that are higher
in frequency than the Nyquist frequency (see page 177). The frequency components that are above the
Nyquist frequency are under sampled and appear to "fold back" around the Nyquist frequency, showing as
lower frequency components. These incorrect components are called aliases.
To quickly check for aliasing, slowly decrease the horizontal time scale. If the shape of the displayed
waveform changes drastically or becomes stable, your waveform is probably aliased. You can also check
for aliasing by turning on peak detect acquisition mode. To remove aliasing, modify the record length.

Eliminate aliasing
Use the following methods to eliminate aliases:
Increase the sample rate by adjusting the horizontal scale to a faster time-per-division setting. Since
you increase the Nyquist frequency (see page 177) as you increase the time per division, the aliased
frequency components should appear at their proper frequency. If the increased number of frequency
components shown on the screen makes it difficult to measure individual components, use MultiView
Zoom to magnify the FFT waveform.
Use a filter on the source signal to limit the bandwidth of the signal to frequencies below that of
the Nyquist frequency. If the frequency components that you want to view are below the built-in
bandwidth settings, set the source channel bandwidth to the appropriate value.
Push the Autoset button.
Switch the acquisition to Envelope mode or Peak Detect mode (see page 198). Envelope mode
searches for samples with the highest and lowest values over multiple acquisitions and can detect
faster signal components over time. In Peak Detect mode, the acquisition alternates between saving
the highest sample in one acquisition interval and lowest sample in the next acquisition interval.

262

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Math setups

Math Equation Editor control window

Math Equation Editor control window
From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

Overview
Use the Math Equation Editor control window to define or edit math waveforms. The readout shows the
math expression as you construct it. New functions are added at the beginning of the expression each time
you click one of the function buttons.

To use
For information on the controls, click the buttons.

Behavior
You can create a math expression using one or more of the following approaches:
Open the tabs and click one or more of the buttons to insert functions into the math expression. Then
select one of the waveforms as an operand by clicking one of the Channels Selector (see page 264).
Use the edit controls to add additional numbers and operators to complete the math expression.
Connect an external keyboard and use it to enter the math expression.
Create a math expression using an external text editor or another application. Copy the text to the
Windows clipboard. Right-click with the mouse to paste the text into the math expression.
If you create a math expression that is longer than the physical space in the control window readout, you
can scroll through the expression using the Text Edit controls (see page 265).
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To edit another math waveform, select the waveform from the Math (n) drop-down list in the Equation
Editor control window.
To open a Math Averaging (see page 247) control window, where you can specify the number of times
the math waveform is to be averaged, click Avgs.
Click Apply to apply the math expression to the selected waveform.
For additional information on creating math waveforms, see Guidelines for Working with Math Waveforms
(see page 826).
What do you want to do next?
Learn about the Math Setup controls. (see page 247)
Learn about using math functions with math waveforms. (see page 265)

Channels selector
Specify the Ch <1 - 4> and waveform type (Channel, Math, or Reference) for oscilloscope operations.
Click Ch and specify a channel to dedicate the controls for use with an input on the front panel.
Click Math to dedicate the controls for use with a math waveform.
Click Ref to dedicate the controls for use with a reference waveform.
Shaded buttons Indicate unused or undefined waveforms.
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Text edit controls
Use the following controls to edit the Math expression.
Moves the text insertion point to the left of the first
character in the expression.
Moves the text insertion point one character to the left.
Moves the text insertion point one character to the right.
Deletes the character to the left of the insertion point.
Moves the text insertion point to the right of the last
character in the expression.
Clears the entire math expression.

xxx

Math equation editor (Time tab)
From the Math menu, select Equation Editor; then open the Time tab.

To use
Click a control to insert time domain functions into the math expression.

1. Click one of the Primitive buttons to insert a Time function into the math expression.
Average (see
page 919)

Sqrt (see
page 266)

FABS (see
page 266)

Sin (see
page 267)

Cos (see
page 267)

Tan (see
page 268)

Integral (see
page 266)

Log 10 (see
page 267)

Ceil (see
page 267)

ASin (see
page 268)

ACos (see
page 268)

ATan (see
page 268)
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Derivative (see
page 266)

Log e (see
page 267)

Invert (see
page 267)

Exp (see
page 267)

Floor (see
page 267)

Sinh (see
page 268)

Cosh (see
page 268)

Tanh (see
page 268)

Min (see
page 278)

Max (see
page 278)

WfmDB (see
page 268)

xxx

2. Click More to add additional functions.

Behavior
You can use any of the channels as arguments for the function. You can also create nested functions by
inserting one function into the argument portion of another.
Consider the following when working with math waveforms:
Scale and position the source waveform so it is contained on-screen; off-screen waveforms may be
clipped, resulting in errors in the math waveform.
Use the vertical position and vertical offset to position the source waveform. The vertical position will
not affect the math waveform unless you position the source waveform off screen so that it is clipped.
What do you want to do next?
Learn about the Spectral Setup controls. (see page 268)
Learn about using the measurement list with math waveforms. (see page 270)

Integral
Inserts the text INTG( into the math expression. Enter an argument to the function. The integral
function produces the integral of the argument.

Derivative
Inserts the text DIFF( into the math expression. Enter an argument to the function. The derivative
function produces the derivative of the argument.

Absolute value
Inserts the text FABS( into the math expression. The FABS function takes the absolute value of
the expression.

Square root
Inserts the text SQRT( into the math expression. Enter an argument to the function. The square root
function produces the square root of the argument.
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Base 10 logarithm
Inserts the text LOG( into the math expression. Enter an argument to the function. The log function
produces the base 10 logarithm of the argument.

Smallest integer
Inserts the text CEIL( into the math expression. The CEIL function takes the largest integer > the
expression.

Natural logarithm
1. Inserts the text LN( into the math expression.
2. Enter an argument to the function.
The LN function produces the natural logarithm of the argument.

Largest integer
Inserts the text FLOOR( into the math expression. The FLOOR function takes the largest integer <
the expression.

Invert
Inserts the text INV( into the math expression. Enter an argument to the function. The invert function
inverts the argument within the parentheses.

Natural antilog
1. Inserts the text EXP( into the math expression.
2. Enter an argument to the function.
The natural antilog function raises e to the power of the argument.

Sine
Inserts the text SIN( into the math expression.

Cosine
Inserts the text COS( into the math expression.
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Tangent
Inserts the text TAN( into the math expression.

Arc sine
Inserts the text ASIN( into the math expression.

Arc cosine
Inserts the text ACOS( into the math expression.

Arc tangent
Inserts the text ATAN( into the math expression.

Hyperbolic sine
Inserts the text SINH( into the math expression.

Hyperbolic cosine
Inserts the text COSH( into the math expression.

Hyperbolic tangent
Inserts the text TANH( into the math expression.

WfmDB
Inserts the text WFMBD( into the math expression. The WfmBD features accumulates sampling
information into a data base.

Math equation editor (Spectral tab)
From the Math menu, select Equation Editor; then open the Spectral tab.

To use
Click a control to insert spectral analysis functions into the math expression.
1. Click one of the Predefined Functions to insert a Spectral function into the math expression.
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Mag (see page 269)

Real (see page 269)

Phase (see page 290)

Imaginary (see page 269)

xxx

2. Select one of the defined waveforms as an argument using the Channels Selector (see page 264).

Behavior
You can use any of the channels as arguments for the function. Create nested functions by inserting
a function into the argument portion of another.
What do you want to do next?
Learn about the Spectral Setup controls. (see page 252)
Learn about using math functions with math waveforms. (see page 265)
Learn about using the Measurement list with math waveforms. (see page 270)

Magnitude
Inserts the text SpectralMag( into the math expression. Select one of the waveforms as an argument to
the function. This function creates an FFT magnitude waveform.

Real number
Inserts the text SpectralReal( into the math expression. Select one of the waveforms as an argument to
the function. This function creates a waveform that displays only the real part of the FFT.

Imaginary number
Inserts the text SpectralImag( into the math expression. Select one of the waveforms as an argument
to the function. This function creates a waveform that displays only the imaginary part of the FFT.
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Math equation editor (Var tab)
From the Math menu, select Equation Editor; then open the Var tab.

To use
1. Click in a Var <1-8> = entry box and use the multipurpose knobs to enter a value for the variable.
2. Click More to add additional variables
3. Click the associated button to enter that variable into the math expression.
4. Click Controls to access the Math Variables (see page 248) control window.

Behavior
You can assign up to eight different variables to add to your math expression.
Clicking a Var <1-8> button enters the variable into the math expression.
Clicking the More button accesses the other four variables.
The Controls button activates the Math Variables control window where you can quickly set or
change the math variables.
What do you want to do next?
Learn about the Edit controls. (see page 818)
Learn about the Math Variable controls. (see page 248)

Math equation editor (Meas tab)
From the Math menu, select Equation Editor; then open the Meas tab.
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To use
1. Use the list to enter one of the predefined measurements into the math expression.
2. Click the button adjacent to an item to insert the measurement into the expression.

Behavior
The list contains the measurements defined in the Measurement control window. The buttons are only
active for defined measurements; they are unavailable for any undefined measurements.
Measurements are continuously updated on live acquisitions. The most recent measurement values are
always used in math expressions.
What do you want to do next?
Learn about the Edit controls. (see page 818)

Math equation editor (Filter tab)
From the Math menu, select Equation Editor; then open the Filter tab.

To use
Use these controls to insert spectral analysis-based functions into the math expression.
1. In the Math Equation Editor control window, click a Load button.
2. In the Open dialog box, navigate to the location of the filter you want to load. You will find a selection
of available Math Arbitrary Filters (see page 859) in C:/TekScope/Math Arbitrary Filters,
or browse to the location of any custom filters.
3. Select the filter you want to use; then click Open.
4. Click the corresponding Flt <1–8> button (that you used to load the filter) to insert its function into
the math expression.
5. You can select one of the defined waveforms as an argument using the Channels Selector (see
page 264).
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6. Edit the math expression using the Operands and edit controls if needed.
7. When you finish building the expression, click Apply.

Behavior
You can use any of the channels as arguments for the function. Create nested functions by inserting
a function into the argument portion of another.
What do you want to do next?
Learn about the Spectral Setup controls. (see page 252)
Learn about using math functions with math waveforms. (see page 265)
Learn about using the Measurement list with math waveforms. (see page 270)
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Measurement Snapshot control window
From the Measure menu, select Measurement Snapshot.

Overview
Measurement Snapshot lists all of the automated measurements that are available for a selected waveform.

To use
1. Select the waveform for which you want to take a snapshot.
2. Click the Snapshot button in the Measurement control window, or select Snapshot from the Measure
menu.
3. Click either General or Comm in the Snapshot Type group box to begin the snapshot.

Behavior
When the instrument has completed all of the measurements, the snapshot window is updated with the
measurements.
Measurement Snapshot executes all of the single waveform measurements once; the measurements are not
continuously updated. Any measurements previously taken are retained on the display until you complete
a new snapshot. To take another snapshot, click the Refresh button.
NOTE. Automatic measurements are not available on digital channels.
TIP. Before taking a snapshot, be sure to properly display the waveform. Measurement Snapshot does
not warn you if a waveform is improperly scaled (for example, clipped, low signal amplitude, low
resolution, and so on).
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To change the source for taking a snapshot, select another channel, math, or reference memory waveform
and then execute snapshot again.
TIP. For information on measurement algorithms, refer to the Automatic Measurement Algorithms and
Methods for High-Performance Communications Applications application note, 85w_15763.pdf. This
application note is available from the www.tektronix.com Web site.
What do you want to do next?
Return to the Measurement control window overview. (see page 274)

Measurement Setup control window (Amplitude tab)
From the Measure menu, select Measurement Setup; then open the Ampl tab.

Overview
Use this control window to set up the instrument for taking automatic amplitude measurements.

To use
For information on the controls, click the buttons.

Behavior
From this control window, you can do the following:
Define amplitude measurements for the selected waveforms.
Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
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Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.
Use gating to limit the measurements to a specific area of the waveform.
Set up measurement statistics.
Set up histograms to evaluate specific regions of the waveform.
TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms.
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.
NOTE. Some measurements are less accurate using Fast Acquisitions mode, for example, timing
measurements.
Automatic measurements are not available on digital channels.
What do you want to do next?
Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Measurement readouts
An Info (information) column in the measurement readout area displays icons that indicate the status of
each measurement. When an error icon displays, the instrument also displays an error code.
For a list of instrument error codes, messages, and definitions, refer to the Programmer guide available
on the product software DVD or from www.tektronix.com/manuals.
The next table shows some of the icons with examples of their meaning.
TIP. If you hover the mouse pointer over the displayed icon, the instrument displays more specific
information on the measurement status.
Icon

Meaning example
The instrument is in the process of acquiring data and calculating the measurement.
The instrument encountered an error.
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Icon

Meaning example
The instrument cannot locate the specified edge of the signal.
The instrument cannot measure a waveform that is “clipped” on the screen.
The instrument cannot locate the specified signal.

xxx

Null waveform data that is seen during measurements is usually seen when using ET mode, when the
instrument is still filling the waveform record. Warnings appear in the measurement readouts because of
ET mode, but eventually go away once the waveform record fills in. Filters can also cause null waveform
data, and measurements on the resulting math waveforms result in warnings.

Select an amplitude measurement
From the Measure menu, select Measurement Setup; then open the Ampl tab.

To use
Use the Ampl tab to select automatic amplitude measurements.
1. Select a source with the Channels Selector (see page 264).
2. Click a Measurements button to add an Amplitude measurement to the Measure list:
Amplitude (see page 277)

Low (see page 278)

+Ovrshoot (see page 279)

AC RMS (see page 277)

Max (see page 278)

-Ovrshoot (see page 279)

Pk-Pk (see page 278)

Min (see page 278)

Mean (see page 279)

RMS (see page 278)

Cycle RMS (see page 278)

Cycle Mean (see page 279)

High (see page 278)
xxx
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xxx

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 274)
to turn the measurement display on and off.

Behavior
Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.
TIP. Select the individual measurements directly from the Measure menu Amplitude submenu.
What do you want to do next?
Learn about taking timing measurements. (see page 279)
Learn about taking histogram measurements. (see page 296)
Learn about other measurements. (see page 288)
Learn about communication measurements. (see page 284)
Learn more about the Measurements list. (see page 872)
Learn more about the Measurement controls. (see page 292)

Amplitude
This voltage measurement is the high value minus the low value measured over the entire waveform
or gated region:
Amplitude = High – Low

AC RMS
This voltage measurement is the true Root Mean Square voltage over the measurement region.
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Peak to Peak
This voltage measurement is the absolute difference between the maximum and minimum amplitude
in the entire waveform or gated region.

RMS
This voltage measurement is the true Root Mean Square voltage over the entire waveform or gated
region.

High
The high level measurement is the value used as 100% whenever high reference, mid reference, or
low reference values are needed, such as in fall time or rise time measurements. This value can be
calculated using either the min/max or histogram method. The min/max method uses the maximum
value found. The histogram method uses the most common value found above the midpoint. This
value is measured over the entire waveform or gated region.

Low
The low level measurement is the value used as 0% whenever high reference, mid reference, or low
reference values are needed, such as in fall time or rise time measurements.
This value can be calculated using either the min/max or histogram method. The min/max method
uses the minimum value found. The histogram method uses the most common value found below the
midpoint. This value is measured over the entire waveform or gated region.

Maximum
This voltage measurement is the maximum amplitude. It is typically the most positive peak voltage
and is measured over the entire waveform or gated region.

Minimum
This voltage measurement is the minimum amplitude. It is typically the most negative peak voltage
and is measured over the entire waveform or gated region.

Cycle RMS
This voltage measurement is the true Root Mean Square voltage over the first cycle in the waveform
or the first cycle in the gated region.
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Positive Overshoot
This voltage measurement is measured over the entire waveform or gated region.
Positive Overshoot = (Maximum – High) × Amplitude 100%

Negative Overshoot
This voltage measurement is measured over the entire waveform or gated region and is expressed as:
Negative Overshoot = (Low – Minimum) × Amplitude × 100%

Mean
This voltage measurement is the arithmetic mean over the entire waveform or gated region.

Cycle Mean
This voltage measurement is the arithmetic mean over the first cycle in the waveform or the first
cycle in the gated region.

Measurement Setup control window (Time tab)
From the Measure menu, select Measurement Setup; then open the Time tab.

Overview
Use this control window to set up the instrument for taking automatic time measurements.

To use
For information on the controls, click the buttons.
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Behavior
From this control window, you can do the following:
Define time measurements for the selected waveforms.
Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.
Use gating to limit the measurements to a specific area of the waveform.
Set up measurement statistics.
Set up histograms to evaluate specific regions of the waveform.
NOTE. Automatic measurements are not available on digital channels.
TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.
What do you want to do next?
Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a time measurement
Type From the Measure menu, select Measurement Setup; then open the Time tab.

To use
Use the Time tab to select automatic time measurements.
1. Select a source with the Channels Selector (see page 264).
2. Click a Measurements button to add a Time measurement to the Measure list:
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Rise Time (see page 281)

Pos Width (see page 282)

Period (see page 282)

Fall Time (see page 281)

Neg Width (see page 282)

Freq (see page 282)

+Duty Cycle (see page 282)

-Duty Cycle (see page 282)

Delay (see page 282)

xxx

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 279)
to turn the measurement display on and off.

Behavior
Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.
A new control window opens when you click Delay (see page 888). Enter the parameters for the
delay measurement, and then click Ok to return to the Measurement Setup control window. The delay
measurement is added to the list.
TIP. Select the individual measurements directly from the Measure menu Time submenu.

Rise Time
This timing measurement is the time required for the leading edge of the first pulse in the waveform
or gated region to rise from the low reference value (default = 10%) to the high reference value
(default = 90%) of the final value.

Fall Time
This timing measurement is the time required for the falling edge of the first pulse in the waveform
or gated region to fall from the high reference value (default = 90%) to the low reference value
(default = 10%) of the final value.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

281

Measurement setups

Select a time measurement

Positive Duty Cycle
This timing measurement is the ratio of the positive pulse width to the signal period expressed as a
percentage.
The duty cycle is measured on the first cycle in the waveform or gated region.
Positive Duty Cycle = (Positive Width) × Period × 100%

Positive Width
This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a positive pulse.
The measurement is made on the first pulse in the waveform or gated region.

Negative Width measurement
This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a negative pulse.
The measurement is made on the first pulse in the waveform or gated region.

Negative Duty Cycle
This timing measurement is the ratio of the negative pulse width to the signal period expressed as a
percentage. The duty cycle is measured on the first cycle in the waveform or gated region.
Negative Duty Cycle = (Negative Width) × Period × 100%

Period
This measurement is the time required to complete the first cycle in a waveform or gated region.
Period is the reciprocal of frequency and is measured in seconds.

Frequency
This timing measurement is a measure of the first cycle in a waveform or gated region. Frequency is
the reciprocal of the period; it is measured in Hertz (Hz) where one Hz is one cycle per second.

Delay
This timing measurement is the time between the mid reference (default 50%) amplitude point
of two different waveforms
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Measurement Setup control window: (Communications tab)
From the Measure menu, select Measurement Setup; then open the Comm tab.

Overview
Use this control window to set up the instrument for taking automatic communications measurements.

To use
For information on the controls, click the buttons.

Behavior
From this control window, you can do the following:
Define communications measurements for the selected waveforms.
Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.
Use gating to limit the measurements to a specific area of the waveform.
Set up measurement statistics.
Set up histograms to evaluate specific regions of the waveform.
NOTE. Automatic measurements are not available on digital channels.
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TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.
What do you want to do next?
Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a communications measurement
From the Measure menu, select Measurement Setup; then open the Comm tab.

To use
Use the Comm tab to select automatic communications measurements.
1. Select a source with the Channels Selector (see page 264).
2. Click a Measurements button to add a Communications measurement to the Measure list:
Ext Ratio (see page 285)

Eye Width (see page 286)

Jitter P-P (see page 286)

Noise RMS (see
page 287)

ExtRatio% (see page 285)

Crossing% (see
page 286)

Jitter RMS (see page 287)

S/N Ratio (see page 287)

Ext Ratio (dB) (see
page 286)

Eye Top (see page 286)

Jitter 6s (see page 287)

CycDistorition (see
page 287)

Eye Height (see page 286)

Eye Base (see page 286)

Noise P-P (see page 287)

Q-Factor (see page 287)

xxx

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 283)
to turn the measurement display on and off.
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Behavior
Measurements are updated approximately three times a second (or less for long record lengths).
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.
TIP. Most Comm measurements require either WfmDB or FastAcq mode.
You may need to select Infinite Persistence display mode (see page 173) to accumulate enough data
for the Comm measurement to work.
NOTE. You can also select the individual measurements directly from the Measure menu Comm submenu.
What do you want to do next?
Learn about taking amplitude measurements. (see page 276)
Learn about taking timing measurements. (see page 279)
Learn about other measurements. (see page 288)
Learn more about the measurement list. (see page 872)
Learn more about the measurement controls. (see page 292)

Extinction Ratio
Extinction ratio is the ratio of eye top to base. This measurement is only valid when the acquisition
mode is set to WfmDB, FastAcq is enabled, or the measurement is taken on a reference waveform
saved in FastAcq mode.
Ext Ratio = pTopMean/pBaseMean

Extinction Ratio Percent
Extinction ratio percent is the ratio of eye base to top expressed as a percentage.
This measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or
the measurement is taken on a reference waveform saved in FastAcq mode.
Ext Percent = 100 × (pTopMean/pBaseMean).
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Extinction Ratio Decibel
Extinction ratio decibel is the ratio of eye top to base expressed in decibels.
This measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or
the measurement is taken on a reference waveform saved in FastAcq mode.
ExtdB = 10 × Log(pTopMean/pBaseMean)

Eye Height
Eye height is the measurement of the eye height in volts.
Eye Height = (pTopMean-3 × pTopSigma) - (pBaseMean + 3 × pBaseSigma)

Eye Width
Eye width is the measurement of eye width in seconds.
Eye Width = (tCross2Mean-3 × pTopSigma) - (tCross1Mean + *tCross1Sigma)

Crossing Percent
Crossing percent measurement is the eye crossing point expressed as a percentage of eye height.
Crossing Percent = 100 × [(pCross1Mean - pBaseMean)/(pTopMean - pBaseMean)]

Eye Top
Eye Top is the top value used in the extinction ratio measurements.
Eye Top = pTopMean

Eye Base
Eye Base is the base value used in the extinction ratio measurements.
Eye Base = pBaseMean

Jitter Peak-to-Peak
Jitter p-p is the peak-to-peak value for the edge jitter in the current horizontal units.
Jitter PP = TCross1PP
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Jitter Root Mean Square
Jitter RMS is the RMS value of the edge jitter in the current horizontal units.
Jitter RMS = TCross 1sigma

Jitter 6 Sigma
Jitter 6 sigma is six times the RMS value of the edge jitter in the current horizontal units.
Jitter 6 sigma = 6 × (JitterRMS)

Noise Peak-to-Peak
Noise p-p is the peak-to-peak value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.
Noise Pk-Pk = PToppk-pk or PBasepk-pk

Noise Root Mean Square
Noise RMS is the RMS value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.
Noise RMS = PTopsigma or PBasesigma

Signal to Noise Ratio
S/N ratio is the ratio of the signal amplitude to the noise of the top or base of the signal as specified
by you.
S/N Ratio = (Ptop – Pbase)/(PTopsigma or PBasesigma)

Duty Cycle Distortion
Duty cycle distortion is the peak-to-peak time variation of the first eye crossing measured at the
MidRef as a percent of the eye period.
DCD(sec) = 100% × TDCDp-p/(TCross2mean – TCross1mean)

Quality Factor
Quality factor is the ratio of eye size to noise.
Quality Factor = (PTopmean – PBasemean)/(PTopsigma + PBasesigma)
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Measurement Setup control window (More tab)
From the Measure menu, select Measurement Setup; then open the More tab.

Overview
Use this control window to set up the instrument for taking miscellaneous measurements.

To use
For information on the controls, click the buttons.

Behavior
From this control window, you can do the following:
Define miscellaneous measurements for the selected waveforms.
Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.
Use gating to limit the measurements to a specific area of the waveform.
Set up measurement statistics.
Set up histograms to evaluate specific regions of the waveform.
NOTE. Automatic measurements are not available on digital channels.
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TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.
What do you want to do next?
Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a miscellaneous measurement
From the Measure menu, select Measurement Setup; then open the More tab.

To use
Use the More tab to select measurements not found under any of the other measurement tabs.
1. Select a source with the Channels Selector (see page 264).
2. Click a Measurements button to add a More measurement to the Measure list:
Area (see page 290)

Cyc Area (see page 290)

Phase (see page 290)

Burst Width (see page 290)

xxx

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 288)
to turn the measurement display on and off.
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Behavior
Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.
A new control window opens when you click Phase (see page 890). Enter the parameters for the
phase measurement, and then click Ok to return to the Measurement Setup control window. The phase
measurement is added to the list.
TIP. Select the individual measurements directly from the Measure menu More submenu.
What do you want to do next?
Learn about taking automatic phase measurements. (see page 890)
Learn about taking amplitude measurements. (see page 276)
Learn about taking timing measurements. (see page 279)
Learn about taking histogram measurements. (see page 296)
Learn about communications measurements. (see page 284)
Learn more about the Measurements list. (see page 872)
Learn more about the Measurement controls. (see page 292)

Area
Area is a voltage-over-time measurement. The measurement is the area over the entire waveform or
gated region expressed in volt-seconds. The area above the common reference point is positive while
the area below the common reference point is negative.

Cycle Area
The cycle area is a voltage over time measurement. The measurement is the area over the first cycle
in the waveform or the first cycle in the gated region expressed in volt-seconds. The area above the
common reference point is positive while the area below the common reference point is negative.

Phase
This timing measurement is the amount of time that one waveform leads or lags another waveform.
The measurement is expressed in degrees where 360° comprise one waveform cycle.

Burst Width
This timing measurement is the duration of a burst (a series of transient events) and is measured over
the entire waveform or gated region.
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Set up measurement statistics
From the Measure menu, highlight Statistics; then select Statistics Controls from the submenu, or click the
Statistics button in the Measurement Setup window.

Overview
Use the Measurement Statistics control window to display statistical calculations on measurements. The
control window contains controls that determine which statistics are displayed in the measurement window.

To use
Click Off to turn the measurement statistics display off.
Click Mean to display the value and the mean (µ) of each measurement.
Click All to display the statistics for each measurement value.
(µ) Mean
(m) Minimum
(M) Maximum
(s) Standard Deviation
(n) Population
Click in the Weight entry box, and then use the multipurpose knobs to set the statistics weight.
Click Reset to restart the statistics calculations.
TIP. Select the individual statistics directly from the Measure menu Statistics submenu.

Behavior
Measurement values continue as live updates while the statistics accumulate over time. The statistics
appear on the main screen when a control window is open or on the right side of the screen when no
control windows are open and there are less than four measurements active. The color of the statistics
match the color of the waveform from which the measurement was taken.
The statistics weight specifies the constant used to calculate the mean and standard deviation; the minimum
and maximum values are unaffected by weighting. A large value produces statistics that vary less over time.
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All statistics (mean, minimum, maximum, standard deviation, and population) are always gathered even
though the mean may be the only statistic shown. When measurements are turned on, the acquisitions take
longer because measurements and statistic calculations are done on each acquisition.
What do you want to do next?
Return to the Measurement Setup control window overview. (see page 274)
Learn about setting the Reference Level controls. (see page 292)
Learn about using gating to specify measurement areas. (see page 295)

Set up reference levels
From the Measure menu, select Reference Levels, or click the Ref Levs button in the Measurement
Setup window.

Overview
Use the Reference Levels control window to define unique reference levels for each measurement. The
default reference levels serve most general-purpose measurements. You can customize all measurements
to use different reference levels.

To use
Click the Min-Max button to derive the reference levels from the minimum and maximum values of
the waveform record. If you want to derive the reference levels based on statistical data, click the
Histogram or the Histogram mean button.
Refer to the graphic in the center of the control window and determine the reference levels you
want to define. Click in the entry boxes associated with the desired reference level, and use the
multipurpose knobs to adjust the value.
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If you want the reference levels to be measured by volts, click the Absolute button under Units. To
measure the reference levels as a percentage, click the Percentage button.
Click either Eye or Pulse to select the signal type.

Behavior
The following reference levels are included: High Reference (see page 294), Mid Reference (see
page 891), Low Reference (see page 295), and Mid2 Reference (see page 295).
Define the reference levels as percentages of the signal amplitude or as absolute values in vertical units by
clicking the appropriate button to define the Units selection. Use Percentage to have reference levels track
the signal. Use Absolute to set the reference levels to fixed values.
The top and base levels that the measurement system derives from a waveform influence the fidelity of
measurements. The measurement system can derive the reference levels from either the minimum and
maximum values of the waveform or from statistical data.
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Min-max uses the highest and lowest values of the
waveform record. This setting is best for examining
waveforms that have no large, flat portions at a common
value, such as sine waves and triangle waves - almost any
waveform except for pulses.

Histogram Mode sets the values statistically. Using a
histogram, it selects the most common value either above or
below the midpoint (depending on whether it is defining the
high or low reference level). Since this statistical approach
ignores short-term aberrations (overshoot, ringing, and so
on), Mode is the best setting for examining pulses.

Histogram Mean sets the values statistically. Using a
histogram, it selects the mean or average value derived
using all values either above or below the midpoint
(depending on whether it is defining the high or low
reference level). This setting is best for examining eye
patterns and optical signals.

xxx

What do you want to do next?
Return to the Measurement Setup control window overview. (see page 274)
Learn more about Measurement controls. (see page 295)
Learn about using Gating to specify measurement areas. (see page 295)
Learn about using measurement Statistics. (see page 291)

High reference
The High Reference defines the high reference level of a waveform; the default level is 90%. This
reference level is used with the Low Reference level in the calculation of rise and fall times. To
change this level, click the control, and then set the level with the multipurpose knob.
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Low reference
The Low Reference defines the low reference level of a waveform; the default level is 10%. This
reference level is used with the High Reference level in the calculation of rise and fall times. To
change this level, click the control and then, set the level with the multipurpose knob.

Mid2 reference
The Mid2 reference defines the middle reference used on the second waveform specified in delay or
phase measurements; the default level is 50%. To change this level, click the control, and then set
the level with the multipurpose knob.

Set up measurement gating
From the Measure menu, highlight Gating; then select Gating from the submenu or click the Gating
button in the Measurement Setup window.

Overview
Use the Gating control window to limit the measurement area of the waveform to the region bounded by
the vertical bar cursors or to the left and right edges of a Zoom window.

To use
To define the gating area with the vertical bar cursors, click Cursor, and then click either Indep or
Tracking to select the Track Mode. These buttons are only displayed when you click Cursor.
To define the gating area from a Zoom area, click one of the four Zoom buttons.
To turn off measurement gating, click the Off button.
Click Setup to return to the Measurement control window.

Behavior
Normally the instrument takes measurements over the entire waveform record. Gating lets you limit
measurements to a specific portion of the waveform. You can limit gating to the region bounded by the
vertical bar cursors or to the left and right edges of a Zoom area.
When you click Zoom (1–4) the Zoom window appears in the lower half of the display. Measurements are
taken within the boundaries of the Zoom area. You can only take measurements on one Zoom area at a time.
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When you click Cursor, measurements are taken within the boundaries of the vertical cursors. Use the
multipurpose knobs to move the cursors.
When you use vertical cursors to control the gating, you can also specify the cursor mode (see page 84).
Use the independent cursor mode to move the cursors one at a time with the multipurpose knobs. Use
the tracking mode to have the cursors track one another; moving Cursor 1 automatically moves Cursor
2 in tandem.
TIP. Click, hold, and drag across the part of the graticule that you want to measure. After you define the
measurement area, select Measurement Gating from the shortcut menu to place gating cursors around
the measurement area.
Use the same click, hold, and drag method to turn measurement gating off; just select Measurement
Gating Off in the shortcut menu.
What do you want to do next?
Return to the Measurement Setup control window overview. (see page 274)
Learn more about using vertical bar cursors. (see page 81)
Learn more about the Measurement controls. (see page 291)
Learn about setting the Reference Level controls. (see page 292)
Learn about using Measurement Statistics. (see page 291)

Set up histogram measurements
From the Measure menu, select Measurement Setup; then open the Histog tab.

To use
Use this control window to set up the instrument for taking histogram measurements.
For information on the controls, click the buttons.
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Behavior
From this control window, you can do the following:
Define histogram measurements for the selected waveforms.
Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.
Use gating to limit the measurements to a specific area of the waveform.
Set up measurement statistics.
Set up histograms to evaluate specific regions of the waveform.
NOTE. Automatic measurements are not available on digital channels.
TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.
If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.
What do you want to do next?
Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)
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Set up histograms
From the Measure menu, select Waveform Histograms, or click the Histogram button in the Measurement
Setup window.

Overview
Use the Histogram control window to set up a vertical or horizontal histogram. Use vertical histograms to
measure signal noise and horizontal histograms to measure signal jitter.

To use
1. Use the Channels Selector (see page 264) to select the source waveform for the histogram
measurements.
2. Click the type of histogram you want to use for your measurement, Horiz (Horizontal) or Vert
(Vertical). When you make this selection, the instrument continues to calculate histograms until
you set Display to Off.
3. Click either Linear or Log to set the scaling.
4. Adjust the size of the histogram box (Horiz (see page 300) or Vert (see page 301)) by clicking Limits
under Adjust Histogram Box. Use the multipurpose knobs or keypad (see page 42) keypad to set the
box boundaries.
5. Move the location of the histogram box (Horiz (see page 302) or Vert (see page 303)) by clicking
Location under Adjust Histogram Box, and then use the multipurpose knobs or keypad to set the X
and Y locations.
NOTE. You must explicitly click the Histogram Mode Off button to stop accumulating histogram data.
You can also click Reset to start a new histogram.
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Behavior
A histogram consists of a series of narrow bins into which samples are counted. The histogram box defines
the graticule area of the histogram and the number of vertical or horizontal bins. Horizontal histograms
have a maximum of 1000 bins while vertical histograms have a maximum of 252 bins. The upper-most
and bottom-most bins are not displayed. They are used for tracking over-range and under-range hits and
can be obtained by saving the histogram data to a file.
The displayed width or height of the bin that contains the most counts is determined by the Histogram
Size control. The relative sizes for all other bins are scaled proportionally to the bin that contains the
most counts.
Histogram limits use the same units as the horizontal and vertical scale controls. When you specify the
histogram box in terms of location, the Y location control adjusts the bottom edges of the histogram while
the X location control adjust the left edge of the histogram box.
TIP. Here are several tips for using histograms:
Right-click in the Histogram box to access a shortcut menu that will allow you to quickly make changes
to the histogram.
Use the Measure menu or shortcut menu Reset Histogram command to reset all bin counts to 0.
Click, hold, and drag across part of the graticule where you want to set up a histogram and select
Histogram from the shortcut menu.
Use the same click, hold, and drag method to remove a histogram from the display. Select Histogram
Off from the shortcut menu.
You can turn the histogram display off and still accumulate histogram data. This enables you to view the
waveform without having the histogram obscure the data. Turn the histogram display on (use the Display
button on the right side of the control window) at any time to view the histogram.
Use the front-panel channel buttons to turn the source waveform display off so that the waveform does not
obscure the histogram. Data accumulation continues whether the waveform display is on or off.
The instrument can perform up to eight automated statistical measurements (see page 296) on the
histogram. Allow the histogram to accumulate data for a while, and then turn on the desired measurements.
You can use Fast Acquisitions mode with histograms. However, only one or two channels can be displayed.
If three or more channels are displayed, the Fast Acquisitions mode is turned off. The Fast Acquisition
mode is automatically turned back on when you select fewer than three channels.
What do you want to do next?
Return to the Measurement Setup control window overview. (see page 274)
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Histogram box limits - horizontal
1. Select a mode:

2. Specify the adjustment:

3. Enter limits:
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Set histogram box limits - vertical
1. Select a mode:

2. Specify the adjustment:

3. Enter limits:
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Set histogram box location - horizontal
1. Select a mode:

2. Specify the adjustment:

3. Enter limits:
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Set histogram box location - vertical
1. Select a mode:

2. Specify the adjustment:

3. Enter limits:
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Control marks
From the Analyze menu, select Mark.

Overview
Use the Mark Control Window to manually set and clear marks on acquired waveforms in areas of interest.

To use
Use the controls in this window to set a mark on a waveform. You can return to the mark and analyze the
waveform in the area at a later time.
1. Press the MultiView Zoom button on the instrument front panel. The instrument uses Zoom 1 to
set marks.
2. From the Menu bar, select Analyze > Mark.
3. Move the zoom box to the area of interest on the waveform with the multipurpose knob.
4. Use the controls described below to set and clear marks.
NOTE. Marks appear as either green or white triangles on-screen. Green triangles represent locations
placed automatically by the instrument; white triangles represent locations placed manually by the user.

Behavior
Use the Mark controls to set marks and analyze waveforms.
Description. Click in the entry box and use the pop-up keyboard to enter a description for the mark
you place.
Set/Clr. Click this button to add or delete a mark. Marks are placed on the waveform at center screen.
Prev/Next. Click these buttons to advance from one mark to another along the waveform.
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Cursor 1/Cursor 2. Click one of these buttons to position a cursor at the active mark.
Zoom 2/Zoom 3. Click one of these buttons to zoom the area around the active mark. Zoom 1 is the
default used by the Search and Mark feature.

Select a search type
From the Analyze menu, select Search; then open the Select tab.

Overview
Use the controls in this window to set up the instrument to automatically search and place mark(s). The
instrument can search for and mark many of the same conditions that are available for triggers.
NOTE. Search and mark operations are not available on digital channels.

To use
For information on the controls, click the buttons.

NOTE. The Edge search type is standard, all other search types are optional.

Behavior
You can search for and mark regions with particular edges, pulse widths, runts, logic states, rise and fall
times, setup and hold violations and bus types. You can also search on math and reference waveforms.
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Select the search type
From the Analyze menu, select Search; then open the Select tab.

Overview
Use these controls to select the type of search you want the instrument to perform to automatically place
marks on a waveform.

To use
Click a button to identify the type of search to perform.
The search Type will appear under Type in the Type-Source table.

Behavior
Clicking a button places the search selection in the Type column of the Type-Source table

Select the search source
From the Analyze menu, select Search; then open the Select or Configure tabs.

Overview
The Source Selection windows allow you to specify the channel parameters used in the search.
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To use
1. In the Type-Source table, identify the search Type you want to use; then click the right arrow for
that search type under Source.
2. After the Source Selection window opens, identify the Channel, Source, Clock, or Logic parameters to
be used in the search.
3. Click OK

Behavior
Use the single Source Selection window to set the Channel parameters for an Edge, Glitch, Runt,
Transition, Width, Window, or Timeout search.

Use the dual Source Selection window to set the Clock and Data Source parameters for a Setup and
Hold search.

Use the Logic Source Selection window to set the threshold parameters for a Pattern or State logic search.
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Configure a search
From the Analyze menu, select Search; then open the Configure tab.

Overview
Use the controls in this window to set up the instrument to automatically search and place marks.
NOTE. Search and mark operations are not available on digital channels.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

Copy search settings
From the Analyze menu, select Search; then open the Configure tab and press the Copy Settings button.
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Overview
Use these controls to copy settings from one search to another. You can also copy a trigger setting to a
search.

To use
1. Set up the desired search(s) in the Search - Select window.
2. Set up the parameters for the search in the Search - Configure window.
3. Click the Copy Settings button to open the Copy Settings window.
4. In the From drop-down list box, select the search or trigger you want to copy.
5. In the To drop-down list box, select the search to copy the settings to.
6. Click the Copy button.
What do you want to do next?
Learn about Search Advanced DDR Control Settings. (see page 311)

Set advanced DDR search settings
From the Analyze menu, select Search; then open the Configure tab.

Overview
Use the controls in these windows to set conditions for the instrument to automatically search and place
marks.
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To use
1. Under Type, select one of the following entries DDR Read, DDR Write, and DDR Read & Write
in the Select tab.
2. Specify a source for the selected DDR search in the Configure tab.
3. Click the Settings button to configure the advanced DDR settings.

Use either Auto or Manual option in the Mode drop-down (under CS Level). When auto is
selected, the midlevel of the chip select source is automatically calculated, and values above
or below this voltage are used to gate mark generation. In custom mode, the specified level is
used as the midlevel.
Specify a value in the Level entry box (under CS Level). This value is used when the CS Level
Mode is set to manual.
Specify a value in the Hysteresis entry box (under Edge Detection). This value is used for edge
detection in the DDR algorithm.
Specify a value in the Margin entry box (under Termination Logic).
What do you want to do next?
Learn about Search Copy Settings (see page 310).
Learn about setting up DDR search parameters (see page 375).

Set search parameters
From the Analyze menu, select Search; then open the Configure tab.

Overview
Use the controls in these windows to set conditions for the instrument to automatically search and place
marks.
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To use
The available controls depend on the searches you selected in the Search - Select Control Window.
1. Under Type, click on an entry in the Type-Source table.
2. Set up the controls for each search you want to perform.
3. Click the Search button to On to initiate a search.

Behavior
Refer to the following table for information on automated searches the instrument can perform. The search
controls are functionally similar to the trigger controls.
Search type

Description

Equivalent trigger

Edge

Searches for edges (rising or falling)
with a user-specified threshold level.

Edge Trigger Control Window (see
page 431)

Glitch

Searches for pulses narrower (or
wider) than the specified width, or
ignores glitches narrower (or wider)
than the specified width.

Glitch Trigger Control Window (see
page 431)

Pattern

Search for a logic pattern (AND,
OR, NAND, or NOR) across multiple
waveforms with each input set to
either High, Low, or Don’t Care.
Search for when the event goes true,
goes false, or stays valid for >, <, =, or
≠ a user-specified time. Additionally,
you must define one of the inputs
as a clock for synchronous (state)
searches.

Serial Pattern Control Window (see
page 438)

Pulse Width

Searches for positive or negative
pulse widths that are >, <, =, or ≠ a
user-specified pulse width

Width Trigger Control Window (see
page 449)

Runt

Searches for positive or negative
pulses that cross one amplitude
threshold but fail to cross a second
threshold before crossing the first
again. Search for all runt pulses or
only those with a duration >, <, =, or ≠
a user-specified time.

Runt Trigger Control Window (see
page 435)

Setup and Hold

Search for violations of user-specified
setup and hold times.

Setup and Hold Trigger Control
Window (see page 439)

State

Searches for the condition when
all logic inputs to the selected logic
function cause the function to be True
or False when the clock input changes
state.

Logic State Trigger Control Window
(see page 443)
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Search type

Description

Equivalent trigger

Timeout

Searches for no pulse in a specified
time.

Timeout Trigger Control Window (see
page 444)

Transition

Search for rising and or falling edges
that are >, <, =, or ≠ a user-specified
time.

Transition Time Trigger Control
Window (see page 446)

Window

Searches for a signal that is entering
or leaving the threshold window.
Qualify the search in terms of time
by using the When Wider option, or
by the logical state of other channels
using the When Logic option.

Window Trigger Control Window (see
page 451)

DDR Searches

Searches for DDR read or write events
on source waveforms.

None

Bus

Search for bus events on source
waveforms.

Bus Trigger Control Window for
Parallel (see page 399)
Bus Trigger Control Window for I2C
Serial (see page 403)
Bus Trigger Control Window for SPI
Serial (see page 405)
Bus Trigger Control Window for
RS232 Serial (see page 406)
Bus Trigger Control Window for USB
Serial (see page 408)
Search MIPI Bus (see page 345)
Bus Trigger Control Window for PCIe
Serial (see page 415)
Bus Trigger Control Window for CAN
Serial (see page 415)
Bus Trigger Control Window for LIN
Serial (see page 416)
Bus Trigger Control Window for
FLEXRAY Serial (see page 418)

xxx
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Check search results
From the Analyze menu, select Search; then open the Results tab.

Overview
The table in this window displays timing information for all marks placed during a search.

To use
For information on the controls, click the buttons.

Behavior
The Location and Time Delta columns list the search results for each mark placed by the instrument for the
search Type indicated. You can also use the buttons to edit or change the format of the table and save
results to a file.
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View the search counts results
From the Analyze menu, select Search; then open the Results tab and click the Count button.

Overview
Use the controls in this window to view the number of times the search criteria was met and the instrument
placed a mark on the waveform.

To use
For information on the controls, click the buttons.

Behavior
The table in this window displays count results for automated search and mark operations. The Count
column displays the number of times the search conditions were met for a specific Type of search.
You can also use the buttons to edit the Results Mark Table and save results to a file.

View search marks
From the Analyze menu, select Search; then open the View tab.

Overview
Use the controls in this window to display marks.
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To use
Click the Show Marks button On or Off to display the marks placed on a waveform.

Set the search mode
From the Analyze menu, select Search; then open the Mode tab.

Overview
You can set up the instrument to stop acquiring waveforms when a search criteria is met and the instrument
finds a match.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

317

Analyzing waveforms

Use Search and Mark controls

To use
Check the Stop Acquisitions if event found option box to stop acquisitions during a search, if a
match is found.

Use Search and Mark controls
From the Analyze menu, select Search, and then open any of the tabs.

Overview
Use these controls to find points of interest, and place or edit marks on the waveform. The Search and
Mark controls are also available through front panel buttons.
NOTE. Search and mark operations are not available on digital channels.

xxx

To use
Search. Click this button to turn the Search and Mark feature On or Off. Use the corresponding
Search button on the front panel to also turn the feature On or Off.
Prev /Next. Click this button to advance from one mark to another along the waveform. Use the
corresponding Mark  and  buttons on the front panel to also move from mark to mark.
Set /Clr. Click this button to add or delete a user mark. User marks are placed on the waveform at
center screen. Use the corresponding Mark Set/Clr button on the front panel to also add or delete a
user mark.
Cursor 1/Cursor 2. Click one of these buttons to position a cursor at the active mark.
Zoom 2 / Zoom 3. Click one of these buttons to zoom the area around the active mark. Zoom 1 is the
default used by the Search and Mark feature.
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Behavior
Use the Search and Mark controls to set a mark on a waveform at a point of interest. You can return to a
mark and analyze the waveform at a later time.
Marks appear as either green or white triangles on-screen. White triangles represent locations placed
manually by the user. Other triangles represent locations placed automatically by the instrument; the color
of the triangles depend on the selected search index.

Control user marks in table
From the Analyze menu, select Search; then open the Results tab.

Overview
Use these controls to convert search marks to user marks and to edit the Result: Mark Table.

To use
Set. Click this button to add a user mark where a search mark was placed by the system. If a search
mark is not selected, then you are asked to select a search mark.
Set All. Click this button to add a user mark at all places where there is a search mark.
Clear. Click to remove the currently selected user mark. If a user mark is not selected, you are
asked to first select a user mark.
Clear All. Click this button to remove all user marks from the Results: Mark Table.

Change mark display digits
From the Analyze menu, select Search; then open the Results tab.

Overview
Use this control to change the type of notation used in the Results: Mark Table.
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To use
Click the Digits button to toggle the display notation between engineering or high precision form.

Export a mark table
From the Analyze menu, select Search; then open the Results tab.

Overview
Use these controls to export the Mark Table to a file.

To use
Export. Click this button to open the Save Marks Table dialog box and export the table to a file
in CSV format.

View mark counts
From the Analyze menu, select Search; then open the Results tab.
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Overview
Use this control to view event and timing information for marks.

To use
Click the View Time / Count button to toggle between the Results Mark and Results Count tables.

Set up a visual search
Overview
A visual search is performed with the same settings as the main trigger. The results of a visual search are
displayed as marks with a color distinct from those of an Analyze search.

To use
Do the following steps to set up a visual search.
1. Set up pinpoint triggers. Set up trigger controls A Event tab (see page 393)
2. Set up a visual trigger. Visual Trigger Setup (see page 467)
3. Click Mark All Trigger Events in Record.

4. Visual Trigger areas are displayed in blue, or they inherit the source channel color.
5. Visual Search areas are displayed in green.
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6. Only the active visual search area is displayed. Press the Mark Next and the Mark Prev buttons to
move the active area to other visual search areas. Active search areas only appear in the zoom window.

Use the other Analyze Search control windows to control or view the results of the Visual Search.
What do you want to do next?
Learn about bus setups (see page 97).
Learn about trigger setups (see page 393).
Learn about setting up a Visual Trigger (see page 467).
Learn about setting up a search (see page 306).
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Set up 8B10B search parameters
After setting up an 8B10B bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the 8B10B Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such
as for an Error.
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In this example, you need to the errors to search for. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.

Click the Search For selections Error (see page 324), Pattern (see page 325), Character/Symbol (see
page 325), or Any Character (see page 326) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for error
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Search for pattern

Search for character/symbol
The mode options available in Search For Character/Symbol are Character, Symbol, and Disparity.

Select the Disparity from the drop-down list. Click Character to search for a character. Click Symbol
to search for a symbol. Click Setup to adjust the logic thresholds.
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Search for any character

Set up RS-232 search parameters
After setting up an RS-232 bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview
Use the controls to set up the RS-232 Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for a Data.
In this example, you need to set a Number of Bytes, Data Format, and Data Value (click the Edit
(see page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Click the Search For selections Start (see page 328), Parity Error (see page 328), or Data (see page 329) to
view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)
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Search for start

Search for parity error
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Search for data
The data type options available in Search For Data are Number of Bytes, Data Format, and Data Value.

Select the Data Format from the drop-down list. Click Edit to enter the data value. Click Setup to
adjust the logic thresholds.

Set up SPI search parameters
After setting up an SPI bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the SPI Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as for
Data.
In this example, you need to set a Data Format, Number of Words, and Data Value (click the Edit (see
page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Click the Search For selections Data (see page 331) or SS Active (see page 331), to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)
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Search for SS Active

Search for data
The data type options available in Search For Data are Number of Bytes, Data Format, and Data Value.

Select the Data Format from the drop-down list. Click Edit to enter the data value. Click Setup to
adjust the logic thresholds.

Set up I2C search parameters
After setting up an I2C bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the I2C Bus parameters.
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To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window.Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for a Data.
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In this example, you need to set a Addressing Mode, Number of Bytes, Data Format, and Data Value (click
the Edit (see page 942) button). Optionally, you can also set the component threshold levels through the
Logic Thresholds Setup button.

Click the Search For selections Start (see page 333), Stop (see page 334), Repeated Start (see page 334),
Missing ack (see page 334), Address (see page 335), Data (see page 335), orAddress and Data (see
page 336) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for start
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Search for stop

Search for repeated start

Search for missing ack
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Search for address
The address mode options available in Search For Address are Address Format, Address Value,
Addressing Mode, Special Address, and Direction.

Select the Address Format, Addressing Mode, special Address, and Direction from the drop-down
lists. Click Edit to enter the address value. Click Setup to adjust the logic thresholds.

Search for data
The data type options available in Search For Data are Addressing Mode, Number of Bytes, Data
Format, and Data Value.

Select the Addressing Mode and Data Format from the drop-down lists. Click Edit to enter the data
value. Click Setup to adjust the logic thresholds.
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Search for address and data
The address and data mode options available in Search For Address are Address Format, Address
Value, Addressing Mode, Special Address, Direction, Number of Bytes, Data Format, and Data Value.

Select the Address Format, Addressing Mode, special Address, Direction, and Data Format from
the drop-down lists. Click Edit to enter the address and data values. Click Setup to adjust the logic
thresholds.

Set up USB search parameters
After setting up an USB bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the USB Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for a Error.
In this example, you need to set an Error Type. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.

Click the Search For selections Sync (see page 338), Reset (see page 338), Suspend (see page 338),
Resume (see page 339), End of Packet (see page 339), Token (Address) Packet (see page 340), Data
Packet (see page 340), Handshake Packet (see page 341), Special Packet (see page 341), or Error (see
page 342) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)
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Search for sync

Search for reset

Search for suspend
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Search for resume

Search for end of packet
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Search for token (address) packet
The token address packet mode options available in Search For Token (Address) Packet are Token
Type, Address Format, Address, Endpoint Format, and Endpoint.

Select the Token Type, Address Format, When address is, and Endpoint Format from the drop-down
lists. Click Edit to enter the address and endpoint values. Click Setup to adjust the logic thresholds.

Search for data packet
The data packet options available in Search For Data Packet are Data Packet Type, When data packet
is. Number of Bytes, Data Format, Offset, and Data Value.

Select the Data Packet Type, When data packet is, Data Format, and Offset from the drop-down lists.
Click Edit to enter the data value. Click Setup to adjust the logic thresholds.
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Search for handshake packet
The handshake packet option available in Search For Handshake Packet is Handshake Type.

Select the Handshake Type from the drop-down list. Click Setup to adjust the logic thresholds.

Search for special packet
The special packet option available in Search For Special Packet is Special Type.

Select the Special Type from the drop-down list. Click Setup to adjust the logic thresholds.
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Search for error
The Error option available in Search For Error is Error Type.

Select the Error Type from the drop-down list. Click Setup to adjust the logic thresholds.

Search for pattern
The options available in Search For Pattern are Character, Symbols RD+, Symbols RD-, and Disparity.

Select the Character, Symbols RD+, Symbols RD-, and Disparity
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Search for character/symbol
The options available in Search For Character/Symbol are Character, Symbol RD+, Symbol RD-,
and Disparity..

Select the Character, Symbol RD+, Symbol RD-, and Disparity.

Search for long ordered set
The options available in Search For Long Ordered Set are types of ordered sets.

Select the ordered set.
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Search for packets
The data packet options available in Search For Packets are types of Packets.

Select the packet types.

Search for LFPS

Search for any control character
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Set up MIPI search parameters
After setting up a MIPI bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the MIPI Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the drop-down list.
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as for
a Long Packet.
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In this example, you need to set a Data Type Value, Virtual Channel, Direction, Word Count, Number of
Bytes, Payload Format, Payload Value, and Byte Offset (click the Edit (see page 942) button). Optionally,
you can also set the component threshold levels through the Logic Thresholds Setup button.

Click the Search For selections Stop (see page 346), Start of Transmission (see page 347), End of
Transmission (see page 347), Bus Turn Around (see page 347), Escape Mode (see page 348), Warning
(see page 348), Error (see page 349), Short Packet (see page 350), or Long Packet (see page 351) to
view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for stop
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Search for start of transmission

Search for end of transmission

Search for bus turn around
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Search for escape mode
The escape mode command options available in Search For Escape Mode are as follows:

Search for warning
The warning type options available in Search For Warning are as follows:

348

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Analyzing waveforms

Set up MIPI search parameters

Search for error
The error type options available in Search For Error Type are as follows:
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Search for short packet
The data type options available in Search On Short Packet are as follows:

The Search For Short Packet window allows you set the Virtual Channel, Direction, Packet Data
Format, and the Packet Data Value (see page 941).
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Search for long packet
The data type value options available in Search For Long Packet are as follows:
MIPI CSI-2

MIPI DSI-1

xxx

The Search For Long Packet window allows you to set the Virtual Channel, Direction, Data Type
Value, Word Count, Number of Bytes, Payload Format, Offset in bytes, and Payload Value (see
page 941).
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Set up PCIe search parameters
After setting up a PCIe bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the PCIe Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for Character/Symbol.
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In this example, you need to set a Character, Symbol, and Disparity.

Click the Search For selections Long Ordered Set (see page 353), Any Control Character (see page 354),
or Error (see page 354), to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for long ordered set
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Search for any control character

Select the Ordered Set from the drop-down list.

Search for error

Set up CAN search parameters
After setting up a CAN bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the CAN Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such
as for Ident & Data.
In this example, you need to set an Identifier, Direction, Data is, and Data value (click the Edit (see
page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.
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Click the Search For selections Frame (see page 356), Identifier (see page 356), Data (see page 357),
End of Frame (see page 357), Missing ack (see page 357), or Bit Stuff Error (see page 358), to view
their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for frame

Search for identifier
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Search for data
The data type options available in Search For Data are Number of Bytes, Data, and Data is.

Search for end of frame

Search for missing ack

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

357

Analyzing waveforms

Set up LIN search parameters

Search for bit stuff error

Set up LIN search parameters
After setting up an LIN bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the LIN Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as for
Data.
In this example, you need to set a Data is, Number of Bytes, and Data value (click the Edit (see page 942)
button). Optionally, you can also set the component threshold levels through the Logic Thresholds Setup
button.

Click the Search For selections Identifier (see page 360) or Ident & Data (see page 360), Wakeup Frame
(see page 361), Sleep Frame (see page 361), or Error (see page 361) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)
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Search for identifier

Select the Identifier from the drop-down list. Click Edit to enter the data value.

Search for ident & data
The data type options available in Search For Ident & Data are Number of Bytes, Identifier, Data is,
and Data value.

Select the Data from the drop-down list. Click Edit to enter the data value.
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Set up LIN search parameters

Search for wakeup frame

Search for sleep frame

Search for error
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Set up FLEXRAY search parameters
After setting up an FLEXRAY bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview
Use the controls to set up the FLEXRAY Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as for
Data.
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In this example, you need to set a Qualifier, Number of Bytes, Offset, and Data value (click the Edit
(see page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Click the Search For selections Indicator Bits (see page 363), Identifier (see page 364), Cycle Count (see
page 364), Header Fields (see page 365), Ident & Data (see page 365), End of Frame (see page 366), or
Error (see page 366), to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for indicator bits
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Search for identifier
The data type options available in Search For Identifier are Identifier and Qualifier.

Select the Identifier from the drop-down list. Click Edit to enter the value. Click Logic Thresholds to
adjust the logic thresholds.

Search for cycle count
The data type options available in Search For Cycle Count are Cycle Count and Qualifier.

Select the Quallifier from the drop-down list. Click Edit to enter the Cycle Count value. Click
Logic Thresholds to adjust the logic thresholds.
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Search for header fields
The data type options available in Search For Header Fields are Indicator Bits, Identifier, Payload
Length, Header CRC, and Cycle Count.

Click Edit to enter the data value. Click Logic Thresholds to adjust the logic thresholds.

Search for ident & data
The data type options available in Search For Ident & Data are Identifier, Number of Bytes, Qualifier,
Offset, and Data.

Select the Identifier from the drop-down list. Click Edit to enter the data values. Click Logic
Thresholds to adjust the logic thresholds.
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Search for end of frame

Search for error

Set up MIL-1553 search parameters
After setting up a MIL-1553 bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview
Use the controls to set up the MIL-1553 Bus parameters.

To use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for Command Word.
In this example, you need to set an Search when RT Address is, Parity, T/R bit, RT Address, Subaddress
Mode, and Word Count/Mode Code (click the Edit (see page 942) button). Optionally, you can also set the
component threshold levels through the Logic Thresholds Setup button.
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Click the Search For selections Frame (see page 356), Identifier (see page 356), Data (see page 357),
End of Frame (see page 357), Missing ack (see page 357), or Bit Stuff Error (see page 358), to view
their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Search for data
The data type options available in Search For Data are Data, and Parity.

Search for RT/IMG Time
The data type options available in Search For RT/IMG Time are Search when data is, Maximum
Time and Minimum Time.
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Search for error
The data type option available in Search For Error is Error Type.

Search for status word
The data type options available in Search For Error are Message Error, Instrumentation, Service
Request, BCR, Busy, Subsystem, DBCA, Terminal Flag, Parity Search when Remote Terminal
Address is, and RT Address (click the Edit (see page 942) button).

Set up Ethernet search parameters
After setting up an Ethernet bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview
Use the controls to set up the Ethernet Bus parameters.
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To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters such as
for Command Word.
In this example, you need to enter a Source Port, Destination Port, Seq Number, and Acq Number (click
the Edit (see page 942) button). Optionally, you can also set the component threshold levels through the
Logic Thresholds Setup button.
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Click the Search For selections Start of Frame (see page 371), MAC Addresses (see page 371), Q-Tag
Control Information (see page 372), MAC Length/Type (see page 372),IPv4 Header (see page 372),TCP
Header (see page 373),MAC Data (see page 373),TCP/IPv4 Client Data (see page 374),End of Packet (see
page 374),Idle (see page 374), or FCS (CRC) Error (see page 375), to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Start of frame
Select Start of Frame to search for the Ethernet Start of Frame.

MAC addresses
The data type options available in Search For MAC Address are Source MAC, and Destination MAC.
To search for an Ethernet MAC address, enter the Source MAC and Destination MAC addresses.
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Q-Tag control information
The data type option available in Search For Q-Tag Control Information is Q-Tag Value.

MAC length/type
The data type option available in Search For MAC Length/Type is MAC Length/Type.

IPv4 header
The data type options available in Search For IPv4 Header are IP Protocol, Source Address, and
Destination Address.

372

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Analyzing waveforms

Set up Ethernet search parameters

TCP header
The data type options available in Search For TCP Header are Source Port, Destination Port, Seq
Number, and Acq Number.

MAC data
The data type options available in Search For MAC Data are Data, Number of Bytes, Offset, and
Qualifier.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

373

Analyzing waveforms

Set up Ethernet search parameters

TCP/IPv4 client data
The data type options available in Search For TCP/IPv4 Client Data are Data, Number of Bytes,
Offset, and Qualifier.

End of packet
Select End of Packet to search for the Ethernet End of Packet.

Idle
Select Idle to search for an Ethernet Idle character.
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FCS (CRC) error
Select FCS (CRC) Error to search for an Ethernet FCS error.

Set up DDR search parameters
After setting up a DDR bus, go to the Analyze menu, select Search, and then select the bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up DDR, DDR2, DDR3, DDR4, DDR3L, LPDDR, LPDDR2, LPDDR3, GDDR3,
GDDR5 bus parameters.

To Use
For information on the controls, click the buttons.
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Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the channels from the window. Select the search source (see page 307)
Select the DDR standard to search for from the DDR Standard drop-down list.
Select the source of the DQS Strobe from the Strobe DQS drop-down list.
Select the data rate from the Data Rate drop-down list.
Select the input levels from the Input Levels drop-down list.
If you selected the Custom input level, enter the High, Mid, Nd Low levels using the keypad or
attached keyboard.
Select the source of the Data DQ from the Data DQ drop-down list.
Select the source of the chip select and its active state from the CS and Active drop-down lists.
For some DDR searches, you may need advanced control over the chip select level and edge detection.
Select the chip select level mode from the Mode drop-down list.

If you select Manual mode, enter the level using the keypad or keyboard.
Enter the Edge Detection Hysteresis using the keypad or keyboard.
Enter the Termination Logic Margin using the keypad or keyboard.
What do you want to do next?
Learn about bus setups (see page 97).
Learn about Custom Serial Bus Setup (see page 114).
Learn about advanced DDR search settings (see page 311).
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Set up Custom search parameters
After setting up a custom bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the Custom Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the type of bus cycle or activity to search for from the Search For drop-down list.
For some Search For selections, you must set additional fields to define other parameters.
What do you want to do next?
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Learn about bus setups (see page 97). .
Learn about Custom Serial Bus Setup (see page 114)

Set up Parallel search parameters
After setting up a parallel bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview
Use the controls to set up the Parallel Bus parameters.

To use
For information on the controls, click the buttons.

Behavior
Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).
NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

378

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Analyzing waveforms

View the results table

To use
Click the Source box and select the bus number or name from the window. Bus Search Selection List
(see page 100)
Select the pattern to search for using the Pattern Editor.
Select when to place a mark using the Mark When Pattern drop-down list.
What do you want to do next?
Learn about bus setups (see page 97).
Learn about Custom Serial Bus Setup (see page 114)

View the results table
From the Bus Setup window, select the Display tab, and click Results Table, or in the Analyze menu,
select Results Table.

Overview
Use this dialog box to view the decoded contents of a bus.
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To use
To view the decoded contents of a bus, select the tab for the bus, bus layer view, or marks. There is
one tab for each defined bus or bus layer.

Behavior
This dialog box opens when you click Results Table from the Bus Setup Display tab, or in the Analyze
menu, when you select Results Table.
Symbol substitution, annotation and radix behavior is controlled by the Bus Setup control window. There
is one row per bus packet. There is one column per visible property or nondetail field in the bus. You can
change the column width and column order. Some rows or columns can be expanded to show additional
details of the hierarchical bus structure.
Two types of icons are displayed in the Index column.
An Error/Warning icon is displayed if the packet contains an error (red X) or warning (yellow triangle).

If the packet row or bus column contains collapsed detail, the Expand icon (+) is displayed. Click on the
icon to expand the detail. If the detail is expanded, the Collapse icon (–) is displayed. Click on the icon
to close the expanded detail.

Results Table data and Waveform Zoom 1 are correlated with each other. Results Table highlights rows
that intersect with the current Waveform Zoom 1, if enabled. Waveform Zoom 1 moves zoom to center
around the selected row in the event table.

Dock or undock the results table
To dock or undock the results table to the graticule, press the Dock button.
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Resize the docked results table
To resize the docked table, click the splitter above the docked window and drag it to the size you want the
table.

Change the results table column layout
Press the Options button to save a table layout, recall a table layout, or customize columns.
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In the Customize Columns Layout window, you can move columns, select the columns you want
displayed, or restore the defaults.

You can also drag columns to new locations and resize them using a mouse. Right clicking on a column
heading in the table, also lets you select the columns you want displayed.
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What do you want to do next?
Learn about copying a results table. (see page 383)
Learn about selecting the columns to Copy/Export. (see page 384)
Learn about saving a results table. (see page 385)

Copy the results table
From the Analyze menu, select Results Table. Click the Copy button to open the Select the columns to
Copy/Export dialog box. From the dialog box, click the Copy button.

To use
To save to a file, enter a Name or use the default file name. The file extension specified in the Save as
type list will automatically be appended to the file name.

Behavior
Clicking the Copy button in the Select the columns to Copy/Export dialog box, copies the content of the
results table to the Windows clipboard with the data formatted with comma separated values (.csv).
After the copy you can paste the data Word, Notepad, Excel, or other programs.
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What do you want to do next?
Learn about selecting the columns to Copy/Export. (see page 384)

Select columns to copy or export
From the Analyze menu, select Results Table. Click the Settings button to open the Select the columns to
Copy/Export dialog box. From the dialog box, click the Copy button.

Overview
Use this dialog box to select the columns of the results table to copy or export.

To use
To select a column to copy or export, place a check mark next to the column name.

Behavior
Clicking the OK button in the Select the columns to Copy/Export dialog box, selects the checked columns
for use by the copy and export
What do you want to do next?
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Learn about the Results Table. (see page 379)

Save the results table
From the Analyze menu, select Results Table. Click the Export button to open the Select the columns to
Copy/Export dialog box. From the dialog box, click the Export button.

Overview
Use this dialog box to export (save) the contents of the results table to a specified file in comma separated
values (CSV) format.

To use
To save to a file, enter a Name or use the default file name. The file extension specified in the Save as
type list will automatically be appended to the file name.

Behavior
This dialog box opens when you click Export from the Select the columns to Copy/Export dialog box.
The default file type is a file with comma separated values (.csv).
The default folder is C:\Users\[Username]\Tektronix\TekScope\data.
NOTE. Any characters that you enter in the file name box become part of the file name. The instrument
does not use any user-defined file extensions.
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What do you want to do next?
Learn about selecting the columns to Copy/Export. (see page 384)
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Set up a MyScope control window

Set up a MyScope control window
From the MyScope menu, select New Control Window.

Overview
MyScope allows you to create custom control windows that include only the controls you use regularly.
Instead of switching between several control windows, put the controls you use into a custom control
window.

To use
Click + to expand a control category.
Click a control to preview it in the pane at the right.
Click the + additionally to expand the control list. (If there is no +, then the control cannot be
customized further.)
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Clear check boxes in the expanded control list to remove any components you do not want.
Click and drag the controls to your MyScope control window. You can also change the placement of
the control in your MyScope control window by clicking and dragging again.
Click the New Tab button to add a tab to your MyScope control window. You can have up to six tabs in
your MyScope control window. To rename a tab, click the Rename Tab button or double-click the tab.
Click a control already added to the MyScope window, and then click the Delete button to remove it.
Click User Pref to specify the user preferences you want to load:
Prompts (see page 559)
Keypad Defaults (see page 560)
Readouts (see page 561)
Measurement Annotation (see page 563)
Units (see page 564)
Click Save or Save As (see page 390) to save your MyScope control window.
Click Close to close the control window without saving it.
NOTE. Some MyScope controls operate differently than the identical control in the user interface.

Behavior
Clicking on a control in the list allows you to preview the control in the pane at the right. Selecting or
clearing the check boxes for the controls in the list adds or removes controls. When you click and drag
a control to assemble your custom control window, it will snap to the nearest grid location when you
release the mouse.
TIP. To change a control you have already placed into a MyScope control window, drag it back to the
preview pane and the appropriate control category will open for quick modifications.

Use a MyScope control window
Some MyScope controls operate differently than the identical controls in the user interface.

Horizontal controls
The Delay Mode control contains only an On/Off button and Position control.
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Trigger controls
Trigger Type and Trigger Sequence controls have a setup button that is automatically included with the
controls. Use this setup control window to set the parameters for the selected trigger type.
The Trigger Sequence controls represent the right half of the Trigger Setup control window under the A ->
B Event tab. Use this setup window to set the parameters for the trigger sequence.

Cursor controls
The Cursor Multipurpose Knob (MPK) and style controls are available but what displays in your MyScope
control window will depend on what type of cursor you select. For example if you select Screen cursors,
then Cursor MPKs controls and Cursor Style controls display as shown in the following graphic.

However if you select V Bars, then Cursor MPKs controls are not available and the Cursor Style controls
change as shown below.

Measure controls
Measurement controls always include a Next and Clear button. The Clear button clears all measurements
on all channels. The Next button advances the Source to the next active channel and assigns the same
measurements to the next channel as were assigned to the previous channel. This is a quick way to
assign the same measurements to multiple channels.
Each page of the measurement controls can hold up to twelve measurements.

Mask controls
The Mask Test controls act as shortcuts to the Mask Test setup control windows.
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Utilities controls
The Set Time and Date, Instrument Diagnostics, E-mail on Event, and User Preferences Utilities controls
act as shortcuts to the setup control window for these controls. Clicking the Setup button in any one of
these controls will activate the setup control window for that command.
What do you want to do next?
Learn about saving MyScope control windows. (see page 390)
Learn about editing MyScope control windows. (see page 602)

Save a MyScope file as a dialog box
In the MyScope Control Window, click the Save button.

To use
Use this dialog box to save a MyScope control window to a specified location:
Enter a Name in the Name text box, use the default file name, or click Auto-increment file name (see
page 391) if you want to save a series of files without typing in a new name each time. The file
extension specified in the Save as type list will automatically be appended to the file name.
To save to a different directory, select a location in the Save in drop-down list.
Click Save.
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Behavior
This dialog box opens in the default directory C:\Users\[Username]\Tektronix\TekScope\MyScope. If you want to save MyScope control windows in another directory, click
the Save in drop-down list to go to that directory. The only available file type is .tcw.
When you open the saved MyScope control window, the File name is displayed in the upper left corner
of the control window.
What do you want to do next?
Learn about the MyScope Setup and Edit control window. (see page 387)
Learn about opening a MyScope Control window. (see page 391)

Auto-Increment the file name
1. Select the Auto-increment file name to save numerous similar files without retyping the entire
file name each time.
2. Enter a Base file name.
3. Click Save.
For the initial save the default count is 000, but you can overwrite this number if you choose. Your
first file is saved as [Base filename][count].ext, where ext is the file extension. On subsequent
saves, the instrument searches for the highest numbered file name and increases the number by one,
as in Base filename001.ext.
For example, if you are saving a series of rise time data files, you can use "Risetime" as the base file
name. Your first file is saved as Risetime000.ext, where ext is the file type extension. The next file
will be Risetime001.ext, and so on.
TIP. If Count reaches 999, it is suggested that you change the base file name to Base filename1 (for
example, Risetime1) on the next save. Your next file will then be saved as Risetime1000.ext. You will
receive a warning message if you are going to overwrite any files with the same name.

Open or edit a MyScope dialog box
From the MyScope menu, select Open Control Window.

To use
1. In the Look in drop-down list, navigate to the file location or select a control window file from the
dialog box.
2. Click Open.
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Behavior
This dialog box opens to the default directory C:\Users\[Username]\Tektronix\TekScope\MyScope. If you saved MyScope control window files in another directory, click
the Look in drop-down list to go to that directory.
Clicking Open will open the selected MyScope control window, allowing you to add or delete controls.
NOTE. The only available file type is . tcw.
What do you want to do next?
Learn about the MyScope Setup and Edit control window. (see page 387)
Learn about the Save MyScope File As dialog box. (see page 390)
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Set up trigger controls (A Event tab)
From the Trig menu, select A Event (Main) Trigger Setup.
NOTE. This online help documents features and options available for several instrument models. Your
instrument may not have every feature discussed in this online help, depending on its configuration.

To use
Use the Trigger Setup control window to set up the instrument to trigger on live waveforms.
For information on the controls, click the buttons.

Behavior
This control window sets up the main trigger type, also known as the A Event trigger. When you click on
the controls, the trigger graphic (see page 394) displays details on the trigger type.
The trigger expression near the top right side of the Trigger window provides a one-line summary of the
conditions that must be fulfilled before the instrument will trigger.
The trigger event establishes the time-zero point in the waveform record. All points in the record are
located in time with respect to the time-zero point. The instrument continuously acquires and retains
sample points to fill the pretrigger (see page 48) portion of the waveform record. When a trigger event
occurs, the instrument starts acquiring samples to build the posttrigger (see page 456) portion of the
waveform record. Once a trigger is recognized, the instrument will not accept another trigger until the
acquisition is complete and the holdoff time has passed.
NOTE. If you select an inverted channel waveform as a trigger source, the normal waveform is used
instead.
What do you want to do next?
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Learn about the main trigger types. (see page 394)
Learn about sequential triggering. (see page 911)
Learn about B Event triggers. (see page 466)
Learn about Trigger Mode and Holdoff. (see page 482)

Trigger graphic
The trigger graphic displays a visual indicator of the trigger criteria. Depending on the trigger type,
the instrument will update the graphic as you define the trigger parameters.

Select the trigger type
From the Trig menu, select A Event Trigger Setup or B Event Trigger Setup.

To use
In the Trigger Type drop-down list box, select a trigger type.
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A Trigger type

Select the trigger type
B Trigger type

xxx

NOTE. This online help documents features and options available for several instrument models. Your
instrument model may not have every trigger type listed above, depending on its configuration.

Behavior
The instrument provides the following trigger type categories.
Comm. The Communication triggers (see page 429) are designed to work with communication
masks and standards.
NOTE. Comm trigger on B Events is not available on MSO/DPO5000B Series instruments.
Edge triggers. This is the most commonly used trigger type. You can use Edge triggers (see page 431)
with analog and digital signals. Edge triggers are available on both the Main and Delayed triggers.
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Logic triggers. These are special-purpose triggers that are primarily used with digital logic signals.
Two of the classes, Pattern (see page 434) and State (see page 443), trigger the instrument based on the
Boolean operator you select for the trigger sources. A third class, Setup and Hold (see page 439),
triggers when data on one trigger source changes state within the setup and hold times that you specify
relative to a clock on another trigger source. Logic triggers are only available on the main trigger.
NOTE. Logic trigger on B Events is not available on MSO/DPO5000B Series instruments.
Pulse triggers. These are special-purpose triggers that are primarily used with digital signals. The
following classes of pulse triggers are available: Glitch (see page 431), Runt (see page 435), Window
(see page 451), Width (see page 449), Transition (see page 446), and Timeout (see page 444). Pulse
triggers are only available on the main trigger.
NOTE. Pulse trigger on B Events is not available on MSO/DPO5000B Series instruments.
Serial. Serial is a special trigger type used on signals with serial data patterns.
NOTE. Serial trigger on B Events is not available on MSO/DPO5000B Series instruments.
Video. Use Video triggers (see page 448) to trigger the instrument on specified fields or lines of a
video signal. You can use one of several preset video signal formats or set a custom format.
NOTE. Video trigger on B Events is not available on MSO/DPO5000B Series instruments.
Window. Use the Window trigger (see page 451) to trigger the instrument when the input signal rises
above an upper threshold or falls below a lower threshold level.
NOTE. Window trigger on B Events is not available on MSO/DPO5000B Series instruments.
NOTE. Bus trigger on B Events is not available on MSO/DPO5000B Series instruments.
Bus. Use to trigger on parallel or serial bus signals.
NOTE. Some Bus triggers may not be available unless your instrument has a specific option installed.
CAN Bus. Use to trigger on CAN Bus signals.
SPI. Use to trigger on Serial Peripheral Interface signals.
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I2C. Use to trigger on Inter-IC signals: start, stop, repeated start, missing acknowledge, address,
data, and address and data.
RS-232. Use to trigger on RS-232 signals.
TIP. Use the Trig menu Quick Select submenu to directly access the Event triggers.
What do you want to do next?
Learn about sequential triggering. (see page 911)
Learn about B Event triggers. (see page 466)
Learn about Trigger Mode and Holdoff. (see page 482)
Return to the Trigger Setup control window. (see page 393)

Set the trigger mode controls
From the Trig menu, select Mode.

Overview
Use the Trigger control window to set the trigger mode, to force a trigger, or to set the trigger level to 50%.

To use
Click Normal (see page 65) or Auto (see page 65) to set the Trigger Mode.
Click Enhanced Triggering to more accurately place the trigger on the display.
Click Optimized for Noisy Signals to more accurately place the trigger on a noisy signal (available
only if Enhanced Triggering is enabled.)
Click Force Trigger (see page 398) once to acquire a waveform record without a trigger event. Forcing
a trigger is useful when the input signal does not contain a valid trigger. The instrument recognizes
and acts upon the forced trigger even when you click the button before the end of the pretrigger
holdoff. The button has no effect when acquisitions are stopped.
Click Set 50% (see page 398) to set the trigger threshold level of the selected trigger channel to
50% of the amplitude of the channel.
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Set up the trigger holdoff

Behavior
These controls operate identically to the controls on the front panel. For more information on the
individual controls, click the related control in the adjacent graphic.
What do you want to do next?
Read information about Trigger Holdoff. (see page 398)
Return to the Trigger Setup control window. (see page 393)
Read information on the Run/Stop controls. (see page 192)

Force Trigger
Click this button to force the instrument to trigger and complete the current acquisition, regardless of
whether any other trigger event occurs.
NOTE. This command has no effect if the acquisition system is not running.
Push the front-panel Level knob. This control is also available in some trigger setup windows.

To use
Click this button to have the instrument automatically search for and set the trigger level to a value
halfway between the peaks of the trigger source signal.
NOTE. Some trigger types support multiple trigger levels, whereas other trigger types are
unsupported, and the front-panel control is inoperative. This control also works differently for certain
Comm triggers.

Set up the trigger holdoff
From the Trig menu, select Holdoff.

Overview
Use the Trigger Holdoff control Window to set the trigger holdoff (see page 399).
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Set to 50%

To use
Click Auto to set the holdoff to the default amount of time.
Click the Time button; then click in the Trig Holdoff entry box and use a multipurpose knob to specify
a holdoff time.
Click Random to delay the trigger a random amount of time between triggers.

Behavior
When Holdoff is set to Auto, the holdoff time is based on the time equal to five times the current horizontal
scale setting. You may want to manually set the holdoff time to help stabilize the display of complex
waveforms, such as digital pulse trains that may have several possible trigger points.
The Level control can be either the main trigger level when there is no B Trigger event, or the A Event
trigger level when a B Event trigger is defined. To change the B Event trigger level, change the B Trig
Level control under the B Event tab of the Trigger Setup control window.
What do you want to do next?
Return to the Trigger Setup control window. (see page 393)
Read information on Trigger modes. (see page 397)

Trigger holdoff
After a trigger event, the instrument will not accept another trigger event until after the holdoff value
is exceeded. Holdoff is usually specified in units of time, but other units may be used.

Set to 50%
Push the front-panel Level knob. This control is also available in some trigger setup windows.

To use
Click this button to have the instrument automatically search for and set the trigger level to a value halfway
between the peaks of the trigger source signal.
NOTE. Some trigger types support multiple trigger levels, whereas other trigger types are unsupported,
and the front-panel control is inoperative. This control also works differently for certain Comm triggers.

Set up a parallel bus trigger
From the Trigger menu, select the Bus setup.
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Set up a parallel bus trigger

Overview
Use the controls to define the trigger for a Parallel bus.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list. The Bus Type shows
Parallel.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Click the Pattern box and select the condition.
Double-click the Time entry box and use the keypad or the multipurpose knob to enter a time.
When All is selected in the Bus box, click the Trigger if Logic State Goes True box and select True or
False.
Click the Edit button to define a numeric or symbolic value of the Pattern.
Click the Format box and select a Binary, ASCII, Decimal, Hex, or Symbolic display format.
What do you want to do next?
Learn how to define a pattern for a bus. (see page 942)
Learn how to set the voltage threshold reference level for logic waveforms and to define a pattern. (see
page 947)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
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Learn about digital setups. (see page 89)

Set up an 8B10B bus trigger
NOTE. The Bus Trigger Control Window for 8B10B Serial option is available only on instruments with
option SR-810B.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the 8B10B Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Pattern.
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In this example, you need to set the Character or Symbol values and select the Disparity. You can also set
the component threshold levels through the Logic Thresholds Setup button.

Click the Trigger On selections Character/Symbol (see page 402) or Error (see page 403) to view their
parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Character/Symbol
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Trigger on Error
The error type options available in Trigger on Error are as follows:

Set up an I2C bus trigger
NOTE. The Bus Trigger Control Window for I2C Serial option is available only on instruments with
option SR-EMBD.
From the Trigger menu, select the Bus setup.

Overview
Use the controls to set up the I2C Bus parameters.

To use
For information on the controls, click the buttons.
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To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you need to set additional fields to define other parameters such as
for an Address.
In the following example, you need to set an Address Format, Address Value (click the Edit (see
page 941) button), Data Direction, and Addressing Mode. Optionally, you can also set the component
threshold levels through the Logic Thresholds Setup button.

In the following example on MSO/DPO5000B Series instruments, you need to set an Address Format,
Address Value (click the Edit (see page 942) button), Addressing Mode, Special Address, Direction,
Number of Bytes, Data Format, Data Value (Edit (see page 942)) for the Addr+Data Trigger On type.
Optionally, you can also set the component threshold levels through the Logic Thresholds Setup button.

In DPO7000C and MSO70000C/DX Series instruments, when you trigger on an Address for I2C serial
bus, there are some predefined patterns termed as Special Addresses. Use this information to debug
your serial bus. The following table lists the predefined patterns along with their names.
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Name

Address

General Call

0000 000 0

START Byte

0000 000 1

HS-mode

0000 1XX X

EEPROM

1010 XXX X

CBUS

0000 001 X

xxx

Not recommended for use with iCapture inputs.
What do you want to do next?
Learn about bus setups. (see page 97)

Set up an SPI bus trigger
NOTE. The Bus Trigger Control Window for SPI Serial option is available only on instruments with
option SR-EMBD.
From the Trigger menu, select the Bus setup.

Overview
Use the controls to set up the SPI Bus parameters.

To use
For information on the controls, click the buttons.
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To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of cycle to use as the trigger from the Trigger On drop-down list.
For the MISO + MOSI Trigger On selection, push the Edit button to set additional fields for the
Data Value, and then set the Format to match. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.
For some Trigger On selections, you need to set additional fields to define other parameters such as
for a Data.
In the following example, you need to set the Number of Words, Format, and Data Value (click the Edit
(see page 941) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Not recommended for use with iCapture inputs.
What do you want to do next?
Learn about bus setups. (see page 97)

Set up an RS-232 bus trigger
NOTE. The Bus Trigger Control Window for RS-232 Serial option is available on instruments with option
SR-COMP.
From the Trigger menu, select Bus setup.
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Overview
Use the controls to set up the RS-232 Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as
for a Data.

In this example, you need to set the Data Format (click the drop-down list), Number of Bytes, and
Data Value (click the Edit (see page 942) button).
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Not recommended for use with iCapture inputs.
What do you want to do next?
Learn about bus setups. (see page 97)

Set up a USB bus trigger
NOTE. The Bus Trigger Control Window for USB Serial option is available only on instruments with
option SR-USB.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the USB Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
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Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such
as for a Data Packet.
In this example, you need to set a Data Packet Type, Trigger when data packet is, Data Format, Number of
Bytes, Byte Offset, and Data Value (click the Edit (see page 942) button). Optionally, you can also set the
component threshold levels through the Logic Thresholds Setup button.

Click the Trigger On selections Token (Address) Packet (see page 409), Handshake Packet (see page 410),
Special Packet (see page 411), or Error (see page 412) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Token (Address) Packet
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Trigger on Handshake Packet
The handshake type options available in Trigger on Handshake Packet are as follows:

410

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Trigger setups

Set up a USB bus trigger

Trigger on Special Packet
The special type options available in Trigger on Special Packet are as follows:

In the USB bus setup window, set the Speed to High (480 Mbps).
In the Trigger setup window, set the Trigger On condition to Special Packet. Here you have the
option to trigger on ANY, specifically on ERR (high only), SPLIT (high only), PING (high only)
or Reserved special types.
The Trigger on SPLIT token field allows you set the Hub Format and Address, Port Format and
Address, Start/Complete (see page 412), Start and End bits (see page 412), and Endpoint Type (see
page 413).

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

411

Trigger setups

Set up a USB bus trigger

Trigger on Error
The error type options available in Trigger on Error are as follows:

NOTE. The Bit Stuffing error type option is not available on high speed bus.

Start/Complete
The options available in Start/Complete are as follows:

Start and end bits
The options available in Start and End bits are as follows:
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Endpoint type
The options available in Endpoint Type are as follows:

Set up a PCIe bus trigger
NOTE. The Bus Trigger Control Window for PCIe Serial option is available only on instruments with
option SR-PCIE.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the PCIe Bus parameters.

To use
For information on the controls, click the buttons.
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To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add a user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Pattern.
In this example, you need to set the Character or Symbol values and select the Disparity. You can also set
the component threshold levels through the Logic Thresholds Setup button.

Click the Trigger On selections Character/Symbol (see page 402) or Error (see page 403) to view their
parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Character/Symbol
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Trigger on Error
The error type options available in Trigger on Error are as follows:

Set up a CAN bus trigger
NOTE. The Bus Trigger Control Window for CAN Serial option is available only on instruments with
option SR-AUTO.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the CAN Bus parameters.

To use
For information on the controls, click the buttons.
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To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Ident & Data.
In this example, you need to set the Trigger When Identifier, When Direction values, and select the And
when data is values. You can also set the component threshold levels through the Logic Thresholds
Setup button.

Select the Trigger On selections to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Set up a LIN bus trigger
NOTE. The Bus Trigger Control Window for LIN Serial option is available only on instruments with
option SR-AUTO.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the LIN Bus parameters.
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To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Ident & Data.
In this example, you need to set the Trigger when Identifier and the And When Data is values. You can
also set the component threshold levels through the Logic Thresholds Setup button.

Click the Trigger On selections to view their parameters.
What do you want to do next?
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Set up a FLEXRAY bus trigger

Learn about bus setups. (see page 97)

Set up a FLEXRAY bus trigger
NOTE. The Bus Trigger Control Window for FLEXRAY Serial option is available only on instruments
with option SR-AUTO.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the FLEXRAY Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
NOTE. You have the option to add user-defined label for bus sources.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Ident & Data.
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Set up a FLEXRAY bus trigger

In this example, you need to set the Identifier, Data, Number of Bytes, Offset, and Qualifier values. You
can also set the component threshold levels through the Logic Thresholds Setup button.

Click the Trigger On selections Header Fields (see page 419) or Cycle Count (see page 419) to view
their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Header Fields

Trigger on Cycle Count
The options available in Trigger on Cycle Count are as follows:
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Set up a MIL-1553 bus trigger
NOTE. The Bus Trigger Control Window for MIL-STD-1553 Serial option is available only on instruments
with option SR-AERO.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the MIL-STD-1553 Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a Ident & Data.
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Set up a MIL-1553 bus trigger

In this example, you need to set the Trigger When Address is, RT Address type and values, the T/R
bit, Subaddress/Mode type and value, and select the Word Count/ModeCode type and value. You can
also set the Parity.

Click the Trigger On selections Status Word (see page 421), Data (see page 422), Sync (see page 422),
RT/IMG Time (see page 422), or Error (see page 422) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Status Word
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Set up a MIL-1553 bus trigger

Trigger on Data
The error type options available in Trigger on Data are as follows:

Trigger on Sync

Trigger on RT/IMG Time
The error type options available in Trigger on RT/IMG Time are as follows:

Trigger on Error
The error type options available in Trigger on Error are as follows:
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Set up an Ethernet bus trigger

Set up an Ethernet bus trigger
NOTE. The Bus Trigger Control Window for Ethernet Serial option is available only on DPO/MSO5000B
Series instruments with option SR-ENET.
From the Trigger menu, select Bus setup.

Overview
Use the controls to set up the Ethernet Bus parameters.

To use
For information on the controls, click the buttons.

To use
Click the Trigger Type box and select Bus from the drop-down list.
Click the Bus box and select the bus number or name from the drop-down list.
Click the Logic Thresholds Setup button to set the voltage threshold levels for the channels in the bus.
Select the type of bus cycle or activity to use as the trigger from the Trigger On drop-down list.
For some Trigger On selections, you must set additional fields to define other parameters such as for
a TCP Header.
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Set up an Ethernet bus trigger

In this example, you need to set the Source Port, Destination Port, Seq Number, and set the Acq Number.

Click the Trigger On selections Start Frame Delimiter (see page 424), MAC Addresses (see page 425),
Q-Tag Control Information (see page 425), MAC Length/Type (see page 425), IPv4 Header (see page 426),
TCP/IPv4 Client Data (see page 426), MAC Data (see page 427), End of Packet (see page 427), Idle (see
page 427), or FCS (CRC) Error (see page 428) to view their parameters.
What do you want to do next?
Learn about bus setups. (see page 97)

Trigger on Start Frame Delimiter
Select Start Frame Delimiter to trigger on an Ethernet Start Frame Delimiter.
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Set up an Ethernet bus trigger

Trigger on MAC Addresses
For Trigger On MAC Addresses you need to set the Source MAC and the Destination MAC.

Trigger on Q-Tag Control Information
For Trigger on Q-Tag Control Information you need to specify the Q-tag Value.

Trigger on MAC Length/Type
For Trigger on MAC Length/Type you need to specify the MAC length and type.
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Set up an Ethernet bus trigger

Trigger on IPv4 Header
For Trigger on IPv4 Header you need to enter the IP Protocol, Source Address, and the Destination
Address.

Trigger on TCP/IPv4 Client Data
For Trigger On TCP/IPv4 Client Data you need to specify the Data, Number of Bytes, Offset, and the
Qualifier.
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Set up an Ethernet bus trigger

Trigger on MAC Data
For Trigger On MAC Data you need to specify the Data, Number of Bytes, Offset, and the Qualifier.

Trigger on End of Packet
Select End of Packet to trigger on an Ethernet End of Packet.

Trigger on Idle
Select Idle to trigger on an Ethernet idle character.
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Set up a CAN bus trigger

Trigger on FCS (CRC) Error
Select FCS (CRC) Error to trigger on an Ethernet FCS error.

Set up a CAN bus trigger
NOTE. The CAN Bus Trigger type is only available on DPO7000C Series instruments.
From the Trig menu, select CAN Setup.
NOTE. You must install Low Speed Serial Analysis (CAN/LIN trigger) before you can access the CAN
triggers.

Overview
Use the controls in this window to set up the parameters to trigger on a CAN bus.

To use
For information on the controls, click the buttons.
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Set up a Comm trigger

Behavior
Use this trigger to analyze CAN_H or CAN_L bus data frames with single-ended probes, or use a
differential probe to read both signals simultaneously.
NOTE. For low-speed Serial triggering on data streams, the instrument implicitly pads the MSB side of the
entered value, up to the next byte, with "don't care" values (X). To trigger on a two-byte message, you must
enter don't care values explicitly up to the desired size.
For example, a binary entered value of 01 is equivalent to XXXX XX01, whereas a two-byte message
would be entered as XXXX XXXX XXXX XX01.
Not recommended for use with iCapture inputs.

Set up a Comm trigger
From the Trig menu, select Comm Setup.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.

Overview
Use the controls in this window to select the trigger source, coding format, and standard for
communications testing.
NOTE. The Comm trigger is only available on analog channels.

To use
For information on the controls, click the buttons.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

429

Trigger setups

Set up a Comm trigger

Depending on which coding format you use, you can also change the Upper, Lower, and Clock level
thresholds and the pulse form using the multipurpose knobs.

Behavior
Use the Comm Trigger control window to trigger the instrument in conjunction with mask testing on
communications codes and standards. The controls work together to define the parameters for the trigger
event. The standards that appear in the Standard drop-down list depend on the coding format that you
selected. The coding format also determines whether upper, lower, single, or clock threshold levels or
pulse forms are used. The standard determines the bit rate. When you click on the trigger window controls,
the trigger graphic (see page 394) shows the trigger sequence.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
Learn about Set to 50% with Comm triggers. (see page 917)
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Set up an Edge trigger

Set up an Edge trigger
From the Trig menu, select Edge Setup.

Overview
Use the controls in this window to set up Edge trigger parameters for general-purpose testing.

To use
For information on the controls, click the buttons.
The following Trigger Edge screen appears on MSO70000C/DX Series instruments:

Behavior
Edge triggering is the most common way to trigger an instrument. The trigger occurs when the trigger
source passes through a specific level on the specified slope (rising or falling).
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Glitch trigger
From the Trig menu, select Glitch Setup.

Overview
Use the controls in this window to set up the Glitch trigger parameters.
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Set up a Glitch trigger

To use
For information on the controls, click the buttons.
NOTE. The Trigger Glitch screen on a DPO Series instrument is the same as that on an MSO/DPO5000B
and MSO70000C/DX Series instrument except for the source selection and Trigger if Glitch Qualification
options.
In MSO70000C/DX Series the source selection includes a combo list and a Select button. The Trigger
if Glitch Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Glitch screen appears on MSO/DPO70000C/DX Series instruments:

The following Trigger Glitch screen appears on MSO/DPO5000B Series instruments:

Behavior
Use the Glitch trigger to detect and trigger on a glitch or to ignore a glitch. Glitches are defined as pulses
that are narrower than a specified time. The trigger occurs when the instrument detects a pulse outside
(either less than or greater than) the parameters that you specify.
The trigger can also be qualified by the logical state of other channels or by a bus pattern (MSO70000C/DX
Series only). When you click on the trigger window controls, the trigger graphic (see page 394) shows the
trigger sequence.
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Set up a Glitch trigger

What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
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Set up a Logic pattern trigger

Set up a Logic pattern trigger
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
From the Trig menu, select Logic Pattern. It includes the D15-D0 digital channels in the trigger setup on
MSO models. DPO models include only the Ch1 - Ch4 analog channels.

Overview
Use the controls in this window to set up the Logic Pattern trigger parameters.

To use
For information on the controls, click the buttons.

Behavior
Use the Logic Pattern trigger to trigger the instrument when the logic inputs cause the selected function to
become True or False. You can also time qualify the trigger to specify that the logic conditions must be
satisfied for a specific amount of time before the instrument triggers.
The Pattern Type buttons set the Boolean logic function for the trigger.
Not recommended for use with iCapture inputs.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
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Set up a Logic pattern trigger

Set up a Logic pattern trigger
From the Trig menu, select Logic Pattern.

Overview
Use the controls in this window to set up the Logic Pattern trigger parameters.

To use
For information on the controls, click the buttons.

Behavior
Use the Pattern trigger to trigger the instrument when the logic inputs cause the selected function to
become True or False. You can also time qualify the trigger to specify that the logic conditions must be
satisfied for a specific amount of time before the instrument triggers.
The instrument input channels represent the data inputs. You can set each channel to be logic high,
logic low, or "don't care". Use the multipurpose knobs to change the threshold voltages for logic levels
other than TTL.
The Pattern Type buttons set the Boolean logic function for the trigger.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Runt trigger
From the Trig menu, select Runt Setup.
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Set up a Runt trigger

Overview
Use the controls in this window to set up the Runt trigger parameters.

To use
For information on the controls, click the buttons.
NOTE. The Trigger Runt screen on DPO and MSO Series instruments is the same except for the source
selection and Trigger if Runt Qualification options.
In some instruments, the source selection is a drop-down list and the Trigger if Runt Qualification option
has Occurs and Logic.
In other instruments the source selection includes a combo list and a Select button. The Trigger if Runt
Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Runt screen appears on MSO70000C/DX and DPO7000C Series instruments:

The following Trigger Runt screen appears on MSO/DPO5000B Series instruments:

NOTE. Logic qualification option is not available on DPO5000B and MSO5000B Series instruments.
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Set up a Runt trigger

Behavior
Use the Upper Level and Lower Level threshold controls to set the voltage ranges that define a valid pulse.
Runt pulses are short pulses that cross one threshold but fail to cross a second threshold before crossing the
first threshold again. The pulse widths are measured at the voltage level specified by the level controls.
These pulses can also be qualified by time, by the logical state of other channels, or by a bus pattern
(MSO70000C/DX Series only). When you click on the trigger window controls, the trigger graphic (see
page 394) shows the trigger sequence.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
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Set up a Serial pattern trigger

Set up a Serial pattern trigger
NOTE. The Serial Pattern Trigger type is not available on DPO5000B and MSO5000B Series instruments.
From the Trig menu, select Serial Pattern Setup.
NOTE. You must install Protocol Trigger and Decode Option (Opt PTH) on some instruments before you
can access the Serial Pattern triggers.

Overview
Use the controls in this window to set up the Serial Pattern trigger parameters. The coding you select will
determine what standards are available. The clock source determines whether clock level and clock
polarity are available to set.

To use
For information on the controls, click the buttons.

Behavior
You can use this trigger to analyze NRZ patterns found in serial bit streams. Functionality includes
triggering on up to 64 bits and recovery on clock data up to 3.125 GB/s, for MSO/DPO70000C/D and
DPO7000C models.
If you select the same clock and data source, or if the clock source is R Clk, only one level is available for
the data source.
When you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger
sequence.
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Set up a Setup and Hold trigger

Set up a Setup and Hold trigger
From the Trig menu, select Setup/Hold Setup.

Overview
Use the controls in this window to set up the Setup and Hold violation trigger parameters.

To use
For information on the controls, click the buttons.
NOTE. The Trigger Setup/Hold screen on DPO and MSO instruments is the same except for the source
selection and Trigger if Setup/Hold Qualification options.
In some instruments, the source selection is a drop-down list and the Trigger if Setup/Hold Qualification
option has Occurs and Logic.
In other instruments the source selection includes a combo list and a Select button. The Trigger if
Setup/Hold Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Setup/Hold screen appears on MSO70000C/DX and DPO7000C Series instruments:
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Set up a Setup and Hold trigger

The following Trigger Setup/Hold screen appears on MSO/DPO5000B Series instruments:

NOTE. The Logic qualification option is not available on DPO5000B and MSO5000B Series instruments.

Behavior
Use the Setup and Hold violation trigger to trigger on setup and hold time violations. When you click on
the trigger window controls, the trigger graphic (see page 394) shows the trigger sequence.
The setup and hold times define a violation region relative to a clock. Data is considered to be invalid in
the violation region. The instrument monitors the data and clock sources. When a clock edge occurs, the
instrument checks the data channel for transitions within the violation region. If any violations occur,
the instrument triggers with the trigger point located at the clock edge. The setup and hold values can be
positive or negative. The trigger can also be qualified by the logical state of other channels or by a bus
pattern (MSO70000C/DX Series only).
The minimum setup and hold time is 2 ns. Negative setup and hold times skew the violation region to
locate it before or after the clock edge. The instrument can detect and trigger on violations of time ranges
that are before or after the clock.
Use one of the channel inputs as the clock signal and a second channel input as the data input. The
clocking and data levels are used to determine if a clock or data transition has occurred.
Not recommended for use with iCapture inputs.
NOTE. You have the option to add user-defined labels for analog, reference, bus, and digital sources.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
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Set up an SPI bus trigger

Set up an SPI bus trigger
NOTE. The SPI Bus Trigger type is available on instruments with option SR-EMBD.
From the Trig menu, select SPI Setup.
NOTE. This online help documents features and options available for several instrument models. Your
instrument may not have every feature discussed in this online help, depending on its configuration.

Overview
Use the controls in this window to set up the SPI trigger parameters.

To use
For information on the controls, click the buttons.

Behavior
Use this trigger to analyze Serial Peripheral Interface Bus data.
You must supply the following inputs to analyze standard configuration SPI frames:
Slave Select (SS) Source control line
Serial Clock (SCLK) Source
Serial Data In (MISO) Source or Serial Data Out (MOSI) Source
The SS, SCLK, and Data Active controls allow compensation for inverted signals or synchronization on
the falling edge of the clock, if applicable.
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Set up an SPI bus trigger

NOTE. For low-speed serial triggering on data streams, the instrument implicitly pads the MSB side of the
entered value, up to the next byte, with "don't care" values (X). To trigger on a two-byte message, you must
enter don't care values explicitly up to the desired size.
For example, a binary entered value of 01 is equivalent to XXXX XX01, whereas a two-byte message
would be entered as XXXX XXXX XXXX XX01.
When you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger
sequence.

442

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Trigger setups

Set up a Logic State trigger

Set up a Logic State trigger
NOTE. The Logic State Trigger Control Window option is available only on MSO5000B and
MSO70000C/DX Series instruments and on DPO5000B Series instruments with option MSOE installed,
and DPO70000DX instruments with option MSOU installed.
From the Trig menu, select Logic State Setup.

Overview
The trigger setup includes the D15-D0 digital channels on MSO instruments. DPO models show only Ch1
- Ch4 analog channels. Use the controls in this window to set up the Logic State trigger parameters.

To use
For information on the controls, click the buttons.

Behavior
Use the Logic State trigger to trigger the instrument when all of the logic inputs to the selected logic
function cause the function to be True or False when the clock input changes state.
The Pattern Type buttons set the Boolean logic function for the trigger.
Not recommended for use with iCapture inputs.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
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Set up a Logic State trigger

Set up a Logic State trigger
From the Trig menu, select Logic State Setup.

Overview
Use the controls in this window to set up the Logic State trigger parameters.

To use
For information on the controls, click the buttons.

Behavior
Use the Logic State trigger to trigger the instrument when all of the logic inputs to the selected logic
function cause the function to be True or False when the clock input changes state.
Channels 1, 2, and 3 represent the data inputs, and channel 4 represents the clock input. (The clock input is
channel 2 on 2-channel models.) You can set each data channel to be logic high, logic low, or a "don't care"
value. You can set the channel 4&#xa0;input to a rising or falling clock edge (or channel 2 on 2-channel
models). Use the multipurpose knobs to change the threshold voltages for logic levels other than TTL.
The Pattern Type buttons set the Boolean logic function for the trigger.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Timeout trigger
From the Trig menu, select Timeout Setup.
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Set up a Timeout trigger

Overview
Use the controls in this window to set up the Timeout trigger parameters.

To use
For information on the controls, click the buttons.
NOTE. The Trigger Timeout screen on DPO and MSO instruments is the same except for the source
selection (MSO instruments include digital channels) and Trigger if Timeout Qualification options.
In some instruments, the source selection is a drop-down list and the Trigger if Timeout Qualification
option has Occurs and Logic.
In other instruments the source selection includes a combo list and a Select button. The Trigger if Timeout
Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Timeout screen appears on MSO70000C/DX and DPO7000C Series instruments:

The following Trigger Timeout screen appears on MSO/DPO5000B Series instruments:

NOTE. The Logic qualification is not available on DPO5000B and .MSO5000B Series instruments.
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Set up a Transition Time trigger

Behavior
Use the Timeout trigger to trigger the instrument on pulses longer than the specified time. The instrument
will trigger at the end of the time-out period. The instrument can trigger on high, low, or both high and
low pulses. The trigger can also be qualified by the logical state of other channels or by a bus pattern
(MSO70000C/DX Series only). When you click on the trigger window controls, the trigger graphic (see
page 394) shows the trigger sequence.

Use the Timer control to specify the time-out limit; any pulses wider than the limit will trigger the
instrument. The time-out limit is measured at the voltage level specified by the Level control.
NOTE. You have the option to add user-defined labels for analog, reference, bus, and digital sources.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Transition Time trigger
From the Trig menu, select Transition Setup.

Overview
Use the controls in this window to set up the Transition time trigger parameters.

To use
For information on the controls, click the buttons.
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Set up a Transition Time trigger

NOTE. The Trigger Transition screen on DPO and MSO instruments is the same except for the source
selection and Trigger if Transition Qualification options.
In some instruments, the source selection is a drop-down list and the Trigger if Transition Qualification
option has Occurs and Logic.
In other instruments the source selection includes a combo list and a Select button. The Trigger if
Transition Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Transition screen appears on MSO70000C/DX and DPO7000C Series instruments:

The following Trigger Transition screen appears on MSO/DPO5000B Series instruments:

Behavior
Use the Transition trigger to trigger the instrument on pulse edges that traverse between two thresholds
at faster or slower rates than the specified time. You can set up the instrument to trigger on positive or
negative edges. The trigger can also be qualified by the logical state of other channels or by a bus pattern
(MSO70000C/DX Series only). When you click on the trigger window controls, the trigger graphic (see
page 394) shows the trigger sequence.
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Set up a Video trigger

Use the Upper Level and Lower Level controls to define the voltage ranges of interest. The Time control
specifies the target transition time.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Video trigger
NOTE. The video trigger type is available only on DPO7000C, MSO5000B, and DPO5000B Series
instruments.
From the Trig menu, select Video Setup.

Overview
Use the controls in this window to set up the Video trigger parameters.
NOTE. The Video trigger is only available on analog channels.

To use
For information on the controls, click the buttons.
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Set up a Width trigger

Behavior
Use the Video trigger to trigger the instrument on specified fields or lines of a composite video signal.
NOTE. Only composite signal formats are supported. Graphic display formats such as RGB and VGA
are not supported.
Select from several preset video signal formats. If using a preset format, the Lines and Fields Autoset
buttons will optimize the instrument for viewing the fields or lines for your chosen format. You can also
select a graticule and set the polarity of the scan. When you click on the trigger window controls, the
trigger graphic (see page 394) shows the trigger sequence.
You must also set the Scan Type and Scan Rate (see page 449) and you can specify a value for the Holdoff
(see page 399) control in units of time only.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Scan controls
These controls are available for the Bilevel and Trilevel video format types. Interlaced and
Progressive are the only available Scan Types.
The Scan Rate enables you to trigger on nonbroadcast video signals that have unique scan rates.
Select the scan rate range that includes your signal: 15-20 kHz, 20-25 kHz, 25-35 kHz, 35-50 kHz, or
50-65 kHz.

Set up a Width trigger
From the Trig menu, select Width Setup.

Overview
Use the controls in this window to set up the Width trigger parameters.

Behavior
For information on the controls, click the buttons.
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Set up a Width trigger

NOTE. The Trigger Width screen on DPO and MSO instruments is the same except for the source selection
(MSO instruments include digital channels) and Trigger if Width Qualification options.
In some instruments, the source selection is a drop-down list and the Trigger if Width Qualification
option has Occurs and Logic.
In other instruments the source selection includes a combo list and a Select button. The Trigger if Width
Qualification option has Occurs, Logic, and Occurs And.
The following Trigger Width screen appears on MSO70000C/DX and DPO7000C Series instruments:

The following Trigger Width screen appears on MSO/DPO5000B Series instruments:

NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.

Behavior
Use the Width trigger to trigger the instrument on a pulse that is either within or outside the specified
range. The range is defined by the Upper Limit and Lower Limit controls. You can specify widths for
either positive or negative pulses. The pulse widths are measured at the voltage level specified by the
Level control. The trigger can also be qualified by the logical state of other channels or by a bus pattern
(MSO70000C/DX Series only). When you click on the trigger window controls, the trigger graphic (see
page 394) shows the trigger sequence.
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Set up a Window trigger

NOTE. You have the option to add user-defined labels for analog, reference, bus, and digital sources.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up a Window trigger
NOTE. Window trigger is not available on MSO/DPO5000B Series instruments.
From the Trig menu, select Window Setup.

Overview
Use the controls in this window to set up the Window trigger parameters.

To use
For information on the controls, click the buttons.
NOTE. The Trigger Window screen on DPO and MSO instruments is the same except for the source
selection and Trigger if Window Qualification options.
In a DPO Series instrument, the source selection is a drop-down list and the Trigger if Window
Qualification option has Occurs and Logic.
In MSO70000C/DX Series the source selection is a drop-down list . The Trigger if Window Qualification
option has Occurs, Logic, and Occurs And.
The following Trigger Window screen appears on MSO70000C/DX Series instruments:
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Behavior
Use the Window trigger to trigger the instrument when the input signal rises above an upper threshold
level or falls below a lower threshold level. After setting these levels, you can specify whether you want to
trigger the instrument as the signal is entering or leaving the threshold window. The trigger can also be
qualified by the logical state of other channels or by a bus pattern (MSO70000C/DX Series only). When
you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger sequence.
You can further qualify the trigger event in terms of time by using the Inside > t or Outside > t selections,
or by the logical state of other channels using the Trigger When Logic option.
The Trigger When controls change as you select different combinations of options.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Set up Sequential triggering (Horizontal Delay off)
From the Trig menu, select A - B Trigger Sequence; then open the A->B Seq tab.

To use
Select the A->B Seq tab to use the A Event (main) trigger with the B Event trigger to capture complex data.
For information on the controls, click the buttons.
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Trigger on A Only (Horizontal Delay on)

The following screen appears on MSO/DPO5000B Series instruments:

Behavior
The A Event trigger arms the trigger system; the instrument will trigger on the B Event trigger defined by
events or time. You can also set up the instrument to delay the B Event Trigger by a specified time period
by turning Horizontal Delay Mode on.
When you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger
sequence.
What do you want to do next?
Learn about the A Event trigger types. (see page 394)
Learn about B Event triggers. (see page 466)
Learn about Trigger Mode and Holdoff. (see page 482)
Return to the Trigger Setup control window. (see page 393)

Trigger on A Only (Horizontal Delay on)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay on.
For information on the controls, click the buttons.
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The following screen appears on MSO/DPO5000B Series instruments:

To use
1. From the A Event tab, select the Trigger Type.
2. Configure the controls for the A Event in the trigger setup window.
3. Select the A->B Seq tab; then click A Only.
4. Click to set the Horizontal Delay Mode button to On.
5. Use the Horiz Delay and Reference Point entry boxes to delay the acquisition relative to the A Event
trigger.

Behavior
When you select A Only with Delay Mode on, the instrument first looks for the trigger conditions
specified by the A Event. The instrument then delays the acquisition for the time specified by the Horiz
Delay control before acquiring the data.
When you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger
sequence.
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Trigger on A Only (Horizontal Delay off)

What do you want to do next?
Learn more about horizontal delay. (see page 841)
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Trigger on A Only (Horizontal Delay off)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay off.
For information on the controls, click the buttons.

The following screen appears on MSO/DPO5000B Series instruments:
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To use
1. From the A Event tab, select the Trigger Type.
2. Configure the controls for the A Event in the trigger setup window.
3. Select the A->B Seq tab; then click A Only.
4. Click to set the Horizontal Delay Mode button to Off.
5. Use the front panel Horizontal Position control (or click in the Horizontal Position entry box and use a
multipurpose knob) to define the amount of pretrigger data (see page 48).
6. Use the front panel Trigger Level control (or click in the A Trigger Level entry box and use a
multipurpose knob) to set the A trigger level.

Behavior
When you select A Only with Delay Mode off, the instrument looks for the trigger conditions specified by
the A event. When the instrument recognizes the A event, it acquires the posttrigger data (see page 456).
TIP. Use the front-panel Horizontal Position knob to set the amount of pretrigger data.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Posttrigger data
The data acquired and displayed after the trigger event. You can set the amount of pretrigger data
with the Horizontal Position control.

Trigger After Time (Horizontal Delay on)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay on.
NOTE. The A->B Sequence trigger is not available with MultiScope Triggers.
For information on the controls, click the buttons.

456

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Trigger setups

Trigger After Time (Horizontal Delay on)

The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Set up the A Event and B Events from their individual tabs.
2. Select the A–>B Seq tab; then click Trig After Time.
3. Click to set the Horizontal Delay Mode button to On.
4. Select the trigger delay time with the Trig Delay control.
5. Use the Horiz Delay control to delay the acquisition relative to the B event.
6. Adjust the Ref Point and B Trig Level controls as necessary.

Behavior
Use this trigger sequence to trigger the instrument on the B trigger event after the A event.
When you select Trig After Time, the instrument looks for the trigger conditions specified by the A
event. After the A event arms the trigger system, the instrument delays the trigger for the period of
time specified by the Trig Delay control. After the trigger delay time has expired, the instrument looks
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Trigger After Time (Horizontal Delay off)

for the B trigger event. When the instrument detects the B event, it delays the acquisition for the period
of time specified by the Horiz Delay.
What do you want to do next?
Learn more about Horizontal Delay. (see page 841)
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Trigger After Time (Horizontal Delay off)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay off.
NOTE. The A->B Sequence trigger is not available with MultiScope Triggers.
For information on the controls, click the buttons.
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Trigger on nth Event (Horizontal Delay on)

The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Set up the A Event and B Events from their individual tabs.
2. Select the A–>B Seq tab; then click Trig After Time.
3. Click to set the Horizontal Delay Mode button to Off.
4. Select the trigger delay time with the Trig Delay control.
5. Adjust the Horiz Position and B Trig Level controls as necessary.

Behavior
When you select Trig After Time, the instrument looks for the trigger conditions specified by the A
event. After the A event arms the trigger system, the instrument triggers on the next B event that occurs
after the time specified by the Trig Delay control.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)

Trigger on nth Event (Horizontal Delay on)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay on.
For information on the controls, click the buttons.
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Trigger on nth Event (Horizontal Delay on)

The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Set up the A Event and B Events from their individual tabs.
NOTE. On MSO/DPO5000B Series instruments, trigger on B events is available only for Edge trigger.
2. Select the A–>B Seq tab; then click Trig on nth Event.
3. Set the Horizontal Delay Mode button to On.
4. Select the number of B events with the Trig Event control.
5. Use the Horiz Delay control to delay the acquisition relative to the B event.
6. Adjust the Ref Point and B Trig Level controls as necessary.

Behavior
When you select Trig on nth Event, the instrument looks for the trigger conditions specified by the A event.
After the A event arms the trigger system, the instrument looks for a specific number of B events before
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Trigger on nth Event (Horizontal Delay off)

triggering. The instrument then delays the acquisition for the amount of time specified by the Horiz Delay
control. After the delay time has expired, the instrument displays the data.
What do you want to do next?
Learn more about Horizontal Delay. (see page 841)
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
Trigger on nth Event (Horizontal Delay Off). (see page 461)
Trigger on nth Event (B-Event Scan). (see page 463)
Trigger on nth Event (B-Event Scan and Horizontal Delay On). (see page 464)

Trigger on nth Event (Horizontal Delay off)
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with Horizontal
Delay off.
For information on the controls, click the buttons.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

461

Trigger setups

Trigger on nth Event (Horizontal Delay off)

The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Set up the A Event and B Events from their individual tabs.
NOTE. On MSO/DPO5000B Series instruments, trigger on B events is available only for Edge trigger.
2. Select the A–>B Seq tab; then click Trig on nth Event.
3. Set the Horizontal Delay Mode button to Off.
4. Select the number of B events with the Trig Event control.
5. Adjust the Horiz Position and B Trig Level controls as necessary.

Behavior
Use this sequence to trigger the instrument on the nth occurrence of the B event after the A event.
When you select Trig on nth Event, the instrument looks for the trigger conditions specified by the A event.
After the A event arms the trigger system, the instrument looks for a specific number of B events before
triggering and displaying the data (see page 456).
What do you want to do next?
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
Trigger on nth Event (Horizontal Delay On). (see page 459)
Trigger on nth Event (B-Event Scan). (see page 463)
Trigger on nth Event (B-Event Scan and Horizontal Delay On). (see page 464)
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Trigger on nth Event (B-Event Scan)

Trigger on nth Event (B-Event Scan)
NOTE. B-Event Scan is not available on MSO/DPO5000B Series instruments.
From the Trig menu, select A - B Trigger Sequence.

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with B-Event
Scan on.
For information on the controls, click the buttons.

To use
1. Set up the A Event and B Events from their individual tabs.
2. Select the A–>B Seq tab; then click Trig on nth Event.
3. Set the Horizontal Delay Mode button to Off.
4. Set the B Event Scan button to On.
5. Click Setup button to set the values for B Event Advance mode, Start Event, End Event, and Advance
After.
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Behavior
Use this sequence to trigger the instrument on the nth occurrence of the B event after the A event.
When you enable the B-Event Scan, the instrument automatically advances the B-Event value to capture a
different portion of the signal. The B-Event value is initialized to the Start Event value and is advanced to
the End Event value by one of three Advance Methods: Sequential, Random, and Toggle.
What do you want to do next?
Learn more about B-Event scan setup. (see page 796)
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
Trigger on nth Event (Horizontal Delay Off). (see page 461)
Trigger on nth Event (Horizontal Delay On). (see page 459)
Trigger on nth Event (B-Event Scan and Horizontal Delay On). (see page 464)

Trigger on nth Event (B-Event Scan and Horizontal Delay on)
NOTE. The B-Event Scan is not available on MSO/DPO5000B Series instruments.
From the Trig menu, select A - B Trigger Sequence.
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Trigger on nth Event (B-Event Scan and Horizontal Delay on)

Overview
Use the controls in this window to define the parameters for the A ->B Sequence trigger with B-Event
Scan and Horizontal Delay on.
For information on the controls, click the buttons.

To use
1. Set up the A Event and B Events from their individual tabs.
2. Select the A–>B Seq tab; then click Trig on nth Event.
3. Set the Horizontal Delay Mode button to On. Select the number of B events with the Trig Event
control, use the Acquisition Delay control to delay the acquisition relative to the B event, and adjust
the Ref Point and B Trig Level controls as necessary.
4. Set the B Event Scan button to On. Click Setup button to set the values for B Event Advance mode,
Start Event, End Event, and Advance After.

Behavior
Use this sequence to trigger the instrument on the nth occurrence of the B event after the A event. The
instrument then delays the acquisition for the amount of time specified by the Acquisition Delay control.
After the delay time has expired, the instrument displays the data.
When you enable the B-Event Scan, the instrument automatically advances the B-Event value to capture a
different portion of the signal. The B-Event value is initialized to the Start Event value and is advanced to
the End Event value by one of three Advance Methods namely Sequential, Random, and Toggle.
What do you want to do next?
Learn more about B-Event scan setup. (see page 796)
Learn more about other trigger types. (see page 394)
Return to the Trigger Setup control window. (see page 393)
Trigger on nth Event (Horizontal Delay Off). (see page 461)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

465

Trigger setups

Set up trigger controls (B Event tab)

Trigger on nth Event (Horizontal Delay On). (see page 459)
Trigger on nth Event (B-Event Scan). (see page 463)

Set up trigger controls (B Event tab)
From the Trig menu, select B Event (Delayed) Trigger Setup.

To use
Use the controls is this window to define the parameters for the B Event trigger.
For information on the controls, click the buttons.
NOTE. On MSO/DPO5000B Series instruments, trigger on B events is available only for Edge trigger.

Behavior
These controls work together to define the parameters for the trigger event. Use the B Event trigger with
the A Event trigger to capture more complex events. The B Event trigger controls are independent from
the A Event trigger. When you click on the trigger window controls, the trigger graphic (see page 394)
shows the trigger sequence.
What do you want to do next?
Learn about sequential triggering. (see page 911)
Learn about the A Event trigger types. (see page 394)
Learn about Trigger Mode and Holdoff. (see page 482)
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Visual trigger

Return to the Trigger Setup control window. (see page 393)

Visual trigger
From the Trig menu, select Visual Trigger Setup. Visual triggers are optional.

Overview
Use the Visual Trigger control window to control which triggered waveforms are displayed. For example,
the following screen capture shows a waveform acquired using edge trigger.

The following screen capture shows the same waveform acquired using edge trigger and visual trigger
with two visual trigger areas controlling which triggered waveforms are displayed.

Use the Visual Trigger control window to control which triggered waveforms are displayed.
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Behavior
The control window provides the following visual trigger controls.
Pressing the Visual Trigger button toggles visual triggering on and off.
NOTE. When Visual Trigger is turned on, the trigger mode is set to Normal. You can change the mode to
Auto by pressing the front panel Trigger Mode button.
Double clicking in the expression area, displays the Qualification Expression Editor window.
Press the Save button to display the Save Visual Setup window. Save Visual Setup only saves the
Visual Trigger settings.
Press the Recall button to display the file Open window.
The Trigger only if matches this condition graphic displays the triggering conditions required to
display triggered waveforms on the instrument.
Check the Display Visual Trigger on Screen check box to toggle display of the visual trigger areas
on and off.
Check the Trig Expression check box to toggle display of the trigger expression on and off.
Check the Area Settings check box to toggle display of the visual trigger area settings on and off.
Click Default Colors to make the visual trigger areas use the default visual trigger colors.
Click Inherit Source Colors to make the visual trigger areas inherit the vertical channel colors.
Click the Visual Setup button to display the Visual Qualification Setup window.
What do you want to do next?
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification expressions. (see page 475)

468

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Trigger setups

Create a visual trigger area

Learn about defining a visual trigger area. (see page 472)
Learn about editing a visual trigger area. (see page 473)

Create a visual trigger area
In the graticule area, left click, drag the cursor, and then release.

Create an area
Create a visual trigger area by clicking and dragging a box on the display. Then select Visual Trigger >
Add Visual Trig Area.

In the same menu you can hide or show all visual trigger areas and toggle visual triggering on and off.

Behavior
Once a visual trigger area is created, you can control the size and position of the area;
Click the area to enable its handles. Click again to display the vertices.
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xxx

Click and drag the area to move it to a new location.
Click and drag one of the area handles to resize the area vertically, horizontally, or both.
Click and drag the circle handle to rotate the area.
Click and drag one of the vertices to change the shape of the area by moving the vertex. Right click
the area to add or delete a vertex.
Visual trigger areas show the area number, area handles, the channel included or excluded from the area,
and a check mark or x indicating whether the channel is included or excluded in the area.
Creating a visual trigger area adds the area to the visual trigger expression. Clicking a waveform handle
before creating a visual trigger area changes the channel included in the area and equation. Right clicking
an area and selecting Must be inside or Must be outside changes the expression to either include or
exclude the channel in the area. Controlling Visual Triggering (see page 470) shows a waveform excluded
from a visual trigger area.
What do you want to do next?
Learn about visual trigger setup. (see page 467)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification expressions. (see page 475)

Control visual triggering
In the display, right click a visual trigger area and select Visual Trigger Area from the menu.

Overview
Use the right-click menu to control visual trigger areas, qualification expressions, and visual triggering.
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To use
Right click a visual trigger area and select Visual Trigger Area.

Select Edit Shape to change the shape and orientation of the visual trigger area. Selections include the
following:
Triangle
Rectangle
Hexagon
Trapezoid
Add Vertex. After adding a vertex, if vertices are not enabled, double click the visual trigger area.
Then select each vertex and drag it to its desired location.
Delete Vertex
Flip Vertical
Flip Horizontal
Select Must be inside, Must be outside, or Edit Equation to create the qualification expression:
Must be inside specifies which channel the area must be inside.
Must be outside specifies which channel the area must be outside.
Edit Equation opens the Qualification Expression Editor, allowing you complete control over the
qualification expression.
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Select what is displayed:
Hide Trig Expression toggles display of the trigger expression on and off.
Hide Visual Trig Areas toggles display of all visual trigger areas on and off.
Hide Area Settings toggles display of the area settings on and off.
Visual Trigger Off toggles visual triggering on and off.
What do you want to do next?
Learn about visual trigger setup. (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification expressions. (see page 475)

Define an area
In the Visual Trigger window, click Visual Setup.

Overview
Use these control to change the settings of each visual qualification area.

To use
Change the settings of a visual qualification area.

Select the Visual Area to set up
Select the Source that will either be included in or out of the visual trigger area
Select the Logic for Source in Area, either In or Out
Enter a Label for the visual trigger area using either a keyboard or the virtual keyboard
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Set the position of the area by entering a Horizontal and Vertical Position
Create a new visual trigger area by pressing the Add or Duplicate buttons
To delete an area or all visual trigger areas, press the Delete or Del All buttons.
If you want to change the default shape of your visual trigger area, select a shape from the Select
Area Shape drop down list
To apply settings you have made, press the Set button
To specify the number of degrees to flip or rotate the area, enter the number of degrees in the Flip
and Rotate Area text box.
To flip the area 180°, press the Flip Horiz or Flip Vert buttons
To move the active vertex, enter a Horizontal or Vertical position using a keyboard or the virtual
keyboard
To add or delete a vertex, press the Add or Delete buttons
To change the vertical or horizontal size of the visual trigger area, enter a new size in the Area Size
Height (Y) or Width (X) text boxes. To maintain the aspect ratio of the area while you change the
width or height, click the Maintain Aspect Ratio check box
What do you want to do next?
Learn about Visual Trigger Qualification (see page 475)
Learn about visual trigger setup. (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about editing a visual trigger area. (see page 473)

Edit expression logic
In the Visual Qualification Setup window, select the Edit Logic tab.

Overview
Use these controls to change the source channels and visual qualifier areas that are part of the visual
qualifier expression.
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To use
Click in the logic expression box to edit the contents of the expression. Pressing a button adds the item
to the expression. If you select an item in the expression, then pressing a button replaces the selected
portion of the expression.
Change the source channels, visual qualifier, and the visual qualifier areas that are included in the
expression. When your finished making changes to the expression, press the Apply button.

Press Save to save a visual trigger expression for later recall. See Save a Visual Setup (see page 480)
Press Recall to recall a visual trigger expression. See Recall a Visual Setup (see page 481)
The Trigger only if matches this condition graphic displays the triggering conditions required to
display triggered waveforms on the instrument.
Check the Display Visual Trigger on Screen check box to toggle display of the visual trigger areas
on and off.
Check the Trig Expression check box to toggle display of the trigger expression on and off.
Check the Area Settings check box to toggle display of the visual trigger area settings on and off.
Click Default Colors to make the visual trigger areas use the default visual trigger colors.
Click Inherit Source Colors to make the visual trigger areas inherit the vertical channel colors.
What do you want to do next?
Learn about Visual Trigger Qualification (see page 475)
Learn about visual trigger setup. (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about defining a visual trigger area. (see page 472)
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Set up visual trigger expression
From the Trig menu, select Visual Trigger Setup; then double click the Visual Trigger equation.

Overview
Use the Qualification Expression Editor control window to define or edit visual trigger expressions. The
readout shows the qualification expression as you construct it. New operands are added at the cursor
location each time you click one of the operand buttons.

To use
For information on the controls, click the buttons.

Behavior
You can create a qualification expression using one or more of the following approaches:
Select one of the channels as an operand by clicking one of the channels in the Channels selector. Use
the edit controls to add additional numbers and operators to complete the math expression.
Connect an external keyboard and use it to enter the expression.
Create an expression using an external text editor or another application. Copy the text to the Windows
clipboard. Right-click with the mouse to paste the text into the expression.
If you create an expression that is longer than the physical space in the control window readout, you can
scroll through the expression using the Text Edit controls (see page 265).
Click Apply to apply the visual qualification expression to visual triggering.
What do you want to do next?
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Select a channel

Learn about visual trigger setup. (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)

Select a channel
Specify the Ch <1 - 4> for oscilloscope operations.
Specify a channel to dedicate the controls for use with an input on the front panel.
Shaded buttons Indicate unused or undefined waveforms.

Enable the visual trigger expression editor
From the Visual Trigger menu, double click the Visual Trigger expression.

To use
Click Enable to toggle display of the visual trigger waveform on and off.

Behavior
This control only affects the visual triggering.
What do you want to do next?
Learn about visual trigger setup. (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification. (see page 475)
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Edit the visual trigger expression
From the Visual Trigger menu, double click the Visual Trigger expression.

To use
Click in the readout field to enter the visual trigger expression.
Click a button to enter its character or operator into the expression.
Use the Text Edit Controls (see page 265) to move the insertion point (cursor) within the expression.

Behavior
The characters are entered into the expression one at a time.
What do you want to do next?
Learn about visual trigger setup (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification. (see page 475)
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Use the expression editor operands

Use the expression editor operands
From the Visual Trigger menu, double click the Visual Trigger expression.

To use
Click an individual button to enter a character or operator into the visual qualification expression.

Behavior
The characters are entered into the expression one at a time.
What do you want to do next?
Learn about visual trigger setup (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification. (see page 475)
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Text edit controls

Text edit controls
Use the following controls to edit the expression.
Moves the text insertion point to the left of the first character in the expression.
Moves the text insertion point one character to the left.
Moves the text insertion point one character to the right.
Deletes the character to the left of the insertion point.
Moves the text insertion point to the right of the last character in the expression.
Clears the entire math expression.

xxx
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Save a visual setup
From the Trig menu, select Visual Trigger Setup; then press Save from the control window.

Overview
Use this dialog box to save Visual Trigger setups to a file for later use. The setup is stored in
human-readable text in GPIB command format.

To use
1. In the Save As dialog box, assign your own file name, and then save the file to a specified folder.
2. Click Save to save the visual trigger setup or cancel to close the dialog box without saving.
What do you want to do next?
Learn about visual trigger setup (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about recalling a visual trigger setup. (see page 481)
Learn about visual trigger qualification. (see page 475)
Learn about saving a waveform. (see page 541)

480

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Trigger setups

Recall a visual setup

Recall a visual setup
From the Trig menu, select Visual Trigger Setup; then press Recall from the control window.

Overview
Use this dialog box to recall a Visual Trigger setup.

To use
Visual trigger setups are recalled from an internal file on your hard drive that you have named.
To recall a visual trigger setup from a file, select the location of the setup from the Look in list. Select
the setup you want to recall, and then click Open.

Behavior
The setups are restored from an internal file on your hard drive as soon as you click the Open button.
What do you want to do next?
Learn about visual trigger setup (see page 467)
Learn about creating a visual trigger area. (see page 469)
Learn about controlling visual triggering. (see page 470)
Learn about saving a visual trigger setup. (see page 480)
Learn about visual trigger qualification. (see page 475)
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Set up trigger controls (Options tab)

Set up trigger controls (Options tab)
From the Trig menu, select the A Event or B Event Trigger Setup; then open the Options tab.

Overview
Use the controls in this window to set up the trigger mode.
For information on the controls, click the buttons.

To use
To set the Trigger Mode, click either Auto or Normal.
To enhance trigger positioning (see page 483), click in the option boxes.
To set the Trigger Holdoff time manually, click Time, and then use the multipurpose knob to set the
holdoff time. The Holdoff range is 250 ns (minimum holdoff available) to 100 s (maximum holdoff
available).
To enable Save on Trigger, click the check box.
To enable E-mail on Trigger, click check box.
To set up the e-mail on event parameters, click Setup. Set the A Event trigger level using the A
Trig Level control and the multipurpose knob.

Behavior
Use the trigger holdoff time to delay the trigger system for a specified amount of time between triggers, or
click Auto to let the instrument calculate the time for you. You can also set the holdoff to a Level that
synchronizes the instrument with an incoming signal to generate a stable display and avoid triggering on
undesired events. When you click on the trigger window controls, the trigger graphic (see page 394)
shows the trigger sequence.
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Enable trigger position correction

If E-mail on Event has already been set up, clicking E-mail on Trigger enables you to send e-mail on a
trigger. If E-mail on Event has not been set up, you must first click Setup, and then configure E-mail
on Event in the setup control window.
What do you want to do next?
Return to the Trigger Setup control window. (see page 393)
Learn about setting up E-mail on Event. (see page 555)

Enable trigger position correction
From the Trig menu, select A Event (Main) Trigger setup; then open the Mode tab.

Overview
Trigger Position corrects for internal differences in the data and trigger paths to more accurately place
triggers on displayed waveforms. This feature can also use averaging to improve trigger placement
on noisy signals.
Trigger Position Correction works for all pinpoint trigger types, except Pattern trigger: Edge, Glitch,
Width, Timeout, Runt, State, Setup and Hold, Transition, Window.

To use
To more accurately place triggers:
Click Enhanced Triggering to more accurately place a trigger on the display.
Click Optimized for Noisy Signals to more accurately place the trigger on a noisy signal (available
only if Enhanced Triggering is enabled.)

Behavior
The Trigger Type indicator(s) in the status area change when you apply Trigger Position Correction. In the
example below, the Trigger A indicator changed from A to A' when trigger correction was applied.
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Enable trigger position correction

NOTE. You can use Trigger Position Correction in any combination for A Event, B Event, or Sequence
triggers, including Trigger After Time and Trigger on nth Event. It is fully compatible with all acquisition
and logic qualification sampling modes, Bandwidth Enhancement, and FastFrame, but not Fast
Acquisition.
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Set up Vertical controls

Set up Vertical controls
From the Vertical menu, select Vertical Setup.

Overview
Use the Vertical Setup control windows to set vertical parameters for live (channel) waveforms. The
example windows below do not show controls for attached probes.
Click for DPO7000C and MSO/DPO5000B Series
instruments

Click for MSO/DPO70000C/DX Series instruments

xxx

For information on the Vertical Setup controls, click the buttons.
NOTE. iCapture is available only on MSO70000C/DX Series instruments and DPO70000DX instruments
with option MSOU installed.
Termination Voltage is available only on MSO/DPO70000DX Series instruments.
NOTE. The bandwidth readout displays in reverse video if the bandwidth is not what you selected. If you
want the bandwidth to be what you selected, make sure that the sample rate is high enough to enable
Digital Filters (DSP). One way to enable DSP is to select Force Constant Sample Rate.
NOTE. The features and options that are documented in this online help are available for several
instrument models. Your instrument may not have every feature discussed in this online help.

To use
Use the tabs on the side of the control window to select the channel you want to change. The controls for
each channel are independent.
What do you want to do next?
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Set up input channels

Continue to learn about the Vertical Setup controls. (see page 954)

Set up input channels
NOTE. iCapture is available only on MSO70000C/DX Series instruments and DPO70000DX instruments
with option MSOU installed.
From the Vertical menu, select Vertical Setup.

To use
Click the Analog Input Normal button when you want the instrument to display the channel for the
selected tab. Each channel has a tab.

Click the Digital Input iCapture (see page 809) button when you want the instrument to display analog
characteristics of a digital channel.
The following screen is captured on MSO70000C/DX Series instruments:
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Zoom Control Window

NOTE. Right-click on the digital source readout in the waveform window to reroute from one analog
channel to any of the other three analog channels. For example, right-click on D0 captured on Ch1 and
select iCapture on Ch2 to reroute the source D0 to Ch2.
The following screen is captured on MSO/DPO5000B Series instruments:

TIP. You have the option to add user-defined labels for the analog, reference, bus, and digital sources.

Behavior
When the Analog Input Normal button is selected, the remaining display, probe, and zoom parameters are
the same as on all other models.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 954)
Learn about the Digital Input iCapture feature. (see page 809)
Learn about the Digital Properties button. (see page 811)

Zoom Control Window
From the Vertical or Horiz /Acq menus, select Zoom Controls, or push the front-panel MultiView Zoom
button.

Overview
Use the Zoom control window to select the Zoom Area and Source, assign, and to lock and scroll the
zoomed areas.
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Zoom Control Window

The following screen appears on MSO70000C/DX Series instruments:

To use
1. Click a Horiz or Vert button to assign the Horizontal or Vertical zoom controls to the multipurpose
knobs.
2. Select the zoom area from the Area drop-down list. The changes you make in this control window
apply only to the zoom area selected.
3. Use the Zoom Source drop-down list to select the waveform or area you want to zoom in on.
4. Click the Waveforms Hide button to open the Show/Hide Waveforms dialog box; here you can identify
waveforms you do not want to display in the selected zoom area.
Click Setup to display the Zoom Setup control window (see page 202) where you can access additional
Zoom controls.
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Waveform Display Control Window

Behavior.
You can also access the controls for both the Acquisition and Zoom windows from the front panel.
Selecting Zoom (1–4) as the Zoom Source allows you to zoom on zoom.
TIP. You can easily zoom in on a waveform by clicking and dragging a box around the area of interest.
Then select Zoom (1– 4) On from the shortcut.
What do you want to do next?
Learn about the Zoom Setup controls. (see page 202)
Return to the Vertical Setup control window overview. (see page 485)
Return to the Horizontal Setup control window. (see page 181)
Learn about the AutoScroll control window. (see page 877)

Waveform Display Control Window
From the Vertical or Math menus, select Display On/Off.

Overview
Use the Position/Offset control window to turn the selected waveform on or off.

To use
1. Click the Channels selector (see page 264) to select a valid channel, math, or reference waveform.
2. Click Display to turn the selected waveform on or off.

Behavior
The Display button applies only to the selected waveform. Each waveform (channel, math, or reference)
has its own Display button.
Any displayed channel, math, or reference waveform can be turned off without impacting any math
functions, measurements, or histograms done on that waveform. You may want to turn some waveform
displays off to make the remaining waveforms easier to view and analyze.
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Set the Position/Offset

TIP. Use the dedicated front-panel buttons to turn the channel waveforms on or off.
What do you want to do next?
Learn more about the Waveform controls. (see page 490)

Set the Position/Offset
From the Vertical or Math menus, select Position/Scale.

To use
Use the Position/Offset control window to set the vertical position and offset of the selected waveform.
1. Use the Channels Selector (see page 264) to select a waveform.
2. Use the Scale (see page 938) and Position (see page 937) controls to set the vertical position and
scale of the selected waveform.
3. Use the Offset control to set the vertical offset (see page 491) of the selected waveform.

What do you want to do next?
Learn more about the Vertical Position control. (see page 937)
Learn more about the Vertical Scale control. (see page 938)
Learn more about the Waveform controls. (see page 491)
Learn more about the Vertical controls. (see page 491)
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Waveform Label Control Window
From the Vertical or Math menus, select Label.

Overview
Use the Label control window to attach a label to the waveform.

To use
1. Use the Channels Selector (see page 264) to select a valid channel, math, or reference waveform.
2. Click in the Label entry box, and then use the pop-up keyboard to create a label for the selected
waveform.
3. Click in the X Position and Y Position entry boxes to activate them.
4. Use the multipurpose knobs to position the label on the graticule. You can also position the label
anywhere on the screen by clicking and dragging it to the desired location.

Behavior
The label applies only to the selected waveform. Each waveform (channel, math, or reference) can have its
own label. If you do not enter a label for the selected waveform, the label will be left blank. A label only
appears when its associated waveform is turned on.
The X Pos control values are relative to the left side of the display. The YPos control values are relative to
the waveform handle. The values are expressed in divisions.
What do you want to do next?
Learn more about the Vertical controls. (see page 491)
Learn more about the Math controls. (see page 247)
Learn more about the Reference Waveform controls. (see page 527)

Vertical Offset Control Window
From the Vertical menu, select Offset.
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Vertical Offset Control Window

Overview
Use the Position/Offset control window to set the offset value of the selected waveform to shift the vertical
acquisition window (see page 62) to match the waveform data you want to acquire.

To use
1. Use the Channels Selector (see page 264) to select a valid channel, math, or reference waveform.
2. Click a Channel button to select the vertical input channel.
3. Click in the Offset entry box, and use a multipurpose knob to set the offset value.

Behavior
The main purpose of the Offset control is to avoid clipping the waveform (see page 493). The Offset
control adjusts the DC bias level that is subtracted from the input signal of a channel and establishes the
level at the vertical center of the acquisition window for that channel. Channel reference indicators always
point to the offset level of the channels. Offset affects only channel waveforms, whereas the Position
control affects all waveforms, including math and reference waveforms.
NOTE. The range of vertical offset available depends on the type of probe used.
What do you want to do next?
Learn more about the Vertical controls. (see page 490)
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Using Offset to Avoid Clipping Signals
Clipping
The circled portion of the incoming waveform is clipped,
and therefore, is not acquired.
The clipped portion cannot be processed or displayed.
Offset can move the acquisition window vertically relative
to the incoming waveform.

Offset removes clipping
By setting an offset to vertically shift the acquisition
positive relative to the waveform, the clipped portion can
be acquired.

xxx

Termination Controls
From the Vertical menu, select Termination.

Overview
Use the Termination control window to select the channel input resistance.

For MSO/DPO70000C/DX model oscilloscopes, Termination is fixed at 50 Ω.
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The following screen appears on MSO/DPO5000B Series instruments:

To use
Click a Channels button to select the vertical input channel.
Click one of the Termination buttons to set the termination for your probe; termination can also be set
during probe compensation.
NOTE. If you are using a probe with a TekProbe/TekVPI interface (see page 495), the termination is
set automatically.

Behavior
The correct termination is set automatically when you attach a probe with a TekProbe interface to the
instrument.
You may need to set the termination manually if you use a probe without the TekProbe Interface. In general:
Select 1 MΩ to use high impedance passive probes (see page 495).
Select 50 Ω to use most active probes (see page 495) and low impedance (Zo) probes (see page 961).
NOTE. On instruments with GND coupling, the 50 Ω termination becomes an open circuit if you set the
channel input coupling to GND.
Consider the following when using 50 Ω termination with any channel:
The instrument does not accurately display frequencies under 200 kHz with AC coupling, if set
to 50 Ω termination.
The instrument reduces the maximum vertical scale setting for the channel to 1 V from 10 V (to
10 V from 100 V with a 10X probe attached), since the amplitudes appropriate for the higher settings
would overload the 50 Ω input.
The instrument switches to 50 Ω and disables AC coupling (and switches coupling to DC if AC is
selected) if you connect an active probe. The active probes also reduce the maximum vertical scale
setting as described above. This behavior results in 50 Ω, non-AC coupling, which is appropriate
for active probes.
What do you want to do next?
Learn more about the Vertical controls. (see page 496)
Learn more about the Bandwidth controls. (see page 498)
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TekProbe/TekVPI Interface
This interface enables the instrument to sense information about the probe such as the serial number
and other unique identification information. It also allows the instrument to provide power directly to
the probe.
With this information, the instrument can automatically set up its requirements to match the
characteristics of the probe, such as termination and attenuation.

High Impedance Probes
Most general-purpose probes have high input impedance.
The high input resistance of passive probes (typically 10 MΩ) provides negligible DC loading and
provides accurate DC amplitude measurements.
Most passive probes require the instrument input impedance to be 1 MΩ. However, their 8 pF to
12 pF (over 60 pF for 1X) capacitive loading can distort timing and phase measurements.
Use high resistance passive probes for measurements involving the following:
Device characterization (above 15 V, thermal drift applications)
Maximum amplitude sensitivity using 1X probe
Large voltage range (between 15 V and 500 V)
Qualitative or go/no-go measurements

Active Probes
Active voltage probes often contain preamplifiers that provide high resistance and low capacitance at
the probe tip. Some active voltage probes contain differential amplifiers that provide high Common
Mode Rejection Ratio (CMRR).
Active current probes often contain Hall-effect sensors that extend the probe bandwidth down to DC.
Many active probes, especially high frequency probes, can drive a 50 Ω instrument input.
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Coupling Controls
From the Vertical menu, select Coupling.

Overview
Use the Termination control window to select the input coupling.

For MSO/DPO70000C/DX model oscilloscopes, DC coupling is the only selection.

The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Click a Channels button to select the vertical input channel.
2. Click one of the Coupling buttons to couple the signal from the probe to the instrument.

Behavior
Select DC coupling to display a waveform with AC and DC components.
Select AC coupling to display a waveform with its DC component removed.
Select GND to display a zero-volt waveform. Use this selection to establish the ground reference
point on the display.
What do you want to do next?
Learn more about the Vertical controls. (see page 893)
Learn more about the Bandwidth controls. (see page 498)
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Deskew/Attenuation Control Window
From the Vertical menu, select Deskew or Attenuation.

Overview
Use the Deskew/Attenuation control window to compensate for propagation delays of different length
probes and to set the input/output ratio of any external attenuation or gain between the signal and input
channels.

To use
Use the Deskew/Attenuation controls to change the settings after you set up the Vertical Setup Control
Window (see page 485).
Deskew.
1. Connect the probes to a signal source.
2. Use the horizontal and vertical controls to center the fastest signal on the screen.
3. Click a Ch <1–4> button to select the slower channel.
4. Click in the Deskew Time entry box, and use a multipurpose knob to adjust the deskew time so
the two signals align.
5. To clear the deskew value, click the Set To 0.0s button.
Each input channel has its own deskew settings. Deskew compensates individual channels for probes or
cables of different lengths. The instrument applies the delay values after each completed acquisition. The
deskew values are saved as part of the instrument setup. The deskew values for the selected channel will
be retained until you change the probe, you restore a saved setup, or you recall the factory setup.
Attenuation.
1. Click a Ch <1–4> button to select the vertical input channel for the attached probe.
2. To set the external attenuation as a multiplier or ratio, click in the External Atten entry box and use a
multipurpose knob to enter a value.
3. To set the external attenuation as dB values, click in the External Atten (dB) entry box and use a
multipurpose knob to enter a value.
4. To set the external attenuation to the default value, click Set to Unity.
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Bandwidth Control Window

Each input channel has its own external attenuation settings. The attenuation control is automatically set
to the correct value when you attach a probe with a TekProbe/TekVPI interface to the instrument. You
can change the external attenuation by entering a multiplier or ratio with one control, or by entering a dB
value with the other control.

Bandwidth Control Window
From the Vertical menu, select Bandwidth Limit.

Overview
Use the Bandwidth control window to filter unwanted high-frequency noise from the waveform and to
decrease the noise bandwidth.

To use
1. Click a Channels button to select the vertical input channel.
2. Use the drop-down list box to select the range of frequencies to acquire.

Behavior
Bandwidth refers to the range of frequencies that the instrument can acquire and display accurately with
less than 3 dB attenuation.
Each input channel has its own bandwidth selection. Bandwidth selections with (HW) indicate a
hardware/analog-only filter. See the Vertical Setup Control Window (see page 485) for more information
on controls that affect the bandwidth selections. (see page 498)
To take accurate measurements, the input frequency should be much less than the rated bandwidth of the
instrument. A good rule to follow is to ensure the bandwidth of the instrument system is three to five times
the bandwidth of the signal that you want to measure.
What do you want to do next?
Learn more about the Vertical controls. (see page 502)

Enhanced Bandwidth
From the Vertical menu, select Bandwidth Enhanced.
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Overview
The Bandwidth Enhancement controls (similar to those shown below) allow you to use DSP processing
to achieve more accurate rise time measurements, to extend the bandwidth, and to flatten the passband
at the full sample rate.
Enhanced Bandwidth also provides a matched response across enabled channels for channel-to-channel
comparisons and differential measurements. The available bandwidth enhancement selections will vary
depending on the instrument you purchased. Enhanced bandwidth is extended to the probe tip for some
high performance probes and tips.

To use
To enable Bandwidth Enhancement for a vertical input channel:
1. Select a Channel tab in the Vertical Setup window.
2. Click Digital Filters (DSP) Enabled to activate the Bandwidth Enhancement filters.
3. Click Apply to All Channels to On to apply Bandwidth Enhancement to all channels simultaneously.
4. Click Analog Only to disable Bandwidth Enhancement and return to Analog operation. The Bandwidth
drop-down list adds (HW) to the selection indicating a hardware/analog-only filter.

The following screen appears on MSO/DPO5000B Series instruments:
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NOTE. For ≥3.5 GHz instrument models, the DSP filter on each channel provides magnitude and
phase compensation of the analog bandwidth to provide more accurate signal fidelity for high-speed
measurements. Digital Filtering (DSP) Enabled provides low-pass bandwidth filtering only to reduce
noise. Refer to your oscilloscope Specifications for a list of bandwidth enhancements available for each
vertical scale setting on your instrument.
The bandwidth enhance filter does not operate in FastAcq mode.

Behavior
Enhanced bandwidth, when enabled, applies independent DSP filtering to four channels.
The following settings are available:
Digital Filters (DSP) Enabled. Enables the selected channel to automatically use the Digital Signal
Process (DSP) filter. The BW indicator (see page 500) appears in the readouts when Enhanced
Bandwidth is active. The BW indictor will appear in reverse video (see page 500) if the user requested
bandwidth cannot be achieved.
Force Constant Sample Rate. The instrument takes the constant sample rate that you set in the
Horizontal control window, and applies a sample rate supported by DSP. It then enables DSP and
selects the appropriate bandwidth.
Analog Only. Disables the DSP filter for the selected input channel.
Apply to All Channels. Applies the DSP settings of the active channel to all channels simultaneously.
TIP. To enable or disable DSP filtering for all channels at once, click the Apply to All Channels button
after turning the Enhanced Bandwidth feature on or off.
NOTE. You may want to turn the DSP filter off to take advantage of the full analog bandwidth for analyzing
and debugging multiple-lane serial devices. DSP Enabled is the Default setting.
What do you want to do next?
Learn more about bandwidth enhancement. (see page 683)

Enhanced Bandwidth Indicator

Reverse Video Bandwidth Indicator
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Vertical Setup Control Window: Aux Tab
From the Vertical menu, select Vertical Setup; then open the Aux tab.

Overview
The Vertical Setup Aux Tab, similar to the window shown below, reports the status of the Auxiliary trigger
input. This input is located on the instrument front panel (see page 57).

The following screen appears on MSO/DPO5000B Series instruments:

NOTE. Some instruments include a Bandwidth control. For these instruments, you can set the Auxiliary
Input bandwidth in the drop-down list box.

To use
To access the controls for this window, connect a compatible probe.
What do you want to do next?
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Probe Setup Control Window

Continue to learn about the Vertical Setup controls. (see page 954)

Probe Setup Control Window
From the Vertical menu, select Probe Cal.

Overview
Use the Probe Setup control window to compensate and check probe status and to compensate the entire
signal path. This will improve the probe gain and offset accuracy. Probe compensation is one of several
features you can use to optimize measurement accuracy.
NOTE. The example windows below do not show the controls for the attached probes.
Click for DPO7000C and MSO/DPO5000B instruments:

Click for MSO/DPO70000C/DX instruments:

xxx

For information on the Probe Setup controls, click the buttons.

NOTE. The Probe Status control indicates the status of probe compensation for the selected channel. If the
probe status does not indicate Pass, the instrument may not take accurate measurements. You may want to
perform the probe compensation procedure before taking any measurements with the selected probe.
In addition to the probe setup above, it is recommended that you do the following to assure measurement
quality:
Use the correct probe tip for your probe. This will ensure that the correct bandwidth filter is applied
and performance is extended to the probe tip.
Use the Probe Compensation (see page 577) procedure to compensate passive probes. This will ensure
maximum distortion-free inputs to the instrument and avoid high frequency amplitude errors.
Use the Signal Path Compensation (see page 516) procedure to compensate the internal signal path
used to acquire waveforms based on the ambient temperature.
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Probe Setup Control Window

Tips for Reducing Measurement Noise
Use the least amount of attenuation. Probe noise is a function of probe attenuation, for example, using
a 25X probe, versus a 5X probe, results in significantly greater noise.
Select the lowest attenuation that displays the input voltage swing of your signal; then use the vertical
scale setting to adjust the waveform display on screen, as needed.
Use a lower bandwidth probe to reduce noise.
Reduce the vertical bandwidth of your oscilloscope. In general, a bandwidth 3 to 5 times the
fundamental frequency of the waveform is a good compromise, allowing capture of harmonic content
while minimizing noise.
What do you want to do next?
Learn more about the Probe Status indicator. (see page 515)
Learn more about the Probe Compensation controls. (see page 506)
Go to a step-by-step procedure to calibrate active probes. (see page 575)
Go to a step-by-step procedure to calibrate passive probes. (see page 576)
Learn more about the Vertical controls. (see page 510)

Probe Compensation Adjustment
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Probe Setup Control Window: Setup Type

Signal Path Compensation Status
The following table lists the possible status messages for signal path compensation and the
recommended action.
Status

Meaning and recommended action

Compensated

The instrument had warmed up, there were no failures
during the signal path compensation procedure, and
the current operating temperature is within 5 °C of the
operating temperature when the previous signal path
compensation was run.

Fail

One or more failures occurred during the signal path
compensation procedure. Contact your local Tektronix
service representative for further action.

Temp

The operating temperature is not within 5 °C of the
previous signal path compensation.

Warming up

The instrument has not warmed up. Wait for the
instrument to complete its warm up period before running
the signal path compensation procedure.

xxx

Probe Setup Control Window: Setup Type
From the Vertical menu, select Probe Controls, and then click the Setup button.
NOTE. You must attach an appropriate probe to the logic probe port or to the Ch1-Ch4 vertical input
to activate this setup window.

Overview
Use the Probe Setup control window to configure a probe that you connect to the vertical input.
Click for DPO7000C and MSO/DPO5000B instruments:

Click for MSO/DPO70000C/DX and DPO7000C
instruments:

xxx

For information on the Probe Setup controls, click the button.
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Probe Setup Control Window: D15-D0 Tab

To use
1. Connect a probe to a vertical input.
2. Press a front panel Ch <1–4> button to activate the channel.
3. In the Probe Setup window, click a Chan <1–4> tab to activate the controls for the input source.
4. Configure the controls for the probe type you attached.
What do you want to do next?
Learn more about the Vertical controls. (see page 511)

Probe Setup Control Window: D15-D0 Tab
NOTE. The Probe Setup Control Window: D15-D0 Tab is available only on MSO5000B and
MSO70000C/DX Series instruments and on DPO5000B Series instruments with option MSOE installed,
and DPO70000DX instruments with option MSOU installed.
From the Vertical menu, select Probe Controls, click the Setup button, and then open the D15-D0 tab.
NOTE. You must attach a logic probe to the logic probe port on the front panel to activate this setup window.

Overview
Use the Probe Setup control window to align the instrument trigger path to optimize measurement
accuracy. The logic probe input for channels D15-D0 is located on the instrument front panel (see page 57).
The instrument requires the Logic Probe Deskew Fixture (Tektronix part number 067-2083-XX) to deskew
the logic probe trigger path.

To use
For information on the controls, click the buttons.
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Probe Setup Control Window: Probe Compensation

1. Connect a logic probe to the logic probe port on the front panel.
2. From the Digital menu, select Digital Setup.
3. Click the D7-D0 or the D15-D8 tab, and then the desired digital channel buttons to activate the
controls for the logic source.
4. From the Vertical menu, select Probe Controls, and then click the Setup button.
5. Click the Properties button to display information on the logic probe and the status of the trigger
path alignment.
What do you want to do next?
Learn about setting up the digital channels. (see page 90)
Learn about digital setups. (see page 89)
Learn about setting up a bus. (see page 97)

Probe Setup Control Window: Probe Compensation
From the Vertical menu, select Probe Cal.

Overview
Use the Probe Setup control window to compensate a probe; this will improve the gain and offset accuracy.
Probe compensation is specific to the channel to which it is connected.
NOTE. To compensate/calibrate a P7520A or P7600 series probe, use the procedure in the probe manual.
Use the manual that came with your probe, the manual in the documentation browser that is accessible
from the instrument desktop, or download the manual from the Tektronix Web site.
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Click for DPO7000C and MSO/DPO5000B instruments:

Probe Setup Control Window: Probe Compensation
Click for MSO/DPO70000C/DX instruments:

xxx

To use
1. Connect a probe to a vertical input.
2. Press a front panel Ch <1–4> button to activate the channel.
3. In the Probe Setup window, click a Chan <1–4> tab to activate the controls for the input source.
4. Select the probe Type for the appropriate signal and ground connections of the probe compensation
terminals.
For some probes, click the Probe Tip Select button (see page 509) and select the tip that matches
the one you are using.
5. Click Restore Factory Default to clear the old values.
6. Click Compensate Probe to begin the procedure.

Behavior
When you perform a probe compensation on the selected channel, you optimize the instrument to
make accurate measurements for that channel and probe. The probe compensation makes significant
performance improvements when performed with active probes or older passive probes.
You can perform a probe compensation at any time to ensure measurements are taken with the highest
possible accuracy. Perform a probe compensation if you have changed probes since the last time a probe
compensation was performed.
TIP. If you are compensating a passive probe, you must first compensate the low-frequency response of the
probe. Refer to the Probe Compensation Procedure for more information.
Some types of probes can be gain compensated, some can be offset compensated, and some can be
compensated for both. If the probe has a TekProbe/TekVPI interface (see page 495), the instrument
can determine the type of compensation needed and will display the appropriate instructions when you
perform the probe compensation procedure. Some probes cannot be compensated; for information on these
probes, refer to probe compensation restrictions.
Some probes cannot be compensated. This might be because the probes have an attenuation factor greater
than 20X. You will get an error message if you try to compensate such a probe.
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Probe Setup Control Window: Probe Compensation

The instrument cannot compensate for probes that may have gain and/or offset errors that are too great
(>2% or >50 mV offset). If these errors are within the specified limits of your probe, you may want to use
another probe. If the errors are outside the limits, have your probe checked by service personnel.
Probe compensation is not recommended for the P5050 passive probe. This probe typically has little gain
and offset error, and therefore, the performance improvement after a probe compensation is not worth
the time needed to do the probe compensation.
What do you want to do next?
Go to a step-by-step procedure to compensate active probes. (see page 575)
Go to a step-by-step procedure to compensate passive probes. (see page 576)
Learn more about the Vertical controls. (see page 510)
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Probe Setup Control Window: Probe Tip Selection

Probe Setup Control Window: Probe Tip Selection
From the Vertical menu, select Probe Cal, and then click the Probe Tip Select button.
NOTE. Some probes have more than one type of probe tip available. The type of probe tips in the selection
window change according to the probe connected to the instrument. Refer to the probe instructions
manual for more information on the tips available for your probe.

To use
1. Select the type of probe tip to match the one you are using.
2. Click OK.
Here is an example of Probe Tip for Tektronix P73XX probe.
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Probe Setup Control Window: Probe Deskew

Here is an example of Probe Tip for Tektronix Trimode probe.

Probe Setup Control Window: Probe Deskew
From the Vertical menu, select Deskew.

Overview
Use the Probe Setup control window to compensate for propagation delays of different length probes
connected to the vertical input channels.
Click for DPO7000C and MSO/DPO5000B instruments:

Click for MSO/DPO70000C/DX instruments:

xxx

NOTE. To compensate for timing differences between voltage and current probes, order the following
Probe Calibration and Deskew Fixtures:
Tektronix part number 067-0405-XX (for DPO7000C and MSO/DPO5000B oscilloscopes).
Tektronix part number 067-1586-XX (for MSO/DPO70000C/DX oscilloscopes).
Tektronix part number 067-2083-XX (for MSO Series instruments) to deskew the logic probe trigger path.
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Probe Setup Control Window: Probe Attenuation

The fixtures may require a user-supplied pulse generator.

To use
1. Connect the probes to a signal source.
2. Use the horizontal and vertical controls to center the fastest signal on the screen.
3. Click a Chan <1–4> tab to select the slower channel.
4. Click in the Deskew Time entry box, and use a multipurpose knob to adjust the deskew time so that
the two signals align.
5. To clear the deskew value, click the Set To 0.0 s button.

Behavior
Each input channel has its own deskew settings. Deskew compensates individual channels for probes or
cables of different lengths. The instrument applies the delay values after each completed acquisition. The
deskew values, which have a range of ±75 ns, do not affect triggering. Deskew is available for Sample
and Average acquisition modes only.
The deskew values are saved as part of the instrument setup. The deskew values for the selected channel
will be retained until you change the probe, you restore a saved setup, or you recall the factory setup.
What do you want to do next?
Go to a step-by-step procedure to deskew the probes. (see page 578)
Learn more about the Vertical controls. (see page 511)

Probe Setup Control Window: Probe Attenuation
From the Vertical menu, select Attenuation.

Overview
Use the Probe Setup control window to describe the input/output ratio of any external attenuation or gain
between the signal and input channels.
Click for DPO7000C and MSO/DPO5000B instruments:

Click for MSO/DPO70000C/DX instruments:

xxx
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Probe Controls Window

To use
1. Click a Chan <1–4> tab to select the vertical input channel for the attached probe.
2. To set the external attenuation as a multiplier or ratio, click in the External Atten entry box and use a
multipurpose knob to enter a value.
3. To set the external attenuation as dB values, click in the External Atten (dB) entry box and use a
multipurpose knob to enter a value.
4. To set the external attenuation to the default value, click Set to Unity.

Behavior
Each input channel has its own external attenuation settings. The attenuation control is automatically set
to the correct value when you attach a probe with a TekProbe/TekVPI interface (see page 495) to the
instrument. You can change the external attenuation by entering a multiplier or ratio in the top control,
or by entering a dB value in the lower control.
When you return the attenuation to the default value, the multiplier returns to 1, and the dB value returns to
zero.
What do you want to do next?
Return to the Vertical Setup control window overview. (see page 485)

Probe Controls Window
From the Vertical menu, select Probe Controls.

Overview
Use the controls in these windows to operate a probe while taking measurements.
The type of probe you connect determines the available controls. For example, the window below contains
controls for a Tektronix current probe.

The following window contains controls for Tektronix TAP1500/TAP2500 type probes.

This window contains controls for Tektronix TriMode probes.
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Probe Properties

This window contains controls for Tektronix logic probes.

This window contains controls for Tektronix generic probes.

Probe Properties
From the Vertical menu, select Probe Controls, click the Setup button, and then click the Properties button.

To use
The Probe Properties dialog displays information on the probe attached to the analog or to the digital
channels. To view the probe information, select the channel of interest from the drop-down list of
channels under Probe.
The dialog includes the following information for analog probes:
Type of probe connected to the selected channel
Serial number of the attached probe (for probes with serial numbers)
Status information, such as the time you connected the probe, the probe type, the serial number, and
compensation results
NOTE. When the probe is compensated, the instrument polls the probe and displays the serial number. An
N/A indicates that the probe has not been compensated.
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Probe Properties

The Probe Properties dialog includes the following information for logic probes:
Type of logic probe connected
Serial number of the logic probe
Analog channel selected as the Reference Channel
Type of probe connected to the Reference Channel
Status of the Analog to Digital Trigger Path Alignment routine
NOTE. The instrument requires the Logic Probe Deskew Fixture (Tektronix part number 067-2083-XX) to
run the Analog to Digital Trigger Path Alignment routine.

The instrument displays the following information in the Analog to Digital Trigger Path Alignment field:
N/A means that the trigger path alignment routine has not been run
Numeric value for the amount of time the instrument needs to skew the channel to align the logic
trigger path to the reference channel
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Probe Setup Control Window: Probe Status

(+) indicates that the analog trigger path occurs before the logic path
(-) indicates that the logic trigger path occurs before the analog path

Probe Setup Control Window: Probe Status
From the Vertical menu, select Probe Cal.

To use
The Probe Status readout provides information on the status of the probe connected to the vertical input
channel.

Behavior
The instrument automatically detects the type of probe that you have installed and displays the probe
status information.
Default. The instrument has no compensation data on file for this probe, on this channel, and is
applying factory-nominal corrections for probe operation only. This message may appear if you
connect a probe and have not performed the probe compensation. Perform a probe compensation before
you using this probe. This message also appears when you disconnect a probe from the vertical input.
Compensated. Compensation data for the probe connected to this channel is available from the most
recent probe compensation or the compensation data has been retrieved form nonvolatile memory.
Fail. The instrument was unable to complete the probe compensation procedure; the probe may be
faulty. Have the probe checked by Tektronix service personnel.
NOTE. The instrument must pass a signal path compensation (see page 516) procedure before it will
perform a probe compensation procedure.
What do you want to do next?
Learn more about the Probe Compensation controls. (see page 506)
Go to a step-by-step procedure to compensate active probes. (see page 575)
Go to a step-by-step procedure to compensate passive probes. (see page 576)
Learn more about the Vertical controls. (see page 510)
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Probe Setup Control Window: Probe Status

Signal Path Compensation
Use the following procedure to compensate the internal signal acquisition. Perform this procedure
if the ambient temperature has changed more than 5 °C (9 °F) since you performed the last signal
path compensation.
1. Power on the instrument, and allow the instrument to complete its warm up period before
continuing with this procedure.
2. Disconnect any probes that you have connected to the input channels.
3. Set the instrument to Menu mode.
4. Select Instrument Calibration from the Utilities menu.
5. Note any instructions that appear under Instructions in the resulting control window.
6. Click Run SPC to begin the procedure. The procedure may take several minutes to complete.
7. Verify that the Status changes to Compensated after the procedure is complete. If the SPC Status
field indicates anything other than Compensated, see Signal Path Compensation Status (see
page 504) for information on the readout and recommended action.
NOTE. When making measurements at vertical scale settings less than or equal to 5 mV, you should
perform the signal path compensation at least once a week. Failure to do so may result in the
instrument not meeting warranted performance levels at those volts/div settings.
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Copy Setup: Images

Copy Setup: Images
From the Edit menu, select Copy Setup; then open the Images tab.

Overview
Use this control window to copy images to the clipboard for use with other applications.
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Copy Setup: Waveforms

To use
1. Select the Palette for the image:
Color
Color (Ink Saver Mode)
Black & White
2. Select the type of View:
Full Screen. Copies an image of the entire screen.
Graticule(s) Only. Copies an image of the selected graticule.
3. Click the Hide Menu/Toolbar check box to save the image without including the Menu bar or Toolbar.
4. Click OK.

Behavior
The Palette, View, and Image selections are identical to those in the Page Setup dialog box and in the
Screen Capture Save Options dialog box.
The copy operation takes place after you click Copy. Clicking OK saves the changes and closes the
dialog box but does not copy the image.
NOTE. Bitmap (.bmp) is the only available Data Format.
What do you want to do next?
Learn about copying waveforms. (see page 518)
Learn about copying measurements. (see page 520)
Learn about saving images to a file. (see page 538)

Copy Setup: Waveforms
From the Edit menu, select Copy Setup; then open the Waveforms tab.

Overview
Use this control window to copy waveforms to the clipboard for use with other applications.

518

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Copying and Printing

Copy Setup: Waveforms

To use
The Data Destination (data format) is Spreadsheet only.
Select a valid waveform from the Source list.
Select the number of samples you want to copy. Select All samples, a range of samples, or only
the samples between the cursors. If you select Save Samples between Cursors, you can use the
multipurpose knobs to adjust the positions if the cursors are already active. If they are not, the cursors
will be turned on at the positions they were in the last time they were used.
Select the Include waveform scale factors check box if you want to include waveform details, such as
header information (record length, sample interval, trigger point information, and so on). If you only
want to include the waveform voltage values, clear the selection.
Specify the FastFrame Data Range if you are copying FastFrame data.
If you are copying Fast Acquisition data, select the data ordering from the list.
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Copy Setup: Measurements

Behavior
The Waveform curve data range can be anywhere from one sample to the record length of the selected
waveform.
The copy operation takes place after you click Copy.
If you select Data between cursors, another set of cursors may temporarily appear on your screen
while the copy is in progress.
What do you want to do next?
Learn about copying images. (see page 517)
Learn about copying measurements. (see page 520)
Learn about saving waveforms to a file. (see page 884)

Copy Setup: Measurements
From the Edit menu, select Copy Setup; then open the Measurements tab.

Overview
Use this control window to copy measurements to the clipboard for use with other applications.
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Copy Setup: Measurements

To use
1. Click the type of Measurements you want to copy.
2. For Displayed Measurements, select the Data Format.
3. Click OK.

Behavior
When you select Displayed Measurements, all displayed measurements will be copied to the clipboard.
NOTE. For Histogram Data, the data format is always CSV.
The copy operation takes place after you click Copy. Clicking the OK button accepts the changes and
closes the dialog box but does not copy the measurements.
What do you want to do next?
Learn about copying images. (see page 517)
Learn about copying waveforms. (see page 518)
Learn about saving measurements to a file. (see page 536)
Learn more about CSV text format. (see page 887)
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Copying the Screen for Use in Other Applications

Copying the Screen for Use in Other Applications
Use the following steps to copy the contents of the screen for use in other applications, such as WordPad,
Microsoft Word, or Paint.
1. From the Edit menu, click Copy Setup.
2. Open the Images tab.
3. Select the Palette, View, and Image as needed for your application.
4. Click Copy to paste the image to the clipboard. You can now paste the bitmap image into other
applications.
5. If you want to copy another image to the clipboard, click Copy on the Edit menu or press Ctrl+C on
the attached keyboard.
NOTE. If you try saving a copy of the screen to the clipboard by pressing the PrtScn button on the attached
keyboard, the bitmap image will not contain any waveforms. Use the procedure above to save a copy of the
entire screen (or the graticule) to the clipboard.
TIP. If your setup information does not change, you do not need to open the Copy Setup dialog box each
time you want to copy a screen. Use the Edit menu Select for Copy option if you need to change the type of
items, for example, to copy waveforms instead of images.

Copying Measurements for Use in Other Applications
Use the following steps to copy the measurements for use in other applications such as WordPad or
Microsoft Word.
1. From the Edit menu click Copy Setup.
2. Open the Measurements tab.
3. Select either Displayed Measurements (make sure that measurements are displayed in the graticule via
the Measurement Control window) or Histogram Data.
4. If you clicked the Displayed Measurements option, select the Data Format, either Numeric or Text.
5. Click Copy to paste the measurements to the clipboard. You can now paste the measurements into
your other applications.
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Page Setup Dialog Box

Page Setup Dialog Box
From the File menu, select Page Setup.

Overview
Use the Page Setup dialog box to define the page before sending it to a printer.

To use
The controls in this window are similar to the Page Setup dialog boxes used in most Windows applications
(see example below).

The Paper settings are dependent on the type of printer connected to the instrument. A reduced preview
image appears at the top of the window. To view a larger image, click Print Preview at the bottom of
the window.
Click the Print button when you have selected all of your desired settings.
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Print Preview Dialog Box

Behavior
The Type of printing should be Screen-copy for all screen shots.

Print Preview Dialog Box
From the File menu, select Print Preview.

Overview
Use the Print Preview dialog box to preview an image before sending the data to a printer.

To use
Use the Magnify control at the top of the window to zoom in and out to view the details of the image.
To return to the Page Setup dialog box, click the down arrow.
Click the Printer button to open the Print dialog box.

Print Dialog Box
From the File menu, select Print.

Overview
Use the Print dialog box to send data to a printer.

To use
The controls in this window are similar to the Print dialog boxes used in most Windows applications. The
settings are dependent on the type of printer connected to the instrument.

Printing the Screen to a Printer
The easiest way to print the contents of the screen is to press the front panel Print button (see page 525).
The instrument will print the screen contents according to the settings in the Page Setup dialog.
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Printing the Screen to a Printer

1. Use the File menu Page Setup dialog to select the Type of printing, Palette, View, and Image before
printing. The Type should be Screen-copy, the default.
2. Use the Print Preview feature to test the appearance of the screen before printing. For example, you
may want to experiment with the different palettes before sending the data to the printer.
3. Click Print in either the Print Preview dialog box or in the Page Setup dialog box to open the Print
dialog box.
4. Click OK to begin printing.

General Purpose Controls
Use the following front-panel controls to perform general-purpose tasks such as Autoset the
instrument, send items to the printer, or enable cursors.
Push the Autoset button to automatically set up the instrument to obtain and display a
stable waveform of usable size. For information on the Autoset default settings click
Autoset (see page 189).
Push the Default Setup button to reset the instrument to the factory default settings.

Push the Print button to make a hard copy of the screen. The printed image is sent
directly to the selected (internal or attached) printer. To change the print settings, click the
File menu Print command, and change the settings in the Print dialog box.
Push the Cursors button to enable cursors on the screen. The Cursor Type control
window (see page 75) opens so that you can specify the cursor parameters.

NOTE. If cursors are on but the readouts are not attached to the cursor controls, press
the Cursors button to attach the readouts to the cursor controls. Press the Cursors button
again to turn the cursors off.
Push the Search and Mark buttons to find and place a mark on a waveform at a point
of interest, or to edit marks. You can return to a mark and analyze the waveform at a
later time.

Push the FastAcq DPX button to turn Fast Acquisition On or Off. The FastAcq button is
lighted when Fast Acquisition is turned on.
Use the Intensity knob to adjust the brightness of the waveform. High intensity settings
show less frequently acquired points more clearly.
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Printing the Screen to a Printer
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Reference Waveform Controls

Reference Waveform Controls
From the File menu, select Reference Waveform Controls.

Overview
Use the Reference control window to display and control reference waveforms. Reference waveforms are
shown with the horizontal settings in effect at the time they are saved.
NOTE. Reference waveforms are only available for analog channels.

To use
1. Select the Ref <1–4> waveform from the drop-down list.
2. Click the On button to display the waveform.
3. Click in the Vert Position or Scale entry boxes. and then use the multipurpose knobs to make
adjustments.
4. Click in the Label entry box, and then use the pop-up keypad to create a label for the waveform.
5. Click the Save button to access the Save As dialog box and save the waveform as a Reference
waveform or save it to a file.
6. Click the Recall button to access the Recall dialog box and recall a waveform from memory.

Behavior
Clicking Save or Recall buttons activates the respective dialog boxes. Typing a name in the Label text
box places the label on the graticule. You can move the label on the graticule by clicking and dragging it.
The label is saved with the Reference waveform.
TIP. To easily change the vertical position of a reference waveform, click the waveform handle on the left
side of the screen, and drag the waveform to the new position. To easily change the vertical scale of a
reference waveform, click the waveform handle, and then use the multipurpose knobs to change the
waveform scale. You can also use the multipurpose knobs to change the waveform position.
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File Menu

Recall Dialog Box: Waveform

What do you want to do next?
Learn how to create a reference waveform. (see page 632)
Learn about instrument setups. (see page 535)
Learn about saving reference waveforms to a file. (see page 541)
Learn about restoring waveforms from a file. (see page 528)
Learn about deleting waveform files. (see page 531)

Recall Dialog Box: Waveform
From the File menu, select Recall, or from the Reference Waveform controls (see page 527), click the
Recall button.

Overview
Use this dialog box to recall a saved waveform file to a reference location.

To use
Under Recall What, click Waveform.
From the Destination drop-down list, select the Ref <1– 4> location that you
want to recall the waveform to. The default folder for reference waveforms is
C:\Users\[Username]\Tektronix\TekScope\Waveforms.
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Use the pop-up keyboard to enter a File name, or click the file name to select it.

TIP. If you do not see the file that you want to recall, verify that the Files of type list shows the correct
file format. You may also need to check other folders if the file was stored in a location other than the
C:\Users\[Username]\Tektronix\TekScope\Waveforms folder.

Behavior
This dialog box opens when you click Recall from the File menu or when you click the Recall button from
the Reference waveform controls. Waveforms are stored in WFM file format, which is an internal format
of the instrument. When you click Recall, the Ref 1-4 waveform is displayed in the graticule.
NOTE. When you recall a reference waveform, a temporary file containing the waveform data is written to
C:\Users\[Username]\Tektronix\TekScope\Waveforms. The file is named TDS_REF n.WFM, where n is the
reference waveform number. This file is deleted when the reference waveform is deleted.
What do you want to do next?
Learn about saving a waveform to a file. (see page 541)
Learn about deleting waveform files. (see page 531)

Recall Dialog Box: Instrument Setups
From File menu, select Recall, or from the Reference Waveform controls (see page 527), click the Recall
button.

Overview
Use the Recall dialog box to recall an instrument setup.
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Recall Dialog Box: Instrument Setups

To use
Setups are recalled from an internal file on your hard drive or from a setup file that you have named.
Under Recall What, click Setup.
Click one of the icons under Look in: Oscilloscope Memory, and then click the Recall button to
restore the setup.
Click the Factory Defaults icon to recall the default factory setup for the instrument.
TIP. Select the File menu Recall Default Setup command to instantly restore the default setup.
To recall an instrument setup from a file, select the location of the setup from the Look in list. Select the
setup you want to recall, and then click Recall.

Behavior
The setups are restored from an internal file on your hard drive as soon as you click the Recall button. The
labels adjacent to the icons were created when the setups were first saved. Any of the setups with the label
"Factory" will restore the default factory setups.
The data in reference waveforms is not saved with the instrument setup. However, the setup information
does include which reference waveforms are turned on and which reference waveforms are used with math
waveforms and automatic measurements. If you want to save the reference waveform data (see page 541),
save the reference waveform separate from the instrument setup. You can then recall the saved waveform
to the setup from the Reference Waveform Controls (see page 527).
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Delete Setups and Reference Waveforms

NOTE. If a restored setup attempts to use an undefined reference waveform (or to use it in a math
waveform or with an automatic measurement), then an undefined reference waveform is created. This
reference waveform becomes a 500-point waveform filled with null data. Any math waveforms or any
measurements done on this waveform will contain invalid or unusable data. However, you can recall a
valid saved waveform to the new reference waveform so that the math waveforms and the automatic
measurements will become valid.
What do you want to do next?
Learn about saving instrument setups. (see page 535)
Learn about deleting instrument setups. (see page 531)

Delete Setups and Reference Waveforms
From the File menu highlight Delete; then select an entry in the submenu.

Overview
Use this dialog box to delete a saved reference waveform or setup file.

To use
Select the setup or reference waveform you want to delete.
To delete all Setups at the same time, select All Setups
To delete All Reference Waveforms at one time, select All Refs.

Behavior
Setups or waveforms stored in Windows directories can be deleted by clicking the
Recall dialog boxes.

in the Save or

NOTE. You can only delete setups and reference waveforms stored in oscilloscope memory using this
command.
What do you want to do next?
Learn about saving instrument setups. (see page 535)
Learn about restoring instrument setups. (see page 529)
Learn about saving a waveform to a file. (see page 541)
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Set up Action On Event
From the File menu, select Action On Event.

Overview
Use this control window to set up the action (save or e-mail) to perform when an event (trigger, limit
test failure, or mask test failure) occurs.

To use
1. From the On the event of drop down list, select the event that will cause the action.
2. Click the Save check box to save a file when the event occurs.
3. Click the Send E-mail check box to send an e-mail when the event occurs.
4. To change the setup of either action, click its Setup button.
What do you want to do next?
Learn about Email on Event setup (see page 555)
Learn about Save On Event Setup (see page 532)

Set up Save On Event
From the File menu select Action On Event, and then click Save Setup.
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Overview
Use this control window to set up the conditions under which the instrument will save a file, the types
of files to save, and the event limits.

To use
1. In the Save Location entry box, type in the location where you want to save the files.
2. In the Save on check boxes, select the events on which you want to save a file.
3. Use the Files to Save check boxes to select the type of files to save.
4. Click the Settings buttons to open a Save Options dialog box and set the parameters for the file.
5. In the File Name radio buttons, select whether to a Use Date and Timestamp or Custom Base Filename.
6. In the Event Limits box, enter the number of events that will save files, up to a maximum of 32,767.
7. Press the Reset button to reset the Current Count of files saved.

Behavior
When the maximum number of files is saved, file saving stops. To continue saving files, you must press
Reset or enter a larger limit. Clicking Reset changes the current count back to 0.
What do you want to do next?
Learn about Mask Testing. (see page 215)
Learn about Limit Testing. (see page 242)
Learn about Screen Capture Save Options (see page 538)
Learn about Waveform Save Options (see page 884)
Learn about Measurement Save Options (see page 558)
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Print Setups
For information on the Print Setups, click here (see page 523).

Save As Dialog Box: Histogram
From the File menu, highlight Save As; then select Histogram Data from the submenu.

Overview
Use this dialog box to save histograms to a file for use with other applications.

To use
To save histogram data with the default file name, click the Save button.
To enter a different file name, click the keyboard icon and use the pop-up keyboard.
Select Auto-increment file name (see page 391) if you want to save a series of files without typing in a
new name each time.
Select a file extension from the Save as type drop-down list. The file type will be automatically
appended to the file name.
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Save As Dialog Box: Instrument Setup

Behavior
Histogram data is saved in C:\Users\[Username]\Tektronix\TekScope\data unless you select a
different location. To access the Histogram Save As dialog box, you may need to select it from the
More submenu.
What do you want to do next?
Learn about saving waveforms. (see page 541)
Learn about saving screen captures. (see page 538)
Learn about saving measurements. (see page 536)

Save As Dialog Box: Instrument Setup
From the File menu, highlight Save As; then select Setup from the submenu.

Overview
Use the Save As dialog box to save instrument setups for later use.

To use
To save in Oscilloscope memory:
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1. Click on one of the setup location icons under Save in: Oscilloscope Memory.
2. Enter a Name for the setup by clicking on it once more and modifying the existing text.
3. Click the Save button.
To save the setup in a different location:
1. Select the location from the Save in drop-down list.
2. Enter a name in the Name text box.
3. Click the Save button.

Behavior
You can display up to ten saved instrument setups in this dialog box. Additional setups can be saved to the
hard drive. When you save a setup, the label adjacent to the setup icon changes from its previous value to
User. You can save setups to any location labeled Factory without overwriting a saved setup.
The data in reference waveforms is not saved with the instrument setup. However, the setup information
does include which reference waveforms are turned on and which reference waveforms are used with math
waveforms and automatic measurements. If you want to save the reference waveform data (see page 541),
save the reference waveform separate from the instrument setup.
The instrument preference settings are not saved with the setup. They are saved when the instrument is
powered off.
NOTE. Before saving an instrument setup, make sure the location does not contain a setup that you have
previously saved. The previously saved setup will be overwritten.
What do you want to do next?
Learn about recalling instrument setups. (see page 529)
Learn about deleting instrument setups. (see page 531)

Save As Dialog Box: Measurement
From the File menu, highlight Save As; then select Measurement from the submenu.

Overview
Use this dialog box to save a measurement to a file for use with other applications.
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To use
1. Under Save What, click Measurement.
2. Set the parameters for the measurement you want to save.
3. Click the Measurement Options button
4. In the Measurement Save Options dialog box, select a Measurement Format from the drop-down
list box.

5. After making the above selection, click OK to return to the Save As dialog box.
6. Use the default name or enter a unique in the Name text box.
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Save As Dialog Box: Screen Capture

7. Select the type of file (either .txt or .csv) to save from the Save as type list. By default, the file will be
saved to the C:\Users\[Username]\Tektronix\TekScope\Data folder.
8. Click the Save button to accept any changes and close the dialog box.

Behavior
When you select Displayed Measurements, all displayed measurements are saved.
What do you want to do next?
Learn about saving waveforms. (see page 541)
Learn about saving screen captures. (see page 538)
Learn more about CSV text format. (see page 887)

Save As Dialog Box: Screen Capture
From the File menu, highlight Save As; then select Screen Capture from the submenu.

Overview
Use this dialog box to save screen captures to a file for use with other applications.
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To use
1. Under Save What click Screen Capture; then click Options.

2. Select the Palette for the image: Color or Black & White.
3. Under View, select the image style:
To save an image of the entire screen, select Full Screen. Optionally, select to Hide Control
Window and Hide Menu/Toolbar.
To select an image of the selected graticule, select Graticule(s) only.
4. Select a resolution from the Resolution drop-down list.
5. Select a file type from the Screen Capture Format drop-down list.
6. Click OK.
7. In the Save As dialog box, assign your own file name, and then save the file to a specified folder. By
default, the image will be saved to C:\Users\[Username]\Tektronix\TekScope\ScreenCaptures.
8. Click Save to save the screen capture or cancel to close the dialog box without saving.

Behavior
The Palette, View, and Image selections are identical to those in the Page Setup dialog box.
The following file types are available:
.bmp
.jpg
.png
.tif
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What do you want to do next?
Learn about saving a waveform. (see page 541)

Save As Dialog Box: User Mask
From the File menu, highlight Save As; then select User Mask from the submenu.

Overview
Use this dialog box to save user masks. Masks are saved in C:\Users\[Username]\Tektronix\TekScope\Masks unless you choose another folder.

To use
To save the mask with the default file name, click the Save button.
To enter a different file name, click the keyboard icon and use the pop-up keyboard to enter a unique file
name. The extension specified in the Save as type list will automatically be appended to the file name.

Behavior
The Save As dialog box displays when you click Save in the Edit Mask control window. The mask is
saved in the format specified in the Save as type list.

540

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

File Menu

Save As Dialog Box: Waveform

What do you want to do next?
Learn about recalling saved masks. (see page 241)
Learn more about mask types. (see page 215)
Learn more about mask setups. (see page 215)

Save As Dialog Box: Waveform
From the File menu, highlight Save As; then select Waveform from the submenu. From the Reference
Waveform controls (see page 527), click the Save button.

Overview
Use this dialog box to save a waveform to a reference location or to a specified folder.

To use
To save to a reference location, select the Source, and then click the reference location in Oscilloscope
Memory.
To save to a file, enter a Name, use the default file name, or click Auto-increment file name (see
page 391) if you want to save a series of files without typing in a new name each time. The file
extension specified in the Save as type list will automatically be appended to the file name.
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Save As Dialog Box: Waveform

Behavior
This dialog box opens when you select Save As from the File menu or click Save from the Reference
Waveform controls. The default file type is a Tektronix waveform file (.wfm).
If you select a different file type from the Save as Type list, you can also define the options (see page 884)
for saving the waveform.
The default folder for reference waveforms is C:\Users\[Username]\Tektronix\TekScope\Waveforms.
The following file formats are available:
.wfm used for internal instrument formats
.csv used for spreadsheets, such as Microsoft Excel
.txt used for standard text file format
.dat used for Mathcad and MATLAB
NOTE. Any characters that you enter in the file name box become part of the file name. The instrument
does not use any user-defined file extensions.
What do you want to do next?
Learn about recalling a saved waveform. (see page 528)
Learn about deleting waveform files. (see page 531)
Learn more about CSV text format. (see page 887)
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Save As Dialog Box: Digitals
From the File menu, highlight Save As; then select Digitals from the submenu.

Overview
Use this dialog box to save the values of logic waveforms to a .csv file.

To use
1. Under Save What, click Digitals.
2. Name the file and set the Save as type parameters for the digital data you want to save.
3. Click the Save button to accept any changes and close the dialog box.

Behavior
Digital data is saved in C:\Users\[Username]\Tektronix\TekScope\data unless you select a
different location.
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Save As Dialog Box: Timestamp
From the File menu, highlight Save As; then select Timestamp Table from the submenu.

Overview
Use this dialog box to save a time stamp to a file.

To use
1. Under Save What, click Timestamp.
2. Click the Timestamp Options button to set the Source and FastFrame Data Range for the time stamp.
3. Name the file and set the Save as type parameters for the timestamp you want to save.
4. Click the Save button to accept any changes and close the dialog box.

Behavior
Timestamp data is saved in C:\Users\[Username]\Tektronix\TekScope\data unless you select a
different location.

544

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

File Menu

Save As Dialog Box: Timestamp

TIP. You can conveniently save time stamps from the FastFrame Control Window by using the Acquisition
> FastFrame > Analyze tab > Save button.
What do you want to do next?
Learn about saving waveforms. (see page 541)
Learn about saving screen captures. (see page 538)
Learn about saving measurements. (see page 536)
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Save As Dialog Box: Timestamp
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Tek Secure Erase
From the Utilities menu, select Tek Secure Erase.

Overview
Use TekSecure to erase all waveforms and instrument setups.

To use
Click OK to erase.
Click Cancel to exit the dialog box.

Behavior
Tek Secure Erase removes all reference waveform and instrument setup memory locations. Erased setups
are replaced with the default factory setups. This is useful if you are using the instrument to gather
sensitive or secure data.

Set Time and Date
From the Utilities menu, select Set Time & Date.
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GPIB Configuration Control Window

Overview
Use the Set Time and Date control window to set the time and date on the instrument.

To use
Click in the entry boxes to map them to the multipurpose knobs, and then use the knobs to set the
time and date.
Click the Set time and date now button to save your changes.
You can also click Get current time to set the time using the system clock. This is useful if the
instrument clock is out of sync.

Behavior
The controls in this window operate the same as the standard Windows Date/Time Properties dialog box.
After you click Set time and date now, the system date and time are set to the specified values. These
controls are provided as a convenience so you can change the date and time without having to go to the
Windows Control Panel > Date and Time properties dialog box.
TIP. The instrument clock is suspended when this window is open. Click Get current time to resynchronize
the clock with the PC clock.

GPIB Configuration Control Window
From the Utilities menu, select GPIB Configuration.

Overview
Use the GPIB Configuration control window to configure the instrument for GPIB (General Purpose
Interface Bus) applications.
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GPIB Configuration Control Window
GPIB applications enable you to remotely control your instrument, for example, taking measurements,
setting controls, or performing calculations.

The following screen appears on MSO/DPO5000B Series instruments:

To use
Click the Talk/Listen button to enable the GPIB.
Click in the Address entry box to map it to a multipurpose knob and use the knob to set the GPIB
address for the instrument.
Click the Controller button to use your instrument to control other instruments.
Click the Off Bus button to make the GPIB port unavailable.
NOTE. The Address controls are only available when you are in Talk/Listen mode.

Behavior
The instrument is defined as a GPIB talker/listener when you click Talk/Listen. This is the device-based
operation.
The instrument is defined as a controller when you click Controller. This is the controller-based
operation. You cannot use GPIB commands to control your instrument when it is in Controller mode.
When in Controller mode, clicking Off Bus has no effect. The Off Bus control only makes the GPIB
port unavailable if you are in Talk/Listen mode.
What do you want to do next?
Learn about External Signals control window. (see page 550)
Learn about LAN Server Status control window. (see page 550)
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LAN Server Status Control Window

LAN Server Status Control Window
From the Utilities menu, select LAN Server Status.

Overview
This control window allows you to enable the VXI-11 LAN server to accept GPIB commands.

For more information, see the Getting Started with OpenChoice Solutions manual that shipped with
your instrument.

To use
Click the Start button to enable the VXI LAN server to accept GPIB commands.
Click the Stop button to disable the ability of the VXI-11 LAN server to accept GPIB commands.
What do you want to do next?
Return to the Utilities Menu. (see page 936)
Learn about oscilloscope analysis and connectivity. (see page 21)
Learn about GPIB Configuration Control Window. (see page 548)

External Signals Control Window
From the Utilities menu, select External Signals, or click the Ext Ref button on the Acquisition tab of the
Horizontal/Acquisition control window (see page 185).

Overview
Use the External Signals control window to select the signal to send to the Aux Out BNC connector, or
to toggle the instrument clock reference source.
NOTE. The following illustrations show C model instruments. On MSO/DPO70000DX model instruments
the External Reference In maximum input voltage is 4 V and the impedance is 50 Ω.
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To use
To send a signal from the Aux Out BNC connector when the instrument triggers:
1. Click on the desired configuration button: A Trig, B Trig, Event, or Ref Out.
A Trig to send a signal when the A Trigger generates a trigger
B Trig to send a signal when the B Trigger generates a trigger
Event to send a signal out the connector when certain events occur, such as a mask test failure or
completion
Ref Out to send a copy of the internal reference clock out the connector
NOTE. Ref Out is not available on MSO/DPO70000C/DX Series instruments.
2. Click Pos or Neg to set the polarity.
To select the oscilloscope clock reference source:
1. Click the Internal or External source button.
To minimize jitter when using an external reference clock input (available on MSO/DPO70000C/DX
instruments only):
Select the Low (Stable) option when using a stable low-jitter clock source.
Select the High (Tracking) option when the oscilloscope needs to track the external clock to minimize
jitter.

Behavior
For Auxiliary Output, the selected signal is routed to the Aux Out BNC connector so that you can trigger
another instrument, such as a logic analyzer. The output voltage is TTL-compatible.
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Touch Screen
For External Reference Sources, the clock reference is routed to the Ext Ref BNC connector when you
select External.
NOTE. You must perform a signal path compensation whenever you change the reference.
When not using the external reference, disconnect signals from the EXT REF IN BNC connector.

Touch Screen
From the Utilities menu, highlight Touch Screen; then select Calibrate.

Overview
Use the Touch Screen submenu to calibrate the touch screen.

To use
1. Select Calibrate.
2. Follow the on-screen instructions.

Behavior
The Calibrate command starts the Touch Screen calibration program.

Instrument Calibration Control Window
From the Utilities menu, select Instrument Calibration.

Overview
Use the Instrument Calibration control window to run the Signal Path Compensation (SPC).
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Instrument Diagnostics Control Window

To use
Click “Always show SPC status icon (even when passing)” to always display the SPC icon in the status
readout. The icon resembles a thermometer.

NOTE. The SPC icon changes color to indicate when you need to run the SPC routine because the
temperature of the oscilloscope has changed by more than 5 °C since the last time the SPC routine was run.
Click “Display a warning when SPC has not been run in more than a month” so the oscilloscope displays a
message when the SPC routine is due to be run again.
1. Follow the set up instructions.
2. Click the Run SPC button to begin the procedure.

Behavior
The only user-accessible calibration is the signal path compensation (SPC). All other calibration is
accessible to qualified service personnel only. For all calibrations, the SPC Status control should indicate
Pass or Compensated. If it does not, contact your local Tektronix service personnel.
The oscilloscope displays the date of the last time the SPC routine was run beneath the SPC Status control.
What do you want to do next?
Follow a step-by-step signal path compensation procedure. (see page 575)

Instrument Diagnostics Control Window
From the Utilities menu, select Instrument Diagnostics.

Overview
Use this control window to run the instrument diagnostics.
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The following screen appears on MSO/DPO5000B Series instruments:

To use
1. Use the drop-down list boxes to identify the Subsystem, Area, and Test you want to run.
2. Use the Halt Condition controls to enable looping on the selected test(s) or to halt looping as soon as
a failure occurs.
3. Click the Run button to initiate the tests.
The Error Log button displays the number of entries in the error log if the number is greater than 0, else
nothing is displayed. The Diagnostics error Log window is available only when the power up diagnostic
setting is set to Factory.
NOTE. The Manual Product Verification option to know how to use special PV modes is available only on
MSO/DPO5000B Series instruments.
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E-mail on Event Control Window

You can run all tests or specific tests using the options on the Subsystem, Area, and Text drop-down
lists. The Diagnostic Status table lists each diagnostic, the results of the test, and the number of failures
that occurred.

Behavior
This window is mainly intended for service personnel. The diagnostic information can be used as part of
an incoming inspection or to diagnose potential problems with the instrument.
NOTE. Remove the input signals before running any diagnostics.
If any diagnostic failures occur, record the failure information, and then contact your local Tektronix
service personnel for more information.

E-mail on Event Control Window
From the Utilities menu, highlight E-mail on Event; then select Setup.

Overview
Use this control window to set up the conditions under which the instrument will send an e-mail, the types
of attachments to include, and the message limits.
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To use
1. In the Recipient e-mail address(es) entry box, type in the addresses where you want to send e-mail.
Use a comma to separate multiple addresses.
2. In the Send E-mail on check boxes, select the events on which you want to send e-mail.
3. Use the E-mail Attachments check boxes to select the type of attachment to include with the e-mail.
4. Click the Settings button to open the Save Options dialog box and set the parameters for the attachment.
5. In the Limit text box, enter the number of e-mail messages to send, up to a maximum of 32767.
6. In the Max E-mail Size entry box, enter the maximum message size, up to 2 GB, for each e-mail
message.
7. Click the Send button to send a test e-mail.
8. Click the Config button to open the E-mail Configuration dialog box.

Behavior
The maximum number of characters in the Recipient e-mail address(es) box is 252, so you can enter any
number of e-mail addresses up to a total of 252 characters. You can select one or all of the events to send
e-mail on. If you do not have a SMTP server address or e-mail address set up, you cannot select an
event to send e-mail on.
The screen capture, waveform, and measurement types for the e-mail attachments are determined by the
type that you select in the Save Options dialog box when you click Settings.
When the maximum number of messages is reached, the Send E-mail on check boxes are cleared and the
Current Count is reset to 0. You must select the event again to continue sending e-mail. Clicking Reset
changes the current count back to 0.
Attachments that exceed the Max E-mail Size are saved to the hard drive on the instrument.
TIP. To save your attachments on the instrument hard drive and still send an e-mail, set the Max E-mail
Size limit to 0.
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What do you want to do next?
Learn about the E-mail Configuration dialog box. (see page 820)
Learn about Mask Testing. (see page 215)
Learn about Limit Testing. (see page 242)
Learn about Measurement Save Options. (see page 558)
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Measurement Save Options
From the Utilities menu, highlight E-mail on Event; then select Setup. From the E-mail on Event Setup
dialog box, select Measurement(s) and then click Settings.

Overview
Use this control window to set up the conditions under which the instrument will send an e-mail and with
the types of attachments to include for the measurements.

To use
1. Click the Settings button to open the Measurement Save Options dialog box.
2. Select the measurement option and the file format. Click OK.
Selecting the Displayed Measurements option includes the measurements that are displayed on the screen;
the Measurement Snapshot option includes the information on measurements snapshot, and the Histogram
Data (CSV) option includes the histogram data in CSV format for the e-mail.
The following measurement file formats are available:
Numeric CSV. This creates (.csv) files in a numeric format usable by spreadsheets.
Numeric TXT. This creates (.txt) files in a numeric format usable by text and word processors.
Text CSV. This creates (.csv) files in a text format usable by spreadsheets.
Text TXT. This creates (.txt) files in a text format usable by text and word processors.
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Multipurpose Knobs
The multipurpose knobs can be used to set screen interface parameters. To use, click a control on the
screen to map it to the multipurpose knob(s).

For MSO/DPO5000B
Series instruments:

You can undo any mapping by right-clicking the multipurpose knob(s) and selecting Deassign
Multipurpose Knobs, or from the Utilities menu, select the Deassign Multipurpose Knobs
command. The mapping is deassigned until you perform that function again.
Turn the knob(s) or scroll with the mouse wheel until the desired selection appears in the
readout mapped to the knob. Push the FINE button, or click the mouse wheel to use the knob
to make small changes, for example, to add another decimal place for greater accuracy.
When no control windows are open and cursors are turned on, the multipurpose knobs control
the cursor positions.

xxx

NOTE. These knobs are automatically mapped when certain functions are performed, for example, when
the MultiView Zoom button is pushed.

User Preferences: Prompt Before Action
From the Utilities menu, select User Preferences; then open the Prompts tab.

Overview
Use the Prompts tab to indicate whether or not you want the instrument to display prompts (confirmation
messages) before carrying out certain tasks, like deleting files or waveforms.
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To use
Click a button to enable or disable the control setting.

Behavior
The confirmation messages give users the chance to change their minds before taking action. The messages
generally explain the implications of the action.
All preference settings are saved when you power off the instrument.
What do you want to do next?
Learn about setting user preferences for trigger level presets. (see page 560)

User Preferences: Keypad Defaults
From the Utilities menu, select User Preferences; then open the Keypad Defaults tab.

Overview
Use the Keypad Defaults tab to define the preset trigger levels.
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To use
To change the label for the selected preset control, click in the Keypad Label text entry boxes and
enter a name.
Click in the Trig Label Level entry boxes to map them to the multipurpose knobs. Use the knobs to
set the trigger level values.

Behavior
Use this control window to change the trigger level preset values. This can be useful when you want to
trigger the instrument on nonstandard trigger levels.
By default:
TTL fixes the trigger level at +1.4 V.
ECL fixes the trigger level at –1.3 V.
When you set the volts/div less than 200 mV, the instrument reduces the TTL or ECL trigger levels below
their standards. This is because the trigger level range is fixed at ±12 divisions from the center. For
example, at 100 mV, the trigger range is ±1.2 V, smaller than the standard TTL and ECL levels.
All preference settings are saved when you turn the instrument power off.
What do you want to do next?
Learn about setting up prompts for certain controls. (see page 559)

User Preferences: Readouts
From the Utilities menu, select User Preferences; then open the Readouts tab.
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Overview
Use the Readouts tab to select readout visibility and turn Highlight readouts on and off.

To use
Select an option for MPK Readout Visibility.
Click the Highlight Control Changes button On or Off to highlight readouts when you make changes.
Enter a time to leave the readout highlighted in the Hide After entry boxes.
Click the Trigger Status button to toggle it on or off.

Behavior
The maximum length of time you can leave the readouts highlighted is 5 seconds.
The following readouts are highlighted:
Vertical Scale
Horizontal Delay
Trigger Level
Trigger Source
Trigger Slope
Source Termination
What do you want to do next?
Learn about setting up prompts for certain controls. (see page 559)
Learn about setting user preferences for trigger level presets. (see page 560)

562

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Utilities

User Preferences: Measurement Annotation

User Preferences: Measurement Annotation
From the Utilities menu, select User Preferences; then open the Measurement tab.

Overview
Use the Measurement tab to set the user preference for measurement annotation. Annotations show the
exact segment of the waveform from which the measurement is derived.

To use
Click a button to select the annotation type, Standard or Detailed.

Behavior
The annotation types consist of horizontal bars, vertical bars, horizontal arrows, or vertical arrows.
TIP. You can access this feature, or turn the feature off, from the Measure menu. Select Measure >
Annotation; then select Standard, Detailed, or Off.
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User Preferences: Units
From the Utilities menu, select User Preferences; then open the Units tab.

Overview
Use the Units tab to set the detents for the vertical scale controls.

To use
Click one of the buttons to set the vertical scale detents:
Click 1–2–3 to set the vertical detent increments to 1, 2, 3, 4...
Click 1–2–5 to set the vertical detent increments to 1, 2, 5, 10...

Behavior
If the user preference is set to 1–2–3, the vertical knobs will increase or decrease the scale in a 1–2–3...
10–20–30... 100–200–300... sequence.
If the user preference is set to 1–2–5, the vertical knobs will increase or decrease the scale in a 1–2–5...
10–20–50... 100–200–500... sequence.
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User Preferences: Front Panel Buttons
From the Utilities menu, select User Preferences; then open the Front Panel Buttons tab.

Overview
Use the Front Panel Buttons tab to set the function of the Print and the Default Setup buttons.

To use
Click the Set Front Panel Print Button to change the function of the front panel Print button to save
a file each time you push the button.
To select a saved setup for the oscilloscope to recall when you push the Default Setup front panel button:
Select Factory from the list to recall the Factory setup.
Select a saved setup (from Setup 1 through Setup 10) to recall a specific setup.

Behavior
When the Set Front Panel Print Button is not selected, the function of the front panel Print button is to
print. When you select the alternate save function for the Print button, the oscilloscope updates the File
Save As menu (under the File menu) for the selected file type.
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Install an option
From the Utilities menu, select Option Installation.

Overview
Use Option Installation to enable upgrades that you have purchased for your instrument from Tektronix. For
the most current list of upgrades, go to www.tektronix.com or contact your local Tektronix representative.

To use
1. Click the Continue button in the initial dialog box.

2. Use either floating license or fixed license and follow the on-screen instructions to install the options.
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NOTE. Use the fixed license option installation (see page 570) to permanently install the optional features
and applications.
Use the floating license option installation (see page 568) to temporarily install the optional features
and applications.

Behavior
The installation dialog box lists information about the installed options and applications. The installation is
acknowledged when complete.
To run external applications following installation:
1. In the Menu bar, click Analyze.
2. Select the application name from the submenu.
NOTE. New versions of software for your instrument are available at our Web site. To find application
software releases that may not be on your instrument or to find the latest versions of instrument software
and application software that is on your instrument, visit www.tektronix.com/support.
What do you want to do next?
Install the Floating license. (see page 568)
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Install the Floating License
Install the Fixed license. (see page 570)
Return the Floating License for the Installed Options(s). (see page 571)

Install the Floating License
From the Utilities menu, select Option Installation.

Overview
Use Option Installation to enable upgrades that you have purchased for your instrument from Tektronix. For
the most current list of upgrades, go to www.tektronix.com or contact your local Tektronix representative.

To use
1. Click the Install button next to Floating License.

2. Browse to the path where the floating license key file (.lic) is located, select the file, and click Open.
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3. On successful installation, a dialog box appears indicating that the Option is enabled. Reboot the
instrument for the changes to take effect.
For example, after installing DPOFL-PTD (TDSPTD), the Tekscope Option Installation dialog box
appears as follows:
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Install the Fixed License
NOTE. Ensure that you select an authorized option installation key file to avoid any errors during
installation. For any information on the purchase of an Option Installation key file, refer to the Technical
Support information at http://www.tektronix.com/floatinglicense.
You must minimize the oscilloscope application to see the WEB page.

Install the Fixed License
From the Utilities menu, select Option Installation.

Overview
Use Option Installation to enable upgrades that you have purchased for your instrument from Tektronix. For
the most current list of upgrades, go to www.tektronix.com or contact your local Tektronix representative.

To use
Fixed License
1. Click the Install button next to Fixed License.

2. Enter the option installation key (provided by Tektronix) in the Options dialog box.
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3. Click OK. On successful installation a dialog box appears. Reboot the instrument for the changes to
take effect.

Return the Floating License for the Installed Option(s)
From the Utilities menu, select Option Installation.

Overview
Use the Option Installation to return the floating license for the installed Option(s) that you purchased for
your instrument from Tektronix.

To use
1. From the Utilities menu, select Option Installation.
2. Click Continue. The following dialog box appears.
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3. Select the Option (for example DPOFL-PTD (TDSPTD)) in the Tekscope Option Installation dialog
box and click the Return button (when the license is still valid) or click Exit Key button (when the
license has expired).
A dialog box appears. Click OK.
4. Browse to the path where you want to save the Exit Key file.
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NOTE. Ensure that the Exit Key file is uploaded to the Online Floating License Management System on
http://www.tektronix.com/floatinglicense to access the floating license again.
5. The following dialog box appears on completing the return of a floating license. Click Close.

6. A dialog box appears indicating that the selected Option is disabled. Reboot the instrument for the
changes to take effect.
For example, after returning the floating license for DPOFL-PTD (TDSTPTD), the Tekscope Option
Installation dialog box appears as follows:
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Compensate the signal path
Use the following procedure to compensate the internal signal acquisition path. Perform this procedure
if the ambient temperature has changed more than 5 °C (9 °F) since you performed the last signal path
compensation. Perform the signal path compensation once a week. Failure to do so may result in the
instrument not meeting warranted performance levels.
1. Power on and wait for the instrument to complete its warm up period before continuing with this
procedure.
2. Disconnect any probes you have connected to the input channels.
3. Set the instrument to Menu mode.
4. Select Instrument Calibration from the Utilities menu.
5. Note any instructions that appear in the resulting control window.
6. Click Run SPC to begin the procedure. The procedure may take several minutes to complete.
7. Verify that the Status changes to Compensated after the procedure is complete. If the Calibration
Status field indicates anything other than Compensated, see Signal Path Compensation Status (see
page 504) for information on the readout and recommended action.
NOTE. When making measurements at vertical scale settings less than or equal to 5 mV, you should
perform the signal path compensation at least once a week. Failure to do so may result in the instrument
not meeting warranted performance levels at those volts/div settings.

Compensate active probes
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
Use this procedure to optimize gain and offset accuracy at the probe tip for each active probe. Allow the
instrument and probe to warm up before performing this procedure. Then complete the following steps:
1. If you have not already done so, connect the probe to one of the vertical inputs on the instrument.
2. For DPO7000C and MSO/DPO5000B instruments only, connect the probe tip to the probe
compensation (Fast Edge on some models) outputs. Connect only one probe at a time.
3. For MSO/DPO70000C/DX instruments, connect the probe to the DC PROBE CAL output through the
deskew fixture as shown in the Z-Active Probe Deskew Fixture Instructions. These instructions are
available from the Documentation Browser on your instrument desktop; click the Documentation icon.
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Compensate passive probes

4. Select Probe Cal from the Vertical menu to open the Probe Setup control window.
5. Select the channel to which the probe is attached.
6. Click Compensate Probe to begin the procedure. The Probe Status indicator changes to Pass when the
procedure is complete. If the procedure does not pass, contact your local Tektronix service personnel.
7. Remove the connections from the terminals.

Compensate passive probes
Use this procedure to optimize gain and offset accuracy at the probe tip. Allow the instrument to warm
up before performing this procedure.
Perform the low frequency probe compensation (see page 577) for passive probes.
NOTE. The probe compensation procedure is not recommended for the P5050 passive probes. These probes
have little gain or offset errors. However, you should perform this procedure for other passive probes.
Complete the following steps:
1. If you have not already done so, connect the probe to the instrument.
2. Connect the probe to probe compensation (Fast Edge on some models) terminals as shown. Connect
only one probe at a time.
3. Select Probe Cal from the Vertical menu to open the Probe Compensation control window.
4. Select the channel to which the probe is attached.
5. Click Compensate Probe to begin the procedure. The Probe Status indicator changes to Pass when the
procedure is complete. If the procedure does not pass, contact your local Tektronix service personnel.
6. Remove the connections from the terminals.
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Low frequency compensate a probe
Use this procedure to compensate passive probes to ensure maximum distortion-free inputs to the
instrument.
1. Connect the probe to Ch 1 on the instrument.
2. Attach the probe tip and reference lead to the probe compensation terminals .
3. Press the Autoset button on the instrument.
4. Adjust the probe (see page 503) until you see a square wave with a perfectly flat top on the display.

5. See your probe manual for adjustment instructions.
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Deskew
Use the following procedure to compensate for timing differences between voltage probes:
1. Set up the instrument to display all of the channels that you want to deskew.
2. Push the instrument Autoset button.
3. Adjust the vertical Scale and Position controls for each channel so that the signals overlap and are
centered on the display.
4. Adjust the horizontal Position so that a rising edge is triggered at the center of the display.
5. Adjust the horizontal Scale so that the differences in the channel delays are clearly visible.
6. Adjust the horizontal Position again so that the first rising edge is exactly at the center of the display.
The fastest probe is connected to this channel (the fastest probe is usually the one with the shortest
cable or with the highest bandwidth).
7. Select Deskew from the Vertical menu to open the Deskew control window.
8. Select one of the slower channels.
9. Adjust the deskew time for the slower channel so that its signal aligns with that of the fastest channel.
The deskew adjustment range is ±75 ns.
10. Repeat steps 8 and 9 for each additional channel you want to deskew.
11. Remove the connections from the probe compensation terminals.
For information on how to deskew probes when using the Probe Setup Control Window, click here (see
page 510).
NOTE. To compensate for timing differences between voltage probes and between voltage and current
probes, order the following Probe Calibration and Deskew Fixtures. These fixtures may require a
user-supplied pulse generator.
For DPO7000C and MSO/DPO5000B Series oscilloscopes, order Tektronix part number 067-0405-XX.
For DPO70000C and DPO7000C Series oscilloscopes, order Tektronix part number 067-1586-XX.
For MSO70000C/DX Series instruments: Tektronix part number 067-2083-XX to deskew the logic
probe trigger path. This fixture is a standard accessory.

Setting up analog channels
Use the following procedure to set the scale and position parameters for analog signal acquisition.
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1. Set the acquisition system to Run continuously.
2. Connect the probe to the input signal source using proper probing/connecting techniques.
3. Click here (see page 485) for details on setting up the Vertical input controls.
NOTE. Some probes automatically set their termination and other values.
4. Push a front panel channel button (Ch <1– 4>) to select the input signal channel. A channel button
lights when its channel is on.
5. Open the Vertical Setup control window by clicking Vert on the toolbar or selecting the Vertical Setup
command from the Vertical menu. To change the input coupling, select the appropriate Termination
button.
Select DC to couple both the AC and DC components of an input signal.
Select AC to couple only the AC components of an input signal.
Select GND to disconnect the input signal from the acquisition system.
6. Use the Vertical knobs to scale and position the waveform on the screen. Dragging the waveform
handle also positions the waveform.
7. Use the Vertical Setup controls to change the offset. Click in the Offset entry box, and then use the
multipurpose knob to adjust the offset.
8. Use the Horizontal knobs to scale and position the waveform on the screen and to set the record length.
Dragging the reference icon also positions the waveform.
9. Use the Resolution knob to set the record length and sample interval.
10. If you need to stabilize the display, push the trigger Level control to set the trigger level to 50%.

Setting acquisition modes
Use this procedure to set the data acquisition mode and specify acquisition start/stop methods.
1. Power on the instrument.
2. Set up the horizontal (see page 181), vertical (see page 485), and triggering (see page 393) controls.
3. From the Horiz/Acq menu, open the Acquisition control window.
4. Click an Acquisition Mode button. For Average and Envelope modes only, select the number of
acquisitions to average or envelope. For WfmDB acquisition mode, select the number of samples.
5. Push the Run/Stop front-panel button to toggle between starting and stopping acquisitions, or push the
Single button to acquire enough waveforms to satisfy the acquisition mode.
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Use Fast Acquisitions

6. To select the sampling mode, click the Horiz toolbar button, or select the Horizontal/Acquisition Setup
command from the Horiz/Acq menu to open the Horizontal/Acquisition Setup control window.
7. Open the Acquisition tab and select one of the following Sampling Modes:
Real Time. This sampling mode acquires all points in a waveform record after one trigger event.
RT mode will switch to ET or IT mode, depending on the time-per-division setting and the number
of channels acquiring data.
Interpolated. This mode interpolates between the samples the instrument acquires when it cannot
acquire all the real samples it needs to fill up its waveform record.
Equivalent. This mode starts when the time base setting (horizontal scale) is too fast to let the
instrument get enough samples with which to create a waveform record using real-time sampling.
Equivalent time mode is intended for repetitive signals only.

Use Fast Acquisitions
To operate the instrument in Fast Acquisitions mode, set up the horizontal, vertical, and triggering controls,
and then follow the procedure below.
1. Enable Fast Acquisitions mode:
a. In the Horiz/Acq menu, select Horizontal/Acquisition Setup.
b. Open the Acquisition tab.
c. Toggle the Fast Acq button to On, or push the front-panel FastAcq button.
d. Click an option button to optimize the capture of data to suite your measurement.
2. Set up the Display Appearance:
a. In the Display menu, select Display Setup.
b. Open the Appearance tab.
c. Click one of the Style buttons: Vectors, Dots, or Inten Samp. Vectors is the default.
d. For the display Persistence, click either Infinite, Variable, or Off. Off is the default, and erases the
screen each time a new waveform array is displayed. For an explanation of Variable persistence,
click here (see page 582).
e. If you specified Variable, click Time, and adjust the persistence time (decay rate) with the
multipurpose knob.
3. Set the Display Readout Options:
a. Open the Display control window Objects tab.
b. Click the Display Date/Time button to toggle the date/time display On or Off.
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4. Adjust the Intensity:
a. Open the Display control window Appearance tab.
b. Rotate the front-panel Intensity knob to adjust the intensity of displayed waveforms, or click
in the Intensity FastAcq/WfmDB entry box and enter the intensity value with the keypad or
multipurpose knob.
5. Select the Color Palette:
a. Open the Display control window Colors tab.
b. Click a color palette button in the Fast/Acq WfmDB Palette. In Fast Acquisitions mode, Temp and
Spectral show more detail than the other color palettes.
c. For a definition of each color palette, click here (see page 179).
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Display persistence
From the Display menu, select Display Setup; then open the Appearance tab.

To use
Click one of the buttons to select the display persistence.
Click Infinite (persistence) to continuously accumulate record points on the waveform until you
change one of the acquisition display settings.
Click Variable; then click in the Time entry box and use the multipurpose knobs to set the
persistence time.
Click Reset to clear the persistence.
Click Controls to activate the Persistence Control window.

Behavior
Use infinite persistence for displaying record points that may occur outside the normal acquisition
envelope.
Use Variable to accumulate record points on the waveform for a specified time interval. Each
record point decays independently according to the time interval.
If you click Off, the waveform record points appear for the current acquisition only.
TIP. Use the Display menu Display Persistence submenu or right-click in the graticule and select
Display Persistence from the shortcut menu to directly access the persistence options.
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View the analog characteristics of a digital signal
NOTE. iCapture is available only on MSO70000C/DX Series instruments and DPO70000DX Series
instruments with option MSOU installed.
The iCapture function allows you to view the analog characteristics of signals connected to a digital
channel. Additional measurement capabilities are available while viewing the analog characteristics of a
signal. You can route up to four of the 16 digital inputs (D15-D0) and Clock/qualifier inputs to the analog
channels through a logic probe using iCapture. When a logic channel is routed to an analog channel, the
normal signal (analog input) is no longer visible.
To use iCapture, follow these steps:
1. From the Vertical menu, select Vertical Setup.
2. Press the Digital Input iCapture button.
3. Click the Digital Source box and select a signal connected to a digital channel to send through the
analog input.
4. To set the voltage reference level thresholds of the channel for the instrument to use when converting
an analog waveform to digital format to include in a bus, click the Digital Properties button.
5. To choose whether to share threshold settings or to have independent threshold settings, click in the
Channel Settings box, and select Shared or Independent from the list.
6. For each threshold you want to change, click the channel threshold entry box, and use the keypad or
multipurpose knobs to set the threshold level.
7. Click OK.
What do you want to do next?
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)

Set up digital channels
NOTE. Acquiring digital signals is available only on MSO5000B and MSO70000C/DX Series instruments
and DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with
option MSOU installed.
You can set the voltage reference level threshold, position, and display size parameters for digital signal
acquisition. To do so, follow these steps:
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1. Connect the logic probe to the input signal source using proper probing and connecting techniques.
2. Click here (see page 89) for details on setting up the Digital input controls.
3. Use the multipurpose knob to change the vertical position of the waveform on the screen. Dragging
the waveform handle also positions the waveform.
4. Use the Horizontal knobs to scale and position the waveform on the screen and to set the record length.
Dragging the reference icon also positions the waveform.
5. Use the Resolution knob to set the record length and sample interval.

Set up a bus
NOTE. Use of serial buses may require an option on your instrument.
You can set up parallel or serial buses. For both types of buses, follow theses steps:
1. From the Digital or the Vertical menu, select Bus Setup.
2. Select the Select tab, scroll through the Bus list, and select the Bus <B1-B16> to configure.
3. To toggle the display of the bus on or off, click the Bus <B1-B16> button.
4. To change the default label of the bus, click the Label box, and use the keyboard to enter a new label.
5. To change the position of the bus in the display, click the Bus Position box, and use the keyboard or
multipurpose knob to adjust the bus position.
6. Continue to set up specific parameters:
for a parallel bus (see page 584)
for an SPI Serial Bus (see page 586)
for an I2C bus (see page 586)
for a USB bus (see page 588)
for an RS-232 bus (see page 587)
for a MIPI CSI2 Serial Bus (see page 589)
for a MIPI DSI1 Serial Bus (see page 588)
for an 8B10B Serial Bus (see page 113)

Set up a parallel bus
First, follow the common steps to set up any bus (see page 584). To continue to set up a parallel bus,
follow these steps:
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Set up a parallel bus

1. To define the bus type in the Bus Setup window, click Parallel as the Bus Type.
2. To add sources to the parallel bus, click the Add Sources Select button. The Bus Source Selection
dialog appears.
3. In the Bus Source Selection dialog , click the button for each channel you want in the bus.
4. Click OK.
5. To move a channel within the parallel bus, scroll to and select the channel you want to move, and then
click the up or down arrow buttons.
6. To remove a channel from the bus, scroll to and select the channel you want to remove, and then
click the Remove button.
7. To set the voltage reference level thresholds, click the Thresholds Setup button.
8. Click the Channel Settings box, and select Shared or Independent. To set the thresholds to the same
level for all the analog channels (Ch), select Shared.
9. Double-click a channel Threshold entry box, and use the keypad or multipurpose knobs to enter a
threshold level.
10. To set the thresholds to the same level for all the analog, math and digital channels, click the Global
Threshold entry box, and use the keypad or multipurpose knobs to enter the threshold level. Click
Apply.
11. Click OK.
12. Click the Display tab, and configure the bus display (see page 594).
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Set up an SPI serial bus

Set up an SPI serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an SPI serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select SPI from the
drop-down list.
2. To select the input for the displayed components of the bus, click on a component Input and select a
channel from the cascading list.
3. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
4. To set the input polarity, click the Polarity entry box, and select Rising or Falling or Active Low or
Active High from the drop-down lists.
5. To set the input word size, double-click the Word Size entry box, and use the keypad or multipurpose
knobs to enter the size.
6. To set the input direction, click the Bit Order entry box, and select MS First or LS First from the
drop-down list.
7. Click the Display tab, and configure the bus display (see page 594).

Set up an I2C serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an I2C serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select I2C from the
drop-down list.
2. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
3. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
4. Click the Display tab, and configure the bus display (see page 594).
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Set up an RS-232 serial bus

Set up an RS-232 serial bus
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
First, follow the common steps to set up any bus (see page 584). To continue to set up an RS-232 serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select RS-232
from the drop-down list.
2. To select the input for the displayed components of the bus, click on a component Input and select a
channel from the cascading list.
3. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
4. To set the input polarity, click the Polarity entry box, and select Normal or Inverted from the
drop-down lists.
5. To set the input data bits, double-click the Data Bits drop-down list, and select use the keypad or
multipurpose knobs to enter the size.
6. To set the parity, click Parity entry box, and select None, Odd, or Even from the drop-down list.
7. To set the bit rate, click Bit Rate entry box, and select Custom, 50, 300, 1200, 2400, 9600, 19200,
38400, 115200, 921600, or 10000000 from the drop-down list.
8. Click the Display tab, and configure the bus display (see page 594).
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Set up a USB serial bus

Set up a USB serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an USB serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select USB from the
drop-down list.
2. To select the input for the displayed components of the bus, click on a component Input and select a
channel from the cascading list.
3. To set an input voltage reference threshold high level, double-click the Threshold (H) entry box
and use the keypad to enter the level.
4. To set an input voltage reference threshold low level, double-click the Threshold (L) entry box and use
the keypad to enter the level.
5. To set the speed, click the Speed entry box, and select Low (1.5 Mbps) or Full (12 Mbps) from the
drop-down lists.
6. To set the signal type, click the Signal Type entry box, and select Differential or Single Ended from the
drop-down list.
7. Click the Display tab, and configure the bus display (see page 594).

Set up a MIPI DSI-1 serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up a MIPI DSI-1
serial bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select MIPI DSI-1
from the drop-down list.
2. To set the channel type, click the Channel Type entry box, and select Analog or Digital from the
drop-down lists.
3. To select the input for the displayed components of the bus, click on a component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level. Set the threshold on the low power portion of the waveform.
5. Click the Display tab, and configure the bus display (see page 594).
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Set up a MIPI CSI-2 serial bus

Set up a MIPI CSI-2 serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up a MIPI CSI-2
serial bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select MIPI CSI-2
from the drop-down list.
2. To set the channel type, click the Channel Type entry box, and select Analog or Digital from the
drop-down lists.
3. To select the input for the displayed components of the bus, click on a component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level. Set the threshold on the low power portion of the waveform.
5. Click the Display tab, and configure the bus display (see page 594).

Set up an 8B10B serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an 8B10B serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select 8B10B
from the drop-down list.
2. To set the data rate, click the Data Rate entry box, and select the rate from the drop-down list.
3. To select the input for the displayed components of the bus, click the Input entry box, and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
5. To set an input hysteresis level, double-click the Hysteresis entry box and use the keypad to enter the
level.
6. Click the Display tab, and configure the bus display (see page 594).
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Set up a Custom serial bus

Set up a Custom serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up a custom serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select Custom
from the drop-down list.
2. To select the custom decoder, click the Custom Decoder arrow, and select the custom decoder from the
drop-down list.
3. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
5. Click the Display tab, and configure the bus display (see page 594).

Set up a PCIe serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up a PCIe serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select PCIe from the
drop-down list.
2. To select the data rate, click the Data Rate arrow, and select the rate from the drop-down list.
3. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
5. To set lane, double-click the Lane entry box and use the keypad to enter the lane.
6. Click the Display tab, and configure the bus display (see page 594).

590

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

How to ?

Set up a CAN serial bus

Set up a CAN serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an CAN serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select CAN from the
drop-down list.
2. To select the components, click Components and select a component from the drop-down list.
3. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
5. To select the bit rate, click the Bit Rate arrow, and select the rate from the drop-down list.
6. Click the Display tab, and configure the bus display (see page 594).

Set up a LIN serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an LIN serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select LIN from the
drop-down list.
2. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
3. To set an input voltage reference threshold level, double-click the Threshold entry box and use the
keypad to enter the level.
4. To select the polarity, click the Polarity arrow, and select the polarity from the drop-down list.
5. To select the LIN standard, click the LIN Standard arrow, and select the standard from the drop-down
list.
6. To select the bit rate, click the Bit Rate arrow, and select the rate from the drop-down list.
7. Click the Display tab, and configure the bus display (see page 594).
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Set up a FLEXRAY serial bus

Set up a FLEXRAY serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an FLEXRAY
serial bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select FLEXRAY
from the drop-down list.
2. To select the signal type, click the Signal Type arrow, and select the type from the drop-down list.
3. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
4. To set an input voltage reference threshold levels, double-click a Threshold entry box and use the
keypad to enter the level.
5. To select the channel type, click the Channel Type arrow, and select the type from the drop-down list.
6. To select the bit rate, click the Bit Rate arrow, and select the rate from the drop-down list.
7. Click the Display tab, and configure the bus display (see page 594).

Set up a MIL-1553 serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an MIL-1553
serial bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select MIL-1553
from the drop-down list.
2. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
3. To set a threshold, double-click the Threshold entry boxes and use the keypad to enter the level.
4. To set a Response Time, double-click the Response Time entry boxes and use the keypad to enter the
time.
5. To select the polarity, click Polarity, and select the rate from the drop-down list.
6. Click the Display tab, and configure the bus display (see page 594).
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Set up an Ethernet serial bus

Set up an Ethernet serial bus
First, follow the common steps to set up any bus (see page 584). To continue to set up an Ethernet serial
bus, follow these steps:
1. To define the bus type in the Bus Setup window, click Serial as the Bus Type, and select Ethernet
from the drop-down list.
2. To select the standard, click Standard, and select the standard from the drop-down list.
3. To set a Signal Type, click Signal Type and select the signal type from the drop-down list.
4. To select the input for the displayed components of the bus, click on the component Input and select a
channel from the cascading list.
5. To set a threshold, double-click the Threshold entry boxes and use the keypad to enter the level.
6. Click the Display tab, and configure the bus display (see page 594).
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Configuring the bus display

Configuring the bus display
You can configure the bus components, and decoding of parallel and serial buses. To do so, follow these
steps:
1. From the Bus Setup menu, click the Display tab, scroll through the Bus list, and select the bus to
configure its display.
2. Click the desired display component for the bus: Waveform, Busform, or Both.
3. Click the desired display style for the decoding method: Hex or Binary.
NOTE. Mixed, Decimal, and ASCII decoding methods are available for USB serial bus type.
ASCII and Packet View decoding methods are available for RS-232 serial bus type.
Mixed decoding methods like symbol for DT (Data Type MIPI element), decimal for VC (VIrtual Channel
MIPI element) and WC (Word Count MIPI element), and hexadecimal for all other fields are available for
MIPI DSI-1 serial bus type.
4. If you also want the instrument to use a symbol table file for decoding, click the Use Symbol File
check box, double-click the entry box, and click the Browse button to locate the file.
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
NOTE. The symbol file must follow a specific format, (see page 158) and reside in the
C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory for the instrument to locate the file,
decode the bus, and display the symbols.
5. For some serial buses, such as for an I2C bus, you can choose to include an R or W in the displayed
address.

Tracking down I2C serial bus anomalies
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
You can use your oscilloscope, with its bus triggering and long-record length management features,
to track down a problem in the physical layer and the protocol layer of a bus. To track down I2C bus
anomalies, follow these steps:
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Tracking down I2C serial bus anomalies

1. Connect a probe between a Ch <1–4> input of the instrument and the SCLK signal of the I2C serial
bus in your system under test.
2. Connect a second probe between one of the other Ch inputs of the instrument and the SDA data
signal of the bus.
3. Push the Autoset front-panel button.
4. From the Digital menu, select Bus Setup.
5. Click Serial as the Bus Type and select I2C.
6. Click the Input box of the SCLK component and select the channel connected to the SCLK signal
in step 1.
7. Double-click the Threshold entry box, and use the keypad or the multipurpose knobs to change the
voltage reference threshold level.
8. Click the Input box of the SDA component and select the channel connected to the SDA signal in
step 2.
9. Double-click the Threshold entry box, and use the keypad or the multipurpose knobs to change the
level.
10. Click the Display tab and set the bus display parameters. The instrument acquires, decodes and
displays data from the bus customized for you to more readily interpret and analyze activity on the bus.
11. From the Trig menu, select Bus Setup.
12. Click the Bus box and select the appropriate Bus setup <B1-B16> to acquire data from the I2C bus.
13. Click the Trigger On box , and select the bus cycle or activity for the instrument to use as the trigger.
For some Trigger On selections, you need to set additional fields to define other parameters such as
for an Address. In this example, you need to set an Address Format, Address Value (click the Edit
button), Data Direction, and Addressing Mode. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.
14. Acquire data and analyze the physical layer. If an analog channel is displayed, you can use Cursors to
take manual measurements or you can take automatic measurements.
15. Push the MultiView Zoom button and scroll to see all the events. Do you have all the packets that you
expected to have? If not, at least you have narrowed your search down to the last packet sent.
16. Analyze the decoded packets in the protocol layer. Did your program send the data bytes in the
correct order? Did you use the correct address?
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Troubleshooting circuits using a parallel bus

What do you want to do next?
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)

Troubleshooting circuits using a parallel bus
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
You can use digital, analog, or math waveforms to create, monitor, and analyze a parallel bus with your
instrument. The supported instruments let you see the on-off status of the signals and decodes the
parallel bus signals for you.
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Troubleshooting circuits using a parallel bus

1. Connect a logic probe to the logic probe port on the front panel.
2. Connect the logic probe tips for data to test points for signals of interest in your system under test.
For parallel buses that include a clock signal, connect the Clock probe tip to a clock signal in your
system under test.
3. From the File menu, select Recall Default Setup. Push the Chl 1 button to remove the waveform
from the display.
4. From the Digital menu, select Digital Setup.
5. Click the digital channel buttons for the channels you plan to use in your parallel bus. For a wider
bus, click the other tab and select more digital channels. To remove a channel, click the channel
button again.
6. From the Digital menu, select Bus Setup.
7. Click Parallel as the Bus Type.
8. Click the Add Sources Select button.
9. In the Bus Source Selection dialog, click the channels to use in the parallel bus. Click OK.
10. Arrange the channels in the desired bit order in the Bus Contains list of channels. To change the bit
order of a channel in the bus, select the channel, and click the up or down arrows to move the channel
to a more or a less significant bit position.
11. Click the Thresholds Setup button, double-click the Threshold entry box for each channel used, and
use the keypad or the multipurpose knobs to change the voltage reference threshold level. You can also
set all the thresholds to the same level with the Global Thresholds entry box. Click OK.
12. To include a clock signal, click the Clocked check box. Then, click the Clock Source box, select the
appropriate channel from the drop-down list, and also select which edge to use in the Clock Polarity
box: Rising, Falling, or Either.
13. Click the Display tab and set the bus display parameters. The instrument acquires, decodes and
displays data from the bus customized for you to readily interpret and analyze activity on the bus.
14. To decode the parallel bus with a symbol table file, click the Use Symbol check box, and enter the full
path to the file in the entry box or use the Browse button to locate the file. The file must reside on the
instrument in the C:\Users\[Username]\Tektronix\TekScope\busDecodeTables directory.
Here is the symbol table file used in this troubleshooting example.
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Troubleshooting circuits using a parallel bus

15. Acquire data and analyze the physical layer. If an analog channel is displayed, you can use Cursors to
take manual measurements or you can take automatic measurements.
16. Turn the Horizontal Scale knob to adjust the time base.
As you increase the time per division, you will see more data appear in the Bus display.
17. From the Trig menu, select the Bus trigger type.
18. Click the Bus box and select the appropriate bus setup <B1-B16> to acquire data from the parallel bus.
19. Click the Trigger If Logic State Goes box , and select True or False.
20. Click the Edit button, select the Format as Binary, Hex, or Symbolic, and enter a bus pattern for the
instrument to use as the trigger event. Click OK.
21. Acquire data from the parallel bus.
22. Push the MultiView Zoom front panel button, and scroll to the areas of interest to analyze the results.
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Troubleshooting an SPI serial bus

What do you want to do next?
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)
Learn about symbol tables for parallel buses. (see page 157)

Troubleshooting an SPI serial bus
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
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Troubleshooting an SPI serial bus

There are various situations where you need to look at analog characteristics of a digital signal in a digital
circuit. For example, you may want to analyze the signal integrity of a signal in a system under test,
such as for an SPI serial bus.
You can use the supported instrument, with its 4 analog channels and 16 digital channels (plus a
clock/qualifier) to track down the problem. It will even decode your SPI signals into ASCII characters.
To analyze the signal integrity of an SPI signal, you need to acquire and display the signal. Then, you
will look at both the analog and digital representations of the signal. Finally, you will search through
each SPI byte with the search and mark functions.
1. Connect a logic probe to the probe port on the front panel.
2. Connect the probe tip for D3 to a test point for the Data signal in your SPI system under test. It's
convenient to use D3 because it matches the default channel assignment for the SPI bus setup.
NOTE. You can connect any digital channel to the SPI signals, as long as you also set the signals to map to
the appropriate digital channel in the Bus Setup menu.
3. Connect D4 to a test point for the SCLK signal.
4. Connect D2 to a test point for the SS signal.
5. From the File menu, select Recall Default Setup.
6. Push the Ch 1 front-panel button to turn off the channel.
7. From the Digital menu, select Bus Setup.
8. Click an unused Bus from the list <B1-B16>.
9. Click the Bus On button.
NOTE. You can double-click the Label box and use the keypad to enter a name for the bus, and adjust
the position of the bus on the screen. You can also click the bus handle and drag it to reposition the bus
on screen.
10. Click Serial as the Bus Type.
11. Click the arrow and select SPI from the list of bus standards.
The default channel assignments are for the Data component to be acquired on D3, the SCLK
component on D4, and the SS component on D2.
12. Click the Display tab and set the bus display parameters, such as to display a busform. The instrument
acquires, decodes and displays data from the bus customized for you to readily interpret and analyze
activity on the bus.
13. To decode the bus as ASCII characters, you can create a symbol file with ASCII and click the Use
Symbol check box.
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Troubleshooting an SPI serial bus
The file must follow a specific format (see page 158), and reside in a specific directory where the
instrument can locate and use the file. You can use the entry box to enter the path or browse to the file.

14. Turn the Horizontal Scale button to adjust the time base.
As you increase the time per division, you will see more data appear in the Bus display.
15. From the Trig menu, select Bus Setup.
16. Click the Bus box and select the appropriate bus <B1-B16> from which to acquire, decode, and
display data.
17. Click the Trigger On box, and select an SPI trigger: SS Active or Data.
18. For Data, click the Edit button, select the Format as Binary, or Hex to use. Enter a bus pattern for the
instrument to use as the trigger event. Click OK.
19. Acquire data from the serial bus.
20. Push the MultiView Zoom front panel button, and scroll to the areas of interest to analyze the results.

What do you want to do next?
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Creating MyScope control windows
Learn about digital setups. (see page 89)
Learn about bus setups. (see page 97)
Learn about bus configuration. (see page 151)

Creating MyScope control windows
Use this procedure to create your own control windows:
1. From the MyScope menu, select New Control Window.
2. Click on the (+) to expand a control group and see the available controls within that group.
3. Click on a selection to see the control in the preview window.
4. Clear the check boxes for any controls that you do not want to appear. Most controls show all check
boxes selected by default.
5. Drag the customized control to your MyScope control window. You can also move a control after it
has been placed in the new control window by dragging it.
6. To remove the control from the custom control window select it, and then click the Delete button.
7. Click New Tab to add up to eight tabs.
8. Click the Rename Tab to create a unique name for each tab in your control window.
9. Click the User Pre button, and then select the user preferences you want to apply to this control window.
10. By default, the preferences are the same as what is currently set on your instrument. The preferences
you set from the MyScope Setup window only apply to your MyScope control window. The
preferences will take effect when the MyScope control window is activated.
11. Click Save or Save As to save your MyScope control window.
12. Enter a unique name for your MyScope control window and click Save. (This name will display in the
upper-right corner of the control window when you open it.) The default location to save MyScope
files is C:\Usrs\[Username]\Tektronix\TekScope\MyScope.
13. From the MyScope menu, click Open Control Window….
14. Select the MyScope control window that you want from the Open MyScope Control Window dialog
box, then and click Open.

Editing MyScope control windows
Use the following procedure to edit previously defined MyScope control windows.
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Editing MyScope control windows

1. From the MyScope menu, select Edit Control Window.
2. Select the MyScope control window that you want to edit from the Edit MyScope Control Window
dialog box. The control window you selected opens in the MyScope Setup control window.
3. Edit the control window using the same procedures as you did to create the control window. (see
page 603)
4. Click Save to save your changes to this control window.
5. Click Save As to save your changes as a different control window. Enter a unique name for
your MyScope control window, and click Save. The default location to save MyScope files is
C:\Users\[Username]\Tektronix\TekScope\MyScope.

Creating MyScope control windows
Use this procedure to create your own control windows:
1. From the MyScope menu, select New Control Window.
2. Click on the (+) to expand a control group and see the available controls within that group.
3. Click on a selection to see the control in the preview window.
4. Clear the check boxes for any controls that you do not want to appear. Most controls show
all check boxes selected by default.
5. Drag the customized control to your MyScope control window. You can also move a control after
it has been placed in the new control window by dragging it.
6. To remove the control from the custom control window select it, and then click the Delete button.
7. Click New Tab to add up to eight tabs.
8. Click the Rename Tab to create a unique name for each tab in your control window.
9. Click the User Pre button, and then select the user preferences you want to apply to this control
window.
10. By default, the preferences are the same as what is currently set on your instrument. The
preferences you set from the MyScope Setup window only apply to your MyScope control
window. The preferences will take effect when the MyScope control window is activated.
11. Click Save or Save As to save your MyScope control window.
12. Enter a unique name for your MyScope control window and click Save. (This name will display
in the upper right corner of the control window when you open it.) The default location to save
MyScope files is C:\Users\[Username]\Tektronix\TekScope\MyScope.
13. From the MyScope menu, click Open Control Window….
14. Select the MyScope control window that you want from the Open MyScope Control Window
dialog box, and then click Open.
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Select cursor sources

Select cursor sources
Use the following procedure to set up cursors on a source waveform.
1. Display the waveform(s) to be measured on the screen.
2. Push the CURSORS front-panel button, or click Cursors on the toolbar to open the Cursor Controls
window.
3. In the Cursor Controls window, click the Setup button.
4. Click a Cursor Type button. See Cursor Types (see page 605) for an explanation of the cursor types.
5. Select a Cursor Source from the Source drop-down list.
NOTE. If you are using H Bars or V Bars there is only one source for both Cursor 1 and 2. If you are using
Waveform or Screen cursors, select a source for both Cursor 1 and 2. If a waveform is not available, it
appears shaded in the drop-down list.
6. To change the position of a cursor, use the multipurpose knobs, enter a numeric value in the X and or
Y Position entry boxes, or click and drag the cursors to a new position.
7. Select a cursor Track Mode:
Indep. Makes each cursor moveable without regard to the position of the other cursor.
Tracking. Makes both cursors move in unison and maintain a fixed horizontal or vertical distance
between each other.
8. To turn the display of the cursors on or off, push the front-panel Cursor button.
9. For waveform or screen cursors, set the cursor style by selecting one of the following from the list:
Lines. Displays the intersection of horizontal and vertical lines. Lines are the default style for
Screen cursors.
Line & X. Displays the horizontal position as a vertical line; the Y-axis is displayed as an X.
X. Displays the horizontal and vertical position as a single X.
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Cursor Types
Because cursor measurements give immediate feedback on the amplitude or time values they measure,
they are usually quick to take and are more accurate than graticule measurements. Also, since you can
position cursors wherever you want them on the waveform, they are easier to localize to a waveform
segment or feature than automatic measurements.
The following table defines the cursor types.
Cursor function

Measurements
Horizontal cursors measure vertical parameters (amplitude) in volts, watts, or
IRE. The cursor readouts are defined as:
V1 = Level @ Cursor 1 with respect to its source ground level.
V2 = Level @ Cursor 2 with respect to its source ground level.
ΔV = Level @ Cursor 2 - Level @ Cursor 1.
Level is cursor displacement from the source ground multiplied by the source in
volts/div. The two cursors may have different sources and therefore can have
different volts/div settings.
Vertical cursors measure horizontal parameters. Typically the horizontal
parameters are in time or frequency, but depend on the units you select. The
cursor readouts are defined as:
T1 = Time @ Cursor 1 with respect to the trigger point
T2 = Time @ Cursor 2 with respect to the trigger point
ΔT = Time @ Cursor 2–Time @ Cursor 1
Time is divisions of displacement of the cursor from its source trigger point
multiplied by the source in time/div.
Waveform cursors measure vertical parameters (typically volts) and horizontal
parameters (typically time or frequency) simultaneously. Each cursor is, in effect,
both a vertical and horizontal cursor. These paired cursors cannot be moved off
of the waveform. The two cursors can have a different source.
Use screen cursors to indicate an arbitrary X and Y position in the waveform
display area represented by the intersection of a vertical and horizontal cursor
line. Screen cursors measure both vertical parameters (typically volts) and
horizontal parameters (typically time or frequency).

xxx

Taking cursor measurements
Use the following procedure to take measurements with cursors:
1. To open the Cursor Controls window, press the Cursors button on the front panel, click Cursors on the
toolbar, or select Cursor Setup from the Cursors menu.
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NOTE. If cursors are on but the readouts are not attached to the cursor controls, press the Cursors button
to attach the readouts to the cursor controls. Press the Cursors button again to turn the cursors off.
2. Select the waveform you want to measure and a Cursor Type (see page 75) from the control window.
3. Position the cursors with the multipurpose knobs.
4. Read the cursor information from the on-screen Position controls.
TIP. Select the cursor mode (Tracking or Independent) in the Cursor Setup control window.
NOTE. Cursor measurements are not available on digital channels.

Taking automatic measurements
Use the following procedures to quickly take a measurement based on the default settings for High and
Low reference levels. The instrument must be installed and operating, with a signal connected to an input
channel, and the horizontal and vertical controls and triggering set up.
1. Obtain a stable display of the waveform to be measured.
2. From the toolbar, click Measure to open the Measurement Setup control window.
3. Click the appropriate waveform button for the Channels <1– 4> and Ch, Math, or Ref Source tab.
4. Select the tab on the Measurement Setup control window that contains the measurement you want to
take:
Ampl
Time
More
Histog
Comm
5. Click a button for the Measurements type.
The readout for the measurement and associated statistics is automatically displayed, and the measurement
is added to the Measurements list in the control window.
NOTE. In roll mode, measurements are not available until after you stop acquisitions.
NOTE. Automatic measurements are not available on digital channels.
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Remove a measurement
1. To remove the measurement, click Clear Selected.
The last measurement on the list is removed.
To remove any measurement, click the name on the Measurements list to highlight the
measurement, and then click Clear.
You can click and drag to select and clear several measurements.
Toggle the display of measurements on the graticule by clicking the Display button On and Off.

Display measurement statistics
1. From any tab on the Measurement Setup control window, click Statistics to open the Measurement
Statistics control window.
2. From the Measurement Statistics control window you can select from the following options:
Off. Turns off the display of measurement statistics.
Mean. Displays the mean of measurements.
All. Displays the Mean, Min, Max, Standard Deviation, and Population measurements.
3. To set the number of measurements included in the measurement statistics, click Weight n=, and use
the multipurpose knobs or pop-up keypad to set the weighting.

Set measurement reference levels
1. From the toolbar, click Measure to open the Measurement Setup control window.
2. From any tab on the Measurement Setup control window, click Ref Levs to open the Reference
Levels Setup control window.
3. To set how the instrument determines the base and top of the waveform, click Determine Base Top
From:
Min-Max. Uses the highest and lowest values of the waveform record. (See Automatic
Measurements (see page 728) High/Low Method for more information.)
Histogram. Select the most common values above or below the midpoint. (See Automatic
Measurements High/Low Method for more information.)
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4. To select the reference level units, click Units:
Absolute. Sets the units to absolute values in user units.
Percentage. Sets the units as a percentage of the High/Low range.
5. To set the reference levels, click on these controls and use the multipurpose knob or pop-up keypad
to set:
High Ref. Defines the high reference level. The default level is 90%.
Mid Ref. Defines the middle reference level. The default level is 50%.
Low Ref. Defines the low reference level. The default level is 10%.
Mid2 Ref. Defines the middle reference used on the second waveform specified in delay or
phase measurements; the default level is 50%.

Take automatic measurements
Use the following procedures to take automatic measurements.
NOTE. This procedure assumes you are using the default reference levels.
1. Open the Measurement Setup control window by clicking Measure on the toolbar or by clicking
Measurement Setup on the Measure menu.
2. Select the source waveform using the Channels Selector, (see page 264) or press one of the front-panel
buttons.
3. Select the desired measurements from the measurement tabs. Each measurement is automatically
added to the measurement list.
The measurement is added to the display in the same color as the selected channel waveform.
NOTE. If the waveform is clipped by the edge of the graticule, the measurement readout will display
question marks.
TIP. You can select an automatic measurement from the menu bar Measure menu by selecting the
measurement type (for example, Amplitude) and clicking the measurement. The measurement is taken on
the currently selected waveform.
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Localize a measurement
Use the following procedure to take a measurement over a segment of the waveform:
1. The instrument must be installed and operating, with a signal connected to an input channel, and
horizontal and vertical controls and triggering set up.
2. Obtain a stable display of the waveform to be measured.
3. From the toolbar, click Measure to open the Measurement Setup control window.
4. Under Setups, click Gating from any tab. The Measurement Gating control window opens.
5. To select how to define the gated area, click one of the following:
Cursor. Sets the gated area to the area between the cursors. Use the multipurpose knobs to adjust
the cursors on screen.
Zoom (1–4). Sets the gated area to the waveform area contained in the Zoom (1–4) area.
Off. Turns off measurement gating. You can also turn gating off from the Zoom shortcut menu.
6. If you selected Cursor, you must also select the Track Mode:
Indep. This mode lets you move one cursor at a time using the multipurpose knobs.
Tracking. This mode allows you to move both cursors at the same time. The cursors track one
another; moving one cursor moves the other cursor in tandem.
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Save measurements
Use this procedure to save measurements to a spreadsheet or text format:
1. Measurements that you want to save must be selected.
2. From the File menu select Save or Save As. Under Save What, click Measurement.
3. Click the Options button to open the Measurement Save Options dialog box.
4. Select the Measurement Format from the drop-down list.
5. Click OK to save the measurement options, or click Cancel to close the dialog box without saving
the changes.
6. To save the measurements to a file, select the location to save from the Save in drop-down list. The
default location is C:\Users\[Username]\Tektronix\TekScope\data.
7. Use the default name for your file, type a unique name into the Name text box, or select an existing
name from the Name list (data in the existing file will be overwritten). You can also select the
Auto-increment file name check box to save a series of files without typing in a new name each time.
8. Select the file type from the Save as type drop-down list; this is the same as the Measurement format
that you selected in the Options dialog box.
Use .cvs for spreadsheets.
Use .txt for text.
NOTE. Changing the file type here will also change the selected format in the Option dialog.
9. Click Save.

Using math waveforms
Use the same techniques to work with math waveforms that you use with channel waveforms. This
procedure demonstrates some common operations that you can perform on math waveforms:
NOTE. Math calculations are not available on digital channels.
NOTE. Each math waveform you create derives its horizontal scale and position from the sources you
include in its math expression. You can adjust these controls for the source waveforms, and your
adjustments are reflected in the math waveform.
You can also magnify math waveforms using MultiZoom, and use the mouse for positioning.
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Prerequisites
A math waveform must be defined and displayed.

Create a math waveform
Use the following procedure to create a math waveform. Ensure that the sources, waveforms, and
measurement scalars you will use are present. The sources do not have to be displayed.
1. From the toolbar, click the Math button to open the Math Setup control window.
2. Select the Math tab for the math waveform you want to create; then click Display Off/On
to toggle it on.
TIP. If the waveform that you select already exists, its math expression appears in the window. You
can still use the waveform by clicking Clear, which discards the previous math expression. You may
also want to select another waveform.
3. Click one of the Predefined Functions buttons to use a predefined math expression, or click Editor
to access the Math Equation Editor.
4. Use the Math Equation Editor control window to define a math expression. See Creating Math
Waveforms (see page 612) for examples, and use the following guidelines:
Math definitions are not implemented if the sources are not valid.
Use the Bksp (backspace) button to remove the last entry; click Clear to remove the entire
expression and start over.
Use parentheses to group terms in the expression to control execution order, for example,
5(Ch1 + Ch2).
5. Select the Time, Spectral, Var, Meas, or Filter tabs to display the available functions.
6. Click a Primitive button to enter the function in the math expression. Click an operand button (+,
-, *, /) to insert an operand.
7. Use the Home and arrow buttons to move within the math expression. Use the Bksp (backspace)
button to delete portions of the expression.
8. Click Apply to apply your new math expression to the math waveform.
9. Click Avgs to open the Math Averaging control window. The controls in the window apply to
the math waveform defined by the expression.
10. Click in one of the Math <1–4> n = entry boxes, and then set the number of averages using
the multipurpose knobs or pop-up keypad. This number of averages affect math waveforms if
the Avg() function is used.
11. Once you have defined the math expression, click Apply in the Math Setup or Math Equation
Editor windows.
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Creating math waveforms
You create math waveforms when you create a math expression. You do so by applying numerical
constants, math operators and functions to operands. You can display and manipulate these derived
math waveforms much like you can the channel and reference waveforms (see Using Math
Waveforms (see page 610)).
Some examples of typical math waveforms follow:
To normalize this waveform:

Enter this math expression:

(Ch1- Meas1)/ Meas2, where Ch1 is the waveform shown
at left Meas1 = Low of Ch1 Meas2 = amplitude of Ch1

And get this math waveform:

To simulate AC coupling on this waveform:

Enter this expression:

Intg(Ch1-Avg(Ch1)), where Ch1 is the waveform shown
at left Avg is the average function

And get this math waveform:

xxx

Offset, position, and scale
The settings that you make for offset, scale, and position affect the math waveform you obtain.
Here are some tips for obtaining a good display:
Scale and position the source waveform so that it is contained on the screen. (Off-screen
waveforms may be clipped, resulting in errors in the derivative waveform.)
Use vertical position and vertical offset to position your source waveform. The vertical position
and offset will not affect your derivative waveform unless you position the source waveform off
screen so that it is clipped.
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Select and display a waveform
1. Click the Math toolbar button to open the Math Setup control window.
2. Select the tab for the math waveform that you want to work with.
If the waveform you select is not defined, use the Create a Math Waveform (see page 611)
procedure to define the math waveform.
If the waveform is not displayed, click Display.

Set scale and position
1. Click in the Position and Scale entry boxes and use the multipurpose knobs or pop-up keypad to
size and position the waveform on the screen.
Keep in mind the following:
The position is in divisions, so changing the scale can make the math waveform disappear until
position is also changed (the same effect happens with channel waveforms).
You can click and drag a waveform handle to change the waveform vertical position.
You can change the waveform vertical position and scale by clicking on the waveform handle and
using the multipurpose knobs to adjust.
You cannot adjust the offset of a math waveform.
You cannot adjust horizontal scale, position, and sample density (resolution) of math waveforms;
different length source waveforms result in a math waveform of the shortest source record length.
If you adjust these settings for sources of a math waveform, the adjustments are reflected in the
math waveform.

Take an automatic measurement
1. Click the Measure toolbar button to open the Measurement Setup control window.
2. Select the Channels Math tab, and click a channel button to choose a math waveform.
3. Select a Measurements type (for more information, see Taking Automatic Measurements (see
page 606)).
4. To display the measurement, click Display to toggle it to on.
NOTE. Automatic measurements are not available on digital channels.
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Take a cursor measurement
1. Click the Cursor toolbar button to display the cursors and open the Cursor Controls window.
2. Select the cursor type by clicking either H Bars, V Bars, Screen, or Waveform (for more information,
see Taking Cursor Measurements (see page 605)).
3. Use the multipurpose knobs to position each cursor on the math waveform to measure the feature
that interests you.
4. Read the results in the cursor readout. The cursor readout is displayed under the multipurpose readouts
or in the upper right corner of the graticule area.
NOTE. Cursor measurements are not available on digital channels.
NOTE. The amplitude measurements on a derivative waveform are in volts-per-second, and volt-seconds
for an integral waveform measurement.

Create a math waveform using predefined expressions
Use the following steps to create math waveforms using predefined expressions:
1. Open the Math Control window by clicking Math on the toolbar or by clicking Math Setup in the
Math window.
2. Select a Math waveform by clicking one of the tabs in the control window.
3. Click one of the Predefined Expression buttons in the control window. The predefined expression is
added to the math expression at the top of the control window and the math waveform appears on
the screen.
TIP. You can select Predefined Expressions directly from the Math menu.
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Create a math waveform with the Equation Editor
Use the following steps to create math waveforms using the Equation Editor:
1. Open the Math Setup control window by clicking Math on the toolbar, or by selecting Math Setup in
the Math menu.
2. In the Math Setup control window, click the Editor button to open the Math Equation Editor.
3. Select a Math waveform from the drop-down list.
4. Select a math function by clicking a button under the tabs on the left side of the Equation Editor (for
example, click Derivative).
5. Select a valid waveform to use as an operand from the Channels Selector (see page 264).
6. Use other buttons in the Equation Editor as necessary to create the math expression for the math
waveform.
7. Click OK to create and display the math waveform.
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Create a math waveform
Use the following procedure to create a math waveform. Ensure that the sources, waveforms, and
measurement scalars you will use are present. The sources do not have to be displayed.
1. From the toolbar, click the Math button to open the Math Setup control window.
2. Select the Math tab for the math waveform you want to create; then click Display Off/On to toggle it on.
TIP. If the waveform that you select already exists, its math expression appears in the window. You can
still use the waveform by clicking Clear, which discards the previous math expression. You may also want
to select another waveform.
3. Click one of the Predefined Functions buttons to use a predefined math expression, or click Editor
to access the Math Equation Editor.
4. Use the Math Equation Editor control window to define a math expression. See Creating Math
Waveforms (see page 747) for examples, and use the following guidelines:
Math definitions are not implemented if the sources are not valid.
Use the Bksp (backspace) button to remove the last entry; click Clear to remove the entire
expression and start over.
Use parentheses to group terms in the expression to control execution order, for example, 5(Ch1 +
Ch2).
5. Select the Time, Spectral, Var, Meas, or Filter tabs to display the available functions.
6. Click a Primitive button to enter the function in the math expression. Click an operand button (+,
-, *, /) to insert an operand.
7. Use the Home and arrow buttons to move within the math expression. Use the Bksp (backspace)
button to delete portions of the expression.
8. Click Apply to apply your new math expression to the math waveform.
9. Click Avgs to open the Math Averaging control window. The controls in the window apply to the math
waveform defined by the expression.
10. Click in one of the Math <1–4> n = entry boxes, and then set the number of averages using the
multipurpose knobs or pop-up keypad. This number of averages affect math waveforms if the Avg()
function is used.
11. Once you have defined the math expression, click Apply in the Math Setup or Math Equation Editor
windows.
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Set up mask testing
Use the following procedure to set up the instrument to perform mask testing.
1. Connect the instrument to the source signal or save the source signal to a math or reference waveform
memory location.
2. Access the mask setup window:
a. From the toolbar, click Masks to display the Mask Testing control window.
b. From the Source/Tolerance tab select the channel, math, or reference tab, and then select the
waveform to use as the mask test source. You can only mask test one waveform at a time.
3. Specify the mask Type:
a. Open the Masks tab.
b. Click the appropriate button in the Type field.
c. Click the More button to display further selections.
NOTE. This window lists the mask types and standards available on your instrument. Industry
standard masks are available. You must install the Serial Communications Mask Testing Option (see
page 215) on some instruments before you can access the Comm triggers.
TIP. Selecting a mask type and standard adjusts the instrument horizontal, vertical, and trigger
settings to those appropriate for displaying a waveform of the specified type. If the signal is not
found within the mask, do the following:
Click the Autoset button to center the waveform in the mask.
If Autoset did not align the signal within the mask, adjust the instrument vertical and
horizontal controls.
If you clicked the Autoset button and the Autoset Undo preference is On, the instrument
will display an Autoset Undo window. Click the Undo button to return to the previous
settings, or click the X icon to remove the window.
4. Select a standard from the drop-down list to specify the mask standard.
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5. Specify the display parameters:
a. In the Masks tab, click the Display button to toggle mask display on or off. The mask must be
turned on to do mask testing.
b. Click the Hit Count button to turn on or off hit counting. The hit count is shown in the Pass/Fail
Results tab.
c. Click the Display Config button to set mask hit highlighting and to lock the mask to the waveform.
Lock Mask to Wfm (Waveform) resizes the mask to reflect changes in the horizontal or vertical
settings of the instrument.
6. Autoset the signal:
a. In the Masks tab, click the Autoset button to have the instrument automatically adjust instrument
settings to align the waveform to the mask based on the characteristics of the input signal. Autoset
is performed on the first waveform acquired after clicking the Autoset button.
NOTE. If the Autoset Undo preference is On, the instrument will display an Autoset Undo window
allowing you to do the following:
Click the Undo button to return to the previous settings.
Click the X icon to remove the window.
NOTE. Selecting the AutosetConfig button opens the Mask Configuration - Autoset window that lets
you do the following:
Set the vertical, horizontal, and trigger autoset parameters.
Activate autofit or autoset.
Select the autoset mode.
Return to the default autoset configuration.
Return to the Mask Setup control window.
7. Enable and set the waveform autofit parameters:
a. In the Masks tab, click the Autofit button to enable the waveform autofit function.
Autofit checks each waveform for any mask hits. If there are hits, autofit repositions the waveform
to minimize hits. The number of hits reported is the number after autofit has minimized hits.
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The autofit Config button lets you do the following:
Set the autofit maximum waveform repositioning parameters (as a percentage of the horizontal
and vertical divisions).
Return to default settings.
Return to the Mask Setup control window.
Change the vertical or horizontal autofit parameters.

8. Click the Masks button to return to the Mask Testing control window.
9. Set the mask test tolerance margins:
a. From the Source/Tolerance tab, you can set the percentage of margin used in the mask test. Click
in the Margins entry box and use the multipurpose knob, pop-up keypad, or the up/down arrow
buttons to enter the mask margin tolerance percentage. The range of values is –50% to 50%
NOTE. Margin tolerance settings greater than 0% expand the size of the segments, making the mask
test harder to pass; margin tolerance settings less than 0% (negative percent) reduces the size of the
segments, making the mask test easier to pass.
10. Set the Mask test pass and fail parameters:
a. Open the Pass/Fail Setup tab of the Masks Testing control window.
b. Use the control knob, keypad, or pop-up keypad to enter the number of waveforms to test (number
of samples in some modes), the failure threshold (the number of waveforms that must fail to fail
the test), and the delay time (the time from when mask test starts to when the instrument begins
sampling).
c. Click the Test Fail Notification buttons to set up what the instrument does when a mask test fails:
Initiate an instrument beep (BEEP).
Send an e-mail (E-mail).
Save Wfm. This saves the waveform data of the first waveform that causes the test to fail to a
.wfm file.
Log Date. This saves the time, date, and basic test information of the first waveform that causes
the test to fail to an ASCII text (.txt) file.
Stop the signal acquisition immediately (Stop Acq).
Send the instrument screen image to a printer (Print).
Send an SRQ on the GPIB bus (SRQ).
NOTE. Files are saved to the location specified by the Path button. The file name format is
YYMMDD-HHMMSS, where YY is year, MM is month, DD is day, HH is hour, MM is minutes, and
SS is seconds. You may also need to select a sound source to enable the BEEP. See Selecting the
Sound Source for more information (see page 232).

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

619

How to ?

Create a new User Mask

11. Use the Test Pass Notification buttons to set what the instrument does at the successful completion
of a mask test.
12. Use the Polarity buttons to set mask and waveform polarity. Positive tests the positive waveform
pulses. Negative inverts the mask and tests the negative waveform pulses. Both test the first half of the
waveforms in positive polarity mode, and then test the remaining waveforms in negative polarity mode.
13. Toggle the Repeat button to On to set the instrument to repeat (continue) mask testing on the
completion of each test.

Create a new User Mask
Use following procedure to create a new user mask that is not based on an existing mask:
1. Use the communications trigger features to trigger the instrument on a signal. The instrument saves
these settings with the mask information.
2. From the toolbar, click Masks.
3. In the Mask Testing control window, open the Masks tab.
4. Click the User Mask button.
5. In the User-Defined Mask drop-down list, select None.
6. Click the Copy Current Mask To user Mask button. If you are asked if you want to overwrite the
current user mask, click the Yes button.
7. Click the Edit User Mask button to display the user Mask Edit functions.
8. Click in the Segment entry box and use the up/down arrows, multipurpose knob, or keypad to enter or
select segment 1.
9. Click the Vertex Add button. The instrument draws the default new segment shape, a triangle.
10. Use the instructions on Editing a User Mask (see page 621), starting at step 5 to edit a segment.
11. Repeat steps 9 through 11, selecting an unused and sequential segment number, to create and edit
more segments.
12. See Saving a User Mask to Disk (see page 621) procedure.
NOTE. You do not need to save an edited user mask to disk; the instrument retains the current user mask
in nonvolatile memory.
If you plan to create a number of user masks, store your user masks on disk or the hard drive. The
instrument can only load one user mask at a time.
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Edit a user defined mask
1. From the toolbar, click Masks.
2. In the Mask Testing control window, open the Masks tab.
3. Click the User Mask button.
4. Click the Edit User Mask button. The instrument displays the Mask Edit control window.
5. Click the Controls button to open the Mask Edit control window.
6. Click in the Segment entry box and use the up/down arrows, multipurpose knob, or keypad
to select a segment to edit. The selected (active) segment is highlighted in red. Each mask
can have up to 16 segments.
7. Click in the Vertex entry box, and use the up/down arrows, multipurpose knob, or keypad to
select the vertex to edit. The active vertex is indicated with an X on the template segment. Each
segment can have up to 50 vertices.
8. Click the in the Horizontal entry box, and then use the multipurpose knob or keypad to change the
selected vertex horizontal position.
9. Click in the Vertical entry box, and then use the multipurpose knob or keypad to change the
selected vertex vertical position.
10. To add a vertex, select the closest vertex that is clockwise from where you want to place a
new vertex. Click Add to add a vertex midway between the selected vertex and the next
counterclockwise vertex.
11. To delete a vertex, enter or select the vertex number; then click Del. The remaining vertices
located counterclockwise from the deleted vertex are renumbered.
12. See Saving a User Mask to Disk (see page 621) procedure.
NOTE. You do not need to save an edited user mask to disk; the instrument retains the current user
mask in nonvolatile memory.
If you plan to create a number of user masks, store your user masks on disk or the hard drive. The
instrument can only load one user mask at a time.

Save a user mask to disk
1. From Mask menu, select Mask Edit Setup.
2. In the Mask Edit control window, click the Save button to open the Save As dialog box.
3. Specify the save location in the Save in drop-down list box.
4. In the Name field, enter the mask name; (*.msk) is the default save type for User Mask Files.
5. Click Save to save the mask to specified location on disk.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

621

How to ?

Create a User Mask from a defined mask

Create a User Mask from a defined mask
NOTE. Refer to Mask Key Points (see page 785) before creating or editing a mask.
Use the following procedure to create a user mask from a defined mask:
1. From the toolbar, click Masks.
2. In the Mask Testing control window, open the Masks tab.
3. Click the appropriate button in the Type field to select a mask type.
4. Click the More button to display further selections.
NOTE. Industry standard masks are available with the Mask Testing feature. The Comm Trigger is
designed to work with communications mask and standard testing. Mask testing automatically uses
Communication triggers. You must install the Serial Communications Mask Testing Option on some
instruments before you can access the Comm triggers.
5. Select a standard from the drop-down list. The control window lists mask types and standards that are
available on your instrument.
6. Click the User Mask button.
7. Click the Copy Current Mask To user Mask button. The instrument copies the current mask to the user
mask memory.
8. See the Editing User Mask procedure (see page 621).
9. See Saving a User Mask to Disk (see page 621) procedure.
NOTE. You do not need to save an edited user mask to disk; the instrument retains the current user mask
in nonvolatile memory.
If you plan to create a number of user masks, store your user masks on disk or the hard drive. The
instrument can only load one user mask at a time.

Edit a user defined mask
1. From the toolbar, click Masks.
2. In the Mask Testing control window, open the Masks tab.
3. Click the User Mask button.
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4. Click the Edit User Mask button. The instrument displays the Mask Edit control window.
5. Click the Controls button to open the Mask Edit control window.
6. Click in the Segment entry box and use the up/down arrows, multipurpose knob, or keypad to select
a segment to edit. The selected (active) segment is highlighted in red. Each mask can have up
to 16 segments.
7. Click in the Vertex entry box, and use the up/down arrows, multipurpose knob, or keypad to select
the vertex to edit. The active vertex is indicated with an X on the template segment. Each segment
can have up to 50 vertices.
8. Click the in the Horizontal entry box, and then use the multipurpose knob or keypad to change the
selected vertex horizontal position.
9. Click in the Vertical entry box, and then use the multipurpose knob or keypad to change the selected
vertex vertical position.
10. To add a vertex, select the closest vertex that is clockwise from where you want to place a new vertex.
Click Add to add a vertex midway between the selected vertex and the next counterclockwise vertex.
11. To delete a vertex, enter or select the vertex number; then click Del. The remaining vertices located
counterclockwise from the deleted vertex are renumbered.
12. See Saving a User Mask to Disk (see page 621) procedure.
NOTE. You do not need to save an edited user mask to disk; the instrument retains the current user mask
in nonvolatile memory.
If you plan to create a number of user masks, store your user masks on disk or the hard drive. The
instrument can only load one user mask at a time.

Save a User Mask to disk
1. From Mask menu, select Mask Edit Setup.
2. In the Mask Edit control window, click the Save button to open the Save As dialog box.
3. Specify the save location in the Save in drop-down list box.
4. In the Name field, enter the mask name; (*.msk) is the default save type for User Mask Files.
5. Click Save to save the mask to specified location on disk.
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Recall a User Mask from disk
1. From the toolbar, click Masks; then open the Masks tab.
2. Click the User Mask button.
3. Click the Edit User Mask button. The instrument displays the Mask Edit control window.
4. Click the Mask Recall button.
5. The instrument opens the Recall dialog box. The default recall location is the TekScope/Masks folder.
If the mask files are in another folder, use the navigation controls to access the appropriate folder.
6. Select the mask name.
7. Click Recall to load the user mask into user mask memory on the instrument.
Alternatively, the mask can be recalled by selecting Recall from the File Menu. This opens the Recall
dialog box where you can navigate to and select the mask that you want to recall.

Create a User Mask with Mask Testing
Use the Edit control to change a standard mask and create your own mask.
NOTE. Industry standard masks are available with the Mask Testing feature. The Comm Trigger is
designed to work with communications mask and standard testing. Mask testing automatically uses
Communication triggers. You must install the Serial Communications Mask Testing Option (see page 215)
on some instruments before you can access the Comm triggers.
1. From the Masks menu, select Mask Setup, or click the Masks button in the toolbar.
2. In the Mask Testing control window, open the Masks tab.
3. From the Masks tab, select the type of mask and standard that you want to use as a basis for your mask.
4. Click User Mask, and then click Copy Current Mask To user Mask.
5. Click Yes. The mask that you selected is now a user mask.
6. To alter the mask, click Edit User Mask.
7. Under Mask Elements, use the up/down arrows to select the segment and vertex that you want to edit.
The selected segment appears in red and a white X indicates the selected vertex.
8. Under Mask Value, click in the Horizontal or Vertical entry boxes. and then use the multipurpose
knobs to change the horizontal or vertical values of the mask.
9. Click Save to save your changes as the User Mask.
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Use Mask Testing
Follow these steps to perform mask testing:
1. From the Mask menu, select Mask Setup, or click the Mask toolbar button.
2. In the Mask Testing control window, open the Masks tab.
3. Select the Type of mask you want to use.
4. Select the mask standard from the drop-down list.
NOTE. The standard you select will determine whether you also need to set the polarity for the test.
5. Make any necessary changes to the Display or Alignment configurations.
6. Click the Hit Count button to turn it off or on.
7. Open the Source/Tolerance tab.
8. Click the input channel you want to test.
9. From the Source/Tolerance tab, make adjustments to the mask margins tolerance.
10. Open the Pass/Fail Setup tab and set the rest of the test parameters.
11. From the Pass/Fail Setup tab or the Pass/Fail Results tab, click the Pass/Fail Test button to run the test.

Send an E-mail on Events
You can set up the instrument to send e-mail following an event.

Set up E-mail on Event
1. From the Utilities menu, select E-mail on Event Setup.
2. Enter the recipients’ e-mail addresses in the entry box.
3. Click the Config button, and then enter your SMTP server address; then click OK.
4. Select the events on which to send e-mail.
5. Select which types of e-mail attachments you want to include.
6. Set the maximum message limit. (The maximum allowed by the system is 50.)
7. Set the maximum message size.
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NOTE. The default is 1 MB and the maximum is 2 GB. Setting the maximum message size to 0 causes
attachments to be saved to the default location on the instrument hard drive.
8. Click Send to send a test e-mail.

Send an E-mail on Mask Test Failure
1. See Setting up the Mask Test (see page 617), and follow the procedure for setting up a mask test.
2. From the Pass/Fail Setup tab, under Test Fail Notification, click E-mail to On.
3. Click the Pass/Fail Test button On to start the mask test or click the Repeat button for continuous
mask testing.

Send an E-mail on Trigger
1. Select the trigger type.
2. Select the trigger source.
3. Set the appropriate parameters for the trigger.
4. From the Mode tab, click E-mail on Trigger to On.
5. Press the Run/Stop button to begin acquiring data to trigger.

Create a spectral waveform
Use these steps to display a spectral (FFT magnitude) waveform.
1. Set the source signal Vertical Scale so that the signal peaks do not go off screen. Off-screen signal
peaks can result in FFT waveform errors.
2. Set the Horizontal Scale control to show five or more cycles of the source signal. Showing more
cycles means the FFT waveform can show more frequency components, provide better frequency
resolution, and reduce aliasing (see page 627).
3. If the signal is a single-shot (transient) signal, make sure that the entire signal (transient event and
ringing or noise) is displayed and centered on the screen.
4. Click Math on the toolbar, or click Math Setup from the Math menu to open the Math Setup control
window.
5. Click the Basic button.
6. Click the Magnitude button to insert the magnitude function into the math expression.
7. Click the channel that is related to the time-domain signal that you want to view as an FFT waveform.
The respective channel is inserted into the math expression.
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8. Select the appropriate FFT window type.
9. Set the Vertical Scale and Reference as appropriate.

Aliasing
Problems occur when the instrument acquires a signal containing frequency components that are
higher in frequency than the Nyquist frequency. The Nyquist frequency is the highest frequency that
any digital oscilloscope can measure without errors is one-half of the sample rate or frequency.
The frequency components that are above the Nyquist frequency are under sampled and appear to
"fold back" around the Nyquist frequency, showing as lower frequency components. These incorrect
components are called aliases.
To quickly check for aliasing, slowly decrease the horizontal time scale. If the shape of the displayed
waveform changes drastically or becomes stable, your waveform is probably aliased. You can also
check for aliasing by turning on peak detect acquisition mode. To remove aliasing, modify the
record length.

Define a spectral math waveform
Use the following procedure to define a spectral math waveform. Before you begin, ensure that the
sources you will use are either acquiring or have acquired data. These sources do not have to be displayed
to be used.
1. All sources that you will use in your math waveform must be available.
2. From the toolbar, click the Math button to open the Math Setup control window.
3. Click a Math <1–4> tab to select the math waveform you want to create.
4. Under Spectral Analysis, click Advanced to open the Spectral Analysis - Advanced control window.
5. Open the Create/Edit tab.
6. Click Magnitude to create a magnitude spectral waveform or Phase to create a phase spectral
waveform. If you want an averaged spectral waveform, click Avgs to set the number of averages. See
the step Apply Averaging Creating a Math Waveform (see page 616) for details.)
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7. Under Source, select the tab and channel number for the source waveform.
TIP. If you want to redefine your waveform, click the Clear button, and repeat the above steps.
8. To display your spectral waveform, click Apply.
9. Set the magnitude scale:
a. Click the Magnitude button.
b. Open the Vert Axis tab.
c. Under Scale, click to select the vertical scale factor.
Linear. Displays magnitude using units equal to the source units.
dBm. Sets the reference level offset to predefined values for dBm; see next step.
dB. Displays magnitude using the log scale, expressed in dB relative to the reference level offset.
TIP. You can also adjust the scale and position by clicking the waveform handle and using the
multipurpose knobs.
d. To set the reference level, click in the Level entry box, and use the multipurpose knobs or pop-up
keypad to set the reference level.
TIP. Reference level is the value at the top of the display screen. It only applies to magnitude
waveforms. Adjusting the reference level positions the waveform with respect to the top of the display,
but does not change the position of the waveform with respect to its ground reference.
e. To set the reference level offset, click in the Level Offset entry box, and use the multipurpose
knobs or pop-up keypad to set the offset.
TIP. Offset determines where zero dB is in the output waveform. Changing offset moves the waveform
with respect to its ground reference. When the input is equal to the offset, it will display as zero
dB in the output.
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10. Set the phase scale:
a. Open the Crate/Edit tab.
b. Click the Phase button.
c. Open the Vert Axis tab.
d. Use the Scale controls to set the vertical scale factors.
Deg (Degree). Sets the phase units to degrees. Phase is displayed using degrees as the scale, where
degrees wrap from –180° to +180°.
Rad (Radian). Sets the phase units to radians. Phase is displayed using radians as the scale,
where radians wrap from –P to +P.
GroupDelay. Unwraps the phase spectrum and displays its derivative.
Using the Phase Controls (see page 770) provides in-depth information on setup for phase displays.
Click Unwrap to specify whether to unwrap phase in a spectral analysis phase waveform.
To set the level in dB that a magnitude in the spectrum must exceed to have its phase computed (to
reduce the effect of noise in your phase waveform), click in the Suppression Threshold entry box,
and use the multipurpose knobs or pop-up keypad to set the threshold level. If the magnitude is
less than the threshold, then its phase is set to zero. See Using the Phase Controls (see page 770),
for additional information on suppression threshold.
11. Set the time and frequency domain control tracking:
To enable changing time and frequency domain controls for one math waveform to change the same
controls for another math waveform,
a. Open the Tracking Tab
b. Toggle the Track Time/Frequency Domain Controls buttons on or off.
12. To select the window type:
a. Open the Create/Edit tab.
b. Select the Window Type from drop-down list. For more information on window types see Using
Spectral Analyzer Windows (see page 775).
13. Set the frequency domain controls:
a. Open the Create/Edit tab.
b. To set the frequency range over which the spectral analysis is performed, click in the Frequency
Span entry box and use the multipurpose knobs or pop-up keypad to set the frequency range.
Higher sample rates allow you to set greater frequency spans. To set the frequency span to the
maximum allowed by the current sample rate, click Full.
c. To set the center frequency of the spectral analysis, click in the Center Frequency and use the
multipurpose knobs or pop-up keypad to set the center frequency.
d. Resolution bandwidth determines how small of a frequency difference can be resolved in the
frequency domain output data. It basically defines the bandwidth of the filters used to do the
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frequency domain analysis. To set the resolution bandwidth, click in the Resolution BW entry box
and use the multipurpose knobs or keypad to set the resolution bandwidth.

14. Set the time domain controls:
a. Open the Create/Edit tab.
b. The Time domain controls determine the sample rate and record length of the acquisition. These
controls allow you to change the duration on the acquisition without changing the sample rate.
Click in the Resolution entry box and use the multipurpose knobs to adjust the time interval
between data samples of the input waveform.
NOTE. Resolution is the inverse of Sample rate. Adjust resolution to adjust sample rate. Resolution
may also cause a change in record length such that the duration is kept constant at the value selected
by the Duration control.
c. To adjust the number of seconds over the duration of the acquired waveform (record length), click
in the Duration entry box and use the multipurpose knobs or pop-up keypad to adjust the duration.
NOTE. Changing duration also changes the record length.
d. Gate position is the position of the phase reference point in the gate with respect to the trigger
in seconds. The gate position and gate duration must be within the acquisition. To set the gate
position, click in the Gate Position entry box and use the multipurpose knobs or pop-up keypad
to adjust the gate position.
e. Gate duration and resolution bandwidth are the same. Gate duration is displayed in seconds and
resolution bandwidth in hertz. To set the gate duration, click in the Gate Duration entry box and
use the multipurpose knobs or pop-up keypad to adjust the gate duration.
15. Take cursor measurements:
a. From the toolbar, click the Cursors button to display the cursors and open the Cursor Controls
window.
b. Click the Setup button to open the Cursor Setup window.
c. Use the Source drop-down lists to select the channels for the spectral waveform you want to
measure.
d. Select the cursor type. For more information, see Taking Cursor Measurements (see page 631).
e. Click in the X and Y Position entry boxes and use the multipurpose knobs to position each cursor
on the waveform to measure the feature(s) that interests you.
f.
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NOTE. The cursor readout is displayed under the multipurpose readouts or in the upper right corner
of the graticule area. The cursor units will be in dB or volts for magnitude waveforms and in degrees
or radians for those measuring phase.
g. Select V Bars, and use the multipurpose knobs to align the two vertical cursors to points of interest
along the horizontal axis of the waveform.
h. Read the frequency difference between the cursors from the Δ: readout. Read the frequency of
each cursor relative to the zero frequency point from the cursors readout.

Take a cursor measurement
Use the following procedure to take measurements with cursors:
1. To open the Cursor Controls window, press the Cursors button on the front panel, click Cursors
on the toolbar, or select Cursor Setup from the Cursors menu.
2. Select the waveform you want to measure and a Cursor Type (see page 75) from the control
window.
3. Position the cursors with the multipurpose knobs.
4. Read the cursor information from the on-screen Position controls.
TIP. Select the cursor mode (Tracking or Independent) in the Cursor Setup control window.

Use a predefined spectral math waveform
The following procedure is an example of setting up the instrument to perform spectral analysis of a signal.
This example uses the probe compensation signal available on the front panel of the instrument.
1. Connect the probe compensation signal to Ch 1 through a suitable probe.
2. Press Default Setup.
3. Press Autoset.
4. From the toolbar, click Vertical, and select the Chan 1 tab.
5. Click in the Offset entry box, and then use the multipurpose knobs or keypad to set the offset to 900 mV.
6. Click in the Scale entry box, and use the multipurpose knobs or keypad to set the Channel 1 Scale
to 200 mV.
7. From the toolbar, click Math, and select the Math 1 tab.
8. Click the Spectral Mag button.
The instrument sets up a predefined magnitude spectral analysis waveform. Your waveform should
be similar to the one below.
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9. Click the Spectral Analysis Basic button.
10. Use the multipurpose knobs or keypad to set the frequency span to 125 kHz and the center frequency
to 62.5 kHz (if necessary, reduce the sample rate).
11. From the toolbar, click Cursors.
12. To assign the cursors to the spectral analysis math waveform, select Math 1 from the Source list for
Cursor 1.
13. Click Setup to open the Cursor Setup control window.
14. Use the multipurpose knobs or keypad to set the Curs1 Pos to 0.0 Hz and the Curs2 Pos to 125 kHz.
The cursor readout should now indicate the frequency span set in step 10.
15. Use the multipurpose knobs or keypad to set the Curs2 Pos to 62.5 kHz. The cursor readout should
now indicate the center frequency set in step 10.
16. Use the multipurpose knobs or keypad to set the Curs1 Pos to 3.0 kHz and the Curs2 Pos to 11.0 kHz.
In this example, the cursors are now on the third and eleventh harmonic of the probe compensation
signal. Read the frequencies from the cursor readouts.
17. Click the Cursor Type Waveform button; then click in the Cursor 2 and the Math 1 entry boxes.
In addition to the frequency at the cursor locations, the cursor readout displays the amplitude at the
cursor locations. The readout also displays the difference in frequency and amplitude between the cursor
locations as shown below.

Create a reference waveform
Use this procedure to create reference waveforms from active or math waveforms.
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1. Click Save on the toolbar or click Save As from File menu.
2. Select Waveform to open the Save As dialog box.
3. From the Source list, select the waveform you want to save as a reference.
4. Under Save in: Oscilloscope Memory, click Ref <1–4> to save the waveform to nonvolatile memory.
You can also select a location from the Save in drop-down list to save the waveform to a file.
5. Use the pop-up keyboard to enter a meaningful name for the waveform in the Name text box.
6. Click Save.
NOTE. When you save a waveform as a reference waveform, a file containing the waveform data is created
in C:\Users\[Username]\Tektronix\TekScope\Waveforms. The file is named TDS_REFn.WFM, where n
is the reference waveform number. Do not manually delete this file because the data will no longer be
available.

Save reference waveforms using Auto-Increment File Name
Use this procedure to repetitively save waveforms without typing in a large number of unique file names.
1. Click Save on the toolbar or click Save As from File menu.
2. Select Waveform.
3. From the Source list, select the waveform that you want to save as a reference.
4. Click Auto-increment file name near the bottom of the dialog box.
5. Enter a descriptive name in the Base file name text box. For example, if you are saving a series of
rise time data files, you can use " Risetime " as the base file name.
6. The Count text box defaults to "000." Change this if you want to start saving your series of files
with another 3-digit number.
7. Change the file Save as type if necessary.
8. Click Save.
Your first file is saved as Risetime000.ext, where ext is the file type extension. The next file will be
Risetime001.ext, and so on.
If Count reaches 999, Tektronix suggests that you change the base file name, for example, Risetime1 on the
next save. Your next file will then be saved as Risetime1000.ext. You will receive a warning message
if you are going to overwrite any existing files with the same name.
TIP. Use the auto-increment file name feature to save a series of setups, exported images, waveforms,
and measurements.
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Recall a reference waveform
Use this procedure to recall a reference waveform from a file:
1. Click Recall on the toolbar, or select Recall from the File menu.
2. Under Recall What, select Waveform.
3. Select the waveform you want to recall; then select the Destination Ref <1– 4>.
4. Click Recall to load the waveform into memory.
You can use reference waveforms for measurements, math functions, or other uses. Simply select the
reference waveform from the Channels Selector (see page 264) on the individual control windows.
NOTE. When you recall a reference waveform from a file, a new file containing waveform data is created
in C:\Users\[Username]\Tektronix\TekScope\Waveforms. The file is named TDS_REFn.WFM, where n is
the reference waveform number. This file is deleted when the reference waveform is deleted.

Save a waveform
Use the following procedure to save a waveform or waveforms to a reference location, the instrument hard
drive or DVD drive, or a third-party storage device.
1. Make sure the waveform to be saved exists. The source must be a channel, an active math waveform,
or an active reference waveform. Display the waveform along with the setup before you save it.
2. From the File menu select Save As; then click Waveform.
3. From the Source drop-down list, select the waveform that you want to save. Only available waveforms
are displayed in the list.
4. Under Save in: Oscilloscope Memory, select the location Ref <1–4>; then click Save to save your
waveform to that reference location. Any data in the existing reference will be overwritten.
5. To save the waveform to a file, select the location to save from the Save in drop-down list. The default
location is C:\Users\[Username]\Tektronix\TekScope\Waveforms.
6. Name your waveform file by typing a name in the Name text box, or select an existing name from the
file list (data in the existing file will be overwritten). You can also select the Auto-increment file name
check box to save a series of files without typing in a new name each time. For more information, see
Saving Reference Waveforms Using Auto-Increment File Name (see page 633).
TIP. If you did not attach a keyboard, click the keyboard icon to display the virtual keyboard.
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7. The file extension specified in the Save as type drop-down list will automatically be appended to the
file name. You can also select from the following file formats:
.wfm is an internal instrument format. When waveform is selected, save waveform options like
waveform data range, FastFrame data range, waveform detail and data ordering are disabled.
.csv is usable by spreadsheets such as Microsoft Excel.
.txt is the standard text file format.
.dat is usable by Mathcad and MATLAB.
HDF5 (*.h5) is Hierarchical Data Format version 5. HDF5 saves the entire waveform. When
HDF5 is selected, save waveform options like waveform data range, FastFrame data range,
waveform detail and data ordering are disabled.
8. If your file type is other than .wfm, click the Options button to set up the Waveform Save Options.
9. Select the data format (Data destination) for the waveform you want to export.
10. Select a valid waveform from the Source list.
NOTE. Options that are grayed out are not available with the currently selected data destination.
11. Under Waveform Detail, select the Include waveform scale factors check box if you want to include
waveform details like header information (record length, sample interval, trigger point information,
and so on). If you only want to include the waveform voltage values, clear the selection.
12. Under Waveform Data Range, select the samples that you want to save. You can select a range of
samples, only the samples between the cursors, samples in a Zoom Area, or All samples. If you select
Samples between cursors, you can use the multipurpose knobs to adjust the positions if the cursors are
active. If they are not, the cursors are activated in their most recent positions.
13. If you are exporting Fast Acquisitions data, select the data ordering from the list.
14. Click OK, and then click Save to save the waveform file. To cancel without saving, click Cancel.

Copy waveform data
1. Identify the waveform, image, or measurement to be copied. The source must be a channel, an active
math waveform, or an active reference.
2. From the Edit menu, highlight Select for Copy.
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3. In the submenu, select the format for export:
Select Full Screen to export a bitmap of all screen contents.
Select Graticule to export a bitmap of only the graticule area.
Select Waveform to export waveform data.
Select Measurements to export measurement data.
4. From the Edit menu, select Copy Setup.
5. Open the Images tab.
6. Set the Image Options:
a. Select a color Palette for your copied images.
b. Select the image View: to copy an image of the entire screen, select Full-screen; to copy an
image of the selected graticule, select Graticule(s) only.
c. The Screen Capture Format is BMP only.
7. Set the Waveform Options:
a. Open the Waveforms tab.
b. Select the data format (Data Destination) for the waveform you want to copy.
c. Select a valid waveform from the Source list.
d. Select the Include waveform scale factors check box if you want to include waveform details
like header information (record length, sample interval, trigger point information, and so on).
If you only want to include the waveform voltage values, clear the selection.
e. Select the number of samples that you want to copy from the Waveform curve data range.
Select all samples, a range of samples, or only the samples between the cursors. If you select
Save Samples between Cursors, you can use the multipurpose knobs to adjust the positions if
the cursors are already active. If they are not, the cursors are activated in their most recent
positions.
f.

If you are copying Fast Acquisitions data, select the data ordering from the list.

8. Set the Measurement Options:
a. Open the Measurements tab.
b. Select either Displayed Measurements (make sure that measurements are displayed in the
graticule via the Measurement Control window) or Histogram Data.
c. If you clicked the Displayed Measurements option, select the Data Format, either Numeric or
Text.
9. Click Copy to save your setup information to the Windows clipboard.
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Save a screen capture
Use this procedure to save screen captures to the instrument memory, a CD, or third-party storage device.
The images you want to save must be displayed within the graticule.
1. From the File menu, select Save As; then select Screen Capture.
2. Click the Options button to open the Screen Capture Save Options dialog box.
3. Select a color Palette for your screen capture.
4. Under View, select from the following:
Full Screen. Saves an image of the entire screen.
Hide Menu/Toolbar. Click this check box if you do not want the menu and toolbar included.
Graticule(s) Only. Selects an image of the selected graticule.
5. Select a data format from the Screen Capture Format list.
6. Click OK to save the screen capture options, or click Cancel to close the dialog box without saving
the changes.
7. In the Save As dialog box, select the location to save from the Save in drop-down list. The default
location is C:\Users\[Username]\Tektronix\TekScope\Screen Captures.
8. Name your screen capture by typing a name in the Name text box, or select an existing name from the
file list (data in the existing file will be overwritten). You can also select the Auto-increment file name
check box to save a series of files without typing in a new name each time.
9. Click Save.

Set the horizontal delay
Use the following steps to set up the horizontal delay mode of the instrument.
1. Open the Horizontal/Acquisition Setup control window.
2. Open the Horizontal tab.
3. Turn on the Horizontal Delay mode by clicking Delay Mode on or pressing the front panel Delay
button.
4. Click in the Horiz Delay entry box and use the multipurpose knobs to set the delay time and reference
point (Ref Point). To view data before the trigger event, enter a negative value; to view data after the
trigger event, enter a positive value.
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Compare data using horizontal delay

TIP. You can also use the horizontal delay with complex trigger events in the Trigger Setup control window
by clicking the A->B Seq tab and configuring the horizontal delay.

Compare data using horizontal delay
After setting up the instrument to use the horizontal delay, press the front panel Delay button to toggle
the horizontal delay on and off. This allows you to quickly compare two segments of a signal that are
separated from each other by a fixed amount of time.

Set up Roll Mode
Use the following procedure to set up roll mode acquisitions.
1. Power on the instrument and set up the horizontal (see page 181) and vertical (see page 485) controls
and triggering (see page 393).
2. Click the Horiz/Acq toolbar button to open the horizontal/acquisition setup control window.
3. Open the Acquisition tab.
4. Click the Roll Mode Auto button to enable roll mode. The resolution, record length, horizontal scale,
and number of active channels on are dependent variables. Therefore, the fastest horizontal scale
setting when Roll mode starts is 40 ms/div, the record length is 1000, the acquisition mode is either
Sample or Peak Detect, and 1 or 2 channels must be on. As the record length or the number of on
channels grows, the time per division required to enter Roll mode is slower.
NOTE. Envelope and Average acquisition modes inhibit roll mode. Hi Res roll mode starts when the
resolution is 4 ms or greater.
5. Push the Single button on the instrument front panel to start and acquire enough points to satisfy the
acquisition mode (when the waveform makes it to the left edge of the screen). The acquisition mode
must be either Sample or Peak Detect.
6. To stop acquisitions in roll mode:
If you are not in Single Sequence, push Run/Stop to stop roll mode.
If you are in Single Sequence, roll mode acquisitions stop automatically when a complete record is
acquired.
7. Click the Horiz toolbar button to open the horizontal/acquisition setup control window.
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Using Roll Mode

8. Open the Acquisition tab.
9. Click Roll Mode Off to disable roll mode. Roll mode is also disabled when you set the horizontal scale
to 200 ms per division or faster. At record lengths greater than 500 points, the time per division to
turn off roll mode becomes slower.
NOTE. Switching to Envelope or Average acquisition mode will also turn off roll mode.

Using Roll Mode
Use Roll mode to view data at very slow sweep speeds. This is useful for observing data samples
on the screen as they occur.
NOTE. Roll mode turns on automatically at slower sweep speeds. You may want to turn Roll mode off
to avoid conflicts with other instrument settings.
To turn Roll mode off (see page 638), deselect Roll Mode Auto in the acquisition setup control window.

Checking trigger status
To assess the state and setup of the triggering circuit, check the trigger status lights, readouts, and display.

Trigger status lights
To quickly determine the trigger status, check the Arm, Ready, and Trig'd indicators on the instrument
front panel.
If Trig'd is on, the oscilloscope has recognized a valid trigger and is filling the posttrigger portion
of the waveform.
If Ready is on, the oscilloscope can accept, and is waiting for, a valid trigger.
If Arm is on, the trigger circuitry is filling the pretrigger portion of the waveform record.
If both Trig'd and Ready are on, a valid A event trigger has been recognized and the instrument is
waiting for a delayed trigger. When a delayed trigger is recognized, the posttrigger portion of the
delayed waveform will fill.
If Arm, Trig'd, and Ready are off, the acquisitions have stopped.

Acquisition readouts
To determine the settings of some key trigger parameters, check the Trigger readout at the bottom of the
display. The readouts differ for edge and the advanced triggers.
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Checking trigger status

Trigger level marker
To determine the trigger level on the waveform display, turn on a trigger level indicator (marker). See
Trigger Level Marker (see page 641) for instructions on setting the indicator.
The trigger level indicator remains on the screen as long as the channel providing the trigger source is
displayed.
You can choose between two types of trigger level indicators:
Short. Consists of an arrow at the right side of the graticule.
Long. Consists of a horizontal bar within the waveform display area.
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Set up triggering from the Front Panel

Trigger level marker
From the Display menu, select Objects, or open the Objects tab in the Display control window.

To use
Click one of the buttons to select the trigger level indicator.

Behavior
The trigger level markers (see page 641) indicate the voltage level where the trigger or threshold
levels of the active waveform occur:
The Short trigger level marker displays a short arrow on the side of the graticule by the active
waveform.
The Long trigger level marker displays a horizontal line through the active waveform.
NOTE. The trigger level indicator does not appear on inactive waveforms, reference waveforms,
or fast acquisition signals.

Set up triggering from the Front Panel
The front panel provides quick access to the most frequently used trigger controls. The trigger readout
shows you the state of the trigger system.
The Slope, Coupling, and Source controls only apply to edge triggering. To access the advanced trigger
controls, open the Trigger Setup control window by pushing the Advanced button. (See Advanced
Triggering (see page 643) for more information.)
Use the following procedure to set up triggers using the front-panel controls:
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Set up triggering from the Front Panel

1. Set the acquisition system to Run (the Run/Stop control is lighted), and set the vertical and horizontal
controls appropriately for the signal you want to acquire.
2. Push the Edge button to select edge triggering. Pushing Advanced opens the Trigger control window
to set up other trigger types.
3. Push the Slope button to toggle between Positive and Negative:
Pos. Triggers on a rising edge (positive-going) signal.
Neg. Triggers on a falling edge (negative-going) signal.
Pos + Neg. Triggers on both edges of the signal.
You can also set the Polarity in the Trigger control window.
4. To manually change the trigger level for edge triggers (or certain threshold levels for logic or pulse
triggers), turn the front-panel Level knob. You can also set the Level in the Trigger control window.
5. To quickly set the edge trigger level to 50% of the waveform voltage range, push the Level knob. The
instrument sets the trigger level to the halfway point between the peaks of the trigger signal. This
function has no effect for the other trigger types.
You can also click Set 50% in the Trigger control window.
6. Push the Trigger left and right arrow button to select a Source:
Ch 1 through Ch 4. These are the input channels. The channel you select as a trigger source
will function whether it is displayed or not.
Ext. This is a fifth, nondisplayable auxiliary (external) trigger source. To use the auxiliary trigger,
connect the source to the front-panel Auxiliary In connector.
Line. This is the AC line voltage. The oscilloscope is used to generate the trigger and you do not
have to input a signal. The trigger level is fixed at zero volts.
7. From the Trig menu select Edge Setup to set the Coupling for an A or B Event main trigger:
DC. Passes both AC and DC components of the input signal.
AC. Passes only the AC components of an input signal.
HF Reject. Attenuates signals above 30 kHz.
LF Reject. attenuates signals below 80 kHz.
Noise Rej. Provides lower sensitivity, reducing the chance of falsely triggering on noise.
8. Push the front-panel Mode button to toggle between normal and automatic trigger modes:
Norm (Normal). Requires a valid trigger event to acquire a waveform.
Auto (Automatic). Acquires a waveform even if no valid trigger event occurs.
NOTE. Be aware that in Auto mode, the acquired waveforms may not be triggered.
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Set up triggering from the Trigger Setup Window

Advanced triggering
You can check the advanced trigger status in the readout. The readout indicates the trigger type and
then shows sources, levels, or any other parameters that are important for the particular trigger type.

Set up triggering from the Trigger Setup Window
The following trigger parameters are accessible only through the Trigger control windows:
Holdoff
Trigger level presets
Force trigger
Use the procedures below to set up these trigger parameters.

Set the trigger holdoff
Changing the holdoff time helps to stabilize triggering.
1. Push the front-panel Advanced button.
2. In the Trigger control window, select the Mode tab.
3. Click Default or Time:
Auto. Uses the instrument default holdoff time, which is five times the current horizontal scale
setting. Default maintains a good value for general-purpose triggering.
Time. Enables you to enter a holdoff that may allow more stable triggering. This time is used at
all horizontal scale settings
4. If using Time, click in the Trig Holdoff entry box and use the multipurpose knob to enter a time value.
The holdoff range is 250 ns to 100 s.

Select a preset trigger
1. Push the front-panel Advanced button.
2. In the Trigger control window, select the A Event tab.
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Set up triggering from the Trigger Setup Window

3. Click a Trigger Type button to select a trigger, such as Edge, that uses a level adjustment. A trigger
uses a level adjustment if the Level control appears within the trigger graphic (see page 394), along
with the other trigger type setup controls.
4. Click Level, and then click the keypad icon to open the keypad. Click on either TTL, ECL, or USER:
TTL. Sets the trigger level to +1.4 V.
ECL. Sets the trigger level to –1.3 V.
USER. You can set the trigger level to a preset voltage.
When you set the volts/div less than 200 mV, the instrument reduces the TTL or ECL trigger levels
below standard TTL and ECL levels. This reduction occurs because the trigger level range is fixed at
+12 divisions from the center. At 100 mV (the next lower setting after 200 mV) the trigger range is +1.2 V,
which is less than the typical TTL (+1.4 V) or ECL (–1.3 V) level.

Define preset levels
1. From the Utilities menu, select user Preferences.
2. In the User Preferences control window, open the Keypad Defaults tab.
3. Click in the appropriate Trig Level entry box; then use the pop-up keypad or multipurpose knob to
adjust the preset.
4. If desired, click a Keypad Label and change the label of the preset using the pop-up keypad.

Force a trigger
When using Normal trigger mode, forcing a trigger is useful if the input signal is not supplying a valid
trigger.
1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event or B Event tab
3. In the Trigger Type drop-down list, select Edge.
4. To force the instrument to immediately acquire one waveform record, even without a trigger event,
click the Force Trigger button.
TIP. Click Force Trigger to quickly confirm there is a signal present for the instrument to acquire. Then
determine how to trigger on the signal. For example, push LEVEL to set 50%, check the trigger source
setting, and so on.
NOTE. The instrument acts on a Force Trigger even if it is selected before the end of pretrigger holdoff.
However, the button has no effect if the acquisition system is stopped.
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Trigger on a sequence

Trigger on a sequence
Use the following procedure to set up the instrument to trigger on a sequence:
1. Connect a signal to an input channel.
2. Set the acquisition system to Run; then set the vertical and horizontal controls appropriately for the
signal you want to acquire.
3. To trigger on A Event (main) only:
a. Click Trigger on the toolbar; then open the A->B Seq tab of the Trigger control window.
b. Click the A Only button to turn off sequential triggering.
4. To trigger on a B event after time:
a. To set the time base to run after an A trigger, a trigger delay, and a B trigger, click Trigger on the
toolbar; then open the A->B Seq tab of the Trigger Setup window.
b. Click Trig After Time.
c. To set the trigger delay, click in the Trig Delay entry box; then use the multipurpose knob or
pop-up keypad to set the time.
d. To set the B trigger level, click in the B Trig Level entry box; then use the multipurpose knob
or pop-up keypad to set the level.
5. To trigger on B events:
a. To set the time base to trigger after an A trigger and a specified number of B trigger events, click
Trigger on the toolbar; then open the A->B Seq tab of the Trigger Setup window.
b. Click Trig on nth Event.
c. To set the number of B trigger events, click in the Trig Event entry box; then use the multipurpose
knob or pop-up keyboard to set the number of events.
d. To set the B trigger level, click in the B Trig Level entry box; then use the multipurpose knob
or pop-up keypad to set the level.
6. To set up B Event triggering:
a. To set the B Event trigger, click Trigger on the toolbar; then open the B Event tab of the Trigger
control window.
b. To specify which channel becomes the B trigger source, click Source; then select the source
from the drop-down list.
c. Click Coupling, then select the trigger coupling to match your trigger signal.
d. To specify the direction of the edge, click a Slope button, positive or negative.
e. To set the B trigger level, click in the Level entry box; then use the multipurpose knob or pop-up
keypad to set the level.
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Trigger on A Event Only
NOTE. You can click Set 50% to set the B trigger level to the midpoint between the positive and
negative peak of the B trigger signal.

Trigger on A Event Only
Use the following trigger sequence to trigger the instrument after the A event has occurred:
1. Set the A Event Trigger Type and Source from the A Event tab in the Trigger control window.
2. Open the A->B Seq tab; then click the A Only button.

Trigger on an event after a specified delay
Use the following trigger sequence to trigger the instrument on the B event after a specified amount of
time after the A event:
1. Set the A Trigger Type and Source from the A Event tab in the Trigger control window.
2. Set the B Trigger Type and Source from the B Event tab.
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
3. Open the A->B Seq tab; then click Trig After Time.
4. Click in the Trig Delay entry box; then enter the trigger delay time between the A and B events.
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Trigger on a B Event

Trigger on a B Event
Use the following trigger sequence to trigger the instrument after a specified number of B events:
1. Set the A Trigger Type and Source from the A Event tab in the Trigger control window.
2. Set the B Trigger Type and Source from the B Event tab.
NOTE. For MSO70000C/DX Series instruments, when you select a Pattern or a State trigger as the B
Event, digital channels are not available.
3. Open the A->B Seq tab; then click Trig on nth Event.
4. Click in the Trig Event entry box; then enter the number of B events that should occur before starting
the acquisition after the A event.
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Trigger on a glitch

Trigger on a glitch
Use the following procedure to detect and trigger on a glitch, or to ignore a glitch:
1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event tab.
3. Select Glitch from the Trigger Type drop-down list.
4. Specify the trigger source. Click Source; then select a channel from the drop-down list.
5. Click a Polarity button to specify the glitch polarity:
Pos. Looks at positive-going pulses.
Neg. Looks at negative-going pulses.
Either. Looks at both positive and negative pulses.
6. To specify the width of the glitch, click in the Width entry box; then set the glitch width using the
multipurpose knob or keypad.
7. Select from the Glitch Width drop-down list to specify whether to trigger on glitches narrower or
greater than the width you specify:
Less Than. Trigger only on narrower pulses.
Greater Than. Trigger only on wider pulses.
8. Click in the Level entry box; then use the multipurpose knob, keypad, or front-panel Trigger Level
knob to set the level that the glitch must cross to be recognized by the instrument. You can also
set the level to a value appropriate to either the TTL or ECL logic families by selecting Logic in
the Trigger if Glitch drop-down list.
9. You can also Trigger on a logic-qualified pulse using the Trigger if Glitch "Logic" selection. When
the instrument detects that a glitch condition has occurred, it checks the logical state of two other
available channels and triggers only if their conditions are met. Each channel can have a value of high
(H), low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater
than the specified threshold voltage; a value is considered low if the channel input voltage is less
than the specified threshold voltage. Use the "don't care" selection for any channels that will not be
used as part of the pattern.
10. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

Trigger on a runt pulse
Use the following procedure to detect and trigger on a runt pulse. The instrument can look for positive or
negative runt pulses. These pulses can also be qualified by time or by the logical state of other channels.
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Trigger on a runt pulse

1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event tab.
3. Select Runt from the Trigger Type drop-down list.
4. Specify the trigger source. Click Source; then select a channel from the drop-down list.
5. Select a Polarity value to specify the direction of the runt pulse. Triggering occurs at the point the
pulse returns over the first threshold without crossing the second threshold level. The polarity selected
determines the order that the threshold must be crossed for a runt trigger to occur:
Pos. Looks at positive-going pulses. The lower threshold must be first crossed going positive, then
recrossed going negative without the upper threshold being crossed at all.
Neg. Looks at negative-going pulses. The upper threshold must be first crossed going negative,
then recrossed going positive without the lower threshold being crossed at all.
Either. Looks at both positive and negative pulses. Either one of the thresholds must be first
crossed going in either direction, then recrossed going in the opposite direction without the other
threshold being crossed at all.
For all three polarity settings, triggering occurs at the point the runt pulse recrosses its first
threshold.
6. To qualify the runt pulse trigger, click Runt; then select from the drop-down list:
Occurs. Triggers on all runt pulses.
Wider. Triggers only on runt pulses that exceed the minimum width that you set. Enter the Width
using the multipurpose knob or pop-up keypad.
7. To set the threshold levels, click in the Upper Limit or Lower Limit entry boxes; then use the
multipurpose knobs or pop-up keypad to set the values.
8. You can also Trigger on a logic-qualified runt pulse using the Trigger if Runt "Logic" selection. When
the instrument detects that a runt condition has occurred, it checks the logical state of two other
available channels and triggers only if their conditions are met. Each channel can have a value of high
(H), low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater
than the specified threshold voltage; a value is considered low if the channel input voltage is less
than the specified threshold voltage. Use the "don't care" selection for any channels that will not be
used as part of the pattern.
TIP. To use the trigger level marker to help in setting the threshold levels, open the Display control window
Objects tab; then click Long to activate the marker.
9. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.
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Trigger on a pulse width

Trigger on a pulse width
Use the following procedure to detect and trigger on a pulse that is either wider or narrower than the
specified range:
1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event tab.
3. Select Width from the Trigger Type drop-down list.
4. Specify the trigger source. Click Source; then select a channel from the drop-down list.
5. To specify the Polarity of the pulse, click Pos (for positive-going pulses) or Neg (for negative-going
pulses).
6. To set the range of pulse widths in units of time, click in the Upper Limit and Lower Limit entry boxes;
then enter values with the multipurpose knobs or pop-up keypad:
Upper Limit. This is the maximum valid pulse width the trigger source will look for.
Lower Limit. This is the minimum valid pulse width. The instrument will always force the Lower
Limit to be less than or equal to the Upper Limit.
7. In the Pulse Width drop-down list:
Select Inside to trigger on pulses that fall within the specified range.
Select Outside to trigger on pulses that are outside the range.
8. You can also Trigger on a logic-qualified pulse using the Trigger if Width "Logic" selection. When
the instrument detects that a width trigger condition has occurred, it checks the logical state of two
other available channels and triggers only if their conditions are met. Each channel can have a value
of high (H), low (L), or "don't care" (X). A value is considered high if the channel input voltage is
greater than the specified threshold voltage; a value is considered low if the channel input voltage is
less than the specified threshold voltage. Use the "don't care" selection for any channels that will not
be used as part of the pattern.
9. Click in the Level entry box; then use the multipurpose knob, pop-up keypad, or front-panel Level
control to set the trigger level.
10. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.
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Trigger on a pulse timeout

Trigger on a pulse timeout
Use the following procedure to detect and trigger on pulses longer than a specified time. The instrument
will trigger at the end of the timeout period.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Timeout from the Trigger Type drop-down list.
4. Specify the trigger source. Click Source; then select a channel from the drop-down list.
5. To set the trigger timeout level, click in the Level entry box; then use the multipurpose knob or
pop-up keypad to enter the voltage level.
NOTE. You can set the level to a value appropriate to either the TTL or ECL logic families by clicking TTL
or ECL on the Level pop-up keypad.
6. To set the timeout timer, click Timer, and then use the multipurpose knob or pop-up keypad to set the
time.
7. To set the pulse threshold, click one of the following:
Stay High. Triggers if the signal stays higher than the trigger level for longer than the timeout
(Timer) value.
Stay Low. Triggers if the signal stays lower than the trigger level for longer than the timeout
(Timer) value.
Either. Triggers if the signal stays lower or stays higher than the trigger level for longer than
the timeout (Timer) value.
8. You can also Trigger on a logic-qualified pulse using the Trigger if Timeout "Logic" selection. When
the instrument detects that a timeout condition has occurred, it checks the logical state of two other
available channels and triggers only if their conditions are met. Each channel can have a value of high
(H), low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater
than the specified threshold voltage; a value is considered low if the channel input voltage is less
than the specified threshold voltage. Use the "don't care" selection for any channels that will not be
used as part of the pattern.
9. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.
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Trigger on a pattern

Trigger on a pattern
Use the following procedure to trigger the instrument when the logic inputs cause the selected function
to become True or False. You can also specify that the logic conditions must be satisfied for a specific
amount of time before the instrument triggers.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Pattern from the Trigger Type drop-down list.
4. Select a value from the Input Threshold drop-down list for each channel. The channel inputs combine
to form a logic pattern. Each channel can have a value of high (H), low (L), or "don't care" (X). A
value is considered high if the channel input voltage is greater than the specified threshold voltage. A
value is considered low if the channel input voltage is less than the specified threshold voltage. Use
the "don't care" selection for any channels that will not be used as part of the pattern.
5. To set the Input Threshold voltages, click one of the Threshold Presets buttons to define the level type.
If you selected USER, click in the Ch <1–4> entry boxes, and then use the multipurpose knobs or
pop-up keypad to set each threshold.
6. Select the Pattern Type Boolean logic function for the combination of input channels. The instrument
will trigger on a clock edge when the input waveforms match the specified logic pattern.
NOTE. See Pattern Triggers (see page 653) for definitions of the logic functions for pattern triggers.
7. From the Pattern drop-down list, select True to trigger the instrument when the logic patterns are true.
Select False to trigger the instrument when the logic patterns are false.
8. You can time qualify a pattern logic trigger, that is, you can specify the amount of time the Boolean
logic function must be True:
NOTE. On MSO/DPO5000B Series instruments, < or > are used instead of Less than or More Than
from the Pattern drop-down list.
a. Select Less than or More Than from the Pattern drop-down list.
b. Under Pattern, click in the Time entry box, and then use the multipurpose knob or keypad to
set the time.
NOTE. When you select Less Than and specify a time, the input conditions must drive the logic
function true for less than the specified time. Conversely, the true for More Than item requires the
Boolean function to be true for longer than the time you specify.
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Trigger on a pattern
The instrument determines the trigger point in the following manner:
It waits for the logic condition to become True.
It starts timing and waits for the logic function to become False.
It compares the times and, if the time True is longer (More Than Time) or shorter (Less Than
Time), then it triggers a waveform display at the point the logic condition became False. This
time can be, and usually is, different from the time set.

9. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

Pattern triggers
A pattern trigger occurs when the inputs to the selected logic function cause the function to become
True or False. When you use a pattern trigger, you define:
The precondition for each logic input: logic high, low, or "don't care"; the logic inputs are the
instrument channels
The Boolean logic function: AND, NAND, OR, or NOR
The condition for triggering: the Boolean function becomes True (logic high) or False (logic
low), and whether the True condition is time qualified
Pattern trigger logic choices are summarized in the following table.
Pattern

State

Definition 1, 2

AND

Clocked AND

If all the preconditions selected for
the logic inputs 3 are TRUE, then the
instrument triggers.

NAND

Clocked NAND

If not all of the preconditions
selected for the logic inputs 3 are
TRUE, then the instrument triggers.

OR

Clocked OR

If any of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

NOR

Clocked NOR

If none of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

xxx

1
2
3

For state triggers, the definition must be met at the time the clock input changes state
The definitions given here are correct for the Goes TRUE setting in the Trigger When menu. If that menu is set to Goes False, swap the
definition for AND with that for NAND and for OR with NOR for both pattern and state types.
The logic inputs are channels 1, 2, 3, and 4 when using Pattern triggers. For State triggers, channel 4 becomes the clock input, leaving
the remaining channels as logic inputs.
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Trigger on a logic state
Use the following procedure to trigger the instrument when all of the logic inputs to the selected logic
function cause the function to be True or False when the clock (channel 4) input changes state.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select State from the Trigger Type drop-down list.
4. Select a value from the Input Threshold drop-down list for each data channel. The channel inputs
combine to form a logic pattern. Each channel can have a value of high (H), low (L), or "don't care"
(X). A value is considered high if the channel input voltage is greater than the specified threshold
voltage. A value is considered low if the channel input voltage is less than the specified threshold
voltage. Use the "don't care" selection for any channels that will not be used as part of the pattern.
NOTE. Channels 1, 2, and 3 represent the data inputs. Channel 4 should be connected to the clock signal.
5. Select either the POS (rising) or NEG (falling) edge for the Clock Channel (Channel 4).
6. To set the Input Threshold voltages, click one of the Threshold Presets buttons to define the level type.
If you selected USER, click in the Ch <1–4> entry boxes, and then use the multipurpose knobs or
pop-up keypad to set each threshold.
7. Select the Pattern Type Boolean logic function for the combination of input channels. The instrument
will trigger on a clock edge when the input waveforms match the specified logic pattern.
NOTE. See Pattern Triggers (see page 653) for definitions of the logic functions for pattern triggers.
8. In the Trigger if Logic State drop-down list, select True to trigger the instrument when the logic
patterns are true. Select False to trigger the instrument when the logic patterns are false.
TIP. For simplest operation, leave this control set to True. Setting the control to False complements the
output of the chosen pattern function (for example, from AND to NAND or NOR to OR).
9. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

654

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

How to ?

Trigger on the transition time

Trigger on the transition time
Use the following procedure to detect and trigger on pulse edges that traverse between two thresholds
at faster or slower rates than the specified time. You can set up the instrument to trigger on positive or
negative edges.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Transition from the Trigger Type drop-down list.
4. Specify the trigger source. Click Source; then select a channel from the drop-down list.
5. Click a Polarity button to specify the direction of the pulse edge:
Pos. Monitors the transition time (slew rate) of the positive-going edges of pulses. The edge must
first cross the lower threshold and then cross the upper threshold.
Neg. Monitors the transition time (slew rate) of the negative-going edges of pulses. The edge
must first cross the upper threshold and then cross the lower threshold.
Either. Monitors positive- and negative-going edges of pulses. The edge may first cross either
threshold and then cross the other.
6. The threshold levels and the delta time setting determine the transition time (slew rate) setting. The
level settings determine the voltage component of slew rate (Volts/Second). Click in the Upper Level
or Lower Level entry boxes; then use the multipurpose knobs or pop-up keypad to set the values for
the upper and lower levels.
NOTE. You can set the level(s) to a value appropriate to either the TTL or ECL logic families by clicking
TTL or ECL on the Level pop-up keypad.
TIP. To use the trigger level marker to help in setting threshold levels, open the Display control window
Objects tab; then click Long to activate the marker.
7. To finish specifying the slew rate (transition time), set the time component by clicking in Time entry
box; then use the multipurpose knob or keypad to set the delta time value.
8. In the Transition drop-down list:
NOTE. On MSO/DPO5000B Series instruments, < or > options are available instead of Less Than or
Greater Than.
Click Less Than to trigger when the transition time is less than the time you set above.
Click Greater Than to trigger when the transition time is greater than the time you set above.
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NOTE. If you select Transition Greater Than, and the instrument does not trigger, the pulse edge may
be too fast. To check the pulse edge speed, switch to edge triggering. Trigger on the pulse edge and
determine the time the edge takes to travel between the upper and lower levels that you set for this
trigger. The instrument cannot transition trigger on pulse edges that traverse between threshold
levels in 600 ps or less.
Also, to reliably trigger on transition time, a pulse must have a width of 7.5 ns or more. A pulse of less
width may trigger on the wrong slope or not trigger at all. Switch to edge triggering, and check the
pulse width if you cannot trigger on transition time as expected.

9. You can also Trigger on a logic-qualified pulse using the Trigger if Violation "Logic" selection. When
the instrument detects that a transition violation has occurred, it checks the logical state of two other
available channels and triggers only if their conditions are met. Each channel can have a value of high
(H), low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater
than the specified threshold voltage; a value is considered low if the channel input voltage is less
than the specified threshold voltage. Use the "don't care" selection for any channels that will not be
used as part of the pattern.
10. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

Trigger on setup/hold time violations
Use the following procedure to detect and trigger on setup and hold time violations. The setup and hold
times define a violation region relative to a clock. Data is considered to be invalid in the violation region.
1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event tab.
3. Select Setup/Hold from the Trigger Type drop-down list.
4. Specify the channel that is connected to the data signal. Click Source; then select a channel from the
drop-down list.
5. Specify the channel that is connected to the clock signal. Click Clock Source; then select a channel
from the drop-down list.
NOTE. Do not select the same channel for both the data and clock sources.
6. The Clock Edge determines whether the instrument finds the trigger point on the rising edge or the
falling edge of the clock signal. Click a Clock Edge button.
7. To set the data transition level, click in the Data Level entry box, and then use the multipurpose
knobs or pop-up keypad to set the value.
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8. The instrument uses the clock level to determine when a clock edge occurs; the point that the clock
crosses the clock level is the reference point from which it measures setup and hold time settings.
To set the clock threshold level, click in the Clock Level entry box, and then use the multipurpose
knobs or pop-up keypad to enter a value.
NOTE. Both Clock and Data Levels can be set to a value appropriate to either the TTL or ECL logic
families by clicking TTL or ECL on the Data Level or Clock Level pop-up keypads.
9. To set the setup time relative to the clock, click in the Setup Time entry box, and then use the
multipurpose knob or pop-up keypad to enter a value.
10. To set the hold time relative to the clock, click in the Hold Time entry box, and then use the
multipurpose knob or pop-up keypad to enter a value.
NOTE. Positive setup time always leads the clock edge; positive hold time always follows the clock edge.
Setup time always leads the hold time by at least 2 ns (TS + TH ≥ 2 ns). Attempting to set either time to
reduce the 2 ns limit adjusts the other time to maintain the limit. In most cases, you will enter positive
values for both setup and hold time. Positive values set the instrument to trigger if the data source is still
settling inside the setup time before the clock or if it switches inside the hold time after the clock. You can
skew this setup/hold violation zone by entering negative values as shown below.
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11. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.
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Set up and hold violation trigger

Trigger on window threshold violations
Use the following procedure to trigger the instrument when the input signal rises above an upper threshold
level or falls below a lower threshold level.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Window from the Trigger Type drop-down list.
4. To specify which channel becomes the trigger source, click Source; then select a channel from the
drop-down list.
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5. The upper and lower threshold levels define the voltage limits of the window. To set the threshold
levels, click in the Upper Level or Lower Level entry boxes, and then use the multipurpose knobs
or pop-up keypad to enter the values
6. To qualify the window trigger, select from the Window Event drop-down list combinations. The
Window Event controls change as you select different combinations of options:
Enter Window and Occurs or Exits Window and Occurs. Triggers the instrument when the signal
enters (or leaves) the window defined by the threshold levels.
Inside > t and Occurs or Outside > t and Occurs. Triggers the instrument when the signal enters
(or leaves) the window defined by the threshold levels for the time specified by Width.
Inside > t and Logic or Outside > t and Logic. When the instrument detects a signal entering or
leaving the window defined by the threshold levels, it checks the logic state of up to two other
available channels and triggers only if their conditions are met. Each channel can have a value of
high (H), low (L), or "don't care" (X).
A value is considered high if the channel input voltage is greater than the specified threshold voltage; a
value is considered low if the channel input voltage is less than the specified threshold voltage. Use
the "don't care" selection for any channels that will not be used as part of the pattern.
7. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

Trigger on a video signal
Use the following procedure to detect and trigger on a video signal. Only composite signal formats are
supported. Graphic display formats such as RGB and VGA are not supported.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Video from the Trigger Type drop-down list.
4. To specify which channel becomes the trigger source, click Source; then select a channel from the
drop-down list.
5. Select a signal format from the Format drop-down list:
If using a preset format, click the Lines and Fields Autoset buttons to optimize the instrument for
viewing the fields or lines for your chosen format
If you select the Custom signal format, no Autoset options are available. You must set the Scan
Type (Interlaced or Progressive) and Scan Rate.
Custom scan rates enable you to trigger on nonbroadcast video signals that have unique scan rates.
Select the scan rate that includes your signal.
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6. Select a value from the Trigger On drop-down list to specify where the trigger will occur on the
video signal:
Field. Use the drop-down list to select either Odd, Even, or All.
All Lines. The trigger will occur on any and all lines.
Line #. Use the multipurpose knob or pop-up keypad to set the line number. Line numbers wrap
when their limits are reached. The range of line numbers depends on the format.
7. Specify the Holdoff from the drop-down list, By Time or By Fields, then use the multipurpose knob to
change the value. If setting a Custom format, only the By Time control is available.
8. Select the Polarity:
Normal. Generally triggers on negative polarity, since the sync pulse leading edge is negative
for most standard formats.
Inverted. Use when probing circuitry that inverts the video signal.
9. You can set the mode and holdoff for all standard trigger types. Refer to trigger mode (see page 397)
and set holdoff (see page 482) to learn more about trigger mode and holdoff.

Trigger on a communication signal
Use the following procedure to set up the instrument to trigger on a communication signal:
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.
1. Push the front-panel Advanced button.
2. In the Trigger control window, Open the A Event tab.
3. Select Comm from the Trigger Type drop-down list.
4. To specify the trigger source, click Source; then select a channel from the drop-down list.
5. Select Clock or Data from the Type drop-down list. If you select Clock, you will also need to select
the polarity.
6. Select the Coding format for triggering on a communication signal and the Standard to use with
the coding format. The coding format determines which standards are available as well as other
parameters, such as trigger threshold and pulse form. The standard sets the bit rate. Changing the bit
rate will change the Standard to Custom.
7. Depending on the coding format, you may also need to set the Pulse Form and Threshold Level.
8. Follow the Setting up Mask Testing (see page 617) procedure to select the communications mask
you want to use.
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Trigger on a bus
NOTE. Triggering on a serial bus may require an option on your instrument.
Use the following procedure to set up the instrument to trigger on a parallel or on a serial bus:
1. Push the front-panel Advanced button.
2. In the Trigger control window, open the A Event tab.
3. Select Bus from the Trigger Type drop-down list.
4. Select if the Settings are to be Shared or Independent.
5. Select the Bus to trigger on from the drop-down list.
The type of bus displays below the bus selection.
6. Select the condition in the Trigger On field.
Depending on the Trigger On and Bus selections, make the other selections and settings required by
your bus, such as disparity, symbols, data and address format, payload length, and trigger when.

Mark all trigger events
Use the following procedure to set up the instrument to mark all trigger events:
1. From the Trigger menu, select A-Event (Main) Trigger Setup.
2. In the Trigger control window, open the A Event tab.
3. Select a trigger type such as Edge from the Trigger Type drop-down list.
4. Set up your trigger as desired.
5. Click Mark All Trigger Events in Record.

6. The instrument searches for and marks all similar events that meet the trigger requirements. The
results of the search are shown as marked events on screen, and they can also be viewed in the Results
tab of the Mark Table.
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7. From the Analyze menu select Search, and then select the Results tab. The results of the search are
displayed and will include the visual trigger area.

8. You can also add a visual trigger area. See Visual Trigger Setup (see page 467)
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9. The results of the edge trigger and the visual trigger are also displayed in the search results.

NOTE. Mark All Trigger Events in Record is not available with some trigger types.
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Set up a histogram
Use the following steps to set up a histogram:
1. From the Measure menu, click Waveform Histograms to open the Waveform Histogram Setup window.
2. Use the Channels Selector (see page 264) to select the waveform, and then use the other instrument
controls to position the waveform in the center of the screen.
3. Use the Histogram Mode controls to turn on the histogram, click either Horiz or Vert.
4. Under Adjust Histogram Box, click Location.
5. Click in an X Position or Y Position entry box; then use the multipurpose knobs to position the
histogram box over the area of interest on the waveform.
6. Under Adjust Histogram Box, click Limits.
7. Click in a Left/Right Limit or Top/Bottom Limit entry box; then use the multipurpose knobs to adjust
the size of the histogram box.
8. Select the type of scaling by clicking either Linear or Log under Histogram Scaling.
TIP. Click the waveform handle to select the waveform (see page 910). Hold the left mouse button and
drag across the segment of the waveform that you want the histogram to cover; then select Histogram from
the pop-up list on the screen.
Taking Automated Measurements on Histogram Data. (see page 665)

Take automated measurements on histogram data
Use the following steps to take automatic measurements on histogram data:
1. Set up a histogram box over the waveform on the screen.
2. Open the Measurement Setup control window, and then select the Histogram tab.
3. Click the histogram measurement buttons to add the measurements to the display readouts list.
Setting up a Vertical Histogram. (see page 665)
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Start or Reset histogram counting
Use this procedure to quickly take a measurement based on the default settings for histograms:
1. Display the waveform(s) to be measured on the screen.
2. From the Measure menu, click Waveform Histograms to open the Waveform Histogram Setup window.
3. Use the Channels Selector (see page 264) to select the waveform, and then use the other instrument
controls to position the waveform in the center of the screen.
4. Click a Histogram Mode button to start histogram counting and display the histogram data:
Horiz. Displays a horizontal histogram that shows how time varies in the histogram box.
Vert. Displays a vertical histogram that shows how your vertical units vary in the histogram box.
Off/On. Turns histogram counting and the display on or off.
NOTE. You can only display one type of histogram at a time. Horizontal histograms have a maximum
of 1000 bins while, vertical histograms have a maximum of 252 bins.
5. Click a Histogram Scaling option:
Linear. Displays histogram data linearly. Bin counts smaller than the maximum counts are scaled
linearly by dividing the bin count by the maximum bin count.
Log. Displays histogram data logarithmically. Bin counts smaller than the maximum counts are
scaled logarithmically. Logarithmic scaling provides better visual details for bins with low counts.
6. Click Adjust Histogram Box Limits, and then use the Top Limit, Bottom Limit, Left Limit, and
Right Limit controls to set the size of the histogram box. The histogram box selects the section of
the waveform used for histograms.
7. Click Adjust Histogram Box Location, and then use the X Location and Y Location controls to set the
location of the histogram box.
8. Click Reset to reset the histogram count. Histograms track numbers of counts. Clicking Reset resets
those counts to zero and begins counting from zero.
9. Click Display to toggle the display of the selected histogram on and off.
TIP. To clear histogram data, right-click in the display area, and then select Clear Data from the short
cut menu.

Display a waveform
This procedure demonstrates the display adjustments you can make.
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1. Connect a signal to an input channel (see page 57).
2. Press Run on the front-panel.
3. Push the Ch <1–4> button for the channel that has the signal connected to it.
4. Adjust the front-panel vertical controls to achieve a good display of the waveform.
5. Use the front-panel horizontal knobs to adjust the Scale and Position of the waveform and to set
the sample Resolution.
NOTE. The Resolution knob also sets the record length. (See Horizontal Acquisition Window Interrelated
Parameters (see page 688) for details.)
6. Push the Level knob (Set 50%) if required to stabilize the display.
7. To adjust the point around which the waveform expands and contracts, click on the horizontal
reference marker (see page 45), and drag it along the horizontal axis until it aligns to the point on the
waveform that you want to be stationary on screen.
NOTE. If horizontal delay is off, the horizontal reference point is the same as the horizontal position.
8. Release the Horizontal Reference, and then adjust the Horizontal Scale to expand or contract the
waveform.

Set up XY display format
Use the following steps to set up the instrument in XY Display format:
1. Determine the waveform pairs (see page 175) you want to display.
2. Click Display in the toolbar, or select Appearance in the Display menu.
3. In the Display control window, open the Appearance tab.
4. Under Format, click the XY button.
5. Use the vertical scale and position controls of the waveform connected to the X-axis source to set
horizontal scale and position of the XY waveform.
6. Use the vertical scale and position controls of the waveform connected to the Y-axis source to set
vertical scale and position of the XY waveform.
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Use MultiView Zoom with waveforms
The instrument must be installed and operating, with a signal connected to an input channel, and the
horizontal and vertical controls and triggering set up.
1. Obtain a stable display of the waveform to be measured.
2. Click and drag across the segment of the waveform that you want to see in greater detail.
3. Select Zoom <1–4> On from the shortcut menu to magnify the highlighted waveform segment.
NOTE. The instrument displays the zoomed area of the waveform as magnified in the bottom graticule. You
can also press the front-panel MultiView Zoom button to split the screen and add a zoom graticule.
4. To zoom on multiple areas, repeat steps 2 and 3.
5. Push the front-panel MultiView Zoom button to select the axis you want to focus on in the zoom
graticule. The Zoom control window opens, if it is not already present.
NOTE. If zoom is on but the readouts are not attached to the zoom controls, press the MultiView Zoom
button to attach the readouts to the zoom controls. Press the MultiView Zoom button again to turn zoom off.
6. To select the waveform you want to scale or position, press the Horiz and Vert buttons.
7. Select the Channel (Ch), Math, or Reference (Ref) waveform from the drop-down list.
8. Use the multipurpose knobs to adjust the Position and Factor of the zoomed waveform. Note that as
you adjust the factor or position, the instrument adjusts the Zoom box relative to the unmagnified
waveform.
9. Click Setup in the Zoom control window to open the Zoom Setup control window.
10. To change the size of the unmagnified (Acquisition) and Zoom windows, select one of the following
from the Graticule Size drop-down list:
50-50. Allocates half of the available display for the zoomed graticule and half of the available
display for the acquisition window.
80-20. Allocates 80% of the available display for the zoomed graticule and 20% for the
acquisition window.
Full. Uses the entire display for the zoomed graticule.
11. Click the Lock and Scroll tab to select a zoom lock and scroll setting:
To scroll a single zoomed area, click Zoom <1–4>, and then click an AutoScroll button.
To scroll multiple zoomed areas simultaneously, click Lock, and then click the Zoom <1–4>
buttons you want to scroll through.

668

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

How to ?

Choose a color palette

12. To quickly determine the magnification factor and position of a zoomed waveform, check the controls
on the appropriate tab (Horizontal or Vertical) of the Zoom Setup control window.
13. To reset all Zoom settings to their defaults, click the Position Factor Reset button in the Zoom Setup
control window.

Choose a color palette
Use the following information to help you select a color palette:
1. Select Colors In the Display menu, or click Display in the toolbar.
2. Open the Colors tab.
3. Under Record View Palettes or FastAcq/WfmDB Palettes, click a button to select a palette for your
application. Use the following criteria:
Normal. Use this palette to display hues and lightness levels for best overall viewing. Every
waveform has its own color: shades of yellow for channel one; shades of blue for channel two,
shades of pink for channel three, shades of green for channel four.
Green. Use this palette to display waveforms and the graticule style in shades of green. The
Green palette simulates the display of an analog oscilloscope. Areas of the waveform with the
highest sample density appear in lighter shades while the areas of lower sample density appear in
darker shades.
Gray. Use this palette to display waveforms and the graticule in shades of gray. Areas of the
waveform with the highest sample density appear in lighter gray shades, while areas of the
waveform with lower sample density appear in darker gray shades.
Temp. Use this (temperature) palette to display variable persistence style waveforms. Areas of the
waveform with the highest sample density appear in warmer colors (red shades), while areas of the
waveform with lower sample density appear in cooler colors (blue shades). This palette is best
suited for seeing detail within a single waveform.
Spectral. Use this palette to display variable persistence style waveforms. Areas of the waveform
with the highest sample density appear in blue shades, while areas of the waveform with lower
sample density appear in red shades. This palette is best suited for seeing detail within a single
waveform.
User. Use this palette to select a color previously defined for the User palette.
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NOTE. To define a custom color for the User palette, click the Edit button and follow the steps to Customize
Color Palettes (see page 805).

Customize the display palette
From the Display menu, select User Palette, or click the Edit button in the Colors tab of the Display
control window.

Overview
Use this control window to customize the color of your waveform display.

To use
1. Click the Source drop-down list to select the waveform for which you want to change the color.
2. Select HLS from the Wfm Palette drop-down menu; then click in the Hue, Saturation, or Lightness
entry boxes and use the multipurpose knobs to adjust the percentage of each of these attributes.
3. If you prefer:
Select Temp (Temperature Grading) from the Wfm Palette menu to define areas of the waveform
with the highest sample density to appear in warmer colors (red shades) while the areas of lowest
sample density appear in cooler colors (blue shades).
Select Spectral (Spectral Grading) from the Wfm Palette menu to define areas of the waveform
with the highest sample density to appear in blue shades while the areas of lowest sample density
appear in red shades.
4. Click the Reset button to return the User palette to the default, if desired.
To activate the Display Setup Control Window, click the Setup button.

Behavior
Increasing the hue value changes the color to blue tones. Decreasing the hue value changes the color to red
tones. For best viewing, set the lightness to 50. Higher numbers tend to wash out the color and lower
numbers can darken the color and make it difficult to see. Lower saturation values reduce the amount of
color displayed in the waveform. Higher saturation values increase the amount of color.
What do you want to do next?
Learn about changing the display colors. (see page 172)
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Learn about changing the overall display appearance. (see page 167)
Learn about the display persistence. (see page 173)
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Save the instrument setups
Use the following procedure to save the current setup to oscilloscope memory:
1. Use the instrument controls to set up the instrument for your application.
2. From the File menu, highlight Save As; then select Setup from the submenu.
3. In the Save As dialog box, select one of the 10 locations under Save in Oscilloscope Memory.
4. In the Save in drop-down list, specify where to save the setup.
5. In the Name list box, enter a name for the setup, use the default name, or select Auto-increment file
name (see page 391) if you want to save a series of files without typing in a new name each time.
6. Click Save.
7. Click OK to overwrite an existing instrument setup, if desired.
NOTE. The data in reference waveforms is not saved with the instrument setups. However, the setup
information includes which reference waveforms are turned on and which are used with math waveforms
and automatic measurements. If you want to save the reference waveform data, save the reference
waveform separate from the instrument setup.
Further note that user preferences and GPIB configurations are not stored with instrument setups, and are
not affected by the front panel Default Setup button.
Creating Reference Waveforms. (see page 632)

Recall an instrument setup
Use this procedure to recall a saved instrument setup:
1. From the File menu, select Recall.
2. In the Recall dialog box, click the Setup icon.
3. Navigate to the location where you saved the setup file
4. Select the setup, then click Recall.
NOTE. The data in reference waveforms is not saved with instrument setups. However, the setup
information does include which reference waveforms are turned on and which are used with math
waveforms and automatic measurements. If you want to save the reference waveform data, save the
reference waveform separate from the instrument setup. You can then recall the saved waveform to the
restored setup.
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Delete instrument setups
Use this procedure to delete all instrument setups previously saved to the oscilloscope memory.
1. From the File menu, highlight Delete; then select All Setups from the submenu.
2. In the resulting Delete all setups? dialog box, click Yes.
Use the following procedure to delete an instrument setup previously saved to a Windows directory.
1. From the File menu, select Recall.
2. In the Recall dialog box, click Setup.
3. Navigate to the directory where the setup was saved
4. Select the setup.
5. Click the

next to the directory.
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GPIB Programmer online help

GPIB Programmer online help
You can control the instrument via GPIB from a remote PC, or from an Internet or Intranet connection.
GPIB programming information is available as a separate file you can install. See the instructions in the
product software DVD booklet.

Oscilloscope applications software
You can install and run optional application software packages on the instrument. These software packages
provide advanced capabilities that support several applications, such as jitter analysis and disk drive
measurements.
Each application can be purchased and installed on the instrument at any time. Contact your Tektronix
representative for purchasing information. Follow the installation instructions that come with the
application.
To open your application software on the instrument, click Analyze in the menu bar, and then select
the application to run.
NOTE. Application software packages have their own online help that is separate from the main instrument
online help.

Add a software application to the instrument
Because the instrument is an open Windows platform, you can easily install and remove additional
software applications. Follow the instructions that came with your software and the basic Windows
instructions to install and remove your application.
NOTE. When adding software to the instrument, avoid making changes to system files. See Windows
Interface (see page 25) for more information.

Set up a dual display
Use the following steps to set up the instrument for dual display operation. You can use the main display
for most instrument operations while you use a second monitor to access other PC applications that
you may have installed.
You can also drag up to five dockable control windows from the TekScope application onto the display
of the second monitor.
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Set up a dual display

For example, this feature allows you to have the Horizontal/Acquisition, the Horizontal Zoom, and the
Display Setup Control Windows (half screen) open on the second monitor at the same time.
In addition to the five dockable windows on the second monitor, you can have one dockable window open
on the main display. If you open a seventh dockable window, whichever window has not been used for the
longest amount of time will automatically close.
TIP. You may want to print this procedure since it requires you to power off the instrument.
1. Power off the instrument.
2. Connect an external monitor to a video port on the instrument.
3. Connect a keyboard and mouse.
4. Power on the instrument and external monitor.
5. After the instrument display appears, click Minimize in the File menu or press CTRL+M to minimize
the instrument application.
6. Right-click on the desktop and select Properties to open the Display Properties dialog box.
7. Open the Display Devices tab to define the Operating Mode and Display Selection of the monitors.
8. In the Display Selection drop downs, set the Primary Device to Notebook, and set the Secondary
Device to Monitor.
9. In the Operating Mode drop down, select Extended Desktop.
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NOTE. Do not change the display settings for the internal monitor. The display settings must be 1024
x 768 pixels and colors must be set to 32-bit color. Ensure that the second monitor is also set to 32-bit
color. If you use other instrument display settings, the video port may not work properly. However, you can
use a resolution setting other than 640 x 480 on the second monitor.
10. Click Apply.
11. Click OK.
12. Click OK.
13. Drag any item, except for the instrument application, from the desktop of the instrument to the new
monitor. You can also drag the task bar.

Enable a network connection
Use the following steps to enable network access to the instrument. You must begin this procedure with
the instrument powered off.
TIP. You may want to print these instructions before you proceed.
1. Attach a keyboard and mouse to the instrument.
2. Power on the instrument.
3. Use the Windows Network Connection Wizard to define the instrument as a network client and
configure it for your network. You can find the network setup program in the Windows Start menu if
you select Settings > Control Panel, and then double-click Network Connections.
4. Consult with your network administrator for specific instructions for these settings.

Exit the instrument application
From the File menu, click Exit to quit the instrument application or click the
corner of the screen.

icon in the upper-right

To restart the instrument application, launch the TekScope icon from the Windows taskbar, Start menu,
or your desktop.

Minimize the instrument application
To temporarily close the TekScope application (so you can use other Windows programs):

676

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

How to ?

Shut down the instrument
Select Minimize from the File menu.
Right-click anywhere in the graticule and select Minimize from the shortcut menu.
Click the

button in the Menu bar.

To restore the application, click the TekScope icon in the Windows taskbar.

Shut down the instrument
When you push the front-panel On/Standby switch (see page 899), the instrument starts a shutdown
process (including a Windows shutdown to preserve settings) before it goes into standby mode. Avoid
disconnecting the power cord to shut down the instrument.
NOTE. It may be necessary to hold the On/Standby switch for up to 20 seconds for the shutdown process
to initiate.
To completely remove power to the instrument, perform the shutdown process described above, and then
disconnect the power cord from the power source.

Adjust the display contrast
If you find that the instrument screen is too bright or too dark, use these steps to adjust the LCD display
contrast to your preference. You need to have a mouse attached to perform this procedure.
1. Right-click on the Windows desktop.
2. Select Properties.
3. Select the Settings tab.
4. Click Advanced.
5. Select the Color tab.
6. Adjust slider controls for desired contrast.
7. Click OK to apply.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

677

How to ?

678

Adjust the display contrast

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Functional model

Functional model
The instrument has four high-level subsystem processes, consisting of both hardware and software
functions, and the data that connects them.

Digital signal acquisition system
This system acquires a waveform record from each input signal you probe. This system consists of the
following subsystems:
Input Channels. Condition the input signal, primarily through the use of analog hardware, before
converting the signal to a digital format.
Trigger System. Recognizes a specific event of interest on the input signal and informs the Time base
system of the occurrence of the trigger event
Time base System. Triggers the Acquisition system to start an acquisition cycle. In more general
terms, synchronizes the capturing of digital samples in the Acquisition system to the trigger events
generated from the Trigger system.

Acquisition system
This system converts and stores the analog signal to a digital format.

Signal processing and transformation
This system performs transformations or operations on user-specified waveform data (channel, reference,
and/or math waveforms). Automatic measurements, spectral waveforms, and histogram generation are
examples of signal processing and transformation.

Display and UI
This system provides output (and sometimes input) of instrument-data elements in a form suitable to the
user and also provides user input control.
What do you want to do next?
Learn about a process overview of the instrument operation. (see page 680)
Learn about the Acquisition System. (see page 685)
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Process overview

Learn about the Display. (see page 718)

Process overview
1. The instrument starts in the idle state; it enters this
state at power on, upon receiving most control setting
changes, or on finishing acquisition tasks.
2. Control settings are implemented as they are requested.
When you toggle the Run/Stop control to Run, the
instrument starts the hardware.
3. The instrument acquires samples until the pretrigger
portion of the waveform record (channel) being acquired
is filled.
4. The instrument then begins looking for a trigger.
Acquiring continues to take place, keeping the pretrigger
points current, until triggering criteria are met or a trigger
is forced (Auto trigger mode only). The instrument
accepts the trigger.
5. The instrument acquires samples until the posttrigger
portion of the waveform record (channel) being acquired
is filled.
6. If averaging or enveloping is on, the record becomes
part of the multi-acquisition record that these modes
produce. The process loops back to step 3 to acquire
additional records until the number of acquisitions
required for the acquisition mode currently set are
processed, and then processing continues to step 7.
7. At this point, the acquisition record is in memory and
is available to the instrument for measurement of its
parameters, display, and so on.
8. The instrument then checks for a user-specified stop
condition and either returns to its idle state or continues
at step 3, according to what it finds.
xxx

Keep in mind that this instrument samples in real time or random equivalent time; both sampling systems
provide pretrigger information by using the trigger to stop an already running acquisition. Both sampling
systems also sample the input after it is scaled, providing improved input protection and dynamic range.
What do you want to do next?
Learn about the Acquisition System. (see page 685)
Learn more about triggering. (see page 696)
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Signal connection

Signal connection
This diagram displays the signal connection model for each input channel.

What do you want to do next?
Learn more about coupling. (see page 684)
Learn more about the vertical acquisition system. (see page 685)

Probes and signal connection
Select the probe or cable that brings the signal into the instrument. Choose the probe or cable that best fits
your acquisition task, whether it is connecting an active probe to test a digital circuit, or connecting to a
test fixture through BNC cables to characterize a device. The connection to the instrument depends on
your application.
Up to four acquisition channels are available. You can display each channel as a waveform or use the
channel data to create other waveforms, such as math and reference waveforms.
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Tektronix provides a variety of probes and cables for this product. You can also check your Tektronix
catalog for connection accessories to support your probing requirements.
For more information about a particular probe, read the documentation that came with that probe.
What do you want to do next?
Get a list of compatible probes. (see page 6)

Input conditioning
You can use input conditioning to ensure that the instrument acquires the best possible data for processing.
Set the Vertical scale (see page 938) to control the size of the vertical acquisition window for each
channel to capture all or part of the input signal vertical amplitude. When vertical scaling is set to
capture a fraction of the input signal (to increase detail), the vertical offset control determines which
part of the input signal is captured by the vertical acquisition window. (See note.)
Set the Horizontal scale (see page 835) to control the size of the horizontal acquisition window to
capture as much as you want of the input signal(s). Set the horizontal position to change the trigger
position or to delay the window relative to a trigger event and to control where in the input signal (data
stream) that the horizontal acquisition window acquires. (See note.)
For additional information on how to use the acquisition windows, refer to the following:
Vertical Acquisition Window Considerations (see page 685)
Horizontal Acquisition Window Considerations (see page 688)
The instrument can automatically obtain and display a stable waveform of usable size. Push the Autoset
button to automatically set the instrument controls based on the characteristics of the input signal. Autoset
is much faster and easier than a manual control-by-control setup.
The instrument can also be reset to its factory default settings by pushing the front-panel Default Setup
button.
Use of some input conditioning controls or features may be limited when other control settings are in
effect. Voltage offset is incompatible with reference waveforms because offset is an acquisition control
for live waveforms (channels), not stored waveforms (reference).
NOTE. The terms vertical acquisition window and horizontal acquisition window refer to the vertical
and horizontal range of the segment of the input signal that the acquisition system acquires. The terms
do not refer to any display windows on screen.
What do you want to do next?
Learn more about Autoset. (see page 691)
Learn about horizontal acquisition interrelated parameters. (see page 688)
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Bandwidth enhancement
Bandwidth enhancement is a DSP implemented FIR filter that flattens the oscilloscope frequency response,
and makes the phase response more linear. This results in better matching of channel responses and better
signal fidelity. On some oscilloscope models, the bandwidth may be extended beyond what the analog
channel exhibits, while other models provide no bandwidth extension but use the enhanced filter to reduce
noise and provide better signal fidelity.

Bandwidth filtering
The bandwidth enhancement (BW) filter reduces noise and alias magnitudes in the frequency range of the
stop band below and above the Nyquist frequency. In oscilloscopes that do not extend the bandwidth,
overall noise is reduced when the filter is on. In oscilloscopes that incorporate a small amount of
bandwidth extension, the filter increases noise at frequencies just above the transition band but decreases
noise at frequencies in the stop band and the aliased stop band. The overall amount of noise with the filter
on may be more or less depending on the oscilloscope model and the enhanced filter characteristics
used within that model.
The BW enhancement filter will only operate at the base sample rate of the channel A/D converters and is
applied at that sample rate. If ET or IT acquisition modes are used, the filter will be applied to the data
before interpolation in IT mode and before it is placed into bins in ET mode. If the sample rate is lower than
base rate, then the filter will turn off. The vertical bandwidth field will display BW' when the filter is on.
The individual filters are calibrated at manufacturing for each of the four channels and for multiple
attenuator settings. The calibrated filters from these attenuator settings are used for the remaining
attenuator settings.
For instrument models >3.5 GHz, the bandwidth enhanced filters are calibrated with a reference plane at
the SMA, or 2.92 mm TekConnect input to a channel depending on the oscilloscope model.

Controls
From the Menu bar, select Vertical > Bandwidth Enhancement.
When Analog Only is selected, the bandwidth enhancement filter is not applied to the input data.
When Digital Filters (DSP) Enabled is selected, the bandwidth enhancement filter is turned on
whenever the base sample rate of the channel, or higher, is selected using the horizontal time base
controls. When in Enabled,, the filter will turn off if the sample rate goes lower than the base rate or if
other oscilloscope settings are selected that do not support the filter operation, such as Fast Acquisition.
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Coupling
All instruments and probes specify a maximum signal level. Do not exceed the limit, even momentarily, as
the input channel or probe may be damaged. Use external attenuators if necessary to prevent exceeding
the limits.
Coupling determines whether an input signal is directly connected to the input channel (DC coupling),
connected through a DC blocking capacitor (AC coupling), or not connected at all (GND coupling).
The input resistance of each input channel can be 1 MΩ or 50 Ω. To properly terminate signals when using
coaxial cables, or to support active probes with different termination requirements, select the termination
in the Coupling control window.
All probes expect a specific coupling and input termination. Both coupling and input termination are
displayed on the screen. If the instrument determines the coupling and termination required by the probe,
either implicitly because of the TekProbe/TekVPI interface or through performing a probe compensation,
the instrument sets the required coupling and input termination.
Consider the following when you use 50 Ω termination with any channel:
The instrument does not accurately display frequencies under 200 kHz if AC coupling is selected.
The instrument reduces the maximum volts per division setting for the channel to 1 V from 10 V (10 V
from 100 V with a 10X probe attached), since input amplitudes appropriate for the higher settings
would overload the 50 Ω input.
The instrument switches to 50 Ω termination and DC coupling if you connect an active probe. Active
probes also reduce the maximum volts per division.
What do you want to do next?
Learn about the Vertical Setup window. (see page 485)
Learn about the Termination control window. (see page 893)
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Scaling and positioning
The scaling and positioning controls determine the portion of the input signal received by the acquisition
system. Set vertical scaling, positioning, and DC offsets to display the features of interest on your
waveform and to avoid clipping.
Waveform data outside of the vertical acquisition window is clipped; that is, the data is limited to the
minimum or maximum boundaries of the vertical acquisition window. This causes inaccuracies in
amplitude-related measurements. For more information see Vertical Acquisition Window Considerations
(see page 685).

Adjusted horizontal scale
Acquired waveform
xxx

Set the horizontal scale, position, and resolution (record length) to include the acquired waveform record
waveform attributes of interest with good sampling density on the waveform. These settings define the
horizontal acquisition window, described in Horizontal Acquisition Window Considerations (see page 688).
NOTE. The terms vertical acquisition window and horizontal acquisition window refer to the vertical
and horizontal range of the segment of the input signal that the acquisition system acquires. The terms
do not refer to any display windows on screen.
What do you want to do next?
Learn about the Vertical Setup Position and Scale controls. (see page 956)
Learn about the Vertical Offset control. (see page 691)

Vertical Acquisition Window considerations
You can set the vertical scale, position, and offset of each channel independently of other channels.
Vertical scale and offset specify the vertical acquisition window for each channel. Parts of the signal
amplitude that fall within the vertical window are acquired; parts outside (if any) are not.
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Vertical Acquisition Window considerations

The offset control subtracts a constant DC level from the input signal before the vertical scale factor is
applied, and the vertical position control adds a constant number of divisions of signal after the scale factor
is applied to the resulting difference.
The vertical scale and position controls have the following affects on the vertical acquisition window
and the displayed waveform:
The vertical volts per division you set determines the vertical size of the acquisition window, allowing
you to scale it to contain all of a waveform amplitude or only part. Figures A and B below show two
vertical acquisition windows that contain the entire waveform, but only the window in Figure B contains
the entire waveform in the graticule on screen.
NOTE. Amplitude-related automatic measurements (for example, peak-to-peak and RMS) will be accurate
for vertical windows like those shown in Figures A and B below because neither waveform is clipped (that
is, both waveforms are acquired). But if signal amplitude were to extend outside the vertical acquisition
window, the data acquired is clipped. Clipped data causes inaccurate results if used in amplitude-related
automatic measurements. Clipping also causes inaccurate amplitude values in waveforms that are stored
or exported for use in other programs.
If the scale of a math waveform is changed so that the math waveform is clipped, it will affect the
amplitude measurements on that math waveform as follows:
The vertical position adjusts the display of the graticule relative to the vertical acquisition window
(position is a display control). Figure B shows how vertical position moves the waveform graticule
vertically in the acquisition window to place the acquired waveform in the graticule display. That is all
position does; it does not determine what data is acquired as do vertical scale and offset.
Figure A

Figure B
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As you vary vertical offset, the middle voltage level moves relative to zero. This moves the vertical
acquisition window up and down on the waveform. With input signals that are smaller than the
window, it appears the waveform moves in the window. Actually, a larger signal shows what really
happens: the offset moves the middle of the vertical acquisition window up and down on the input
signal. The next figure shows how offset moves the acquisition window to control the portion of
the waveform amplitude the window captures.
Applying a negative offset moves the vertical range down relative to the DC level of the input signal.
Likewise, applying a positive offset moves the vertical range up. See the following illustration.

What do you want to do next?
Learn about horizontal acquisition window considerations. (see page 688)
Learn about setting offset. (see page 491)
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Horizontal Acquisition Window considerations
The instrument lets you define the horizontal acquisition window parameters that determine which
segment of an incoming signal that becomes the waveform record, following acquisition. For additional
information, see Waveform Record (see page 694).
These common parameters specify a horizontal acquisition window that is applied to all channels in
parallel. See Independent vs. Shared Window (see page 689) for additional information.
These parameters are shown in the next figure (horizontal window with delay on):
The trigger position determines where the trigger event will be located in the waveform record. To see
more pretrigger data move your trigger position to the right on the graticule.
The horizontal position determines the number of pretrigger and posttrigger samples. Samples before
the trigger point are pretrigger samples and those after the trigger point are posttrigger samples. When
Delay is off, the horizontal position is the same as the trigger position.
The horizontal delay determines the time from the trigger point to the Horizontal Reference.
The horizontal scale determines the horizontal size of the window relative to any waveform, allowing
you to scale it to contain a waveform edge, a cycle, or several cycles.

What do you want to do next?
Learn more about Horizontal Setup. (see page 181)

Horizontal Acquisition Window interrelated parameters
Horizontal Scale, Record Length, Sample Interval, and Resolution are related parameters that specify the
horizontal acquisition window.
Because the horizontal acquisition window must fit in the 10 horizontal division display, for most cases,
you can set the Time Duration of the horizontal acquisition window (10 divs × the scale setting) as
described below. By also setting a Record Length in samples, you indirectly set the Resolution, Sample
Interval, and Sample Rate for the horizontal acquisition window (waveform record).
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The relationship between these horizontal elements is as follows:
Time Duration (seconds) = 10 divs (window size) × Horizontal Scale (sec/div)
Time Duration (seconds) = Sample Interval (seconds/sample) × Record Length (samples), where Time
Duration is the horizontal acquisition window time duration, and Sample Interval (sec/sample) =
Resolution (sec/sample) = 1/Sample Rate (samples/sec)
Note that it is the Sample Interval that changes to accommodate the window Time Duration (and its scale
setting) and the Record Length setting.
The elements behave as follows:
If the Record Length or Time Duration change, the Sample Interval will vary to accommodate the
change. The Sample Interval can vary up to the highest Sample Rate, (this corresponds to the lowest
Sample Interval, and the highest Resolution).
If the Sample Interval reaches its lower limit, the Record Length must decrease if the Time Duration
decreases (you set faster scale settings), or Time Duration must increase (forcing slower scale settings)
if Record Length increases (you set longer record lengths. The equation becomes: Maximum Record
Length = Time Duration ÷ Min Sample Interval.
NOTE. Resolution and the equivalent elements, Sample Interval and Sample Rate, are derived and cannot
be set directly. You can, however, check the Resolution at anytime in the resolution readout. Also note that
the front-panel Resolution knob actually adjusts the Record Length to increase sample density.
This discussion assumes that Horizontal Scale is held constant. You can hold the Sample Rate constant
instead by clicking Hold Sample Rate constant on the Record Length tab of the User Preferences control
window.
What do you want to do next?
Overview Learn about horizontal scale. (see page 835)
Learn about record length. (see page 902)
Learn about horizontal resolution. (see page 198)

Independent versus shared window
The instrument applies the same horizontal acquisition window to all channels from which it acquires
data. Unlike the vertical acquisition window that you size and offset independently for each channel, the
same time/div, resolution (record length), and horizontal position (from the same trigger point) apply to
all channels simultaneously.
One trigger, from a single trigger source, will locate a common horizontal acquisition window for all active
channels, which you can shift in parallel by setting the horizontal position control.
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What do you want to do next?
Learn more about the horizontal acquisition window. (see page 181)

Incompatible acquisition features
The following table shows which acquisition features and modes are incompatible with other features
or modes:
Incompatible with

Control/Feature

Explanation

Reference Waveforms (Ref 1– 4)

Voltage Offset

Offset is an acquisition control, not a
display control

Single shot acquisition

Average

Acquisitions continue until the
specified number of waveforms have
been acquired and averaged

Single shot acquisition

Envelope

Acquisitions continue until the
specified number of waveforms have
been acquired for the enveloped
waveform

Measurements

Roll

Measurements are not available until
you stop acquisitions

Envelope, Average, or WfmDB
acquisition modes

Roll

Using these acquisition modes will
turn Roll mode off

xxx
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Autoset considerations
Autoset acquires samples from the input signal and attempts to take the following actions based on the
input data:
Evaluates the amplitude range of the input signals and sets the size and vertical offset of the vertical
acquisition window to acquire the signal with good resolution, but without clipping.
Sets the trigger to the approximate midlevel of the signal being Autoset and switches to edge trigger
mode.
Evaluates the signal transitions and sets the horizontal scale to produce a waveform display of 2 or
3 cycles of the input signal.
Sometimes Autoset cannot produce a correct display due to the nature of the input signal. If so, you may
have to adjust the scale, trigger, and acquisition controls manually. The following are some conditions
that can cause Autoset to fail:
No signal present
Signals with extreme or variable duty cycles
Signals with multiple or unstable signal periods
Signals with too low amplitude
No recognizable trigger signal
Signals with a frequency < 20 Hz
Signals with a frequency above the bandwidth of the instrument
What do you want to do next?
Learn about adjusting the horizontal scale. (see page 835)
Learn about trigger setup. (see page 393)
Learn about horizontal acquisition controls. (see page 63)

Acquisition hardware
Before a signal can be acquired, it must pass through the input channel where it is scaled and digitized.
Each channel has a dedicated input amplifier and digitizer, as shown in the next figure; each channel can
produce a stream of digital data from which the instrument extracts waveform records.
Refer to Signal Connection (see page 693) for further description of scaling, positioning, and DC offsetting
of channels.
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Acquisition hardware

What do you want to do next?
Learn about the sampling process. (see page 693)
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Signal connection
This diagram displays the signal connection model for each input channel.

What do you want to do next?
Learn more about coupling. (see page 684)
Learn more about the vertical acquisition system. (see page 685)

Sampling process
Acquisition is the process of sampling an analog signal, converting it into digital data, and assembling it
into a waveform record, which is then stored in acquisition memory. Sampling is the process that provides
a waveform record per trigger event as shown in the next figure.
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The signal parts within the vertical range of the amplifier are digitized as shown in the next figure.

What do you want to do next?
Learn about sampling modes. (see page 694)

Sampling modes
The acquisition system can process the data as it is acquired, averaging or enveloping the waveform data to
produce enhanced waveform records. Once the waveform record exists (enhanced or not), you can use the
post processing capabilities of the instrument to further analyze that record.
Refer to Acquisition Mode (see page 838) for a description of the acquisition modes.
What do you want to do next?
Learn about waveform measurements. (see page 274)

Waveform record
While sampling on the input signal provides the data that makes up the waveform record for any given
channel, the instrument builds the waveform record through use of some common parameters ("common"
means they affect the waveforms in all channels).
The next figure shows how these common parameters define the waveform record. They define how much
data is taken and the location within the data stream. These parameters include the following:

694

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Waveform record

Sample Interval. This is the time between sample points taken during acquisition.
Record Length. This is the number of samples required to fill a waveform record.
Trigger Point. The trigger point marks the reference zero time in a waveform record. All waveform
samples are located in time (minus and/or plus) with respect to the trigger point.
Horizontal Position. When horizontal delay is off, the horizontal position is the time from the first
sample taken (first point in the waveform record) to the trigger point (in percent of samples before the
trigger). The trigger point and the horizontal reference are at the same time in the waveform record.
When horizontal delay is on, the Horizontal Position knob controls the horizontal delay time. The
horizontal delay is the time from the trigger point to the horizontal reference.

The waveform record and its defining parameters (horizontal delay on)
The previous figure shows that the instrument acquires points in order from left to right.
When all of the points in the waveform record have been sampled and digitized, the waveform record
is stored in acquisition memory and becomes available for display (or use in math waveforms, storage,
and so on).
What do you want to do next?
Learn about Horizontal window considerations. (see page 688)
Learn about Horizontal Acquisition Window interrelated parameters. (see page 688)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

695

Oscilloscope Reference

Interleaving

Interleaving
The instrument can interleave channels to attain higher real-time digitizing rates and longer record
length when only one or two channels are turned on without equivalent-time sampling. The instrument
applies the resources of unused channels (that is, channels that are turned off) to sample those that are in
use (turned on).
Once you set the horizontal scale to exceed the maximum digitizing rate for the number of channels in
use, the instrument will not be able to get enough samples to create a waveform record. At that point, the
instrument will switch from real-time to equivalent-time to obtain additional samples.
What do you want to do next?
Learn about equivalent time sampling. (see page 194)

Interpolation
When the sample density falls to less than one sample per display column, the instrument must calculate
intermediate points to display a waveform. This process is called interpolation.
There are two options for interpolation:
Sin(x)/x Interpolation. Computes record points using a curve fit between the actual values acquired.
It assumes that all the interpolated points fall along that curve.
Linear Interpolation. Computes record points between actual acquired samples by using a straight
line fit. It assumes that all the interpolated points fall in their appropriate point in time on that
straight line.
What do you want to do next?
Learn about using the MultiView Zoom feature. (see page 728)
Go to a step-by-step procedure for displaying waveforms. (see page 666)

Triggering concepts
Overview
To use the instrument to sample a signal and digitize it into a waveform record that you want to process,
you need to set up the trigger conditions.
The next figure shows how triggers fit into the overall instrument operation.
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Triggers create meaningful waveforms from signal displays. This instrument has simple edge triggers as
well as a variety of advanced triggers.

The trigger event
The trigger event establishes the time-zero point in the waveform record. All waveform record data are
located in time with respect to that point. The instrument continuously acquires and retains enough sample
points to fill the pretrigger portion of the waveform record (that part of the waveform that is displayed
before, or to the left of, the triggering event on screen).
When a trigger event occurs, the instrument starts acquiring samples to build the posttrigger portion of the
waveform record (displayed after, or to the right of, the trigger event). Once a trigger is recognized, the
instrument will not accept another trigger until the acquisition is complete and the holdoff time has expired.
What do you want to do next?
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Learn about trigger sources. (see page 698)
Learn about trigger types. (see page 699)
Learn about trigger modes. (see page 702)
Learn about trigger holdoff. (see page 703)

Trigger sources
The trigger source provides the signal that triggers acquisition. Use a trigger source that is synchronized
with the signal that you are acquiring and displaying.
NOTE. This online help supports many oscilloscope models from Tektronix. Some of these sources may
not be available on your instrument. Some of the sources may not be available on your instrument with
its current setup.
You can derive your trigger from the following sources:
Input channels. These are the most commonly used trigger sources. You can select any one of
the four input channels. The channel that you select as a trigger source will function whether it is
displayed or not.
Digital channels. These sources are available on MSO instruments. You can select any combination
of digital channels.
Bus. This source is used to trigger a parallel bus or a serial bus. You can include any combination of
analog, math, or digital channels to build a parallel bus with up to 20 bits (and a clock), or use any
channel as a component in a serial bus. You define the trigger as a bus pattern for parallel buses or as
a bus cycle for serial buses.
AC Line Voltage. This source is often used to look at signals related to the power line frequency
(for example, signals from devices such as lighting equipment and power supplies). Because the
instrument generates the trigger from the power line, you do not have to use a channel input.
Auxiliary Trigger. (AUX IN) provides a fifth source that you can use as a trigger input when you
need to use the four input channels for other signals. For example, you might want to trigger on a
clock while displaying four other logic signals. To use the auxiliary trigger, connect the signal to the
auxiliary input connector on the front panel. The input connector is not compatible with most probes,
nor can you display the auxiliary trigger signal.
iCapture. This source is available on MSO instruments. If you select iCapture in the Vertical menu,
you can then select the iCapture channel as the trigger source.
The trigger level range for the front-panel auxiliary input (Aux In) is adjustable from +5 V to –5 V. The
maximum input voltage depends on the instrument model, check your instrument specifications.
What do you want to do next?
Learn about trigger types. (see page 699)
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Trigger types

Learn about trigger modes. (see page 702)

Trigger types
NOTE. This online help documents features and options available for several instrument models. Your
instrument may not have every feature discussed in this online help, depending on its configuration.
From the Trig menu, select A Event Trigger Setup or B Event Trigger Setup.

To use
Click the Select button for selecting the trigger type in the Trigger Selection dialog box.
The triggers type available are listed as follows:
Edge trigger. This is the simplest and most commonly used trigger type, used with both analog and digital
signals. An edge trigger event occurs when the trigger source passes through a specified voltage level in
the specified direction (rising or falling signal voltage).
Bus trigger. This trigger is used with both analog and digital signals used to set up parallel buses or a
serial buses. A bus trigger event occurs when the instrument detects a bus pattern that you specify for a
parallel bus, or a bus cycle you select for a serial bus.
NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
Glitch trigger (see page 709), Transition trigger (see page 713), Pattern trigger (see page 709), Runt trigger
(see page 710), Window Trigger (see page 714), State trigger (see page 712), Width trigger (see page 714),
Timeout trigger (see page 713), and Setup/Hold trigger (see page 710)
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Pulse trigger
NOTE. Pulse trigger on B event is not available on MSO/DPO5000B Series instruments.
These are special-purpose triggers that are primarily used with digital signals. The following types of
pulse triggers are available: Glitch, Runt, Window, Width, Transition, and Timeout. Pulse triggers are
available on the main and B event triggers only.

Logic trigger
NOTE. Logic trigger on B event is not available on MSO/DPO5000B Series instruments.
These are special-purpose triggers that are primarily used with digital logic signals. Two of the types,
Pattern and State, trigger the instrument based on the Boolean operator that you select for the trigger
sources. A third type, Setup and Hold, triggers when data in one trigger source changes state within
the setup and hold times that you specify relative to a clock in another trigger source. Logic triggers
are available on the main and B event triggers.

Communication trigger
NOTE. Communication trigger is not available on MSO/DPO5000B Series instruments.
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Available with Mask Testing, this trigger is designed to work with communication masks and standards.
Mask testing automatically uses Communication triggers.
NOTE. You must install the Serial Communications Mask Testing Option (see page 215) on some
instruments before you can access the Comm triggers.

Video trigger
NOTE. Video trigger is available on DPO7000C and MSO/DPO5000B Series instruments.
These are used to trigger the instrument on specified fields or lines of a video signal. You can use one of
several preset video signal formats or set a custom format.

Serial trigger
NOTE. Serial trigger is not available on MSO/DPO5000B Series instruments.
Serial triggering allows you to define a 64-bit pattern and trigger on it. The serial pattern can be set in
radices of binary or hex. Serial triggering also offers Recovered Clock as the clock source in addition
to Ch1 – Ch4. Use serial triggering in conjunction with mask testing to trigger the instrument on
communications codes and standards. The communication codes and standards work together to define the
parameters for the trigger event.
What do you want to do next?
Learn about trigger sources. (see page 698)
Learn about trigger modes. (see page 702)
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Trigger modes
The trigger mode determines how the instrument behaves in the absence of a trigger event:
Normal trigger mode enables the instrument to acquire a waveform only when it is triggered. If no
trigger occurs, the instrument does not acquire a waveform, and the last waveform record acquired
remains "frozen" on the display. If no last waveform exists, no waveform is displayed.
Auto trigger mode enables the instrument to acquire a waveform even if a trigger does not occur. Auto
mode uses a timer that starts after a trigger event occurs. If another trigger event is not detected before
the time out, the instrument forces a trigger. The length of time it waits for a trigger event depends on
the time base setting.
Auto mode, when forcing triggers in the absence of valid triggering events, does not synchronize the
waveform on the display. In other words, successive acquisitions are not triggered at the same point on
the waveform; therefore, the waveform will appear to roll across the screen. If valid triggers occur, the
display will become stable.
What do you want to do next?
Learn about trigger sources. (see page 698)
Learn about trigger types. (see page 699)
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Trigger holdoff
Trigger holdoff can help stabilize triggering. When the instrument recognizes a trigger event, it disables
the trigger system until acquisition is complete. In addition, the trigger system remains disabled during
the holdoff period that follows each acquisition. Adjust holdoff to obtain stable triggering when the
instrument is triggering on undesired trigger events.
A digital pulse train is a good example of a complex waveform. Each pulse looks like any other, so many
possible trigger points exist. Not all of these will result in the same display. The holdoff period allows the
instrument to trigger on the correct edge, resulting in a stable display.

At the longer holdoff time for the top waveform, unstable triggering occurs. With a shorter holdoff set for
the bottom waveform, triggers all occur on the first pulse in the burst to remedy the unstable trigger.
The Holdoff setting range is 1.5 µs (minimum holdoff available) to 12 s (maximum holdoff available). For
more information on how to set holdoff, click here (see page 482). You can also set a default holdoff.
The default holdoff is the general-purpose holdoff for most applications and varies with the horizontal
scale. It is equal to five times the current horizontal scale setting.
What do you want to do next?
Learn about trigger coupling. (see page 704)
Learn about trigger modes. (see page 702)
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Trigger coupling
Trigger coupling determines what part of the signal is passed to the trigger circuit. Edge triggering can use
all available coupling types: AC, DC, Low Frequency Rejection, High Frequency Rejection, and Noise
Rejection. All of the advanced trigger types use DC coupling only. For a description of each coupling
type, click here (see page 64).
What do you want to do next?
Learn about trigger position. (see page 705)
Learn about trigger holdoff. (see page 703)

Trigger slope and level
The slope control determines whether the instrument finds the trigger point on the rising or the falling edge
of a signal. The level control determines where on that edge the trigger point occurs. See the next figure.

What do you want to do next?
Learn about trigger position. (see page 705)
Learn about trigger slope. (see page 704)
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Horizontal trigger position
Horizontal position is an adjustable feature that defines where the trigger occurs on the waveform record.
It lets you choose how much the instrument acquires before and after the trigger event. The part of the
record that occurs before the trigger is the pretrigger portion. The part that occurs after the trigger is
the posttrigger portion. A longer posttrigger period may be useful when you want to see the effects an
event has on your system under test.
Pretrigger data can be valuable when troubleshooting. For example, if you are trying to find the cause of
an unwanted glitch in your test circuit, you can trigger on the glitch and make the pretrigger period large
enough to capture data before the glitch. By analyzing what happens before the glitch, you may uncover
information that helps you find the source of the glitch.
What do you want to do next?
Learn about trigger coupling. (see page 704)
Learn about trigger slope. (see page 704)
Learn about glitch triggers. (see page 709)
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Delayed trigger system
You can trigger with the A (Main) trigger system alone or you can combine the A (Main) trigger with
the B (Delayed) trigger to trigger on sequential events. When using sequential triggering, the A trigger
event arms the trigger system, and the B trigger event triggers the instrument when the B trigger conditions
are met.
A and B triggers can (and typically do) have separate sources. The B trigger condition can be based on a
time delay or a specified number of counted events.
For more details on delayed triggering, clickhere (see page 911).
What do you want to do next?
Learn about advanced triggering. (see page 706)

Advanced triggering
You can check the advanced trigger status in the readout. The readout indicates the trigger type and then
shows sources, levels, or any other parameters that are important for the particular trigger type.
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Bus trigger
A bus trigger occurs when a supported instrument detects a bus pattern that you specify for a parallel bus,
or a bus cycle you select for aserial bus.
You can set the instrument to trigger on a parallel bus when the instrument detects a match to the bus
pattern, or when the instrument detects that the value on the bus is < or > the value of the bus pattern. The
pattern can be in Binary, Hex, or Symbolic format.
You can set the instrument to trigger on an SPI bus when the instrument detects an SS or an MISO + MOSI
bus cycle. For the MISO + MOSI selection, click the Edit button to define the Data Value pattern, and
then set the Format to match.
You can set the instrument to trigger on an I2C bus when the instrument detects a Start, Stop, Repeated
Start, Missing Ack, Address, Data, or Addr + Data bus cycle or activity. For some Trigger On selections,
you need to set additional fields to define other parameters, such as for an Address. In this example, you
need to set an Address Format, Address Value (click the Edit button), Data Direction, and Addressing
Mode.
You can set the instrument to trigger on a USB bus when the instrument detects a Sync, Reset, Suspend,
Resume, End of Packet, Token (Address) Packet, Data Packet, Handshake Packet, Handshake Packet,
Special Packet, or Error bus cycle or activity. For some Trigger On selections, you need to set additional
fields to define other parameters, such as for a Token (Address) Packet. In this example, you need to set
a Token Type, Trigger when address is, Address Format, Address (click the Edit button), and when
endpoint is equal to Endpoint Format, and Endpoint.
You can set the instrument to trigger on an RS232 bus when the instrument detects a Start, End of Packet,
Data, or Parity Error bus cycle or activity. For some Trigger On selections, you need to set additional fields
to define other parameters, such as for a Data. In this example, you need to set a Data Format, Number
of Bytes, and Data Value (click the Edit button).
You can set the instrument to trigger on an 8b10b bus when the instrument detects a Pattern,
Character/Symbol, Error, or Any Control Character. For some Trigger On selections, you need to set
additional fields to define other parameters, such as for a Pattern.
For all the serial standard buses, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Communication trigger
Use the Comm trigger to trigger the instrument in conjunction with mask testing on communications codes
and standards. The controls work together to define the parameters for the trigger event.
The standards that appear in the Standard drop-down list depend on the coding format that you selected.
The coding format also determines whether upper, lower, single, or clock threshold levels or pulse forms
are used. The standard determines the bit rate.
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Communication triggering
Communication (Comm) triggers are one type of trigger. Comm triggers are designed to work with
communication masks and standards. When you select a mask to test, it is associated with a specific
communication standard. The mask you select determines the Comm trigger needed for that standard.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.
Eye diagrams that are set up with an external clock use a time base position value large enough to
guarantee the edge is always before the acquisition record starts. This forces all Comm triggers to
disable the B-Trigger.
Even though Comm triggers are designed to work with masks, you can set up Comm triggering without
using a mask. You can also set up your own mask to use with Comm triggers.
What do you want to do next?
Learn about mask testing. (see page 786)
Learn more about eye measurements. (see page 788)
Go to the mask testing setup overview. (see page 215)
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Glitch trigger
A glitch trigger occurs when the instrument detects a pulse narrower (or wider) than some specified time.
You can set the instrument to trigger on glitches of either polarity or to reject glitches of either polarity.

Pattern trigger
A pattern trigger occurs when the inputs to the selected logic function cause the function to become True
or False. When you use a pattern trigger, you define:
The precondition for each logic input: logic high, low, or "don't care"; the logic inputs are the
instrument channels
The Boolean logic function: AND, NAND, OR, or NOR
The condition for triggering: the Boolean function becomes True (logic high) or False (logic low),
and whether the True condition is time qualified
Pattern trigger logic choices are summarized in the next table.
Pattern

State

Definition 1, 2

AND

Clocked AND

If all the preconditions selected for
the logic inputs 3 are TRUE, then the
instrument triggers.

NAND

Clocked NAND

If not all of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

OR

Clocked OR

If any of the preconditions selected for
the logic inputs 3 are TRUE, then the
instrument triggers.

NOR

Clocked NOR

If none of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

xxx

1
2
3

For state triggers, the definition must be met at the time the clock input changes state
The definitions given here are correct for the Goes TRUE setting in the Trigger When menu. If that menu is set to Goes False, swap the definition for
AND with that for NAND and for OR with NOR for both pattern and state types.
The logic inputs are channels 1, 2, 3, and 4 when using Pattern triggers. For State triggers, channel 4 becomes the clock input, leaving
the remaining channels as logic inputs.
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Runt trigger
A runt trigger occurs when the instrument detects a short pulse that crosses one threshold but fails to
cross a second threshold before recrossing the first.
You can set the instrument to detect any positive or negative runt pulse, or only those wider than
a specified minimum width.
Runt pulses can also be qualified by the logical state of other channels.

Setup and hold trigger
A setup/hold trigger occurs when a data signal changes state inside of the user specified setup and hold
times relative to the clock. When you use setup/hold triggering, you define:
The channel containing the logic input (the data source) and the channel containing the clock (the
clock source)
The direction of the clock edge to use
The clocking level and data level that the instrument uses to determine if a clock or data transition
has occurred
The setup and hold times that together define a time range relative to the clock
Data that changes state within the setup/hold violation zone triggers the instrument. The next figure shows
how the setup and hold times that you choose position the violation zone relative to the clock.
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Setup/hold triggering uses the setup/hold violation zone to detect when data is unstable too near the time it
is clocked. Each time trigger holdoff ends, the instrument monitors the data and clock sources. When
a clock edge occurs, the instrument checks the data stream it is processing (from the data source) for
transitions occurring within the setup/hold violation zone. If any occur, the instrument triggers with the
trigger point located at the clock edge.
Positive settings for both setup and hold times (the most common application) locate the setup/hold
violation zone so that it spans the clocking edge as shown above in the top waveform. The instrument
detects and triggers on data that does not become stable long enough before the clock (setup time violation)
or that does not stay stable long enough after the clock (hold time violation).
Negative settings for setup or hold times skew the setup/hold violation zone to locate it before or after the
clocking edge as shown above in the center and bottom waveforms. The instrument can then detect and
trigger on violations of a time range that occurs before or one that occurs after the clock.
NOTE. Keep the hold-time setting to no more than 2.5 ns less than one-half the clock period (hold time <
(period/2) –2.5 ns) or the instrument cannot trigger (this assumes a 50% duty cycle clock).
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State trigger
A state trigger occurs when the inputs to the logic function cause the function to become True or False at
the time the clock input changes state. When you use a state trigger, you define:
The precondition for logic input channels 1 through 3
The direction of the state change for the clock input, channel 4
The Boolean logic function: AND, NAND, OR, or NOR
The condition for triggering: the Boolean function becomes True (logic high) or False (logic low)
State trigger logic conditions are summarized in the following table.
Pattern

State

Definition 1, 2

AND

Clocked AND

If all the preconditions selected for
the logic inputs 3 are TRUE, then the
instrument triggers.

NAND

Clocked NAND

If not all of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

OR

Clocked OR

If any of the preconditions selected for
the logic inputs 3 are TRUE, then the
instrument triggers.

NOR

Clocked NOR

If none of the preconditions selected
for the logic inputs 3 are TRUE, then
the instrument triggers.

xxx

1
2
3
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For state triggers, the definition must be met at the time the clock input changes state.
The definitions given here are correct for the Goes TRUE setting in the Trigger When menu. If that menu is set to Goes False, swap the definition for
AND with that for NAND and for OR with NOR for both pattern and state types.
The logic inputs are channels 1, 2, 3, and 4 when using Pattern triggers. For State triggers, channel 4 becomes the clock input, leaving
the remaining channels as logic inputs.
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Timeout trigger
A timeout trigger occurs when the instrument does not detect an expected pulse transition within a user
specified period of time, such as when a signal gets stuck either high or low. If the pulse transition occurs
prior to a specified timeout time (the expected case), then no trigger results.

Transition time trigger
Transition triggering is based on the slope (change in voltage/change in time) of a pulse edge.
Use the transition trigger to trigger the instrument on pulse edges that traverse between two thresholds
at faster or slower rates than the specified time. You can set up the instrument to trigger on positive or
negative edges.

Video trigger
Use the Video trigger to trigger the instrument on specified fields or lines of a composite video signal. You
can select from several preset video signal formats or set a custom format.
NOTE. Only composite signal formats are supported. Graphic display formats such as RGB and VGA
are not supported.
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Width trigger
A width trigger occurs when the instrument detects a pulse that is inside or outside some specified time
range. The instrument can trigger on positive or negative width pulses. Width triggers can also be qualified
by the logical state of other channels.

Window trigger
NOTE. Window trigger is not available on MSO/DPO5000B Series instruments.
Use the Window trigger to trigger the instrument when the input signal rises above an upper threshold
level or falls below a lower threshold level.
After setting these levels, you can specify whether you want to trigger the instrument as the signal is
entering or leaving the threshold window. You can further qualify the trigger event in terms of time, or
by the logical state of other channels.

714

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Sequential triggering

Sequential triggering
In applications that involve two or more signals, you may be able to use sequential triggering to capture
more complex events. Sequential triggering uses the A (Main) trigger to arm the trigger system, and then
uses the B (Delayed) trigger to trigger the instrument if a specific condition is met.
You can choose one of two trigger conditions:
Trigger After Time. After the A trigger arms the trigger system, the instrument triggers on the next
B-trigger event that occurs after the trigger delay time. You can set the trigger delay time with the
keypad or the multipurpose knobs.
Trigger on nth Event. After the A trigger arms the trigger system, the instrument triggers on the nth B
event. You can set the number of B events with the keypad or the multipurpose knobs.
NOTE. The traditional delayed trigger mode called "Runs After" is controlled by the Horizontal Delay
feature. You can use horizontal delay to delay acquisition from any trigger event, whether from the A
(Main) trigger alone or from a sequential trigger that uses both the A (Main) and B (Delayed) triggers.
See Triggering with Horizontal Delay On (see page 716) for more information.
Keep in mind the following when using sequential triggers:
In most cases, you will set separate trigger sources for the A (Main) and B (Delayed) triggers.
Sequential triggering for Trigger after Time or Trigger on nth Event is available for all trigger types.
The B trigger is can be any trigger type except Bus.
What do you want to do next?
Learn more about sequential triggering. (see page 715)
Learn about advanced triggers (see page 706)
.

Triggering with Horizontal Delay off
The next figure compares the sequential trigger choices A Only, Trig After Time, and Trig on nth Event
when horizontal delay is off. Each illustration shows where pretrigger and posttrigger data is acquired
relative to the trigger event.
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Triggering with Horizontal Delay on

What do you want to do next?
Learn more about sequential triggering. (see page 716)
Learn about advanced triggers. (see page 706)

Triggering with Horizontal Delay on
You can use horizontal delay when you want to acquire a waveform record that is separated from the trigger
event by a significant interval of time. The horizontal delay function can be used with any trigger setup.
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Triggering with Horizontal Delay on

You can turn horizontal delay on and off from the front panel, the Horizontal/Acquisition control window,
and many of the Trigger control windows.
The next figure compares the sequential trigger choices A Only, Trig After Time, and Trig on nth Event
when horizontal delay is on. Each illustration shows where pretrigger and posttrigger data is acquired
relative to the trigger event.

What do you want to do next?
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Learn about advanced triggers. (see page 706)
View a summary of triggering and horizontal delay. (see page 718)

Triggering and horizontal delay summary
The next figure shows all combinations of triggering and horizontal delay.

What do you want to do next?
Go to a step-by-step procedure for sequential triggering. (see page 645)
Learn about advanced triggers. (see page 706)

Display overview
This instrument includes a flexible, customizable display that lets you control how waveforms appear. The
next figure shows how the display features fit into the overall instrument operation.
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What do you want to do next?
Learn about display elements. (see page 719)
Learn about customizable display elements. (see page 721)
Go to a step-by-step procedure for displaying waveforms. (see page 666)

Display elements
The waveform shown below is displayed as part of the user interface (UI) application. Some terms that
are useful in discussing the UI follow.
1. Menu Bar. Access the controls for data I/O, printing, online help, and instrument functions here.
2. Buttons/Menu. Click to toggle between the toolbar and menu bar modes.
3. Multipurpose Knob Readout. Adjust and display the parameters controlled by the multipurpose
knobs.
4. Display. Live, reference, and math waveforms are displayed here, along with cursors.
5. Waveform Handle. Click and drag to change the vertical position of a waveform.
6. Controls Status. Obtain a quick reference to the vertical selections, scale, and parameters.
7. Readouts. The cursor and measurement readouts are displayed in this area. Measurements are
selectable form the menu bar or toolbar. If a control window is displayed, some combinations of
readouts move to the graticule area.
8. Status. Displays the acquisition status, mode, and number of acquisitions; trigger status; date; time;
and quick reference to horizontal parameters
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See the next figure for some ideas on how to manipulate the display elements.
1. Click to toggle between toolbar and menu bar modes and select toolbar extensions.
2. Drag cursors to measure waveforms on screen.
3. Drag the horizontal reference marker to reposition a waveform.
4. Click the waveform handle to assign the multipurpose knobs to waveform vertical position and scale.
5. Drag across the waveform area to create a box for zooming, enabling/disabling histograms, and
gating measurements.
6. Drag the trigger level marker to change the trigger level.
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What do you want to do next?
Learn about acquisition preview. (see page 724)
Learn about customizable display elements. (see page 721)
Go to a step-by-step procedure for displaying waveforms. (see page 666)

Customizable display elements
The following lists contains information on customizable display elements and their points of access.
Color Palette (Graticule and Waveform):
Access these elements through the Display menu Colors command, Display menu Display Palette
submenu, or Display Setup control window Colors tab (Disp toolbar button):
Normal. Displays hues and lightness levels for best overall viewing. The color of each channel
waveform matches the color of the corresponding front-panel vertical SCALE knob.
On the Spectral Grading) palette. Areas of the waveform with the highest sample density appear in
blue shades and the areas of lowest sample density appear in red shades.
On the Temp (Temperature Grading) palette. Areas of the waveform with the highest sample
density appear in warmer colors (red shades) and the areas of lowest sample density appear in cooler
colors (blue shades).
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Gray (Monochrome Gray). Displays waveforms in shades of gray. Areas of the waveform with the
highest sample density appear in lighter gray shades and the areas of lowest sample density appear
in darker gray shades.
Green (Monochrome Green). Displays waveforms in shades of green. Areas of the waveform with
the highest sample density appear in lighter green shades and the areas of lowest sample density
appear in darker green shades.
Date and Time:
Access these elements through the Display menu Objects command, Display menu Display Date & Time
command, or Display Setup control window Objects tab Disp toolbar button):
Toggle. Alternates the display of the date and time on the graticule. To set the time and date, use
the Utilities menu Set Time & Date command.
Display Format:
Access these elements through the Display Appearance or Display Format commands, the Display toolbar
button, or the Display Setup Control Window Appearance tab:
XY or YT Formatting. For additional information, see Display Format (see page 174).
Display Persistence:
Access these elements through the Display menu Display Persistence submenu commands or Display
Setup control window Appearance tab ( Disp toolbar button):
Infinite persistence. Continuously accumulates record points on the waveform until you change
one of the acquisition display settings. Use for displaying points that may occur outside the normal
acquisition envelope.
Variable persistence. Accumulates record points on the waveform for a specified time interval. Each
record point decays independently according to the time interval.
Off. Shows waveform record points for the current acquisition only. Each new waveform record
replaces the previously acquired record for a channel.
Display Style:
Access these elements through the Display menu Display Style submenu commands or Display Setup
control window Appearance tab ( Disp toolbar button):
Vectors. Displays waveforms with lines drawn between record points.
Dots. Displays waveform record points as dots on the screen.
Inten Samp (Intensified Samples). Shows the actual samples on interpolated waveforms.
Graticule Style:
Access these elements through the Display menu Graticule Style command or Display Setup control
window Objects tab Disp toolbar button):
Full. Provides a grid, cross hairs, and frame on the instrument display. Use for quick estimates of
waveform parameters.
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Grid. Shows a frame and grid on the instrument display. Use for full-screen measurements with
cursors and automatic readouts when cross hairs are not needed.
Cross Hair. Shows cross hairs and a frame on the instrument display. Use for making quick estimates
of waveforms while leaving more room on the display for automatic readouts and other data.
Frame. Shows only a frame on the instrument display. Use with automatic readouts and other screen
text when other display features are not needed.
IRE. Use for NTSC video signals.
mV. Use for video signals other than NTSC.
Math Colors:
Access these elements through the Display menu Colors command or Display Setup control window
Colors tab Disp toolbar button):
Default. Uses the default system color (red) for math waveforms.
Inherit. Uses the same color for the math waveform as the waveform the math function is based on.
Reference Colors:
Access these elements through the Display menu Colors command or Display Setup control window
Colors tab (Disp toolbar button):
Default. Uses the default system color (white) for reference waveforms.
Inherit. Uses the same color for the reference waveform as the original waveform.
Screen Text:
Access these elements through the Display menu Screen Text command or Display Setup control window
Screen Text tab (Disp toolbar button):
Up to eight (8) lines of text. Provides notes for screen shots, printouts, or for other instrument users.
Display. Turns the text display on and off.
Properties. Opens the Text Properties control window for positioning of the text on the display.
Clear. Erases the entire text of the selected line.
Trigger Level Marker:
Access these elements through the Display menu Objects command or Display Setup control window
Objects tab (Disp toolbar button):
Short. Displays a short arrow on the side of the graticule by the active waveform.
Long. Displays a horizontal line through the active waveform.
Waveform Interpolation:
Access these elements through the Display menu Waveform Interpolation submenu or Display Setup
control window Appearance tab (Disp toolbar button):
Sin(x)/x. Provides Sin(x)/x interpolation of the waveform.
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Linear. Provides linear interpolation of the waveform.
What do you want to do next?
Learn about waveform display and the time base. (see page 726)
Learn about using the MultiView Zoom feature. (see page 728)
Go to a step-by-step procedure for displaying waveforms. (see page 666)

Acquisition preview
The acquisition preview attempts to show what the next acquisition will look like when the acquisition
is delayed due to slow triggers or long acquisition duration, or when the acquisitions have stopped.
Acquisition preview recalculates math waveforms, but does not represent changes in trigger levels, trigger
modes, or different acquisition modes.
Acquisition preview has some limitations. For example, if the horizontal scale is changed to a setting that
is significantly faster or slower, the waveform display is are cleared.
NOTE. There is no acquisition preview in Fast Acquisitions mode.
What do you want to do next?
Learn more about waveform display. (see page 724)
Learn about waveform display and time base. (see page 726)
Go to a step-by-step procedure for displaying waveforms. (see page 666)

Waveform display
The instrument uses the following methods to display waveforms:
Defines the waveform (math and reference waveforms only).
Enables the waveform display.
The following table summarizes this process as it applies to the different types of waveforms.
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Waveform

To define

To display

Channel: Ch <1-4>

Channels are predefined

Push the Vertical CH n button to toggle
the channel display on or off.

Logic: D <15-0>

Channels are predefined

From the Digital Setup control window,
click the D15-D8 or D7-D0 tab, and
then click the button of the desired
digital channel to toggle the waveform
display on and off.

Math: Math <1-4>

Create a math waveform using existing
sources (channel, math, and reference
waveforms; measurements).

From the Math Setup control window,
click Display on the Math n tab to
toggle the math waveform display on
and off.

Reference: Ref <1-4>

Define an active reference waveform
by:

From the Reference Setup control
window, click Display on the Ref n
tab to toggle the reference waveform
display on and off.

Saving a channel, reference, or
math waveform to one of locations
Ref1 – Ref4.
Recalling a waveform previously
saved to a file into one of locations
Ref1 – Ref4.
Perform these operations from the
File menu.
xxx

In general, the method of adjusting (vertically scaling, offsetting, positioning, and so on) the waveform
display is from the front-panel vertical Scale and Position knobs. Note that math and reference waveforms
are scaled and positioned from their setup control windows.
For channel waveforms, the vertical and horizontal controls that you set also adjust the instrument
acquisition parameters. See the following for more information:
Vertical Acquisition Window Considerations. (see page 685)
Horizontal Acquisition Window Considerations. (see page 688)
To change the size of the acquisition waveform and zoomed waveform windows, select the Graticule
Size in the Zoom Setup control window. The 50-50 selection allocates half of the available display for
the zoomed graticule and half of the available display for the acquisition window. The 80-20 selection
allocates 80% of the available display for the zoomed graticule and 20% for the acquisition window. Select
Full to use the entire display for the zoomed graticule.
The display elements are the same for each graticule.
What do you want to do next?
Learn about customizable display elements. (see page 721)
Learn about using the MultiView Zoom feature. (see page 728)
Go to a step-by-step procedure for displaying waveforms. (see page 666)
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Operations on the time base
In general, to adjust the time base, use the front-panel horizontal Scale, Resolution, and Positions knobs.
Only channel waveforms can be set directly.
Here are some key points to remember about how horizontal operations relate to the waveform types:
Reference waveforms are shown with the horizontal settings in effect at the time that they are
saved. You cannot adjust these settings. See Saving and Recalling Waveforms (see page 790) more
information on reference waveforms.
Math waveforms are shown with the horizontal settings derived from the math expression that creates
them. You cannot change these directly. See Creating (see page 747) or Using Math Waveforms (see
page 610) for more information on math waveforms.
All waveforms are displayed within the horizontal divisions that the graticule provides. However,
some waveforms may actually be wider or narrower than the display due to acquisition rate/time scale
combinations and acquisition preview.
What do you want to do next?
Learn about the horizontal reference point. (see page 727)
Learn about using the MultiView Zoom feature. (see page 728)
Go to a step-by-step procedure for displaying waveforms. (see page 666)
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Horizontal position and the horizontal reference point
The time value you set for horizontal position is measured from the trigger point to the horizontal reference
point. This is not the same as the time value from the trigger point to the start of the waveform record,
unless you set the horizontal reference to 0%. See the next figure.

What do you want to do next?
Learn about interpolation. (see page 696)
Learn about using the MultiView Zoom feature. (see page 728)
Go to a step-by-step procedure for displaying waveforms. (see page 666)
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Using the MultiZoom feature
Use the instrument MultiZoom feature to magnify an acquisition vertically, horizontally, or in both
dimensions to let you see the fine detail in your signals without changing the acquisition parameters
(sample rate, record length, and so on). For example, to temporarily expand the front corner of a pulse to
inspect its aberrations, push the front-panel MultiZoom button to expand it horizontally and vertically.
To help you use Mulitzoom effectively, consider how it operates on waveforms:
When zooming vertically, the instrument expands up to four zoomed areas at one time. The zoomed
areas can all be on the same waveform or they can be on different Channel, Math or Reference
waveforms. Each zoomed area has its own vertical position and factor.
When zooming horizontally, the Zoom Source is either the acquisition waveform or one of the zoomed
areas.
When zooming either horizontally or vertically, Zoom expands or contracts the waveform by the
Zoom Factor.
What do you want to do next?
Go to a step-by-step procedure for displaying waveforms. (see page 666)
Go to a step-by-step procedure for using MultiView Zoom. (see page 668)

Automatic measurements
All channel, reference, and math waveforms can serve as sources for automatic measurements. Some
measurements, such as Delay and Phase, require two sources.
NOTE. Automatic measurements are not available on digital channels.
The following automatic measurement categories are available:
Amplitude (see page 276)
Time (see page 279)
More (see page 288) (miscellaneous)
Histogram (see page 296)
Communication (see page 284)
Click the category for a list of the measurements that you can choose from in each category.
The instrument can take and update up to eight measurements at one time. You can apply measurements
to any combination of sources. For example, you can take all eight measurements on Channel 1, or you
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can take measurements on a combination of channel waveforms, math waveforms, reference waveforms,
and/or histograms.

High/Low method
The levels that the automatic measurement system derives as the High (top) or Low (bottom) for a
waveform influence the fidelity of amplitude and aberration measurements. Select among the modes the
instrument provides for determining these levels:
Histogram mode sets the values statistically. It selects the most common value either above or below
the midpoint (depending on whether it is defining the High or Low reference level). Since this
statistical approach ignores short term aberrations (overshoot, ringing, and so on), Histogram is the
best setting for examining pulses. See the next figure.
Min-Max mode uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as sine waves and
triangle waves (almost any waveform except for pulses). See the next figure.

Reference levels method
A second set of levels affect the fidelity of time-related measurements. For example, the measurement
system calculates rise time from the waveform edge that transitions from the Low to the High reference
levels.
The instrument provides the following calculation methods (see the next figure):
Relative Reference is calculated as a percentage of the High/Low range.
Absolute Reference is set by absolute values in user units.
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What do you want to do next?
Learn about cursor measurements. (see page 84)
Go to a step-by-step procedure for taking automatic measurements. (see page 606)

Measurement variables
By knowing how the instrument makes calculations, you may better understand how to use your instrument
and how to interpret your results. The instrument uses a variety of variables in its calculations. These
include:

High, low
High is the value used as the 100% level in measurements such as fall time and rise time. For example,
if you request the 10% to 90% rise time, then the instrument calculates 10% and 90% as percentages
with High representing 100%.
Low is the value used as the 0% level in measurements such as fall time and rise time.
The exact meaning of High and Low depends on which of two calculation methods you choose from the
High-Low Setup item of the Measure menu. These are Min-max and Histogram.
Min-Max method. defines the 0% and the 100% waveform levels as the lowest amplitude (most negative)
and the highest amplitude (most positive) samples. The min-max method is useful for measuring
frequency, width, and period for many types of signals. Min-max is sensitive to waveform ringing and
spikes, however, and does not always measure accurately rise time, fall time, overshoot, and undershoot.
The min-max method calculates the High and Low values as follows:
High = Max
and
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Low = Min
Histogram method. attempts to find the highest density of points above and below the waveform midpoint.
It attempts to ignore ringing and spikes when determining the 0% and 100% levels. This method works
well when measuring square waves and pulse waveforms.
The oscilloscope calculates the histogram-based High and Low values as follows:
1. It makes a histogram of the record with one bin for each digitizing level (256 total).
2. It splits the histogram into two sections at the halfway point between Min and Max (also called Mid).
3. The level with the most points in the upper histogram is the High value, and the level with the most
points in the lower histogram is the Low value. (Choose the levels where the histograms peak for
High and Low)
If Mid gives the largest peak value within the upper or lower histogram, then return the Mid value for
both High and Low (this is probably a very low amplitude waveform).
If more than one histogram level (bin) has the maximum value, choose the bin farthest from Mid.
This algorithm does not work well for two-level waveforms with greater than about 100% overshoot.

HighRef, MidRef, LowRef, Mid2Ref
You set the various reference levels, through the Reference Level selection of the Measure menu. They
include:
HighRef. the waveform high reference level. Used in fall time and rise time calculations. Typically set to
90%. You can set it from 0% to 100% or to a voltage level.
MidRef. the waveform middle reference level. Typically set to 50%. You can set it from 0% to 100% or to
a voltage level.
LowRef. the waveform low reference level. Used in fall and rise time calculations. Typically set to 10%.
You can set it from 0% to 100% or to a voltage level.
Mid2Ref. the middle reference level for a second waveform (or the second middle reference of the same
waveform). Used in delay time calculations. Typically set to 50%. You can set it from 0% to 100% or to
a voltage level.

Other variables
The instrument also measures several values itself that it uses to help calculate measurements.
Record Length. is the number of data points in the time base. You set it with the Horizontal menu Record
Length item.
Start. is the location of the start of the measurement zone (X-value). It is 0.0 samples unless you are
making a gated measurement. When you use gated measurements, it is the location of the left vertical
cursor.
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End. is the location of the end of the measurement zone (X-value). It is (RecordLength – 1.0) samples
unless you are making a gated measurement. When you use gated measurements, it is the location of
the right vertical cursor.
Hysteresis. is the hysteresis band 10% of the waveform amplitude. It is used in MCross1, MCross2, and
MCross3 calculations.
For example, once a crossing has been measured in a negative direction, the waveform data must fall
below 10% of the amplitude from the MidRef point before the measurement system is armed and ready for
a positive crossing. Similarly, after a positive MidRef crossing, waveform data must go above 10% of the
amplitude before a negative crossing can be measured. Hysteresis is useful when you are measuring noisy
signals, because it allows the oscilloscope to ignore minor fluctuations in the signal.

MCross calculations
MCross1, MCross2, and MCross3. refer to the first, second, and third MidRef cross times, respectively.
The polarity of the crossings does not matter for these variables, but the crossings alternate in polarity;
that is, MCross1 could be a positive or negative crossing, but if MCross1 is a positive crossing, MCross2
will be a negative crossing.

MCross Calculations
The instrument calculates these values as follows:
1. Find the first MidRefCrossing in the waveform record or the gated region. This is MCross1.
2. Continuing from MCross1, find the next MidRefCrossing in the waveform record (or the gated region)
of the opposite polarity of MCross1. This is MCross2.
3. Continuing from MCross2, find the next MidRefCrossing in the waveform record (or the gated region)
of the same polarity as MCross1. This is MCross3.
MCross1Polarity. is the polarity of first crossing (no default). It can be rising or falling.
StartCycle. is the starting time for cycle measurements. It is a floating-point number with values between
0.0 and (Record Length – 1.0), inclusive.
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StartCycle = MCross1
EndCycle. is the ending time for cycle measurements. It is a floating-point number with values between
0.0 and (Record Length – 1.0), inclusive.
EndCycle = MCross3
Waveform[<0.0 ... RecordLength–1.0>]. holds the acquired data.
TPOS. is the location of the sample just before the trigger point (the time reference zero sample). In other
terms, it contains the domain reference location. This location is where time = 0.
TSOFF. is the offset between TPOS and the actual trigger point. In other words, it is the trigger
sample offset. Values range between 0.0 and 1.0 samples. This value is determined by the instrument
when it receives a trigger. The actual zero reference (trigger) location in the measurement record is
at ( TPOS + TSOFF).

Measurement algorithms
The automated measurements are defined and calculated as follows:

Amplitude
Amplitude = High – Low

Aarea
The arithmetic area for one waveform. Remember that one waveform is not necessarily equal to one cycle.
For cyclical data you may prefer to use the cycle area rather than the arithmetic area.
If Start = End then return the (interpolated) value at Start.
Otherwise,

Details of the integration algorithm are given later. Integration Algorithm (see page 741)

Cycle area
Amplitude (voltage) measurement. The area over one waveform cycle. For data not cyclical, you might
prefer to use the Area measurement.
If StartCycle = EndCycle then return the (interpolated) value at StartCycle.
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Details of the integration algorithm are given later. Integration Algorithm (see page 741)

Burst width
Timing measurement. The duration of a burst.
1. Find MCross1 on the waveform. This is MCrossStart.
2. Find the last MCross (begin the search at EndCycle and search toward StartCycle). This is MCrossStop.
This could be a different value from MCross1.
3. Compute BurstWidth = MCrossStop – MCrossStart

Cycle mean
Amplitude (voltage) measurement. The mean over one waveform cycle. For non-cyclical data, you might
prefer to use the Mean measurement.
If StartCycle = EndCycle then return the (interpolated) value at StartCycle.

Details of the integration algorithm are given later. Integration Algorithm (see page 741)

Cycle RMS
The true Root Mean Square voltage over one cycle.
If StartCycle = EndCycle then CycleRMS = Waveform[Start].
Otherwise,

Details of the integration algorithm are given later. Integration Algorithm (see page 741)
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Delay
Timing measurement. The amount of time between the MidRef and Mid2Ref crossings of two different
traces, or two different places on the same trace.
Delay measurements are actually a group of measurements. To get a specific delay measurement, you must
specify the target and reference crossing polarities and the reference search direction.
Delay = the time from one MidRef crossing on the source waveform to the Mid2Ref crossing on the
second waveform.
Delay is not available in the Snapshot display.

Extinction ratio
Optical measurement between 1 and 100. In real circuits, the extinction ratio is typically 8 to 30. Values
≤ 1 or ≥ 100 generate errors. An Extinction Ratio of 1 or 100 means a problem exists. The optical probe
and the instrument must be calibrated. All inputs are micro watts and are not negative. Extinction ratio
is dimensionless.
Extinction Ratio = (High/Low)
Low ≥ 1 μW

Extinction %
Optical measurement.
Extinction % = 100.0 / Extinction Ratio

Extinction dB
Optical measurement. Extinction dB is typically 8 to 12 db. To exceed this range the input may be from
nonoptical probes or noncommunication lasers.
Extinction dB = 10.0 (log10(Extinction Ratio))

Fall time
fall time
Timing measurement. The time taken for the falling edge of a pulse to drop from a HighRef value (default
= 90%) to a LowRef value (default = 10%).
The following figure shows a falling edge with the two crossings necessary to calculate a Fall measurement.
1. Searching from Start to End, find the first sample in the measurement zone greater than HighRef.
2. From this sample, continue the search to find the first (negative) crossing of HighRef. The time of this
crossing is THF. (Use linear interpolation if necessary.)
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Fall Time
3. From THF, continue the search, looking for a crossing of LowRef. Update THF if subsequent HighRef
crossings are found. When a LowRef crossing is found, it becomes TLF. (Use linear interpolation if
necessary.)
4. FallTime = TLF – THF

Frequency
Timing measurement. The reciprocal of the period. Measured in Hertz (Hz) where 1 Hz = 1 cycle per
second.
If Period = 0 or is otherwise bad, return an error.
Frequency = 1 / Period

High
100% (highest) voltage reference value. See High Low (see page 730).
Using the min-max measurement technique:
High = Max

Low
0% (lowest) voltage reference value calculated. See High Low (see page 730)
Using the min-max measurement technique:
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Low = Min

Maximum
Amplitude (voltage) measurement. The maximum voltage. Typically the most positive peak voltage.
Examine all Waveform[ ] samples from Start to End inclusive, and set Max equal to the greatest
magnitude Waveform[ ] value found.

Mean
The arithmetic mean for one waveform. Remember that one waveform is not necessarily equal to one
cycle. For cyclical data you may prefer to use the cycle mean rather than the arithmetic mean.
If Start = End then return the (interpolated) value at Start.
Otherwise,

Details of the integration algorithm are given later. Integration Algorithm (see page 741)

Mean dBm
The normalized mean. If the waveform source is from an optical probe, this can give average optical power.
Mean dBm = 10.0 (log10(Mean / 0.001))

Minimum
Amplitude (voltage) measurement. The minimum amplitude. Typically the most negative peak voltage.
Examine all Waveform[ ] samples from Start to End inclusive, and set Min equal to the smallest magnitude
Waveform[ ] value found.

Negative duty cycle
Timing measurement. The ratio of the negative pulse width to the signal period expressed as a percentage.
NegativeWidth is defined in Negative Width, below.
If Period = 0 or undefined then return an error.
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Negative overshoot
Amplitude (voltage) measurement.

Note that this value should never be negative (unless High or Low are set out-of-range).

Negative width
Timing measurement. The distance (time) between MidRef (default = 50%) amplitude points of a negative
pulse.
If MCross1Polarity = –
then
NegativeWidth = (MCross2 – MCross1)
else
NegativeWidth = (MCross3 – MCross2)
Waveform[Start]

Optical power
See Mean dBm (see page 737).

Peak to peak
Amplitude measurement. The absolute difference between the maximum and minimum amplitude.
PeaktoPeak = Max – Min

Period
Timing measurement. Time taken for one complete signal cycle. The reciprocal of frequency. Measured
in seconds.
Period = MCross3 – MCross1
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Phase
Timing measurement. The amount of phase shift, expressed in degrees of the target waveform cycle,
between the MidRef crossings of two different waveforms. Waveforms measured should be of the same
frequency or one waveform should be a harmonic of the other.
Phase is a dual waveform measurement; that is, it is measured from a target waveform to a reference
waveform. To get a specific phase measurement, you must specify the target and reference sources.
Phase is determined in the following manner:
1. The first MidRefCrossing (MCross1Target) and third (MCross3) in the source (target) waveform
are found.
2. The period of the target waveform is calculated (see Period above).
3. The first MidRefCrossing (MCross1Ref) in the reference waveform crossing in the same direction
(polarity) as that found MCross1Target for the target waveform is found.
4. The phase is determined by the following:

If the target waveform leads the reference waveform, phase is positive; if it lags, negative.
Phase is not available in the Snapshot display.

Positive duty cycle
Timing measurement. The ratio of the positive pulse width to the signal period, expressed as a percentage.
PositiveWidth is defined in Positive Width, following.
If Period = 0 or undefined then return an error.

Positive overshoot
Amplitude (voltage) measurement.

Note that this value should never be negative.
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Positive width
Timing measurement. The distance (time) between MidRef (default = 50%) amplitude points of a positive
pulse.
If MCross1Polarity = +
then
PositiveWidth = (MCross2 –MCross1)
else
PositiveWidth = (MCross3 – MCross2)

Rise time
Timing measurement. Time taken for the leading edge of a pulse to rise from a LowRef value (default =
10%) to a HighRef value (default = 90%).
The following figure shows a rising edge with the two crossings necessary to calculate a Rise Time
measurement.
1. Searching from Start to End, find the first sample in the measurement zone less than LowRef.
2. From this sample, continue the search to find the first (positive) crossing of LowRef. The time of this
crossing is the low rise time or TLR. (Use linear interpolation if necessary.)
3. From TLR, continue the search, looking for a crossing of HighRef. Update TLR if subsequent LowRef
crossings are found. If a HighRef crossing is found, it becomes the high rise time or THR. (Use linear
interpolation if necessary.)
4. RiseTime = THR – TLR
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Rise Time

RMS
Amplitude (voltage) measurement. The true Root Mean Square voltage.
If Start = End then RMS = the (interpolated) value at Waveform[Start].
Otherwise,

For details of the integration algorithm, see below.

Integration Algorithm
The integration algorithm used by the instrument is as follows:

W(t) is the sampled waveform
Ŵ(t) is the continuous function obtained by linear interpolation of W(t)
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A and B are numbers between 0.0 and RecordLength – 1.0
If A and B are integers, then:

where s is the sample interval.
Similarly,

W(t) is the sampled waveform
Ŵ(t) is the continuous function obtained by linear interpolation of W(t)
A and B are numbers between 0.0 and RecordLength – 1.0
If A and B are integers, then:

where s is the sample interval.

Measurements on envelope waveforms
Time measurements on envelope waveforms must be treated differently from time measurements on other
waveforms, because envelope waveforms contain so many apparent crossings. Unless otherwise noted,
envelope waveforms use either the minima or the maxima (but not both), determined in the following
manner:
1. Step through the waveform from Start to End until the sample min and max pair do not straddle MidRef.
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Choosing Minima or Maxima to Use for Envelope Measurements
2. If the pair > MidRef, use the minima, else use maxima.
If all pairs straddle MidRef, use maxima. See the figure.
The Burst Width measurement always uses both maxima and minima to determine crossings.

Missing or out-of-range samples
If some samples in the waveform are missing or off-scale, the measurements will linearly interpolate
between known samples to make an appropriate guess as to the sample value. Missing samples at the ends
of the measurement record will be assumed to have the value of the nearest known sample.
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When samples are out of range, the measurement will give a warning to that effect (for example,
CLIPPING) if the measurement could change by extending the measurement range slightly. The
algorithms assume the samples recover from an overdrive condition instantaneously.
For example, if MidRef is set directly, then MidRef would not change even if samples were out of range.
However, if MidRef was chosen using the % choice from the Set Levels in % Units selection of the
Measure menu, then MidRef could give a CLIPPING warning.
NOTE. When measurements are displayed using Snapshot, out of range warnings are NOT available.
However, if you question the validity of any measurement in the snapshot display, you can select and
display the measurement individually and then check for a warning message.

Measurement warnings
The following measurement warnings can be generated by the instrument. They may be generated in
various situations such as those described below. In general, measurement warnings produce measurement
results that are uncertain.
Warning

Description

Not yet computed

Displayed until a measurement is completed. This is displayed if you hit the clear
button and the instrument is waiting for a trigger.

LT
GT

This is a measurement warning that’s only generated in some cases where null
samples are present in a waveform, such as an ET waveform or a math waveform
generated by arbflt() functions. It is a warning that strictly speaking a measurement
might be larger then or less then the reported value because some samples were
null in measured waveform.

Uncertain

This is a generic warning regarding an uncertain result and can result for
measurements that depend on multiple sub-measurements to generate a result
(such as area, or rms that need to measure times and voltages). If one of the
sub-measurements generates a warning the combination of warnings may be
combined to simply report ‘uncertain’ to the user.

Low signal amplitude

This is reported when the measurement system tries to find a cross for a waveform
less then 50 digitizing levels high.

Unstable histogram

This is generated for histogram measurements when the resulting histogram size
is too narrow to perform an accurate measurement. It might show up for some eye
measurements.

Low resolution

This is a common warning that can occur when there is insufficient horizontal
resolution to get accurate timing measurements.

Uncertain edge

This warning is generated in eye diagram measurements when there isn’t sufficient
resolution to determine an edge to measure.

Clipping positive
Clipping negative
Clipping pos neg

These are generated in response to any input waveform that has generated an over
range or under range DAC value, indicating the waveform went off screen.

xxx
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Measurement errors
The following measurement errors can be generated by the instrument. They may be generated in
various situations such as those described below. In general, measurements producing an error will
produce nothing.
Error

Description

Unstable

These are generic error messages that occur when the measurement system was
unable to obtain a correct measurement

Measurement system error
Zero period
No period found

These occur when the measurement system was unable to correctly measure the
period of a waveform

No period 2nd waveform
Low signal amplitude
Low amplitude 2nd wfm

These occur when the measurement system was unable to correctly measure the
signal amplitude of a waveform

Invalid gate

This error can occur if measurement gating was turned on and gated a measurement
to a region that was insufficient to complete a measurement

Waveform does not close ref

These errors can occur when the measurement system cannot correctly find edge
crossings for the specified edge crossing and waveform

No second ref crossing
No ref cross 2nd wfm
No backwards ref cross
Wfm does not cross Ref
No ref cross 2nd wfm
No ref cros 1st wfm
Constant waveform

This can be generated from various timing based measurements on flat waveforms

No valid edge

This can occur when the measurement package was unable to extract a valid edge
crossing in some timing measurements

xxx
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Cursor types
Because cursor measurements give immediate feedback on the amplitude or time values they measure,
they are usually quick to take and are more accurate than graticule measurements. Also, since you can
position cursors wherever you want them on the waveform, they are easier to localize to a waveform
segment or feature than automatic measurements.
The following table defines the cursor types.
Cursor function

Measurements
Horizontal cursors measure vertical parameters (amplitude)
in volts, watts, or IRE. The cursor readouts are defined as:
V1 = Level @ Cursor 1 with respect to its source ground
level.
V2 = Level @ Cursor 2 with respect to its source ground
level.
ΔV = Level @ Cursor 2 - Level @ Cursor 1.
Level is cursor displacement from the source ground
multiplied by the source in volts/div. The two cursors may
have different sources and therefore can have different
volts/div settings.
Vertical cursors measure horizontal parameters. Typically
the horizontal parameters are in time or frequency, but
depend on the units you select. The cursor readouts are
defined as:
T1 = Time @ Cursor 1 with respect to the trigger point
T2 = Time @ Cursor 2 with respect to the trigger point
ΔT = Time @ Cursor 2-Time @ Cursor 1
Time is divisions of displacement of the cursor from its
source trigger point multiplied by the source in time/div.
Waveform cursors measure vertical parameters (typically
volts) and horizontal parameters (typically time or frequency)
simultaneously. Each cursor is, in effect, both a vertical and
horizontal cursor. These paired cursors cannot be moved
off of the waveform. The two cursors can have a different
source.
Use screen cursors to indicate an arbitrary X and Y
position in the waveform display area represented by the
intersection of a vertical and horizontal cursor line. Screen
cursors measure both vertical parameters (typically volts)
and horizontal parameters (typically time or frequency).

xxx

What do you want to do next?
Learn about histograms. (see page 747)
Go to a step-by-step procedure for taking automatic measurements. (see page 606)
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Histograms
The instrument can display histograms constructed from the selected waveform data. You can display both
vertical (voltage) and horizontal (time) histograms, but only one at a time. Use histogram measurements to
get statistical measurement data for a section of a waveform along one axis.
The histogram source can be any channel, math, or reference waveform.
Turning on histograms starts histogram counting and data accumulation. A sample histogram display is
shown below. Histogram data is continuously accumulated until you explicitly turn off histograms. This
allows you to continue collecting histogram data even when you turn off the histogram display.
In addition to using limit controls to set histogram box boundaries, you can also use standard Windows
drag-and-drop to resize and reposition the histogram box.
Histograms are not available in Zoom modes.
What do you want to do next?
Go to a step-by-step procedure for starting histogram counting. (see page 666)
Go to a step-by-step procedure for taking automatic measurements. (see page 606)

Typical math waveforms
You create math waveforms when you create a math expression. You do so by applying numerical
constants, math operators and functions to operands. You can display and manipulate these derived
math waveforms much like you can the channel and reference waveforms (see Using Math Waveforms
(see page 610)).
NOTE. Math calculations are not available on digital channels.
Some examples of typical math waveforms follow:
To normalize this waveform:

Enter this math expression:

(Ch1- Meas1)/ Meas2, where Ch1 is the waveform shown
above Meas1 = Low of Ch1 Meas2 = amplitude of Ch1

And get this math waveform:
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To simulate AC coupling on this waveform:

Enter this expression:

Intg(Ch1-Avg(Ch1)), where Ch1 is the waveform shown
above Avg is the average function

And get this math waveform:

xxx

Offset, position, and scale
The settings that you make for offset, scale, and position affect the math waveform you obtain. Here are
some tips for obtaining a good display:
Scale and position the source waveform so that it is contained on the screen. (Off-screen waveforms
may be clipped, resulting in errors in the derivative waveform.)
Use vertical position and vertical offset to position your source waveform. The vertical position
and offset will not affect your derivative waveform unless you position the source waveform off
screen so that it is clipped.
What do you want to do next?
Learn about math waveform sources. (see page 752)
Go to a step-by-step procedure for creating math waveforms. (see page 616)

Math waveforms
Once you have acquired waveforms or taken measurements on waveforms, the instrument can
mathematically combine them to create a waveform that supports your data-analysis task. For example,
you might have a waveform clouded by background noise. You can obtain a cleaner waveform by
subtracting the background noise from your original waveform. Or, you can integrate a single waveform
into an integral math waveform as shown below.
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With spectral analysis you can analyze waveforms in the frequency domain. The interface is similar to
a dedicated spectrum analyzer, so you do not need to know the details of the underlying algorithms.
See the next figure.

This instrument supports mathematical combination and functional transformations of waveforms it
acquires. The next figure shows this concept:

You create math waveforms to support the analysis of your channel and reference waveforms. By
combining and transforming source waveforms and other data into math waveforms, you can derive the
data view that your application requires. Create math waveforms that result from:
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Mathematical operations on one or several waveforms: add, subtract, multiply, and divide.
Functional transformations of waveforms, such as integration, differentiation, and so on.
Spectral analysis of waveforms, such as testing impulse response.
You can create up to four math waveforms.
Measurement scalars can be used in math expressions. For example, you can measure the average of
a waveform (using the measurement capabilities of the instrument) and subtract it from the original
waveform to define a new math waveform. Measurements 1 through 8 are allowed in a math definition,
but not measurement functions, such as rise (Ch1).
This instrument supports the following operations for math waveforms:
Vertical display scaling and positioning
Taking automatic measurements
Taking cursor measurements
Using histograms
User defined vertical units
In addition to the operations listed above, you can save math waveforms as reference waveforms.
You cannot use the following math waveforms for some operations:
Circular Math-on-Math. You cannot use circular definitions of math waveforms. For example, if you
define Math2 = Ch1 - Math1, and then define a second math waveform as Math3 = Ch2 + Math2, you
cannot define a third math waveform as Math1 = Math2 + Ch3. If you do, the Math1 definition is
rejected with an error because a circular definition is not allowed.
Fast Acquisitions. Math is not allowed in Fast Acquisitions mode.
Roll Mode. Math is not allowed in roll mode until you push STOP.
Different Length Sources. If you use two waveforms (channel and reference waveforms) of different
lengths, the length of the math waveform will be the shorter of the two lengths.
What do you want to do next?
Learn about creating math waveforms. (see page 747)
Go to a step-by step procedure for using math waveforms. (see page 610)

Math waveform differentiation
The math capabilities of the instrument include waveform differentiation. This allows you to display a
derivative math waveform that indicates the instantaneous rate of change of the waveform acquired.
Derivative waveforms are used in the measurement of slew rate of amplifiers and in educational
applications. You can create a derivative math waveform and then use it as a source for another derivative
waveform. The result is the second derivative of the waveform that was first differentiated.
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The math waveform, derived from the sampled waveform, is computed based on the following equation:
Yn = (X( n + 1) - Xn) 1/T
Where: X is the source waveform, Y is the derivative math waveform, and T is the time between samples.
Since the resultant math waveform is a derivative waveform (see the next figure), its vertical scale is in
volts/second (its horizontal scale is in seconds). The source signal is differentiated over its entire record
length; therefore, the math waveform record length equals that of the source waveform.

Cursor Measurements
You can also use cursors to measure derivative waveforms. Use the steps in Taking Cursor Measurements
(see page 605). When using that procedure, note that the amplitude measurements on a derivative
waveform will be in volts per second rather than in volt-seconds as is indicated for the integral waveform
measured in the procedure.
NOTE. Cursor measurements are not available on digital channels.
What do you want to do next?
Learn more about cursor measurements. (see page 84)
Go to a step-by-step procedure for creating math waveforms. (see page 616)
Go to a step-by step procedure for using math waveforms. (see page 610)
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Math waveform sources
You can create Math waveforms from the following:
Channel waveforms
Reference waveforms
Measurement scalars (automated measurements) that measure channel, reference, or math waveforms,
or histograms.
Other math waveforms
Variables

Dependencies
In general, math waveforms that include sources as operands are affected by updates to those sources:
Shifts in amplitude or DC level of input sources that cause the source to clip also clip the waveform
data supplied to the math waveform.
Changes to the vertical offset setting for a channel source that clip its data also clip the waveform
data supplied to the math waveform.
Changes to the acquisition mode globally affects all input channel sources, modifying any math
waveforms using them. For example, with the acquisition mode set to Envelope, a Ch1 + Ch2 math
waveform will receive enveloped channel 1 and channel 2 data, and will also be an envelope waveform.
Clearing the data in a waveform source causes a baseline (ground) to be delivered to any math
waveform that includes that source until the source receives new data.
What do you want to do next?
Learn about math waveform expression syntax. (see page 753)
Go to a step-by-step procedure for creating math waveforms. (see page 616)
Go to a step-by step procedure for using math waveforms. (see page 610)
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Math waveform expression syntax
You can build math waveforms using the Predefined Expressions or Equation Editor control window. To
help you create valid math waveforms, the following tools will block most illegal entries by disabling any
window element that would create an invalid entry in the math waveform expression.
Predefined expressions are performed from the Math Setup control window by selecting an expression.
The following syntax describes the valid math expressions you can use with the Equation Editor:
<MathWaveform> := <Expression>
<Expression> := <UnaryExpression> | <BinaryExpression>
<UnaryExpression> := <UnaryOperator> ( <Term>) | <UnaryOperator> (
<Expression>)
<BinaryExpression> := <Term> <BinaryOperator> <Term> | <Scalar>
<BinaryOperator> <Term> | <Term> <BinaryOperator> <Scalar>
<Term> := <Waveform> | ( <Expression>)
<Scalar> := <Integer> | <Float> | <Meas-Result>
<Waveform> := <ChannelWaveform> | <ReferenceWaveform> | <MathWaveform>
<ChannelWaveform> := Ch1 | Ch2 | Ch3 | Ch4
<ReferenceWaveform> := Ref1 | Ref2 | Ref3 | Ref4
<MathWaveform> := Math1 | Math2 | Math3 | Math4
<UnaryOperator> := Invert | Derivative | Integral | Average | Max | Min |
Filter | Vmag | Exp | log 10 | log e | sqrt | Spectral Magnitude| Spectral
Phase | Spectral Real | Spectral Imag
<BinaryOperator> := + | - | / | *
<Meas-Result> := meas1 | meas2 | meas3 | meas4 | meas5 | meas6 | meas7 | meas8
<Variable> = VAR1 |VAR2 |VAR3 |VAR4

What do you want to do next?
Learn about math waveform differentiation. (see page 750)
Go to a step-by-step procedure for creating math waveforms. (see page 616)
Go to a step-by step procedure for using math waveforms. (see page 610)
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Offset, position, scale, and math waveforms
The settings that you make for offset, scale, and position affect the math waveform you obtain. Here are
some tips for obtaining a good display:
Scale and position the source waveform so that it is contained on the screen. (Off-screen waveforms
may be clipped, resulting in errors in the derivative waveform).
Use vertical position and vertical offset to position your source waveform. The vertical position
and offset will not affect your derivative waveform unless you position the source waveform off
screen so that it is clipped.
What do you want to do next?
Learn about waveform integration. (see page 754)
Go to a step-by-step procedure for creating math waveforms. (see page 616)
Go to a step-by step procedure for using math waveforms. (see page 610)

Waveform integration
The math capabilities of the instrument include waveform integration. This allows you to display an
integral math waveform that is an integrated version of the acquired waveform.
Use integral waveforms in the following applications:
Measuring power and energy, such as in switching power supplies.
Characterizing mechanical transducers, as when integrating the output of an accelerometer to obtain
velocity.
The integral math waveform, derived from the sampled waveform, is computed based on the following
equation:

Where: x(i) is the source waveform, y(n) is a point in the integral math waveform, scale is the output
scale factor, and T is the time between samples.
Since the resultant math waveform is an integral waveform, its vertical scale is in volt-seconds (its
horizontal scale is in seconds). The source signal is integrated over its entire record length; therefore, the
math waveform record length equals that of the source waveform.
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Offset and position
When creating integrated math waveforms from live channel waveforms, consider the following:
You should scale and position the source waveform so that it is contained on screen. (Off screen
waveforms may be clipped, which will result in errors in the integral waveform.)
You can use vertical position and vertical offset to position your source waveform. The vertical
position and vertical offset will not affect your integral waveform unless you position the source
waveform off screen so that it is clipped.

DC offset
The source waveforms that you connect to the instrument often have a DC offset component. The
instrument integrates this offset along with the time-varying portions of your waveform. Even a few
divisions of offset in the source waveform may be enough to ensure that the integral waveform saturates
(clips), especially with long record lengths.
What do you want to do next?
Learn about spectral math waveforms. (see page 763)
Go to a step-by-step procedure for creating math waveforms. (see page 616)
Go to a step-by step procedure for using math waveforms. (see page 610)

Using math plugins
Math plugins extend the current built-in math system on your instrument. When the TekScope
application starts, it scans C:\Users\Public\Tektronix\Plugins\Math and C:\Users\<current user
ID>\Tektronix\Plugins\Math for .NET libraries and loads any tagged functions into the math system. For a
library to load, it must have the word math, meas or plugin in its name. If a plugin library is placed in
one of the folders after the TekScope application has started, the plugin will not be available until the
application is restarted. Plugins are only loaded when TekScope starts up to avoid performance impact.
Once the instrument has started, the plugin is used in the math system like any built in function. For
example, if one of the libraries provides two functions, MyAdd and MyMultiply, each of which takes two
vector inputs, the following math definitions are valid:
Math1=MyAdd(Ch1, Ch2)
Math1=MyMultiply(Ch1+Ch2, Ch3)
Math2=MyAdd(Ref1, Math1)
Math1=MyMultiply(Ch1, Ch2)+Inv(Ch3)
Math1=MyMultiply(Avg(Ch1), Ch2)
The math system generates standard syntax errors if there is an issue with a math equation using a plugin,
such as a missing parenthesis. If there is an error with the plugin itself, math reports a plugin specific error.
This may be that the plugin is not valid because it has mismatched input and output types or that an
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argument specified in the equation does not match the type expected by the plugin (for example, a string
was expected but a FastFrame waveform was supplied).

Writing math plugins
You can write plugins in any .NET language. The following examples use C#. When writing a plugin,
reference the ScopeSupportBase.dll and TekScriptingEngine.dll system assemblies. Additionally, tag all
plugins with the C# attribute [Math] if they are to be loaded into the system.
Six different classes are used inside plugins: INormalizedVector, IFastFrame, IWaveformDB, IString,
ISettings and IRange. The first two, INormalizedVector and IFastFrame, are waveform vector types used
by the instrument. The third, IWaveformDB is a pixmap waveform. IStrings, ISettings and IRange are
used to pass additional information into a plugin.

Waveform types
All waveform classes contain a member called SourceName. This is a string that contains the symbol
name of the waveform source. If the source is a channel, math or reference waveform, the SourceName
will be Ch<x>, Math<n> or Ref<n>, respectively. If the waveform is an intermediate, the SourceName
will be Intermediate0, if it is the output waveform or Intermediate<n> if it’s an input vector, where <n>
corresponds to which argument it is. Examples of intermediates are:
Math1=MyAdd(Ch1, Ch2)*Ch3: The output of MyAdd is an intermediate because it still needs to
be multiplied by Ch3 before being put into Math1. The SourceName for the output waveform will
be Intermediate0.
Math1=MyAdd(Ch1*Ch2, Ch3): The first input is an intermediate because two channels are being
multiplied together. Its SourceName will be Intermediate1.
Math1=MyAdd(Ch1, Ch2/Ch3): The second input is an intermediate because two channels are being
divided. Its SourceName will be Intermediate2.
INormalizedVector is the basic waveform type used by TekScope. The length of the vector is found in the
Count member of the class. Array indices are used to access values inside the vector:
INormalizedVector output;
INormalizedVector input1;
for (long i = 0; i < input1.Count; i++)
output[i] = input1[i];
IFastFrame is built on top of INormalizedVector. An IFastFrame is a grouping of INormalizedVectors.
IFastFrames are generated when FastFrame is enabled on the instrument. The number of frames is stored
in the member called FrameCount. You can iterate through the frames by setting the CurrentFrame (note:
frames are 1 counted so you should iterate from 1 to FrameCount). Once you set the CurrentFrame, you
use the IFastFrame the same as an INormalizedVector.
IFastFrame output;
IFastFrame input1;
IFastFrame input2;
for (long f = 1; f <= output.FrameCount; f++)
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{
input1.CurrentFrame = f;
input2.CurrentFrame = f;
output.CurrentFrame = f;
for (long i = 0; i < output.Count; i++)
output[i] = input1[i] * input2[i];
}
The final waveform type is IWaveformDB (waveform database or DPO data). This type essentially tracks
hits in a visual manner. The higher the value that is stored into a point relative to the other values stored,
the brighter the color will be. Unlike an INormalizedVector or an IFastFrame, the IWaveformDB goes
both horizontally and vertically across the screen. The horizontal length is in Horizontal.Count and the
vertical height is in Vertical.Count. To access a point inside the IWaveformDB, use double array indices
where the vertical position comes before the horizontal position:
IWaveformDB output;
long hCount = output.Horizontal.Count;
long vCount = output.Vertical.Count;
for (long hh = 0; hh < hCount - 1; hh++)
{
Parallel.For(0, vCount, vv =>
{
output[vv, hh] = output[vv, hh + 1];
});
}
If the output type of a plugin is IWaveformDB, when the plugin is called the output waveform is populated
with the values the plugin returned the last time it was called. If this is the first time the plugin was called,
all of the values inside the IWaveformDB will be zero (displays as clear).
The advanced user can change the vertical scale and position, as well as the horizontal scale and spacing by
setting Vertical.Scale, Vertical.Position, Horizontal.Scale, and Horizontal.Spacing in the IWaveformDB.

IString
A plugin may use an unlimited number of IStrings as input. An IString is simply a string and is used to
pass meta data or additional information into a plugin.

ISettings: scope settings
You can access information about instrument settings through ISettings. Settings for the math target, as
well as the input and output waveforms, are put into the dictionary. However, if the waveform is an
intermediate, no setting information is available. Examples of intermediates are:
MATH1=Add(Ch1*Ch2, Ch3): Ch1*Ch2 is an intermediate
MATH1=Add(Ch1, Ch2)*Ch3: The output of Add is an intermediate
To look up information in ISettings, you need to know the waveform name. For input or output waveforms,
this is put into the SourceName field. This is either Ch<n>, Math<n>, Ref<n> or Intermediate<n> if it is a
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channel, math, reference, or intermediate waveform respectively. To find the name of the target math, look
up MathTarget in ISettings (a string of the form Math<n> is returned).
Once you have the waveform name, you can look up the following information:
Vertical scale (“VScale”)
Vertical offset (“VOffset”)
Vertical position (“VPosition”)
Vertical units (“VUnits”)
Horizontal scale (“HScale”)
Horizontal offset (“HOffset”)
Horizontal position (“HPosition”)
Horizontal units (“HUnits”)
Additionally, the following information about the target math is available:
LPCT
MPCT
HPCT
HYSTPCT
The recommended method for looking up information is to use the ISettings::GetNumber(string
sourceName, string name, double defaultValue) and ISettings::GetString(string sourceName, string name,
double defaultValue) functions. For example, to get the name of the target math:
string mathTarget = settings.GetString("", "mathTarget", "");
Or to get the vertical scale for an input:
double scale = settings.GetNumber((!string.IsNullOrEmpty(input1.SourceName) ?
input1.SourceName : ""), "vscale", double.NaN);
Note: Strings are not case sensitive, so VSCALE and vscale return the same information.
You can also use the array operators to look up information, but if the information is not in the dictionary
you may end up with null objects:
string mathTarget = settings["mathTarget"];
double scale = settings["ch1.vscale"];
This may be useful for debug purposes however.

IRange: gating information
Currently, the IRange parameter will always be null. It is in place to support future features.
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Plugin rules
Plugins require at least one and at most two vector inputs (either INormalizedVector or IFastFrame). If two
vector inputs are used by the plugin, they both must be the same type. Additionally, plugins may take an
unlimited number of IStrings as input. When using IString inputs, it is important to remember that the
entire math equation, when typed into the editor, is limited to 128 characters.
Plugins can generate an INormalizedVector, IFastFrame or IWaveformDB waveform as output. If the
output type is INormalizedVector, the vector input(s) must also be INormalizedVector. For IFastFrame and
IWaveformDB outputs, the inputs can be INormalizedVector or IFastFrame.
If FastFrame is turned off and the plugin takes IFastFrames as input, the plugin is given IFastFrames that
consist of only one frame. How the plugin behaves when FastFrame is turned on depends on the output
waveform type. If the output is an INormalizedVector, which takes only INormalizedVector as input, the
plugin is called once per frame and the math system handles iterating through all of the frames. If the
plugin produces IFastFrame or IWaveformDB it is called once per FastFrame acquisition. When the plugin
takes as input an IFastFrame, it is given all of the frames at once. If the plugin takes an INormalizedVector
as input, the plugin will only see the first frame which is put into the INormalizedVector. The rest of the
frames in the FastFrame are not seen by the plugin.
Summary of valid plugin signatures and behavior
Output Type

Vector Input Type

FastFrame Off

FastFrame On

INormalizedVector

INormalizedVector

Called once per acq

Called once per frame

IFastFrame

INormalizedVector

Called once per acq

First frame put into
INormalizedVector

IFastFrame

IFastFrame

Called once per acq; Only
contains one frame

Called once per FastFrame

IWaveformDB

INormalizedVector

Called once per acq

First frame put into
INormalizedVector

IWaveformDB

IFastFrame

Called once per acq; Only
contains one frame

Called once per FastFrame

xxx

Example plugins
If the Application Developer Kit has been installed on the instrument, example plugins can be found in
Microsoft Visual Studio. When you create a new project, choose Visual C#->Tektronix->Math to access
the examples.

Create a plugin
To create a plugin, you need to use either one of our Visual Studio templates or create a new project using
the .NET language of your choice. To create a C# plugin from scratch, you first need to create a new, empty
C# project. Once you create your project, add references to ScopeSupportBase, TekScriptingEngine,
System.Data, System.Data.DataSequence, System.XML and System.Xml.Linq. In your code, use System,
System.Collections.Generic, System.Linq, System.Text, and Tek.Scope.Support.
There are no requirements for the name of the class or namespace the plugins use. In this example
the namespace is MyMathPlugins and the class name is MyMath. The plugin function is a public,
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static function inside the class with the math attribute. We call our plugin Add, and it takes two
INormalizedVectors as input and produces an INormalizedVector.
namespace MyMathPlugins
{
class MyMath
{
// Add(<wfm>, <wfm>):
// This plugin adds two INormalizedVector inputs
[Math]
public static void Add(ISettings settings, IRange gate, INormalizedVector output, INormalizedVector
input1, INormalizedVector input2)
{
// We only want to add up to the shorter input length
if (input1.Count < input2.Count)
{
output.Count = input1.Count;
output.Horizontal.Spacing = input1.Horizontal.Spacing;
output.Horizontal.ZeroIndex = input1.Horizontal.ZeroIndex;
}
else
{
output.Count = input2.Count;
output.Horizontal.Spacing = input2.Horizontal.Spacing;
output.Horizontal.ZeroIndex = input2.Horizontal.ZeroIndex;
}
// Add two inputs together
for (long i = 0; i < output.Count; i++)
output[i] = input1[i] + input2[i];
}
}
}
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When compiling the project, make sure the target platform is Any CPU. Once the DLL is compiled
(release or debug, both work), it should be placed in the appropriate directory on the instrument. Restart
the instrument application, and the plugin is ready to use like any existing math operator.

MATLAB custom functions
The Custom Analysis Interface for use with MATLAB provides two options for writing MATLAB custom
analysis functions: a basic function interface and a more advanced class-based interface. Both types are
available in demo form on the instrument in C:\Users\Public\Tektronix\Plugins\Math\MATLAB.

Using the basic Function interface to create MATLAB functions
The function interface uses a simple signature: function [ output ] = exampleProcessingFunction(
firstTime, varargin ) Your function should take two inputs: a Boolean that indicates whether or not this is
the first time the function has been called and a variable length array. Put the results that you want the
instrument to display into the output variable of the same length as the input array.
If this is the first time the function has been called as part of the math expression, firstTime is true. In this
case, the varargin array consists of the record length and the sample rate:
recordLength = varargin{1};
sampleRate = varargin{2};
and the output is expected to be true:
output = true;
If you have any one time processing, such as filter creation, do this when firstTime is true. If you want
to have variables from a previous execution of the function available, you should mark the variables
persistent. See the examples for more information. Note that persistent variables are automatically cleared
before the first execution of the function.
If this is not the first time the function has been called, then firstTime is false and varargin will consist of the
waveform inputs. The math expression may have one or two waveform inputs to the MATLAB function:
input1 = varargin{1};
if numel(varargin) == 2
input2 = varargin{2};
end
From here you can do any computations you want and put the results into the output. Your MATLAB
function can use any features available in MATLAB or installed toolboxes to perform its calculations.
Note that the output must have the same length as the inputs. If your output vector is shorter, zero out
the remaining points.
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Using a Class to create MATLAB functions
An dvanced user can create a MATLAB custom analysis function by subclassing
instrument.integration.AlgorithmDefinition. The waterfall.m class shows an example of this type of
custom analysis function. This is more complex than using a function but allows more control of behavior
than the basic function capability. By using a subclass, you can implement custom tear-down behaviors,
such as closing plots automatically when an analysis function is no longer being called.
Your class should be a subclass of instrument.integration.AlgorithmDefinition:
classdef myClass < instrument.integration.AlgorithmDefinition
There are four methods your class may need to implement: a constructor, a destructor, a process, and a
stopProcessingHook. The default destructor and stopProcessingHook from the superclass may be sufficient
for your class. However, at minimum you need to implement a constructor and the process function:
classdef myClass < instrument.integration.AlgorithmDefinition
methods
function obj = myClass(sampleRate,pointsPerRecord)
obj@instrument.integration.AlgorithmDefinition(sampleRate,pointsPerRecord);
end
function [result] = process(obj,varargin)
result = varargin{1};
end
end
end
The constructor is called the first time the analysis function is used in a specific math expression on the
instrument. Here anything that requires setup before processing data, such as plots, should be configured.
The parent constructor can be called from your custom construct if necessary (the constructor for
AlgorithmDefinition sets up some basic settings information about the instrument).
The process function is the main workhorse of the class. This function computs results and returns data to
the instrument. Like the custom analysis functions created using the basic function interface, the length of
the results returned by your process function should match the length of the input.
The stopProcessingHook function is called when the analysis function is no longer in use by the
instrument. This may happen when you edit or clear a math function, or in other situations when the
instrument math system expects that the state should be reset. For example, if your analysis function is
displaying a plot, this would be the time to close the plot.
Finally, the destructor is called when the analysis function is no longer in use. Typically you call the
stopProcessingHook function from here to aid in cleanup.
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Spectral math waveforms
The math capabilities of the instrument include waveform spectral analysis. This section describes how you
can control the analysis intuitively with time domain and frequency domain controls. These controls merge
the time domain controls with the frequency domain controls to provide a complete spectral analyzer.
Signals may be represented by their characteristics in both the time and the frequency domain. By
combining and transforming source waveforms into spectral math waveforms, you can simultaneously
view signal characteristics in both domains.
This spectral analyzer provides a complete set of controls and features that allow you to make time and
frequency domain measurements without the need to learn extensive details about FFT algorithms.
Frequency Domain Controls. Use traditional spectrum analyzer controls to set the center frequency,
span, and resolution bandwidth directly.
Time Domain Controls. The time domain controls for the acquired waveform set the time duration
and the resolution (time between samples). You can easily set the required sample rate and record
length.
Gating Controls. These controls are the bridge that connects the time domain to the frequency
domain. You can perform spectral analysis on a gated region of the input waveform. This gating also
determines the resolution bandwidth.
Window Functions. Eight different window functions are available to shape the filter response.
Magnitude Versus Frequency. Displays log data in dB, dBm, or linear mode. You can display the
real or imaginary parts of the spectral magnitude only. Reference level offset and reference level
controls give complete control over the vertical position and offset of the spectrum.
Phase Versus Frequency. Displays phase data as a function of frequency in radians or degrees. You
may zero the noise phase for magnitudes below a threshold level. Finally, you may select Phase
unwrap and dq/dw, group delay.
Spectral Averaging. You can turn on averaging in the frequency domain for phase and magnitude
waveforms.
Multiple Analyzer Control Locks. Up to four spectral analyzers can be used simultaneously. They
can all be assigned to different gates on the same source waveform or to different channel sources.
The controls of Math1 and Math2 can be locked, and the controls of Math3 and Math4 can be locked.
When controls are locked, turning a control on one analyzer changes the control on the other analyzer
to the same value. Other combinations of locking, including all four analyzers, are available using
GPIB commands.
The same exclusions for math waveforms apply to spectral math waveforms. In addition, sources for
spectral math waveforms must be channel waveforms.
What do you want to do next?
Learn about using the spectral math controls. (see page 764)
Go to a step-by-step procedure for creating a spectral math waveform. (see page 627)
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Spectral math controls
The spectral analyzer contains five primary control categories. These are shown in the table below.
Click one of the links for more information on using each type of control.
Time controls (see
page 764)

Gate controls (see
page 766)

Frequency controls
(see page 767)

Magnitude controls
(see page 769)

Phase controls
(see page 770)

Source

Position

Center

dB, dBm linear, real
imaginary

degrees, radians,
group delay

Duration, record
length

Duration

Span

Ref level

Zero threshold

Duration, sample
rate

Window

Resolution
bandwidth

Ref level offset

Phase Unwrap

Resolution
xxx

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)
Learn how to recognize aliasing. (see page 784)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)

Spectral math time controls
The operation of the time domain controls for the spectral analyzer is summarized by the following rules:
Duration selects the time from the beginning to the end of the acquired waveform. You may set
duration using the record length control or the sample rate control.
Resolution determines the time between samples. Duration is kept constant as resolution is changed.
Therefore, the Resolution control affects both the sample rate and the record length simultaneously.
Most often, you will want to use a short record length because long record lengths can slow instrument
response. However, long record lengths lower the noise relative to the signal and increase the
frequency resolution for the spectral math waveform. More importantly, they might be needed to
capture the waveform feature that you want to include in the waveform.
Examples of how duration and resolution affect the acquired waveform are shown in the next figure.
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What do you want to do next?
Go to a list of all spectral math controls. (see page 764)
Learn more about spectral math controls. (see page 766)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)
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Spectral math gating controls
Gating determines which portion of the acquired waveform is transformed into the frequency domain. The
gate has a position and a width control.
The gate position is the time in seconds from the trigger location to the center 50% position of the gate
interval (see the next figure). The position and width units are seconds.

The gate must reside within the duration interval of the source waveform. If the source waveform duration
is adjusted, and the gate position and width would result in the gate being outside of that duration, then
the gate position or width is set within the limits.
The width of the gate affects the resolution bandwidth of the spectral analyzer. Gate width has units of
seconds. The resolution bandwidth directly controls the gate width, but the numerical value is entered
in units of hertz. Therefore, the time domain gate markers move as you adjust the resolution bandwidth
control.
The data contained in the gated region is transformed into the frequency domain.
The gate is identified on the display using dashed markers (similar to cursors). The default gate width
setting is equal to the duration of the source waveform.
What do you want to do next?
Go to a list of all spectral math controls. (see page 764)
Learn more about spectral math controls. (see page 767)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)
.
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Spectral math frequency domain controls
The gated region of the source waveform is transformed into a spectral phase or magnitude waveform. The
horizontal units are always hertz. The vertical units depend on whether phase or magnitude is selected.
The frequency domain controls for the spectral waveform are span, center, and resolution bandwidth. The
spectrum normally appears on the display fit to a screen width of 10 divisions.

Span
Span is the frequency at the end of the spectral waveform minus the frequency at the beginning of
the waveform. The span control maximum value is equal to the current sample rate divided by two.
Therefore, if you are unable to increase the span to the desired value and if you want to keep the same
source waveform duration, go to the time base controls and increase the sample rate using the resolution
control. Or, if you want to also decrease the source waveform duration, adjust the sample rate control. If
you decrease the sample rate, the span setting may decrease, if necessary, to keep the span less than the
sample rate divided by two.

Center
This is the frequency at the center of the spectral waveform. Center is equal to the start frequency plus
one half of the span. The adjustment range depends on the sample rate and the current span setting.
Remember that the span must always be in the interval of zero to one half of the sample rate. Therefore, if
the span is set to full, the center frequency control will not have any adjustment range and will remain at
one half of the sample rate. It is necessary to decrease the span before the center will have an adjustment
range. If you are unable to increase the center to the desired value, increase the sample rate using either
the sample rate or resolution controls. You may also change sample rate by using the HORIZONTAL
SCALE knob on the instrument front panel.

Resolution bandwidth ( RBW)
This is the 3 dB down bandwidth of the spectral analyzer frequency response to a sine wave input. The
resolution bandwidth is affected by two parameters:
Different window functions produce different filter response shapes in the spectrum and result in
different resolution bandwidths.
The gate width of the input data affects the RBW because the RBW is inversely proportional to the
gate width. So, adjusting the gate width changes the RBW. Gate width has units of seconds. The RBW
directly controls the gate width, but the numerical value is entered in units of hertz. Therefore, the
time domain gate markers move as you adjust the RBW control.
The next figure demonstrates the effects of adjusting the center frequency and span. Center frequency is a
horizontal position control for the spectrum. Span is a horizontal scale control. Resolution bandwidth
adjusts the bandwidth of the analyzer filters without affecting the span and center frequency.
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What do you want to do next?
Go to a list of all spectral math controls. (see page 764)
Learn more about spectral math controls. (see page 769)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)
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Spectral math magnitude controls
Vertical units can be either linear or log. You can select from the following choices by clicking the Math
menu button. Then select the Spectral Analysis Setup command.

Mag tab
Select the desired scale type, Linear, dB, or dBm:
Linear. When the spectrum is linear magnitude the vertical units are the same as the source waveform.
Usually this is volts. However, it may also be watts or amperes.
dB. This sets the vertical scale of the magnitude spectrum to dB. Use the Reference Level Offset to set
which vertical position in the magnitude spectrum will be zero dB. The following equation applies:
dB = 20 log (|X| - Ref)
Where X is a complex data point in the spectrum and Ref is the Reference Level Offset value.
dBm. This selects dB as described in the above equation, but also sets the Reference Level Offset to a
value that is equivalent to 1 mW of power into 50 ohms. Therefore, if the input units are volts, then the
value is set to 223.6 mV. If the input units are amperes, then the value is set to 40 mA. If the input
units are watts, then the value is set to 1 mW.

Reference level
This sets the vertical position of the displayed spectrum.
Its value is the magnitude at the top of the display screen.
When this control is adjusted, the spectral waveform along
with its zero reference marker move vertically on the screen
as shown. This control does not change the spectral data.

xxx
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Reference level offset
This changes the value of Ref in the equation for dB shown
above. Unlike the Reference Level control, this control
actually changes the output data values in the spectrum.
Zero dB is shown on the display screen by the marker
associated with the spectral waveform. Adjusting the
Reference Level Offset causes the spectral waveform to
move vertically with respect to the waveform reference
marker as shown. This moves the waveform without
changing the Reference Level control setting. Sometimes
it is beneficial to adjust this control so that the peak of a
fundamental is at zero dB. Then you can measure other
harmonics in terms of how many dB they are away from the
fundamental. Click the dBm button to preset this level to the
equivalent of 1 mW into 50 ohms.

xxx

Real and imaginary magnitudes
You can display the linear magnitude of the real data or the imaginary data in the spectrum. This is useful
if you process the spectrum off line and transform it back into a time domain trace. You can save the real
and the imaginary spectrum into reference memory, and export the waveforms directly into Mathcad,
MATLAB, or Excel documents to update in real time.
To turn on a real or imaginary spectrum, click the Math menu button, select Define/Edit Expression
Editor, and select the Freq tab. Click either the Real or the Imag buttons and enter an expression. Click
the appropriate channel button, and click Apply.
What do you want to do next?
Go to a list of all spectral math controls. (see page 764)
Learn more about spectral math controls. (see page 770)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)

Spectral math phase controls
Select the phase controls
You can set the vertical units to Degrees, Radians, or Group Delay in seconds. To do this, click the Math
toolbar button, click Spectral Analysis Setup, and select the Phase tab. Then select the desired scale type
from Degrees, Radians, or Group Delay.
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Phase reference position
Phase is a relative measurement that must have a time domain reference point. The phase value is specified
with respect to this phase reference position.
For the spectral analyzer, the phase reference position is the 50% position of the gate, that is, the middle of
the gate interval of the data that is input to the spectral analyzer. This is true for all window functions
except for the Tek Exponential window. This window has a reference point at the 20% position of the gate.

Phase unwrap
The spectral analyzer produces phase values from –π to +π radians or –180 to 180 degrees. However,
when you perform impulse response testing and the phase is continuous, then phase values outside these
ranges may occur. The spectral analyzer then wraps the data with discontinuities in the display from +180
to –180 degrees. Phase unwrap will display the correct result by unwrapping the phase.
Phase unwrap is only valid when the phase spectrum is a continuous function of frequency. Therefore, do
not use it when analyzing the harmonic content of the typical repetitive signal.

Suppression threshold
Random noise in the spectrum may have phase values over the entire range. This could make the phase
display unusable. However, you can set the suppression threshold control to a level in dB. The phase of
any complex spectral points with a magnitude below this threshold is set to zero. See the next figure
for an example.

Group delay
When the phase spectrum is a continuous function of frequency, group delay may be computed. This is
true of impulse response testing where an impulse is fed into the system, and the spectrum of the response
of the system output is computed.
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Group delay measures how well a system passes a signal in terms of phase distortion. Group delay is the
derivative of the phase with respect to frequency.
This feature is not useful for analysis of harmonic content of signals where the phase response is not
continuous.

Impulse response testing
When performing impulse response testing of a system, place the impulse at the zero-phase reference
position of the acquisition. This produces a correct phase display. Because the Tek Exponential window
has its zero phase reference position at the 20% point, more of the impulse response is captured. All other
window functions have their phase reference position at the 50% position in the gated region.
There are several ways to adjust the position of the zero phase reference point with respect to your input
signal:
Adjust the spectral analyzer gate position
Perform fine adjustment using the front-panel trigger level control
Adjust the front-panel horizontal Position control

Spectral analyzer windows
In the time domain, a window is a bell-shaped function
equal in length to the gate duration.
For most windows, this function tapers to zero at
both ends of the gate region. Before computation of
the spectral transformation, the window is multiplied,
sample by sample, times the input data in the gated
region. The window function affects the shape of the
spectral analyzer response in the frequency domain.

xxx

The window functions affect the ability to resolve frequency in the output spectrum and can affect the
accuracy of the magnitude and phase measurements. The previous figure shows how the time domain
record is processed.
Accurate magnitude measurements require that the input source waveform be stationary within the gated
region. This means that waveform parameters, such as frequency and amplitude, should not change
significantly as a function of time within the gate region that is input to the spectral analyzer. Also, the gate
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width must be greater than or equal to the period of the start frequency of the span of the spectral analyzer.
That is, there must be at least one cycle of the harmonic being measured within the gated region.
There are eight different spectral analyzer windows:
Rectangular (see page 782)
Gaussian (see page 779)
Hamming (see page 780)
Blackman-Harris (see page 780)
Hanning (see page 780)
Flattop2 (see page 778)
Kaiser-Bessel (see page 780)
Tek Exponential (see page 783)
Your choice of window function will depend on the input source characteristics that you want to observe
and the characteristics of the window function. The window characteristics are shown in the following
table.
Scallop loss

Nearest side
lobe

Zero phase
reference

Coefficients

0.89

3.96 dB

-13 dB

50%

1.0

1.3

1.78 dB

-43 dB

50%

0.543478,
0.456522

Hanning

1.44

1.42 dB

-32 dB

50%

0.5, 0.5

Kaiser-Bessel

1.72

1.02 dB

-69 dB

50%

0.40243,
0.49804,
0.09831,
0.00122

BlackmanHarris

1.92

0.81 dB

-92 dB

50%

0.35875,
0.48829,
0.14128,
0.01168

Gaussian

2.0

0.76 dB

-79 dB

50%

a = 3.75 (not
cosine series)

Flattop2

3.8

0.0065 dB

-90 dB

50%

0.213348,
-0.206985,
0.139512,
-0.043084,
0.003745

Tek Exponential

1.42

0.60 dB

-67 dB

20%

not applicable

Window

3 dB BW in bins

Rectangular
Hamming

xxx

3 dB BW in bins
This is the bandwidth in units of bins, which are the intervals between spectral output samples when no
zero fill is used. The bandwidth is measured between the points on the lobe that are 3 dB down from the
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peak of the lobe. The bandwidth in hertz may be computed by dividing the BW in bins by the gate duration
in seconds. This is also referred to as resolution bandwidth (RBW).

Coherent gain
The gain factor normally associated with different window functions is correctly scaled into the magnitude
spectrum output. Therefore, the magnitudes in the output spectrum do not change as different windows
are selected.

Scallop loss
This is the magnitude error of the spectral analyzer when the frequency of the observed signal is exactly
half way between two frequency samples of the spectrum when the interpolation ratio due to zero fill of the
FFT is one. When zero fill is in effect, scallop loss is essentially eliminated because of the interpolation in
the frequency domain due to zero fill. If you work with span settings less than full and you work with
larger resolution bandwidth settings, zero fill is in effect most of the time.

Nearest side lobe
This is the difference in magnitude between the spectral lobe peak in the spectrum and the next side lobe
that occurs due to energy leakage. Different windows have different leakage characteristics. The more
narrow the resolution bandwidth of the window the more leakage in the spectrum.

Zero phase reference
This is the position in the time domain gate that is the reference point for phase in the output spectrum.
That is, if a sine wave input has its peak at the zero phase reference position, then it reads out as zero phase
in the spectrum. If the phase is to be correct when doing impulse response testing, the impulse in the time
domain must be located at this position in the gate interval.
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Coefficients
These are used to generate the windows that are constructed from a cosine series. For the Gaussian window,
the value of "a" is given instead of a set of coefficients. You can find descriptions of cosine series windows
in the Handbook of Digital Signal Processing Engineering Applications by Elliot. ISBN 0-12-237075-9.
What do you want to do next?
Go to a list of all spectral math controls. (see page 764)
Learn about using spectral analyzer windows. (see page 775)
Go to a step-by-step procedure for defining a spectral math waveform. (see page 627)

Spectral analyzer window types
In the time domain, a window is a bell-shaped function equal
in length to the gate duration.
For most windows, this function tapers to zero at both ends
of the gate region. Before computation of the spectral
transformation, the window is multiplied, sample by sample,
times the input data in the gated region. The window
function affects the shape of the spectral analyzer response
in the frequency domain.

xxx

The window functions affect the ability to resolve frequency in the output spectrum and can affect the
accuracy of the magnitude and phase measurements. The previous figure shows how the time domain
record is processed.
Accurate magnitude measurements require that the input source waveform be stationary within the gated
region. This means that waveform parameters, such as frequency and amplitude, should not change
significantly as a function of time within the gate region that is input to the spectral analyzer. Also, the gate
width must be greater than or equal to the period of the start frequency of the span of the spectral analyzer.
That is, there must be at least one cycle of the harmonic being measured within the gated region.
There are eight different spectral analyzer windows:
Rectangular (see page 782)
Gaussian (see page 779)
Hamming (see page 780)
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Blackman-Harris (see page 780)
Hanning (see page 780)
Flattop2 (see page 778)
Kaiser-Bessel (see page 780)
Tek Exponential (see page 783)
Your choice of window function will depend on the input source characteristics that you want to observe
and the characteristics of the window function. The window characteristics are shown in the following
table.
Window

3 dB BW in bins

Scallop loss

Nearest side
lobe

Zero phase
reference

Coefficients

Rectangular

0.89

3.96 dB

-13 dB

50%

1.0

Hamming

1.3

1.78 dB

-43 dB

50%

0.543478,
0.456522

Hanning

1.44

1.42 dB

-32 dB

50%

0.5, 0.5

Kaiser-Bessel

1.72

1.02 dB

-69 dB

50%

0.40243,
0.49804,
0.09831,
0.00122

BlackmanHarris

1.92

0.81 dB

-92 dB

50%

0.35875,
0.48829,
0.14128,
0.01168

Gaussian

2.0

0.76 dB

-79 dB

50%

a = 3.75 (not
cosine series)

Flattop2

3.8

0.0065 dB

-90 dB

50%

0.213348,
-0.206985,
0.139512,
-0.043084,
0.003745

Tek Exponential

1.42

0.60 dB

-67 dB

20%

not applicable

xxx

3 dB BW in bins
This is the bandwidth in units of bins, which are the intervals between spectral output samples when no
zero fill is used. The bandwidth is measured between the points on the lobe that are 3 dB down from the
peak of the lobe. The bandwidth in hertz may be computed by dividing the BW in bins by the gate duration
in seconds. This is also referred to as resolution bandwidth (RBW).

Coherent gain
The gain factor normally associated with different window functions is correctly scaled into the magnitude
spectrum output. Therefore, the magnitudes in the output spectrum do not change as different windows
are selected.
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Scallop loss
This is the magnitude error of the spectral analyzer when the frequency of the observed signal is exactly
half way between two frequency samples of the spectrum when the interpolation ratio due to zero fill of the
FFT is one. When zero fill is in effect, scallop loss is essentially eliminated because of the interpolation in
the frequency domain due to zero fill. If you work with span settings less than full and you work with
larger resolution bandwidth settings, zero fill is in effect most of the time.

Nearest side lobe
This is the difference in magnitude between the spectral lobe peak in the spectrum and the next side lobe
that occurs due to energy leakage. Different windows have different leakage characteristics. The more
narrow the resolution bandwidth of the window the more leakage in the spectrum.

Zero phase reference
This is the position in the time domain gate that is the reference point for phase in the output spectrum.
That is, if a sine wave input has its peak at the zero phase reference position, then it reads out as zero phase
in the spectrum. If the phase is to be correct when doing impulse response testing, the impulse in the time
domain must be located at this position in the gate interval.

Coefficients
These are used to generate the windows that are constructed from a cosine series. For the Gaussian window,
the value of "a" is given instead of a set of coefficients. You can find descriptions of cosine series windows
in the Handbook of Digital Signal Processing Engineering Applications by Elliot. ISBN 0-12-237075-9.
What do you want to do next?
Learn about recognizing aliasing. (see page 784)
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Flattop2 window

Flattop2 window
This window has the lowest scallop loss of any of the windows. It also has a wider resolution bandwidth
but lower side lobe attenuation. Also, it is unique because the time domain shape has negative values.
NOTE. The Flattop2 window is useful for high accuracy magnitude measurements for signals that do not
require very narrow bandwidth.
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Gaussian window

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)

Gaussian window
This is the default window function (see the next figure). It is unique in that the time-domain shape of an
exponential Gaussian function transforms into a Gaussian exponential shape in the frequency domain.
NOTE. This window provides optimal localization in both the time and the frequency domain

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)
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Hamming window

Hamming window
This window is unique in that the time domain shape does not taper all the way to zero at the ends. This
makes it a good choice if you wanted to process the real and imaginary parts of the spectrum off line and
inverse transform it back to the time domain. Because the data does not taper to zero, you could remove
the effect of the window function from the result.

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)

Hanning, Kaiser-Bessel, and Blackman-Harris windows
These windows have various resolution bandwidths and scallop losses (see the figures below). Choose the
one that best allows you to view the signal characteristics you are interested in.
NOTE. The Blackman-Harris window has a low amount of energy leakage compared to the other windows.
The Hanning window has the narrowest resolution bandwidth, but higher side lobes.
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Hanning, Kaiser-Bessel, and Blackman-Harris windows

Hanning window

Kaiser-Bessel window
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Rectangular window

Blackman-Harris window

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)

Rectangular window
This window is equal to unity (see the next figure). This means the data samples in the gate are not
modified before input to the spectral analyzer.
NOTE. This window has the narrowest resolution bandwidth of any of the windows, but it also has the
most spectral leakage and the highest side lobes.
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Tek-Exponential window

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)

Tek-Exponential window
In the time domain, it is not a symmetrical bell shape as is the case with the other windows. Instead, it
is exponential with a peak at the 20% position of the time domain gate. The frequency domain shape is
triangular.
NOTE. Use this window for impulse-response testing where the 20% position is the zero phase reference
point. More of the acquired data record length is used to capture the impulse response.
Exact details of how to compute its values were published in the article; Impulse-Response Testing Lets a
Single Test Do the Work of Thousands, by John Pickerd, EDN magazine, April 27, 1995.
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Recognizing aliasing

What do you want to do next?
Learn about using spectral analyzer windows. (see page 775)

Recognizing aliasing
Aliasing occurs when the input frequency of a signal is greater than one half of the sampling frequency
(the sample rate).
Set the sample rate high enough so that the signals in the spectrum appear at their correct frequency as
opposed to a lower aliased frequency value. Also, complex signal shapes that have many harmonics in
them, such as a triangle or square wave, can appear to be OK in the time domain when in fact many of
the harmonics in that signal are aliased.
One way to check for aliasing is to increase the sample rate and observe whether any of the harmonics
unwrap to different frequency locations.
Another way to recognize aliasing is to realize that higher order harmonics usually have decreasing
magnitudes compared to lower order harmonics. Thus, if you see a series of increasing harmonic
magnitude values as frequency increases then you can suspect that they may be aliased. In the spectral
math waveform, the actual higher frequency components are under sampled, and therefore they appear as
lower frequency aliases that "fold back" around the Nyquist point. (See the next figure.) You may test by
increasing the sample rate and observing if aliases unwrap to different frequency positions.
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Mask key points

If you have a variable-frequency signal source, another way to observe aliasing is to adjust the frequency
slowly while watching the spectral display. If some of the harmonics are aliased, you will see the
harmonics decreasing in frequency when they should be increasing or vice versa.
Once you have displayed a spectral math waveform, use cursors to measure its frequency amplitude or
phase angle. See Setting Cursor Sources (see page 604) for detailed steps.
You can use automated measurements to measure spectral math waveforms. See Taking Automatic
Measurements (see page 606) for step-by-step instructions.
What do you want to do next?
Learn about horizontal setup. (see page 181)

Mask key points
There are a number of mask test key points to be aware of prior to using, editing, or creating a mask.

Mask testing
Only one mask standard is active at any one time. If you have one mask selected or enabled and then
select a new mask, the new mask replaces the previous mask. You cannot test to multiple standards
simultaneously.

Autofit and persistence interaction
The Autofit function moves the waveform vertically and horizontally in a mask to reduce the number of
segment hits within a mask. If persistence is set to infinite or variable, each Autofit waveform movement
clears existing persistence data. If Autofit makes frequent waveform movements, there may be little or no
displayed waveform persistence data.
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Serial mask testing with mask testing

Segments and mask hits
Each mask can have a maximum of 16 segments. Segments can overlap. The number of mask hits is the
sum of all hits in all segments, regardless of whether or not segments overlap. For example, if a waveform
crosses over an area where two segments overlap, both segments will count the waveform hit.

Vertices
Each segment can have a maximum of 50 vertices. Vertices are numbered counterclockwise, with vertex
one generally located at the bottom left of each segment. The active (selected) vertex is indicated by an X.
The instrument automatically assigns numbers to vertices during mask creation or editing.

Mask margin tolerance
Mask margin tolerance moves the mask segment boundaries by the specified percentage. Negative margins
reduce the size of the segment, making it easier to pass a mask test. Positive numbers make it harder to
pass and allow you to perform margin testing on your design. If a user defined mask has more than three
segments, turning on mask margins generates an error message. Turning mask margin tolerance off
redraws the mask segment margins to their default values, but leaves the numeric value as it is, allowing
you to quickly toggle between default and user-set margin values.

Standards and bandwidth
When the instrument system bandwidth (which includes the instrument, attached probes, and/or cabling)
falls into the range of 1.5 to 1.8 (0.8 for optical signals) times the data signal bit rate, the third harmonic
of the data signal is significantly attenuated. The instrument displays useful qualitative information, but
quantitative rise-time measurements under these conditions may not be accurate.
For example, a FC531E Elec mask has a bit rate of 531.25 Mb/s; 1.5 to 1.8 times this value is a range
of 796.5 MHzBW to 955.8 MHzBW. Therefore, you should not use an instrument with less than 1 GHz
measurement system for making quantitative rise-time measurements of this standard.
When just the instrument bandwidth falls within 1.5–1.8 (0.8 for optical signals) times the bit rate of a
selected mask standard, the instrument displays the message "Consider system bandwidth when testing at
this bit rate." in the status area above the graticule.
What do you want to do next?
Learn more about eye measurements. (see page 788)
Learn about communication triggering. (see page 708)
Go to mask testing setup overview. (see page 215)

Serial mask testing with mask testing
The Serial Mask Testing option (see page 215) provides electrical mask testing on communication
standards and communication triggering.
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Serial mask testing with mask testing

Mask testing consists of two tasks: signal violation detection and pass/fail testing. Signal violation
detection lets you test communications signals for time or amplitude violations against a predefined mask.
Each mask consists of one or more polygonal regions called segments. The signal waveform data should
stay outside of the segments defined by the mask. Any signal data that occurs inside a mask segment is
called a mask segment violation or "hit."
You can select from any of the included standard telecommunications masks, or you can define your own
custom masks. Selecting a mask automatically sets the instrument communications triggers to properly
display most communication signals in the mask.
Pass/Fail testing defines the mask testing parameters, including the number of waveforms to test, how
many mask hits are allowed before failing a test, setting a mask margin tolerance value, and what action to
perform upon the completion or failure of a test.
Communication triggering enables you to trigger on and display waveforms for industry-standard
communications signals. See Mask Types and Standards (see page 217) for a list of the supported
standards on which you can trigger.
Automatic communication signal measurements enable you to make automatic measurements on
communications signals. See the Communication Measurement (see page 284) tab in the Measurement
setup window for the available measurements.
The following are Serial Mask Testing key features:
Predefined masks for testing or triggering on industry-standard signals, such as ITU-T G.703, ANSI
T1.102, Fibre Channel, Ethernet, Video, SONET, Rapid IO, USB, IEEE 1394b, OIF Standards and
their subsets
Autoset, which quickly adjusts the instrument vertical and horizontal controls to display a waveform
in a mask
Autofit, which positions the signal on each acquisition to minimize mask segment hits
Mask margins, which allow you to adjust the default mask margin tolerances
Pass/Fail testing to continuously test a specified number of waveforms against a mask
A mask editor for creating, saving, and recalling user-defined masks
Waveform database technology to perform mask testing based on waveforms accumulated in a
database, rather than a single waveform stored in acquisition memory
Communications triggers to trigger the instrument on industry-standard communications signals
Automatic measurements on communications signals
NOTE. If a standard listed in this manual is not available on your instrument, it is because the
configuration or bandwidth of your instrument cannot test that standard.
Although this oscilloscope is not a calibrated optical reference receiver, you can use it with mask testing to
evaluate general optical signal characteristics and wave shape, using an external O/ E converter.
What do you want to do next?
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Levels used in taking eye measurements

Learn more about mask testing. (see page 785)
Learn more about eye measurements. (see page 788)
Learn about communication triggering. (see page 708)
Go to mask testing setup. (see page 215)

Levels used in taking eye measurements
All eye-diagram measurements are based on the power level, the voltage level, or the time locations of
edges within each acquisition.
The next figure shows the areas of an eye-diagram used to calculate measurements.

P values
The P values include the mean and standard deviation of the vertical location of PTop and PBase. These
areas are used with a specified sample size to statistically measure the following values *:
PTop Mean. This is the mean value of PTop.
PTop Sigma. This is the standard deviation of PTop.
PBase Mean. This is the mean value of PBase within the Eye Aperture.
PBase Sigma. This is the standard deviation of PBase within the Eye Aperture.
*
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Saving and recalling setups

T1 values
The T1 values are vertical and horizontal values associated with the left-most crossing point. These
areas are used to establish the following values:
TCross1 Mean. This is the horizontal mean of the left-crossing point at TCross1.
TCross1 Sigma. This is the horizontal standard deviation of the left-crossing point at TCross1.
TCross1 Peak-to-Peak. This is the horizontal peak-to-peak deviation of the left-crossing point at
TCross1.
PCross1 Mean. This is the vertical mean of the left-crossing point at PCross1.

T2 values
The T2 values are vertical and horizontal values associated with the right-most crossing point. These
areas are used to establish the following directions:
TCross2 Mean. This is the horizontal mean of the right-crossing point at TCross2.
TCross2 Sigma. This is the horizontal standard deviation of the right-crossing point at TCross2.
TCross2 Peak-to-Peak. This is the horizontal peak-to-peak deviation of the right-crossing point
at TCross2.

DCD values
The duty cycle distortion (DCD) values are horizontal values associated with the right-most crossing point
at 50% of the eye height. These areas are used to establish DCDpk-pk, the horizontal peak-to-peak deviation
of the left-crossing point at half the height of the eye.
What do you want to do next?
Learn about communication triggering. (see page 708)
Go to mask testing setup overview. (see page 215)

Saving and recalling setups
This instrument can save a number of different instrument setups for later recall, limited only by the
space that you have to store the setups.
By saving and recalling different setups, you can switch from setup to setup without having to first
manually record your settings and then manually set them. This capability is helpful when you want to:
Save and recall a setup that optimizes the instrument for displaying and analyzing a certain signal
Save a series of setups to help automate a procedure through recall of a sequence of saved setups
as part of performing the procedure
Save a setup for sharing with a second instrument
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Saving and recalling waveforms

If you do not have an attached keyboard, you can still name setup files. The Save and Recall dialog
boxes include a pop-up keyboard that you can use with your mouse or the touch screen to enter the
setup path name and file name.
The instrument excludes the following items when saving setups:
Channel waveforms and reference waveforms. Control settings (scale, position, and so on) are saved
but not the waveform data. Upon recall of the setup, the settings are applied, but the data is not restored.
Math waveforms. Control settings and the math expression are retained but not the waveform data.
Upon setup recall, however, the math waveform expressions are applied, but math waveform data
is not restored.
User options stored in the Windows registry. These include all options set in the User Preferences
control window.
If you want to save a waveform in a useful format for other applications, such as a spreadsheet, use the
save or save as function (see Saving and Copying Waveform Data (see page 791)).
A few other things to remember when saving and recalling setups:
Recalling a setup replaces the current setup with the recalled setup. If you do not want to lose your
current setup, save the setup file for later recall.
Saved setups may contain settings inappropriate for waveforms currently in your instrument. For
example, if you save a setup that displays a math waveform that is the average of reference waveform
1, when you recall the setup, if the reference is empty, the math and reference waveforms are not
displayed.
What do you want to do next?
Learn about saving and recalling waveforms. (see page 790)
Learn about exporting waveform data. (see page 791)

Saving and recalling waveforms
This instrument can save any number of waveforms, limited only by the space that you have to store them.
By saving a waveform, you can recall it at a later time for comparison, evaluation, and documentation.
This is helpful when you want to:
Recall a waveform for further evaluation or comparison with other waveforms.
Extend the waveform carrying capacity of the instrument. The instrument supports four reference,
four channel, and four math waveforms. If you want more than four reference waveforms, you can
save additional references to disk for recall later.
The Reference Setup control window contains a Label field for including comments with your saved
waveforms.
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Saving and copying waveform data

If you do not have an attached keyboard, you can still enter comments and name reference waveform files.
The Reference Setup control window includes a pop-up keyboard that you can use with your mouse or the
touch screen to enter the waveform path name, file name, and comments.
The instrument recalls each waveform into one of the reference waveform locations Ref <1–4>. You
cannot recall into a channel or a math waveform.
What do you want to do next?
Learn about saving and copying waveform data. (see page 791)
Learn about saving and recalling setups. (see page 789)
.

Saving and copying waveform data
This instrument supports saving waveform data to a file. The instrument can save waveforms, images, and
measurements in several formats. You can also copy waveform data to the Windows clipboard for use with
other applications, such as spreadsheets or math analysis applications.
A few things to remember when saving waveform data:
Waveform data are saved as a series of comma-separated values (CSV), which are amplitudes without
units. There is no timing information, but data is placed in the file in sequence from the first sample in
the waveform record to the last.
Because the waveform data are saved as CSV, without timing and scaling information, the instrument
does not save these waveforms directly. (It only saves the data.) If you intend to recall a waveform
later, save it (see the procedure Saving A Waveform (see page 634)) using the .wfm file type.
You may also choose to copy a waveform and paste it directly into an application such as Microsoft
Word or Excel. If so, select your waveform, and then select Copy in the Edit menu.

File formats
To make saved files more useful, select a file format usable by your analysis tools:
BMP. This creates (.bmp) files in a bitmap file format usable by many graphic programs. (Available
for screen captures.)
JPEG. This creates (.jpg) files in a compressed image format usable by many graphic programs.
(Available for screen captures.)
PNG. This creates (.png) files usable by many graphic programs. (Available for screen captures.)
TIFF. This creates (.tiff) files usable by many graphic programs. (Available for screen captures.)
HDF5. This creates a Hierarchical Data Format (.h5) file of the entire waveform.
Tek Waveform. This creates (.wfm) files that can be recalled back into an instrument reference file.
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Saving and copying waveform data

Spreadsheet CSV. This creates (.csv) files in a format usable by spreadsheets (Excel, Lotus 1-2-3,
and Quattro Pro).
Spreadsheet TXT. This creates (.txt) files in a text format usable by text and word processors and
spreadsheets.
MATLAB. This creates (.dat) files in a format usable by MATLAB.
Mathcad. This creates (.dat) files in a format usable by MathCad. The MathCad file is an ASCII file,
the first five values of which contain the following header information:
The first header value holds the record length.
The second header value holds time, in seconds, between samples.
The third header value holds the trigger position (expressed as an index in the data position).
The fourth header value refers to the fractional trigger position.
The fifth header value holds the horizontal offset in seconds.
NOTE. The delimiters are carriage returns.
What do you want to do next?
Learn about saving and recalling setups. (see page 789)
Learn about saving and recalling waveforms. (see page 790)
Learn more about CSV text format. (see page 887)
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ACos

ACos
Inserts the text ACOS( into the math expression.

Acquisition interval
The acquisition interval is the time between sample points. For mathematical purposes, it is the time
covered by the waveform record divided by the record length.

Acquisition window
The acquisition window defines what data are sampled from the input signal to form a waveform record.
The vertical scale and offset controls set the vertical size and vertical center of this window
independently for each channel.
The horizontal scale and position controls set the horizontal size and position for all channels in unison.

Active probes
Active voltage probes often contain preamplifiers that provide high resistance and low capacitance at the
probe tip. Some active voltage probes contain differential amplifiers that provide high Common Mode
Rejection Ratio (CMRR).
Active current probes often contain Hall-effect sensors that extend the probe bandwidth down to DC.
Many active probes, especially high frequency probes, can drive a 50 Ω instrument input.

Amplitude
This voltage measurement is the high value minus the low value measured over the entire waveform
or gated region:
Amplitude = High – Low
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Analog oscilloscope sweeps

Analog oscilloscope sweeps

Area
Area is a voltage-over-time measurement. The measurement is the area over the entire waveform or gated
region expressed in volt-seconds. The area above the common reference point is positive while the area
below the common reference point is negative.
Taking Automatic Measurements (see page 606)
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ASin

ASin
Inserts the text ASIN( into the math expression.

ATan
Inserts the text ATAN( into the math expression.

Auto-Increment file name
1. Select the Auto-increment file name to save numerous similar files without retyping the entire file
name each time.
2. Enter a Base file name.
3. Click Save.
For the initial save the default count is 000, but you can overwrite this number if you choose. Your
first file is saved as [Basefilename][count].ext, where ext is the file extension. On subsequent
saves, the instrument searches for the highest numbered file name and increases the number by one, as
in Basefilename001.ext.
For example, if you are saving a series of rise time data files, you can use "Risetime" as the base file
name. Your first file is saved as Risetime000.ext, where ext is the file type extension. The next file
will be Risetime001.ext, and so on.
TIP. If Count reaches 999, it is suggested that you change the base file name to Basefilename1 (for
example, Risetime1) on the next save. Your next file will then be saved as Risetime1000.ext. You will
receive a warning message if you are going to overwrite any files with the same name.

Auto trigger mode
Auto trigger mode causes the instrument to trigger if a valid trigger event does not occur within a set
amount of time.
Auto trigger mode is useful when probing DC signal levels such as power supplies or logic levels that are
stuck high or low. It is also useful when looking for activities on signal nodes such as oscillations when you
first set up the instrument. The length of time it waits for a trigger event depends on the time base setting.
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B-Event Scan Setup

B-Event Scan Setup
B-Event Scan is particularly useful for creating overlapped eye diagrams, and applies to all standard
Pinpoint Trigger A- and B-Events sequenced by Trig on nth Event in non-FastAcq mode.
The B-Event Scan initializes the Start Event value to 1 and the End Event value to 8. The Start Event
must be less than or equal to the End Event value. Advance After, advances the B-Event value after the
given number of acquisitions have occurred depending on the selected Advance method (Sequential,
Random, and Toggle).

When set to Sequential, the B-Event value is sequentially incremented after each acquisition
completes, until the Start Event reaches the End Event. At this point the B-Event value is set to
Start Event value again.
When set to Random, the B-Event value is set to a random value between the Start Event and End
Event values for each set of Advance After acquisitions.
When set to Toggle, the B-Event value alternates between the Start Event and End Event for each set
of Advance After acquisitions.
This process continues and occurs at hardware speed. The range for the B-Event, Start Event, and End
Event is from 1 to 2e9.

CAN bit rate
1. Click in the Nominal Bit Rate entry box.
2. Use the multipurpose knob to set the bit rate for the trigger.
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CAN format

CAN format
In the CAN Format drop-down list, specify the format.

CAN signal type
In the drop-down Signal Type list, select the type of data to trigger on.

Center frequency
The center frequency is the frequency at the center of the frequency span. The maximum center frequency
is equal to the sample rate divided by two (the Nyquist frequency) minus one half the span. The minimum
center frequency is equal to one half of the span.
If the frequency span is set to maximum, then the center frequency will not move. To increase the center
frequency beyond the present limits, either reduce the frequency span or increase the sample rate. To
decrease the center frequency beyond the present limits, reduce the frequency span.
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Channel 1 – 4 inputs

Channel 1 – 4 inputs
You can connect up to four probes to the inputs of the instrument. Each vertical input channel has its own
vertical control settings. Each probe input channel has its own TekProbe/TekVPI interface (see page 495).

Channels selector
Specify the Channel <1 – 4> and waveform type (Channel, Math, or Reference) for oscilloscope operations.
Click Ch and specify a channel to dedicate the controls for use with an input on the front panel.
Click Math to dedicate the controls for use with the a math waveform.
Click Ref to dedicate the controls for use with the a reference waveform.
Shaded buttons Indicate unused or undefined waveforms.

Clear button
Removes all of the characters from the math expression.

Clear data control
Access this control from the Edit menu.
Use the Clear Data control to reset waveform, measurement, and histogram data, mask hit data, template
violations, persistence, statistics, mask pass/fail test data. The Clear data control only clears the
accumulated data; it does not turn off any functions.
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Clock edge
The Clock Edge determines whether the instrument finds the trigger point on the rising edge (left button)
or the falling edge (right button) of the clock signal.

Level
Click in the Level entry box and use the multipurpose knob and to set the threshold on which you want to
trigger. Different levels are available depending on the code selected:
The upper level controls the upper level trigger point
The lower level controls the lower level trigger point
The clock level sets the clock threshold on which you want to trigger

Communication trigger codes and standards
The communication trigger standards available for an instrument depend on the bandwidth and or the
configuration of that instrument. The following tables list the Communication Trigger Codes and
Standards available with Mask Testing.
NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.
AMI trigger standards
Custom

32Mb 32.064 Mb/s

97Mb 97.728 Mb/s

DS1 1.544 Mb/s

DS1A 2.048 Mb/s

DS1C 3.152 Mb/s

DS2 6.312 Mb/s

DS2 Rate Sym 6.312 Mb/s

DS2 Rate Coax 6.312 Mb/s

DS3 44.736 Mb/s

E1 2.048 Mb/s

E2 8.448 Mb/s

E3 34.368 Mb/s

STS–1 51.84 Mb/s

B3ZS trigger standards
Custom

DS3 44.736 Mb/s

STS–1 51.84 Mb/s

DS2 6.312 Mb/s

DS2 Rate Sym 6.312 Mb/s

DS1 1.544 Mb/s

DS1C 3.152 Mb/s

B6ZS trigger standards
Custom
B8ZS trigger standards
Custom
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CMI trigger standards
Custom

DS4NA 139.26 Mb/s

STM1E 155.52 Mb/s

STS–3 155.52 Mb/s

E4 139.26 Mb/s

HDB3 trigger standards
Custom

E1 2.048 Mb/s

E3 34.368 Mb/s

DS1A 2.048 Mb/s

E2 8.448 Mb/s

MLT3 trigger standards
Custom

100Base–TX 125 Mb/s

NRZ trigger standards
Custom

2.5 IBand 2.5 Gb/s

FC133 132.8 Mb/s

FC266 265.6 Mb/s

FC531 531.2 Mb/s

FC1063 1.0625 Gb/s

FC2125E 2.125 Gb/s

G1 ATA 1.5 Gb/s

GB Ethernet 1.25 Gb/s

FS USB 12 Mb/s

HS USB 480 Mb/s

OC1/STM0 51.84 Mb/s

OC3/STM1 155.5 Mb/s

OC12/STM4 622.1 Mb/s

OC48/STM16 2.488 Gb/s

OC48–FEC 2.666 Gb/s

S400b 491.5 Mb/s

S800b 983.0 Mb/s

S1600b 1.966 Gb/s

XAUI 3.125 Gb/s

RapidIO 500M 500 Mb/s

RapidIO 750M 750 Mb/s

RapidIO 1.0G 1.0 Gb/s

RapidIO 1.5G 1.5 Gb/s

RapidIO 2.0G 2.0 Gb/s

SFI/SPI–5 2.5G 2.5 Gb/s

SFI/SPI–5 3.1G 3.1 Gb/s

RIO Serial 1G 1.25 Gb/s

RIO Serial 2G 2.5 Gb/s

RIO Serial 3G 3.125 Gb/s

VSR OC192 1.244 Gb/s

TFI–5 2.5G 1.488 Gb/s

TFI–5 3.1G 3.11 Gb/s

Serial 8b/10b 3.125 Gb/s

xxx
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Set up communication trigger coding

Set up communication trigger coding
From the Trig menu, select Comm Setup.

Overview
Use these controls to select the coding format for triggering on a communication signal and the standard to
use with the coding format.

To use
In the Coding drop-down list box, select the coding format for triggering the communication signal.
In the Standard drop-down list box, select the standard to use with the coding format.
The Standard sets the bit rate.

Behavior
The coding format determines which standards are available as well as other parameters, such as trigger
threshold and pulse form. The standard selected determines the bit rate. Changing the bit rate causes the
standard to change to your own customized standard.
What do you want to do next?
Learn about Communication Trigger Pulse Form. (see page 802)
Go to the Communication Trigger control window. (see page 429)
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Select the Comm Trigger Pulse Form

Select the Comm Trigger Pulse Form
From the Trig menu, select Comm Setup.

Overview
Pulse Form directs the instrument to trigger on a voltage change from the prior bit. This can be positive,
negative, or neutral if there was no change.
Depending on the code used, the pulse form can also indicate that triggering is to occur on an eye diagram.

To use
Click the pulse form you want the instrument to use for triggering:
1 triggers the instrument on a positive pulse form.
0 triggers the instrument on a neutral pulse form.
-1 triggers the instrument on a negative pulse form.
Eye triggers the instrument on an eye diagram.

Behavior
The available pulse forms are determined by which code is used for the signal. For example, the only
pulse form available for NRZ codes is eye diagram.
What do you want to do next?
Learn about Communication Trigger Coding. (see page 801)
Go to the Communication Trigger control window. (see page 429)
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Set the Comm trigger source

Set the Comm trigger source
Use the Source drop-down list to select the channel for the Comm trigger source.
Use the Type drop-down list to select the clock source for the trigger.
Use the Polarity drop-down list to select the polarity of the clock source.

Control window handle
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Cos

Cos
Inserts the text COS( into the math expression.

Cosh
Inserts the text COSH( into the math expression. The COSH function computes the hyperbolic cosine of x.

Crossing percent
Crossing percent measurement is the eye crossing point expressed as a percentage of eye height.
Crossing Percent = 100 × [(pCross1Mean - pBaseMean)/(pTopMean - pBaseMean)]

Cursors menu
Use the Cursors menu options to select cursor types, mode, and position, and to turn cursors on and off.

Set the cursor sources (XY display)
From the Cursor menu, select Cursor Setup.

Overview
Use these controls to define the source for both Cursor 1 and Cursor 2 for any cursor type.

804

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Customize color palettes

To use
1. Click the Source drop-down list to select the measurement source for the cursor.
2. Click in a Position entry box and use a multipurpose knob to adjust the position of the cursor.

Behavior
If the cursor type is V Bars or H Bars, setting the Cursor 1 source sets the Cursor 2 source to the same
value. To have different sources for Cursor 1 and Cursor 2, set the Cursor 1 source first, and then set the
Cursor 2 source.
NOTE. Only Screen Cursors have both an X and Y Position controls.
The Multi-Purpose Knobs Adj buttons appear only with Screen cursors. Click the Adj buttons to assign the
multipurpose knobs to the X-axis and the Y-axis controls.
What do you want to do next?
Learn about cursor types. (see page 75)
Learn about cursor styles. (see page 77)
Learn about Cursor Readouts in XY display format. (see page 77)

Customize color palettes
1. Click a User palette button in the Display control window, Colors tab.
2. Click the Edit button.
3. Click in the Hue, Saturation, or Lightness entry boxes; then use the multipurpose knobs to adjust the
attributes.
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Cycle area

Cycle area
The cycle area is a voltage over time measurement. The measurement is the area over the first cycle in the
waveform or the first cycle in the gated region expressed in volt-seconds. The area above the common
reference point is positive while the area below the common reference point is negative.

Cycle mean
This voltage measurement is the arithmetic mean over the first cycle in the waveform or the first cycle in
the gated region.

Cycle RMS
This voltage measurement is the true Root Mean Square voltage over the first cycle in the waveform
or the first cycle in the gated region.

Data direction
In the Data Direction drop-down list, specify the data direction.

Data threshold
1. Click in the Data Threshold entry box.
2. Use a multipurpose knob to set the threshold voltage for the trigger.
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Dead time

Dead time
Dead time is the time that the instrument requires to process an acquisition.

The instrument cannot acquire any new data until the previous data has been processed. If dead time is
long, the instrument can miss acquiring infrequent events.

"Dead time" between acquisitions
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Delay edges

Delay edges
The Delay Edge buttons determine whether the measurements will be taken on the rising or falling edge
of the waveform. After selecting an edge, the graphic in the control window is updated to show the
edge from which the measurements will be taken.

Delay
This timing measurement is the time between the mid reference (default 50%) amplitude point of two
different waveforms

Trigger delay
Use the Trig Delay control to trigger the instrument a specified period of time after the A trigger. After the
A trigger arms the trigger system, the instrument triggers on the next B trigger event that occurs after the
time that you specify with the Trig Delay control.
Click in the Trig Delay entry box, and then use the multipurpose knob to enter the delay time.

Trigger events
Use the Trig Event control to trigger the instrument a specified number of events after the A trigger. After
the A trigger arms the trigger system, the instrument triggers on the nth B trigger event.
Click Trig Event, and then use the multipurpose knob to enter the number of B trigger events.
Click the increment/decrement buttons to enter the number of B trigger events.
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Select digital input iCapture

Select digital input iCapture
NOTE. iCapture is available only on MSO70000C/DX Series instruments and DPO70000DX instruments
with option MSOU installed.
The supported instrument uses iCapture to display analog characteristics of up to four signals connected
to up to four of the D15-D0 digital channel through a logic probe.
From the Vertical menu, select Vertical Setup.

To use
Click the Digital Input iCapture button when you want to display the analog characteristics of a
single digital channel.
Click the Digital Source selection box and select a digital channel to acquire and process as an analog
input waveform.

NOTE. Right-click on the digital source waveform handle in the waveform window to reroute from one
analog channel to any of the other three analog channels. For example, right-click on D0 captured on
Ch1 and select iCapture on Ch2 to reroute the source D0 to Ch2.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 954)
Learn about the Digital Properties button. (see page 811)
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Set up trigger path alignment

Set up trigger path alignment
NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
The exact trigger location is used in alignment process to avoid jitter. To minimize logic trigger errors,
trigger adjustment aligns the 16 digital probe trigger paths (excluding the clock) using a specified analog
path as a reference source to provide the best trigger alignment possible. You need the Logic Probe
Deskew Fixture to deskew the logic probe against one analog probe on supported instruments. The fixture
provides an edge source for the instrument to time-align the 16 logic trigger paths from the logic probe tips.
NOTE. Refer to the Logic Probe Deskew Fixture Instructions, Tektronix part number 071-2613-XX, for
information on equipment needed, and procedures to connect and perform the deskew routine.

To use
Calibrate the analog probe connected to the reference channel.
Click the Align Trigger Path button to start the trigger path alignment routine for the logic probe.
Click the Clear Trigger Path Alignment button to clear the instrument memory of previously-aligned
probe data.
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Set logic properties

Set logic properties
NOTE. Logic Properties option is available only on MSO5000B and MSO70000C/DX Series instruments
and DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with
option MSOU installed.
From the Vertical menu, select Vertical Setup. From the Math menu, select Math Setup.

To use
Click the Logic Properties button when you want to specify the voltage threshold level of the Ch1-Ch4
(live) and M1-M4 (math) channels to use as logic waveforms and to include in a bus.
Click the Logic Properties button to set the voltage threshold levels in the Logic Threshold Setup
Window (see page 811).

What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 954)
Learn about the Logic Threshold Setup menu. (see page 811)

Set the logic thresholds
NOTE. The Logic Threshold Setup option is available only on MSO5000B and MSO70000C/DX Series
instruments and DPO5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.
Select the Vertical Setup or the Math Setup menu, and then click the Logic Properties button.

Overview
Use this control window to specify the voltage threshold level of the Ch1-Ch4 (live) and the M1-M4
(math) channels to use as logic waveforms and to include in a bus.
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Digital menu

To use
Click the Threshold entry box for the desired channel and use the keypad to enter a value or use
the multipurpose knobs to select a voltage level.
Click the OK button.

What do you want to do next?
Learn about the digital channel setup. (see page 89)
Learn about bus setups. (see page 97)

Digital menu
NOTE. The Digital Menu is available only on MSO5000B and MSO70000C/DX Series instruments and
DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with option
MSOU installed.
Use the Digital menu options to set parameters for the D15-D0 digital channels, and to set up buses
based on analog, math, and digital waveforms from which the instrument can acquire, decode, and
display data (or bus forms).
On MSO/DPO5000B Series instruments, you have the option to turn on or turn off the MagniVu feature.
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Select the display style

Select the display style
From the Display menu, select Display Setup; then open the General tab.

To use
Click one of the buttons to select the waveform display style.

Behavior
Vectors displays waveforms with lines drawn between record points.
Dots displays waveform record points as dots on the screen. Dots are useful when you want to display
multivalued waveforms such as eye diagrams. (see page 814)
Inten Samp (Intensified Samples) shows only the actual samples. When you use intensified samples,
you identify the actual sample points in an interpolated waveform.
You can also use the Display menu Display Style submenu to directly access the style options.
NOTE. The Vectors and Inten Samp selections are not available when using the XY or XYZ Display
Formats.
What do you want to do next?
Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)
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Select the math color

Eye diagram
The eye diagram is a synchronized display of a data stream that shows signal levels and transition
regions, typically over one cycle.
The eye diagram has the appearance of an opened eye. Compared to a normal instrument display, the
eye diagram generally appears as an untriggered waveform. This is because on successive cycles the
signal is high and then low. The areas of interest are the transition regions and eye opening.

Select the math color
From the Display menu, select Colors, or open the Colors tab in the Display control window.

To use
Click one of the buttons to select the color scheme for math waveforms.
Click Default to use the default system color for the selected math waveform.
Click Inherit to use the same color as the waveform the reference function is based on.

What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about using text with screen displays (see page 168)
.
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Select the reference color

Select the reference color
From the Display menu, select Colors, or open the Colors tab in the Display control window.

To use
Click one of the buttons to select the color scheme for reference waveforms.
Click Default to use the default system color for the selected reference waveform.
Click Inherit to use the same color as the original waveform.

What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the appearance of objects in the display. (see page 171)
Learn about using text with screen displays. (see page 168)

Display menu
Use Display menu options to change the way that waveforms appear on the instrument. This includes the
style, intensity, color, format, text, and persistence. You can also change the graticule type and the items
that appear on the display, such as date and time.

Select the trigger level marker
From the Display menu, select Objects, or open the Objects tab in the Display control window.

To use
Click one of the buttons to select the trigger level indicator.
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Duty cycle distortion

Behavior
The trigger level markers (see page 641) indicate the voltage level where the trigger or threshold levels of
the active waveform occur:
The Short trigger level marker displays a short arrow on the side of the graticule by the active
waveform.
The Long trigger level marker displays a horizontal line through the active waveform.
NOTE. The trigger level indicator does not appear on inactive waveforms, reference waveforms, or
fast acquisition signals.
What do you want to do next?
Learn about changing the overall display appearance. (see page 167)
Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)

Duty cycle distortion
Duty cycle distortion is the peak-to-peak time variation of the first eye crossing measured at the MidRef as
a percent of the eye period.
DCD(sec) = 100% × TDCDp-p/(TCross2mean – TCross1mean)
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Edit a User Mask

Edit a User Mask
Use the Mask Edit Setup to alter a user mask.
1. From the Masks menu, select Mask Edit Setup to display the Mask Edit control window.
2. Under Mask Elements, use the up and down arrows to select the Segment and Vertex you want to edit.
The selected segment appears in red and a white X indicates the selected vertex.
3. Click in the Horizontal and or Vertical controls under Mask Value to change the horizontal or vertical
values of the mask.
4. Click Save to save your changes to the user mask.
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Editor button

Editor button
Closes this window and opens the Equation Editor control window so you can edit the math expression.

Enter Math Equation Editor: Operands
From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

To use
Click an individual button to enter a character or operator into the math expression.

Behavior
The characters are entered into the math expression one at a time.
What do you want to do next?
Learn about the Math Setup controls. (see page 247)
Learn about averaging math waveforms. (see page 247)

Edit menu
Use the Edit menu for copying images, waveforms, or measurements to the clipboard for use in other
applications. You can select items from the menu or you can select Copy Setup to fine tune the parameters
with the Copy control window before copying items to the clipboard.
You can also use the Edit menu to clear data and undo the last Autoset (see page 189).
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Set up E-mail on Trigger

Set up E-mail on Trigger
Click Setup to access the E-mail on Event control window where you configure sending e-mail on events.

Enhanced bandwidth indicator

Extinction ratio
Extinction ratio is the ratio of eye top to base. This measurement is only valid when the acquisition
mode is set to WfmDB, FastAcq is enabled, or the measurement is taken on a reference waveform saved
in FastAcq mode.
Ext Ratio=pTopMean/pBaseMean

Extinction ratio decibel
Extinction ratio decibel is the ratio of eye top to base expressed in decibels.
This measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or the
measurement is taken on a reference waveform saved in FastAcq mode.
ExtdB=10 × Log(pTopMean/pBaseMean)

Eye Base
Eye Base is the base value used in the extinction ratio measurements.
Eye Base = pBaseMean
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Eye diagram

Eye diagram
The eye diagram is a synchronized display of a data stream that shows signal levels and transition regions,
typically over one cycle.
The eye diagram has the appearance of an opened eye. Compared to a normal instrument display, the eye
diagram generally appears as an untriggered waveform. This is because on successive cycles the signal is
high and then low. The areas of interest are the transition regions and eye opening.

Eye Height
Eye height is the measurement of the eye height in volts.
Eye Height = (pTopMean - 3 × pTopSigma) - (pBaseMean + 3 × pBaseSigma)

Eye Top
Eye Top is the top value used in the extinction ratio measurements.
Eye Top = pTopMean

Eye Width
Eye width is the measurement of eye width in seconds.
Eye Width = (tCross2Mean –3 × pTopSigma) – (tCross1Mean + *tCross1Sigma)

Set up E-mail configuration
From the Utilities menu, highlight E-mail on Event; then Select Setup from the submenu. In the E-mail
on Event Setup window, click the Config button.

Overview
Use this dialog box to enter the address of the mail server to use when sending E-mail on events. You must
have a server entered in the SMTP Server Address box for your instrument to send e-mail.
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Set up E-mail configuration

You can customize your e-mail by selecting the number of attempts to make, entering a From address,
setting the time out length, entering a login and password if necessary, and entering a host name.
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Send an E-mail on Trigger

To use
Enter the SMTP server address.
Click OK if you want to accept the default values.
Click More>> if you want to customize your e-mail.
Enter the appropriate information in each box that you need to change from the default.

Behavior
The number you enter in the Number Attempts to Send entry box is the number of times the system will
try to send the e-mail if it is not successful on the first try. The default is 1.
Entering an address in the From entry box puts that address in the From field of the e-mail. The default
value is the instrument model number. Entering your own address allows the instrument to send you
e-mail if there is a problem sending to the recipient.
Entering a number in the Timeout entry box will override the default time out for sending e-mail to
the server.
If your mail server requires a login or password, enter the login in the Auth Login entry box and the
password in the Auth Password entry box.
Entering a network ID in the Hostname entry box makes the e-mail appear as though it did not come
from the instrument.
What do you want to do next?
Learn about E-mail on Event Setup. (see page 555)

Send an E-mail on Trigger
To send e-mail on a trigger event, click the E-mail on Trigger button to On.
NOTE. E-mail on Event must be configured to enable E-mail on Trigger (Use the Utilities > E-mail
on Event > Setup window).
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Fall Time

Fall Time
This timing measurement is the time required for the falling edge of the first pulse in the waveform or
gated region to fall from the high reference value (default = 90%) to the low reference value (default =
10%) of the final value.

FastFrame acquisitions

File menu
Use the File menu for basic file operations such as saving, recalling, and deleting waveforms or setups.
You can also use the File menu for standard Windows operations such as printing files and loading the
most recent setup.

Force a trigger
Click this button to force the instrument to trigger and complete the current acquisition, regardless of
whether any other trigger event occurs.
NOTE. This command has no effect if the acquisition system is not running.

Frame
A frame is a segment of the entire data record. When used with FastFrame, each segment contains all
of the data of a single acquisition. Each captured event is stored sequentially in its own frame. Frames
appear in the order they were captured.
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Frequency

Frequency
This timing measurement is a measure of the first cycle in a waveform or gated region. Frequency is the
reciprocal of the period; it is measured in Hertz (Hz) where one Hz is one cycle per second.

Frequency span
The frequency span is the range of frequencies over which the spectral analysis is performed. The
maximum span is from DC to one half of the sample rate (the Nyquist frequency). A smaller frequency
span allows a greater range of center-frequency adjustment. If a larger frequency span is desired, increase
the sample rate.

Imaginary number
Inserts the text SpectralImag( into the math expression. Select one of the waveforms as an argument to the
function. This function creates a waveform that displays only the imaginary part of the FFT.

Magnitude
Inserts the text SpectralMag( into the math expression. Select one of the waveforms as an argument to the
function. This function creates an FFT magnitude waveform.

Phase
Inserts the text SpectralPhase( into the math expression. Select one of the waveforms as an argument to the
function. This function creates an FFT phase waveform.

Real number
Inserts the text SpectralReal( into the math expression. Select one of the waveforms as an argument to the
function. This function creates a waveform that displays only the real part of the FFT.
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Maximum value

Maximum value
Inserts the text MAX( into the math expression. The MAX function accumulates over time the maximum
value at each point in the vector.

Minimum value
Inserts the text MIN( into the math expression. The MIN function accumulates over time the minimum
value at each point in the vector.

Getting the analysis and connectivity support tools
This instrument offers several tools you can install to support data export for use with data-analysis tools.
These tools ship with the Tektronix instrument that this online help supports. You can find them on the
product software DVD that ships with this instrument. You can find the Readme file on the CD-ROM that
you use to install the analysis and connectivity tools.
For more information:
For general information and examples on how each of these tools can help you use your instrument,
see the Getting Started with OpenChoice Solutions Manual with the CD-ROM (020-2513-XX).
For online information about the VXIplug&play driver, access the driver online help in from the help
system of your software development environment in which you install the driver. The driver online
help describes each function of the driver and presents these components in a hierarchical outline
corresponding to the standard VXIplug&playmodel.
For further reference information on TekVISA, see the TekVISA Programming Manual (071-1101-XX).
For online information on the TekVISA Excel toolbar, access the online help for the TekVISAExcel
Toolbar from the Excel Help menu once you have installed the toolbar.
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Ground terminal

Ground terminal
Use this terminal to connect the instrument to the same ground as the unit under test.

Guidelines for working with math waveforms
Use the following guidelines when working with math waveforms:
Keep math waveforms simple. If the math expression becomes too complex, try separating the
expression into more than one math waveform and then combining the waveforms (for example,
Math1 = Math2 + Math4).
Math calculations are not available on digital channels.
You cannot use math waveforms with Fast Acquisition mode.
Math waveforms cannot be turned on without a math expression.
Math waveforms cannot be created from a reference waveform that was saved in Fast Acquisition
mode.
To avoid syntax errors in a math expression, verify the use of operators, parentheses, operands, and the
spelling of functions before activating the math waveform.
When working with reference waveforms, if one or more reference waveforms are used as part of a
math waveform, the number of frames in the math waveform is the smallest of all source waveforms
(reference, math, or channel waveforms).
If one or more reference waveforms are used in a math waveform, the record length is equal to the
smallest of all the source waveforms (reference, math, or channel waveforms). The math is calculated
using the first point from each source, followed by the next point, and so forth. This is true even if the
sources have different times between points in the record.
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High

High
The high level measurement is the value used as 100% whenever high reference, mid reference, or low
reference values are needed, such as in fall time or rise time measurements. This value can be calculated
using either the min/max or histogram method. The min/max method uses the maximum value found. The
histogram method uses the most common value found above the midpoint. This value is measured over
the entire waveform or gated region.

High impedance probes
Most general-purpose probes have high input impedance.
The high input resistance of passive probes (typically 10 MΩ) provides negligible DC loading and
provides accurate DC amplitude measurements.
Most passive probes require the instrument input impedance to be 1 MΩ. However, their 8 pF to
12 pF (over 60 pF for 1X) capacitive loading can distort timing and phase measurements.
Use high resistance passive probes for measurements involving the following:
Device characterization (above 15 V, thermal drift applications)
Maximum amplitude sensitivity using 1X probe
Large voltage range (between 15 V and 500 V)
Qualitative or go/no-go measurements
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High reference

High reference
The High Reference defines the high reference level of a waveform; the default level is 90%. This
reference level is used with the Low Reference level in the calculation of rise and fall times. To change
this level, click the control, and then set the level with the multipurpose knob.

Histogram box limits - horizontal
1.

Select a mode:

2.

Specify the adjustment:

3.

Enter limits:

xxx

828

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Histogram box limits - vertical

Histogram box limits - vertical
1.

Select a mode:

2.

Specify the adjustment:

3.

Enter limits:

xxx
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Histogram box location - horizontal

Histogram box location - horizontal
1.

Select a mode:

2.

Specify the adjustment:

3.

Enter limits:

xxx
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Histogram box location - vertical

Histogram box location - vertical
1.

Select a mode:

2.

Specify the adjustment:

3.

Enter limits:

xxx

Histogram Max
Displays the voltage of the highest nonzero bin in vertical histograms or the time of the right-most nonzero
bin in the horizontal histograms.

Histogram Mean
Measures the average of all acquired points within or on the histogram box.

Histogram Min
Displays the voltage of the lowest nonzero bin in vertical histograms or the time of the left-most nonzero
bin in the horizontal histograms.
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Hits in Box

Hits in Box
Displays the number of points in or on the histogram box.

Mean±1 StdDev
The percentage of points in the histogram that are within one standard deviation of the histogram mean.

Mean±2 StdDev
The percentage of points in the histogram that are within two standard deviations of the histogram mean.

Mean±3 StdDev
The percentage of points in the histogram that are within three standard deviations of the histogram mean.

Peak Hits
Displays the number of points in the largest bin of the histogram.

Pk-Pk
Displays the peak-to-peak value of the histogram.
Vertical histograms display the "voltage" of the highest nonzero bin minus the "voltage" of the lowest
nonzero bin.
Horizontal histograms display the "time" of the right-most nonzero bin minus the "time" of the
left-most nonzero bin.
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StdDev (standard deviation)

StdDev (standard deviation)
The standard deviation (Root Mean Square deviation) of all acquired points within or on the histogram box.

Waveform count
Displays the number of waveforms that have contributed to the histogram.

Median
The middle point of the histogram box. Half of all acquired points within or on the histogram box are less
than this value and half are greater than this value.

Horizontal/Acquisition menu
Use the Horizontal/Acquisition menu options to set the horizontal and acquisition parameters for
waveforms. This menu also provides access to the Zoom controls, Autoset, and Fast Acquisitions.
On MSO5000B models and on DPO5000B models with option MSOE, you have the option to turn on or
turn off the MagniVu feature.

Set the horizontal delay
Use the Horizontal Delay Mode control to enter the amount of horizontal delay.
1. Click the Horizontal Delay Mode button to set the horizontal delay to on.
2. Click in the Acquisition Delay entry box and use the multipurpose knob to enter a value.
NOTE. You can also enter a delay value with the front-panel Horizontal Position knob.
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Set the horizontal position
Use the Horizontal Position control to move the trigger point within the acquired waveform.
To acquire waveform data only after the trigger event, set the Horizontal Position control to zero.
To acquire waveform data leading up to the trigger event, set the Horizontal Position control to any
value greater than zero.
For some setup control windows, you can click in the position control entry box and use the
multipurpose to enter a value (in addition to using the front-panel Horizontal Position knob).

Horizontal Position/Scale control window: Delay Mode
From the Horiz /Acq menu, select Position/Scale.

Overview
Use the Horizontal Position/Scale control window (see page 184) to set the horizontal delay and the
horizontal scale of the displayed waveforms when the horizontal delay is on.

To use
When horizontal delay is off (see page 184), the horizontal position control moves the trigger point
within the acquired waveform. The horizontal scale control expands or contracts the waveform around
the trigger point.
When horizontal delay is on (see page 185), you can delay the acquisition relative to the trigger event.
For more information on horizontal delay, see Horizontal Position/Scale Control Window: Horiz Delay On
(see page 185).
What do you want to do next?
Learn more about the Horizontal Position controls. (see page 834)

Set the horizontal position
From the Horiz /Acq menu, select Position/Scale to open the Horizontal Position/Scale control window
(see page 184).
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Set the horizontal scale

Overview
The horizontal position control moves the trigger point within the acquired waveform.

To use
Click in the Position entry box and use the multipurpose knob or keypad to change the setting.

Behavior
You can select the amount of data that appears before and after the trigger event. To acquire waveforms
leading up to the trigger event, set the horizontal position control to the maximum time setting. To acquire
waveforms after the trigger event, set the horizontal position control to the minimum time setting.
The horizontal reference point is shown as a small inverted triangle.
TIP. Use the dedicated front-panel Position knob to change the horizontal position.
What do you want to do next?
Learn about the Horizontal Scale control. (see page 835)

Set the horizontal scale
From the Horiz /Acq menu, select Position/Scale to open the Horizontal Position/Scale control window
(see page 184).

Overview
The Horizontal Scale control adjusts the time base.
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Horizontal reference marker

To use
Click in the Scale entry box and use the multipurpose knob or keypad to change the setting.

Behavior
The Scale control scales all live displayed waveforms at the same time.
The scale units depend on the waveform type. In most cases the horizontal units will be time. However,
the horizontal units can also be frequency.
TIP. Use the dedicated front-panel Horizontal Scale knob to change the horizontal scale.
What do you want to do next?
Learn about the Horizontal Setup control window. (see page 181)
Learn about the Acquisition Setup control window. (see page 185)

Horizontal reference marker

Horizontal delay mode
Use the Horizontal Delay Mode button to delay the acquisition relative to the trigger event.
When Horizontal Delay Mode is On, use the Acquisition Delay control to enter the delay time.
You can also enter the delay time with the front-panel Horizontal Position knob.
TIP. The Horizontal Delay Mode button functions identically to the Delay Mode button in the
Horizontal/Acquisition control window.

Set the horizontal delay
From the Horiz /Acq menu, select Position/Scale to open the Horizontal Position/Scale control window
(see page 185).
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Set the horizontal scale when delay is on

Overview
The Horiz Delay control delays the acquisition relative to the trigger event.

To use
Click Delay Mode On or push the front-panel Delay button to activate horizontal delay.
Click in the Horiz Delay entry box and use the multipurpose knob or keypad to change the setting.
You can also use the dedicated Horizontal Position knob on the front panel.

Behavior
The horizontal delay feature is useful when you want to acquire waveform details that are separated from
the trigger event by a significant interval of time.
For example, you can trigger the instrument on a sync pulse that occurs once every 10 ms, and then look at
the high-speed characteristics that occur 6 ms after the pulse.
TIP. A convenient way to use the horizontal delay is to make quick comparisons between two different
points in time. Trigger the instrument on one area of interest and then set the horizontal delay to acquire
the other area of interest. You can then toggle the horizontal delay on and off to compare details at
the two points in time.
What do you want to do next?
Learn more about the Horizontal Position controls. (see page 834)

Set the horizontal scale when delay is on
From the Horiz /Acq menu, select Position/Scale to open the Horizontal Position/Scale control window
(see page 185).

Overview
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To use
Click in the Scale entry box and use the multipurpose knob or keypad to change the setting.

Behavior
Use the Scale control to adjust the time base. This control scales all live displayed waveforms at the same
time. When horizontal delay is on, the scale expands or contracts around the horizontal reference point
instead of the trigger point.
The scale units depend on the waveform type. In most cases the horizontal units will be time. However,
the horizontal units can also be frequency.
TIP. Use the dedicated front-panel Horizontal Scale knob to change the horizontal scale.
What do you want to do next?
Learn more about the Horizontal Position controls. (see page 834)
Learn about the Horizontal Setup control window. (see page 181)
Learn about the Acquisition Setup control window. (see page 185)

Acquisition mode
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Acquisition tab (see
page 841).
The Acquisition Mode controls determine the method of acquisition.

To use
If you use Average or Envelope mode, select the number of waveforms for that mode using the
multipurpose knob.
If you use Waveform Database mode, use the multipurpose knob to select the number of samples.
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Behavior
A single waveform data point can be made up of several sequentially acquired data points. The waveform
data points can also be created from a composite of sampled data taken from multiple acquisitions. The
acquisition modes determine how the waveform data points are produced from the sampled data.
Sample. This mode creates a record point by saving one or more samples during each acquisition interval
(see page 200). Sample mode is the default acquisition mode. The instrument does no post processing of
acquired samples in this mode.
Pk Detect. Peak Detect mode alternates between saving the highest sample in one acquisition interval
and the lowest sample in the next acquisition interval. Peak Detect mode only works with real-time,
noninterpolated sampling.
Hi Res. High Resolution mode averages all samples taken during an acquisition interval to create a
record point. This average results in a higher-resolution, lower-bandwidth waveform. This mode only
works with real-time, noninterpolated sampling.
NOTE. A key advantage of Hi Res mode is its potential for increasing resolution regardless of the input
signal. The following table indicates that you can obtain up to 15 significant bits with Hi Res mode. Note
that the resolution improvements are limited to speeds slower than 40 ns/div.
Additional resolution bits
2.5 GS/s

8.5 bits

1.1 GHz

1 GS/s

9 bits

440 MHz

250 MS/s

10 bits

110 MHz

50 MS/s

11 bits

22 MHz

10 MS/s

12 bits

4.4 MHz

2.5 MS/s

13 bits

1.1 MHz

1 MS/s

14 bits

440 kHz

250 KS/s

15 bits

110 kHz

25 KS/s

>15 bits

11 kHz

250 S/s

>15 bits

110 Hz
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Acquisition mode

Additional resolution bits
25 S/s

>15 bits

11 Hz

2.5 S/s

>15 bits

1.1 Hz

xxx

Envelope. This mode acquires and displays a waveform record that shows the extremes in variations over
several acquisitions. The instrument saves the highest and lowest values in two adjacent intervals similar
to Peak Detect mode. Unlike Peak Detect mode, the peaks are gathered over many trigger events.
After each trigger event, the instrument acquires data and then compares the minimum and maximum
values from the current acquisition with those stored from the previous acquisition. The final display
shows the most extreme values for all the acquisitions for each point in the waveform record.
Acquiring and displaying a noisy square wave signal illustrates the difference between the modes. Note
how Average mode reduces the noise while Envelope mode captures its extremes:

Average. This mode acquires and displays a waveform record that is the average result of several
acquisitions. This mode reduces random noise. Use the multipurpose knobs to specify the number of
waveforms that you want to average.
WfmDB. Waveform Database mode acquires and displays a waveform that is the accumulation of
several acquisitions. In addition to time and amplitude, the waveform displays a count of the number of
times a specific sample point has been acquired. The value at each point on the waveform is a counter
that reflects the hit intensity. The instrument acquires data after each trigger event using Sample mode.
It then determines the location of each sample point and accumulates it with shared data from previous
acquisitions. This is the only mode that can be used when doing mask testing with an optical standard.
Fast Acq is inhibited in Waveform Database mode.
What do you want to do next?
Learn about Fast Acquisitions mode. (see page 191)
Learn about Roll mode. (see page 193)
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Horizontal/Acquisition control window (Acquisition tab)
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Acquisition tab.

Overview
Use the Acquisition tab to set the acquisition parameters for all live waveforms. The Acquisition
controls are common to all channels. This means that you cannot acquire in Sample mode on channel
1 while channel 2 acquires in Envelope mode.
For information on the controls, click on the buttons.
Acquisition Mode (see page 838)
Fast Acquisitions (see page 191)
Roll Mode (see page 193)
Sampling Modes (see page 194)
FastFrame Control Windows (see page 200)
External Signals Control Window (see page 550)

Behavior
Acquisition is the process of sampling the analog input signal, digitizing the signal to convert it into
digital data, and then assembling the signal information into a waveform record. The instrument
creates a digital representation of the input signal by sampling the voltage level of the signal at
regular time intervals. The sampled and digitized points are stored in memory along with the
corresponding timing information. The instrument uses the digital representation of the signal for
display, measurements, or for further processing.
Use the controls on this tab to define the sampling method, the acquisition mode, turn Fast
Acquisitions on or off, and activate an external reference.
What do you want to do next?
Learn about Acquisition modes. (see page 838)

Set horizontal delay and horizontal position
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab (see
page 181).

Overview
Use this control to select the amount of data that appears before the trigger event.
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To use
Click Delay Mode to toggle Delay Mode Off, and then click in the Position entry box. Use a
multipurpose knob or the front-panel Horizontal Position knob to set the horizontal position.
Click Delay Modeto toggle Delay Mode On, and then click in the Horiz Delay (Horizontal Delay)
or Ref Point (Reference Point) entry boxes. Use a front panel multipurpose knob or the keypad to
set these values.

Behavior
The Position control moves the trigger point within the acquired waveform.
The Horiz Delay and Ref Point controls only appear when the Delay Mode is On. Horiz Delay enables the
instrument to look for a trigger and then wait a specified time before acquiring data. This is useful when
you know that the data you are interested in occurs a set time after the trigger.
Use the Ref Point control to specify the amount of pretrigger data. The reference point is represented on
the screen by a small inverted triangle.
TIP. Use the dedicated Horizontal Delay button to turn the Horizontal Delay on and off. Or, use the
Horiz/Acq menu Delay Mode On command.
You can also toggle the Horizontal Delay on and off to quickly compare signal details at two different
areas of interest, one near the trigger location and the other centered at the delay time.
What do you want to do next?
Go to the Horizontal Setup control window. (see page 181)
Return to the Acquisition Setup control window. (see page 185)
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Horizontal control window readouts
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab (see
page 181).

Overview
Use the horizontal readouts, similar to those shown below, to obtain a quick overview of the horizontal
settings.
NOTE. You cannot change the Horizontal controls directly from the readouts.

To use
The readout values are determined by the Horizontal control settings. The type and number of readouts
will change depending on the setup of the horizontal controls.

Resolution Readout.
This readout displays the time between sample points. In most
cases, the acquisition interval is the same as the resolution.

This readout displays the number of acquisition samples per
Sample Rate Readout.
second. The faster the sample rate, the more accurately the instrument can represent fine details
in a fast signal.

Duration Readout.

Record Length Readout.
the waveform record.

Digital Record Length.
the digital waveform record.

This readout displays the time to cross the 10-division screen.

This readout displays the number of samples that make up

This readout displays the number of samples that make up

NOTE. Digital Record Length is available only on MSO5000B Series instruments and DPO5000B Series
instruments with option MSOE.
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Horizontal controls

What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 841)

Horizontal controls
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab (see
page 181).

Overview
Use the Mode controls to adjust the time base.

To use
Click in a Horizontal Controls entry box to map it to one of the multipurpose knobs; then use the knob to
change the value. You can also use the pop-up keypad to enter a value.
Horizontal controls
Use this control to set the sample rate (see page 693) for
the waveform record. In general, higher sampling rates
produce more accurate measurements.
Use this control to adjust the scale of live waveforms,
including math waveforms. Scale units depend on the
waveform type; in most cases the horizontal units will be
time, but they can also be frequency.

TIP. Use the dedicated front-panel Horizontal Scale knob
to change the horizontal scale.

Use this control to define the length of the waveform record
(see page 694). The record length is the number of sample
points that make up the waveform record.

NOTE. Record lengths of less than 1000 samples are not
supported.
Click this button to maximize the updated rate by setting a
record length limit in the Set Record Length Limit dialog
box. This feature is available in Automatic mode only.

xxx

Behavior
When you change the record length, you can choose to hold either the sample rate or the horizontal scale
constant. The remaining variables will change in response to the record length changes.
Maximum record length depends on the following:
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The amount of memory.
The ability to combine the memory length of unused channels.
NOTE. Hi Res and Avg modes require twice the acquisition memory of other acquisition modes. When you
select these modes, the instrument sets the record length accordingly to keep it from running out of memory.
Delay mode.
When Delay Mode is Off the scale expands or contracts around the trigger point (see page 694).
When Delay Mode is On the scale expands or contracts around the horizontal reference point.
Horizontal zoom. You can use the Horizontal Zoom control window (see page 202) to change the
horizontal scale and position of reference waveforms within the Zoom window(s).
What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 843)

I2C addressing mode
In the Addressing Mode drop-down list, select the bit addressing mode.

Increment/Decrement buttons
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Installing software

Installing software
The instrument system and application software is pre-installed at the factory. If you have to reinstall the
software for any reason, refer to the instruction manuals that accompanied the product.

Software release notes
Read the software release notes (README.TXT) on the product software DVD before performing
installation procedures. This file contains additional information that supersedes other product
documentation.
To view the README.TXT file, start the Windows Notepad accessory and open the file from the product
software DVD that came with your instrument.

Accessory software
The product software DVD contains accessory software and files that you can install on the instrument or
on another PC. Refer to the instructions that accompany the DVD for installation information.

Desktop applications
You can install desktop application software on the instrument. The instrument has been tested with the
following software products installed:
Microsoft Office (Word, Excel, PowerPoint, etc.)
MathCad
MATLAB
Other software products may be compatible but have not been tested by Tektronix. If the instrument
malfunctions after you install software, uninstall the software and then reinstall the instrument application
to restore proper operation.
Before installing other desktop applications, exit the instrument application. To do this, click Exit on the
File menu.

846

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Interactions of Roll Mode and other instrument settings

Interactions of Roll Mode and other instrument settings
Roll mode can interact with other instrument settings:
If Roll mode is on and you turn on Fast Acquisitions, Roll mode will be suppressed until you turn
Fast Acquisitions off.
If Roll mode is on, math waveforms and measurements are updated only after acquisition is stopped
(when you manually stop an acquisition). If you stop an acquisition before a record is filled, the math
waveform or measurements will be calculated on the partial data.
Roll mode is only valid for real-time acquisition modes such as Sample, Peak Detect, and Hi Res.
Roll mode is ignored in Average or Envelope acquisition modes.
Deskew values are ignored when Roll mode is on.
If you attempt to save a waveform when Roll mode is on, only the waveform points in the acquisition
memory are saved.
The maximum record length where Roll mode is allowed is 10 M.

IVI drivers
IVI drivers conform to specifications produced by the IVI Foundation.
Unlike VXI-plug&play drivers, IVI drivers provide a standard interface to different classes of instruments,
including oscilloscopes and spectrum analyzers.
IVI drivers have the ability to simulate instruments, automatically check ranges, and multithread safety
features.

Jitter 6 sigma
Jitter 6 sigma is six times the RMS value of the edge jitter in the current horizontal units.
Jitter 6 sigma = 6 × (JitterRMS)

Jitter peak-to-peak
Jitter p-p is the peak-to-peak value for the edge jitter in the current horizontal units.
Jitter PP = TCross1PP
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Jitter root mean square

Jitter root mean square
Jitter RMS is the RMS value of the edge jitter in the current horizontal units.
Jitter RMS = TCross 1sigma

Lock mask
Lock Mask to Waveform resizes the mask to reflect changes in the horizontal or vertical settings of the
instrument.

Logic pattern
Select the Boolean logic function for the combination of the input channels. The instrument will trigger on
a clock edge when the input waveforms match the specified logic pattern.

Logic pattern inputs
The instrument input channels represent the data inputs; the channel inputs combine to form a logic pattern.
Each channel can have a value of high (H), low (L), or "don't care" (X):
A value is considered high if the channel input voltage is greater than the specified threshold voltage.
A value is considered low if the channel input voltage is less than the specified threshold voltage.
Use the "don't care" selection for any channels that will not be used as part of the pattern.
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Logic pattern trigger criteria
Use the Pattern drop-down list to determine when the instrument should trigger.
Select True to trigger the instrument when the logic patterns are true.
Select False to trigger the instrument when the logic patterns are false.
You can also specify that the pattern is true (or false) for a specified amount of time before the instrument
triggers. To specify the time:
Click in the Time entry box.
Set the time with the multipurpose knob.
NOTE. The Time control is unavailable when you select True or False.
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Logic pattern and state pattern editor (bus tab)
Use the controls to set up the Logic Pattern or the Logic State trigger pattern for the instrument to use
to detect a bus value.
The maximum pattern size (number of bits) for Logic Pattern or Logic State trigger is 20 bits. The display
pattern format is binary, hexadecimal, ASCII, or decimal. The pattern display format can also be symbolic.
The binary pattern uses the symbols 0, 1, and X (it is a do not care bit and is not case-sensitive). The
hexadecimal pattern uses the symbols 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F, and X. Five hexadecimal
characters will convey all 20 digital inputs. The characters show up in the binary, hexadecimal, ASCII, and
decimal fields. The non-selected entries are automatically populated with the correct data corresponding
to what you enter in the selected entry field. An X is shown in the field when you do not enter enough
characters.

What do you want to do next?
Learn how to set the voltage threshold level for channels used as digital waveforms and to define a
pattern. (see page 851)
Learn about bus setups. (see page 97)
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Logic pattern and state pattern editor (digital tab)
Use the controls to set up the Logic Pattern or the Logic State trigger pattern of the channels the instrument
uses as logic waveforms to detect a bus value.

What do you want to do next?
Learn how to define a pattern for the instrument to use to detect a bus value. (see page 850)
Learn about bus setups. (see page 97)

Logic clock inputs
For the supported instruments, you need to connect one of the channel inputs to a clock signal. The
instrument combines all of the channel inputs to form a logic pattern.
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Logic pattern format
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
Select the Logic Pattern or Logic State trigger type. You can change the format of the pattern after you
define a logic pattern.

ASCII causes the instrument to represent the bus pattern value as an ASCII value.
Decimal causes the instrument to represent the bus pattern value as a decimal value.
Hex causes the instrument to represent the bus pattern value as a hexadecimal value.
Binary causes the instrument to represent the bus pattern value as a binary value.

Logic pattern setup
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
Use the controls to set up the Logic Pattern or Logic State trigger pattern. Click the Edit button to access
the Pattern Editor dialog box.
NOTE. The Logic Pattern or Logic State trigger setups include the D15-D0 digital channels.
For information on the Pattern Editor dialog box, click the buttons.
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Logic state inputs
Channels 1, 2, and 3 represent the data inputs. Channel 4 should be connected to the clock signal. The
channel inputs combine to form a logic pattern.
Each channel can have a value of high (H), low (L), or "don't care" (X).
A value is considered high if the channel input voltage is greater than the specified threshold voltage.
A value is considered low if the channel input voltage is less than the specified threshold voltage.
Use the "don't care" selection for any channels that will not be used as part of the pattern.

Logic state trigger criteria
Use the Trigger When Pattern selection to determine when the instrument should trigger.
Select True to trigger the instrument when the logic patterns go true.
Select False to trigger the instrument when the logic patterns go false.

Low
The low level measurement is the value used as 0% whenever high reference, mid reference, or low
reference values are needed, such as in fall time or rise time measurements.
This value can be calculated using either the min/max or histogram method. The min/max method uses the
minimum value found. The histogram method uses the most common value found below the midpoint.
This value is measured over the entire waveform or gated region.

Low impedance probes
Most low impedance (Zo) passive probes measure frequencies or timing measurements more accurately
than general-purpose probes, but they take less accurate amplitude measurements. They offer a higher
bandwidth to cost ratio.
The low input impedance passive probes must be terminated in a 50 Ω instrument input. Input capacitance
is much lower than high impedance passive probes, typically 1 pF, but input resistance is also lower
(500 Ω to 5000 Ω typically). Although that DC loading degrades amplitude accuracy, the lower input
capacitance reduces high frequency loading to the circuit under test. That makes low input impedance
passive probes ideal for timing and phase measurements when amplitude accuracy is not a major concern.
Low input passive impedance probes are useful for measurements up to 40 V.
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Low reference
The Low Reference defines the low reference level of a waveform; the default level is 10%. This reference
level is used with the High Reference level in the calculation of rise and fall times. To change this level,
click the control and then, set the level with the multipurpose knob.

Enable mask autoset autofit
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Setup control
window, click the Autoset Config button.

Overview
Use this control to minimize hits.

To use
Click the Autofit Once button to autofit the waveform after autoset is performed.

Behavior
When Autofit is turned on, the waveform is autofitted once at the end of every autoset. Autoset will take
longer but hits will be minimized. Autofit will only move the signal if there are mask hits.
What do you want to do next?
Learn about trigger level autoset. (see page 857)
Learn about vertical autoset. (see page 858)
Learn about horizontal autoset. (see page 855)
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Mask autoset horizontal controls
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Setup control
window, click the Autoset Config button.

Overview
Use these controls to choose whether to have autoset affect the horizontal scale or position.

To use
Click the Scale and Position controls to turn these horizontal control functions on or off.

Behavior
Turning on the Scale or Position horizontal control functions sets up these adjustments to align the signal
within the mask when autoset is done.
What do you want to do next?
Learn about vertical autoset. (see page 858)
Learn about trigger level autoset. (see page 857)
Learn about autofit for autoset. (see page 854)
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Select the mask autoset mode
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Testing control
window, click the Autoset Config button.

Overview
Use these controls to select whether autoset will be done automatically or manually.

To use
Click Auto to have autoset done automatically after a standard mask is selected.
Click Manual to make adjustments manually.

Behavior
If Auto is selected, an autoset is done automatically after a standard mask is selected. The purpose of the
manual autoset mode is to adjust everything that can be done without having any waveform data.
What do you want to do next?
Learn about trigger level autoset. (see page 857)
Learn about vertical autoset. (see page 858)
Learn about horizontal autoset. (see page 855)
Learn about autofit for autoset. (see page 854)
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Control the mask autoset trigger level
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Setup control
window, click the Autoset Config button.

Overview
Use this control to choose whether to have autoset affect the trigger level.

To use
Click the Trigger Level button to turn it off or on.

Behavior
When the Trigger Level control is turned on, the trigger levels are adjusted to match the signal when
autoset is performed.
What do you want to do next?
Learn about autofit for autoset. (see page 854)
Learn about vertical autoset. (see page 858)
Learn about horizontal autoset. (see page 855)
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Set mask autoset vertical controls
From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Setup control
window, click the Autoset Config button.

Overview
Use these controls to choose whether to have autoset affect the vertical scale or position. You can also
choose whether to have autoset affect DC compensation.

To use
Click the Scale, Position, and DC Compensation controls to turn these vertical control functions on or off.

Behavior
Turning on the Scale, Position, or DC compensation sets these vertical adjustments up to be performed on
an autoset.
What do you want to do next?
Learn about horizontal autoset. (see page 855)
Learn about trigger level autoset. (see page 857)
Learn about autofit for autoset. (see page 854)
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Mask Hit Count
Each mask can have a maximum of 16 segments. Segments can overlap. The number of mask hits is the
sum of all hits in all segments, regardless of whether or not segments overlap. If a waveform crosses over
an area where two segments overlap, both segments will count the waveform hit.
When you set Hit Count to on, the counts will appear in the Pass/Fail Test Summary (see page 235).

Mask menu
Use the Mask menu commands to setup or edit or a user mask.

Math arbitrary filters
This section describes the library of FIR filters that are available for use under the ArbFilt <x>( <
fsource waveform>) function in the Tektronix oscilloscope waveform math section. The user may
find this under the path: C:\Users\[Username]\Tektronix\TekScope\Math Arbitrary
Filters\<filename>. The filename of each filter identifies its type as low pass, high pass, etc
and also identifies its normalized cutoff frequency or other identifying factors. The precise magnitude
characteristics of these filters are shown in the following graphs. These are all linear phase filters.
You can use the Math Equation Editor (see page 271) to set up a waveform filter.

Low pass filters
The following graphs show the available set of low pass filters. Their normalized frequency response is
shown from 0 to ½ the sample rate. These filters will operate at any sample rate with cutoff frequency
scaled as shown below on the graphs. The filters have normalized cutoff frequencies of 0.05, 0.1, 0.15,
0.20, 0.25, 0.3, 0.35, 0.40, and 0.45. Stop band rejection is typically between –50 and –60 dB.
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Frequency response of the available low pass filters
The following table lists the available low pass filters:
File name

Normalized cutoff frequency

lowpass_0.05bw.fl

0.05

lowpass_0.10bw.flt

0.10

lowpass_0.15bw.flt

0.15

lowpass_0.20bw.flt

0.20

lowpass_0.25bw.flt

0.25

lowpass_0.30bw.flt

0.30

lowpass_0.35bw.flt

0.35

lowpass_0.40bw.flt

0.40

lowpass_0.45bw.flt

0.45

xxx

High pass filters
The following graphs show the available set of high pass filters. Their normalized frequency response is
shown from 0 to ½ the sample rate. These filters will operate at any sample rate with cutoff frequency
scaled as shown below on the graphs. The filters have normalized cutoff frequencies of 0.05, 0.1, 0.15,
0.20, 0.25, 0.3, 0.35, 0.40, and 0.45. Stop band rejection is typically between –50 and –60 dB.
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Frequency response of the available high pass filters
The following table lists the available high pass filters:
File name

Normalized cutoff frequency

highpass_0.05bw.flt

0.05

highpass_0.10bw.flt

0.10

highpass_0.15bw.flt

0.15

highpass_0.20bw.flt

0.20

highpass_0.25bw.flt

0.25

highpass_0.30bw.flt

0.30

highpass_0.35bw.flt

0.35

highpass_0.40bw.flt

0.40

highpass_0.45bw.flt

0.45

xxx

Band pass filters
Each filter has a bandwidth of 0.05 times the sample rate. They will operate at any sample rate. The
available center frequencies are 0.05, 0.10, 0.15, 0.20, 0.25, 0.30, 0.35, 0.40, 0.45. Stop band attenuation is
approximately -60 dB and pass band ripple is around 1dB.
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The following table lists the available normalized band pass filters:
File name

Normalized bandwidth

Normalized center frequency

bandpass_0.05bw_0.05center.flt

0.05

0.05

bandpass_0.05bw_0.10center.flt

0.05

0.10

bandpass_0.05bw_0.15center.flt

0.05

0.15

bandpass_0.05bw_0.20center.flt

0.05

0.20

bandpass_0.05bw_0.25center.flt

0.05

0.25

bandpass_0.05bw_0.30center.flt

0.05

0.30

bandpass_0.05bw_0.35center.flt

0.05

0.35

bandpass_0.05bw_0.40center.flt

0.05

0.40

bandpass_0.05bw_0.45center.flt

0.05

0.45

xxx

Band stop filters
Each filter has a bandwidth of 0.1 times the sample rate. They will operate at any sample rate. The
available center frequencies are 0.10, 0.15, 0.20, 0.25, 0.30, 0.35, and 0.40. Stop band attenuation is
approximately – 110 dB, however, the noise floor of the oscilloscope will not allow for that depth.
With an FFT and long record length, and averaging turned on, one can approach noise floors in the –
110 dBm range on an 8-bit oscilloscope. However, the oscilloscope will have some spurious signals
above that floor. This is possible because the FFT is an average calculation internally and the averaging
function increases the vertical bits of resolution.
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Frequency response of the available band stop filters
The following table lists the available normalized band stop filters:
File name

Normalized bandwidth

Normalized center frequency

bandstop_0.1bw_0.10center.flt

0.1

0.10

bandstop_0.1bw_0.15center.flt

0.1

0.15

bandstop_0.1bw_0.20center.flt

0.1

0.20

bandstop_0.1bw_0.25center.flt

0.1

0.25

bandstop_0.1bw_0.30center.flt

0.1

0.30

bandstop_0.1bw_0.35center.flt

0.1

0.35

bandstop_0.1bw_0.40center.flt

0.1

0.40

xxx

Smoothing filters
These are sometimes called box car filters. They simply average together adjacent samples along the time
record. The filter coefficients for these filters are all equal to 1/ M where M is the length of the filter. The
name of the files indicates the length of the smoothing filter.
Smoothing filters are low pass filters with a somewhat less than optimal stop band characteristic. However,
they are commonly used to remove high frequency noise from a displayed trace. Take care in using to
insure that the pass band of the signal you are filtering is well within the pass band of the filter you
choose. That will insure that only noise is removed. Lengths of 3, 5, 10, 20, 50, 100, and 200 are provided
in the library. The red trace is for filter length 3, followed by blue trace at 5, followed by magenta trace
for 10, and so on.
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Frequency response of the available smoothing filters
The following table lists the available smoothing filters:
File name

Length

Normalized bandwidth

Stop band attenuation dB

smooth3.flt

3

0.1558

-9.4

smooth5.flt

5

0.0903

-12

smooth10.flt

10

0.0446

-12.9

smooth20.flt

20

0.0224

-13.2

smooth50.flt

50

0.00887

-13.2

smooth100.flt

100

0.0045

-13.2

smooth200.flt

200

0.0022

-13.2

xxx

Hilbert transform filter
The ideal Hilbert transform filter has a gain of one at all frequencies and shifts the phase of all frequencies
by 90 degrees. This type of filter is one of the types that may be specified in the Remez Exchange
algorithm. This filter departs from its desired behavior in the frequency range of 0 to 0.025 times
the sample rate and also in the range of about 0.475 to 0.5 times the sample rate. This type of filter
can be used to create quadrature signals over a wide frequency range. The filename for this filter is
HilbertTransform90PhaseShift.flt.
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Frequency response of the Hilbert transform filter

Differentiator
The ideal differentiator is a high pass filter that shifts phase by 90 degrees and its’ frequency response
would be linear from DC to 0.5. Since this is not easily realized, the filter provided in the library makes a
good differentiator for the frequency range of DC to 0.45.
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Frequency response of the differentiator filter
This section describes the ASCII file format for storing filters for use in the Tektronix oscilloscope
waveform math section. A filter menu function allows the user to specify a disk file name containing the
filter. A single file format allows the user to specify a different set of coefficients for each sample rate that
the filter operates at. If the desired sample rate is not in the file list, then the filter will not be applied to the
data. The file format also allows the user to specify that the set of filter coefficients is normalized. This
allows the same set of filter coefficients to operate at all sample rates.
The ASCII file format is specified as follows:
# Comments are preceded by # symbol
<
<
|
|
<

sampleRate > coef1, coef2, ….
sampleRate > coef1, coef2, ….
|
|
sampleRate > coef1, coef2, ….

coefN
coefN

coefN

Each set of filter coefficients in a file are specified in one row preceded by the sample rate value at which
that set will operate. If the user specifies the @ symbol for the sample rate then the filter will operate at all
sample rates. If the @ symbol is specified then there should only be one set of filter coefficients in the file.
However, the user may have other rows with sample rates specified and they will be ignored. There will be
a separate row for each sample rate the filter is to operate at. Each row may have a different number of
coefficients with a maximum of 1000. The file may contain up to 20 rows.
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An example of file content for a normalized filter is shown below. This example is the contents of the
smooth5.flt file:
@ 0.2, 0.2, 0.2, 0.2, 0.2

An example of a filter that is setup to operate at a specific sample rate is given as follows. This is
the contents of a file named 200MHz_mult_sample_rates.flt that is included in the library directory on
the oscilloscope.
#This is a 4th order Bessel Thompsen low pass filter.
#200MHz bandwidth, will operate at any of the following sample rates:
# 40 GS/s, 20 GS/s, 10 GS/s, 5 GS/s, 2.5 GS/s, 1 GS/s, 500 MS/s
5e8; 1.968e-007,1.008,-0.00978,0.002267,-0.0002208,1.643e-005,-1.397e006,1.434e-007
1e9; 9.524e-008,0.3899,0.4877,0.1304,-0.004733,-0.004566,………………………….
2.5e9; 3.868e-008,0.01885,0.1081,0.1982,0.2284,0.1981,………………………
5e9; 1.935e008,0.0007332, 0.009428, 0.02874, 0.05408, 0.07921, ……………………….
1e10; 9.673e-009,3.445e-006,0.0003666,0.001831,0.004714,0.008978,0.01437,0………
……….
2e10; 4.837e-009, 1.657e-008, 1.723e-006, 4.274e-005, 0.00018334-009, ……………….
4e10; 2.418e-009, -3.524e-009, 8.284e-009, -1.795e-008,8.613e-007, ……………….

Enter a math expression
From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

To use
Select a Math <1-4> waveform from the drop-down list.
Click in the readout field to enter the math expression.
Click a button to enter its character or operator into the expression.
Click the Editor button and use the Math Equation Editor controls to insert numerals, math operators,
and variables into a math expression.
Use the Text Edit Controls (see page 265) to move the insertion point (cursor) within the expression.

Behavior
The characters are entered into the math expression one at a time.
What do you want to do next?
Learn about the Math Setup controls. (see page 247)
Learn about averaging math waveforms. (see page 247)
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Display a math equation
From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

To use
Click Off/On to turn the math waveform display on and off.
Click Avgs to open the Adjust Math Parameters (see page 247) control window. Use this window to
define the number of times you want to average the selected math waveform.

Behavior
These controls only affect the selected math waveform.
What do you want to do next?
Learn about the Equation Editor. (see page 263)

Math menu
Math menu options enable you to perform mathematical operations on waveforms, build algebraic
expressions, perform math-on-math operations, analyze histograms, or use advanced spectral analysis.

Set the math display and vertical controls
From the Math menu, select Math Setup.

To use
Click a Math <1-4> tab to identify a math waveform.
Click in the Math <1-4> = data entry field to enter the math expression, or select a predefined
expression (see page 899).
Click Off/On to turn the math waveform display on and off.
Click Avgs to open the Adjust Math Parameters (see page 247) control window. Use the Math
Parameter control window to define the number of times that you want to average the selected math
waveform.
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Maximum

Click in the Vertical Control entry boxes and use the multipurpose knobs to change the vertical
position and scale of the selected math waveform.
Use the Label entry box to attach a meaningful label to the waveform.
Use the Units to assign custom vertical units for each math waveform.
Click the Logic Properties button and open the Logic Threshold Setup (see page 811) menu to set the
thresholds for each channel or math waveform.

Behavior
These controls only affect the selected math waveform. The Position control increases or decreases the
vertical position of the waveform one pixel at a time. The Scale control changes the displayed waveform
only; it has no effect on the acquisition hardware.
TIP. To open the Math Equation Editor, double-click in the math expression field or click the Editor button.
NOTE. If Autoscale is not checked, vertical scale and position are not calculated when a math waveform is
turned on or the math equation is changed.
What do you want to do next?
Learn about the Equation Editor. (see page 263)

Maximum
This voltage measurement is the maximum amplitude. It is typically the most positive peak voltage and is
measured over the entire waveform or gated region.

Mean
This voltage measurement is the arithmetic mean over the entire waveform or gated region.

Set up a histogram measurement
From the Measure menu, select Measurement Setup; then open the Histog tab.
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To use
Use the Histog tab to select automatic histogram measurements.
1. Select a source with the Channels Selector (see page 264).
2. Click a Measurements button to add a Histogram measurement to the Measure list:
WfmCt (see page 871)

Median (see page 871)

Pk-Pk (see page 871)

U+ /-1S (see page 872)

Hits in Box (see
page 871)

Max (see page 871)

Mean (see page 871)

U+ /-2S (see page 872)

Peak Hits (see page 871)

Min (see page 871)

St Dev (see page 871)

U+ /-2S (see page 872)

xxx

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 296)
to turn the measurement display on and off.

Behavior
Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.
TIP. Select the individual measurements directly from the Measure menu Histogram Measurements
submenu.
What do you want to do next?
Learn about taking amplitude measurements. (see page 276)
Learn about taking timing measurements. (see page 279)
Learn about other measurements. (see page 288)
Learn about communications measurements. (see page 284)
Learn more about the Measurements list. (see page 872)
Learn more about the Measurement controls. (see page 292)
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Waveform count
Displays the number of waveforms that have contributed to the histogram.

Hits in Box
Displays the number of points in or on the histogram box.

Peak Hits
Displays the number of points in the largest bin of the histogram.

Median
The middle point of the histogram box. Half of all acquired points within or on the histogram box are
less than this value and half are greater than this value.

Histogram Max
Displays the voltage of the highest nonzero bin in vertical histograms or the time of the rightmost
nonzero bin in the horizontal histograms.

Histogram Min
Displays the voltage of the lowest nonzero bin in vertical histograms or the time of the leftmost
nonzero bin in the horizontal histograms.

Pk-Pk
Displays the peak-to-peak value of the histogram.
Vertical histograms display the "voltage" of the highest nonzero bin minus the "voltage" of the
lowest nonzero bin.
Horizontal histograms display the "time" of the rightmost nonzero bin minus the "time" of the
leftmost nonzero bin.

Histogram Mean
Measures the average of all acquired points within or on the histogram box.

StdDev (standard deviation)
The standard deviation (Root Mean Square (RMS) deviation) of all acquired points within or on the
histogram box.
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Mean±1 StdDev
The percentage of points in the histogram that are within one standard deviation of the histogram
mean.

Mean±2 StdDev
The percentage of points in the histogram that are within two standard deviations of the histogram
mean.

Mean±3 StdDev
The percentage of points in the histogram that are within three standard deviations of the histogram
mean.

Set up the measurement list
From the Measure menu, select Measurement Setup.

To use
To add a measurement to the list, select the waveform type (Channel, Math, or Reference), and then
click one of the Measurements buttons.
To delete a measurement, select the measurement, and then click Clear Selected.
To delete all measurements, click Clear All.
Click Annotations to quickly select a measurement already included in the listed.
Click Display in the upper-right corner of the control window to turn the measurement displays
on and off.
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Behavior
This list contains your selected automatic measurements. You can add up to eight automatic measurements
to the list. The measurements appear on the main screen when the Display button is On.
When you click Clear without selecting a measurement, the last measurement in the list is deleted.
TIP. To quickly move the measurements from one channel to another, select all of the measurements
in the list (click the first measurement, hold the left mouse button, and drag the mouse to the last
measurement), and then select a new channel from the Source control. Similarly, you can change all of
the measurements from one type to another if you select all the measurements in the list and click on a
single measurement button.
What do you want to do next?
Learn more about the Measurement controls. (see page 292)
Return to the Measurement Setup control window overview. (see page 274)

Measurement menu
Use Measurement menu commands to select from and set up a variety of automatic measurements.
Commands are also available on this menu for further in-depth analysis, gating (bounding), statistics,
communication, and histograms.

Mid2 reference
The Mid2 reference defines the middle reference used on the second waveform specified in delay or phase
measurements; the default level is 50%. To change this level, click the control, and then set the level
with the multipurpose knob.

Mid reference
The Mid reference defines the middle reference level of a waveform; the default level is 50%. This
reference value is primarily used for making measurements between edges such as pulse widths. To
change this level, click the control, and then set the level with the multipurpose knob.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

873

Oscilloscope Reference

Minimum

Minimum
This voltage measurement is the minimum amplitude. It is typically the most negative peak voltage and is
measured over the entire waveform or gated region.

Graphic indicator
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MyScope menu
Use the MyScope Menu to create a new MyScope control window, open or edit an existing one, display
the active MyScope window, or recall recently used ones.

Natural antilog
1. Inserts the text EXP( into the math expression.
2. Enter an argument to the function.
The natural antilog function raises e to the power of the argument.

Negative duty cycle
This timing measurement is the ratio of the negative pulse width to the signal period expressed as a
percentage. The duty cycle is measured on the first cycle in the waveform or gated region.
Negative Duty Cycle = ((Negative Width) ÷ Period) × 100%

Negative overshoot
This voltage measurement is measured over the entire waveform or gated region and is expressed as:
Negative Overshoot = (Low – Minimum) × Amplitude × 100%

Negative width measurement
This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a negative pulse.
The measurement is made on the first pulse in the waveform or gated region.
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Noise peak-to-peak
Noise p-p is the peak-to-peak value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.
Noise Pk-Pk = PToppk-pk or PBasepk-pk

Noise root mean square
Noise RMS is the RMS value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.
Noise RMS = PTopsigma or PBasesigma

Normal trigger mode
Normal trigger mode causes the instrument to wait for a valid trigger event before displaying waveform
data. Normal trigger mode is most useful during single-shot acquisitions.

Nyquist frequency
The highest frequency that any digital oscilloscope can measure without errors is one-half of the sample
rate or frequency. This frequency is called the Nyquist frequency.
The FFT waveform displays the input signal frequency components from DC (0 Hz) to the Nyquist
frequency.
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Set up zoom AutoScroll
From the Vertical or Horiz /Acq menu, select Zoom Controls; then open the Scroll tab.

Overview
Use the AutoScroll control window to set the scroll speed and lock zoomed areas together.

To use
To scroll a single zoomed area, open the Zoom tab and select the zoom area (1–4).
Open the Scroll tab and click an Auto Scroll arrow button.
Click in the Scroll Speed entry box, and then use a multipurpose knob to set the scroll speed.
To scroll multiple zoomed areas simultaneously, click Lock, and then click the zoomed areas (1–4)
you want to scroll through. This locks the zoomed areas in their relative horizontal positions.

Behavior
If the zoom areas are unlocked, the Horizontal Position and Factor controls affect only the selected zoom
area. The Horizontal Position and Factor will affect all zoom areas that are locked together, such that a
change to one zoom area will change the horizontal position and factor of all the locked zoom areas.
What do you want to do next?
Learn about the Zoom Setup controls. (see page 202)
Return to the Vertical Setup control window overview. (see page 485)
Return to the Horizontal Setup control window. (see page 181)
Learn about the Zoom Control window. (see page 487)
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Set the cursor position: XY display
From the Cursor menu, select Cursor Position.

Overview
Use the Cursor Position control window to position the cursors with the multipurpose knobs.

To use
1. Click the Source drop-down list to select the measurement source for the cursor.
2. Click in one of the cursor position entry boxes and use a multipurpose knob to enter the cursor position.

Behavior
The cursor units depend on the cursor type. The cursor position readouts appear on the display graticule.
When using the IRE graticule style, amplitude cursor readouts are shown in IRE units.
Cursor position does not change if the cursor source changes or if the waveform is repositioned.
TIP. Use the pop-up keypad or your external keyboard to specify exact numerical cursor coordinates.
What do you want to do next?
Learn about the Cursor Setup controls. (see page 73)
Learn about the cursor types. (see page 80)
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Set display persistence
From the Display menu, highlight Display Persistence; the select Persistence Controls.

To use
Click one of the buttons to select the display persistence.
Click Infinite (persistence) to continuously accumulate record points on the waveform until you
change one of the acquisition display settings.
Click Variable; then click in the Time entry box and use the multipurpose knobs to set the persistence
time.
Click Reset to clear the persistence.
Click Controls to activate the Persistence Control window.
Click Setup to open the Display control window.

Behavior
Use infinite persistence for displaying record points that may occur outside the normal acquisition
envelope.
Use Variable to accumulate record points on the waveform for a specified time interval. Each record
point decays independently according to the time interval.
If you click Off, the waveform record points appear for the current acquisition only.
TIP. Use the Display menu Display Persistence submenu or right-click in the graticule and select Display
Persistence from the shortcut menu to directly access the persistence options.
What do you want to do next?
Learn about changing the display colors. (see page 172)
Learn about using text with screen displays. (see page 168)
Learn about changing the appearance of objects in the display. (see page 171)
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Set the FastFrame Analyze tab controls
From the Horiz /Acq menu, select FastFrame; then open the Analyze tab.

Overview
Use the FastFrame Control Window (see page 200) Analyze tab to select the viewing frame (see page 881)
(Selected Frame) when FastFrame is turned on. You can also select the reference frame.

To use
1. Select the Source channel from the drop-down list, and then use the multipurpose knob to select
the Reference Frame.
2. Select the Source channel from the drop-down list, and then use the multipurpose knob to identify the
Selected Frame.
3. Click the Timestamp (see page 202) Table Save button to display the Save As dialog box and save
FastFrame time stamps in a table format.

Behavior
The Selected Frame displays the frame of interest. The Selected Frame can use any Channel, Math, or
Reference waveform as the source waveform. The instrument will display one frame at a time. You can
use the Selected Frame control to scroll through all of the frames until you find the frame of interest.
TIP. Use the Reference frame to establish a reference frame when using time stamps. You can view the
time stamps by turning on the readouts.
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Time delta between frames
You can calculate the Time Delta (differences) between Frames and display those differences. These time
stamps are displayed in a format (see page 881) that shows the date and time. The Timestamp Table
displays the current time stamps and readout information. This table is read-only.

Frame
A frame is a segment of the entire data record. When used with FastFrame, each segment contains all
of the data of a single acquisition. Each captured event is stored sequentially in its own frame. The
frames appear in the order they were captured.

Time stamp readout format
The Time Stamp readouts are displayed in the following format:
Day/Month/Year/ Hours/Minutes/Seconds/ Milliseconds/Microseconds/Nanoseconds/Picoseconds

Frame finder
Set up the Frame Finder to search for individual frames; then click Start to initiate the search.
What do you want to do next?
Go to the Horizontal Setup control window. (see page 181)
Return to the Acquisition Setup control window. (see page 185)

Set up FastFrame Setup tab controls
From the Horiz /Acq menu, select FastFrame Setup; then open the Setup tab.

Overview
Use the FastFrame Control Window (see page 200) Setup tab to select the event Duration and Frame Size
when FastFrame is turned on.
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To use
1. Click the FastFrame button to turn FastFrame mode On or Off.
2. Click in the Event/Frame entry boxes and use the multipurpose knobs to select the Frame Size,
Duration, and the Number of Events/Frames.
3. Click a None, Average, or Envelope option button from the Summary Frame list to replace the last
frame with one that is the computed, average or envelope, of all frames in the set.
4. Click a Single Sequence Mode Stop Condition option button to define how to stop FastFrame
acquisition.
5. Start the acquisition; it is recommended that you use Single acquisition mode rather than Run/Stop
mode.
NOTE. If you change the oscilloscope controls while Fastframe is running, the controls will be returned to
the user and the maximum number of frames may not be captured.

Behavior
The Frame Size is the record length and defines the number of samples in each frame.
The Event/Frame Duration defines the number of frames to store in the acquisition memory of a single
channel. The product of the frame size and the event/frame duration is constrained within the available
memory. If more frames are needed, the instrument will automatically decrease the record length; if more
samples are needed, the instrument will automatically decrease the frame count.
NOTE. Because of the overhead associated with each frame, the maximum number of frames the
instrument can capture (from a given record length) is less than the number theoretically possible.
What do you want to do next?
Learn about the Reference Frame and time stamps. (see page 880)
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Learn some tips for using FastFrame. (see page 935)

Set up FastFrame View tab controls
From the Horiz /Acq menu, select FastFrame; then open the View tab.

Overview
Use the FastFrame Control Window (see page 200) View tab to specify how to view frames when
FastFrame is turned On.

To use
1. Select the Source channel from the drop-down list, and then use the multipurpose knob to identify the
Selected Frame.
2. Click either the Channel, Math or Channel, Math, Ref option buttons to determine which frames
you want to lock together.
3. Click a View Multiple Frames option button to toggle this function between Off, Overlay Only, or
Overlay and Selected Frame. When Overlay is selected, two additional fields are displayed: Start
Frame and Number of Frames. These fields allow you to select a range of frames that are displayed in
the color of the Source channel.
NOTE. In Overlay Only, the frames are superimposed over each other. The Selected Frame is displayed in
blue unless you are using the Spectral or Temperature palette; then the selected waveform is displayed
in the same color as the other frames.
The instrument does not support Overlay and Selected Frame view when the display format is set to XYZ.
TIP. You may find it difficult to distinguish the dark blue Selected Frame if you have previously selected
Spectral or Temp for the Color Palette.
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Behavior
The Selected Frame displays the frame that you want to view. You can use the MultiView Zoom features
of the instrument to magnify the waveform of interest. The Selected Frame can use any Channel, Math,
or Reference waveform as the source waveform.
When View Multiple Frames is off, the instrument will display one frame at a time. You can use the
Selected Frame control to scroll through all of the frames until you find the frame of interest.
When you click a Lock Frame Together <Channel, Math> option button, the channel and math waveforms
are locked together. Adjusting a channel waveform also adjusts a related math waveform. All reference
waveforms are locked together, but they are separate from channel and math waveforms.
When you set the Selected Frame Source Ch1 to Frame 3, then the Selected Frame Ch2, Ch3, Ch4, Math1,
Math2, Math3 and Math4 are also set to frame 3. When you set the Selected Frame Source Ref1 to Frame
2, then the Selected Frame Ref2, Ref3, and Ref4 are also set to Frame 2.
To lock the reference and all selected frames together, click the Lock Frames Together <Channel, Math,
Ref> option button. When these frames are locked, they maintain the same relative distance from each
other as you adjust either frame. For example: if channels and maths are set to frame 2, and references
are set to frame 3, then after selecting Lock <Channel, Math, Ref>, an increment of 1 frame will cause
channels to display frame 3 and references to display frame 4.
When you click the View Multiple Frames <Overlay> button, the Start Frame and the Number of Frames
fields are displayed. Use the upper multipurpose knob to enter the Start Frame (first frame) in the frame
sequence that you want to view. Use the lower multipurpose knob to enter the total number of frames
that you want to view.
For example, if you have 1000 frames and you want to view frames 75 through 100, use the upper
multipurpose knob to enter 75 in the Start Frame field and the lower multipurpose knob to enter 26 in the #
of Frames field. The result of these settings is that frames 75 through 100 are displayed superimposed over
each other in the color of the selected Source, and the current (selected frame) is displayed superimposed
in dark blue, unless you are using the Spectral or Temperature color palette.
What do you want to do next?
Learn about the reference frame and time stamps. (see page 880)
Learn some tips for using FastFrame. (see page 935)

Select waveform save options
From the File menu, highlight Save As; then select Waveform from the submenu. In the Save As dialog
box, click the Waveform Options button.

Overview
Use the Waveform Save Options dialog box to set the parameters for the waveform you want to save.
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To use
1. Select the data format (Data Destination) for the waveform you want to save:
a. Select Spreadsheet (TXT) to include spreadsheet data separated by white space.
b. Select Spreadsheet (CSV) to include spreadsheet data separated by commas.
c. Select Mathcad or Matlab to save the waveform in Mathcad or Matlab format.
d. Select TekWaveform (*.wfm) to save the waveform in the TekScope waveform format. When
waveform is selected, save waveform options like waveform data range, FastFrame data range,
waveform detail and data ordering are disabled.
e. Select HDF5 (*.h5) to save the waveform in HDF5 format. HDF5 saves the entire waveform.
When HDF5 is selected, save waveform options like waveform data range, FastFrame data range,
waveform detail and data ordering are disabled.
2. Select a valid waveform from the Sources to Save list: Channel <1– 4>, Math <1–4>, Ref <1– 4>, All
Digital, All Analog, All Math, or All Displayed Sources.
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3. Select the number of samples you want to save under Waveform Data Range:
a. Select a range of samples.
b. Select only the Samples between Cursors. If you select Samples between Cursors, you can use the
multipurpose knobs to adjust the positions if the cursors are already active. If they are not, the
cursors are activated in their most recent positions.
c. Select only Samples in Zoom Area.
d. Select All samples.
4. If the waveform is a FastFrame waveform, specify the FastFrame Data Range.
5. Click the Include waveform scale factors check box if you want to include waveform details like
header information (record length, sample interval, trigger point information, and so on). If you only
want to include the waveform voltage values, clear the selection.
6. If you are saving Fast Acquisition data, select the Data Ordering from the drop-down list.
7. Click OK to return to the Save As dialog box (see page 541), where you can assign your own
file name and save the waveforms to a specified folder. By default, the file is saved to the
C:\Users\[Username]\Tektronix\TekScope\Waveforms folder. If the information is saved
as a CSV file, then the file is saved to the C:\Users\[Username]\Tektronix\TekScope\data
folder by default.

Behavior
The waveform data is saved as numeric values. The data destination you select here is the file type
selection used in the Save As dialog box. Use the Save As dialog box to finalize the selections and to
save the waveform to a file. Options are grayed out if they are not available with the currently selected
data destination.
What do you want to do next?
Learn about saving waveforms. (see page 541)
Learn more about CSV text format. (see page 887)
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CSV text format
In the Tektronix oscilloscope, you can save the waveform data generated in CSV format. You can import
this waveform data into an Microsoft Excel spreadsheet for analysis. The waveform data occupies five
columns in the spreadsheet.
NOTE. Do not enter math formulas or other data in the first 3 columns. Data in the first 3 columns is
deleted if you paste new waveform data into the spreadsheet.
The first column is the name of the parameter (such as Record Length, Sample Interval, Trigger Point, and
Trigger Time), the second column is the value of the parameter, the third column is the unit associated with
each of the parameters, the fourth column is the time of the waveform sample relative to the trigger point,
and the fifth column is the value of the sampled waveform that was converted from the oscilloscope's
internal digitizing levels.
time = sample interval * (index – trigger point )
Where:
sample interval = the Sample Interval from column two
index = the sample number of the sample being calculated
trigger point = the sample number of the Trigger Point
The information in the first to fourth columns is generated only if you select the Include waveform scale
factors option and when you paste or export data.
Deselect the Include waveform scale factors option when you want to analyze and/or plot the data for
several waveforms captured with the same setup on a given instrument. The values in the first to fourth
columns are same for all the waveforms. So you need to export these columns only once.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

887

Oscilloscope Reference

Set Mask Test controls

Set Mask Test controls
From the Mask menu, select Mask Controls. You can also click the Controls button in the Mask Testing Pass/Fail Setup or Mask Testing - Pass/Fail Results control windows.

Overview
Use this control window to run a test and view the results. You can also reset or start the test and return to
the Mask Setup control window from this control window.

To use
Click On/Off to start and stop the test.
Click Reset to reset the test.
Click the drop-down arrow in the Test Summary field to select a different source. Status, Total Hits,
and Failed Wfms are read only fields.
Click Setup to return to the Mask Setup control window.

Behavior
This control window allows a mask test to run on a full screen and still provide access to the start, stop and
reset functions. In addition, you can see the test summary for each input selected.
What do you want to do next?
Learn about test summary. (see page 235)
Learn about hits per segment. (see page 237)
Learn about test results. (see page 234)

Set up a delay measurement
From the Measure menu highlight Time; then select Delay from the submenu, or open the Time tab in the
Measurement Setup control window and click the Delay button under Measurements.
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Overview
Use the Delay Measurement control window to set up the instrument to measure the delay between
two waveforms.

To use
1. Select the source waveforms from the Channels Selector (see page 264).
2. Use the other controls in the control window to select the Delay Edges (see page 890), Mid Reference
point (see page 891), Mid2 Reference point (see page 295), and to specify the Search Direction.
3. Click OK to add the measurement to the measurement list, or click Cancel to cancel the measurement
and return to the Measurement control window.

Behavior
This timing measurement is the time between the mid reference crossing of two different waveforms,
or the gated region of the waveforms.
The graphic in the control window shows the points on the waveforms from which the delay measurement
will be taken. The graphic is updated each time you change the control settings. The Delay direction
controls only apply to Source 2. When you click Forward, the instrument starts searching for the desired
edge at the beginning of the record. When you click Backwards, the instrument starts searching for the
desired edge from the end of the record. If the edge for Source 1 is before the edge for Source 2, then
the delay is greater than zero. Otherwise the delay is less than zero.
What do you want to do next?
Learn about taking amplitude measurements. (see page 276)
Learn about taking histogram measurements. (see page 296)
Learn about other measurements. (see page 288)
Learn about taking communications measurements. (see page 284)
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Learn more about the Measurements List. (see page 872)

Delay edges
The Delay Edge buttons determine whether the measurements will be taken on the rising or falling
edge of the waveform. After selecting an edge, the graphic in the control window is updated to show
the edge from which the measurements will be taken.

Set up a phase measurement
From the Measure menu highlight More; then select Phase from the submenu. You can also open the More
tab in the Measurement Setup control window, and then click the Phase button under Measurements

Overview
Use the Phase Measurement Setup control window to set up the instrument to take phase measurements.

To use
1. Use the Channels Selector (see page 264) to select the target and reference source waveforms.
2. Then use the Mid Reference (see page 891) control to specify the voltage reference point in the
waveform.
3. Click OK to add the measurement to the measurement list or click to cancel the measurement and
return to the Measurement Setup control window.
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Behavior
This measurement is the amount of time one waveform leads or lags another waveform. Phase is expressed
in degrees, where 360° comprise one waveform cycle. The measurement is taken at the voltage level
specified by the Mid Reference control.
What do you want to do next?
Learn about taking amplitude measurements. (see page 276)
Learn about taking timing measurements. (see page 279)
Learn about taking histogram measurements. (see page 296)
Learn about taking communications measurements. (see page 284)
Learn more about the Measurements List. (see page 872)

Mid reference
The Mid reference defines the middle reference level of a waveform; the default level is 50%. This
reference value is primarily used for making measurements between edges such as pulse widths. To
change this level, click the control, and then set the level with the multipurpose knob.

MyScope controls
Click one of links below to access detailed information on the controls in each category:
File (see page 538)
Edit (see page 517)
Vertical (see page 485)
Horizontal (see page 181)
Trigger (see page 393)
Display (see page 167)
Cursors (see page 73)
Measure (see page 274)
Mask (see page 215)
Math (see page 247)
Utilities (see page 936)
NOTE. Some MyScope controls operate differently than the identical control in the user interface.
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What do you want to do next?
Learn about the MyScope Setup and Edit control windows. (see page 387)

Select timestamp save options
From the File menu, highlight Save As; then select Timestamp Table from the submenu. In the Save As
dialog box, click the Timestamp Options button.

Overview
Use the Timestamp Save Options dialog box to set the parameters for the time stamp you want to save.

To use
1. Select the data Source for the time stamp you want to save.
2. Set the FastFrame Data Range for the time stamp.
3. Click OK to return to the Save As dialog box, where you can assign your own file
name and save the time stamp to the specified folder. By default, the file is saved to the
C:\Users\[Username]\Tektronix\TekScope\data folder.

Behavior
The time stamp table data is saved as a .txt file.
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Select the graticule size
From the Vertical or Horiz/Acq menus, highlight Zoom Graticule Size; then select Size from the submenu.

To use
Click one of the Graticule Size buttons to set the proportion of the display area for the acquisition
window and zoom window.
Click Setup to access the Zoom Setup control window.

Behavior
Click the 50-50 button to allocate half of the available display for the zoomed graticule and half of the
available display for the acquisition window. Click 80-20 to allocate 80% of the available display
for the zoomed graticule and 20% for the acquisition window. Click Full to use the entire display for
the zoomed graticule.
What do you want to do next?
Learn about the Zoom Setup controls. (see page 202)
Go to the Zoom Setup control window. (see page 893)

Select the termination/coupling
From the Vertical menu, select Termination or Coupling.

Overview
Use the Termination control window to select channel input resistance or probe coupling parameters.
For information on the controls, click the buttons.
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NOTE. This online help documents features and options available for several instrument models. Your
instrument may not have every feature discussed in this online help.

To use
The correct input termination is set automatically when you attach a probe with a TekProbe or TekVPI
interface. For other probes, you must set the input termination manually.
Select the input coupling for the signal from the attached probe to the instrument.
What do you want to do next?
Learn more about the Bandwidth controls. (see page 498)

Offset and clipping
Clipping
The circled portion of the incoming waveform is clipped,
and therefore, is not acquired.
The clipped portion cannot be processed or displayed.
Offset can move the acquisition window vertically relative
to the incoming waveform.

Offset removes clipping
By setting an offset to vertically shift the acquisition
positive relative to the waveform, the clipped portion can
be acquired.

xxx
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The On-Screen MultiView Zoom Menu
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Peak to peak
This voltage measurement is the absolute difference between the maximum and minimum amplitude in
the entire waveform or gated region.

Period
This measurement is the time required to complete the first cycle in a waveform or gated region. Period is
the reciprocal of frequency and is measured in seconds.

Phase
This timing measurement is the amount of time that one waveform leads or lags another waveform. The
measurement is expressed in degrees where 360° comprise one waveform cycle.

Select trigger polarity
Select the polarity from the drop-down list.
Click Positive to trigger on a positive-going pulse.
Click Negative to trigger on a negative-going pulse.
Click Either to trigger the instrument on either polarity.
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Pop-up keypad
1. Click in a data entry box.

2. Click on the keypad icon.

3. Use the pop-up keypad to enter data.

4. Click the Enter button.
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Positive duty cycle
This timing measurement is the ratio of the positive pulse width to the signal period expressed as a
percentage.
The duty cycle is measured on the first cycle in the waveform or gated region.
Positive Duty Cycle = ((Positive Width) ÷ Period) × 100%

Positive overshoot
This voltage measurement is measured over the entire waveform or gated region.
Positive Overshoot = (Maximum – High) × Amplitude × 100%

Positive width
This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a positive pulse.
The measurement is made on the first pulse in the waveform or gated region.
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Posttrigger data
The data acquired and displayed after the trigger event. You can set the amount of pretrigger data with the
Horizontal Position control.

On / Standby switch
Use this button to power the instrument on or to set the instrument to standby.

Before shutting down, it is recommended that you first exit the instrument application and any other active
Windows applications to avoid error messages on shutdown or the next power on.
TIP. To exit the instrument application and shut down in one step, select Shutdown in the File menu.

Predefined functions
From the Math menu, select Math Setup.

To use
Click a button to use one of the predefined math expressions to create the math waveform based on
live (channel) waveforms. If the channels are active, you can access each expression directly from the
Math menu.

Behavior
These buttons provide common predefined math expressions.
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Click Ch1-Ch2 and Ch3-Ch4 to create math waveforms that are the difference between two input
waveforms. Use these functions to view differential signals.
Click Ch1*Ch2 or Ch3*Ch4 to create math waveforms that are the product of the two input
waveforms. For example, you can obtain a power waveform by multiplying a voltage waveform by
a current waveform.
Click Spectral Mag to create a spectral magnitude waveform.
Click Spectral Phase to create a spectral phase waveform.
The math waveform is based on the last active waveform on the screen. A spectral waveform is created
from a channel waveform; you cannot create a spectral waveform from math or reference waveforms.
TIP. Use the Equation Editor (see page 263) to manually create and edit math waveforms.
What do you want to do next?
Learn about the Equation Editor. (see page 263)

Pretrigger data
The data points of the waveform acquired and displayed before the trigger event. You can set the amount
of pretrigger data with the Horizontal Position control.

Probe calibration output
Use the Probe Calibration output to calibrate or deskew passive or active voltage probes.

Probe calibration restrictions
Some probes cannot be calibrated or compensated. This might be because the probes have an attenuation
factor greater than 20X. You will get an error message if you try to compensate such a probe.
The instrument cannot compensate for probes that may have gain and/or offset errors that are too great
(>2% or >50 mV offset). If these errors are within the specified limits of your probe, you may want to use
another probe. If the errors are outside the limits, have your probe checked by service personnel.
Probe calibration is not recommended for the P5050 passive probe. This probe typically has little gain
and offset error, and therefore, the performance improvement after a probe calibration is not worth the
time needed to do the probe calibration.
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Probe compensation

Probe compensation adjustment

Probe compensation output
Use the Probe Compensation output to compensate or deskew passive or active voltage probes.

Quality factor
Quality factor is the ratio of eye size to noise.
Quality Factor = (PTopmean – PBasemean)/(PTopsigma + PBasesigma)
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Recall a template waveform
Use this procedure to recall a template waveform to a reference location.
1. From the File menu click Recall.
2. Under Recall What: click Waveform, and then select the waveform you want to recall.
3. Select Ref <1–4> from the Destination drop-down list.
4. Click Recall.

Recall a mask
Use the Mask Edit Setup control window to recall a mask.
1. From the Mask menu, select Mask Edit Setup.
2. In the Mask Edit control window, click the Recall button.
3. In the Recall dialog box, click User Mask; then select the mask you want to recall.
4. Click Recall to recall the mask.
NOTE. The default folder for saving masks is C:\Users\[Username]\Tektronix\TekScope\Masks. If you
saved masks in a different folder, click the Look in drop-down list to find the folder where your masks
are saved.

Horizontal modes
From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab (see
page 181).

Overview
The instrument has three horizontal modes. The default mode is Automatic; the default record length
limit is 200,000 points.
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To use
Select the mode that works best for your application.
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Horizontal mode
Automatic. Use this mode to set the Scale and Sample
Rate; the record length is a dependent variable. If the
current time-per-division scale has a record length equal
to the record length limit, changing the time-per-division
to a larger value will decrease the sample rate to the next
available setting. If the current record length is less than the
record length limit, the record length can exceed the record
length limit by one record length setting. If the sampling
mode is real time, and the sample rate is at the real-time
limit, attempting to increase the sample rate has no effect.
To set the Record Length Limit, click the Advanced button
and enter the limit in the Set Record Length Limit dialog
box. You can use the buttons or keypad. The instrument
will keep the set record length near this limit to produce
the best sequence of reduction in sample rate, as the
time-per-division is increased.
Record length limiting takes place when you change the
time-per-division setting. You can use the Sample Rate
control to temporarily exceed the record length limit by
any amount. The default maximum limit depends on the
instrument model and record length option you purchased.

TIP. You can use the front panel Horizontal Resolution
knob to change the sample rate in Automatic mode.

NOTE. The instrument supports Mask testing in Automatic
mode only.
Constant Sample Rate. Use this mode to set the Sample
Rate and Scale; the record length is a dependent variable.
For ≥4 GHz instrument models, the default sample rate
supports bandwidth filter operation. The maximum record
length for your instrument depends on instrument model
and record length option.

TIP. You can use the front panel Horizontal Resolution

knob to change the sample rate in Constant Sample Mode.

Manual. Use this mode to set the Sample Rate and
Record Length; the horizontal scale is a dependent variable
calculated from the sample rate and record length.

TIP. You can use the front panel Horizontal Scale knob to
change the record length in Manual mode.

xxx

Behavior
Sample rate, scale, and record length are interactive in all modes. If you increase the scale, the sample rate
must decrease if either the maximum record length or the record length limit you set is reached.
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Automatic and Constant Sample Rate modes are identical, with the exception that in Constant Sample Rate
mode the user cannot set the record length limit. In both cases, the instrument maintains the sample rate
constant as set specified by the user.
NOTE. Manual mode uses the maximum record length available for the instrument you purchased.
What do you want to do next?
Learn more about the Horizontal Setup controls. (see page 844)

Reference point
Use the Ref Point control to define the horizontal reference point within the acquired waveform. The
horizontal reference point determines the location within the acquired data where the scale controls
will expand or contract the waveform.
When Horizontal Delay is On, the reference point is the trigger point plus the Horizontal Delay time.
When the horizontal delay is Off, the reference point is the trigger point.

Resolution bandwidth
The resolution bandwidth controls the bandwidth of the spectral analyzer filters. You can adjust the
resolution bandwidth in units of hertz. The resolution bandwidth is measured at the –3 dB points on
each side of the peak spectral lobe of the filter.
Resolution bandwidth is inversely proportional to the gate duration in the time domain. Changing the
gate duration changes the resolution bandwidth. Changing the spectral analyzer window function also
changes the resolution bandwidth but will not affect the gate duration.
To decrease the resolution bandwidth beyond the present limits, increase the time domain gate duration. If
this is insufficient, increase the record length and then increase the gate duration again. You can also try the
rectangular or Hamming window to maximize the frequency resolution (minimize resolution bandwidth).
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Rise time

Rise time
This timing measurement is the time required for the leading edge of the first pulse in the waveform or
gated region to rise from the low reference value (default = 10%) to the high reference value (default =
90%) of the final value.

RMS
This voltage measurement is the true Root Mean Square voltage over the entire waveform or gated region.

Set the RS-232 baud rate
Click in the Baud Rate entry box and use the multipurpose knob to set the baud rate for the trigger.

Select the RS-232 data parity
In the Data Parity drop-down list, select the parity for the trigger.

Set the upper and lower threshold values
The upper and lower threshold levels define the voltage limits of a runt pulse.
To set the upper threshold, click in the Upper Level entry box, and then use the multipurpose knob to
set the voltage level.
To set the lower threshold, click in the Lower Level entry box, and then use the other multipurpose
knob to set the voltage level.
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Runt trigger criteria
Select Occurs from the Runt drop-down list to trigger on any runt.
Select Wider from the Runt drop-down list to trigger on a runt pulse of a minimum width; click in the
Width entry box and use the multipurpose knob to set the minimum pulse width.
Select Logic from the Trigger if Runt drop-down list to trigger on a logic-qualified runt pulse. When
the instrument detects that a runt has occurred, it checks the logical state of two other available
channels and triggers only if their conditions are met. Each channel can have a value of high (H),
low (L), or "don't care" (X). A value is considered high if the channel input voltage is greater than
the specified threshold voltage; a value is considered low if the channel input voltage is less than the
specified threshold voltage.
Use the X "don't care" selection for any channels that will not be used as part of the pattern.

Save a mask
Use the Mask Edit Setup control window to save a mask:
1. From the Mask menu, select Mask Edit Setup.
2. In the Mask Edit control window, click Save.
3. In the Save As dialog box, select User Mask. You may need to click More to access the User Mask
selection.
4. Enter a file name in the Name box. If you do not have a keyboard attached, click the keyboard icon to
use the pop-up keyboard to enter the file name.
5. Click Save to save the mask. The default folder for saving masks is C:\Users\[Username]\Tektronix\TekScope\Masks. If you want to save the mask in a different folder, click the Save in
drop-down list, and then click a folder to select it.
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Scallop loss
Scallop loss is the difference between the actual magnitude and the computed magnitude of a signal that is
halfway between two frequency bins in the spectral output data. Scallop loss is only noticeable when the
spectral analyzer is not using zero-fill such as when it is set to full span.
If zero-fill is in use, frequency domain interpolation occurs and there is minimal scallop loss. Zero-fill
cannot be directly controlled; it is affected by changing settings of resolution bandwidth or gate width.
When in use, a minimum of 20% of the FFT input is always zero, effectively removing scallop loss
error by interpolating in the frequency domain.
NOTE. For most settings, descriptions of amplitude accuracy due to scallop loss (as discussed in other
publications) do not apply to this oscilloscope when used as a spectral analyzer because of zero-fill. Full
span is the most likely setting where scallop loss might occur.

Scan controls
These controls are available for the Custom video format. Interlaced and Progressive are the only available
Scan Types.

The Scan Rate enables you to trigger on nonbroadcast video signals that have unique scan rates. Select the
scan rate range that includes your signal: 15-20 kHz, 20-25 kHz, 25-35 kHz, 35-50 kHz, or 50-65 kHz.

Selecting a spectral window
A spectral window determines what the filter shape of the spectral analyzer will be in the frequency
domain. It may be described by a mathematical function that is multiplied point-by-point times the input
data to the spectral analyzer.
The following spectral windows are available with the instrument:
Rectangular
Hamming
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Selecting a spectral window

Hanning
Kaiser-Bessel
Blackman Harris
Gaussian
Tek Exponential
Flattop2
The windows are listed in the order of their ability to resolve frequencies (resolution bandwidth). You
can easily observe the shape of a window in the frequency domain by feeding a sine wave into the
instrument and setting the center frequency of the spectral analyzer to the same frequency. Then reduce the
resolution bandwidth to spread out the lobe horizontally. You can then select different window functions
and observe their shape.

Window attributes
In the time domain, windows are typically bell shaped and go to zero at the ends of the record. For
cases where you may be doing impulse response testing, the impulse should be centered at the zero
phase reference point (for most windows, this is the 50% position of the gate and 20% for the Tek
Exponential window).
Different window functions affect the resolution bandwidth of the spectral analyzer.
Various window shapes affect the scallop loss (see page 909).
The shape of the frequency domain lobe is determined by the window function. Some windows have
better resolution bandwidth, but they do so at the expense of side lobe attenuation and energy leakage
(see page 910) into adjacent bins. For example, a rectangular window typically spills energy into
many bins showing signals that don’t exist; but it has the best frequency resolution. If you are using
a window where leakage is occurring, you may want to use spectral gating to reduce the amplitude
errors when measuring a given frequency.

Scallop loss
Scallop loss is the difference between the actual magnitude and the computed magnitude of a signal
that is halfway between two frequency bins in the spectral output data. Scallop loss is only noticeable
when the spectral analyzer is not using zero-fill such as when it is set to full span.
If zero-fill is in use, frequency domain interpolation occurs and there is minimal scallop loss. Zero-fill
cannot be directly controlled; it is affected by changing settings of resolution bandwidth or gate width.
When in use, a minimum of 20% of the FFT input is always zero, effectively removing scallop loss
error by interpolating in the frequency domain.
NOTE. For most settings, descriptions of amplitude accuracy due to scallop loss (as discussed in
other publications) do not apply to this oscilloscope when used as a spectral analyzer because of
zero-fill. Full span is the most likely setting where scallop loss might occur.
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Selected waveform versus deselected waveform

Leakage
Leakage results when the time domain waveform used to create the FFT function is periodic but
contains a noninteger number of waveform cycles. When the record contains a fraction of a cycle,
there are discontinuities at the ends of the record.
These discontinuities cause energy from each discrete frequency to leak over on to adjacent
frequencies. This results in amplitude errors when measuring any given frequency. Different windows
have different leakage characteristics.

Selected waveform versus deselected waveform
The waveform handle indicates if a waveform is selected
or deselected.
The waveform handle is outlined in the same color as the
graticule when the waveform is selected. The waveform
handle is outlined in black when a waveform is deselected.

xxx
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Sequence triggering (horizontal delay on)
From the Trig menu, select A - B Trigger Sequence; then open the A -> B Seq tab.

Overview
Select the A-B Seq tab to use the A Event (main) trigger with the B Event trigger to capture complex data.
For information on the controls, click the buttons.

Behavior
Select A - B Trigger Sequence to use the A Event (main) trigger with the B Event trigger to capture
complex data. The A Event trigger arms the trigger system. The instrument then triggers on the B Event
trigger defined by events or time. You can also set up the instrument to delay the B Event Trigger by a
specified time period by turning Horizontal Delay Mode on.
When you click on the trigger window controls, the trigger graphic (see page 394) shows the trigger
sequence.
What do you want to do next?
Learn about the A Event trigger types. (see page 394)
Learn about B Event triggers. (see page 466)
Learn about Trigger Mode and Holdoff. (see page 482)
Return to the Trigger Setup control window. (see page 393)
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Change the serial bit rate
From the Trig menu, select Serial Pattern Setup.

To use
To change the bit rate of the serial bus on the display, double-click the Bit Rate entry box, and use the
keypad or the multipurpose knob to enter a new bit rate.

Behavior
The Standard you select determines the bit rate range. Adjusting the bit rate will change the standard
to Custom.

Select the serial clock source
From the Trig menu, select Serial Pattern Setup.

To use
In the Clk Src drop-down list, select the clock source for the trigger. The instrument makes one
attempt to recover the clock from the data.

Behavior
If you are using R Clk as the clock source, and the clock recovery system does not lock to the input
signal, the input signal may be missing or the trigger level may be incorrect. In such an event, correct the
problem and push the Level control Set 50% knob, to force the instrument to make another attempt at
recovering the clock.

912

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Select the serial coding standard

Select the serial coding standard
From the Trig menu, select Serial Pattern Setup.

To use
In the Coding drop-down list, select the coding standard for the trigger.

Behavior
The standard sets the bit rate. Changing the bit rate causes the standard to change to your own customized
standard.

Select the serial data format
From the Trig menu, Select Serial Pattern Setup.

To use
In the Format drop-down list, select the data format, Binary or Hex, depending on how you want
to view the data.

Select the serial data source
From the Trig menu, select Serial Pattern Setup.

To use
In the Data Src drop-down list, select the data source for the trigger.

Behavior
Depending on which clock source you use, the Clk Polarity and Clk Level controls appear. Use these
controls to set the clock polarity and clock level threshold.
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Select the serial data standard
From the Trig menu, select Serial Pattern Setup.

To use
In the Standard drop-down list, select the data standard for the trigger.

Serial mask testing option
Install Option MTM on DPO7000C and MSO/DPO5000B Series instruments.
Install Option MTH on DPO70000C/DX and MSO70000C/DX Series instruments.

Define the serial pattern data
From the Trig menu, select RS-232, Serial, or SPI Setup and then click the Edit button.

To use
1. Select either the Binary or Hex format option.
2. Use the editor controls to define the pattern to trigger on:
Use the alpha - numeric buttons to insert a character in the text box.
Click the Home button to place the cursor at the right most position of the text box.
Click the Left arrow button to move the cursor one space to the left.
Click the Bksp button to delete one character at a time from left to right.
Click the Right arrow button to move one space to the right.
Click the Clear button to clear the text box.
3. Click Enter to complete the edit.
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Behavior
If you select the hexadecimal format and the binary pattern cannot be displayed in hexadecimal format,
then the serial pattern data will display a question mark (?) instead of an alpha - numeric character.
Clicking the X, 0, or 1 button inserts that character to the left of the cursor in the text box.
What do you want to do next?
Learn more about other trigger types. (see page 394)
Go to the Serial Trigger control window. (see page 438)
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Define the serial trigger on pattern
From the Trig menu, select Serial Pattern Setup.

To use
Use these controls to define a NRZ pattern for the instrument to trigger on.
Pattern
1. In the Format drop-down list box, select Binary or Hex.
2. Click the Edit button and use the Serial Pattern Editor to define the pattern.
3. Click Enter.
Lock
Lock automatically finds and locks on to a long repeating pseudo-random bit sequence (PRBS). Pattern
Lock enables the instrument to take samples at specific locations in a data stream to define the trigger.
1. Click in the Bit Pattern Length entry box and use the multipurpose knobs to define the bit length of a
pattern to search for.
2. Click in the Shift Amount entry box and use the multipurpose knobs to define the number of bits to
shift from the zero bit position of the initial lock.
3. Click the left or right arrows to increment from bit zero by the Shift Amount to redefine the pattern to
be used as the trigger.

Set up FastFrame operation
Follow these steps to use FastFrame mode:
1. Set up the Trigger control window to trigger on the signal of interest.
2. Adjust the horizontal and vertical controls to display a waveform without any clipping.
3. Adjust the Resolution controls to set the number of samples you want to acquire with each acquisition.
4. From the Horiz/Acq menu select FastFrame Setup.
5. Configure the number of frames (Frame Count) you want to capture.
6. Touch the FastFrame button to turn on the FastFrame mode.
7. After the acquisition is complete, select the frame that you want to view under the Frame Viewing
section.

916

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Set to 50% with Comm triggers

Set to 50% with Comm triggers
Push the front-panel Level knob.

Overview
The Set to 50% control sets the trigger threshold to 50% for some Comm triggers, and to a high of 75%
with a low of 25% for others.

Behavior
When either AMI or MLT-3 code is selected with Comm triggers the Set 50% control measures
peak-to-peak level and sets an upper threshold value at 75% and a lower threshold value at 25%. Other
codes work exactly the same as Edge, Width, Glitch, and Timeout triggers; the threshold is set to 50%.

Clock source channel
Use the Clock Source drop-down list to select the input channel that is connected to the clock signal.

Set the clock threshold level
To set the clock threshold voltage level:
1. Click in the Clock Level or Threshold entry box.
2. Use the multipurpose knob to set the voltage level.

Select the data source channel
Use the Source drop-down list to select the input channel that is connected to the data signal.

Set the data threshold level
To set the data threshold voltage level:
1. Click in the Data Level entry box.
2. Use the multipurpose knob to set the data voltage level.
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Set the setup and hold times
Use the Setup Time and the Hold Time controls to specify the setup and hold limits.
1. Click in a data entry box.
2. Use the multipurpose knobs to set the limits.

Enter a spectral math equation
From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

To use
Select a Math <1-4> waveform from the drop-down list.
Click in the readout field to enter the math expression.
Click a button to enter its character or operator into the expression.
Click the Editor (see page 263) button and use the Math Equation Editor controls to insert numerals,
math operators, and variables into a math expression.
Use the Text Edit Controls (see page 265) to move the insertion point (cursor) within the expression.

Behavior
These controls only affect the selected math waveform.
What do you want to do next?
Learn about the Equation Editor. (see page 263)

Enter a spectral math expression
From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window;
then open the Create/Edit tab.

To use
Use these controls to insert spectral analysis functions into the math expression.
1. Click one of the buttons to insert a function into the math expression.
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Magnitude (see page 269)
Phase (see page 290)
Real (see page 269)
Imaginary (see page 269)
Average (see page 919)
2. Use the Channels Selector (see page 264) to select one of the input channel waveforms to create
the Math waveform.
3. Click Avgs to open the Adjust Math Parameters (see page 247) control window. Use this window to
define the number of times you want to average the selected math waveform.

What do you want to do next?
Learn about the Math Setup controls. (see page 247)
Learn about setting up the instrument for spectral magnitude waveforms. (see page 923)

Average
Inserts the text AVG( into the math expression. Enter an argument to the function. The average
function produces the average of the argument.

Spectral tracking
From the Math menu, select Advanced Spectral; then open the Tracking tab.
Use these controls to lock two math waveforms together. This is useful when you want to generate both a
magnitude waveform and a phase waveform from the same source.
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When you lock the spectral controls together, any changes you make to one math waveform are also made
to the other math waveform.
You can only lock Math1 with Math2 and Math3 with Math4.
Locking is useful, for example, when Math1 is the spectral magnitude and Math2 is the spectral phase
of the same signal. Locking forces the magnitude and phase waveforms to track if you change the
spectral controls.
What do you want to do next?
Learn about the Math Setup controls. (see page 247)

Set up the spectral vertical axis
From the Math menu, select Advanced Spectral; then open the Vert Axis tab.

To use
Use these controls to specify the vertical scale for advanced spectral waveforms. The available selections
will vary depending on the settings you make in the Create/Edit tab.

Set the magnitude scale
Use these controls to specify the vertical scale for magnitude waveforms.
Click one of the Scale buttons to specify the vertical units as linear (V, A, W), dBm (1mW into
50 Ω), or dB (logarithmic).
Click in an entry box and use the multipurpose knobs to set the reference Level at the top of the screen.
Use the Level Offset control to position the waveform with respect to the 0 dB reference level without
changing the reference level at the top of the screen.
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NOTE. The reference level offset is used to calculate the log magnitude in dB. Adjusting the reference
level positions the waveform with respect to the top of the screen but does not change the position of the
waveform with respect to the ground reference marker.
Changing the reference level offset moves the waveform with respect to its ground reference marker.

Set the Phase Scale
Use these controls to specify the vertical scale for spectral phase waveforms.
Click one of the Scale buttons to specify the vertical units in degrees, radians, or as group delay.
Group delay unwraps and differentiates the phase. All phase values out of the spectral transformation
are between p and -p even though the actual phase value may be outside this range.
Click Unwrap to work on a continuous phase function to unwrap the phase value and show the true
range. The phase unwrap begins with a phase value obtained at the first spectral sample after DC.
Click in the suppression Threshold entry box and use the multipurpose to set the level. Suppression
prevents random noise from making the display unusable. Any spectral points with magnitudes less
than the threshold will have phase values set to zero (degrees or radians). To set a dB level for the
suppression threshold, select dB scale from the magnitude tab, and then set a horizontal bar cursor to
the level on the magnitude spectrum. Read the dB value from the cursor and use the multipurpose
knob to enter the value as the suppression threshold.
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Set the Linear Scale
Click in an entry box and use a multipurpose knob to specify the position and scale for a linear display.

What do you want to do next?
Learn about locking math waveforms together. (see page 919)
Learn about the Math Setup controls. (see page 247)
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Set the spectral vertical controls
From the Math menu, select Basic Spectral or click Basic in the Math Setup control window.

To use
Use these controls to specify the vertical scale for magnitude and phase waveforms.
Click either the Magnitude or Phase button.
Click one of the Vertical Control buttons to specify the vertical units.
Click in an entry box and use the multipurpose knobs to adjust the level, scale, position, or offset
on screen.
For Magnitude waveforms, use the Reference Level Offset control to position the waveform with
respect to the 0 dB reference level without changing the reference level at the top of the screen.

Behavior
The reference level offset is used to calculate the log magnitude in dB. Adjusting the reference level
positions the waveform with respect to the top of the screen but does not change the position of the
waveform with respect to the ground reference marker.
Changing the reference level offset moves the waveform with respect to its ground reference marker.
What do you want to do next?
Learn about setting up the instrument for spectral phase waveforms. (see page 920)
Learn about the Math Setup controls. (see page 247)
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SPI bus trigger polarity
The SS, MISO, and MOSI Active controls allow you to select when the enable is active.
Select (H) High or (L) Low from the drop-down menu.
The SCLK Active control provides compensation for inverted signals or synchronization on the falling
edge of the clock.
Select Rising or Falling from the drop-down menu.

SPI bus trigger threshold
1. Click in the SS Threshold or SCLK Threshold entry boxes.
2. Use the multipurpose knobs to set the threshold voltage levels for the trigger.

SPI data source
In the drop-down list box, specify the MISO and or MOSI data source.

Supported ADEs
TekVISA supports these Application Development Environments:
Microsoft C/C++
Microsoft Visual Basic
LabVIEW graphics software using the G language
MATLAB analysis software

TekProbe/TekVPI interfaces
These interfaces enable the instrument to sense information about the probe such as the serial number and
other unique identification information. It also allows the instrument to provide power directly to the probe.
With this information, the instrument can automatically set up its requirements to match the characteristics
of the probe, such as termination and attenuation.
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Set the timeout trigger criteria
Click Stays High to trigger the instrument when the pulse is high for the specified time.
Click Stays Low to trigger the instrument when the pulse is low for the specified time.
Click Either to trigger the instrument if the signal has not crossed the threshold value for the specified
time.

Set the Time-Out value
The time-out value determines when the instrument will trigger.
1. Click in the Timer entry box.
2. Use the multipurpose knob to set the time-out value.

Set the upper and lower threshold levels for transition time
Use the upper and lower threshold levels to measure the transition time as shown in the trigger graphic.
1. Click in the Upper Level entry box and use the multipurpose knob to set the voltage level.
2. Click in the Lower Level entry box and use the other multipurpose knob to set the voltage level.

Set the transition time trigger criteria
1. Click in the Time entry box and use the multipurpose knob to set the target transition time.
2. Click in the Transition entry box.
<. Triggers the instrument when the transition time is less than the specified time.
Greater Than. Triggers the instrument when the transition time is greater than the specified time.
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Trigger coupling
The trigger coupling determines what part of the signal is passed to the trigger circuitry. All trigger types
except edge triggering use DC coupling only. Edge triggering can use all available coupling choices.
DC. This coupling passes all input signals to the trigger circuitry.
AC. This coupling passes the input signals above 60 Hz to the trigger circuitry.
HF Reject. This coupling attenuates signals above 50 kHz before passing the signal to the trigger
circuitry.
LF Rej. This coupling attenuates signals below 80 kHz before passing the signal to the trigger circuitry.
Noise Rej. This coupling provides stable triggering by increasing the trigger hysteresis. Increased
hysteresis reduces the trigger sensitivity to noise but may require greater signal amplitude.

Set the glitch width criteria
These controls specify the action of the glitch width criteria. The trigger graphic displays the criteria
you have selected.
1. Click in the Width entry box and set the width with the multipurpose knob.
2. Use the Glitch Width drop-down list box to specify the action:
Less Than. Triggers the instrument only on glitches narrower than the specified width
Greater Than. Triggers the instrument only on pulses wider than the specified width.
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Trigger graticule
All graticule types are available for selection from the drop-down list. The IRE graticule is normally used
with the NTSC signals, and the mV graticule is normally used with all other video signals.

Trigger holdoff
After a trigger event, the instrument will not accept another trigger event until after the holdoff value is
exceeded. Holdoff is usually specified in units of time, but other units may be used.

Trigger Holdoff: Auto
When the Trigger Holdoff is set to Auto, the instrument automatically calculates the trigger holdoff time.
It is normally equal to five times the current Horizontal Scale setting.
After a trigger event, the instrument will not accept another trigger event until after the holdoff value is
exceeded. Holdoff is usually specified in units of time, but other units may be used.

Trigger Holdoff: Random
When Trigger Holdoff is set to Random, the instrument delays the trigger a random amount of time
between triggers. This means that successive acquisitions are unrelated to the previous trigger signal.

Trigger Holdoff: Time
After a trigger event, the instrument will not accept another trigger event until after the holdoff value is
exceeded. Holdoff is usually specified in units of time, but other units can be used.
When the Trigger Holdoff is set to Time, you can manually adjust the value with the multipurpose knob.
Use this option when the signal that you want to trigger on has several possible trigger points. Use the
Trigger Holdoff control to delay the trigger system for a specified amount of time between triggers so that
you can obtain a stable display.
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Set the trigger level
The trigger level determines the voltage level where the trigger point occurs.

To use
Adjust the trigger level with the front-panel Trigger Level knob.
Click in the Level entry box in a Trigger control window and use the multipurpose knob to adjust the
level.

Trigger menu
Use the Trigger menu to set up the instrument to trigger on live waveforms. Several different types of
triggering are available.

Select the Trigger On options
Select a value from the Trigger On drop-down list to specify where the trigger will occur on the video
signal. The Trigger On drop-down list contains the options Field, All Lines, and Line #.
If you select Field, use the drop-down list to select Odd, Even, or All.
If you select Line #, click in entry field and use the multipurpose knob to set the line number. Line
numbers wrap when their limits are reached. The range of line numbers depends on the chosen Format.
NOTE. If you select the NTSC format, use the multipurpose knob to first scroll through all of the odd
lines, and then the even lines.
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Select the bus Trigger On data
In the Trigger On drop-down menu, select the type of data to trigger on. The available selections are
different for each bus type.

Select the glitch trigger polarity
The Polarity buttons set the glitch polarity.
Click Pos to trigger on a positive-going pulse.
Click Neg to trigger on a negative-going pulse.
Click Either to trigger on positive or negative glitches.

Set the trigger qualification
You can qualify some trigger types by the logical state of other channels or by a bus pattern for
MSO70000C/DX Series instruments.
Click Occurs to trigger the instrument only when the defined trigger type occurs. No qualification
occurs.
Click Logic to trigger the instrument when the defined trigger type occurs and the logic input
conditions occur.
Click Occurs And to trigger the instrument when the defined trigger type occurs and the bus pattern
occurs on the selected bus.
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Set the Trigger Occurs And qualification
NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
For the supported instruments, use the controls to set up the Occurs And pattern for the instrument to
qualify the following triggers: Glitch, Runt, Setup/Hold, Timeout, Transition, Width, and Window.

What do you want to do next?
Learn how to set the voltage threshold level for channels used as digital waveforms. (see page 146)
Learn about bus setups. (see page 97)
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HF filtering
NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.
The high frequency filtering function is used when the signal of interest contains high frequency data that
you do not want to trigger on. With this option enabled, the trigger will ignore the high speed data or high
frequency carrier when looking for the glitch, pulse width, or timeout value events. These triggers work
the same way with or without the high frequency filtering option except the timer setting that has different
limits. The high frequency burst data is seen as a single pulse.

Set the trigger reset conditions
1. In Trigger Reset Type drop-down menu, select a condition for a trigger reset.
2. Use the drop-down menus to set up Time, Transition, State, Source, or Threshold conditions for the
specified reset.

Trigger settings (Shared - Independent)
This feature determines how the instrument applies trigger levels to the input channels:
Shared. Sets the trigger level in common across all input channels. Changing the trigger level of one
channel changes the trigger levels of all input channels to the same level.
Independent. Allows you to set a unique trigger level for each input channel. Changing the trigger
level on one channel does not affect the trigger level setting of the other input channels.

Trigger slope
The trigger slope determines whether the instrument finds the trigger point on the rising edge, falling edge,
or both edges of the signal.

Trigger source
The trigger source determines the source of the trigger signal. The input channels are the most commonly
used trigger sources and are available for all trigger types.
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Trigger source

NOTE. You have the option to add user-defined label for analog, reference, bus, and digital sources.

To trigger on an input channel, select a channel.

If your instrument has digital channels, trigger on a digital channel by selecting a digital channel.

If your instrument has digital channels and, in the Vertical menu you selected an iCapture signal, trigger on a the
iCapture channel by selecting the channel.
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Trigger summary
In the upper-right corner of the setup window, the trigger summary provides a one-line summary of the
trigger setups. Use this summary to get an overview of the trigger setups without having to look through
all of the trigger tabs.

Trigger T marker

Window event trigger
To qualify the trigger for Window triggering, select from these drop-down list selections:
Enter Window. Triggers the instrument when the signal enters the window as defined by the
threshold levels.
Exit Window. Triggers the instrument when the signal leaves the window as defined by the threshold
levels.
Inside > t. Triggers the instrument when the signal leaves the window, defined by the threshold levels,
after remaining inside the window longer than the time specified by Width:
Click POS to trigger on waveforms with a positive polarity exiting the window.
Click NEG to trigger on waveforms with a negative polarity exiting the window.
Click EITHER to trigger on either polarity.
Outside > t. Triggers the instrument when the signal reenters the window, defined by the threshold
levels, after remaining outside the window longer than the time specified by Width.
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Set the trigger width limits
To trigger on a pulse width outside a range of limits:
1. Select Outside from the Pulse Width drop-down list.
2. Set the Upper Limit and Lower Limit with the multipurpose knobs.
To trigger on a pulse width within a range of limits:
1. Select Inside from the Trig When drop-down list and
2. Set Upper Limit and Lower Limit with the multipurpose knobs or pop-up keypad.

Set the trigger polarity
The polarity buttons define the polarity of the pulse width.
Click Pos to trigger on a positive-going pulse.
Click Neg to trigger on a negative-going pulse.
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Using FastFrame acquisitions
Consider the following operating characteristics when using FastFrame :
You can push Run/Stop to terminate a FastFrame sequence. If any frames were acquired, they are
displayed. If no frames were acquired, the previous FastFrame waveform is displayed.
Because FastFrame introduces additional processing time into the operation cycle of acquire, process,
and display, it is best to use Single Sequence Acquisition (see Acquire menu, Stop After menu). With
Single Sequence selected, you will see the current acquisition sequence; otherwise, the display lags the
current sequence by one sequence. You can also see the current sequence by pushing the Run/Stop
button to stop the acquisition.
FastFrame greatly reduces the minimum trigger holdoff time, enabling you to acquire and store
records at rates of up to 225,000 captures per second (until the number of frames requested has
been acquired). FastAcq mode also provides exceptionally fast acquisition rates. Both modes have
advantages. FastFrame preserves the actual data associated with each trigger event for further analysis
or visual inspection, but only acquires at the fast rate for short bursts of time. FastAcq mode combines
the data from all trigger events into a single pixel map, but can acquire at exceptionally fast rates
continuously, not just for short bursts.
In single sequence acquisition mode, statistics are calculated using all frames in the current acquisition
except for Average and Envelope frames. If the currently selected frame is the Average or Envelope
Frame, measurements are taken on the frame but statistics are still based on all frames excluding the
Average and Envelope frames. Statistics reset with each new single sequence acquisition.
On a reference waveform, statistics are derived from all frames in that reference waveform when
FastFrame is on. If FastFrame is off, the statistics reflect only the first frame that is displayed.
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Use Print Screen
If you have an attached keyboard you can use the Print Screen (Prt Sc) key to copy the screen contents to
the Windows clipboard. This bitmap does not include the waveforms or graticule. The waveforms and
graticule are displayed by the graphics adapter outside of normal Windows mechanisms.

To use
To capture the instrument screen with its graticule and waveforms, use the Edit menu Copy command after
selecting Image in the Copy Setup menu, or to build a bitmap file, select the File menu Save As command.
Click Options under Screen Capture, and then select Full Screen under View. For additional information,
see Save As Dialog Box: Screen Captures. (see page 538)
You can display the current date and time on screen so that they appear on hard copies you print. To do
this, toggle the Display Date/Time button On from the Display Setup control window Objects tab. If you
need to reset the date and time for any reason, right-click the date and time and then select Set Date/Time.

Behavior
Pressing the Print Screen key on an attached keyboard copies the screen image minus the waveform and
graticule to the Windows clipboard. Using the Edit menu Copy command copies the screen image with
the waveform and graticule.

Analyze menu
The Analyze menu provides access to search and place marks on acquired waveforms. It also provides
access to tools for DDR analysis and other applications that are installed on your instrument.

Utilities menu
The Utilities menu provides access to utilities used by the instrument such as instrument calibration,
instrument diagnostics, and user preferences. All utilities are accessible from the menu bar only. None of
the utilities are directly accessible from the front panel controls or from the toolbar.

Vertical menu
Use the Vertical menu options to set vertical parameters for waveforms. This menu also provides access to
the Zoom controls and the probe compensation, deskew, and attenuation functions.
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Set the vertical position
From the Vertical menu, select Position/Scale.

Overview
Use the Position control to set the vertical position of the selected waveform.

To use
Click in the Position entry box to map it to one of the multipurpose knobs; then use the knob to
move the waveform.
You can also use the up-down arrows to change the value.

Behavior
The Position control moves the vertical position of the waveform 0.2 divisions (0.02 divisions with
FINE control). Increasing the position value moves the waveform up, and decreasing the position value
moves the waveform down.
The Position control differs from the Offset control; for information on the Offset control for channel
waveforms refer to the Vertical Offset Control Window (see page 491).
TIP. Several alternatives are available for adjusting the position of a waveform:
Use the dedicated knob on the front panel for the selected waveform.
Enter a value with the on-screen pop-up keypad.
Use an attached keyboard to type a value directly into the position field.
What do you want to do next?
Learn more about offsetting channel waveforms. (see page 491)
Learn more about the Vertical controls. (see page 491)
Learn more about the Waveform controls. (see page 491)
Learn more about the Vertical Scale controls. (see page 938)
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Set the vertical scale
From the Vertical menu, select Position/Scale.

Overview
Use the Scale control to set the vertical scale value of the selected waveform.

To use
Click in the Scale entry box to map it to one of the multipurpose knobs; then use the knob to move the
waveform.
You can also use the up-down arrows to change the value.

Behavior
Each waveform has its own vertical scale parameter. For a signal with constant amplitude, increasing the
scale causes the waveform to appear smaller. Decreasing the scale causes the waveform to appear larger.
The scale affects all waveforms, but affects channel waveforms differently:
For channel waveforms, the scale setting controls the vertical size of the acquisition window (see
page 62) as well as the display scale. The range and resolution of the scale value depends on the
attached probes and any other external factors you may have specified.
For reference or math waveforms, the scale setting controls the display only. Scaling these waveforms
has no affect on the acquisition hardware.
Use the dedicated knob on the front panel for the selected waveform.
Enter a value with the on-screen pop-up keypad.
Use an attached keyboard to type a value directly into the position field.
What do you want to do next?
Learn more about the Vertical controls. (see page 491)
Learn more about the Waveform controls. (see page 491)
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Select the bandwidth
From the Vertical menu, select Vertical Setup.

Overview
Use the following controls (similar to the example shown below) to set the bandwidth and filter unwanted
high-frequency noise from the waveform. You can also use the Bandwidth Enhancement Controls (see
page 498) to normalize the bandwidths between selected channels.

To use
Click the appropriate option buttons and use the drop-down list box to specify the bandwidth you want to
acquire. The available selections and controls will vary depending on the instrument model and probe you
are using.

Behavior
Bandwidth refers to the range of frequencies the instrument can acquire and display accurately with less
than 3 dB attenuation. Each input channel has its own bandwidth selection.
To take accurate measurements, the input frequency should be much less than the rated bandwidth of the
instrument. A good rule to follow is to ensure the bandwidth of the instrument system is three to five times
the bandwidth of the signal that you want to measure.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 959)
Return to the Vertical Setup control window overview. (see page 485)
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Bus pattern condition
For the supported instruments, use the control to select how many occurrences of the pattern to detect
before the instrument triggers.

Bus selection
For the supported instruments, use the control to select the Bus on which to trigger from the list of bus
setups.

Bus time condition
For the supported instruments, click the Time entry box and enter a value with the keypad or use the
multipurpose knobs to select a value.

Trigger logic state condition
For various trigger types, in the Trigger if Logic State drop-down list, select True to trigger the instrument
when the logic patterns are true. Select False to trigger the instrument when the logic patterns are false.

Set the parallel bus pattern
For the supported instruments, use the controls to set up the Parallel Bus parameters. Click the Edit button
to access the Pattern Editor dialog box.
For information on the Pattern Editor dialog box, click the buttons.
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Bus Pattern Editor (Bus tab)
When you select a parallel bus and click the Edit button, use the Pattern Editor controls to set up the bus
trigger pattern for the instrument to use to detect a specific parallel bus value.

When you select a serial bus and click the Edit button, use the Pattern Editor controls to set up the bus
trigger pattern for a serial bus value. For example, the Data (SPI bus), or the Address, Data, or Address
and Data (I2C bus) bus values.
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What do you want to do next?
Learn how to set the voltage threshold level for logic waveforms and to define a pattern. (see page 947)
Learn about bus setups. (see page 97)

Bus Pattern Editor (Bus tab)
Use the Pattern Editor controls to set up the bus trigger pattern for the instrument as follows:

942

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Oscilloscope Reference

Bus Pattern Editor (Bus tab)

For parallel bus
Select the parallel bus and click Edit button.
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Select a bus and click Edit button.

For serial bus
Select a bus SPI (with Trigger On set to Data ), RS232 (with Trigger On set to Data), I2C (with Trigger On
set to Data), or USB (with Trigger On set to Special Packet, Special Type set to SPLIT 1000, and select Hub
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Address or Port Address) and click Edit button. The Bus field would display the text depending on the type
of bus selected (address, data, hub, or port). For example for data bus (B1), the field would display B1Data.

Select a bus I2C (with Trigger On set to Address or Addr+Data) or USB (with Trigger On set to Token
Address Packet or Data Packet) and click the Edit button. The Bus field would display the text depending
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on the type of bus selected (address, data, hub, or port). For example for data bus (B1), the field would
display B1Data.

What do you want to do next?
Learn how to set the voltage threshold level for logic waveforms and to define a pattern. (see page 947)
Learn about bus setups. (see page 97)
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Bus Pattern Editor (Logic tab on MSO Series)
Use the controls to set the bus trigger pattern of the channels the instrument uses as logic waveforms to
detect a parallel or serial bus value. Click a channel button to select the value for that channel: 0, 1, or X.
For convenience, you can also change the voltage reference level threshold values.

What do you want to do next?
Learn how to define a pattern for a bus. (see page 942)
Learn about bus setups. (see page 97)
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Bus Pattern Editor (Live tab)
Use the controls to set the bus trigger pattern of the channels the instrument uses as logic waveforms to
detect a parallel or serial bus value. Click a channel button to select the value for that channel: 0, 1, or X.
For convenience, you can also change the voltage reference level threshold values.

What do you want to do next?
Learn how to define a pattern for a bus. (see page 942)
Learn about bus setups. (see page 97)
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Bus pattern format
For MSO70000C/DX Series instruments, from the Trigger menu, select the Bus trigger type. You can
change the format of the bus pattern after you define a pattern.

Hex causes the instrument to display the bus pattern as a hexadecimal value.
Binary causes the instrument to display the bus pattern as a binary value.
Decimal causes the instrument to display the bus pattern as a decimal value.

Bus Trigger On selections
For MSO Series instruments, select the type of data to trigger on. The available selections in the Trigger
On drop-down list are different for each serial bus.

Set logic thresholds
NOTE. This online help file supports many oscilloscope models from Tektronix. This feature is only
available on some models.
For the supported instruments, from the Trigger menu or from the Search and Mark menu, select the Bus,
the Logic Pattern, or the Logic State trigger. Click the Logic Thresholds button to access the Threshold
Setup dialog box.
Use the controls to set up the Threshold Setup parameters for a Pattern or a State trigger.
NOTE. When you select a Pattern or a State trigger as the B Event, digital channels are not available.
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The instrument displays a different Threshold Setup dialog box for each type of bus defined: parallel or
serial types.
This is an example of the Threshold Setup dialog box when you select a parallel bus in the Bus list of
the Trigger menu.
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Set logic thresholds

This is an example of the Threshold Setup dialog box for a 4-bit parallel bus.

This is an example of the Threshold Setup dialog box for an I2C serial bus.
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This is an example of the Threshold Setup dialog box for an SPI serial bus.

This is an example of the Threshold Setup dialog box for an RS232 serial bus.
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This is an example of the Threshold Setup dialog box for an USB serial bus.

What do you want to do next?
Learn about the Global Threshold field. (see page 95)
Learn about bus setups. (see page 97)
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Select the coupling
From the Vertical menu, select Vertical Setup.

Overview
Use the Coupling controls to couple the signal from the attached probe to the instrument.
Available controls depend on the instrument model, selected termination, and attached probe. Some
example control groups are shown.

xxx

To use
Select DC to display waveforms with AC and DC components.
Select AC to display waveforms with AC components.
Select GND to display a zero-volt waveform. Use this selection to establish the ground reference
point on the display.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 939)
Return to the Vertical Setup control window overview. (see page 485)

Set display characteristics
From the Vertical menu, select Vertical Setup.

To use
1. Click Display to turn the channel waveform display on and off.
2. Assign a label to the waveform (see page 491) with the pop-up keyboard to make it easier to identify
on the screen.
3. Set the units of vertical scale in the Units text box.
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Behavior
The tab selector on the side of the Vertical Setup control window identifies the channel waveform source.
The Display button, the label, and units apply only to the selected waveform.
Each waveform (channel, math, or reference) has its own Display button, label, and units. If you do not
enter a label for the selected waveform, the label will be left blank. You can position the label anywhere
on the graticule by clicking and dragging it to the desired location.
Any displayed channel waveform can be turned off without impacting any math functions, measurements,
or histograms done on that waveform. You may want to turn some waveform displays off to make the
remaining waveforms easier to view and analyze.
TIP. Use the dedicated front-panel Ch <1 - 4> buttons to turn the channel waveforms on or off.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 956)

Set the offset
From the Vertical menu, select Vertical Setup.

To use
Use the Offset controls to set the value of the selected Channel vertical offset. This shifts the vertical
acquisition window (see page 62) to match the waveform data you want to acquire.
1. Click a channel tab to select the vertical input channel.
2. Click in the Offset entry box and use a multipurpose knob to set the offset value.
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Behavior
Use the Offset control to eliminate clipping the waveform (see page 493). The offset control affects
the vertical acquisition window by subtracting a DC bias from the waveform. This moves the level at
the vertical center of the acquisition window of the selected channel. Visualize offset as scrolling the
acquisition window toward the top of a large signal for increased offset values and scrolling toward
the bottom for decreased offset values.
The offset control affects the waveform display by defining the channel reference indicator to match the
offset rather than the ground level. The offset affects only channel waveforms as compared to the position
control that affects all waveforms, including math and reference waveforms.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 959)

Set the vertical position/scale
From the Vertical menu, select Vertical Setup.

To use
Use the Position control to set the vertical position of the waveform and the Scale control to set the
vertical scale.
3. Click a Chan <1–4> tab to select the waveform on screen.
4. Click in the Position entry box and use the multipurpose knobs to adjust the position of the waveform.
5. Click in the Scale entry box and use the multipurpose knobs to adjust the vertical sensitivity.
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TIP. You can also use the dedicated Position and Scale knobs on the front panel to control the position and
scale of the selected waveform.

Behavior
Each waveform has its own vertical Position control. The control increases or decreases the vertical
position of the waveform 0.2 divisions (0.02 divisions using the Fine knob (see page 958)). Increasing
the position value of the waveform moves the waveform up, and decreasing the position moves the
waveform down.
Each waveform also has its own vertical Scale control. For a signal with a constant amplitude, increasing
the scale causes the waveform to appear smaller. Decreasing the scale causes the waveform to appear larger.
For channel waveforms, the scale setting controls the vertical size of the acquisition window (see page 62)
as well as the display scale. The range and resolution of the scale value depends on the attached probes and
any other external factors that you may have specified.
NOTE. The vertical system bandwidth (BW) readout (see page 958) will display the probe tip bandwidth
if the tip is limiting the bandwidth of the selected channel. See User Interface Map (see page 37) for
the location of the readouts.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 955)
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Multipurpose knobs
The multipurpose knobs can be used to set screen interface parameters. To use, click a control on the
screen to map it to the multipurpose knob(s).

On MSO/DPO5000B
Series instruments

You can undo any mapping by right-clicking the multipurpose knob(s) and selecting
Deassign Multipurpose Knobs, or from the Utilities menu, select the Deassign Multipurpose
Knobs command. The mapping is deassigned until your perform that function again.
Turn the knob(s) or scroll with the mouse wheel until the desired selection appears in the
readout mapped to the knob. Push the FINE button, or click the mouse wheel to use
the knob to make small changes, for example, to add another decimal place for greater
accuracy.
When no control windows are open and cursors are turned on, the multipurpose knobs
control the cursor positions.

xxx

NOTE. These knobs are automatically mapped when certain functions are performed, for example,
when the MultiView Zoom button is pushed.

Bandwidth readout (BW)

Nominal system bandwidth consists of a combination of factors including, but not limited to, probe
bandwidth, probe tip bandwidth, and bandwidth selections made in the Vertical Setup Control
Window.
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Select the probe controls
From the Vertical menu, select Vertical Setup.

Overview
The Probe controls provide access to the Probe Setup, Compensation, Deskew, and Attenuation control
windows.

To use
Click the Probe buttons to display the Probe Setup control windows:
Use Setup (see page 504) to configure the attached probe type. The setup will vary depending on the
individual probe you connect.
Use Cal (see page 506) to check the status of the attached probe and to compensate the entire signal
path from the probe tip to the digitized signal.
Use Deskew (see page 510) to compensate the vertical channels for propagation delays of different
length probes.
Use Atten (see page 511) to change the default attenuation or gain for the selected probe channel.
What do you want to do next?
Learn more about the Attenuation controls. (see page 511)
Learn more about the Deskew controls. (see page 510)
Learn more about the Probe Compensation controls. (see page 502)
Return to the Vertical Setup control window overview. (see page 485)

Select the termination
From the Vertical menu, select Vertical Setup.
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To use
Use the Termination controls to select the channel input resistance:
For DPO7000C and MSO/DPO5000B oscilloscopes:
Select 1 MΩ for use with high impedance passive probes (see page 495).
Select 50 Ω for use with most active probes (see page 495) and low impedance (Zo) probes (see
page 961).
NOTE. Termination is automatically set for TPP0500 and TPP1000 Series probes on the MSO/DPO5000B
Series instruments.

For MSO/DPO70000C/DX oscilloscopes, Termination is fixed at 50 Ω.

Behavior
The correct termination is set automatically when you attach a probe with a TekProbe/TekVPI interface
(see page 495) to the instrument. However, you may have to set the termination manually if you use
a probe without a TekProbe Interface.
Consider the following when using 50 Ω termination with any channel:
AC coupling is not available with 50 Ω termination.
The instrument reduces the maximum vertical scale setting for the channel with a X10 probe attached,
since the amplitudes appropriate for the higher settings would overload the 50 Ω input.
The instrument switches to 50 Ω and disables AC coupling (and switches coupling to DC if AC is
selected) if you connect an active probe. The active probes also reduce the maximum vertical scale
setting as described above. This behavior results in 50 Ω, nonalternating current coupling, which is
appropriate for active probes.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 954)
Return to the Vertical Setup control window overview. (see page 485)
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Set the termination voltage

Low impedance probes
Most low impedance (Zo) passive probes measure frequencies or timing measurements more
accurately than general-purpose probes, but they take less accurate amplitude measurements. They
offer a higher bandwidth to cost ratio.
The low input impedance passive probes must be terminated in a 50 Ω instrument input. Input
capacitance is much lower than high impedance passive probes, typically 1 pF, but input resistance is
also lower (500 Ω to 5000 Ω typically). Although that DC loading degrades amplitude accuracy, the
lower input capacitance reduces high frequency loading to the circuit under test. That makes low
input impedance passive probes ideal for timing and phase measurements when amplitude accuracy is
not a major concern. Low input passive impedance probes are useful for measurements up to 40 V.

Set the termination voltage
Termination Voltage is available only on MSO/DPO70000DX Series instruments.
From the Vertical menu, select Vertical Setup.

To use
Use the Termination Voltage control to set the channel termination voltage:
Click Termination Voltage.
Set the termination voltage using the keypad or multipurpose knobs.

Behavior
Oscilloscope inputs have traditionally been terminated to ground. The signals being measured often are
not ground referenced. Pulling signals to ground can impair measurement results or potentially damage the
DUT.
The instrument delivers variable termination voltage up to ±3.5 Volts to the device under test (DUT), and
supports a large offset range.
This allows you to adjust the oscilloscope to mirror the conditions and behavior of the DUT, and measure
high-speed signals in an environment similar to the one in which they operate.
Using the combination of termination voltage and offset to center the oscilloscope reference point in the
operating range of the DUT maximizes the available dynamic range and minimizes the noise of the
measurement system.
What do you want to do next?
Continue to learn about the Vertical Setup controls. (see page 954)
Return to the Vertical Setup control window overview. (see page 485)
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Video trigger autoset

Video trigger autoset
Autoset automatically sets the video trigger controls for the selected format and optimizes the vertical
sensitivity and time per division for viewing video lines and fields. These controls do not appear if you
select the Custom format.
Click Lines or Fields to optimize the settings.

Select the video trigger format
Select one of the predefined video signal formats from the drop-down list:
525i/NTSC
625i/PAL
SECAM
Bilevel
Trilevel
1080i/60
1080i/50
480p/60
576p/50
720p/30
720p/50
720p/60
875i/60
1080/24sF
1080p/24
1080p/25
1080p/30
1080p/50
1080p/60
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Specify the video trigger holdoff

Specify the video trigger holdoff
1. Click in the Holdoff field.
2. Specify Holdoff By Time or By Fields.
3. Use the multipurpose knob to change the value.
If you are setting a Custom format, only the By Time control is available.

Select the video trigger polarity
Select either Normal or Inverted polarity.
Normal. This polarity generally triggers on the negative polarity, since the sync pulse leading edge is
negative for most standard formats.
Inverted. Use this polarity when probing circuitry that inverts the video signal.

VXI 11.2 LAN server
The VXI 11.2 LAN Server provides software connectivity between your instrument and remote PCs over
an Ethernet LAN. This tool is a client-side component built-in with TekVISA on each remote PC, you
must install another copy of TekVISA to make use of its client-side component.
The VXI-11 standard specifies a protocol for communication with devices over a network via a network
instrument server. This protocol uses the ONC/RPC (Open Network Computing/Remote Procedure
Call) standard that, in turn, is based on TCP/IP.
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VXI Plug-and-Play instrument driver

VXI Plug-and-Play instrument driver
The VXIplug&play instrument driver is a collection of software components, organized according
to the standard VXIplug&play model established by the VXIplug&play Systems Alliance. Use this
VXIplug&play instrument driver to simplify programming tasks when using the following software
development environments:
LabWindows/CVI
LabVIEW
MATLAB
Visual C++ 6.0
Visual Basic 6.0
HP-VEE
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Working with your oscilloscope
The following topics describe features of your Tektronix oscilloscope. Even if you are an experienced
user, you may want to browse through these topics to learn new ways of doing familiar tasks.

Basic operations
Using the Instrument Interface (see page 32)
Changing Control Settings (see page 39)
Moving and Docking Control Windows (see page 43)
Controlling from within the Graticule Area (see page 44)
Initializing the Instrument (see page 46)
Choosing and Connecting Probes (see page 47)
Creating your Own Control Windows (see page 46)

Waveform operations
Using Time Bases and Triggering (see page 47)
Looking at Waveform Details (see page 48)
Using Fast Acquisition and DPO (see page 50)
Using Logic Waveforms MSO Series (see page 52)
Using Waveform Math (see page 53)
Using Spectral Analysis (see page 53)
Characterizing a Signal (see page 54)
Adding Application-Specific Measurements (see page 55)

Windows environment
Connecting to a Network (see page 26)
Printing a Hard Copy (see page 31)
Using Other PC Applications (see page 31)
Using a Second Monitor (see page 32)
Connecting to Other Instruments (see page 32)
Access Shortcut Menus with Right-click (see page 45)
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Set the window trigger levels

Set the window trigger levels
The upper and lower threshold levels define the voltage limits of the window.
To adjust the upper threshold level:
1. Click the Upper Level entry box.
2. Use the multipurpose knob to set the voltage level.
To adjust the lower threshold level:
1. Click the Lower Level entry box.
2. Use the other multipurpose knob to set the voltage level.
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Symbols and Numbers
3 dB BW in bins, 775
8B10B bus
setting up, 589
8B10B serial bus
trigger, 323
8B10B Serial Bus
search for any character, 324
search for character
symbol, 324
search for data, 323
search for error, 324
search for pattern, 324
Trigger on Any Control
Character, 402
Trigger on Character/Symbol, 402
Trigger on Error, 414
Trigger on Pattern, 417

A
A event trigger types, 394
AC line voltage, 698
Accessories, 6
ACos, 793
Acquire data, 682
Acquire samples, 680
Acquired waveform, 685
Acquisition, 838
channels, 681
control window, 198
dead time, 807
hardware, 691
Incompatible features, 690
Interval, 793
modes, 838
preview, 724
run/stop button, 66
setting modes, 579
setup control window, 185
single button, 66
starting and stopping, 66
status lights, 66

system, 679
window, 793
Active probes, 47
Add sources
parallel bus, 145
Adjust, 677
Advanced trigger button, 63
Aliasing, 262
recognizing, 784
Amplitude measurements, 276
Analog, 32
oscilloscopes, 669
signal, 185
simulating, 669
Analog channel, 578
Analog signal
digital threshold, 811
logic threshold, 811
setting up, 578
Analysis tools, 21
Annotation, 563
Anomalies and bus analysis, 594
Application software
packages, 55
Applications, 17
Arbitrary filters, math, 859
ASin, 795
ATan, 795
Attenuation, 959
Audio port, 68
Auto trigger mode, 795
Auto-increment file name, 633
Autofit, 221
masks, 223
Automatic measurements, 606
Autoscroll, 877
Autoset, 187
autoset considerations, 691
button, 67
horizontal mask controls, 855
input conditioning, 682
mask alignment controls, 223
mask autoset mode, 856

mask configuration
control, 220
undo, 189
vertical mask controls, 858
Autoset preferences, 189
AUX OUT connector, 32
AUX TRIG OUT, 68
Auxiliary input connector, 32
Auxiliary trigger, 698
Averaging, 680
acquisition mode, 838
math waveforms, 616

B
B event trigger, 466
Bandwidth, 939
control window, 498
enhancement, 683
readout, 958
Bit order
parallel bus, 148
Blackman-Harris window, 780
defined, 780
Browse to a bus, 160
Bus
8B10B serial trigger, 323
analyzing anomalies, 594
CAN serial trigger, 415
configuring, 594
custom serial trigger, 377
DDR serial trigger, 375
Ethernet serial trigger, 369
FLEXRAY serial trigger, 418
I2C serial trigger, 403
LIN serial trigger, 416
MIL-1553 serial trigger, 366
MIL-STD-1553 serial
trigger, 420
MIPI serial trigger, 345
parallel trigger, 399
PCIe serial trigger, 413
RS-232 serial trigger, 406
setting up, 584

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

967

Index
SPI serial trigger, 354
trigger, 378
troubleshooting, 599
USB serial trigger, 336
Bus channels
threshold level setup, 146
Bus clear, 101
Bus decode method, 156
Bus display, 101
Bus display components, 154
Bus display views, 154
Bus layers, 154
Bus list, 98
Bus location, 160
Bus menu options
8B10B serial bus setup, 113
bus display, 101
bus label, 101
bus list, 98
bus position, 103
CAN serial bus setup, 117
clear bus, 101
configure, 151
custom serial bus setup, 119
decode method for parallel
buses, 156
decode method for serial, 157
display bus components for
parallel buses, 154
Ethernet serial bus setup, 123
I2C serial bus setup, 103
MIL-1553 serial bus
setup, 122
MIL-STD-1553 serial bus
setup, 122
MIPI CSI-2 serial bus
setup, 111
number of lanes, 125
parallel bus and clock
polarity, 151
parallel bus and clock
source, 150
parallel bus and remove a
channel, 149
parallel bus bit order, 148
parallel bus setup, 144
parallel bus source, 145
parallel bus thresholds, 146

968

PCIe serial bus setup, 116
RS-232 serial bus bit rate, 138
RS-232 serial bus data
bits, 136
RS-232 serial bus
direction, 135
RS-232 serial bus parity, 137
RS-232 serial bus setup, 106
serial bus channel input, 127
serial bus channel
threshold, 133
serial bus channel type, 126
serial bus data rate, 130
serial bus input, 131
serial bus signal type, 129
serial bus speed, 128
serial bus threshold high, 132
setup, 97
SPI serial bus direction, 134
SPI serial bus framing, 139
SPI serial bus idle time, 140
SPI serial bus setup, 105
SPI serial bus word size, 141
symbol table for parallel
buses, 157
USB serial bus setup, 108
Bus pattern editor
bus tab, 941
live tab to set thresholds, 948
logic tab to set thresholds, 947
Bus pattern editor
(DPO/MSO5000B Series)
bus tab, 942
Bus position, 103
Bus symbol file
format, 158
Bus symbol table, 157
Bus trigger
defined, 707
Bus triggering, 662

C
Calibration, 959
probe, 959
CAN bus, 428
bit rate, 796
CAN Serial Bus
Trigger on Pattern, 420

Capturing the screen, 522
CD-RW, 68
Center frequency, 797
control, 767
Changing cursor positions, 84
Channel display size
digital inputs, 94
Channel position
digital inputs, 92
Channel selector, 476
Channel threshold
digital inputs, 91
Channel waveform
digital threshold, 811
logic threshold, 811
Checking trigger status, 639
Clear bus, 101
Clear data control, 798
Clipping, 685
Clipping waveforms, 955
Clock polarity
parallel bus, 151
Clock source
parallel bus, 150
Coefficients, 775
Coherent gain, 775
Color palette, 721
black and white, 517
color, 517
custom, 805
gray scale, 517
gray-scale, 538
monochrome gray, 179
monochrome green, 179
normal, 179
spectral, 179
temperature, 179
COM 1 and COM 2 ports, 68
Comm trigger control
window, 429
Comm trigger pulse form, 802
Comm triggering, 708
Communication mask
triggering, 661
Communication trigger, 707
defined, 707
Communication trigger codes and
standards option, 799
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Comparing data, 638
Compensate
probe, 506
Compensation, 577
instrument, 552
probe, 515
signal path, 575
Components for display of parallel
buses, 154
Configure e-mail, 820
Configure mask, 219
Connect, 681
signal, 681
Connecting probes, 47
Connecting to a system under test
logic probe, 90
Connection, 681
signal and probes, 681
Connectivity tools, 21
Connectors, 32
Audio port, 68
AUX TRIG OUT, 68
CH3 OUT, 68
COM 1, 68
COM 2, 68
DVI-I, 68
EXT REF, 68
front panel, 57
GPIB, 68
LAN, 68
parallel port, 68
PS-2 keyboard, 68
rear panel, 32
REF OUT, 68
serial port, 68
side panel, 68
signal out, 68
USB, 68
video port, 68
Conpensate
probe, 502
Continuous mask testing, 234
Control, 763
frequency domain, 763
gating, 763
time domain, 763
Control window handle, 43

Control windows, 215
acquisition mode, 198
adjust parameters, 247
advanced math setup, 247
attenuation, 511
autoset undo, 189
AUX OUT configuration, 550
bandwidth, 498
bus configuration, 151
bus setup, 97
copy setup: images, 517
copy setup: measurements, 520
copy setup: waveforms, 518
coupling, 496
cursor position, 79
cursor setup, 73
cursor type setup, 75
deskew, 510
deskew/attenuation, 497
digital channels setup, 96
digital setup, 89
display on-off, 489
display setup, 167
docking, 43
edge trigger, 431
equation editor, 263
gating, 295
glitch trigger, 431
GPIB configuration, 548
histogram, 298
horizontal & acquisition
setup, 183
horizontal position/scale, 184
instrument compensation, 552
instrument diagnostics, 553
label, 491
logic pattern trigger, 435
logic state trigger, 444
mark, 305
mask setup, 215
measurement setup, 274
measurement statistics, 291
moving, 43
page setup dialog box, 523
position-scale, 490
probe compensation, 502

qualification expression
editor, 475
recall instrument setup, 529
recall visual trigger setup, 481
reference levels, 292
reference waveform, 527
resolution, 198
run/stop, 192
runt trigger, 435
save instrument setup, 535
search and mark, 318
setup and hold trigger, 439
spectral setup, 252
termination, 893
text properties, 170
timeout trigger, 444
transition time trigger, 446
trigger mode, 397
trigger mode & holdoff, 482
trigger setup, 393
user preferences: keypad
defaults, 560
user preferences: prompt
before action, 559
vertical acquisition, 685
vertical offset, 491
vertical setup, 485
video trigger, 448
waveform display, 489
waveform label, 491
width trigger, 449
window trigger, 451
zoom, 202
Controls
search and mark, 318
Copy Event Table, 383
Copy setup control window, 517
images, 517
measurements, 520
waveforms, 518
copying, 522
images, 31
measurements, 520
screen, 31
waveforms, 518
Copying waveform data, 791
Cos, 804
Cosh, 804
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Coupling, 684
control window, 496
controls, 954
Creating, 602
create math waveforms, 616
custom control windows, 46
math waveforms, 747
spectral Waveforms, 626
user masks, 622
CSV Text Format, 887
Cursor, 84
button, 67
function, 746
horizontal, 746
limitations, 84
measurements, 84
modes, 84
paired, 75
position control window, 79
XY display, 878
readouts, 80
screen, 83
setup control window, 73
split, 75
type control window, 746
units, 79
vertical, 75
waveform, 82
Cursor measurements, 750
sources, 76
styles, 77
units, 84
XY Display Format, 87
Cursor Sources
XY display, 804
YT display, 76
Cursors menu options, 804
controls, 75
mode, 84
on/off button, 73
position, 79
setup, 73
type, 75
Custom bus
setting up, 591
Custom control window, 46
editing, 602
Custom controls, 891
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Custom serial bus
trigger, 377
Customer feedback, 21
Customer support, 18
Customize color, 670
Customizing color palettes, 805

D
D15-D0 digital channels setup, 96
D15-D0 tab
probe setup, 505
Date, 547
dB, 769
dBm, 769
DC offset, 754
DDR serial bus
trigger, 375
Dead time, 191
Deassign multipurpose
knobs, 559
Decode bus values as
symbols, 157
Decode method for parallel
buses, 156
symbol file format, 158
Default settings for
histograms, 666
Default setup button, 67
Defining a spectral math
waveform, 627
Delay button, 841
Delay measurement, 888
setup, 888
Delay mode, 185
Delayed trigger, 706
Delete, 531
setups, 531
waveforms, 531
Deskew, 191
control window, 510
interaction with fast
acquisition, 191
procedure, 959
Diagnostics, 553
Digital channel, 95
setting up, 583
Digital channel D7-D0
turn off, 93

Digital channel display size, 94
Digital channel position, 92
Digital channel threshold, 91
Digital channels D7-D0
turn on, 93
Digital channels setup tabs, 96
Digital Menu, 812
Digital menu options
channel position, 91
channel threshold, 91
digital channels setup tabs, 96
display size, 94
global threshold, 95
setup, 89
Digital oscilloscopes, 50
Digital probe See logic probe
Digital signal
setting up, 583
Digital signal acquisition
system, 679
Digital signals
analog characteristics, 583
connecting a logic probe, 90
Digital threshold setup, 811
Digital waveform
setting up, 583
Digital waveforms
analog characteristics, 583
Digitals
saving, 543
Digitizer, 691
Disk drive signals, 55
Display, 679
format, 167
XY format, 174
XYZ format, 174
YT format, 174
Display bus, 101
Display elements, 719
customizing, 721
Display format, 721
Display format XY, 175
Display menu objects, 721
Display menu options, 815
appearance, 167
colors, 172
date & time, 171
format, 174
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graticule, 178
objects, 171
palette, 179
persistence, 173
screen text, 168
setup, 168
style, 813
waveform interpolation, 176
Display palette, 670
Display resolution, 1
Display style, 721
Displayed waveform, 685
Displaying waveforms, 666
Displays, 489
appearance, 677
color palette, 172
colors, 172
contrast, 677
control window, 489
intensity, 176
objects, 171
on/off, 954
persistence, 173
persistence control
window, 879
screen objects, 171
screen text, 168
setup control window, 172
styles, 813
trigger marker, 815
waveform Display control
window, 489
XY format, 813
XYZ format, 813
Dockable windows, 32
Documentation, 17
Dots, 813
DPO, 50
DSP memory, 680
Dual display, 674
DVD/CD-RW, 68
DVI-I port, 68

E
E-mail configuration dialog
box, 820

E-mail on, 555
event, 625
limit test failure, 532
mask test failure, 532
trigger, 555
E-mail on event control
window, 532
E-mail on event setup
window, 558
Edge button, 63
Edge trigger control window, 431
Edit custom window, 391
Edit mask, 240
Edit menu, 818
Edit menu options, 818
clear data, 798
copy, 522
copy setup, 520
select for copy, 522
Undo last autoset, 189
Edit MyScope, 391
Editing a user defined mask, 622
Editing a user mask, 817
Editing MyScope control
windows, 602
Effective number of bits
enhanced, 190
Eliminating aliases, 262
Enabling a network
connection, 676
Enhance Bandwidth, 498
Enhanced effective number of
bits, 190
ENOB, 190
Envelope mode, 838
Enveloping, 680
Equation editor, 53
as an option, 53
control window, 263
edit controls, 478
spectral analysis, 263
using, 615
Equivalent time mode, 194
Equivalent time sampling, 696
Error detector, 205
error condition setup, 211
results tab, 205
source setup, 206

test pattern setup, 210
Errors, 745
Ethernet serial bus
trigger, 369
Ethernet Serial Bus
Destination port, 371
search for data, 370
search port, 371
Trigger on End of Packet, 424
Trigger on FCS (CRC)
Error, 424
Trigger on Idle, 424
Trigger on IPv4 Header, 424
Trigger on MAC
Addresses, 424
Trigger on MAC
Length/Type, 424
Trigger on Q-Tag Control
Information, 424
Trigger on Start Frame
Delimiter, 424
Trigger on TCP header, 423
Trigger on TCP/IPv4/MAC
Client Data, 424
Event table
copy, 384
export, 384
exporting, 385
saving, 385
selecting columns, 384
Event Table, 379
Exiting the application, 676
Export Event Table, 385
Exporting, 791
files, 538
images, 538
measurements, 536
waveforms, 884
Expression editor
visual trigger, 475
EXT REF, 68
External reference, 550
External signals control
window, 550
external trigger, 57
Eye aperture, 788
Eye diagram, 788
eye diagrams, 813
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F
failure log, 234
fast acquisition, 50
turning on and off, 580
Fast acquisition, 191
FastAcq button, 67
FastFrame
analyze, 880
overview, 200
setup, 916
view, 883
FastFrames, 826
Feedback, 21
FFT, 256
creating waveforms, 918
display, 258
features, 256
locking waveforms, 919
magnitude waveforms, 918
phase waveforms, 920
process, 258
window characteristics, 260
windows, 908
File, 791
File menu options, 823
display on/off, 489
exit, 676
export setup, 538
instrument setup, 535
label, 491
page setup, 523
position/scale, 490
print, 524
print preview, 524
recall default setup, 529
recall wfm, 527
run application, 566
save wfm, 527
shutdown, 899
Filters, 939
Fine button, 937
Fixed license, 570
Flattop2 window, 778
defined, 778
FLEX Serial Bus
trigger on cycle count, 419
trigger on header fields, 419
Floating license, 568
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Frequency domain, 775
controls, 767
setup, 627
Front Panel, 641
autoset, 67
channel buttons, 62
connectors, 57
controls, 61
cursors, 67
default setup, 67
fast acquisition, 67
intensity, 67
pan, 61
pause, 61
play, 61
position, 62
print, 524
scale, 62
termination, 961
touch screen, 552
triggering from, 641
zoom, 61
Functional model of
instrument, 679

G
Gating, 766
a localized measurement, 609
controls, 295
in frequency domain, 767
in zoom window, 295
position, 766
with cursors, 81
Gaussian window, 779
definition, 779
Glitch trigger, 709
control window, 431
Glitch triggering, 648
Global threshold
digital inputs, 95
GPIB, 550
address, 548
controller, 68
GPIB configuration control
window, 548
programming, 674
Graticule, 178
and cursors, 82

controlling within the
graticule area, 44
display elements, 719
exporting, 538
labels, 491
styles, 178
zoom, 48
Graticule size, 893
Graticule split, 724
Graticule style, 721
Graticule zoom control
window, 893
Group delay, 770

H
H Bar cursors, 75
Hamming window, 780
defined, 780
Hanning window, 780
defined, 780
Hardware, 691
acquisition, 691
hardware applications, 674
adding, 674
removing, 674
harmonics, 784
Help
about tekscope, 24
HF Filtering, 931
Hi Res mode, 838
high input impedance probes, 62
High/low method, 728
histogram, 54
Histogram
automated measurements, 665
control window, 298
interaction with fast
acquisition, 191
measurements, 298
reference level
considerations, 292
vertical, 665
Histogram counting, 666
Histogram mode, 728
Histograms, 747
saving, 534
Hits, 237
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holdoff, 482
Horiz/Acq menu options, 833
acquisition mode, 198
autoset, 187
delay mode on, 841
equivalent time, 194
fast acquisitions, 191
horizontal/acquisition
setup, 185
position/scale, 184
resolution, 198
roll mode auto, 193
run/stop, 192
zoom controls, 487
zoom graticule, 202
zoom lock, 202
zoom setup, 202
Horizontal acquisition, 688
bar cursors, 80
control window readouts, 843
delay, 48
delay off, 715
delay on, 716
interrelated parameters, 688
parameters, 688
position, 688
position & scale control
window, 184
position controls, 63
reference, 719
reference point, 727
scale controls, 184
scale setting, 682
setup control window, 183
trigger position, 705
window, 689
Horizontal position, 834

I
I2C
definition, 97
I2C bus
setting up, 586
I2C serial bus
trigger, 331
I2C Serial Bus
search for address, 333

search for address and
data, 333
search for data, 332
search for missing ack, 333
search for repeated start, 333
search for start, 333
search for stop, 333
Impulse-response testing, 783
using the phase controls, 770
Incompatible acquisition
features, 690
Independent cursor mode, 84
Independent triggers, 931
Indicator
trigger correction, 483
Initializing the oscilloscope, 46
Ink saver, 31
Input, 684
resistance, 684
termination, 684
Input amplifier, 691
Input channel, 679
acquisition hardware, 691
conditioning, 682
trigger sources, 698
Input signal, 583
setting up, 578
Installing options, 566
Installing software, 846
Instrument calibration, 552
calibration control
window, 552
signal path compensation, 552
Instrument diagnostics control
window, 553
Instrument setups, 535
deleting, 673
recalling or restoring, 529
saving, 672
visual trigger setup, 481
Intensified samples, 813
Intensity knob, 176
Interaction of acquisition
features, 690
Interface, 32
Interleaving, 696
affects on sample rate, 696

Interpolation, 696

J
Jitter, 55
analysis, 674

K
Kaiser-Bessel window, 780
defined, 780
Key features, 1
Keyboard, 39
connecting, 68
pop-up, 39
use to change control
settings, 39

L
Label
bus, 584
Labels, 491
LAN, 68
LAN server status control
window, 550
Level, 704
Level knob, 63
Line style cursor, 77
Linear interpolation, 696
Linear magnitude, 769
List of bus setups, 98
Localizing a measurement, 609
Lock mask, 219
Logic
threshold setup, 949
Logic clock input for a
trigger, 851
Logic pattern format for a
trigger, 852
Logic pattern setup for a
trigger, 852
Logic probe
connecting to a system under
test, 90
Logic Properties button, 811
Logic trigger pattern editor
bus tab, 850
digital tab, 851
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Logic triggers, 654
logic pattern control
window, 394
logic state control
window, 443
runt control window, 435
Logic waveform
digital threshold, 811
logic threshold, 811
Logic waveforms
analog characteristics of
digital signals, 583
Low input impedance probes, 853
LSB order
parallel bus, 148

M
Magnitude controls, 769
Magnitude scale, 627
magnitude waveforms, 923
MagniVu, 163
manuals, 17
Margin tolerance, 785
Mark
clear, 305
mark all events, 662
set, 305
Mark all trigger events, 662
Markers, 44
cursor, 73
enhanced bandwidth, 819
horizontal reference, 44
trigger level, 44
Mask alignment controls, 223
Mask autoset, 786
autofit control, 854
automatic mode, 856
horizontal control, 855
trigger level control, 857
vertical control, 858
Mask configuration, 786
autofit controls, 221
autoset controls, 220
display control, 219
display controls, 219
Mask editing, 622
from a defined mask, 622
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setup window, 224
Mask hits, 785
per segment, 237
Mask margin, 785
controls, 226
Mask pass/fail, 215
define source/tolerance, 225
set test notification, 227
view results, 234
Mask polarity, 233
Mask segments, 237
Mask setup, 238
mask sources control
window, 225
mask testing control
window, 215
Mask test, 786
controls, 888
repeat test, 234
set limits, 242
set pass/fail parameters, 230
start or reset, 238
summary, 235
Mask testing, 786
communication trigger, 707
overview, 785
Mask tolerance, 226
Mask type, 217
set polarity, 215
set standard, 215
standards, 217
Math equation, 748
create waveform, 616
expression syntax, 753
operations on time base, 726
predefined expressions, 899
Math equation editor, 263
arbitrary filters, 859
display functions, 868
edit functions, 867
filter functions, 271
measurement functions, 270
spectral functions, 268
time functions, 265
variables functions, 270
Math functions
custom, 249
plugin, 249

Math menu options, 868
Ch1 * Ch2, 899
Ch1 - Ch2, 899
Ch3 * Ch4, 899
Ch3 - Ch4, 899
digital properties, 811
display On/Off, 489
logic properties, 811
position and scale, 490
set averages, 247
setup and control, 247
spectral setup, 252
Math plugins, 250
using, 755
writing, 756
Math setup control window, 247
Math variables control
window, 248
Math waveform, 826
averaging, 247
color, 814
create, 615
defining, 610
differentiation, 750
digital threshold, 811
entering functions, 265
FFT functions, 268
guidelines, 826
interactions, 748
label, 491
logic threshold, 811
offset, 754
position, 754
properties, 868
scale, 610
sources, 752
spectral, 631
using predefined
expressions, 899
variables, 270
MATLAB
basic function interface, 761
creating with a class, 762
custom functions, 761
plugins, 251
Maximum signal level, 684
Mean, 54
Measure amplitude, 80
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Measurement, 609
annotation, 563
gating, 609
localizing, 609
snapshot, 273
Measurement algorithms, 733
amplitude, 733
area, 733
burst width, 734
cycle area, 733
cycle mean, 734
cycle RMS, 734
delay, 735
end, 732
EndCycle, 733
envelope waveforms, 742
extinction %, 735
extinction dB, 735
extinction ratio, 735
frequency, 736
high, 736
high, low, 730
HighRef, 731
histogram method, 731
hysteresis, 732
integration algorithm, 741
low, 736
LowRef, 731
maximum, 737
MCross1, 732
MCross1Polarity, 732
MCross2, 732
MCross3, 732
mean, 737
mean dBm, 737
Mid2Ref, 731
MidRef, 731
min-max method, 730
minimum, 737
missing samples, 743
negative duty cycle, 737
negative overshoot, 738
negative width, 738
optical power, 738
out of range samples, 743
peak to peak, 738
period, 738
phase, 739

positive duty cycle, 739
positive overshoot, 739
positive width, 740
record lelngth, 731
rise time, 740
RMS, 741
start, 731
StartCycle, 732
TPOS, 733
TSOFF, 733
variables, 730
waveform record length, 733
Measurement errors, 745
Measurement menu options, 873
amplitude measurements, 276
display statistics, 291
gating control window, 295
histogram measurements, 296
more tab, 288
reference levels, 292
reset histograms, 298
setup control window, 274
time measurements, 279
waveform histograms, 298
Measurement readouts, 275
Measurement Save Options, 558
Measurement setups, 890
delay, 888
phase, 890
Measurement warnings, 744
Measurements, 608
amplitude, 276
automatic, 608
communication, 284
control window, 274
cursor, 83
gating, 81
histogram, 292
horizontal, 82
horizontal parameters, 81
interaction with fast
acquisition, 191
list, 270
mean, 291
miscellaneous, 288
reference levels, 292
standard deviation, 291
statistics, 291

statistics control window, 291
time, 279
using in math waveforms, 270
vertical, 82
Menu bar mode, 33
MIL-1553 bus
setting up, 593
MIL-1553 serial bus
trigger, 366
MIL-1553 Serial Bus
Trigger on Command
Word, 421
Trigger on Data, 421
Trigger on Error, 421
MIL-STD-1553 serial bus
trigger, 366
Min-max mode, 728
Minimizing the display, 676
Minimum value, 825
MIPI CSI-2 bus
setting up, 589
MIPI DSI-1, 110
MIPI DSI-1 bus
setting up, 588
MIPI serial bus
trigger, 345
MIPI Serial Bus
search for bus turn
around, 346
search for end of
transmission, 346
search for error, 346
search for escape mode, 346
search for long packet, 346
search for short packet, 346
search for start of
transmission, 346
search for stop, 346
search for warning, 346
Model numbers, 1
Monitor, 25
Mouse, 68
connecting, 68
Moving control windows, 43
MSB order
parallel bus, 148
Multipurpose knobs, 559
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Multizoom, 668
using, 668
MyScope controls, 388
MyScope setup window, 387

N
Negative pulse testing, 233
Network connections, 26
New features, 965
New tab, 387
Number of lanes
setup, 125
Nyquist frequency, 262
Nyquist point, 784

O
Occurs And trigger
qualification, 930
Offset, 685
control, 955
math offset and position, 754
On/standby switch, 899
Open bus, 160
Open custom window, 391
Open MyScope window, 391
Options, 11
installation, 570
MTM, 786
Options waveforms, 884
Order of bits
parallel bus, 148
Overview, 679
functional, 679
process, 680

P
P value, 788
Page setup dialog box, 523
Paired cursors, 75
Parallel bus
add sources, 145
bit order, 148
clock polarity, 151
clock source, 150
decode method, 156
display bus components, 154
remove a channel, 149

976

setting up, 584
setup for a clocked
acquisition, 144
setup for an unclocked
acquisition, 143
symbol file format for
decoding, 158
symbol table for
decoding, 157
threshold level setup, 146
trigger, 399
troubleshooting, 596
Parallel bus options, 144
Parallel port, 68
Pass/fail mask test, 227
Pattern editor for a bus
Bus setup control
window, 941
Pattern editor for a bus
(DPO/MSO5000B Series)
Bus setup control
window, 942
Pattern editor for live tab
threshold setup, 948
Pattern editor for logic tab
threshold setup, 947
Pattern editor for Occurs And
trigger qualification, 930
Pattern editor to trigger on a bus
Logic Pattern setup control
window, 850
Logic State setup control
window, 850
Pattern editor to trigger on digital
inputs
Logic Pattern setup control
window, 851
Logic State setup control
window, 851
Pattern trigger, 709
control window, 435
triggering on a pattern, 652
PCIe Serial Bus
Trigger on Pattern, 414
PDF documents, 17
Peak detect mode, 838
Performance verification, 17
Persistence, 721

Persistence control window, 879
Phase controls, 770
Phase measurement, 890
setup, 890
Phase reference position, 770
Phase scale, 627
Phase unwrap, 770
Phase waveform, 919
pop-up, 38
keyboard, 39
keypad, 39
Position, 754
Position a bus, 103
Position control, 685
Position correction, trigger, 483
Position knob, 63
Position/scale control
window, 490
position, 937
scale, 938
Positive pulse testing, 233
Posttrigger, 705
Posttrigger data, 393
Power down, 677
Power on, 899
Predefined math expressions, 899
Preferences, 559
keypad defaults, 560
prompts, 559
trigger level presets, 560
user, 560
Presets, 560
Pretrigger, 705
Pretrigger data, 393
Preview acquisition, 724
Print, 936
button, 67
Printer, 524
external, 31
internal, 523
page setup, 523
selecting, 523
Printing, 524
button, 67
capturing the screen, 522
color palette, 31
copying, 522
dialog box, 524
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Ink saver, 31
page setup dialog box, 523
preview, 523
the screen, 522
to a printer, 524
Probe calibration procedure
restrictions, 900
Probe compensation, 901
adjusting probes for
compensation, 901
low frequency probes, 506
Probe compensation
procedure, 959
active probes, 575
passive probes, 576
Probe controls, 959
Probe setup, 502
compensation, 506
control window, 504
D15-D0 tab, 505
status, 515
tip selection window, 509
Probe Setup Control
Window, 502
Probe tip selection, 509
Probes, 47
attenuation, 959
connecting, 47
deskew, 959
termination, 62
types, 47
Probes and signal connection, 681
Process overview, 680
Product description, 1
Product feedback, 21
Product software, 5
Programmer guide PDF, 17
Programming, 674
Prompts, 559
Protocol Event Table, 379
column layout, 381
docking, 380
resizing a docked table, 381
undocking, 380
Pulse form, 802
Pulse timeout triggering, 651
Pulse triggers, 394
Pulse width trigger, 449

Pulse width triggering, 650

Q
Qualification editor
visual trigger, 475
Qualification expression
editor, 476
Quitting the application, 676

R
RBW, 767
Readouts, 276
Recall dialog box instrument
setups, 529
Recall instrument setup control
window, 529
Recall user mask, 241
Recalling, 902
masks, 902
Setups, 789
template, 902
Waveforms, 790
Recalling a template
waveform, 902
Recalling a user mask from
disk, 624
Recalling masks, 902
recalling saved files, 634
instrument setups, 672
reference waveforms, 634
Recalling waveforms, 790
Recommended accessories, 6
Record, 694
Waveform, 694
Record length, 902
Rectangular window, 782
defined, 782
REF OUT, 68
Reference color, 815
Reference colors, 721
Reference level, 769
Reference level offset, 769
Reference levels control
window, 527
Reference levels method, 728
Reference waveform
controls, 527

Reference waveforms, 632
Remote Desktop Connection, 180
Remote Operation, 180
Remove a channel
parallel bus, 149
Reset, 798
Resolution, 262
Resolution bandwidth, 767
Resolution control window, 198
Resolution knob, 63
Return floating license, 571
Right-click, 45
Roll mode, 639
interactions with other
settings, 847
setting up, 638
RS-232
setting up, 587
RS-232 serial bus
bit rate, 138
data bits, 136
direction, 135
parity, 137
trigger, 406
RS-232 Serial Bus
search for data, 327
search for parity error, 327
search for start, 327
Run/stop button, 66
Run/stop control, 680
Run/stop control window, 192
Runt pulse triggering, 648
Runt trigger, 435
control window, 435
definition, 710

S
Sample density, 696
Sample interval, 688
Sample mode, 838
Sample rate and user
preference, 688
Sampling, 693
defined, 693
modes, 694
Save As dialog box, 791
digitals, 543
histogram, 534
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instrument setup, 535
measurement, 536
screen capture, 538
timestamp, 544
user mask, 540
visual trigger setup, 480
waveform, 541
Save custom window, 390
Save Event Table, 385
Save MyScope window, 390
Save template, 243
Saving, 907
masks, 907
setups, 789
visual trigger setup, 480
waveforms, 790
Saving a screen capture, 637
Saving a user mask to disk, 623
Saving a waveform, 634
Saving and copying waveform
data, 791
Saving masks, 907
Saving measurements, 610
Scale controls, 63
math, 754
positioning, 685
Scallop loss, 775
Screen capture dialog box, 538
Screen elements, 37
control window, 170
cursors, 83
display text, 168
objects control window, 171
Search
configure, 310
controls, 318
count results, 316
mark all events, 662
mark table, 315
parameters, 312
place marks automatically, 312
select type, 306
show marks, 316
stop, 317
timing results, 315
Search menu options
8B10B serial bus setup, 323
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custom serial bus setup, 377
DDR serial bus setup, 375
Ethernet serial bus setup, 369
I2C serial bus setup, 331
MIL-1553 serial bus
setup, 366
MIPI serial bus setup, 345
parallel bus setup, 378
RS-232 serial bus setup, 326
SPI serial bus setup, 352
USB serial bus setup, 336
Second monitor, 674
Selecting the sound source, 232
Sequential triggering, 715
A event only, 646
after a delay, 646
B event, 459
B event scan, 463
triggering on a sequence, 645
with horizontal delay on, 911
Serial bus
8B10B trigger, 401
analyzing anomalies, 594
CAN trigger, 415
custom trigger, 377
DDR trigger, 375
Ethernet trigger, 423
FLEXRAY trigger, 418
I2C trigger, 403
LIN trigger, 416
MIL-1553 trigger, 420
MIL-STD-1553 trigger, 420
MIPI trigger, 345
options, 103
PCIe trigger, 413
RS-232 trigger, 406
setup, 123
SPI trigger, 329
trigger, 416
troubleshooting, 599
USB trigger, 336
Serial bus channel input
setup, 127
Serial bus channel threshold
setup, 133
Serial bus channel type
setup, 126

Serial bus data rate
setup, 130
Serial bus input
setup, 131
Serial bus options, 141
Serial bus signal type
setup, 129
Serial bus speed
setup, 128
Serial bus threshold high
setup, 132
Serial bus tions
options, 111
Serial error detector, 205
error condition setup, 211
results tab, 205
source setup, 209
test pattern setup, 210
Serial mask testing, 786
Serial mask testing option, 914
Serial pattern data editor, 914
Serial port, 68
Service manual, 17
Set to 50%, 917
Setting acquisition modes, 579
Setting cursor sources, 604
Setting the horizontal scale, 682
Setting the vertical scale, 682
setting time and date, 547
Setting up digital waveforms, 583
Setting up mask testing, 617
Setting up roll mode, 638
Setting up signal input, 578
Setup and hold trigger, 710
control window, 439
Setup window, 643
triggering from, 643
Setup/hold violations
triggering, 656
Setups, 789
recalling, 789
saving, 789
Shared triggers, 931
Shortcuts, 45
Shutting down the
oscilloscope, 677
Side lobe, 775
Side panel connectors, 68
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Signal characterization, 54
Signal connection, 681
Signal input, 583
Signal path compensation
procedure, 502
Signal processing and
transformation, 679
Sin(x)/x interpolation, 696
Single button, 192
Slope, 704
trigger, 704
SMTP server address, 820
Snapshot, 273
Software, 5
adding applications, 674
analysis and connectivity
support, 21
analysis and connectivity
tools, 825
installation, 846
Source, 225
cursor, 604
masks, 225
Sources, 752
math waveforms, 752
Sources for automatic
measurements, 728
Span, 767
Specifications, 17
Spectral analysis, 908
spectrum analyzer
controls, 53
time domain gating, 261
Spectral analyzer windows, 775
Blackman-Harris, 775
Gaussian, 775
Hamming, 775
Hanning, 775
Kaiser-Bessel, 775
Rectangular, 775
Tek Exponential, 775
using, 775
Spectral averaging, 763
Spectral math controls, 764
frequency, 764
gate, 764
magnitude, 764
phase, 764

time, 764
Spectral math waveforms, 763
example, 631
frequency domain, 763
gating, 763
overview, 763
set up, 627
time domain, 763
Spectral setups
control window
advanced, 252
basic, 251
frequency, 253
gating, 255
Spectral waveforms, 252
creating, 918
features, 256
overview, 256
SPI bus, 441
setting up, 586
SPI serial bus
direction, 142
framing, 139
idle time, 140
trigger, 405
word size, 141
SPI Serial Bus
search for data, 353
search for SS Active, 363
Split cursors, 82
Srial bus
trigger, 420
Standard deviation, 54
Starting an acquisition, 66
State trigger, 712
control window, 443
State trigger pattern editor
bus tab, 850
digital tab, 851
Status, 639
trigger, 639
Stopping an acquisition, 66
Support
information, 18
tools, 825
Suppression threshold, 770
Symbol file format
parallel buses, 158

Symbol table file, 160
Symbol table for parallel
buses, 157
Syntax, 753
math waveform
expression, 753

T
Taking automatic measurements, 606
Technical support, 18
Tek exponential window, 783
defined, 783
Tekprobe interface, 924
TekProbe interface, 47
TekSecure erase, 547
Template, 902
recall, 902
saving, 243
Termination, 959
and coupling, 893
termination control
window, 893
Test notification, 227
Test results, 234
Test summary, 235
Text properties control
window, 170
Thermal printer, 524
Threshold setup for logic, 949
Thresholds setup
parallel bus, 146
Pattern Editor bus tab, 947
Pattern Editor live tab, 948
Time and date, 547
Time base system, 679
Time bases, 47
Time controls, 764
duration, 764
resolution, 764
Time domain, 627
setup, 627
Time domain controls, 764
Time domain gating, 261
Time duration, 688
Time measurements, 279
Time stamps, 880
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Timeout trigger, 713
timeout trigger control
window, 444
Tolerance, 226
Toolbar mode, 34
Touch screen, 25
button, 60
calibrate, 552
Tracking cursor mode, 84
Transition time trigger, 446
definition, 713
setup, 655
Trigger, 713
bus pattern condition, 940
bus pattern condition
(MSO/DPO5000B
and MSO70000C/DX
Series), 940
bus pattern editor, 941
bus pattern editor
(DPO/MSO5000B
Series), 942
bus selection, 940
bus time condition, 940
codes, 799
concepts, 696
considerations, 688
coupling, 704
delayed, 706
event, 696
holdoff, 703
indicator, 483
level marker, 721
live tab of the pattern
editor, 948
logic clock input, 851
logic pattern editor, 851
logic pattern format, 852
logic pattern setup, 852
logic state condition, 940
logic tab of the pattern
editor, 947
modes, 702
Occurs And pattern
editor, 930
parallel bus pattern, 940
pattern editor, 851
point, 694
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position, 705
position correction, 483
setup window, 643
slope and level, 704
sources, 698
standards, 799
state pattern editor, 851
status, 639
system, 679
threshold, 917
transition time, 713
types, 699
Trigger controls, 63
advanced button, 63
edge button, 63
level knob, 63
mode, 63
slope, 63
source, 63
Trigger menu options, 928
8B10B serial bus setup, 401
A event setup, 394
A-B sequence, 911
B event setup, 466
CAN serial bus setup, 415
CAN setup, 428
comm setup, 429
edge setup, 431
Ethernet serial bus setup, 423
FLEXRAY serial bus
setup, 418
glitch setup, 431
holdoff, 482
I2C serial bus setup, 404
LIN serial bus setup, 416
logic pattern, 434
logic state, 444
MIL-1553 serial bus
setup, 420
mode, 397
parallel bus setup, 399
PCIe serial bus setup, 413
quick select, 394
RS-232 serial bus setup, 406
run/stop, 192
runt setup, 435
serial pattern setup, 438
setup/hold setup, 439

SPI serial bus setup, 405
SPI setup, 441
timeout setup, 444
transition setup, 446
USB serial bus setup, 408
video setup, 448
width setup, 449
window setup, 451
Triggering, 680
a glitch, 648
a pattern, 652
a pulse width, 650
a runt pulse, 648
a sequence, 645
a video signal, 660
advanced, 706
bus, 662
communication mask, 661
coupling, 704
from front panel, 641
from trigger setup
window, 643
holdoff, 703
logic state, 654
mark all events, 662
modes, 702
overview, 696
pulse timeout, 651
setup/hold violations, 656
sources, 698
transition time, 655
triggering on, 645
types, 699
window threshold
violations, 659
Triggers, 393
bus, 699
communication, 699
coupling, 63
edge, 699
external, 57
glitch, 699
holdoff, 398
holdoff control window, 398
level, 397
level marker, 815
logic, 699
markers, 815
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menu options, 393
mode, 397
mode control window, 397
out signal, 550
pattern, 699
posttrigger data, 393
pretrigger data, 393
pulse, 699
runt, 699
sequential, 646
serial, 699
setup control window, 393
setup/hold, 699
shared/independent, 931
state, 699
timeout, 699
transition, 699
types, 394
video, 699
width, 699
window, 699
Troubleshooting
autoset, 691
bus anomalies, 594
parallel bus, 596
serial bus, 599
support information, 18
Windows interface, 25
Turn off power, 677
Turning fast acquisition on and
off, 580
Type of mask, 617

U
Upgrades, 11
USB bus
setting up, 588
USB serial bus
trigger, 408
USB Serial Bus
search for data packet, 337
search for end of packet, 337
search for error, 337
search for handshake
packet, 337
search for reset, 337
search for resume, 337
search for special packet, 337

search for suspend, 337
search for sync, 337
search for token (address)
packet, 337
Trigger on Data Packet, 409
Trigger on Error, 409
Trigger on Handshake
Packet, 409
Trigger on Special
Packet, 409
Trigger on Token (Address)
Packet, 409
User color palette, 670
User color palettes, 805
user interface, 38
User interface, 37
User mask, 624
creating, 620
editing, 622
saving, 623
User mask edit, 240
User mask setup, 238
User preferences control
window, 560
prompts, 559
readouts, 561
trigger level presets, 560
Using Fast Acquisitions, 580
Using mask testing, 625
Using math waveforms, 610
Using MyScope control
windows, 388
Using zoom, 728
Using zoom with waveforms, 668
Utilities menu, 936
Utilities menu options, 936
autoset preferences, 189
deassign multipurpose
knobs, 559
external signals, 550
GPIB configuration, 548
instrument calibration, 552
instrument diagnostics, 553
option installation, 566
set time & date, 547
TekSecure erase, 547
user preferences, 559

V
V Bar cursors, 75
Variable List, 270
Variables control window, 248
vectors, 813
Vertical acquisition, 685
Vertical acquisition window, 685
vertical controls
Multiview Zoom button, 68
offset, 491
position, 62
scale, 62
V Bar cursors, 81
vertical bar cursors, 81
vertical offset control
window, 491
Vertical controls, 485
vertical setup control
window, 485
aux tab, 501
Vertical menu options, 936
attenuation, 511
bandwidth, 498
coupling, 496
deskew, 510
digital channels, 505
digital properties, 811
display on/off, 954
label, 491
logic properties, 811
offset, 491
position/scale, 956
probe cal, 506
termination, 893
vertical setup, 485
zoom controls, 487
zoom graticule, 202
zoom setup, 202
Vertical offset, 685
vertical scale, 682
setting, 682
Vertices, 785
Video port, 68
Video signal triggering, 660
video trigger, 713
control window, 448
signal types, 448
View Bus Packet, 157
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Visual qualification
define area, 472
edit logic, 473
Visual search, 321
Visual trigger, 321
area creation, 469
controls, 470
equation editor, 477
qualification, 475
recall setups, 481
setup, 480
Voltage threshold levels
parallel bus, 146
Volts per division, 684
maximum, 684
Vvisual trigger
expression editor, 476
VXI LAN server, 550

W
Warnings, 744
Waveform differentiation, 750
Waveform display, 724
Waveform display control
window, 489
Waveform integration, 754
Waveform intensity, 721
Waveform interpolation, 721
Waveform Label control
window, 491
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Waveform options dialog
box, 884
Waveform record, 694
Waveforms, 826
averaging, 247
clipping, 955
colors, 814
display, 167
displaying, 666
handle, 44
histogram, 298
intensity, 176
interpolation, 167
label, 954
math, 826
position, 937
recalling and restoring, 528
reference, 490
saving, 541
scale, 490
spectral magnitude, 53
spectral phase, 919
WfmDB mode, 838
Width trigger, 714
defined, 714
Width trigger control
window, 449
Window bin width, 767
Window threshold violations
triggering, 659

Window trigger, 451
defined, 714
window trigger control
window, 451
Windows, 674
dockable, 674
Windows interface, 25
Working with your
oscilloscope, 965

X
X style cursor, 77
XY cursors, 76
XY format, 175
XYZ format, 174

Y
YT format, 174

Z
Zero phase reference, 775
Zoom, 728
button, 68
control window, 487
graticule, 48
setup window, 202
using, 668
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